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Στους αυριανούς χαρτογράφους 
  
Πίνακας συντομεύσεων-ακρωνύμια
 	AJAX
	Asynchronous JavaScript and XML

	ASCII
	American Standard Code for Information Interchange

	ASTER
	Advanced Spaceborne Thermal Emission and Reflection Radiometer

	CEN
	European Committee for Standardization

	CIE 
	Commission Internationale de l' Éclairage

	CMYK
	Cyan Magenta Yellow Black

	CSS
	Cascading Style Sheets

	EPSG
	European Petroleum Search Group

	GML
	Geography Markup Language

	GNSS
	Global Navigation Satellite System

	GRASS
	Geographic Resources Analysis Support System

	GSHHS
	Global Self-consistent Hierarchical High-Resolution Shoreline

	HTML
	HyperText Markup Language

	HTTP
	HyperText Transfer Protocol

	ICA
	International Cartographic Association

	ICC
	International Color Consortium

	IGN
	Institut Géographique National

	IGNF
	Institut Geographique National de France

	INSPIRE
	Infrastructure for Spatial Information in the European Community

	ISO
	International Organization for Standardization

	ISO/TC
	International Organization for Standardization/Technical Committee

	KML
	Keyhole Markup Language

	OGC
	Open Geospatial Consortium

	OLE DB
	Object Linking and Embedding Database

	OSM
	Οpen Street Map

	OWL
	Web Ontology Language

	PAEK
	Polynomial Approximation with Exponential Kernel

	RDF
	Resource Description Framework

	RGB
	Red Green Blue

	RMSE
	Root Mean Square Εrror

	SLD
	Style Layer Descriptor

	SQL
	Structured Query Language

	SRTM
	Shuttle Radar Topography Mission

	SVG
	Scalable Vector Graphics

	TIN
	Triangulated Irregular Network

	URL
	Uniform Resource Locator

	VGI
	Volunteered Geographic Information

	W3C
	World Wide Web Consortium

	WCS
	Web Coverage Service

	WFS
	Web Feature Service

	WFS-T
	Web Feature Service Τransactional

	WMS
	Web Map Service

	WMTS
	Web Map Tile Service

	WPS
	Web Processing Service

	WSDL
	Web Service Definition Language

	XML
	eXtensible Mark-up Language

	ΓΥΣ
	Γεωγραφική Υπηρεσία Στρατού

	ΕΓΣΑ ’87
	Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς του 1987

	ΕΚΧΑ Α.Ε
	Εθνικό Κτηματολόγιο και Χαρτογράφηση Α.Ε.

	ΕΛ/ΛΑΚ
	Ελεύθερο Λογισμικό/Λογισμικό Ανοικτού Κώδικα
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	Σύστημα Αναφοράς των Συντεταγμένων

	ΣΓΠ
	Σύστημα Γεωγραφικών Πληροφοριών

	ΣΔΒΔ
	Σύστημα Διαχείρισης Βάσεων Δεδομένων

	ΥΥΠΝ
	Υδρογραφική Υπηρεσία του Πολεμικού Ναυτικού

	Φ.Χ.
	Φύλλο Χάρτου

	ΨΜΕ
	Ψηφιακό Μοντέλο Εδάφους


 
 
Ευρετήριο όρων
 	ακμή 
	edge 

	αλγόριθμος απλοποίησης 
	simplification algorithm

	αλληλεπιδρούσα
	interactive

	αναδειγματοληψία
	resampling

	ανάλυση εικόνας
	resolution

	αντικειμενο-σχεσιακό 
	object-relational

	αρχείο 
	file

	βάση δεδομένων 
	database

	βάση δεδομένων με χωρικές δυνατότητες 
	spatially enabled database

	γεωβάση 
	geodatabase

	γεωγραφική πληροφορία που συλλέχθηκε από εθελοντές 
	Volunteered Geographic Information 

	γλώσσα επισήμανσης 
	markup language

	γραμμές αλλαγής κλίσης 
	breaklines

	γραμμής κατάσταση 
	status bar

	δεδομένα 
	data

	δευτερεύον κλειδί 
	foreign key

	δημόσια δεδομένα
	public domain data

	διαλειτουργικότητα 
	interoperability

	διανυσματικό
	vector

	διγραμμική παρεμβολή
	bilinear interpolation

	δικαιώματα πνευματικά
	copyright

	δίκτυο 
	network

	Δίκτυο Ακανόνιστων Τριγώνων 
	Triangulated Irregular Network 

	δυαδικοί τελεστές 
	binary operators

	δυαδικός
	binary

	εικόνα 
	image 

	εικονοστοιχείο 
	pixel

	εκτέλεση μιας επεξεργασίας στον υπολογιστή χωρίς την παρέμβαση του χρήστη
	batch mode

	εξυπηρετητής 
	server

	επίπεδη επιφάνεια 
	face 

	εργαλειοθήκη 
	tool bar

	ετικέτα 
	tag

	θεματικό επίπεδο
	layer

	ισοϋψής 
	contour 

	κανονικοποιημένο
	raster 

	κατ’ απαίτηση το χρήστη 
	on demand

	κατάλογος δεδομένων 
	folder

	κατάλογος με δυαδικά αρχεία 
	folder of binary files

	κατάσταση 
	status

	κείμενο 
	text

	Κοινοπραξία του Παγκόσμιου Ιστού 
	World Wide Web Consortium

	κόμβος 
	node

	κυβική συνέλιξη
	cubic convolution

	κωδικός πρόσβασης 
	password

	λεξικό δεδομένων 
	data dictionary

	λογικός τελεστής 
	logical operator

	μέσο τετραγωνικό σφάλμα
	root mean square error

	μορφότυπος
	format

	ομοπαράλληλος μετασχηματισμός
	affine transformation

	ορισμός υπηρεσίας 
	service definition

	παράμετρος ανοχής 
	threshold

	πεδίο ορισμού 
	domain

	περιγραφικά χαρακτηριστικά
	attributes

	πίνακας ιδιοτήτων 
	attribute table

	πληθοπορισμός 
	crowdsourcing

	πλησιέστερος γείτονας 
	nearest neighbour

	προκαθορισμένη τιμή 
	default

	πρόσθετα 
	plugins

	πρωτεύον κλειδί 
	primary key

	πύκνωση 
	cracking 

	ρυθμίσεις
	configuration.

	σημεία γεωγραφικής προσαρμογής/ελέγχου
	registration/control points

	σημειακά δεδομένα 
	point data

	στιγμές 
	points

	στοιχεία 
	elements 

	στροφή /καμπή
	bend

	σύμπτωση θέσεων 
	snapping

	σύνολο χωρικών στοιχείων 
	feature dataset

	συντεταγμένες των ορίων 
	bounding coordinates

	σχήμα 
	schema

	τάξη χωρικών στοιχείων 
	feature class

	τελεστές σύγκρισης 
	comparison operators 

	τεχνική εξομάλυνσης ψηφιακής εικόνας
	anti-aliasing

	τιμή ανοχής 
	tolerance

	υπηρεσία 
	service

	υπηρεσία χαρτών 
	map service 

	υπολογιστικό νέφος 
	cloud

	χαρτογραφικές πινακίδες 
	map tiles

	χρήστης 
	user

	χωρική οντότητα
	feature

	χωρικός τελεστής
	spatial operator

	ψηφιοποιητής
	digitizer 


 
 
Πρόλογος
Η συγγραφή ενός βιβλίου που πραγματεύεται τη χαρτογραφική σύνθεση και απόδοση σε ψηφιακό περιβάλλον, παρουσιάζει ιδιαίτερα χαρακτηριστικά και αντίστοιχες προς αυτά απαιτήσεις. Τούτο διότι εκτός από το σχετικά ευρύ θεωρητικό υπόβαθρο, προϋποθέτει συμπυκνωμένη εμπειρία και γνώση πραγματικών συνθηκών παραγωγής και ταυτόχρονα προσαρμογή τους στο εκπαιδευτικό περιβάλλον ώστε να επιτευχθεί η απαιτούμενη όσμωση. Πρόσθετο παράγοντα προβληματισμού αποτελεί η αξιοποίηση περισσοτέρων του ενός περιβάλλοντος λογισμικού Συστήματος Γεωγραφικών Πληροφοριών για τη χαρτογραφική σύνθεση και απόδοση. Η επιλογή αυτή, εκτιμάται ότι θα δώσει στον αναγνώστη δυνατότητα τεκμηριωμένης κριτικής προσέγγισης σε ό,τι αφορά τα πλεονεκτήματα και τυχόν μειονεκτήματα καθενός. 
Η πολύχρονη διδασκαλία του αντικειμένου στο πλαίσιο των σχετικών μαθημάτων σε προπτυχιακό και μεταπτυχιακό επίπεδο, και η εξ αυτής ανάδραση με τους φοιτητές, έδωσε τη δυνατότητα στη συγγραφική ομάδα να διαμορφώσει το περιεχόμενο του βιβλίου με τρόπο που να καλύπτει τις ουσιαστικές απαιτήσεις για το σύνολο των φάσεων της χαρτοσύνθεσης και των συγγενών εφαρμογών και να παρέχει κατευθυντήριες γραμμές για ένα ολοκληρωμένο και πλήρως αποδεκτό αποτέλεσμα. Θα ήθελα να ευχαριστήσω τις κυρίες Ανδριανή Σκοπελίτη και Λήδα Στάμου για την ουσιαστική συμβολή τους στη συγγραφή του βιβλίου και την αδιάκοπη προσπάθειά τους για συνεχείς βελτιώσεις. Ευχαριστίες απευθύνονται επίσης στον κριτικό αναγνώστη, συνάδελφο κ. Βύρωνα Νάκο, για την ενδελεχή ανάγνωση του κειμένου και τις εύστοχες παρατηρήσεις του. Ελπίζω ότι οι αναγνώστες και μελλοντικοί χαρτογράφοι θα εντοπίσουν στα περιεχόμενα του βιβλίου τις κατευθύνσεις οι οποίες θα τους οδηγήσουν στη σύνθεση σωστών και αισθητικά ελκυστικών χαρτών.
 
Λύσανδρος Τσούλος
 
 
 
Εισαγωγή
Το σύγγραμμα αυτό πραγματεύεται το αντικείμενο της χαρτογραφικής σύνθεσης και απόδοσης σε ψηφιακό περιβάλλον και τη σημασία της σε ένα ευρύ φάσμα εφαρμογών της Γεωπληροφορικής, οι οποίες καλύπτονται στις επιμέρους ενότητες/κεφάλαια. Στο πλαίσιο της Εισαγωγής, αναλύονται οι στόχοι του συγγράμματος και παρουσιάζονται συνοπτικά τόσο τα αντικείμενα που καλύπτονται σε κάθε κεφάλαιο, όσο και η λειτουργική τους αλληλουχία. Επιπλέον, παρουσιάζονται τα χαρακτηριστικά των ενδιάμεσων αποτελεσμάτων και αυτά του τελικού προϊόντος και αναδεικνύονται οι γνώσεις τις οποίες θα αποκτήσει ο σπουδαστής και εν γένει ο χρήστης με την ολοκλήρωση της ύλης. Τέλος, γίνεται συνοπτική παρουσίαση του λογισμικού που προτείνεται σε κάθε ενότητα του βιβλίου με αναλυτική παράθεση της σχετικής διαδικασίας. Για την υλοποίηση των διαδικασιών συλλογής, επεξεργασίας, ανάλυσης και απόδοσης χωρικών δεδομένων, τόσο σε τοπικό όσο και σε περιβάλλον διαδικτύου, προτείνεται κατά περίπτωση ανοιχτό λογισμικό όπως: QGIS, Geoserver κ.ά. με παράλληλη αναφορά στο εμπορικό λογισμικό Συστημάτων Γεωγραφικών Πληροφοριών ArcGIS. Για την υποβοήθηση του χρήστη, ο οποίος δεν είναι εξοικειωμένος με τα συγκεκριμένα συστήματα λογισμικού, προστέθηκαν δύο παραρτήματα που παρέχουν βασικές οδηγίες χρήσης των συγκεκριμένων συστημάτων. Με τον τρόπο αυτό, οι χρήστες του βιβλίου θα είναι σε θέση να αντιμετωπίσουν τις επιμέρους εφαρμογές σε περισσότερα από ένα περιβάλλοντα λογισμικού και ταυτόχρονα να αποκτήσουν κριτική προσέγγιση για τις επί μέρους δυνατότητες καθενός από αυτά.
Οι σύγχρονες εξελίξεις της τεχνολογίας και ιδιαίτερα η ραγδαία ανάπτυξη και ευρεία χρήση των ηλεκτρονικών υπολογιστών, επηρεάζουν αναμφίβολα όλους τους τομείς της επιστήμης και της τεχνικής. Η κατάσταση αυτή μπορεί να παραλληλιστεί με την Βιομηχανική επανάσταση του προηγούμενου αιώνα, την εξέλιξη της οποίας τίποτε δεν μπόρεσε να αναστείλει. Στον χώρο της Χαρτογραφίας η τάση αυτή εκδηλώθηκε αρχικά με τη διέξοδο που δόθηκε στα υπολογιστικά και σχεδιαστικά προβλήματα των χαρτών και στη συνέχεια με τη δημιουργία οργανωμένων τραπεζών ψηφιακών πληροφοριών. Η νέα αυτή μορφή της πληροφορίας έδωσε τη δυνατότητα στους χαρτογραφικούς φορείς να αξιοποιήσουν σωστά τον τεράστιο όγκο των στοιχείων που διαθέτουν και να εκδώσουν σειρές χαρτογραφικών προϊόντων, τα οποία καλύπτουν ένα ευρύ φάσμα αναγκών. Φυσικά, η διείσδυση αυτή επηρέασε κατά κύριο λόγο τη μεθοδολογία της σύνθεσης, δεδομένου ότι το τελικό προϊόν - έστω και με διαφορετικές προδιαγραφές - ήταν ένας χάρτης τυπωμένος σε χαρτί. Επισημαίνεται επίσης ότι ο τρόπος απόδοσης και η μεθοδολογία χρήσης του χάρτη δεν άλλαξαν ριζικά και παρά την εμφάνιση της νέας μορφής του χάρτη, του ηλεκτρονικού, ο χάρτης στην παραδοσιακή του μορφή αποτελεί το σημαντικότερο βοήθημα.
Η διείσδυση των συστημάτων υπολογιστών στη χαρτογραφία δημιούργησε ένα αυθυπόστατο γνωστικό αντικείμενο και τομέα έρευνας γνωστό ως «Ψηφιακή Χαρτογραφία». Ο όρος αυτός δεν είναι ο μοναδικός με τον οποίο χαρακτηρίζεται το γνωστικό αυτό αντικείμενο και έτσι υφίστανται παράλληλα όροι όπως «Χαρτογραφία με τη βοήθεια Ηλεκτρονικών υπολογιστών», «Αυτοματοποιημένη Χαρτογραφία» κ.ο.κ. Επισημαίνεται ότι ανεξάρτητα από τον όρο που υιοθετείται κάθε φορά, ο ανθρώπινος παράγοντας διαδραματίζει καταλυτικό ρόλο στη διαδικασία της σύνθεσης χαρτών, στο πλαίσιο του χαρτογραφικού συστήματος, στο βαθμό που τίποτε δεν γίνεται αυτόματα. Η δυναμική ανάπτυξη των τεχνολογιών του διαδικτύου επηρέασε επίσης τις διαδικασίες της σύνθεσης και απόδοσης χαρτών όπως και τη δυνατότητα αναζήτησης Γεωχωρικών δεδομένων από το διαδίκτυο, ζητήματα τα οποία πρέπει να γνωρίζουν σε επίπεδο παραγωγής οι σύγχρονοι χαρτογράφοι. 
Τα αίτια που προκάλεσαν τη στροφή προς την Ψηφιακή Χαρτογραφία, σχετίζονται με τη γενική παραδοχή των πλεονεκτημάτων που έχουν τα γεωχωρικά και χαρτογραφικά στοιχεία σε ψηφιακή μορφή. Ένα από τα κύρια αίτια αποτελεί το αυξανόμενο κόστος της παραδοσιακής χαρτογραφικής εργασίας σε αντίθεση με το συνεχώς μειούμενο κόστος των χαρτογραφικών συστημάτων. Οι συνεχώς βελτιούμενες μέθοδοι και η τεχνολογία για ψηφιοποίηση, έλεγχο και σχεδίαση χαρτών, σε συνδυασμό με την αυξανόμενη απαίτηση για στοιχεία σε ψηφιακή μορφή με σκοπό την επεξεργασία για χωρική ανάλυση και τη στατική ή δυναμική χαρτογραφική απόδοση, έδωσαν σημαντική ώθηση στην ενσωμάτωσή τους στη χαρτογραφική διαδικασία και πρακτική. Επισημαίνεται ότι η διαθεσιμότητα ελεγμένου και ολοκληρωμένου εμπορικού ή ανοικτού λογισμικού, συμβάλλει ουσιαστικά στην αντιμετώπιση των διαφόρων χαρτογραφικών προβλημάτων. Παράλληλα, η δυναμική ανάπτυξη των τεχνολογιών του διαδικτύου τόσο σε ό,τι αφορά το περιβάλλον χαρτογραφικής σύνθεσης όσο και την αναζήτηση των γεωχωρικών στοιχείων που είναι απαραίτητα για αυτήν, συμβάλλουν αποτελεσματικά στην εξέλιξη της Χαρτογραφίας και στη διάδοση των χαρτογραφικών προϊόντων.
Κύριο χαρακτηριστικό της Χαρτογραφίας σε ψηφιακό περιβάλλον, αποτελεί η επιτάχυνση του συνόλου των φάσεων που υπεισέρχονται στη χαρτογραφική διαδικασία. Φυσικά αυτό δεν συμβαίνει για τους πρώτους χάρτες που θα παραχθούν, γεγονός που οφείλεται στην αναγκαιότητα εξοικείωσης με το εκάστοτε χρησιμοποιούμενο σύστημα λογισμικού και στη δημιουργία της απαραίτητης υποδομής (προδιαγραφές, διαδικασίες και βιβλιοθήκες συμβόλων κ.ά.). Η ακρίβεια που επιτυγχάνεται στην απόδοση των χαρτογραφικών στοιχείων είναι θεωρητικά αυτή που προβλέπεται από τις προδιαγραφές του συστήματος και των περιφερειακών του. Ο παράγων αυτός, αν συνεντιμηθεί με τον παράγοντα σταθερότητας της ποιότητας παραγωγής, προσδίδει ιδιαίτερη υπεροχή στη νέα μεθοδολογία. Η σύνθεση χαρτών σε ψηφιακό περιβάλλον προσφέρει δυνατότητες πολλαπλής επιλογής του χαρτογραφικού προϊόντος σε επίπεδο σχεδιασμού. Ο χαρτοσυνθέτης δημιουργεί εναλλακτικές λύσεις σε χρόνο που είναι σημαντικά μικρότερος από τον απαιτούμενο για τη σύνθεση ενός χάρτη με την παραδοσιακή μεθοδολογία. Αναμφίβολα η σύνθεση χαρτών σε ψηφιακό περιβάλλον, προϋποθέτει την επένδυση μάλλον σημαντικών ποσών έως ότου υλοποιηθεί. Η αρχική επένδυση είναι  υψηλή και επιμερίζεται αναλογικά σε δαπάνες για εξοπλισμό και λογισμικό. Αυτό δεν πρέπει να αποτελέσει αποθαρρυντικό παράγοντα προς την κατεύθυνση της υλοποίησης ενός αναπτυξιακού προγράμματος, δεδομένων των θετικών επιπτώσεων στο παραγωγικό πρόγραμμα των χαρτογραφικών φορέων.
Το σύγγραμμα, στο πρώτο μέρος κάθε κεφαλαίου, παρέχει μια περιληπτική προσέγγιση του θεωρητικού υποβάθρου που απαιτείται για την πλήρη κατανόηση και σωστή εφαρμογή των οδηγιών υλοποίησης. Για τον λόγο αυτό, ο αναγνώστης θα πρέπει να έχει γνώσεις των αρχών της Χαρτογραφίας σε ό,τι αφορά τη σύνθεση τοπογραφικών και θεματικών χαρτών ανεξαρτήτως κλίμακας, τους βασικούς προβολικούς μετασχηματισμούς, τον μετασχηματισμό της γενίκευσης, τον σχεδιασμό και την αξιοποίηση βάσεων γεωχωρικών δεδομένων, τα στοιχεία ποιότητας των γεωχωρικών δεδομένων, τη διαδικασία δημιουργίας αναγλύφου και των παράγωγων προϊόντων, τον συμβολισμό των σημειακών, γραμμικών, επιφανειακών και τρισδιάστατων χωρικών οντοτήτων, τη μεθοδολογική προσέγγιση αναγραφής της ονοματολογίας και τις διαδικασίες παραγωγής και αναπαραγωγής των χαρτών. Παράλληλα ο αναγνώστης θα πρέπει να είναι εξοικειωμένος με την αλγοριθμική προσέγγιση των προβλημάτων και να έχει βασικές γνώσεις μιας από τις εν χρήσει γλώσσες προγραμματισμού όπως και των λειτουργιών του διαδικτύου.
Στο Κεφάλαιο 1 περιγράφεται ο «Σχεδιασμός και υλοποίηση βάσης χαρτογραφικών δεδομένων» με σκοπό την υποστήριξη της σύνθεσης ενός χάρτη. Η διαδικασία αυτή, η οποία αποτελεί υποχρεωτικό σημείο διάβασης για τη σύνθεση χάρτη σε ψηφιακό περιβάλλον, περιλαμβάνει αρχικά τη μελέτη και ανάλυση των χαρτών που θα χρησιμοποιηθούν ως πηγή, την επιλογή των πληροφοριών σε συνάρτηση με την κλίμακα και τον σκοπό του χάρτη ο οποίος θα συντεθεί και την ανάλυση του περιεχομένου του σε θεματικά επίπεδα. Ακολουθούν τα στάδια του εννοιολογικού, λογικού και φυσικού σχεδιασμού που περιλαμβάνονται στο σχεδιασμό κάθε είδους βάσης δεδομένων, προσαρμοσμένα στον σχεδιασμό μιας βάσης χαρτογραφικών δεδομένων. Η ολοκλήρωση αυτής της φάσης έχει αποτέλεσμα την επιλογή των θεματικών επιπέδων που θα εισαχθούν στη βάση, τον προσδιορισμό της γεωμετρίας που θα χρησιμοποιηθεί για την καταγραφή των στοιχείων κάθε θεματικού επιπέδου, τον προσδιορισμό των περιγραφικών χαρακτηριστικών κάθε θεματικού επιπέδου και την περιγραφή της μορφοποίησης και του πεδίου ορισμού των τιμών κάθε περιγραφικού χαρακτηριστικού.
Το Κεφάλαιο 2 «Γεωαναφορά» αναφέρεται στη διαδικασία της  γεωαναφοράς ή γεωγραφικής προσαρμογής, η οποία μετατρέπει το τοπικό σύστημα αναφοράς των συντεταγμένων του μέσου ψηφιοποίησης (π.χ. ψηφιοποιητή, οθόνης, σαρωτή) στο σύστημα απεικόνισης του εκάστοτε ψηφιοποιούμενου χάρτη. Η γεωαναφορά προηγείται της ψηφιακής καταγραφής και αποτελεί προϋπόθεση για τη σωστή καταγραφή, δεδομένου ότι προϊόν της συγκεκριμένης διαδικασίας είναι το αρχείο των συντεταγμένων των θέσεων των γεωχωρικών οντοτήτων, οι οποίες θα ενταχθούν στη βάση δεδομένων. Μέσω της διαδικασίας της γεωαναφοράς συνορθώνονται οι παραμορφώσεις, οι οποίες οφείλονται στις εγγενείς ιδιότητες του υλικού (χαρτιού) εκτύπωσης των χαρτών από μεταβολές της θερμοκρασίας και υγρασίας, αλλά και από τον τρόπο αναπαραγωγής τους. Για τον σκοπό αυτό, χρησιμοποιείται κυρίως ο ομοπαράλληλος (Affine) ή άλλος μετασχηματισμός, ανάλογα με την κατάσταση του χάρτη-πηγή. Αντικείμενο του κεφαλαίου αυτού, πέραν του μετασχηματισμού, είναι και ο τρόπος επιλογής του πλήθους και των θέσεων των σημείων γεωγραφικής προσαρμογής, η ερμηνεία των συντελεστών του μετασχηματισμού, η κριτική αξιολόγηση του αποτελέσματος μέσω του σφάλματος του μετασχηματισμού και τα αποδεκτά όρια.
Στο Κεφάλαιο 3 «Ψηφιακή καταγραφή χωρικών οντοτήτων» παρουσιάζονται οι μέθοδοι που αφορούν την ψηφιακή καταγραφή χωρικών οντοτήτων, οι οποίες προέρχονται από αναλογικές πηγές. Πρόκειται για τις μεθόδους της χειροκίνητης ψηφιοποίησης, της σάρωσης και της αυτόματης και ημιαυτόματης διανυσματοποίησης. Η επιλογή της κατάλληλης μεθόδου γίνεται με βάση τόσο το περιεχόμενο της αναλογικής πηγής, όσο και το είδος των οντοτήτων. Η ψηφιακή καταγραφή, παρά το ότι αποτελεί μια χρονοβόρα και επίπονη διαδικασία, είναι σημαντική διότι παρέχει τα απαραίτητα για τη χαρτοσύνθεση στοιχεία τα οποία θα αποτελέσουν μέρος της βάσης δεδομένων. Το αποτέλεσμα της ψηφιακής καταγραφής, αποθηκεύεται στη βάση δεδομένων σύμφωνα με τη δομή που προέκυψε από τον σχεδιασμό της βάσης και στο σύστημα συντεταγμένων που ορίστηκε στη φάση της γεωγραφικής προσαρμογής.
Στο Κεφάλαιο 4 «Αναζήτηση και χρήση γεωγραφικών δεδομένων από άλλες πηγές» γίνεται αναφορά στα γεωχωρικά δεδομένα, τα οποία δεν συλλέγονται από τον ίδιο τον χρήστη κατά τη δημιουργία της βάσης χαρτογραφικών δεδομένων, αλλά ενδέχεται να ληφθούν από άλλες πηγές συμπεριλαμβανομένης και αυτής του διαδικτύου. Συχνά, τα γεωχωρικά δεδομένα από άλλες πηγές διατίθενται σε κάποιο ουδέτερο μορφότυπο π.χ. αρχεία shapefile ή στο πλαίσιο υπηρεσιών που παρέχονται από διαδικτυακούς εξυπηρετητές χωρικών δεδομένων π.χ. ορθοφωτοχάρτης από την ΕΚΧΑ Α.Ε. Στη συνέχεια, αναλύεται η μεθοδολογία με την οποία τα δεδομένα αυτά μπορούν να αξιοποιηθούν ή να ενσωματωθούν στη βάση χαρτογραφικών δεδομένων. Ιδιαίτερη αναφορά γίνεται στον εντοπισμό και στην αντιμετώπιση τυχόν προβλημάτων π.χ. καταλληλότητα, ποιότητα, ασυμφωνία συστήματος αναφοράς συντεταγμένων, χωρικές ασυμβατότητες κ.ά. 
Στο Κεφάλαιο 5 «Έλεγχος ποιότητας χωρικών δεδομένων» αναδεικνύεται το γεγονός ότι η ποιότητα των δεδομένων, τα οποία θα χρησιμοποιηθούν στη χαρτοσύνθεση, αποτελεί σημαντικό παράγοντα για την αξιοπιστία του χάρτη. Ως εκ τούτου, θα πρέπει να διασφαλιστεί ότι τα δεδομένα που θα χρησιμοποιηθούν είναι απαλλαγμένα –κατά το δυνατόν– από σφάλματα γεωμετρίας και περιγραφικών χαρακτηριστικών και ότι διατηρούν τις μεταξύ τους τοπολογικές σχέσεις. Στο κεφάλαιο αυτό, περιγράφεται η διαδικασία ελέγχου της ποιότητας των δεδομένων που συλλέχθηκαν κατά την ψηφιακή καταγραφή, μέσω εξέτασης της πληρότητας των τιμών, της συμβατότητας της μορφοποίησης και της ανασύστασης των τοπολογικών σχέσεων που ενυπάρχουν στο χάρτη και αναγνωρίζονται κατά την ανάγνωσή του. Η αδυναμία ικανοποίησης των σχέσεων αυτών, οδηγεί στον εντοπισμό των σφαλμάτων της γεωμετρίας. Ο έλεγχος των τοπολογικών σχέσεων υλοποιείται με κανόνες που περιγράφουν τη συμπεριφορά των χωρικών στοιχείων προς άλληλα και επιτρέπουν την καταγραφή των μεταξύ τους χωρικών σχέσεων. Περιγράφεται η διαδικασία επιλογής των τοπολογικών κανόνων που θα εφαρμοστούν ανάλογα με τη φύση των θεματικών επιπέδων και τον σκοπό της βάσης χαρτογραφικών δεδομένων. Αποτέλεσμα αυτής της φάσης είναι χαρτογραφικά στοιχεία ελεγμένης ποιότητας, τα οποία θα χρησιμοποιηθούν για τη χαρτοσύνθεση.
Στο Κεφάλαιο 6 «Αλλαγή συστήματος αναφοράς των συντεταγμένων» περιγράφεται η διαδικασία αλλαγής του συστήματος αναφοράς των συντεταγμένων των γεωχωρικών δεδομένων. Ο μετασχηματισμός αυτός μπορεί να χρησιμοποιηθεί για τη συνδυασμένη αξιοποίηση των θεματικών δεδομένων που υπάρχουν καταχωρισμένα στη βάση χαρτογραφικών δεδομένων και χρησιμοποιούν ένα συγκεκριμένο σύστημα αναφοράς, π.χ. το ΕΓΣΑ’87, με γεωχωρικά δεδομένα από άλλες πηγές, όπως δεδομένα GPS, δεδομένα από ναυτικούς χάρτες κ.ά. που χρησιμοποιούν διαφορετική χαρτογραφική προβολή ή και σύστημα αναφοράς. Επίσης, για τη χαρτογραφική απόδοση στη βέλτιστη χαρτογραφική προβολή η οποία αρμόζει με τον σκοπό, τη μορφή της χαρτογραφούμενης περιοχής και την κλίμακα του χάρτη.
Το Κεφάλαιο 7 «Ψηφιακό Μοντέλο Εδάφους» παρουσιάζει τη δυνατότητα δημιουργίας Ψηφιακού Μοντέλου Εδάφους – ΨΜΕ, αλλά και άλλων φαινομένων (θερμοκρασίας, βροχόπτωσης, κατανομής πληθυσμού) από περιορισμένο αριθμό μετρήσεων. Η δυνατότητα αυτή, αποτελεί σημαντική συμβολή της τεχνολογίας στη Γεωπληροφορική και κατ’ επέκταση στη χαρτοσύνθεση. Στο κεφάλαιο αυτό, αναλύεται η δημιουργία του ψηφιακού μοντέλου εδάφους - με αξιοποίηση των θεματικών επιπέδων πληροφορίας που συνδέονται με αυτό όπως: ισοϋψείς καμπύλες, σημεία γνωστού υψομέτρου, υδρολογικό δίκτυο, ακτογραμμή κ.ά. Περιγράφεται η δημιουργία του ΨΜΕ τόσο με τη μέθοδο του δικτύου ακανόνιστων τριγώνων (ΤΙΝ), όσο και με αλγορίθμους που βασίζονται στη δομή κανάβου. Επισημαίνεται ότι η διαδικασία που παρουσιάζεται, έχει εφαρμογή στο σύνολο σχεδόν των φαινομένων που παρουσιάζουν συνεχή κατανομή. Επιλέχτηκε να δοθεί έμφαση στη δημιουργία του ψηφιακού μοντέλου εδάφους, λόγω του μεγάλου αριθμού εφαρμογών οι οποίες σχετίζονται τόσο με το μοντέλο αυτό καθαυτό, όσο και με τα παράγωγα από αυτό μεγέθη. Αναλύονται ζητήματα όπως: η αξιοποίηση του κάθε θεματικού επίπεδου κατά τη δημιουργία του ΨΜΕ, ο έλεγχος της αξιοπιστίας του ΨΜΕ μέσω συγκεκριμένων τεχνικών (εντοπισμός επιπέδων τριγώνων, σύγκριση μεταξύ αρχικών και παράγωγων ισοϋψών, προσδιορισμός χονδροειδών σφαλμάτων στα αρχικά δεδομένα,  προσδιορισμός του μέσου τετραγωνικού σφάλματος του μοντέλου, συμφωνία με το εύρος τιμών των υψομέτρων κ.ά.), η σύγκριση των δύο δομών καταγραφής του ΨΜΕ και η οπτικοποίηση του ΨΜΕ μέσω σκίασης, ισοϋψών καμπυλών και υψομετρικών ζωνών. 
Στο Κεφάλαιο 8 «Υδρολογική ανάλυση με βάση το ΨΜΕ» παρουσιάζεται ένα τυπικό παράδειγμα αξιοποίησης του Ψηφιακού Μοντέλου Εδάφους στο γνωστικό αντικείμενο των Υδατικών Πόρων, με τη βοήθεια της τεχνολογίας των Συστημάτων Γεωγραφικών Πληροφοριών. Αναλύονται τα θέματα που αφορούν τον προσδιορισμό των κανάβων διεύθυνσης απορροής και συγκεντρωτικής ροής, καθώς και τον προσδιορισμό της λεκάνης απορροής και του υδρογραφικού δικτύου. Γίνεται αναφορά στις μεθόδους ιεράρχησης των κλάδων του υδρογραφικού δικτύου και στον υπολογισμό παράγωγων μετρητικών στοιχείων των υδρογραφικών σχηματισμών που προέκυψαν από το ΨΜΕ όπως: εμβαδόν, μέσο υψόμετρο, κλίσεις της λεκάνης απορροής και μήκος, μήκος ανά τάξη, μέση κλίση κυρίου κλάδου, μηκοτομή κυρίου κλάδου, διατομές σε χαρακτηριστικές θέσεις του υδρογραφικού δικτύου κ.ά. 
Το Κεφάλαιο 9 «Χαρτογραφική Γενίκευση» πραγματεύεται τη γενίκευση που αποτελεί ίσως τον πλέον σημαντικό μετασχηματισμό στη χαρτογραφία κυρίως λόγω του ότι η κλίμακα του υπό σύνθεση χάρτη είναι μικρότερη αυτής των χαρτογραφικών στοιχείων που έχουν καταχωριστεί στη βάση δεδομένων. Ως εκ τούτου η γενίκευση προηγείται της χαρτογραφικής απόδοσης. Στο πλαίσιο του συγκεκριμένου κεφαλαίου περιγράφεται η γενίκευση των θεματικών επιπέδων και διατυπώνονται προτάσεις για την εφαρμογή συγκεκριμένων τελεστών γενίκευσης. Γίνεται αναλυτική παρουσίαση και εφαρμογή της γενίκευσης των γραμμικών δεδομένων, της «Αρχής της Επιλογής» και τέλος των μεθόδων αναλυτικής εκτίμησης των αποτελεσμάτων της γενίκευσης των γραμμικών δεδομένων. 
Στο Κεφάλαιο 10 «Σύνθεση χάρτη σε ψηφιακό περιβάλλον» παρουσιάζεται η διαδικασία που ακολουθείται για τη σύνθεση και την απόδοση του χάρτη σε ψηφιακό περιβάλλον. Αποτελεί τον πυρήνα του βιβλίου όπως προκύπτει και από τον τίτλο του. Λόγω του εύρους των εξειδικευμένων γνώσεων που απαιτούνται για τη σύνθεση και την απόδοση του χάρτη, παρουσιάζονται επιγραμματικά τα πλέον ουσιαστικά στοιχεία που δομούν το γνωστικό υπόβαθρο που απαιτείται για την υλοποίηση της συγκεκριμένης φάσης της χαρτογραφικής διαδικασίας. Έτσι, γίνεται αναφορά στις αρχές και στους στόχους της χαρτογραφικής σχεδίασης, στις φάσεις της σύνθεσης του χάρτη, στον ρόλο και στον τρόπο ανάλυσης των δεδομένων με σκοπό την εκχώρηση των κατάλληλων συμβόλων κατά την απόδοση και τον σχεδιασμό των συμβόλων, και τέλος στη χρήση του χρώματος και στην απόδοση της ονοματολογίας. 
Στο Κεφάλαιο 11 «Δημιουργία υλικού αναπαραγωγής σε ψηφιακό περιβάλλον» περιγράφεται η διαδικασία δημιουργίας του υλικού αναπαραγωγής ενός χάρτη που έχει συντεθεί με ψηφιακές μεθόδους και πρόκειται να αναπαραχτεί σε πολλά αντίτυπα με τη διαδικασία offset. Καθώς πρόκειται για το ενδιάμεσο στάδιο μεταξύ της παραγωγής (σύνθεσης) και της αναπαραγωγής του χάρτη, παρουσιάζεται το αντικείμενο της διαχείρισης του χρώματος για τα ψηφιακά προϊόντα που πρόκειται να διατεθούν είτε σε ψηφιακή είτε σε αναλογική (έντυπη) μορφή. Τέλος, παρουσιάζονται τα χαρακτηριστικά και η διαδικασία δημιουργίας των αρχείων της τετραχρωμίας (CMYK), η οποία απαιτείται για την κατασκευή των πλακών εκτύπωσης σε offset.
Στο Κεφάλαιο 12 παρουσιάζεται η «Δημοσιοποίηση χαρτών και χαρτογραφικών δεδομένων στο διαδίκτυο». Λόγω της ευρείας χρήσης του διαδικτύου και της παρατηρούμενης τάσης της κοινωνίας των χρηστών για άμεση πρόσβαση σε χάρτες με ηλεκτρονική μορφή, κρίθηκε σκόπιμη η κάλυψη του αντικειμένου της δημοσιοποίησης χαρτογραφικών δεδομένων και χαρτών στο διαδίκτυο. Για προφανείς λόγους, η δημοσιοποίηση πρέπει να στηρίζεται σε διεθνώς αποδεκτά πρότυπα. Για τον λόγο αυτό, παρουσιάζονται τα πρότυπα του Open Geospatial Consortium (OGC) για τη δημοσιοποίηση χαρτογραφικών δεδομένων και χαρτών στο διαδίκτυο, όπως  Web Map Service (WMS) και  Web Feature Service (WFS). Στη συνέχεια περιγράφεται η διαδικασία συγκρότησης ενός εξυπηρετητή δημοσιοποίησης χαρτογραφικών δεδομένων και χαρτών, ο οποίος ακολουθεί τα παραπάνω πρότυπα. Ακολουθεί η ανάλυση θεμάτων όπως:  επιλογή του κατάλληλου προτύπου, δημοσιοποίηση ενός χάρτη, δημοσιοποίηση χαρτογραφικών δεδομένων, ορισμός των δυνατοτήτων παρέμβασης του χρήστη, σύνδεση του εξυπηρετητή με τα θεματικά επίπεδα κ.ά.
Στο Κεφάλαιο 13 παρουσιάζεται η «Σύνθεση χάρτη σε περιβάλλον διαδικτύου». Ενώ είναι πρακτικά δυνατή η δημοσιοποίηση υφιστάμενων χαρτών στο διαδίκτυο, όπως περιγράφεται στο προηγούμενο κεφάλαιο, η καθαυτή σύνθεση διαφέρει από αυτήν που ακολουθείται στους χάρτες που συντίθενται ψηφιακά αλλά προορίζονται για εκτύπωση σε χαρτί, λόγω των ιδιαιτεροτήτων του περιβάλλοντος απόδοσης. Για την κάλυψη της συγκεκριμένης απαίτησης, στο κεφάλαιο αυτό περιγράφεται η σύνθεση  χάρτη που προορίζεται για απόδοση στο διαδίκτυο. Παρουσιάζονται οι παράγοντες οι οποίοι επηρεάζουν το αποτέλεσμα καθώς και μια σειρά καλών πρακτικών για την υλοποίηση της χαρτοσύνθεσης. Ακολουθεί συνοπτική περιγραφή του προτύπου Styled Layer Descriptor (SLD) του OGC, το οποίο χρησιμοποιείται για την περιγραφή του συμβολισμού. Παρουσιάζεται η δημιουργία του συμβολισμού για ένα θεματικό επίπεδο με το ΣΓΠ QGIS και η αποθήκευσή του σε αρχεία με βάση το πρότυπο SLD. Επιπλέον, περιγράφεται η ενσωμάτωσή τους στον Geoserver και η δημιουργία Style, η σύνδεση του συμβολισμού με ένα δημοσιοποιημένο θεματικό επίπεδο και η σύνθεση του χάρτη ως συνόλου θεματικών επιπέδων που αποδίδονται με συγκεκριμένη ιεράρχηση.
Το σύγγραμμα συμπληρώνεται με δύο παραρτήματα: το ΠΑΡΑΡΤΗΜΑ A «Εισαγωγή στο QGIS» και το ΠΑΡΑΡΤΗΜΑ Β «Εισαγωγή στο ArcGIS», τα οποία παρέχουν τις βασικές γνώσεις που απαιτούνται για την αξιοποίηση του αντίστοιχου περιβάλλοντος λογισμικού.
Κεφάλαιο 1 
Σχεδιασμός και υλοποίηση βάσης χαρτογραφικών δεδομένων
Σύνοψη 
Στο κεφάλαιο αυτό περιγράφεται η διαδικασία σχεδιασμού και υλοποίησης μιας βάσης χαρτογραφικών δεδομένων, με σκοπό την υποστήριξη της σύνθεσης του χάρτη. Η διαδικασία αυτή περιλαμβάνει, αρχικά, τη μελέτη και ανάλυση των χαρτών που θα χρησιμοποιηθούν ως πηγή, την επιλογή των πληροφοριών σε συνάρτηση με την κλίμακα και τον σκοπό του χάρτη και την ανάλυση του περιεχομένου σε θεματικά επίπεδα. Στη συνέχεια, παρουσιάζονται τα στάδια του εννοιολογικού, λογικού και φυσικού σχεδιασμού που περιλαμβάνονται στο σχεδιασμό βάσεων δεδομένων προσαρμοσμένα στο σχεδιασμό μιας βάσης χαρτογραφικών δεδομένων. Η ολοκλήρωση αυτής της φάσης έχει αποτέλεσμα την επιλογή των θεματικών επιπέδων που θα εισαχθούν στη βάση, τον προσδιορισμό της γεωμετρίας που θα χρησιμοποιηθεί για την καταγραφή των στοιχείων κάθε θεματικού επιπέδου, τον προσδιορισμό των περιγραφικών χαρακτηριστικών κάθε θεματικού επιπέδου και τον προσδιορισμό της μορφοποίησης και του πεδίου ορισμού κάθε περιγραφικού χαρακτηριστικού. Παράλληλα, παρατίθεται λεπτομερής περιγραφή για την υλοποίηση της βάσης χαρτογραφικών δεδομένων στο Σύστημα Διαχείρισης Βάσεων Δεδομένων PostgreSQL/PostGIS σε συνδυασμό με το Σύστημα Γεωγραφικών Πληροφοριών QGIS και στο περιβάλλον του Συστήματος Γεωγραφικών Πληροφοριών ArcGIS.
 
Προαπαιτούμενη γνώση
Γενική γνώση για τα Συστήματα Διαχείρισης Βάσεων Δεδομένων (ΣΔΒΜ), Ανάγνωση του χάρτη.
 
1. Βάση χαρτογραφικών δεδομένων
 
Η εύρεση και η οργάνωση των κατάλληλων χαρτογραφικών δεδομένων αποτελούν θεμέλιο λίθο της δημιουργίας ενός χάρτη. Επομένως, στο πρώτο κεφάλαιο αναπτύσσεται η διαδικασία σχεδιασμού και υλοποίησης μιας βάσης χαρτογραφικών δεδομένων που έχει σκοπό την υποστήριξη της σύνθεσης ενός χάρτη (NCGIA, 1997a; NCGIA, 1997b; NCGIA, 1997c).
Ο πραγματικός κόσμος είναι πολύπλοκος για την άμεση και πλήρη κατανόησή μας. Τα στελέχη της Γεωπληροφορικής ανάλογα με τα ιδιαίτερα ενδιαφέροντα και το αντικείμενο μελέτης τους, δημιουργούν μοντέλα της πραγματικότητας που συνιστούν το ψηφιακό ομοίωμα του πραγματικού κόσμου και περιλαμβάνουν τις χωρικές οντότητες και τα χαρακτηριστικά που τους ενδιαφέρουν. Τα μοντέλα αυτά αποτελούν βασικά στοιχεία κατανόησης της γεωγραφικής πραγματικότητας. Ο χάρτης αποτελεί ένα βασικό αναλογικό μοντέλο καταγραφής της γεωγραφικής πραγματικότητας που χρησιμοποιείται από εξειδικευμένους και μη χρήστες. Η τεχνολογική επανάσταση της επιστήμης της πληροφορικής των τελευταίων δεκαετιών καλεί τους επιστήμονες να μεταφέρουν τα αναλογικά μοντέλα στο ψηφιακό περιβάλλον. Επομένως, η ανάγκη για την ψηφιακή καταγραφή και επεξεργασία των στοιχείων του χώρου συνδέεται με την οργάνωσή τους σε βάσεις δεδομένων σχεδιασμένες κατάλληλα για να αναπαριστούν τα χαρακτηριστικά των χωρικών φαινομένων (Εικόνα 1.1). Η βάση δεδομένων ενδέχεται να περιέχει δεδομένα που καλύπτουν πολλές κλίμακες και χρονικές περιόδους γεγονός που θέτει επιπλέον απαιτήσεις στον σχεδιασμό.
Η εξέλιξη της τεχνολογίας των βάσεων δεδομένων επιτρέπει τη χρήση τους για την οργανωμένη αποθήκευση και διαχείριση γεωχωρικών δεδομένων, καθώς παρέχεται η δυνατότητα εκχώρησης ειδικού πεδίου για την καταγραφή της γεωμετρίας. Η οργάνωση των γεωχωρικών δεδομένων σε ενιαία βάση δεδομένων, θεωρείται ότι πλεονεκτεί σε σχέση με τη χρήση μεμονωμένων διανυσματικών ή κανονικοποιημένων αρχείων που συσχετίζονται με τα αρχεία των αντίστοιχων περιγραφικών χαρακτηριστικών. Βασικά πλεονεκτήματα της χρήσης ενιαίας βάσης χωρικών δεδομένων αποτελούν η κεντρική οργάνωση του συνόλου των δεδομένων, η σύνδεση των χωρικών δεδομένων με άλλα μη χωρικά δεδομένα, η αξιοποίηση των εργαλείων διαχείρισης και συντήρησης κάθε βάσης δεδομένων, π.χ. η δυνατότητα επεξεργασίας από πολλούς χρήστες, η δημιουργία αντιγράφων ασφαλείας, οι έλεγχοι ακεραιότητας, η ασφάλεια, τα ισχυρά εργαλεία χωρικών ευρετηρίων και χωρικών ερωτήσεων, ο έλεγχος και η βελτίωση της ποιότητας κ.ά. 
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Εικόνα 1.1 Πραγματικότητα, χάρτης, θεματικά επίπεδα και βάση χαρτογραφικών δεδομένων.
1.1 Χάρτης και θεματικά επίπεδα
 
Η οργάνωση του χάρτη ως μοντέλου της πραγματικότητας βασίζεται στα θεματικά επίπεδα (layers) των πληροφοριών που περιέχει. Ως θεματικό επίπεδο ορίζεται ένα σύνολο γεωχωρικών δεδομένων που περιγράφουν χωρικές οντότητες που εντάσσονται στο ίδιο γεωμετρικό αρχέτυπο (σημείο, γραμμή, πολύγωνο), έχουν τα ίδια περιγραφικά χαρακτηριστικά και, φυσικά, αφορούν το ίδιο γεωγραφικό φαινόμενο. 
Η διαδικασία του σχεδιασμού της βάσης χαρτογραφικών δεδομένων ξεκινά με τη μελέτη και ανάλυση των χαρτών που θα χρησιμοποιηθούν ως πηγές, την επιλογή των πληροφοριών σε συνάρτηση με την κλίμακα και τον σκοπό του χάρτη και την ανάλυση του περιεχομένου τους σε θεματικά επίπεδα. Η ανάλυση των θεματικών επιπέδων καθορίζει το περιεχόμενο και τον βαθμό πληρότητας της Βάσης Δεδομένων. Βασικές δεξιότητες για τον επιτυχή σχεδιασμό είναι η αναγνώριση των θεματικών επιπέδων (με βάση τον χάρτη και το αντίστοιχο υπόμνημα), ο προσδιορισμός του γεωμετρικού αρχετύπου στο οποίο θα ενταχθούν (σημεία, γραμμές, πολύγωνα) και των περιγραφικών χαρακτηριστικών που καταγράφονται για κάθε θεματικό επίπεδο, βάσει του συμβολισμού που χρησιμοποιείται στο χάρτη πηγή. 
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Εικόνα 1.2 Στάδια της διαδικασίας σχεδιασμού της βάσης χαρτογραφικών δεδομένων.
1.2 Στάδια σχεδιασμού της βάσης χαρτογραφικών δεδομένων
 
Ο σχεδιασμός κάθε βάσης δεδομένων περιλαμβάνει τα στάδια του εννοιολογικού σχεδιασμού, του λογικού σχεδιασμού και του φυσικού σχεδιασμού (Tσούλος, 2008). Πρόκειται για μια αφαιρετική διαδικασία από την πραγματικότητα, όπως την αντιλαμβάνεται ο άνθρωπος (π.χ. μέσω του χάρτη), σε ένα μοντέλο που καταγράφεται σε περιβάλλον Η/Υ (Εικόνα 1.2).
1.2.1 Εννοιολογικός σχεδιασμός
 
Ο εννοιολογικός σχεδιασμός συνίσταται στον προσδιορισμό του περιεχομένου (χωρικών οντοτήτων) της βάσης δεδομένων, των περιγραφικών τους χαρακτηριστικών και των σχέσεων μεταξύ τους (Tσούλος, 2008). Στην περίπτωση της βάσης χαρτογραφικών δεδομένων, ο εννοιολογικός σχεδιασμός προϋποθέτει την απάντηση στα ακόλουθα ερωτήματα:
 
	Ποιο είναι το εύρος κλιμάκων που θα καλύπτει η βάση δεδομένων; 
	Ποιο είναι το σύστημα αναφοράς που θα χρησιμοποιηθεί για την καταγραφή της γεωμετρίας; Π.χ. για εφαρμογές του ελλαδικού χώρου χρησιμοποιείται το Ελληνικό Γεωδαιτικό Σύστημα Αναφοράς (ΕΓΣΑ ’87).
	Ποιες οντότητες (φυσικές και εννοιολογικές, χωρικές ή μη) – θεματικά επίπεδα θα περιλαμβάνει η βάση; Π.χ. σε μια εφαρμογή κτηματολογίου στη βάση δεδομένων θα καταγραφεί η φυσική οντότητα του γεωτεμαχίου (χωρική), η φυσική οντότητα του ιδιοκτήτη (μη χωρική), η εννοιολογική οντότητα του εμπράγματου δικαιώματος κ.ά.
	Ποιο γεωμετρικό αρχέτυπο (σημείο, γραμμή ή πολύγωνο) θα χρησιμοποιηθεί για να καταγραφούν οι χωρικές οντότητες που περιλαμβάνονται σε κάθε θεματικό επίπεδο; Π.χ. το γεωτεμάχιο καταγράφεται ως πολύγωνο, η οικοδομική γραμμή ως γραμμή. Συχνά, η επιλογή του γεωμετρικού αρχετύπου για μια οντότητα εξαρτάται από το μέγεθος της οντότητας, από την κλίμακα του χάρτη που χρησιμοποιείται ως πηγή αλλά και την κλίμακα που χαρακτηρίζει τη χωρική βάση δεδομένων π.χ. ο οικισμός θα καταγραφεί με σημείο ή πολύγωνο, το ποτάμι θα καταγραφεί με γραμμή ή πολύγωνο κ.ά.
	Ποιες είναι οι περιγραφικές ιδιότητες των οντοτήτων; Π.χ. τα υψομετρικά σημεία συνοδεύονται από την περιγραφική ιδιότητα του υψομέτρου.
	Ποια είναι τα αποδεκτά πεδία ορισμού των τιμών των περιγραφικών ιδιοτήτων; Π.χ. το υψόμετρο παίρνει τιμές από 0 έως 1475 βάσει του αναγλύφου της περιοχής μελέτης. Επιτρέπεται η μη αναγραφή τιμών σε ορισμένες εγγραφές; Π.χ. οι εκκλησίες ενός χάρτη ενδέχεται να μην έχουν όλες όνομα, ενώ το όνομα για τους οικισμούς είναι απαραίτητο.
	Ποιες είναι οι σχέσεις ανάμεσα σε διαφορετικές οντότητες; Π.χ. Μια ιδιοκτησία μπορεί να έχει Ν ιδιοκτήτες (σχέση 1-Ν), τα όρια των γεωτεμαχίων και των Ο.Τ. πρέπει να ταυτίζονται.
	Ποιους περιορισμούς πρέπει να ικανοποιούν οι οντότητες; Π.χ. Τα ρέματα έχουν κατεύθυνση από τα υψηλότερα προς τα χαμηλότερα υψόμετρα, δυο γεωτεμάχια δεν πρέπει να τέμνονται κ.ά.

 
Συνοπτικά ο εννοιολογικός σχεδιασμός καλύπτει τα ακόλουθα θέματα: την επιλογή των θεματικών επιπέδων, το είδος της γεωμετρίας των οντοτήτων που εντάσσονται στο κάθε θεματικό επίπεδο, τις ιδιότητες, τα πεδία ορισμού των ιδιοτήτων (Εικόνα 1.3) και τον προσδιορισμό των σχέσεων μεταξύ των οντοτήτων. Αποτέλεσμα του εννοιολογικού σχεδιασμού είναι η δημιουργία του μοντέλου Οντοτήτων-Συσχετίσεων. Οι σχέσεις που υπάρχουν ανάμεσα στις οντότητες της βάσης πρέπει να εκφραστούν στο στάδιο αυτό με συσχετίσεις ανάμεσα στους πίνακες π.χ. του χωρικού πίνακα των αγροτεμαχίων με τον πίνακα των ιδιοκτητών. Αν όμως στη βάση υπάρχουν μόνο χωρικές οντότητες που προκύπτουν από τα θεματικά επίπεδα, οι σχέσεις που υπάρχουν μεταξύ τους είναι χωρικές π.χ. τα όρια των γεωτεμαχίων και των Ο.Τ. πρέπει να είναι κοινά. Αυτές οι χωρικές σχέσεις θα καλυφθούν με άλλες διαδικασίες όπως είναι ο έλεγχος των τοπολογικών σχέσεων οι οποίες θα αναλυθούν σε επόμενα κεφάλαια (βλ. Κεφάλαιο 6).
Με αφετηρία ένα χάρτη κλίμακας 1:150.000 (Εικόνα 1.3) και το υπόμνημά του, η διαδικασία του εννοιολογικού σχεδιασμού οδηγεί στις πληροφορίες που συνοψίζονται στον Πίνακα 1.1.
1.2.2 Λογικός σχεδιασμός
 
Στο επόμενο στάδιο, αυτό του λογικού σχεδιασμού, το εννοιολογικό μοντέλο μεταφράζεται στο λογικό μοντέλο χρησιμοποιώντας ένα πρότυπο οργάνωσης βάσης δεδομένων π.χ. σχεσιακό, αντικειμενοστραφές, σχεσιακό – αντικειμενοστραφές. Αυτό το πρότυπο οργάνωσης θα πρέπει να υποστηρίζεται από το Σύστημα Διαχείρισης Βάσεων Δεδομένων (ΣΔΒΔ) που έχει επιλεχτεί για χρήση στο στάδιο του φυσικού σχεδιασμού. Η απεικόνιση του εννοιολογικού σχήματος στο λογικό σχήμα γίνεται με την εφαρμογή μιας σειράς κανόνων – βημάτων όπως η ανάλυση των σύνθετων ιδιοτήτων σε στοιχειώδεις, η επιλογή του πεδίου που θα είναι το πρωτεύον κλειδί σε μια σχέση, η απεικόνιση κάθε τύπου συσχετίσεων κ.ά., όπως προβλέπεται από τη θεωρία των βάσεων δεδομένων (Στεφανάκης, 2003). 
Το στάδιο αυτό δεν είναι ιδιαίτερα απαιτητικό στην περίπτωση της βάσης χαρτογραφικών δεδομένων λόγω της απλότητας των σχέσεων μεταξύ των οντοτήτων. Επανεξετάζεται η λίστα των θεματικών επιπέδων ως προς τις χωρικές οντότητες που καταγράφουν και εντοπίζονται τυχόν συγγένειες και ομοιότητες που μπορούν να οδηγήσουν σε συγχωνεύσεις ως προς τις χωρικές οντότητες και τους χωρικούς πίνακες που θα δημιουργηθούν.
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Εικόνα 1.3 Αναγνώριση θεματικών επιπέδων και των χαρακτηριστικών τους.
 
 
 		Θεματικό επίπεδο
	Γεωμετρία
	Ιδιότητες
	Πεδίο ορισμού

	1
	Ακτογραμμή
	γραμμή
	Υψόμετρο
	0

	2
	Ισοϋψής
	γραμμή
	Υψόμετρο
	50, 100, 150, …,750,800, …,950

	3
	Οδικό δίκτυο
	γραμμή
	Κατηγορία
	Επαρχιακή οδός, Αγροτική οδός

	4
	Οικισμός
	σημειακό
	Όνομα
	
	5
	Πρωτεύουσα
	σημειακό
	Όνομα
	
	6
	Υψομετρικό σημείο
	σημειακό
	Υψόμετρο
	1 - 997

	7
	Τριγωνομετρικό σημείο
	σημειακό
	Υψόμετρο
	1 – 997

	8
	Ρέμα
	γραμμή
		
	9
	Ποτάμι
	γραμμή
	Όνομα
	
	10
	Εκκλησία
	σημειακό
	Όνομα
	
	11
	Μονή
	σημειακό
	Όνομα
	
	12
	Μνημείο
	σημειακό
		
	13
	Παραλία
	σημειακό
		

Πίνακας 1.1 Αποτέλεσμα του εννοιολογικού σχεδιασμού.
Για παράδειγμα, από τον κατάλογο των θεματικών επιπέδων που εντοπίστηκαν (Πίνακας 1.1), παρατηρείται ότι τα θεματικά επίπεδα «υψομετρικό σημείο» και «τριγωνομετρικό σημείο» περιγράφουν το ίδιο γεωγραφικό φαινόμενο αυτό του αναγλύφου κι έχουν κοινή γεωμετρία και ιδιότητες. Για τον λόγο αυτό, είναι σκόπιμη η ενσωμάτωσή τους σε μια γεωγραφική οντότητα που θα καλείται «Σημείο γνωστού υψομέτρου», θα χρησιμοποιεί σημειακή γεωμετρία και θα περιλαμβάνει τα περιγραφικά χαρακτηριστικά «υψόμετρο» και «είδος», το οποίο θα λαμβάνει τις τιμές «υψομετρικό σημείο» ή «τριγωνομετρικό σημείο». Με την πρόβλεψη του πεδίου «είδος», δεν χάνεται η διαφοροποίηση των σημείων σε τριγωνομετρικό σημείο ή υψομετρικό σημείο. Τα σημεία διαφέρουν σε ορισμένα ιδιαίτερα χαρακτηριστικά όπως εάν είναι υλοποιημένα ή όχι, την ακρίβεια προσδιορισμού του υψομέτρου, τον τρόπο συμβολισμού κ.ά. Ανάλογα διαχειρίζονται τα θεματικά επίπεδα Ερημοκλήσι, Εκκλησία και Μονή καθώς και Παραλία, Μνημείο, Εργοστάσιο. Τα αποτελέσματα του λογικού σχεδιασμού συνοψίζονται στον  πίνακα που ακολουθεί (Πίνακας 1.2).
 
 
 	 
	Γεωγραφική οντότητα 
	Γεωμετρία 
	Ιδιότητες 
	Πεδίο ορισμού

	1
	Ακτογραμμή
	γραμμή 
	Υψόμετρο
	0

	2
	Ισοϋψής
	γραμμή 
	Υψόμετρο
	50, 100, 150, …,750, 800, …, 950

	3
	Υδρολογικό Δίκτυο
	γραμμή 
	Όνομα
	
				Είδος
	Ρέμα, Ποτάμι

	4
	Οδικό δίκτυο
	γραμμή 
	Κατηγορία
	Επαρχιακή οδός, Αγροτική οδός

	5
	Οικισμός
	σημειακό
	Όνομα
	 

				Είδος
	Πρωτεύουσα, Οικισμός

	6
	Σημείο γνωστού υψομέτρου
	σημειακό
	Είδος
	Υψομετρικό σημείο, Τριγωνομετρικό σημείο

	 
	 
	 
	Υψόμετρο
	1 - 997

	7
	Θρησκευτικό μνημείο
	σημειακό
	Όνομα
	 

				Είδος
	Εκκλησία, Μονή

	 8
	 Σημεία ενδιαφέροντος
	 σημειακό
	Είδος
	Παραλία, Μνημείο, Εργοστάσιο


Πίνακας 1.2 Αποτέλεσμα του λογικού σχεδιασμού.
1.2.3 Φυσικός σχεδιασμός
 
Οι επιλογές του λογικού σχεδιασμού προσαρμόζονται στις δυνατότητες του Συστήματος Διαχείρισης Βάσης Δεδομένων (ΣΔΒΔ), το οποίο θα χρησιμοποιηθεί για την υλοποίηση και τη διαχείριση της βάσης χαρτογραφικών δεδομένων. Βασική προϋπόθεση για την επιλογή ΣΔΒΔ είναι η ύπαρξη ειδικού πεδίου για την καταγραφή της γεωμετρίας π.χ. ArcGIS geodatabase, PostgreSQL/PostGIS, Oracle Spatial κ.ά., καθώς και η εξασφάλιση επικοινωνίας με το Σύστημα Γεωγραφικών Πληροφοριών (ΣΓΠ) το οποίο θα χρησιμοποιηθεί για την επεξεργασία και απόδοση των χαρτογραφικών δεδομένων π.χ. ArcGIS, QGIS κ.ά.
Κάθε βάση δεδομένων με χωρικές δυνατότητες (spatially enabled database) διαθέτει ορισμένα κοινά χαρακτηριστικά. Αποτελεί μια κεντρική αποθηκευτική μονάδα όπου αποθηκεύονται η γεωμετρία και οι ιδιότητες των χωρικών δεδομένων. Βασική λογική μονάδα είναι ο πίνακας (χωρικός ή απλός). Ο χωρικός πίνακας αντιστοιχεί σε μια γεωγραφική οντότητα ή θεματικό επίπεδο π.χ. ποτάμι. Κάθε αντικείμενο, π.χ. ο ποταμός Πηνειός, εμφανίζεται ως μια γραμμή/εγγραφή στον πίνακα, λαμβάνει ένα μοναδικό κωδικό ο οποίος αποτελεί την ταυτότητά του καθώς και ιδιότητες που καθορίζονται κατά τον σχεδιασμό της βάσης. Οι χωρικοί και οι απλοί πίνακες συνήθως συσχετίζονται με βάση κοινά πεδία. Κάθε χωρικός πίνακας διαθέτει ένα ειδικού τύπου πεδίο όπου αποθηκεύεται η γεωμετρία, χρησιμοποιώντας το μοντέλο απλών γεωμετρικών στοιχείων του Open Geospatial Consortium (OGC). Διαφορετικών τύπων πεδία διατίθενται για την αποθήκευση των περιγραφικών ιδιοτήτων π.χ. integer, text, double κ.ά. Τα σύγχρονα συστήματα διαχείρισης βάσεων δεδομένων π.χ. ΑrcGIS geodatabase, PostgreSQL/PostGIS, Oracle Spatial ακολουθούν το αντικειμενο-σχεσιακό (object-relational) μοντέλο, το οποίο διατηρεί τα χαρακτηριστικά του σχεσιακού μοντέλου και το επεκτείνει με αντικειμενοστραφείς έννοιες.
Μια βάση χαρτογραφικών δεδομένων μπορεί να περιέχει τα ακόλουθα στοιχεία:
 
	Πίνακας: χρησιμοποιείται για να αποθηκεύσει μη χωρικά δεδομένα.
	Πίνακας χωρικών στοιχείων: ένας πίνακας που περιέχει το πεδίο καταχώρισης της γεωμετρίας και χρησιμοποιείται για να αποθηκεύσει χωρικές οντότητες ιδίου τύπου ως προς τη γεωμετρία (σημεία, γραμμές, πολύγωνα) που έχουν κοινές ιδιότητες και κοινό Σύστημα Αναφοράς Συντεταγμένων (ΣΑΣ). 
	Δομή ομαδοποίησης πινάκων: χρησιμοποιείται για την οργάνωση δεδομένων της βάσης σε ομάδες από πίνακες που συνδέονται χωρικά ή θεματικά.
	Συσχετίσεις πινάκων: οι χωρικές και μη οντότητες της βάσης ενδέχεται να συνδέονται μεταξύ τους. Πιθανές συσχετίσεις: οι χωρικές οντότητες συνδέονται με άλλες χωρικές οντότητες π.χ. ένα κτήριο συσχετίζεται με ένα αγροτεμάχιο, οι χωρικές οντότητες συνδέονται με άλλες μη χωρικές οντότητες π.χ. το αγροτεμάχιο με τον ιδιοκτήτη και οι μη χωρικές οντότητες συνδέονται με άλλες μη χωρικές οντότητες π.χ. ένας ιδιοκτήτης με έναν φορολογικό κωδικό. Οι συσχετίσεις μπορεί να είναι μορφής 1-1, 1-Ν ή Ν-Μ.
	Χωρικό ευρετήριο: βελτιώνει τη διεξαγωγή των χωρικών ερωτήσεων στους χωρικούς πίνακες π.χ. ταυτοποίηση μιας οντότητας, γραφική επιλογή μιας χωρικής οντότητας, μετακίνηση και μεγέθυνση στο γραφικό περιβάλλον επεξεργασίας κ.ά. 
	Περιορισμοί ως προς τις τιμές των πεδίων.
	Ένα πεδίο ορίζεται ως Πρωτεύον κλειδί (primary key), όταν οι τιμές του ταυτοποιούν μοναδικά μια εγγραφή.
	Ένα πεδίο ορίζεται ως Δευτερεύον κλειδί (foreign key), όταν οι τιμές του ταυτίζονται με αυτές ενός πρωτεύοντος κλειδιού ενός άλλου πίνακα.

 
Για την ολοκλήρωση του φυσικού σχεδιασμού θα πρέπει να απαντηθούν τα ακόλουθα ερωτήματα: 
 
	Το ΣΔΒΔ ή το ΣΓΠ που θα χρησιμοποιηθεί απαιτεί την ύπαρξη μοναδικού κωδικού – ταυτότητας για κάθε εγγραφή ενός χωρικού ή μη πίνακα;
	Θα δημιουργηθεί κάποια δομή για την ομαδοποίηση των δεδομένων;
	Ποιοι θα είναι οι χωρικοί πίνακες και οι πίνακες περιγραφικών χαρακτηριστικών που θα δημιουργηθούν;
	Ποιο είδος γεωμετρίας θα χαρακτηρίζει κάθε χωρικό πίνακα;
	Ποια πεδία θα προστεθούν σε κάθε χωρικό πίνακα για την αποθήκευση των ιδιοτήτων που ορίστηκαν κατά τον λογικό σχεδιασμό; Ποιο θα είναι το όνομά κάθε ενός από αυτά π.χ. type και ποιο είδος πεδίου θα χρησιμοποιηθεί; Π.χ. text, short integer, long integer, float, double.
	Πώς θα γίνει η καταχώριση των περιγραφικών ιδιοτήτων; Ποιες είναι οι επιτρεπόμενες τιμές των πεδίων; Θα δημιουργηθούν περιορισμοί; Επιτρέπεται (ή όχι) η μη καταγραφή τιμών (null); Υπάρχει προκαθορισμένη τιμή (default); Θα χρησιμοποιηθεί κωδικοποίηση των αλφαριθμητικών τιμών; Π.χ. τιμή 1 για το μουσείο και τιμή 2 για το θέατρο. Θα δημιουργηθούν βοηθητικοί πίνακες που θα επεξηγούν την κωδικοποίηση των ιδιοτήτων; Ποιοι θα είναι αυτοί και ποια θα είναι η δομή και το περιεχόμενό τους; Αξίζει να σημειωθεί ότι η κωδικοποίηση των αλφαβητικών τιμών των πεδίων με αριθμητικές τιμές μειώνει τον απαιτούμενο χώρο αποθήκευσης, περιορίζει τα σφάλματα και αυξάνει την ταχύτητα κατά την εισαγωγή των δεδομένων καθώς η επιλογή γίνεται από προκαθορισμένες τιμές και αποφεύγεται η πληκτρολόγηση λέξεων.

	 

 	Table
	Όνομα πεδίου
	Είδος πεδίου
	Default Value
	Constraint
	Foreign key \ Σύνδεση με πίνακα κωδικοποίησης τιμών
	Primary key (Υ/Ν)
	Νull
(Υ/Ν)

	coastline
	id
	serial
				Y
	N

		z
	integer
	0
	chk_z_coast
			N

		geom
	Geometry (line)
					
	contours
	id
	serial
				Y
	N

		z
	integer
		chk_z_cont
			N

		geom
	Geometry (line)
					
	rivers
	id
	serial
				Y
	N

		name
	text
					
		geom
	Geometry (line)
					
		type
	 integer
	1
		Y / riv_code
		N

	roads
	id
	serial
				Y
	N

		type
	 integer
	1
		Y / road_code
		N

		geom
	Geometry (line)
					
	settlements
	id
	serial
				Y
	N

		name
	text
					
		geom
	Geometry (point)
					
		type
	 integer
	1
		Y / sett_code
		N

	zpoints
	id 
	serial
				Y
	N

		type
	 integer
	1
		Y/zpoint_code
		N

	 
	z
	 integer
		chk_z_zpoints
			N

		geom
	Geometry (point)
					
	reg_mon
	id
	serial
				Y
	N

		name
	text
					
	 
	type
	 integer
	2
		Y/reg_code
		N

		geom
	Geometry (point)
					
	road_code
	type
	 integer
				Y
	N

		type_of _roads
	text
					
	zpoint_code
	type
	 integer
				Y
	N

		type_of _zpoints
	text
					
	reg_code
	type
	 integer
				Y
	N

		type_of _reg_mon
	text
					
	riv_code
	type
	 integer
				Y
	N

		type_of _rivers
	text
					
	sett_code
	type
	 integer
				Y
	N

		type_of _settlement
	text
					

Πίνακας 1.3 Αποτέλεσμα του φυσικού σχεδιασμού.
1.3 Η βάση γεωχωρικών δεδομένων PostgreSQL/PostGIS και το Σύστημα Γεωγραφικών Πληροφοριών QGIS
 
Η PostgreSQL (“PostgreSQL”, χ.η.) είναι ένα ΕΛ/ΛΑΚ σχεσιο-αντικειμενοστραφές ΣΔΒΔ. Η PostGIS (“PostGIS”, χ.η.) είναι μια βιβλιοθήκη ΕΛ/ΛΑΚ που επιτρέπει την αποθήκευση και τη διαχείριση χωρικών δεδομένων στην PostgreSQL. Η PostgreSQL είναι το πιο εξελιγμένο ΕΛ/ΛΑΚ ΣΔΒΔ, καθώς χαρακτηρίζεται από ταχύτητα και λειτουργικότητα που συναγωνίζεται τα εμπορικά ΣΔΒΔ και χρησιμοποιείται για την αποθήκευση μεγάλων σε μέγεθος βάσεων δεδομένων. Η PostgreSQL/PostGIS επιτρέπει τη χρήση διαφορετικού είδους γεωμετρίας στον ίδιο χωρικό πίνακα, γεγονός το οποίο είναι αντίθετο με την χαρτογραφική πρακτική. Για τον λόγο αυτό, όταν οι πίνακες δημιουργούνται από το ΣΔΒΔ της Postgres/Postgis, θα πρέπει να εφαρμόζονται περιορισμοί στη χρήση ενός γεωμετρικού αρχετύπου. Αυτό εξασφαλίζεται όταν οι πίνακες δημιουργούνται από το κατάλληλο εργαλείο του QGIS. Τα χαρτογραφικά δεδομένα που έχουν καταχωρηθεί σε μια βάση δεδομένων PostgreSQL/PostGIS μπορούν να αποδοθούν γραφικά και να επεξεργαστούν σε περιβάλλον QGIS (“QGIS Training Manual”, χ.η.;“QGIS User Guide”, χ.η.).
Η βάση PostgreSQL/PostGIS γεωχωρικών δεδομένων παρέχει τις ακόλουθες δομές:
 
	Η δομή Table χρησιμοποιείται για να αποθηκεύσει χωρικά και μη χωρικά δεδομένα.
	Το Schema αποτελεί μία δομή με μορφή καταλόγου που διευκολύνει την οργάνωση και τη διαχείριση των πινάκων και των άλλων στοιχείων της βάσης.
	Η δομή Spatial Index αποτελεί το χωρικό ευρετήριο. 
	Η δομή Constraint χρησιμοποιείται για να επιβάλει δεσμεύσεις στις τιμές ενός πεδίου π.χ. επιτρέπεται (ή όχι) η μη λήψη τιμών, οι τιμές πρέπει να είναι μοναδικές, οι τιμές πρέπει να βρίσκονται εντός ενός εύρους  το οποίο προσδιορίζεται από την ελάχιστη και τη μέγιστη τιμή, ένα πεδίο λειτουργεί ως πρωτεύον κλειδί, ένα πεδίο λειτουργεί ως δευτερεύον κλειδί κ.ά.

 
 
 
α. Πίνακας roads_code
 	type
	type_of _roads

	1
	Επαρχιακή οδός

	2
	Αγροτική οδός


  
β. Πίνακας zpoints_code
 	type
	type_of _zpoints

	1
	Υψομετρικό σημείο 

	2
	Τριγωνομετρικό σημείο


 
γ. Πίνακας regmon_code
 	type
	type_of _reg_mon

	1
	Εκκλησία

	2
	Μονή


Πίνακας 1.4 Βοηθητικοί πίνακες επεξήγησης της κωδικοποίησης του οδικού δικτύου (a), των σημείων γνωστού υψομέτρου (β) και των θρησκευτικών μνημείων (γ).
Με βάση τον πίνακα του λογικού σχεδιασμού (Πίνακας 1.2), εφαρμόζονται τα ερωτήματα που διαμορφώνουν τους ακόλουθους πίνακες (Πίνακας 1.3, Πίνακας 1.4 και Πίνακας 1.5)  οι οποίοι συνοψίζουν τα αποτελέσματα του φυσικού σχεδιασμού. Με βάση τα στοιχεία αυτά υλοποιείται η βάση δεδομένων.
Στη συνέχεια, παρατίθενται οδηγίες για την υλοποίηση του φυσικού σχεδιασμού σε μια βάση δεδομένων PostgresSQL/PostGIS. Η δημιουργία της γεωβάσης γίνεται μέσω του λογισμικού pgAdmin της PostgresSQL/PostGIS και το ΣΓΠ QGIS (“QGIS Training Manual”, χ.η.;“QGIS User Guide”, χ.η.). Επισημαίνεται ότι θα πρέπει να είναι ενεργοποιημένος ο εξυπηρετητής της PostgresSQL/PostGIS. 
 
 
 	Όνομα Constraint
	Λογική συνθήκη

	chk_z_coast
	z = 0

	chk_z_cont
	z> = 50 and z = < 950

	chk_z_zpoints
	z>= 1 and z =< 997


Πίνακας 1.5 Οι περιορισμοί των τιμών των πεδίων ορίζονται ως Constraints.
 
 
[image: ]
Εικόνα 1.4 Δημιουργία βάσης δεδομένων από το περιβάλλον pgAdmin.
1.3.1 Δημιουργία βάσης και δομής ομαδοποίησης πινάκων
 
Αρχικά, δημιουργείται η σύνδεση με τον εξυπηρετητή της PostgresSQL/PostGIS από το γραφικό περιβάλλον pgAdmin. Γίνεται η εκκίνηση του pgAdmin. Η σύνδεση με τον εξυπηρετητή πραγματοποιείται με διπλό κλικ στην καταχώριση PostGIS (localhost:5431) που εμφανίζεται στο παράθυρο Object Browser>Server Groups>Servers (Εικόνα 1.4). Στη συνέχεια, αν ζητηθεί, δίνεται ο κωδικός. Η ανάπτυξη του Databases εμφανίζει τις υπάρχουσες βάσεις. Στη συνέχεια, είναι δυνατή η διαχείριση κάποιας από αυτές ή η δημιουργία μιας νέας. Για τη δημιουργία μιας νέας βάσης δεδομένων από το περιβάλλον pgAdmin, στο παράθυρο Object Browser, επιλέγεται Databases και με δεξί κλικ New Database. Στο παράθυρο New database συμπληρώνονται τα ακόλουθα στοιχεία: το όνομα της βάσης δεδομένων Name π.χ. dm_geodatabase, ο χρήστης ιδιοκτήτης Owner π.χ. Postgres. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK. Με διπλό κλικ πάνω στην νέα βάση που δημιουργήθηκε στο παράθυρο Object Browser, γίνεται η σύνδεση με αυτήν. Στη συνέχεια καλείται το περιβάλλον εκτέλεσης εντολών SQL, με το εργαλείο SQL queries [image: ]από την εργαλειοθήκη του pgAdmin. Στο νέο παράθυρο, πληκτρολογούνται και εκτελούνται οι παρακάτω εντολές που προσθέτουν στη βάση δεδομένων τις χωρικές δυνατότητες της PostGIS (1) και ελέγχουν αν η προσθήκη ολοκληρώθηκε επιτυχώς (2): 
 
	CREATE EXTENSION postgis;
	SELECT postgis_full_version();

 
Αν η βάση έχει λάβει τις χωρικές δυνατότητες, τότε εντός του σχήματος public της βάσης εντοπίζεται ο πίνακας των συστημάτων αναφοράς των συντεταγμένων Tables>spatial_ref_sys (Εικόνα 1.4). 
 
 
[image: ]
Εικόνα 1.5 Δημιουργία σύνδεσης στη βάση δεδομένων από το περιβάλλον του ΣΓΠ QGIS.
Για την υλοποίηση της σύνδεσης στη βάση δεδομένων από το περιβάλλον του ΣΓΠ QGIS, από τη εργαλειοθήκη επιλέγεται Προσθήκη επιπέδου PostGIS [image: ]. Από το νέο παράθυρο Add PostGIS Table(s), επιλέγεται το πλήκτρο Νέα. Στο παράθυρο Δημιουργία νέας PostGIS σύνδεσης που εμφανίζεται (Εικόνα 1.5), συμπληρώνονται τα ακόλουθα: το όνομα της σύνδεσης Όνομα π.χ. dm_geodatabase_connect, το όνομα του εξυπηρετητή Host π.χ. localhost, ο κωδικός της θύρας Port π.χ. 5432, το όνομα της βάσης δεδομένων Βάση Δεδομένων π.χ. dm_geodatabase, το όνομα του χρήστη Όνομα χρήστη π.χ. postgres και ο κωδικός του χρήστη Κωδικός π.χ. postgres. Από το πλήκτρο Έλεγχος σύνδεσης, ελέγχεται η επιτυχία της σύνδεσης. H σύνδεση ολοκληρώνεται με το πλήκτρο ΟΚ. Στο παράθυρο Add PostGIS Table(s) επιλέγεται το πλήκτρο Σύνδεση και τέλος Close.
 
 
[image: ]
Εικόνα 1.6 Δημιουργία σχήματος εντός της βάσης δεδομένων.
Για να τη δημιουργία της δομής ομαδοποίησης - σχήμα (schema) εντός της βάσης, από το περιβάλλον του ΣΓΠ QGIS επιλέγεται το μενού Βάση Δεδομένων>Διαχείριση Βάσεων Δεδομένων>Διαχείριση Βάσεων Δεδομένων. Από το νέο παράθυρο Διαχείριση Βάσεων Δεδομένων (Εικόνα 1.6) υλοποιείται η σύνδεση με τη βάση δεδομένων με την επιλογή της σύνδεσης π.χ. dm_geodatabase_connect και στη συνέχεια διπλό κλικ. Στο παράθυρο που εμφανίζεται - εφόσον ζητείται - δίνεται ο κωδικός πρόσβασης (password). Για τη δημιουργία ενός σχήματος εντός της βάσης, επιλέγεται Σχήμα>Δημιουργία Σχήματος. Στο νέο παράθυρο Νέο σχήμα (Εικόνα 1.6) και στη ερώτηση Εισάγετε το νέο όνομα σχήματος πληκτρολογείται το όνομα του σχήματος π.χ. data και στη συνέχεια επιλέγεται το πλήκτρο ΟΚ. Στην καρτέλα Τree του παραθύρου Διαχείριση Βάσεων δεδομένων, εντοπίζεται το νέο σχήμα π.χ data και το υπάρχον σχήμα public εντός της βάσης.
 
1.3.2 Δημιουργία χωρικού πινάκα 
 
Από το περιβάλλον του ΣΓΠ QGIS επιλέγεται το μενού Βάση Δεδομένων>Διαχείριση Βάσεων Δεδομένων>Διαχείριση Βάσεων Δεδομένων. Από το νέο παράθυρο Διαχείριση Βάσεων Δεδομένων (Εικόνα 1.6) υλοποιείται η σύνδεση με τη βάση δεδομένων με την επιλογή της βάσης π.χ. dm_geodatabase_connect και στη συνέχεια διπλό κλικ. Στο παράθυρο που εμφανίζεται - εφόσον ζητείται - δίνεται ο κωδικός πρόσβασης (password). Στη συνέχεια, επιλέγεται η βάση π.χ. dm_geodatabase και το σχήμα π.χ. data μέσα στο οποίο θα δημιουργηθεί ο πίνακας. Από το μενού επιλέγεται Πίνκακας>Δημιουργία Πίνακα. Στο νέο παράθυρο Δημιουργία πίνακα (Εικόνα 1.6) συμπληρώνονται τα ακόλουθα: το όνομα του σχήματος Σχήμα ΒΔ π.χ. data, το όνομα του πίνακα Όνομα π.χ. roads, ενεργοποιείται η επιλογή Δημιουργία στήλη γεωμετρίας και επιλέγεται το είδος της γεωμετρίας π.χ. Point, Linestring, Polygon, το όνομα του πεδίου αποθήκευσης της γεωμετρίας Όνομα π.χ. geom, ο κωδικός του Συστήματος Συντεταγμένων (SRID) όπου καταχωρείται ο κωδικός EPSG (European Petroleum Search Group) (βλ. Κεφάλαιο 6) του συστήματος αναφοράς π.χ. 2100 για το ΕΓΣΑ ’87. Ακόμα είναι απαραίτητη η προσθήκη ενός πεδίου με όνομα id, είδους serial και ορισμένου ως Primary key, που συμπληρώνεται αυτόματα σειριακά με την προσθήκη νέων εγγραφών και αποτελεί την ταυτότητα των εγγραφών του πίνακα. Επιλέγεται το πλήκτρο Προσθήκη πεδίου και στη νέα γραμμή που δημιουργείται συμπληρώνεται στη στήλη Name το όνομα και στη στήλη Type το είδος. Ορίζεται επιπλέον ως πρωτεύον κλειδί. H δημιουργία του χωρικού πίνακα ολοκληρώνεται με το πλήκτρο Δημιουργία. Η επιτυχής δημιουργία του πίνακα συνοδεύεται με την εμφάνιση του παραθύρου Επιτυχία, το οποίο κλείνει με το πλήκτρο ΟΚ. Στη συνέχεια επιλέγεται Close και το παράθυρο δημιουργίας του πίνακα κλείνει.
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Εικόνα 1.7 Δημιουργία χωρικού πίνακα εντός της βάσης δεδομένων.
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Εικόνα 1.8 Προσθήκη πεδίων για την καταχώριση των περιγραφικών χαρακτηριστικών στο χωρικό πίνακα.
Για την προσθήκη στον χωρικό πίνακα πεδίων καταγραφής των περιγραφικών ιδιοτήτων, από το μενού επιλέγεται Πίνακας>Επεξεργασία Πίνακα. Στο νέο παράθυρο Ιδιότητες πίνακα και στην καρτέλα Στήλες είναι δυνατή η προσθήκη στον πίνακα νέων πεδίων/στηλών με το κουμπί Προσθήκη στήλης (Εικόνα 1.8). Στο νέο παράθυρο Ιδιότητες Πεδίου, ορίζονται τα χαρακτηριστικά του πεδίου ως εξής: το όνομα Όνομα π.χ. type, ένα από τα προσφερόμενα είδη πεδίων Τύπος  π.χ. integer, ο αριθμός των ψηφίων Μήκος π.χ. 1, η επιλογή Λαμβάνει τιμές Null επιλέγεται αν επιτρέπεται η μη καταχώριση τιμών και ως Προεπιλεγμένη τιμή δίνεται μια τιμή που καταχωρίζεται αυτόματα στο πεδίο κατά την εισαγωγή δεδομένων π.χ. 1. Η προσθήκη του πεδίου ολοκληρώνεται με το πλήκτρο ΟΚ. Στη συνέχεια, αν απαιτείται η προσθήκη και άλλων πεδίων επαναλαμβάνεται η διαδικασία ή διαφορετικά με το πλήκτρο Close το παράθυρο κλείνει.
1.3.3 Δημιουργία πίνακα κωδικοποίησης, καταχώριση τιμών και σύνδεση του πίνακα κωδικοποίησης με ένα χωρικό πίνακα
 
Για τη δημιουργία ενός βοηθητικού πίνακα κωδικοποίησης, επιλέγεται η βάση και στη συνέχεια το σχήμα μέσα στο οποίο θα δημιουργηθεί ο πίνακας. Από το μενού επιλέγεται Table>Create table. Στο νέο παράθυρο, συμπληρώνονται τα ακόλουθα: το όνομα του σχήματος Σχήμα π.χ. data και το όνομα του πίνακα Όνομα π.χ. roads_code. Στη συνέχεια, προστίθενται στον πίνακα δύο πεδία με το κουμπί Προσθήκη πεδίου, ένα για τους κωδικούς π.χ. Code τύπου integer και ένα για τη λεκτική τους περιγραφή π.χ. Τype_of_roads τύπου text. Στη στήλη Name πληκτρολογείται το όνομα π.χ. Code και στη στήλη Type επιλέγεται το κατάλληλο είδος πεδίου π.χ. integer, ενώ η στήλη Null δεν επιλέγεται καθώς δεν επιτρέπεται η μη καταχώριση τιμών. Το αριθμητικό πεδίο π.χ. Code, αποτελεί την ταυτότητα των εγγραφών του πίνακα και για τον λόγο αυτό επιλέγεται ως Primary key (Εικόνα 1.9). Στη συνέχεια προστίθενται και τα υπόλοιπα πεδία. H δημιουργία του πίνακα ολοκληρώνεται με το πλήκτρο Δημιουργία. Η επιτυχής δημιουργία του πίνακα συνοδεύεται από την εμφάνιση του παραθύρου Επιτυχία, το οποίο κλείνει με το πλήκτρο ΟΚ. Στη συνέχεια επιλέγεται Close και το παράθυρο δημιουργίας του πίνακα κλείνει.
Στη συνέχεια, θα πρέπει να ενημερωθεί ο πίνακας κωδικοποίησης π.χ. roads_code με τις κατάλληλες τιμές. Αρχικά, ο πίνακας προστίθεται στο περιβάλλον του QGIS. Από την εργαλειοθήκη επιλέγεται Προσθήκη επιπέδου PostGIS. Στο παράθυρο Δημιουργία νέας PostGIS σύνδεσης (Εικόνα 1.10), επιλέγεται η σύνδεση που δημιουργήθηκε προηγουμένως και το πλήκτρο Σύνδεση. Επιπλέον, ενεργοποιείται και η επιλογή Απαρίθμηση πινάκων χωρίς γεωμετρία. Από το σχήμα data επιλέγονται ο χωρικός πίνακας π.χ. roads και ο πίνακας κωδικοποίησης π.χ. roads_type και στη συνέχεια το πλήκτρο Προσθήκη. Ο χωρικός πίνακας π.χ. roads και ο πίνακας κωδικοποίησης π.χ. roads_code έχουν προστεθεί στο παράθυρο Επίπεδα. Επιλέγεται ο πίνακας κωδικοποίησης π.χ. roads_code και με δεξί κλικ Open attribute table. Στο νέο παράθυρο Attribute table, ξεκινάει η επεξεργασία με το εργαλείο Toggle editing tool [image: ] από την εργαλειοθήκη. Mε το εργαλείο Προσθήκη αντικειμένου [image: ] από την εργαλειοθήκη, καταχωρίζονται τα στοιχεία στον πίνακα. Στο νέο παράθυρο Feature Attributes, συμπληρώνονται τα στοιχεία στα πεδία π.χ. code και type_of_roads. (Εικόνα 1.11). Με το εργαλείο Αποθήκευση αλλαγών [image: ] από την εργαλειοθήκη, ολοκληρώνεται η αποθήκευση των αλλαγών στον πίνακα.
 
 
[image: ]
Εικόνα 1.9 Δημιουργία πίνακα κωδικοποίησης.
Ακολουθεί η περιγραφή της καταχώρισης τιμών και η σύνδεση του χωρικού πίνακα με τον πίνακα κωδικοποίησης Στο περιβάλλον του ΣΓΠ QGIS, από τη εργαλειοθήκη επιλέγεται Προσθήκη επιπέδου PostGIS. Στο παράθυρο Δημιουργία νέας PostGIS σύνδεσης, επιλέγεται η σύνδεση που δημιουργήθηκε προηγουμένως και το πλήκτρο Σύνδεση, καθώς και η επιλογή Απαρίθμηση πινάκων χωρίς γεωμετρία. Από το σχήμα data επιλέγονται ο χωρικός πίνακας π.χ. roads και ο πίνακας κωδικοποίησης π.χ. roads_type και στη συνέχεια το πλήκτρο Προσθήκη. Ο χωρικός πίνακας π.χ. roads και ο πίνακας κωδικοποίησης π.χ. roads_type έχουν προστεθεί στο παράθυρο Επίπεδα. Στη συνέχεια, με διπλό κλικ στο χωρικό πίνακα π.χ. roads ή δεξί κλικ και Ιδιότητες, εμφανίζεται το παράθυρο Layer Properties και επιλέγεται Συνδέσεις. Στην καρτέλα Συνδέσεις με το πλήκτρο + θα προστεθεί η σύνδεση των πινάκων π.χ. roads και roads_type. Στο παράθυρο Προσθήκη σύνδεσης που εμφανίζεται δίνονται οι ακόλουθες πληροφορίες: ο πίνακας κωδικοποίησης Συνένωση επιπέδου π.χ. roads_code, το πεδίο του πίνακα κωδικοποίησης Συνένωση πεδίου π.χ. code, το πεδίο του χωρικού πίνακα Πεδίο προορισμού π.χ. type και τέλος η ενεργοποίηση της επιλογής Αποθήκευση συνδεμένου επιπέδου στην εικονική μνήμη. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK. Με βάση τη σύνδεση του χωρικού πίνακα π.χ. roads με τον πίνακα κωδικοποίησης π.χ. roads_type μέσω του κοινού πεδίου π.χ. code, όταν κατά την συλλογή των δεδομένων του θεματικού επιπέδου των δρόμων θα πληκτρολογείται ένας από τους κωδικούς του πεδίου π.χ. type ->1, τότε αυτόματα θα ενημερώνεται το συσχετισμένο πεδίο με την αντίστοιχη λεκτική περιγραφή π.χ. Ασφαλτόστρωτη. Σε περίπτωση που εισαχθεί ένας κωδικός που δεν ανήκει σε αυτούς του πεδίου code, τότε το συσχετισμένο πεδίο μένει κενό (null).
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Εικόνα 1.10 Προσθήκη πινάκων και χωρικών πινάκων στο περιβάλλον του ΣΓΠ QGIS.
 
 
[image: ]
Εικόνα 1.11 Καταχώριση δεδομένων στον πίνακα κωδικοποίησης.
Συχνά, πρέπει να εφαρμοστούν περιορισμοί στις επιτρεπόμενες τιμές ενός πεδίου. Από το περιβάλλον του ΣΓΠ QGIS επιλέγεται το μενού Database>DB Manager>DB Manager. Από το νέο παράθυρο του DB Manager επιλέγεται Βάση δεδομένων>Παράθυρο SQL. Στο νέο παράθυρο SQL πληκτρολογούνται και εκτελούνται κατάλληλες εντολές που περιορίζουν τις επιτρεπόμενες τιμές ορισμένων πεδίων, όπως προβλέφθηκε κατά τον σχεδιασμό (Πίνακας 1.5). Για παράδειγμα η εντολή που ακολουθεί επιτρέπει στο πεδίο z να παίρνει τιμές από 0 έως 997 alter table data.zpoints add constraint chk_z_zpoints check(z>0 AND Z <997);. Σημειώνεται ότι αν κατά την εισαγωγή δεδομένων μέσω του QGIS εισαχθούν τιμές διαφορετικές από τις επιτρεπόμενες, το πρόγραμμα δεν αποθηκεύει τα δεδομένα στη βάση και εμφανίζει μήνυμα σφάλματος. 
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Εικόνα 1.12 Σύνδεση χωρικού πίνακα roads και πίνακα κωδικοποίησης roads_type.
1.4 Η βάση γεωχωρικών δεδομένων και το ΣΓΠ ArcGIS 
 
Το ΣΓΠ (“ArcGIS Help 10.2”, χ.η.) δίνει τη δυνατότητα δημιουργίας μιας βάσης γεωχωρικών δεδομένων που καλείται γεωβάση (geodatabase). Προτείνεται η δημιουργία γεωβάσης τύπου File Geodatabase, που αποθηκεύεται ως ένας κατάλογος με δυαδικά αρχεία (folder of binary files), δίνει δυνατότητα αποθήκευσης δεδομένων μεγέθους 1 ΤΒ σε κάθε πίνακα, είναι συμβατή με πολλαπλά λειτουργικά συστήματα και δίνει ένα δικαίωμα επεξεργασίας και πολλαπλά δικαιώματα χρήσης.
Η γεωβάση ενδέχεται να περιέχει τις ακόλουθες δομές:
 
	Η δομή Table χρησιμοποιείται για να αποθηκεύσει μη χωρικά δεδομένα. Το σύστημα δημιουργεί αυτόματα το πεδίο OBJECTID, που είναι πρωτεύον κλειδί και εξασφαλίζει ένα μοναδικό κωδικό για κάθε γραμμή του πίνακα.
	Η δομή Feature class χρησιμοποιείται για να αποθηκεύσει χωρικά δεδομένα. Το σύστημα δημιουργεί αυτόματα το πεδίο OBJECTID που εξασφαλίζει έναν μοναδικό κωδικό για κάθε γραμμή του πίνακα και το πεδίο SHAPE που καταγράφει τη γεωμετρία βάσει των αρχετύπων σημείο, γραμμή και πολύγωνο. Το χωρικό ευρετήριο κάθε χωρικού πίνακα δημιουργείται αυτόματα. Επιπλέον, δημιουργείται το πεδίο SHAPE_Length στα γραμμικά και επιφανειακά δεδομένα το οποίο καταγράφει το μήκος και την περίμετρο αντίστοιχα και το πεδίο SHAPE_Αrea στα επιφανειακά δεδομένα που καταγράφει το εμβαδόν.
	Η δομή Feature dataset ομαδοποιεί ένα σύνολο από τάξεις χωρικών στοιχείων (feature classes) που συνδέονται χωρικά ή θεματικά κι έχουν κοινό σύστημα αναφοράς. Χρησιμοποιείται για την οργάνωση δεδομένων της βάσης σε μια ομάδα, ώστε να εξυπηρετηθεί η δόμηση της τοπολογίας ενός δικτύου (network) κ.ά.
	Η δομή Domain περιγράφει την κωδικοποίηση και τις επιτρεπόμενες τιμές ενός πεδίου βάσει του σχεδιασμού της βάσης. Αντικαθιστά τους βοηθητικούς πίνακες επεξήγησης της κωδικοποίησης. Ο έλεγχος ικανοποίησης των περιορισμών του πεδίου τιμών γίνεται μετά την εισαγωγή δεδομένων (βλ. Κεφάλαιο 4). Ορίζεται στο επίπεδο της γεωβάσης και χρησιμοποιείται για να εξασφαλίσει την ποιότητα της βάσης δεδομένων. Υπάρχουν δύο είδη: α. Το είδος Range αφορά συνεχή δεδομένα και οι αποδεκτές τιμές ανήκουν σε ένα εύρος τιμών που ορίζεται από την ελάχιστη και τη μέγιστη τιμή π.χ. τα βάθη σε μια περιοχή κυμαίνονται από -0.5 έως -233.76 μέτρα, ένας δρόμος μπορεί να έχει από 1 έως 8 λωρίδες β.  Το είδος Coded Value αφορά διακριτά δεδομένα και οι αποδεκτές τιμές παρατίθενται σε μια λίστα (τιμή 1, τιμή 2, ….., τιμή Ν) π.χ. οι ισοβαθείς μιας περιοχής μπορεί να έχουν τις τιμές -5, -10, -50, -100, ένας δρόμος μπορεί να είναι ασφαλτόστρωτος ή χωματόδρομος. Άλλες επιλογές ελέγχου των τιμών ενός πεδίου είναι η απαγόρευση της μη καταγραφής τιμών (null) και η δυνατότητα καταχώρισης μιας προκαθορισμένης τιμής (default).
	Η δομή Topology καταγράφει τους τοπολογικούς κανόνες και τα σφάλματα που εντοπίζονται από τον έλεγχό τους (βλ. Κεφάλαιο 5). 
	Η δομή Relationship Class καταγράφει τις συσχετίσεις.

 
 
 	Feature Class
	Shape
	Field Νame
	Field Type
	Default Value
	Null (Υ/Ν)
	Domain 
/ Domain Type

	coastline
	line
	z
	short integer
	0
	Ν
	
	contours
	line
	z
	short integer
		Ν
	DomainOfContoursZ
(range)

	rivers
	line
	name
	text
		Υ
	
	roads
	line
	type
	short integer
	1
	Ν
	DomainOfRoadsType
(coded values)

	settlements
	polygon
	name
	text
		Ν
	
	zpoints
	point
	type
	short integer
	1
	Ν
	DomainOfZpointsType
(coded values)

	 
	 
	z
	short integer
		Ν
	DomainOfZpointsZ
(range)

	reg_mon
	point
	name
	text
		Υ
	
	 
	 
	type
	short integer
	1
	Ν
	DomainOfRegΜonType
(coded values)


Πίνακας 1.6 Αποτέλεσμα του φυσικού σχεδιασμού για το ΣΓΠ ArcGIS.
Με βάση τον πίνακα του λογικού σχεδιασμού (Πίνακας 1.2) και τα χαρακτηριστικά της γεωβάσης διαμορφώνονται οι πίνακες (Πίνακας 1.6, Πίνακας 1.7 και Πίνακας 1.8), οι οποίοι συνοψίζουν τα αποτελέσματα του φυσικού σχεδιασμού. Με βάση τα στοιχεία αυτά υλοποιείται η βάση δεδομένων.
Στη συνέχεια, παρατίθενται οδηγίες για την υλοποίηση των αποτελεσμάτων του σχεδιασμού σε μια γεωβάση του ΣΓΠ ArcGIS τύπου File Geodatabase (“ArcGIS Help 10.2”,χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β). Η δημιουργία της γεωβάσης γίνεται μέσω του λογισμικού ArcCatalog του ArcGIS.
 
1.4.1 Δημιουργία γεωβάσης και δομής ομαδοποίησης δεδομένων
 
Η ενεργοποίηση του λογισμικού ArcCatalog 10.2 πραγματοποιείται από την επιλογή Start>All Programs>ArcGIS>ArcCatalog 10.2[image: ]. 
Αρχικά, δημιουργείται μια μόνιμη σύνδεση με έναν κατάλογο δεδομένων (folder) όπου θα αποθηκευτεί η γεωβάση. Με το εργαλείο [image: ], ανοίγει το παράθυρο Connect to folder, όπου υποδεικνύεται η θέση του καταλόγου δεδομένων που θα χρησιμοποιηθεί για την αποθήκευση της βάσης δεδομένων π.χ. c:\data. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
Στη συνέχεια, για τη δημιουργία της γεωβάσης, επιλέγεται ο κατάλογος δεδομένων στον οποίο θα αποθηκευτεί η βάση δεδομένων π.χ. c:\data και από το μενού File>New>File Geodatabase ή δεξί κλικ New>File Geodatabase. Ακολουθεί η εισαγωγή του ονόματος. Εάν δεν γίνει αλλαγή του ονόματος και δημιουργηθεί μια γεωβάση με όνομα New File Geodatabase.gdb, τότε επιλέγεται η γεωβάση και με δεξί κλικ Rename μετονομάζεται στο επιθυμητό όνομα π.χ. test_geodatabase (Εικόνα 1.13).
 
 
 	Domain Name
	DomainOfRoadType

	Field Type: 
	Integer

	Domain Type: 
	Coded Values

	Code
	Description

	1
	Επαρχιακή οδός

	2
	Αγροτική οδός


 
 	Domain Name
	DomainOfRegMon

	Field Type: 
	Integer

	Domain Type: 
	Coded Values

	Code
	Description

	1
	Εκκλησία

	2
	Μονή


 
 	Domain Name
	DomainOfZpointsType

	Field Type: 
	Integer

	Domain Type: 
	Coded Values

	Code
	Description

	1
	Υψομετρικό Σημείο

	2
	Τριγωνομετρικό Σημείο


 
 	Domain Name
	DomainOfZpointsZ

	Field Type: 
	Integer

	Domain Type: 
	Range

	Minimum Value:
	1

	Maximum Value:
	997


 
 	Domain Name
	DomainOfZlines

	Field Type: 
	Integer

	Domain Type: 
	Range

	Minimum Value:
	50

	Maximum Value:
	950


 
Πίνακας 1.7 Η δημιουργία domains περιλαμβάνεται στο φυσικό σχεδιασμό για το ΣΓΠ ArcGIS.
Ακολουθεί η δημιουργία ενός συνόλου χωρικών στοιχείων (Feature Dataset) εντός της γεωβάσης. Επιλέγεται η γεωβάση π.χ. test_geodatabase και με δεξί κλικ New>Feature Dataset. Στο νέο παράθυρο New Feature Dataset και στις καρτέλες που εμφανίζονται διαδοχικά ορίζονται τα ακόλουθα: το όνομα Νame π.χ. data, το σύστημα αναφοράς των συντεταγμένων Coordinate System π.χ. για το ΕΓΣΑ ‘87 επιλέγεται Projected Coordinate System>National Grids>Europe>Greek Grid, το Vertical Coordinate System δεν ορίζεται και τέλος το μέγεθος απόστασης XY Tolerance. Η απόσταση XY Tolerance χρησιμοποιείται για τη θεώρηση ως ταυτόσημων στοιχείων που απέχουν απόσταση μικρότερη από αυτήν. Η μεταφορά στην επόμενη καρτέλα γίνεται με το πλήκτρο Next. Η διαδικασία ολοκληρώνεται με το πλήκτρο Finish. 
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Εικόνα 1.13 Σύνδεση με έναν κατάλογο και δημιουργία μιας γεωβάσης.
1.4.2 Δημιουργία τάξης χωρικών στοιχείων
 
Για τη δημιουργία μιας τάξης χωρικών στοιχείων (Feature Class), σε επίπεδο Geodatabase ή Feature Dataset, με δεξί κλικ επιλέγεται New>Feature Class. Στο νέο παράθυρο New Feature Class και στις καρτέλες που εμφανίζονται διαδοχικά ορίζονται τα ακόλουθα: το όνομα Name π.χ. roads, ανάλογα με τη γεωμετρία επιλέγεται Type π.χ. Polygon features ή Line features ή Point Features και ως Configuration Keyword η τιμή Default. Ακολουθεί η εισαγωγή των πεδίων Fields για τα περιγραφικά χαρακτηριστικά με τον ορισμό των: Field name (όνομα) και Data type (είδος πεδίου) π.χ. Short Integer, Text, Float κ.ά. Ακόμα ορίζονται οι ιδιότητες Field Properties. H ιδιότητα Allow NULL Values παίρνει τις τιμές Yes/ No ανάλογα με το αν επιτρέπονται ή όχι κενές τιμές και η ιδιότητα Default value ορίζει την προκαθορισμένη τιμή. Η διαδικασία ολοκληρώνεται με το πλήκτρο Finish (Εικόνα 1.14). 
Για την προσθήκη νέων πεδίων ή αλλαγή των ιδιοτήτων Default Value ή του Domain υπαρχόντων πεδίων, σε επίπεδο Feature Class με δεξί κλικ επιλέγεται Properties. Στην καρτέλα Fields εφαρμόζονται οι αλλαγές και η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Σημειώνεται ότι το είδος του πεδίου (type) δεν αλλάζει. Για τη διαγραφή ενός πεδίου στην καρτέλα Fields επιλέγεται το πεδίο και το πλήκτρο Delete από το πληκτρολόγιο. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 1.14 Δημιουργία μιας τάξης χωρικών στοιχείων (Feature Class).
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Εικόνα 1.15 Δημιουργία πεδίου ορισμού (domain) που ορίζεται από μια λίστα τιμών (coded values).
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Εικόνα 1.16 Δημιουργία πεδίου ορισμού (domain) που ορίζεται από τη μέγιστη και την ελάχιστη τιμή (range).
1.4.3 Δημιουργία πεδίου ορισμού τιμών των πεδίων των περιγραφικών ιδιοτήτων
 
Η δημιουργία ενός πεδίου ορισμού για τις τιμές των πεδίων των περιγραφικών ιδιοτήτων εξασφαλίζει την αποφυγή χονδροειδών σφαλμάτων κατά την εισαγωγή των τιμών.
Για τη δημιουργία ενός πεδίου ορισμού (domain) που ορίζεται από λίστα τιμών (coded values), σε επίπεδο Geodatabase με δεξί κλικ επιλέγεται Properties. Στην καρτέλα Domains ορίζονται τα ακόλουθα: το όνομα Domain Name, μια σύντομη περιγραφή του πεδίου ορισμού Description, η επιλογή του είδους του πεδίου στο οποίο θα εφαρμοστεί το πεδίο ορισμού Field Type και ως Domain Type επιλέγεται Coded Values. Στην περιοχή Coded values, στη στήλη Code πληκτρολογείται η πρώτη επιτρεπτή τιμή και στη στήλη Description πληκτρολογείται μια περιγραφή για την πρώτη επιτρεπτή τιμή. Τα δύο τελευταία στάδια επαναλαμβάνονται μέχρι να ολοκληρωθεί η εισαγωγή όλων των τιμών. Το πλήκτρο Apply δημιουργεί το πεδίο ορισμού, ενώ το πλήκτρο OK δημιουργεί το πεδίο ορισμού και κλείνει το παράθυρο (Εικόνα 1.15). 
Για τη δημιουργία ενός πεδίου ορισμού (domain) που ορίζεται από τη μέγιστη και την ελάχιστη τιμή (range), σε επίπεδο Geodatabase με δεξί κλικ επιλέγεται Properties. Στην καρτέλα Domains ορίζονται τα ακόλουθα: το όνομα του πεδίου ορισμού Domain Name, μια σύντομη περιγραφή του πεδίου ορισμού Description, η επιλογή του είδους του πεδίου στο οποίο θα εφαρμοστεί το πεδίο ορισμού Field Type, ως Domain Type επιλέγεται Range, ως Minimum value η ελάχιστη τιμή και ως Maximum value η μέγιστη τιμή. Το πλήκτρο OK δημιουργεί το πεδίο ορισμού και κλείνει το παράθυρο (Εικόνα 1.16). 
Για την αντιστοίχιση του πεδίου ορισμού (domain) στο σχετικό πεδίο, σε επίπεδο Feature Class με δεξί κλικ επιλέγεται Properties. Στην καρτέλα Fields επιλέγεται το πεδίο. Στη συνέχεια, στην ιδιότητα του πεδίου Field Properties>Domain με κλικ εμφανίζονται τα υπάρχοντα πεδία ορισμού που ταιριάζουν με το είδος του υπό επεξεργασία πεδίου και επιλέγεται το κατάλληλο. Το πλήκτρο Apply πραγματοποιεί τη σύνδεση με το πεδίο ορισμού ενώ το πλήκτρο OK πραγματοποιεί τη σύνδεση με το πεδίο ορισμού και κλείνει το παράθυρο.
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	Πεδίο ταυτοποίησης των εγγραφών του feature class είναι το objectιd που ορίζεται αυτόματα από το σύστημα.
	Πεδίο ταυτοποίησης των εγγραφών του χωρικού πίνακα είναι ένα πεδίο ελευθέρου ονόματος τύπου serial που ορίζεται ως πρωτεύον κλειδί από τον χρήστη.

	Το πεδίο καταχώρισης της γεωμετρίας καλείται Shape και οι πιθανές επιλογές είναι line, point, polygon κ.ά.
	Το πεδίο καταχώρισης της γεωμετρίας είναι ελευθέρου ονόματος, τύπου geometry και λαμβάνει τις τιμές point, linestring, polygon κ.ά.

	Δομή ομαδοποίησης των πινάκων είναι το feature dataset.
	Δομή ομαδοποίησης των πινάκων είναι το σχήμα (schema).

	Το σύστημα αναφοράς καταγράφεται σε επίπεδο feature dataset.
	Το σύστημα αναφοράς καταγράφεται σε κάθε χωρικό πίνακα.

	Το πεδίο τιμών των περιγραφικών οντοτήτων που χαρακτηρίζεται από εύρος τιμών ορίζεται με ένα domain τύπου range.
	Το πεδίο τιμών των περιγραφικών οντοτήτων που χαρακτηρίζεται από εύρος τιμών ορίζεται με ένα constraint.

	Το πεδίο τιμών των περιγραφικών οντοτήτων που χαρακτηρίζεται από μια λίστα τιμών ορίζεται με ένα domain τύπου coded values.
	Όταν το πεδίο τιμών των περιγραφικών οντοτήτων χαρακτηρίζεται από μια λίστα τιμών, χρησιμοποιείται ένας πίνακας κωδικοποίησης και πραγματοποιείται σύνδεση με τον χωρικό πίνακα βάσει των πεδίων που έχουν οριστεί ως πρωτεύον κλειδί και δευτερεύον κλειδί αντίστοιχα.


Πίνακας 1.8 Σύγκριση της γεωβάσης ArcGIS και της χωρικής βάσης PostgreSQL/PostGIS.
1.4.4 Εξαγωγή της δομής της βάσης
 
Η δομή της γεωβάσης μπορεί να εξαχθεί ως αρχείο xml και να απεικονιστεί γραφικά με το πρόγραμμα ArcGISDiagrammer (Εικόνα 1.15). Για την εξαγωγή του σχήματος της γεωβάσης σε μορφή XML, σε επίπεδο γεωβάσης με δεξί κλικ επιλέγεται Export>XML Workspace Document. Στο νέο παράθυρο επιλέγεται Schema Only και ορίζεται το αρχείο xml που θα δημιουργηθεί ως Specify the output XML file. Στη συνέχεια επιλέγεται Next και ακολουθεί η προεπισκόπηση του περιεχομένου και η απενεργοποίηση των ανεπιθύμητων δεδομένων. Η διαδικασία ολοκληρώνεται με το πλήκτρο Finish. 
Ακολούθως, εισάγεται το σχήμα της γεωβάσης στο ArcGIS Diagrammer και δημιουργείται το γράφημα του σχήματος. Από το σύστημα επιλέγεται Programs> ArcGIS Diagrammer. Στο περιβάλλον του ArcGIS Diagrammer επιλέγεται File>Open και υποδεικνύεται το αρχείο xml του σχήματος. Το πρόγραμμα δημιουργεί τη γραφική απόδοση του σχήματος (Εικόνα 1.17). Για την αποθήκευση του γραφήματος του σχήματος της γεωβάσης ως εικόνα, από το περιβάλλον του ArcGIS Diagrammer επιλέγεται Export και ακολουθεί ο ορισμός του ονόματος και του είδους του αρχείου.
1.5 Σύγκριση της γεωβάσης ArcGIS και της χωρικής βάσης PostgreSQL/PostGIS
 
Για την πληρέστερη κατανόηση των βάσεων δεδομένων που περιγράφηκαν, παρατίθενται οι δομές που χρησιμοποιήθηκαν για την υλοποίηση της βάσης χαρτογραφικών δεδομένων με  τη γεωβάση ArcGIS και τη χωρική βάση PostgreSQL/PostGIS (Πίνακας 1.8). 
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Εικόνα 1.17 Γραφική απεικόνιση μιας γεωβάσης μέσω του ArcGIS Diagrammer.
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Κριτήρια αξιολόγησης 
Στη συνέχεια ακολουθούν μια σειρά από κριτήρια αξιολόγησης με τη μορφή ερωτήσεων των οποίων οι απαντήσεις βρίσκονται εντός του κειμένου του κεφαλαίου. 
 
Κριτήριο αξιολόγησης 1 
Τι είναι τα θεματικά επίπεδα ενός χάρτη και πως συνδέονται με τον σχεδιασμό μιας βάσης χωρικών δεδομένων;
 
Κριτήριο αξιολόγησης 2 
Ποια ερωτήματα πρέπει να απαντηθούν κατά τη διαδικασία του εννοιολογικού σχεδιασμού;
 
Κριτήριο αξιολόγησης 3
Ποια ερωτήματα πρέπει να απαντηθούν κατά τη διαδικασία του λογικού σχεδιασμού;
 
Κριτήριο αξιολόγησης 4
Ποια ερωτήματα πρέπει να απαντηθούν κατά τη διαδικασία του φυσικού σχεδιασμού;
 
Κριτήριο αξιολόγησης 5
Πώς υλοποιείται η αποθήκευση της γεωμετρίας των δεδομένων σε μια βάση χωρικών δεδομένων;
 
Κριτήριο αξιολόγησης 6
Ποια εργαλεία ενός ΣΔΒΔ μπορούν να αξιοποιηθούν για την εξασφάλιση της ποιότητας μιας βάσης χωρικών δεδομένων;
 
Κριτήριο αξιολόγησης 7
Ποια είναι η αντιστοιχία των δομών που προσφέρει η γεωβάση του ArcGIS και η χωρική βάση Postgres/PostGIS;
Κεφάλαιο 2
Γεωαναφορά 
Σύνοψη 
Το κεφάλαιο αυτό αναφέρεται στη διαδικασία της γεωαναφοράς ή γεωγραφικής προσαρμογής που μετατρέπει το τοπικό σύστημα αναφοράς των συντεταγμένων του μέσου ψηφιοποίησης (π.χ. ψηφιοποιητή, οθόνης, σαρωτή) στο σύστημα απεικόνισης του εκάστοτε ψηφιοποιούμενου χάρτη. Επιπλέον, με τη διαδικασία της γεωαναφοράς συνορθώνονται οι παραμορφώσεις, λόγω των εγγενών ιδιοτήτων του υλικού (χαρτιού) εκτύπωσης από μεταβολές της θερμοκρασίας και υγρασίας αλλά και από τον τρόπο αναπαραγωγής του. Για το σκοπό αυτό χρησιμοποιείται ο ομοπαράλληλος (Affine) ή άλλος μετασχηματισμός ανάλογα με την κατάσταση του χάρτη. Αντικείμενο του κεφαλαίου, πέραν του μετασχηματισμού, είναι και ο τρόπος επιλογής του πλήθους και των θέσεων των σημείων γεωγραφικής προσαρμογής, η γεωμετρική ερμηνεία των συντελεστών του μετασχηματισμού, η κριτική αξιολόγηση του σφάλματος μετασχηματισμού και τα αποδεκτά όρια. Ακολουθεί λεπτομερής περιγραφή υλοποίησης της γεωαναφοράς σε περιβάλλον Συστήματος Γεωγραφικών Πληροφοριών.
Προαπαιτούμενη γνώση 
Χαρτογραφικές απεικονίσεις, Μέθοδος ελαχίστων τετραγώνων για την επίλυση συστημάτων γραμμικών εξισώσεων.
2. Γεωαναφορά 
 
Η ψηφιακή καταγραφή των χωρικών οντοτήτων από αναλογικό χάρτη, έχει αποτέλεσμα τη δημιουργία αρχείων με τις συντεταγμένες των σημείων τα οποία περιγράφουν τη γεωμετρία κάθε οντότητας. Οι συντεταγμένες αυτές αναφέρονται στο τοπικό σύστημα αναφοράς του μέσου ψηφιοποίησης (π.χ. ψηφιοποιητή, οθόνης, σαρωτή) και γι’ αυτό δεν έχουν γεωγραφική έννοια. Ως εκ τούτου, είναι απαραίτητη η υλοποίηση του μετασχηματισμού ο οποίος μετατρέπει τις συντεταγμένες των χωρικών οντοτήτων από το σύστημα αναφοράς του μέσου ψηφιοποίησης στο σύστημα απεικόνισης του εκάστοτε ψηφιοποιούμενου χάρτη. Ο μετασχηματισμός αυτός ονομάζεται γεωαναφορά ή γεωγραφική προσαρμογή.
Με τη γεωγραφική προσαρμογή επιλύεται το πρόβλημα της κλίμακας, μετάθεσης και στροφής (σε σχέση με το σύστημα αναφοράς του χάρτη) κατά την τυχαία τοποθέτηση του αναλογικού χάρτη στην επιφάνεια του μέσου ψηφιοποίησης (ψηφιοποιητής, οθόνη, σαρωτής). Επιπλέον, είναι γνωστό ότι κάθε έντυπος χάρτης παραμορφώνεται λόγω των ιδιοτήτων του υλικού (χαρτιού) εκτύπωσης, από μεταβολές της θερμοκρασίας και υγρασίας αλλά και από τον τρόπο αναπαραγωγής του. Είναι επομένως χρήσιμο, το μοντέλο που υλοποιεί τη γεωγραφική προσαρμογή να συνορθώνει ταυτόχρονα και τις παραμορφώσεις αυτές (διαφορετική κλίμακα κατά μήκος των αξόνων, μη καθετότητα των αξόνων). Κατάλληλο μοντέλο για τον σκοπό αυτό είναι ο ομοπαράλληλος μετασχηματισμός (Affine transformation) ή πολυωνυμικός μετασχηματισμός 1ου βαθμού (Τσούλος, 2008), (Νάκος, 2011).
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Εικόνα 2.1 Προβλήματα που επιλύει η γεωγραφική προσαρμογή.
Η γεωγραφική προσαρμογή υλοποιείται με τη χρήση βοηθητικών σημείων γεωγραφικής προσαρμογής/ελέγχου (registration/control points) για τα οποία είναι γνωστές οι συντεταγμένες και στα δύο συστήματα, ήτοι: αυτό του μέσου ψηφιοποίησης και του συστήματος απεικόνισης του χάρτη (Εικόνα 2.1). Ο αριθμός των σημείων εξαρτάται από το μοντέλο μετασχηματισμού που χρησιμοποιείται. Για την εφαρμογή του ομοπαράλληλου μετασχηματισμού (affine transformation), ο οποίος έχει έξι (6) άγνωστες παραμέτρους, απαιτούνται τουλάχιστον τρία (3) μη συνευθειακά σημεία.
Ο μετασχηματισμός υλοποιείται με βάση σύστημα γραμμικών εξισώσεων, το οποίο έχει τη γενική μορφή:
 
X = ax + by + c      
                                        Y = dx + ey + f                                            (2.1)
 
Στις εξισώσεις αυτές, άγνωστες είναι οι παράμετροι a,b,c,d,e,f ενώ οι καρτεσιανές συντεταγμένες των σημείων γεωγραφικής προσαρμογής στο σύστημα αναφοράς του χάρτη (Χ,Υ) και στο τοπικό σύστημα του εκάστοτε χρησιμοποιουμένου περιβάλλοντος ψηφιοποίησης (x,y) είναι γνωστές. Πρέπει να σημειωθεί ότι για την εφαρμογή του ομοπαράλληλου μετασχηματισμού, οι θέσεις των σημείων γεωγραφικής προσαρμογής/ελέγχου τα οποία επιλέγονται από τον χάρτη δίνονται σε καρτεσιανές συντεταγμένες ακόμη κι όταν επιλέγονται σημεία (διασταυρώσεις/τομές) του πλέγματος των μεσημβρινών και παραλλήλων (λ,φ). Τούτο διότι οι γεωγραφικές συντεταγμένες είναι γωνιακά μεγέθη στη σφαίρα (επιφάνεια σταθερής καμπυλότητας) ή στο ελλειψοειδές (επιφάνεια μεταβλητής καμπυλότητας) και οι εξισώσεις -ως γραμμικές- υλοποιούν μετασχηματισμό μεταξύ δύο επιπέδων επιφανειών ήτοι: του επιπέδου του συστήματος ψηφιοποίησης και του επιπέδου του προβολικού συστήματος στο οποίο αναφέρεται ο χάρτης. Για τον λόγο αυτό απαιτούνται, ανάλογα με το προβολικό σύστημα του χάρτη, μετασχηματισμοί οι οποίοι μετατρέπουν τις γεωγραφικές συντεταγμένες σε καρτεσιανές. Επομένως, εάν ο χάρτης διαθέτει μόνο γεωγραφικό πλέγμα (Εικόνα 2.2), πριν από τη διαδικασία της γεωγραφικής προσαρμογής, είναι απαραίτητη -ως προεργασία- η μετατροπή των γεωγραφικών συντεταγμένων των σημείων γεωγραφικής προσαρμογής/ελέγχου, σε καρτεσιανές στο προβολικό σύστημα στο οποίο έχει συνταχθεί ο χάρτης-πηγή.
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Εικόνα 2.2 Επιλογή σημείων γεωγραφικής προσαρμογής. 
Η επιλογή των θέσεων και του αριθμού των σημείων γεωγραφικής προσαρμογής/ελέγχου αποτελεί κρίσιμο στοιχείο για την αξιοπιστία του αποτελέσματος, επειδή η χωροθέτησή τους καθορίζει την περιοχή μέσα στην οποία διαμορφώνεται και εφαρμόζεται ο μετασχηματισμός. Ο μετασχηματισμός δεν αφορά μόνο στις θέσεις χαρτογραφικών δεδομένων αλλά και στις μεταξύ τους σχέσεις (αποστάσεις, γωνίες, αζιμούθια). Για τον λόγο αυτό, είναι επιθυμητό, τα σημεία γεωγραφικής προσαρμογής να κατανέμονται ομοιόμορφα στην περιοχή του χάρτη, ο οποίος αποτελεί αντικείμενο ψηφιακής καταγραφής, επειδή σε διαφορετική περίπτωση ο μετασχηματισμός υλοποιείται με βάση την αυθαίρετη υπόθεση πως ό,τι συμβαίνει ανάμεσα στα σημεία γεωγραφικής προσαρμογής/ελέγχου μπορεί να επεκταθεί και πέρα από αυτά. Επεκτείνεται δηλαδή το μοντέλο προσαρμογής και εκτός των ορίων του μοντέλου αυτού καθαυτού θεωρώντας ότι οι παραμορφώσεις είναι ομοιόμορφες.
Κατά τη διαδικασία του μετασχηματισμού είναι δυνατό να προκύψουν σφάλματα που μπορεί να οφείλονται σε:
 
	Παραμόρφωση του αρχικού μέσου, αν πρόκειται για έντυπο χάρτη.
	Εσφαλμένη ψηφιοποίηση ενός ή περισσοτέρων σημείων γεωγραφικής προσαρμογής/ελέγχου.
	Εσφαλμένη καταγραφή των συντεταγμένων των θέσεων των σημείων γεωγραφικής προσαρμογής/ελέγχου.
	Ανεπιτυχή επιλογή των θέσεων των σημείων γεωγραφικής προσαρμογής/ελέγχου.

 
Στην πράξη, για τη συνόρθωση των σφαλμάτων τα οποία μπορεί να προκύψουν, χρησιμοποιούνται περισσότερα από τρία (3) σημεία, ήτοι τέσσερα (4) έως εννέα (9). Ο προσδιορισμός των παραμέτρων του συστήματος των εξισώσεων που υλοποιούν τον ομοπαράλληλο μετασχηματισμό γίνεται με τη βοήθεια της μεθόδου των Ελαχίστων Τετραγώνων. Ως εκ τούτου είναι δυνατή η στατιστική εκτίμηση της ορθότητας του μετασχηματισμού μέσω του μέσου τετραγωνικού σφάλματος (Root Mean Square Error - RMSE).
Η τιμή του RMSE εξαρτάται από πολλούς παράγοντες, αλλά κυρίως από το είδος, την κλίμακα και την κατάσταση του χάρτη-πηγή. Η ακρίβεια ενός αναλογικού χάρτη είναι συνάρτηση της κλίμακας και της μεθόδου (ή των μεθόδων) παραγωγής και αναπαραγωγής του. Για έναν αναλογικό χάρτη, η αναμενόμενη ακρίβεια δεν μπορεί να ξεπερνάει την τιμή της διαχωριστικής ικανότητας του ανθρώπινου ματιού (0.2-0.25mm) η μετατροπή της οποίας στην κλίμακα, μπορεί να δώσει μια εκτίμηση για τις ανεκτές τιμές του σφάλματος μετασχηματισμού. Εν προκειμένω υφίστανται δυο περιπτώσεις:
 
	Ψηφιοποίηση σε περιβάλλον ψηφιοποιητή (digitizer). 
	Ψηφιοποίηση σε περιβάλλον οθόνης μετά από σάρωση του χάρτη πηγή (Heads-up digitization) ή γεωγραφική προσαρμογή raster εικόνας. 

 
Στην περίπτωση της ψηφιοποίησης σε ψηφιοποιητή, η αποδεκτή τιμή του μέσου τετραγωνικού σφάλματος, όπως αναφέρθηκε, πρέπει να είναι μικρότερη από τη διαχωριστική ικανότητα του ανθρώπινου ματιού (0.2-0.25 mm) εκφρασμένη στην κλίμακα του χάρτη. Η μετατροπή του χάρτη σε εικόνα ή η χρήση εικόνας γενικότερα, εισάγει στους παράγοντες που επηρεάζουν την ακρίβεια της γεωγραφικής προσαρμογής και το μέγεθος του φατνίου (pixel) του κανονικοποιημένου (raster) αρχείου. Μια εύλογη και αποδεκτή τιμή για το RMSE πρέπει να είναι μικρότερη ή ίση με το ½ του μεγέθους του φατνίου (pixel), η οποία προσδιορίζεται στις μονάδες του συστήματος αναφοράς της εικόνας (π.χ. μέτρα) με βάση την κλίμακα και την ανάλυσή της (resolution). Πρέπει να σημειωθεί ότι είναι εξαιρετικά απίθανο να προκύψει μηδενικό RMSE. Στην περίπτωση κατά την οποία συμβεί, αυτό σημαίνει είτε ότι είναι ανεπαρκής ο αριθμός των σημείων γεωγραφικής προσαρμογής/ελέγχου, είτε ότι ταυτίζονται τα συστήματα συντεταγμένων/αναφοράς (για παράδειγμα η εικόνα είναι ήδη γεωαναφερμένη). Σε περίπτωση που το RMSE το οποίο θα προκύψει δεν είναι αποδεκτό, ελέγχονται οι πιθανές πηγές σφάλματος που προαναφέρθηκαν και επαναλαμβάνεται η διαδικασία του μετασχηματισμού.
Θα πρέπει εδώ να αναφερθούν και ορισμένες ειδικές περιπτώσεις (Τσούλος, 2008). Στην περίπτωση κατά την οποία δεν διατίθενται τρία (3) τουλάχιστον σημεία γνωστών συντεταγμένων, είναι πρακτικά δυνατή η γεωγραφική προσαρμογή μέσω του μετασχηματισμού ομοιότητας με χρήση δύο (2) σημείων γεωγραφικής προσαρμογής/ελέγχου και τέσσερις (4) άγνωστες παραμέτρους. Οι εξισώσεις του μετασχηματισμού ομοιότητας έχουν τη μορφή:
 
Y = -bx +ay + c1
                                         X = ax + by + c2                                           (2.2)
 
Σημειώνεται ότι η χρήση του συγκεκριμένου μετασχηματισμού καλύπτει μόνο μεταφορά αρχής, στροφή και κλίμακα. Σε περιπτώσεις κατά τις οποίες η ποιότητα του χάρτη είναι κακή (π.χ. λόγω παλαιότητας), το μοντέλο μετασχηματισμού μπορεί να βελτιωθεί. Για τις περιπτώσεις αυτές, ο αλγόριθμος τροποποιείται ως προς τον βαθμό του δισδιάστατου πολυωνυμικού μετασχηματισμού. Δηλαδή, μπορεί να χρησιμοποιηθεί πλήρης δισδιάστατος πολυωνυμικός μετασχηματισμός συστήματος εξισώσεων 2ου βαθμού με δώδεκα (12) παραμέτρους, όπως δίνεται από τις παρακάτω σχέσεις:
 
X = a0+a1x+a2y+a3xy+a4x²+a5y²
                               Y = b0+b1x+b2y+b3xy+b4x²+b5y² 	                               (2.3)
 
Σε περίπτωση ψηφιοποίησης από χάρτη-πηγή ο οποίος είναι «διπλωμένος» (π.χ. λόγω αποθήκευσης), επειδή ο μετασχηματισμός δεν ισχύει στην περιοχή του άξονα του διπλώματος, συνιστάται η γεωγραφική προσαρμογή των δύο τμημάτων του χάρτη ξεχωριστά  και η συνακόλουθη προσαρμογή των επί μέρους τμημάτων είτε μέσω του περιβάλλοντος γραφικών του συστήματος ή μέσω μιας τοπικής προσαρμογής που είναι γνωστή ως rubber sheeting.
2.1. Η διαδικασία γεωαναφοράς στο QGIS 
 
Στο QGIS η γεωαναφορά υλοποιείται για δεδομένα τύπου raster (κανονικοποιημένα δεδομένα) σε περιβάλλον QGIS Desktop (“QGIS Training Manual”, χ.η.; “QGIS User Guide”, χ.η.).
2.1.1 Ενεργοποίηση και διαμόρφωση του περιβάλλοντος εργασίας στο Georeferencer
 
Από το μενού Raster επιλέγεται η ομάδα Georeferencer και το αντίστοιχο εργαλείο (Εικόνα 2.3) και ακολούθως ενεργοποιείται το παράθυρο επισκόπησης των δεδομένων που διατίθεται για την εικόνα.
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Εικόνα 2.3 Ενεργοποίηση του εργαλείου Georeferencer στο QGIS.
2.1.2 Εισαγωγή του κανoνικοποιημένου αρχείου (raster) του χάρτη και των σημείων γεωγραφικής προσαρμογής/ελέγχου
 
H προσθήκη της εικόνας γίνεται με το σχετικό πλήκτρο της γραμμής εργαλείων του Georeferencer (Εικόνα 2.4). Μετά την εμφάνιση της εικόνας, κάνοντας την κατάλληλη μεγέθυνση, προστίθενται τα σημεία γεωγραφικής προσαρμογής/ελέγχου και οι συντεταγμένες τους.
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Εικόνα 2.4 Η γραμμή εργαλείων του Georeferencer στο QGIS.
Η καταγραφή των συντεταγμένων του συστήματος αναφοράς γίνεται, εναλλακτικά, με δύο τρόπους: 
 
	Με την πληκτρολόγηση των τιμών τους στα πεδία X/East και Y/North (Εικόνα 2.5).
	Με τη λειτουργία From map canvas (Εικόνα 2.6) και την επιλογή του αντίστοιχου σημείου ενός γεωαναφερμένου διανυσματικού ή κανονικοποιημένου θεματικού επιπέδου το οποίο έχει ήδη προστεθεί στον χάρτη με τα αντίστοιχα πλήκτρα που επισημαίνονται στην Εικόνα 2.7.
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Εικόνα 2.5 Εισαγωγή συντεταγμένων για τα σημεία γεωγραφικής προσαρμογής/ελέγχου στο QGIS.
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Εικόνα 2.6 Έμμεση εισαγωγή συντεταγμένων μέσω επιλεγμένων θέσεων στον χάρτη, στο QGIS.
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Εικόνα 2.7 Προσθήκη διανυσματικού ή κανονικοποιημένου αρχείου στο QGIS.
Τα σημεία ελέγχου αποθηκεύονται σε text file, γεγονός που επιτρέπει την επανάληψη της γεωαναφοράς εάν απαιτηθεί.
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Εικόνα 2.8 Οι ρυθμίσεις του μετασχηματισμού στο QGIS.
 
2.1.3 Υλοποίηση της γεωαναφοράς
 
Επειδή το αρχείο το οποίο προέκυψε από τον μετασχηματισμό εικόνας έχει, μεταξύ των άλλων, στραφεί σε σχέση με την αρχικές διευθύνσεις των γραμμών του κανάβου, απαιτείται να επαναληφθεί ο υπολογισμός των τιμών των φατνίων (τα οποία έχουν αλλάξει θέσεις). Για τον σκοπό αυτό, από το μενού Settings>Transformation settings επιλέγεται ο κατάλληλος μετασχηματισμός, η μέθοδος αναδειγματοληψίας (resampling), ορίζεται το όνομα του κανονικοποιημένου αρχείου το οποίο θα δημιουργηθεί, καθώς και άλλα στοιχεία (προαιρετικά) όπως φαίνεται στην Εικόνα 2.8. 
Από τους διαθέσιμους αλγορίθμους μετασχηματισμού επιλέγεται ο Polynomial 1 ενώ από τις διαθέσιμες μεθόδους αναδειγματοληψίας επιλέγεται συνήθως αυτή του Πλησιέστερου Γείτονα (Nearest neighbour) (Εικόνα 2.13). Εναλλακτικές προσεγγίσεις αποτελούν οι μέθοδοι της Διγραμμικής παρεμβολής (Bilinear Interpolation) και της Κυβικής συνέλιξης (Cubic Convolution). 
Η μέθοδος της Διγραμμικής παρεμβολής:
 
	Λαμβάνει υπόψη τις τιμές των τεσσάρων (4) πλησιέστερων φατνίων σε συνάρτηση με συντελεστή βάρους για την απόσταση από το φατνίο του οποίου υπολογίζεται η τιμή.
	Εφαρμόζεται μόνο σε συνεχείς οντότητες.
	Απαιτεί περισσότερο χρόνο.
	Έχει αποτέλεσμα την εξομάλυνση των δεδομένων.

 
Η μέθοδος της Κυβικής συνέλιξης:
 
	Λαμβάνει υπόψη τις τιμές των δεκαέξι (16) πλησιέστερων φατνίων σε συνάρτηση με συντελεστή βάρους για την απόσταση από το φατνίο του οποίου υπολογίζεται η τιμή.
	Εφαρμόζεται μόνο σε συνεχείς οντότητες.
	Έχει αποτέλεσμα περαιτέρω εξομάλυνση των τιμών των δεδομένων.
	Είναι η πλέον απαιτητική σε υπολογισμούς και χρονοβόρα μέθοδος.

 
Οι επιλογές αυτές εξαρτώνται από το είδος των δεδομένων και από το προσδοκώμενο αποτέλεσμα. Η υλοποίηση της γεωαναφοράς και η δημιουργία του νέου κανονικοποιημένου αρχείου γίνεται με το πλήκτρο εκτέλεσης (Εικόνα 2.4). Ο πίνακας με τα σημεία γεωγραφικής προσαρμογής/ελέγχου περιλαμβάνει τις συντεταγμένες τους στα δύο συστήματα, καθώς και το RMSE σε pixels (Εικόνα 2.9) ή στις μονάδες του χάρτη (map units) (Εικόνα 2.10) ανάλογα με τη ρύθμιση μέσω του μενού Georeferencer>Settings>Configure Georeferencer.
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Εικόνα 2.9 Πίνακας σημείων γεωγραφικής προσαρμογής και RMSE σε pixels, στο QGIS.
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Εικόνα 2.10 Πίνακας σημείων γεωγραφικής προσαρμογής και RMSE σε μονάδες χάρτη, στο QGIS.
Αν κριθεί απαραίτητο, από τον πίνακα των σημείων γεωγραφικής προσαρμογής/ελέγχου μπορεί να διαγραφεί ένα ή περισσότερα σημεία γεωγραφικής προσαρμογής/ελέγχου.
2.2. Η διαδικασία γεωαναφοράς στο ArcGIS
 
Στο ArcGIS η γεωαναφορά υλοποιείται για δεδομένα τύπου raster (κανονικοποιημένα δεδομένα) σε περιβάλλον ArcMap (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α, Τσούλος, Σκοπελίτη & Στάμου, 2015β). Η ενεργοποίησή του καθώς και η διαμόρφωση του περιβάλλοντος εργασίας, παρατίθενται στο Παράρτημα Β, §Β.5.1-§Β5.4. Γίνεται αναφορά σε κανονικοποιημένα δεδομένα, διότι στις περισσότερες των περιπτώσεων ο χάρτης-πηγή σαρώνεται και χρησιμοποιείται ως εικόνα. Στις διαδικασίες που περιγράφονται στη συνέχεια, έχουν χρησιμοποιηθεί οι εκδόσεις ArcGIS 10.1 και ArcGIS 10.2. H διαδικασία της γεωαναφοράς μπορεί να γίνει:
 
	Με τις συντεταγμένες σημείων κοινών και στα δύο επίπεδα.
	Με άλλο raster dataset.
	Με vector layer.
	Με άλλο raster dataset, αυτόματα.

 
Εδώ θα παρουσιαστεί αναλυτικά η τυπική περίπτωση γεωγραφικής προσαρμογής με τη χρήση ορθογωνίων συντεταγμένων. Οι γενικές οδηγίες για την ενεργοποίηση και τη διαμόρφωση του περιβάλλοντος εργασίας στο ArcMap περιλαμβάνονται στο Παράρτημα Β. Στο περιβάλλον εργασίας ArcMap και στο πλαίσιο μιας χαρτοσύνθεσης (map document - mxd) επιλέγεται η κατάσταση λειτουργίας Data view (επισκόπηση δεδομένων), από τη βάση του παραθύρου επισκόπησης των δεδομένων. Από το μενού Customize>Toolbars ενεργοποιείται η γραμμή εργαλείων Georeference toolbar και με το αριστερό πλήκτρο του ποντικιού σύρεται και τοποθετείται στη γκρίζα περιοχή των εργαλείων (Εικόνα 2.11).
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Εικόνα 2.11 Η γραμμή εργαλείων γεωαναφοράς στο ArcMap.
2.2.1 Εισαγωγή του κανονικοποιημένου αρχείου (raster) του χάρτη
 
Από τη Standard toolbar με το πλήκτρο Add Data, επιλέγεται το κανονικοποιημένο (raster) αρχείο του χάρτη που πρόκειται να γεωαναφερθεί (Εικόνα 2.12).
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Εικόνα 2.12 Εισαγωγή του κανονικοποιημένου αρχείου στο ArcMap.
2.2.2 Εισαγωγή των σημείων γεωγραφικής προσαρμογής/ελέγχου 
 
Από τη Georeference Toolbar επιλέγεται το πλήκτρο Add control points. Στην κατάλληλη μεγέθυνση, με τη χρήση του ποντικιού και αριστερό κλικ, ψηφιοποιείται η θέση του σημείου γεωγραφικής προσαρμογής (registration point) και στη συνέχεια με το πάτημα του δεξιού κουμπιού του ποντικιού (δεξί κλικ) αναδύεται ένα μενού λειτουργιών. Από την επιλογή Input X and Y (με αριστερό κλικ) γίνεται η εισαγωγή των συντεταγμένων του συγκεκριμένου σημείου (Εικόνα 2.13). Η διαδικασία επαναλαμβάνεται για το σύνολο των σημείων γεωγραφικής προσαρμογής τα οποία θα χρησιμοποιηθούν.
2.2.3 Υλοποίηση και αποθήκευση της γεωαναφοράς
 
Ο έλεγχος της ακρίβειας του μετασχηματισμού γίνεται από το σφάλμα του μετασχηματισμού, το οποίο εμφανίζεται μαζί με τις συντεταγμένες των σημείων σε ένα παράθυρο στο εικονίδιο View Link Table της Georeference toolbar (§2.2, Εικόνα 2.11). Το RMSE υπολογίζεται στις μονάδες των συντεταγμένων που έχουν εισαχθεί, εν προκειμένω μέτρα (Εικόνα 2.14). Αν κριθεί απαραίτητο, από τον πίνακα των σημείων γεωγραφικής προσαρμογής/ελέγχου μπορεί να γίνει η διαγραφή ενός ή περισσότερων σημείων. Η γεωαναφορά αποθηκεύεται μόνιμα για το κανονικοποιημένο αρχείο, από τη λίστα επιλογών του μενού Georeferencing>Update Georeferencing (§2.2, Εικόνα 2.11).
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Εικόνα 2.13 Προσθήκη σημείου γεωγραφικής προσαρμογής στο ArcMap.
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Εικόνα 2.14 Πίνακας σημείων γεωγραφικής προσαρμογής και RMSE στο ArcMap.
2.2.4 Αναδειγματοληψία
 
Η αναδειγματοληψία εικόνας σε περιβάλλον ArcMap υλοποιείται με το εργαλείο Georeferencing>Rectify και υποστηρίζονται οι μέθοδοι του πλησιέστερου γείτονα (nearest neighbor), διγραμμικής παρεμβολής (bilinear interpolation) και κυβικής συνέλιξης (cubic convolution). Στην περίπτωση αυτή, το αποτέλεσμα της διαδικασίας αποθηκεύεται σε ένα νέο raster αρχείο (Name), για το οποίο εκτός από τη μέθοδο αναδειγματοληψίας (Resampling Type) ορίζονται επίσης, o μορφότυπος (format), το μέγεθος του φατνίου και ο τύπος συμπίεσης (NONE, LZ77, JPEG, JPEG2000) (Εικόνα 2.15).
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Εικόνα 2.15 Αποθήκευση συνορθωμένου αρχείου κατά την αναδειγματοληψία στο ArcMap.
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Κριτήρια αξιολόγησης 
Κριτήριο αξιολόγησης 1
Αναφερθείτε στην αναγκαιότητα και τη σκοπιμότητα της γεωαναφοράς.
 
Κριτήριο αξιολόγησης 2
Περιγράψατε τον τρόπο εντοπισμού εσφαλμένης γεωαναφοράς και τις πιθανές αιτίες που την προκαλούν. Στη συνέχεια αναφερθείτε στον τρόπο αποκατάστασης του συγκεκριμένου προβλήματος. 
 
 
Κριτήριο αξιολόγησης 3
Είναι πρακτικά δυνατή η χρήση γεωγραφικών συντεταγμένων για τα σημεία γεωγραφικής προσαρμογής; Τεκμηριώστε την απάντηση.
 
Κριτήριο αξιολόγησης 4
Αναφερθείτε στους λόγους για τους οποίους είναι απαραίτητη η αναδειγματοληψία σε αρχεία κανονικοποιημένης δομής για την ολοκλήρωση της γεωαναφοράς.
 
Κεφάλαιο 3 
Ψηφιακή καταγραφή χωρικών οντοτήτων 
Σύνοψη
Στο κεφάλαιο αυτό, παρουσιάζονται οι μέθοδοι που αφορούν στην ψηφιακή καταγραφή χωρικών οντοτήτων οι οποίες προέρχονται από αναλογικές πηγές. Πρόκειται για τις μεθόδους της χειροκίνητης ψηφιοποίησης, της αυτόματης και της ημιαυτόματης διανυσματοποίησης. Η επιλογή της κατάλληλης μεθόδου γίνεται με βάση τόσο το περιεχόμενο της αναλογικής πηγής, όσο και το είδος των οντοτήτων.
Προαπαιτούμενη γνώση 
Μοντέλα ψηφιακών δεδομένων (vector – raster).
3. Ψηφιακή καταγραφή χωρικών οντοτήτων
 
Για την ένταξη σε ψηφιακό περιβάλλον των χωρικών οντοτήτων που απεικονίζονται σε χάρτες αναλογικής μορφής, απαιτείται η χρήση εργαλείων λογισμικού τα οποία επιτρέπουν την καταγραφή των γεωμετρικών τους χαρακτηριστικών, δηλαδή της θέσης τους στο γεωγραφικό χώρο και της μορφής τους, και παράλληλα, την καταγραφή των περιγραφικών τους χαρακτηριστικών (attributes), δηλαδή των ιδιοτήτων που τα προσδιορίζουν εννοιολογικά/ποσοτικά.
Η συγκρότηση των χωρικών οντοτήτων σε ψηφιακό περιβάλλον στηρίζεται στην άρρηκτη και λειτουργική σύνδεση των γεωμετρικών στοιχείων των οντοτήτων με τα αντίστοιχα περιγραφικά χαρακτηριστικά. Τα γεωμετρικά στοιχεία είναι προϊόν της μετάπτωσης των χωρικών οντοτήτων σε μία από τις τρεις βασικές κατηγορίες γεωμετρικών αρχετύπων: σημειακά, γραμμικά και επιφανειακά, είναι δε ο γραφικός τρόπος με τον οποίο αναπαριστώνται στην οθόνη ή στο χαρτί, με τη χρήση των κατάλληλων γραφικών στοιχείων (συμβόλων). Η εισαγωγή στοιχείων κατά την ψηφιακή καταγραφή έχει δύο σκέλη:
 
	Εισαγωγή των γεωμετρικών στοιχείων.
	Εισαγωγή των αντιστοίχων περιγραφικών χαρακτηριστικών (ιδιοτήτων).

 
Το λογισμικό το οποίο χρησιμοποιείται για την εισαγωγή στοιχείων από αναλογικές πηγές, υποστηρίζει διάφορες μεθόδους ψηφιακής καταγραφής:
 
	χειροκίνητη ψηφιοποίηση,
	αυτόματη διανυσματοποίηση,
	ημιαυτόματη ή αλληλεπιδρούσα διανυσματοποίηση.

 
Η επιλογή της μεθόδου εξαρτάται από το περιεχόμενο του χάρτη-πηγή που χρησιμοποιείται και από τα εγγενή χαρακτηριστικά των χωρικών οντοτήτων.
3.1 Μέθοδος χειροκίνητης ψηφιοποίησης 
 
Η μέθοδος της χειροκίνητης ψηφιοποίησης ακολουθείται για διακριτές χωρικές οντότητες, οι οποίες πρέπει να επιλεγούν από ένα πλήθος διαφορετικών χωρικών οντοτήτων που περιέχει μια αναλογική χαρτογραφική πηγή (όπως για παράδειγμα ένας τοπογραφικός χάρτης). Η μέθοδος μπορεί να υποστηρίξει την καταγραφή όλων των κατηγοριών γεωμετρίας χωρικών οντοτήτων (σημειακές, γραμμικές, επιφανειακές) και έχει αποτέλεσμα τη δημιουργία αρχείων διανυσματικής (vector) δομής. Για μεγάλο χρονικό διάστημα η χειροκίνητη ψηφιοποίηση γινόταν με ειδικές επίπεδες ηλεκτρομαγνητικές συσκευές, τους ψηφιοποιητές (digitizers) (Τσούλος, 2008). Καθώς οι ψηφιοποιητές έχουν αντικατασταθεί πλέον από τις οθόνες, η χειροκίνητη ψηφιοποίηση είναι γνωστή ως heads-up digitization, εκτελείται στην οθόνη σε περιβάλλον εξειδικευμένου λογισμικού. Με τη χρήση του ποντικιού ο χρήστης ακολουθεί το ίχνος (tracing) κάθε χωρικής οντότητας που εμφανίζεται στην εικόνα και αποτελεί αντικείμενο ψηφιακής καταγραφής. Η ακρίβεια της καταγραφής εξαρτάται από την κλίμακα του χάρτη-πηγή και από την ακρίβεια της γεωαναφοράς. Παρά το γεγονός ότι με τα εργαλεία μεγέθυνσης και σμίκρυνσης που διατίθενται στο πλαίσιο του εκάστοτε λογισμικού, δίνεται η δυνατότητα επισκόπησης των οντοτήτων σε μεγάλο βαθμό μεγέθυνσης, ξεπερνώντας τα όρια που θέτει η διαχωριστική ικανότητα του ανθρώπινου ματιού, εν τούτοις αυτό δεν βελτιώνει (δεν αυξάνει) την πυκνότητα της αρχικής πληροφορίας, δεδομένου ότι η πυκνότητα των χαρακτηριστικών σημείων των οντοτήτων του αναλογικού χάρτη ο οποίος χρησιμοποιείται ως πηγή δεν μεταβάλλεται. Επομένως, η αξιοποίηση των εργαλείων μεγέθυνσης και σμίκρυνσης κατά την ψηφιοποίηση των οντοτήτων διευκολύνει την οπτική πρόσβαση στα δεδομένα αλλά δεν πρέπει να δημιουργείται η ψευδής εντύπωση ότι βελτιώνεται και η πληροφορία της αρχικής αναλογικής πηγής.
Η ψηφιακή καταγραφή των χωρικών οντοτήτων γίνεται με βάση την ερμηνεία των αντίστοιχων χαρτογραφικών συμβόλων, τόσο για τη θέση όσο και για τα περιγραφικά χαρακτηριστικά (ιδιότητες). Η θέση των σημειακών χαρτογραφικών στοιχείων ψηφιοποιείται στο γεωμετρικό κέντρο του σημειακού συμβόλου, ενώ η θέση των γραμμικών στοιχείων ψηφιοποιείται με βάση τον άξονα συμμετρίας του αντίστοιχου συμβόλου, καθώς αυτοί είναι οι τρόποι εφαρμογής των συμβόλων κατά τη σύνθεση του χάρτη. Για τα επιφανειακά χωρικά στοιχεία, καταγράφεται η θέση του περιγράμματός τους, το οποίο υλοποιείται με ένα γραμμικό σύμβολο, οπότε ακολουθείται η ίδια πρακτική με εκείνη των γραμμικών χωρικών στοιχείων. Γενικά, με τη μέθοδο αυτή, οι γραμμικές οντότητες αντιμετωπίζονται και καταγράφονται ως τεθλασμένες γραμμές, δηλαδή ως μια αλληλουχία κορυφών και ευθύγραμμων τμημάτων. Αν το χρησιμοποιούμενο λογισμικό διαθέτει κι άλλα εργαλεία, μπορούν να ψηφιοποιηθούν ανάλογα με τη μορφή τους και ως κύκλοι, ορθογώνια παραλληλόγραμμα κλπ. Για την καταγραφή ενός σημείου απαιτείται ένα ζεύγος συντεταγμένων (x,y) (Εικόνα 3.1α), ενώ για την καταγραφή μιας γραμμής απαιτείται η καταγραφή μια ακολουθίας ζευγών συντεταγμένων (x,y) (Εικόνα 3.1β).
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Εικόνα 3.1 Ψηφιοποίηση σημείου (α) και γραμμής (β).
Η προετοιμασία του αναλογικού χάρτη ο οποίος θα ψηφιοποιηθεί, παίζει σημαντικό ρόλο στην εξέλιξη της διαδικασίας καταγραφής. Είναι σκόπιμο, πριν από την καταγραφή, να εξεταστεί το περιεχόμενο του χάρτη και να ελεγχθεί η κατάστασή του, με σκοπό την επισήμανση χαρακτηριστικών σημείων ψηφιοποίησης και τον εντοπισμό προβλημάτων, όπως για παράδειγμα ασαφείς τομές μεταξύ γραμμικών χωρικών οντοτήτων, σημεία διακοπής γραμμικών χωρικών οντοτήτων, αρχή/τέλος κλειστών πολυγώνων κ.ά. Η προσέγγιση αυτή συμβάλλει στη χάραξη της τακτικής η οποία θα ακολουθηθεί στην αντιμετώπιση των προβλημάτων που ενδεχομένως προκύψουν. Εφόσον υποστηρίζεται από το χρησιμοποιούμενο λογισμικό, η ψηφιακή καταγραφή γίνεται παράλληλα για τη θέση των χωρικών οντοτήτων και για τα αντίστοιχα περιγραφικά χαρακτηριστικά. Αν η παράλληλη καταγραφή θέσης και ιδιοτήτων δεν υποστηρίζεται, η εκχώρηση των ιδιοτήτων γίνεται είτε σε δεύτερο χρόνο, είτε με έμμεσο τρόπο (π.χ. αποθήκευση σε διαφορετικά θεματικά επίπεδα (layers) ανάλογα με τις τιμές των ιδιοτήτων), πρακτική όμως που σήμερα θεωρείται ξεπερασμένη. Μετά την ολοκλήρωση της ψηφιακής καταγραφής, ακολουθούν ο έλεγχος και η διόρθωση για τα σφάλματα της ψηφιοποίησης ή/και της εκχώρησης των ιδιοτήτων. 
3.2 Μέθοδος αυτόματης διανυσματοποίησης
 
Η αυτόματη διανυσματοποίηση αφορά τη μετατροπή δεδομένων κανονικοποιημένης δομής (raster) σε διανυσματικά και υλοποιείται μέσω μιας εικόνας, η οποία συνήθως έχει προέλθει από σάρωση και στη συνέχεια, για να αξιοποιηθεί χαρτογραφικά, έχει γεωαναφερθεί. Κάθε εικόνα κανονικοποιημένης (raster) δομής αποτελείται από ένα κανονικό πλέγμα φατνίων. Οι τιμές των φατνίων εξαρτώνται από το αν η εικόνα είναι έγχρωμη ή ασπρόμαυρη. Σε μια έγχρωμη εικόνα οι τιμές των φατνίων, εξαρτώνται από τον τρόπο που έχει δημιουργηθεί η εικόνα και από το είδος των οντοτήτων. Στη γενική περίπτωση, κάθε φατνίο χαρακτηρίζεται από τιμή η οποία αντιστοιχεί στη σύνθεση των συνιστωσών R,G,B (Red, Green, Blue) του χρώματος του φατνίου. Στην ασπρόμαυρη (δυαδική/binary) εικόνα, οι τιμές που έχουν τα φατνία είναι είτε 1 για το κενό (λευκό/nodata) και 0 για τα φατνία που αντιστοιχούν σε δεδομένα (μαύρο/data), είτε αντίστροφα 0 και 1, ανάλογα με τη χρησιμοποιούμενη κωδικοποίηση που εφαρμόζει το λογισμικό χρήσης. Επομένως η αυτόματη διανυσματοποίηση αφορά τη μετατροπή όλων των φατνίων της εικόνας που έχουν την τιμή η οποία αντιστοιχεί στα δεδομένα (μαύρο/data) σε διανύσματα (Εικόνα 3.2). 
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Εικόνα 3.2 Διανυσματοποίηση. 
Η υλοποίηση αυτής της μεθόδου, έχει αποτέλεσμα τη μετατροπή του συνόλου των φατνίων της εικόνας σε διανύσματα, αλλά το αποτέλεσμα εξαρτάται από το λογισμικό και την ανάλυση (resolution) της εικόνας. Για παράδειγμα, στο QGIS εφαρμόζεται μόνο για τη δημιουργία πολυγωνικών χωρικών οντοτήτων. Επισημαίνεται ότι ακόμη και τα σύμβολα με τα οποία αποδίδεται χαρτογραφικά το περίγραμμα των πολυγώνων, μετατρέπονται σε πολύγωνα (Εικόνα 3.3). Το γεγονός αυτό περιορίζει ιδιαίτερα τη χρήση του συγκεκριμένου λογισμικού για την αυτόματη διανυσματοποίηση. 
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Εικόνα 3.3 Αυτόματη διανυσματοποίηση στο QGIS.
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Εικόνα 3.4 Αυτόματη διανυσματοποίηση ομοειδών γραμμικών οντοτήτων στο ArcGIS.
Στο ArcGIS εφαρμόζεται για γραμμικά χωρικά δεδομένα και έχει τη βέλτιστη απόδοση όταν εφαρμόζεται σε δεδομένα τα οποία είναι απολύτως ομοειδή κι έχουν κοινές τιμές ιδιοτήτων (π.χ. ακτογραμμή, Εικόνα 3.4). Η εφαρμογή της σε μια εικόνα η οποία περιέχει πλήθος ανομοιογενών χαρτογραφικών στοιχείων, έχει αποτέλεσμα τη μετατροπή του συνόλου του περιεχομένου της σε διανυσματική μορφή, αδιακρίτως (Εικόνα 3.5) και την ένταξή τους σε μια κλάση γραμμικών χωρικών οντοτήτων.
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Εικόνα 3.5 Αυτόματη διανυσματοποίηση εικόνας με πλήθος μη ομοειδών στοιχείων στο ArcGIS.
3.3 Μέθοδος ημιαυτόματης ή αλληλεπιδρούσας διανυσματοποίησης
 
Η ημιαυτόματη ή αλληλεπιδρούσα (interactive) διανυσματοποίηση επιλέγεται ως μέθοδος ψηφιακής καταγραφής για δεδομένα τα οποία είναι ομοειδή, αλλά απαιτείται η καταγραφή διαφορετικών τιμών σε ένα ή περισσότερα περιγραφικά χαρακτηριστικά (attributes). Κατά την υλοποίησή της, ο χρήστης καθοδηγεί το λογισμικό και ελέγχει ως ένα βαθμό το αποτέλεσμα. Στο περιβάλλον λογισμικού ArcGIS επιλέγεται για γραμμικά και επιφανειακά δεδομένα, ενώ το λογισμικό QGIS δεν υποστηρίζει αυτή τη μέθοδο.
3.4 Η διαδικασία χειροκίνητης ψηφιοποίησης στο QGIS
 
Η ψηφιοποίηση υλοποιείται σε περιβάλλον QGIS Desktop (“QGIS Training Manual”, χ.η.; “QGIS User Guide”, χ.η.). Αφού ενεργοποιηθεί, εισάγεται η γεωαναφερμένη εικόνα από το μενού Layer>Add Layer>Add Raster Layer και στη συνέχεια:
 
	Eίτε εισάγεται ένα υπάρχον διανυσματικό θεματικό επίπεδο από το μενού Layer>Add Layer>Add Vector Layer.
	Eίτε δημιουργείται ένα καινούργιο θεματικό επίπεδο τύπου shapefile από το μενού Layer>Create layer>New Shapefile Layer, ορίζοντας και τα σχετικά πεδία ιδιοτήτων (attributes) όπως αυτά προσδιορίζονται από τον σχεδιασμό της βάσης δεδομένων.

 
Τα εργαλεία ψηφιοποίησης βρίσκονται σε δυο εργαλειοθήκες: την εργαλειοθήκη Digitizing και την εργαλειοθήκη Advanced digitizing που εμφανίζονται με δεξί κλικ στην γκρίζα περιοχή των εργαλείων. Από το μενού Settings>Options και την επιλογή Digitizing ρυθμίζεται η παράμετρος σύμπτωσης θέσεων (snap mode) για κάθε νέα οντότητα σε σχέση με ήδη υπάρχοντα στοιχεία καθώς και η απόσταση (σε εικονοστοιχεία/pixels ή μονάδες συστήματος αναφοράς του χάρτη/ map units) εντός της οποίας θα εφαρμοστεί η αναζήτηση και η σύμπτωση θέσης. Οι διαθέσιμες επιλογές ψηφιοποίησης είναι:
 
	To vertex (σε κορυφή).
	To segment (σε ευθύγραμμο τμήμα).
	To vertex and segment (σε κορυφή και ευθύγραμμο τμήμα).

 
Οι ρυθμίσεις για τη σύμπτωση των θέσεων γίνονται ανά θεματικό επίπεδο (layer based), δηλαδή μετά την εισαγωγή τουλάχιστον μιας οντότητας στο εκάστοτε θεματικό επίπεδο και δηλώνονται μέσω του μενού Settings>Snapping Options. Χρήσιμες είναι οι ακόλουθες ρυθμίσεις (βλ. και Εικόνα 3.6):
 
	Enable snapping on intersection, που επιτρέπει τη σύμπτωση στην τομή με ένα άλλο υποκείμενο θεματικό επίπεδο (background layer).
	Avoid intersections of new polygons (για πολυγωνικές οντότητες), που επιτρέπει την ψηφιοποίηση ενός νέου πολυγώνου χωρίς να απαιτείται η ακριβής σύμπτωση με τα γειτονικά πολύγωνα.
	Enable topological editing, που εξασφαλίζει ότι τα κοινά όρια διατηρούνται σωστά στα πολυγωνικά θεματικά επίπεδα.
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Εικόνα 3.6 Επιλογές σύμπτωσης θέσεων στο QGIS.
Η ψηφιακή καταγραφή υλοποιείται σε περιβάλλον διόρθωσης (editing). Το περιβάλλον διόρθωσης ενεργοποιείται με το πλήκτρο Toggle editing [image: ]. Ανάλογα με τη γεωμετρία του θεματικού επιπέδου στο οποίο θα ενταχθούν οι οντότητες που ψηφιοποιούνται, ενεργοποιούνται τα σχετικά εργαλεία ψηφιοποίησης (Add Features):
 
	Ψηφιοποίηση γραμμικών οντοτήτων [image: ].
	Ψηφιοποίηση σημειακών οντοτήτων [image: ].
	Ψηφιοποίηση επιφανειακών οντοτήτων [image: ].

 
Για τα σημειακά στοιχεία, η ψηφιοποίηση της θέσης γίνεται με αριστερό κλικ στο κέντρο του σημειακού συμβόλου, ενώ για τα γραμμικά καταγράφεται με διαδοχικά αριστερά κλικ η θέση του άξονα του γραμμικού συμβόλου. Το τέλος της γραμμής επισημαίνεται με δεξί κλικ. Για τα επιφανειακά χωρικά στοιχεία, καταγράφεται το περίγραμμα του πολυγώνου. Μετά την ολοκλήρωση της ψηφιοποίησης της θέσης, ενεργοποιείται αυτόματα ο διάλογος για την εισαγωγή τιμών στα πεδία των ιδιοτήτων (attributes). Η αλλαγή των προεπιλεγμένων συμβόλων γίνεται με δεξί κλικ στο θεματικό επίπεδο (από τον πίνακα περιεχομένων) και την επιλογή Properties>Style. Η αποθήκευση των αλλαγών και των διορθώσεων στο θεματικό επίπεδο γίνεται με το πλήκτρο Save Layer Edits [image: ]. 
Κατά τη διαδικασία της ψηφιακής καταγραφής, ανεξάρτητα από τη μέθοδο, είναι μάλλον ή βέβαιο ότι θα απαιτηθούν χειρισμοί διορθώσεων. Οι πιο συνηθισμένες διορθώσεις περιλαμβάνουν:
 
	Επιλογή οντότητας, με το εργαλείο [image: ].
	Διαγραφή οντότητας, με το εργαλείο [image: ] ή [image: ].
	Διαχείριση κορυφών (τεθλασμένης) γραμμής.

 
Ειδικότερα για τη διαχείριση των κορυφών μιας τεθλασμένης γραμμής, με το εργαλείο [image: ] επιλέγεται η οντότητα στης οποίας τις κορυφές θα γίνουν αλλαγές. Η επιλογή μιας κορυφής γίνεται με αριστερό κλικ, η επιλογή πολλών κορυφών γίνεται με <Ctrl> αριστερό κλικ, η επιλογή δύο διαδοχικών κορυφών γίνεται με αριστερό κλικ στο ευθύγραμμο τμήμα (segment) που ανήκουν. Η διαγραφή των επιλεγμένων κορυφών γίνεται από το πληκτρολόγιο με το πλήκτρο <Delete>. Η μετακίνηση κορυφών γίνεται μετά την επιλογή τους, σύροντάς τες (drag) στη νέα θέση κρατώντας πατημένο το αριστερό πλήκτρο του ποντικιού. Η προσθήκη νέων κορυφών γίνεται με διπλό κλικ επάνω ή κοντά σε ένα ευθύγραμμο τμήμα της γραμμής. Άλλες συνηθισμένες διορθώσεις γίνονται ως ακολούθως:
 
	Αντιγραφή οντότητας, με το εργαλείο [image: ].
	Επικόλληση οντότητας, με το εργαλείο [image: ].
	Μετακίνηση οντότητας, με το εργαλείο [image: ].
	Περιστροφή οντότητας, με το εργαλείο [image: ].
	Περιστροφή σημειακού συμβόλου, με το εργαλείο [image: ].
	Τροποποίηση μορφής, με το εργαλείο [image: ].
	Κατάτμηση, με το εργαλείο [image: ].
	Συνένωση, με το εργαλείο [image: ].

 
3.5 Η διαδικασία αυτόματης διανυσματοποίησης στο QGIS
 
Η ψηφιακή καταγραφή με την αυτόματη διανυσματοποίηση, γίνεται από το μενού Raster>Conversion>Polygonize (Raster to Vector) (Εικόνα 3.7).
3.6 Η διαδικασία χειροκίνητης ψηφιοποίησης στο ArcGIS
 
Στο ArcGIS η ψηφιοποίηση γίνεται σε περιβάλλον ArcMap (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β). Η ενεργοποίησή του καθώς και η διαμόρφωση του περιβάλλοντος εργασίας, παρατίθενται στο Παράρτημα Β, §Β.5.1 - §Β5.4. Στις διαδικασίες που περιγράφονται στη συνέχεια, έχουν χρησιμοποιηθεί οι εκδόσεις ArcGIS 10.1 και ArcGIS 10.2 
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Εικόνα 3.7 Διανυσματοποίηση στο QGIS.
3.6.1 Προεργασία ψηφιοποίησης
 
Για την ψηφιοποίηση, ανεξαρτήτως μεθόδου, είναι απαραίτητη η ύπαρξη του διανυσματικού αρχείου στο οποίο θα ενταχθούν οι οντότητες του θεματικού επιπέδου που θα ψηφιοποιηθεί. Από τη γραμμή εργαλείων Standard toolbar με το πλήκτρο Add Data [image: ] επιλέγεται το γεωαναφερμένο αρχείο (δομής raster) του χάρτη ο οποίος πρόκειται να ψηφιοποιηθεί, καθώς και ένα ή περισσότερα διανυσματικά αρχεία για την αποθήκευση των διανυσματικών οντοτήτων για τις οποίες πρόκειται να γίνει ψηφιακή καταγραφή. Υπάρχει η δυνατότητα επιλογής και ταυτόχρονης προσθήκης πολλών αρχείων με τη χρήση του πλήκτρου <Ctrl> ή του <Shift>. 
Για κάθε θεματικό επίπεδο, ανάλογα με τη φύση και τις ιδιότητες των χαρτογραφικών οντοτήτων, καθορίζεται η μέθοδος του συμβολισμού και τα χαρακτηριστικά των συμβόλων. Με δεξί κλικ στο layer από τον πίνακα περιεχομένων (TOC, βλ. Παράρτημα Β§5.2), εμφανίζεται το μενού με όλες τις δυνατές λειτουργίες για τα θεματικά επίπεδα (layers). Η επιλογή Properties ενεργοποιεί μια ομάδα από επάλληλες καρτέλες λειτουργιών από τις οποίες επιλέγεται η καρτέλα Symbology μέσω της οποίας καθορίζονται:
 
	Tο είδος (μέθοδος) του συμβολισμού (Features, Categories, Quantities, Charts, Multiple attributes).

	Tα χαρακτηριστικά του συμβόλου (ή των συμβόλων).

 
Κατά τη διαδικασία της ψηφιακής καταγραφής, οι απαιτούμενες μέθοδοι συμβολισμού είναι συνήθως:
 
	Συμβολισμός με ενιαίο σύμβολο.
	Συμβολισμός με κατηγοριοποίηση οντοτήτων.

 
Για τον συμβολισμό του συνόλου των χαρτογραφικών οντοτήτων ενός layer με το ίδιο σύμβολο, διατηρείται η προκαθορισμένη επιλογή του συστήματος Features/Single symbol. Η διαδικασία προσδιορισμού ή/και αλλαγής των χαρακτηριστικών των συμβόλων η οποία περιγράφεται στη συνέχεια, ισχύει για όλες τις κατηγορίες συμβόλων. Για τον καθορισμό των χαρακτηριστικών του συμβόλου, γίνεται διπλό κλικ στο πρότυπο του συμβόλου που εμφανίζεται είτε στον πίνακα περιεχομένων του χάρτη, είτε στην καρτέλα Properties>Symbology η οποία ενεργοποιείται με δεξί κλικ στο θεματικό επίπεδο από τον πίνακα περιεχομένων (TOC - βλ. Παράρτημα Β§5.2). Μέσω του μενού Symbol Selector που ενεργοποιείται με το πλήκτρο Properties, μπορούν να διαφοροποιηθούν η μορφή, η απόχρωση και το μέγεθος του συμβόλου, με χρήση του Symbol Property Editor (Edit Symbol). 
Για τον συμβολισμό των χαρτογραφικών οντοτήτων ενός layer, ανάλογα με τις ιδιότητές τους, από την καρτέλα Properties>Symbology επιλέγεται η μέθοδος συμβολισμού Categories και ενεργοποιείται η επιλογή Categories>Unique values. Aπό τον κατάλογο Value field των περιγραφικών χαρακτηριστικών (ιδιοτήτων) του layer, επιλέγεται το πεδίο με βάση το οποίο θα γίνει ο συμβολισμός. Η διαχείριση των τιμών του επιλεγμένου πεδίου γίνεται με τα πλήκτρα:
 
	Add All Values.
	Add values.
	Remove. 
	Remove All.

 
Οι τιμές μπορούν επίσης να ομαδοποιηθούν ως εξής: με αριστερό κλικ επιλέγεται η πρώτη τιμή και πατώντας το πλήκτρο <Shift> επιλέγεται η τελευταία αν πρόκειται για τιμές οι οποίες είναι διαδοχικές στη λίστα, ενώ για την επιλογή μεμονωμένων τιμών χρησιμοποιείται το πλήκτρο <Ctrl> σε συνδυασμό με αριστερό κλικ. Στη συνέχεια με δεξί κλικ, από το μενού που εμφανίζεται, επιλέγεται η λειτουργία Group Values.
Η διαφάνεια στην απόδοση ενός layer ορίζεται στον συμβολισμό του, μέσω της καρτέλας Properties>Display>Transparency (%). 
 
 
[image: ]
Εικόνα 3.8 Απόδοση ιδιότητας με μορφή κειμένου (Labels) στο ArcMap.
Σε περίπτωση κατά την οποία για κάποιο θεματικό επίπεδο απαιτηθεί η απόδοση τιμών ιδιοτήτων με τη μορφή κειμένου (labels), από το μενού λειτουργιών Properties>Labels ενεργοποιείται η επιλογή Label features in this layer και στην επιλογή Label Field ορίζεται το προς αναγραφή πεδίο (π.χ. Elevation) (Εικόνα 3.8).
3.6.2 Ψηφιακή καταγραφή
 
Η ψηφιακή καταγραφή των χαρτογραφικών οντοτήτων γίνεται με τα εργαλεία της γραμμής εργαλείων (toolbar) Editor (Εικόνα 3.9). Ο όρος sketch που χρησιμοποιείται στην ψηφιοποίηση, είναι ένα σχήμα που αντιπροσωπεύει τη γεωμετρία μιας οντότητας. Μπορεί να είναι σημείο ή τεθλασμένη γραμμή. Κάθε οντότητα (feature) έχει μια εναλλακτική μορφή που επιτρέπει την οπτικοποίηση των στοιχείων τα οποία την συνθέτουν. Στην περίπτωση των τεθλασμένων γραμμών, εμφανίζει τις κορυφές και τα ευθύγραμμα τμήματα από τα οποία αποτελούνται. 
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Εικόνα 3.9 Η γραμμή εργαλείων και οι βασικές λειτουργίες του Editor στο ArcMap.
Η έναρξη της ψηφιακής καταγραφής γίνεται με την επιλογή Editor>Start Editing οπότε ανοίγει το παράθυρο Create features. Η ψηφιακή καταγραφή οντοτήτων υλοποιείται με χρήση της Φόρμας Οντοτήτων (Feature Templates) (Εικόνα 3.10). Με αυτήν ορίζονται όλες οι πληροφορίες που απαιτούνται για την καταγραφή μιας οντότητας: το θεματικό επίπεδο στο οποίο θα αποθηκευτεί, οι ιδιότητες που θα έχει καθώς και το εργαλείο καταγραφής της γεωμετρίας που θα χρησιμοποιηθεί π.χ. σημείο, τεθλασμένη γραμμή, τμήμα τόξου, πολύγωνο κ.ά. Η φόρμα καταγραφής και επεξεργασίας οντοτήτων χαρακτηρίζεται από ένα όνομα, μια περιγραφή (προαιρετικά) και μια λέξη κλειδί η οποία εξυπηρετεί την αναζήτηση και οργάνωση (προαιρετικά). Όταν ξεκινάει για πρώτη φορά η επεξεργασία, οι φόρμες δημιουργούνται αυτόματα για κάθε θεματικό επίπεδο που υπάρχει στο χάρτη και αποθηκεύονται στο αρχείο του. Εάν στη συνέχεια προστεθούν νέα θεματικά επίπεδα, ο χρήστης θα πρέπει να δημιουργήσει νέες φόρμες για όποια από αυτά επιθυμεί να επεξεργαστεί. Το σύμβολο που χρησιμοποιείται για τα δεδομένα κάθε φόρμας, δεν μπορεί να μεταβληθεί από τις ιδιότητες της φόρμας. Η ιδιότητα του συμβόλου σε επίπεδο φόρμας λαμβάνεται από το αντίστοιχο θεματικό επίπεδο. Για να αλλάξει το σύμβολο στη φόρμα, πρέπει πρώτα να αλλάξει στον συμβολισμό του θεματικού επιπέδου. Για τον λόγο αυτό, προτείνεται να γίνεται η διαμόρφωση των συμβόλων πριν από τη δημιουργία της φόρμας συλλογής και στη συνέχεια να ξεκινήσει η επεξεργασία, ώστε αυτά να μεταφερθούν και στις φόρμες συλλογής. Η διαχείριση των συμβόλων γίνεται με δεξί κλικ στο θεματικό επίπεδο Properties>Symbology.
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Εικόνα 3.10 Φόρμα συλλογής και επεξεργασίας στοιχείων (Create features) στο ArcMap.
Η δημιουργία μιας νέας φόρμας ξεκινάει με το πλήκτρο [image: ]. Θα πρέπει να οριστεί το θεματικό επίπεδο στο οποίο αναφέρεται και το εργαλείο εισαγωγής γεωμετρίας το οποίο θα χρησιμοποιηθεί (Εικόνα 3.11). Επιπλέον, μπορούν να οριστούν προεπιλεγμένες τιμές για τις ιδιότητες.
Τα εργαλεία εισαγωγής γεωμετρίας, εξαρτώνται από το γεωμετρικό αρχέτυπο του θεματικού επιπέδου στο οποίο γίνεται η καταγραφή. Για τις γραμμικές οντότητες, τα εργαλεία είναι (Εικόνα 3.12):
 
	Line - Τεθλασμένη γραμμή.
	Rectangle - Ορθογώνιο παραλληλόγραμμο.
	Circle – Κύκλος.
	Ellipse – Έλλειψη. 
	Freehand - Γραμμή με ελεύθερο χέρι.

 
Για τις σημειακές οντότητες διατίθενται δύο εργαλεία (Εικόνα 3.13).
 
	Point – Σημείο.
	Point at end of line - Σημείο στην τελευταία κορυφή μιας γραμμής.

 
Για τις πολυγωνικές οντότητες διατίθενται τα ακόλουθα εργαλεία (Εικόνα 3.14):
 
	Polygon - Περίγραμμα πολυγώνου με τεθλασμένη γραμμή.
	Rectangle - Ορθογώνιο παραλληλόγραμμο.
	Circle – Κύκλος. 
	Ellipse – Έλλειψη. 
	Freehand - Περίγραμμα πολυγώνου με ελεύθερο χέρι.
	Auto Complete Polygon. 
	Auto Complete Freehand.

 
Με τις επιλογές Auto-Complete Polygon ή Auto Complete Freehand, ψηφιοποιείται ένα νέο πολύγωνο το οποίο συνορεύει με ένα υπάρχον, οπότε δεν χρειάζεται να ψηφιοποιηθεί το κοινό όριο. 
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Εικόνα 3.11 Δημιουργία νέας φόρμας διορθώσεων στο ArcMap.
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Εικόνα 3.12 Εργαλεία κατασκευής γραμμικών οντοτήτων στο ArcMap.
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Εικόνα 3.13 Εργαλεία κατασκευής σημειακών οντοτήτων στο ArcMap.
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Εικόνα 3.14 Εργαλεία κατασκευής πολυγωνικών οντοτήτων στο ArcMap.
Πιο εξειδικευμένες επιλογές παρέχονται από τα εργαλεία Feature Construction (Εικόνα 3.15) τα οποία ενεργοποιούνται από την αντίστοιχη γραμμή εργαλείων (toolbar): Customize>Toolbars>Feature Construction.
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Εικόνα 3.15 Η γραμμή εργαλείων Feature Construction στο ArcMap.
Σημαντικό στοιχείο της ψηφιακής καταγραφής, είναι η διαμόρφωση περιβάλλοντος σύμπτωσης θέσεων (snapping environment) για κάθε νέα οντότητα, σε σχέση με ήδη υπάρχοντα στοιχεία. Με την επιλογή Editor>Snapping>Snapping Toolbar της Editor toolbar εμφανίζεται το παράθυρο Snapping (Εικόνα 3.16). Η ενεργοποίηση γίνεται με Snapping>Use Snapping. Ο καθορισμός του τρόπου εφαρμογής του snapping περιλαμβάνει:
 
	Την πλησιέστερη σημειακή οντότητα [image: ].
	Τον πλησιέστερο κόμβο (end) [image: ].
	Την πλησιέστερη κορυφή (vertex) [image: ].
	Την πλησιέστερη ακμή (edge) [image: ].

 
Με τη θέση των στοιχείων αυτών θα ταυτίζεται η θέση ενός στοιχείου της νέας οντότητας, εφόσον απέχει απόσταση μικρότερη ή ίση με την αντίστοιχη ανοχή (snapping tolerance). Η ρύθμιση αφορά οντότητες οι οποίες εμφανίζονται σε όλα τα θεματικά επίπεδα. Με την επιλογή Editor>Snapping>Options εμφανίζεται το παράθυρο Snapping Options. Εκεί ορίζεται το μέγεθος (ακτίνα του κύκλου) για την υλοποίηση του snapping. Το Show Tip είναι ένα σύνολο πληροφοριών που εμφανίζονται δίπλα στον δείκτη του ποντικιού τη στιγμή που θα υλοποιηθεί το snapping και δείχνουν το θεματικό επίπεδο και το είδος του snapping π.χ. endpoint. Με την επιλογή Background, οι πληροφορίες εμφανίζονται με διαφάνεια ώστε, εάν υπάρχει στο υπόβαθρο μια εικόνα, να φαίνεται.
 
 
[image: ]
Εικόνα 3.16 Επιλογές σύμπτωσης θέσης (snapping) στο ArcMap.
Εκτός από τους κανόνες οι οποίοι ορίζουν το περιβάλλον snapping, το snap μπορεί να γίνει δυναμικά κατά τη διάρκεια της προσθήκης νέων οντοτήτων. Αυτό υλοποιείται μέσω της εντολής Snap to Feature η οποία βρίσκεται στο μενού του εργαλείου Feature Construction και ενεργοποιείται με δεξί κλικ. Με την εντολή αυτή (Εικόνα 3.17), κατά την ψηφιακή καταγραφή μιας οντότητας, η επόμενη κορυφή θα τοποθετηθεί αυτόματα στο στοιχείο που ορίζεται (Endpoint, Vertex, Midpoint, Edge), μιας υφιστάμενης οντότητας, ανεξάρτητα από τις ρυθμίσεις του περιβάλλοντος snapping.
 
 
[image: ]
Εικόνα 3.17 Η εντολή Snap to Feature στο ArcMap.
3.6.3 Εισαγωγή θέσης
 
Η έναρξη της ψηφιακής καταγραφής γίνεται με την επιλογή Editor>Start Editing και την επιλογή μιας φόρμας από το παράθυρο Create features. Στη συνέχεια γίνεται η εισαγωγή των θέσεων των χαρτογραφικών οντοτήτων.
 
	Για τα σημειακά: καταγράφεται με αριστερό κλικ η θέση ενός σημείου, στο κέντρο του σημειακού συμβόλου.
	Για τα γραμμικά: καταγράφεται με διαδοχικά αριστερά κλικ η θέση του άξονα του γραμμικού συμβόλου. Το τέλος της γραμμής δηλώνεται με διπλό αριστερό κλικ ή με δεξί κλικ και την επιλογή Finish Sketch. 
	Για τα επιφανειακά: καταγράφεται το περίγραμμα του πολυγώνου, ακολουθώντας την ίδια διαδικασία με εκείνη της ψηφιοποίησης των γραμμικών χωρικών στοιχείων.

 
Κατά την εισαγωγή γραμμής ή πολυγώνου, εμφανίζεται το παράθυρο Feature Construction (Εικόνα 3.18).
3.6.4 Εισαγωγή ιδιοτήτων
Όταν μια οντότητα είναι επιλεγμένη ή επιλεγεί με το [image: ], από το πλήκτρο [image: ] (Attributes) της Editor toolbar, εμφανίζεται στην περιοχή του παραθύρου Create features ο πίνακας ιδιοτήτων της οντότητας αυτής, στον οποίο μπορεί να γίνει ενημέρωση των τιμών των πεδίων (π.χ. Elevation) (Εικόνα 3.19). 
Η επιστροφή στην επεξεργασία της γεωμετρίας γίνεται με την επιλογή Create features (Εικόνα 3.20).
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Εικόνα 3.18 Οι επιλογές του εργαλείου Feature Construction του ArcMap.
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Εικόνα 3.19 Το περιβάλλον ενημέρωσης ιδιοτήτων μιας οντότητας σε περιβάλλον ArcMap.
3.6.5. Διορθώσεις (editing)
 
Κατά τη διαδικασία της ψηφιακής καταγραφής και μάλιστα ανεξάρτητα από τη μέθοδο, είναι μάλλον ή βέβαιο ότι θα απαιτηθούν χειρισμοί διορθώσεων. Οι διορθώσεις ακολουθούν την εξής διαδικασία:
 
	Έναρξη της διόρθωσης (Editor>Start Editing).

	Επιλογή της φόρμας οντοτήτων η οποία θα αποτελέσει αντικείμενο επεξεργασίας. 
	Επιλογή οντότητας και εργαλείου ενημέρωσης γεωμετρίας ή περιγραφικών χαρακτηριστικών (ιδιοτήτων – attributes). 
	Αποθήκευση διορθώσεων (Editor>Save Edits) και τέλος διαδικασίας διορθώσεων (Editor>Stop Editing).
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Εικόνα 3.20 Εναλλαγή μεταξύ λειτουργιών Create Features και Attributes σε περιβάλλον ArcMap.
Επιπλέον εργαλεία διόρθωσης, όπως η αποκοπή και η επέκταση γραμμών, εμφανίζονται από το Editor>More Editing Tools>Advanced Editing ή Customize>Toolbars>Advanced Editing (Εικόνα 3.21). Ακολούθως παρατίθενται οι πιο συνηθισμένες λειτουργίες διόρθωσης. 
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Εικόνα 3.21 Η γραμμή εργαλείων Advanced Editing στο ArcMap.
3.6.5.1 Επιλογή οντότητας
 
Η επιλογή οντότητας για διόρθωση, γίνεται με το εργαλείο [image: ] (Edit Tool) από την Editor toolbar και στη συνέχεια με την υπόδειξη της οντότητας με το ποντίκι (αριστερό κλικ).
3.6.5.2 Διαγραφή οντότητας
 
Όταν επιλεγεί μια οντότητα η διαγραφή της γίνεται με την επιλογή Delete η οποία εμφανίζεται με δεξί κλικ του ποντικιού ή με το πλήκτρο <Delete> από το πληκτρολόγιο. Επίσης η διαγραφή μπορεί να γίνει μέσω του Attribute table: στον πίνακα περιεχομένων, δεξί κλικ στη οντότητα ή το θεματικό επίπεδο και επιλογή Open Attribute Table. Η επιλεγμένη οντότητα φωτίζεται με κυανό χρώμα και με το πλήκτρο <Delete> γίνεται η διαγραφή της. Σημειώνεται ότι η διαγραφή οντοτήτων πρέπει να γίνεται στο περιβάλλον της ψηφιακής καταγραφής και των διορθώσεων (Data view) [image: ].
3.6.5.3 Επεξεργασία των κορυφών (vertices) και των τμημάτων (segments) μιας γραμμής
 
Όταν επιλεγεί μια γραμμή, με διπλό κλικ του ποντικιού ή με την επιλογή Edit vertices [image: ] από την Editor toolbar, εμφανίζονται οι κορυφές της γραμμής και τότε μπορεί να γίνει επεξεργασία των κορυφών με το μενού Edit Vertices (Εικόνα 3.22) για την αλλαγή της μορφής (σχήματος) της γραμμής.
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Εικόνα 3.22 Οι διαθέσιμες λειτουργίες διόρθωσης κορυφών στο περιβάλλον ArcMap.
Οι πιο συνηθισμένες από τις επιτρεπόμενες ενέργειες είναι:
 
	Επιλογή κορυφής (ή κορυφών, με το σχηματισμό ορθογωνίου γύρω από αυτές) [image: ].
	Προσθήκη κορυφής[image: ].
	Διαγραφή κορυφής (ή κορυφών) [image: ].
	Συνέχιση ψηφιοποίησης από το τέλος της γραμμής.
	Μετακίνηση κορυφής με αναλογική διατήρηση του σχήματος της γραμμής [image: ].
	Διαχείριση των κορυφών και των συντεταγμένων τους [image: ].

 
Επίσης, κατά την επιλογή μιας κορυφής, οι διαθέσιμες ενέργειες εμφανίζονται με δεξί κλικ. Ανάλογα με την περίπτωση είναι δυνατή η αλλαγή φοράς (flip), η αλλαγή τύπου, η αποκοπή σε συγκεκριμένο μήκος (trim to length), η σχετική μετακίνηση κατά ΔΧ και ΔΥ, η μετακίνηση σε θέση X,Y (move to) κ.ά. Η μετακίνηση μιας κορυφής σε νέα θέση χειροκίνητα, γίνεται με την επιλογή της με τον δείκτη και τη μετακίνησή της (drag).
Για την επεξεργασία ενός ευθυγράμμου τμήματος (segment) μιας επιλεγμένης γραμμής, αφού εμφανιστούν με διπλό κλικ οι κορυφές, τοποθετείται ο δείκτης στο ευθύγραμμο τμήμα μέχρι να αλλάξει σε [image: ] κι η επιλογή του τμήματος γίνεται με κλικ. Εκτός από τη μετακίνηση του ευθυγράμμου τμήματος, με δεξί κλικ εμφανίζονται άλλες διαθέσιμες ενέργειες, όπως εισαγωγή κορυφής (insert vertex), αλλαγή τύπου (change segment) κ.ά.
3.6.5.4 Μετακίνηση οντότητας 
 
Με το εργαλείο επιλογής σύρουμε την οντότητα στην επιθυμητή θέση. 
3.6.5.5 Κατάτμηση μιας γραμμικής οντότητας
 
Το εργαλείο Split Tool [image: ] επιτρέπει την κατάτμηση μιας γραμμικής οντότητας που έχει επιλεγεί, σε σημείο που υποδεικνύει ο χρήστης. Στο μενού Editor>Split υπάρχουν κι άλλες επιλογές, όπως κατάτμηση σε ν ίσα τμήματα, σε συγκεκριμένο μήκος, σε ποσοστό επί του μήκους, από την αρχή ή το τέλος της γραμμικής οντότητας.
 
3.6.5.6 Επέκταση γραμμικών οντοτήτων (Extend Tool – Advanced Editing)
 
Με το εργαλείο [image: ] επιλέγεται η γραμμική οντότητα η οποία θα χρησιμοποιηθεί ως όριο στην επέκταση. Αρχικά επιλέγεται το εργαλείο [image: ] και στη συνέχεια το άκρο της γραμμικής οντότητας που θα επεκταθεί. 
3.6.5.7 Αποκοπή γραμμικών οντοτήτων (Trim Tool – Advanced Editing) 
 
Με το εργαλείο [image: ] επιλέγεται η γραμμική οντότητα η οποία θα χρησιμοποιηθεί ως όριο για την τομή. Αρχικά επιλέγεται το εργαλείο [image: ] και στη συνέχεια το άκρο της γραμμής που θα τμηθεί.
3.6.5.8 Συνένωση γραμμών (Merge)
 
Αφού επιλεγούν οι γραμμικές οντότητες με το εργαλείο [image: ] , συνενώνονται με την επιλογή Editor>Merge.
3.6.5.9 Προσθήκη εργαλείων
 
Η προσθήκη εργαλείων μπορεί να επιτευχθεί μέσω της επιλογής Customize που ενεργοποιείται με το [image: ] στο άκρο της Editor toolbar (Εικόνα 3.23) Customize>Commands>Editor, ενώ η προσθήκη εντολής-εργαλείου (π.χ. στην ομάδα Editor) γίνεται όπως παρουσιάζεται στην Εικόνα 3.24.
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Εικόνα 3.23 Επέκταση των διαθέσιμων εργαλείων στο ArcMap.
3.7 Η διαδικασία της αυτόματης/ημιαυτόματης διανυσματοποίησης στο ArcGIS
 
Η ενεργοποίηση και η διαμόρφωση του περιβάλλοντος στο ArcMap παρουσιάζεται στο Παράρτημα Β, §Β.5.1-Β.5.4. Επί πλέον, απαιτείται η ενεργοποίηση του ArcScan από το μενού Customize>Extensions>ArcScan ([image: ]) και ο καθορισμός των εργαλείων τα οποία θα χρησιμοποιηθούν. Από το μενού Customize>Toolbars ενεργοποιούνται διαδοχικά οι γραμμές εργαλείων ArcScan και Editor. Επιλέγεται ως περιβάλλον εργασίας αυτό της ψηφιακής καταγραφής και των διορθώσεων (Data view) [image: ]. Πρέπει να σημειωθεί πως τόσο η αυτόματη όσο και η ημιαυτόματη μέθοδος εφαρμόζονται μόνο για γραμμικά χωρικά δεδομένα.
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Εικόνα 3.24 Προσθήκη εργαλείων στο ArcMap.
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Εικόνα 3.25 Διαμόρφωση του συμβολισμού του κανονικοποιημένου αρχείου στο ArcMap.
3.7.1 Προετοιμασία και απόδοση του κανoνικοποιημένου αρχείου 
 
Προκειμένου να υλοποιηθεί η αυτόματη ή η ημιαυτόματη διανυσματοποίηση γραμμικών οντοτήτων με το εργαλείο ArcScan, ο μορφότυπος (format) του κανονικοποιημένου αρχείου πρέπει να είναι tiff και μαυρόασπρο (black and white). Για τον λόγο αυτό, πραγματοποιείται η μετατροπή της εικόνας σε μαυρόασπρη tiff με κάποιο λογισμικό εκτός περιβάλλοντος ΑrcGIS. Εάν η αρχική εικόνα είναι γεωαναφερμένη, η μετατροπή σε μαυρόασπρο και tiff, έχει ως αποτέλεσμα να χαθεί η γεωαναφορά, επομένως απαιτείται να γεωαναφερθεί η εικόνα εκ νέου μετά τη μετατροπή της σε μαυρόασπρο και tiff. Πριν ξεκινήσει η χρήση του ArcScan το κανονικοποιημένο αρχείο θα πρέπει να απεικονίζεται ως μαυρόασπρο. Στον πίνακα περιεχομένων (TOC, βλ. Παράρτημα Β§5.2) επιλέγεται η εικόνα και από το μενού λειτουργιών το οποίο εμφανίζεται με δεξί κλικ, η επιλογή Properties. Στη συνέχεια επιλέγεται η καρτέλα Symbology στην οποία ενεργοποιείται η επιλογή Properties>Symbology>Unique Values (Εικόνα 3.25).
3.7.2 Διαμόρφωση του περιβάλλοντος διανυσματοποίησης 
 
Η ενεργοποίηση των εργαλείων του ArcScan γίνεται με την έναρξη της ψηφιακής καταγραφής με την επιλογή Editor>Start Editing. Η διαμόρφωση του περιβάλλοντος αυτόματης/ημιαυτόματης διανυσματοποίησης γίνεται από το πλήκτρο Vectorization της εργαλειοθήκης ArcScan (Εικόνα 3.26). 
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Εικόνα 3.26 Η γραμμή εργαλείων ArcScan στο ArcMap.
Στο παράθυρο που εμφανίζεται, με την επιλογή Options καθορίζεται η μέθοδος διανυσματοποίησης και η απόχρωση των φατνίων τα οποία θα διανυσματοποιηθούν (Εικόνα 3.27). 
Με το εργαλείο Raster Line Width [image: ] της ArcScan toolbar, μετράται το πάχος της γραμμής που θα διανυσματοποιηθεί (Εικόνα 3.26). Από το πλήκτρο Vectorization και με την επιλογή Vectorization Settings, καθορίζονται οι ακόλουθες παράμετροι της διανυσματοποίησης (Εικόνα 3.28):
 
	Intersection Solution: διαχείριση των διασταυρώσεων.
	Maximum Line Width: τα στοιχεία τα οποία έχουν πάχος μικρότερο ή ίσο με την τιμή που ορίζεται θα χρησιμοποιηθούν στη διανυσματοποίηση.
	Compression Tolerance: καθορίζει την πυκνότητα των κορυφών των γραμμικών οντοτήτων.
	Smoothing Weight: καθορίζει τον βαθμό εξομάλυνσης των γραμμικών οντοτήτων.
	Gap Closure Tolerance: διαχείριση των κενών στις γραμμές του κανονικοποιημένου αρχείου με βάση συγκεκριμένη τιμή ανοχής.
	Fan Angle: γωνία αναζήτησης φατνίων κατά τη διαχείριση των κενών στις γραμμές.
	Hole setting: διαχείριση των οπών στις γραμμές του κανονικοποιημένου αρχείου.
	Resolve Corners: διαχείριση των γωνιών στις γραμμές του κανονικοποιημένου αρχείου.
	Styles: επιλογή ή αποθήκευση παραμέτρων διανυσματοποίησης από προκαθορισμένες ρυθμίσεις, ανάλογα με το είδος των οντοτήτων.
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Εικόνα 3.27 Οι επιλογές διανυσματοποίησης στο ArcMap.
3.7.3 Διανυσματοποίηση Γραμμικών Οντοτήτων με αυτόματη μέθοδο 
 
Η έναρξη της ψηφιακής καταγραφής γίνεται με την επιλογή Editor>Start Editing. Η αυτόματη ψηφιακή καταγραφή γίνεται με την επιλογή ArcScan>Vectorization>Generate Features. Στο παράθυρο Generate features με το πλήκτρο Template… εμφανίζεται το παράθυρο Select Feature Template, όπου ορίζεται σε ποιο γραμμικό θεματικό επίπεδο θα καταγραφούν τα δεδομένα και ακολούθως εκτελείται η αυτόματη διανυσματοποίηση (Εικόνα 3.29). Η αποθήκευση των οντοτήτων που καταγράφηκαν γίνεται με την επιλογή Editor >Save Edits.
Ανάλογα με το περιεχόμενο της γεωαναφερμένης εικόνας η οποία θα χρησιμοποιηθεί ως πηγή (βλ. §3.6.1), ίσως απαιτηθούν κάποιοι χειρισμοί διορθώσεων, κυρίως για τη διαγραφή στοιχείων που προέκυψαν από τη διανυσματοποίηση βοηθητικών στοιχείων και πληροφοριών, όπως σημεία γεωγραφικής προσαρμογής, αναγραφή συντεταγμένων κλπ., που μπορεί να εμφανίζονται στην εικόνα-πηγή.
3.7.4. Διανυσματοποίηση Γραμμικών Οντοτήτων με ημιαυτόματη μέθοδο
 
Η έναρξη της ψηφιακής καταγραφής γίνεται με την επιλογή Editor>Start Editing. Επιλέγεται ένα Feature Template για να οριστεί σε ποιο θεματικό επίπεδο θα καταγραφούν τα δεδομένα και να επιλεγεί το εργαλείο εισαγωγής της γεωμετρίας (Construction Tool). Στη συνέχεια επιλέγεται το εργαλείο ημιαυτόματης διανυσματοποίησης (Vectorization Trace) [image: ] από τη γραμμή εργαλείων ArcScan (Εικόνα 3.30) και με το πλήκτρο του ποντικιού υποδεικνύονται τα φατνία της εικόνας από όπου θα γίνει η έναρξη της διαδικασίας. 
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Εικόνα 3.28 Οι ρυθμίσεις διανυσματοποίησης στο ArcMap.
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Εικόνα 3.29 Ορισμός του θεματικού επιπέδου καταγραφής της διανυσματοποίησης στο ArcMap.
Με το ποντίκι υποδεικνύεται η διεύθυνση προς την οποία θα γίνει η διανυσματοποίηση και με αριστερό κλικ (του ποντικιού) ξεκινάει η διαδικασία (Εικόνα 3.31α). Όταν συναντήσει μια διασταύρωση, η διαδικασία σταματάει και τότε ο χρήστης πρέπει να υποδείξει εκ νέου τη διεύθυνση διανυσματοποίησης με το ποντίκι (Εικόνα 3.31β). Εάν η διαδικασία δεν μπορεί να συνεχιστεί, π.χ. λόγω κενού ή γραμμών που τέμνονται, τότε ο χρήστης ψηφιοποιεί με τη βοήθεια του ποντικιού χειροκίνητα το τμήμα της γραμμής που δημιούργησε το πρόβλημα, κρατώντας πατημένο το πλήκτρο S από το πληκτρολόγιο. Όταν φτάσει σε τμήμα της γραμμής που μπορεί να διανυσματοποιηθεί και πάλι αυτόματα, ελευθερώνει το πλήκτρο S και με αριστερό κλικ ξεκινάει και πάλι η διανυσματοποίηση. Η ολοκλήρωση της διανυσματοποίησης μιας γραμμής γίνεται με διπλό αριστερό κλικ ή με δεξί κλικ και την επιλογή Finish Sketch. Για την αποφυγή σφαλμάτων, προτείνεται η ενεργοποίηση του snapping.
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Εικόνα 3.30 Επιλογή του εργαλείου Vectorization Trace στο ArcMap.
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Εικόνα 3.31 Διανυσματοποίηση με την ημιαυτόματη μέθοδο στο ArcMap.
3.7.5. Εισαγωγή ιδιοτήτων
 
Όταν μια οντότητα είναι επιλεγμένη, από το πλήκτρο [image: ] (Attributes) της Editor toolbar εμφανίζεται ένα παράθυρο με τον πίνακα των ιδιοτήτων της στον οποίο μπορεί να γίνει ενημέρωση των τιμών των πεδίων (βλ. και §3.6.5.)
3.7.6. Έλεγχος τιμών των πεδίων των χωρικών στοιχείων βάσει των πεδίων ορισμού (domain)
 
 
Η έναρξη του ελέγχου γίνεται με την επιλογή Editor>Start Editing. Στη συνέχεια επιλέγονται με το εργαλείο επιλογής [image: ] τα στοιχεία τα οποία θα αξιολογηθούν. Ο έλεγχος πραγματοποιείται με την επιλογή Editor>Validate Features. Εάν υπάρχουν σφάλματα στις τιμές των πεδίων βάσει του πεδίου ορισμού (domain - βλ. Κεφάλαιο 1 §1.4), εμφανίζεται ένα παράθυρο μηνύματος όπου αναφέρεται το πλήθος των χωρικών στοιχείων με προβλήματα. Μόνο τα χωρικά στοιχεία με σφάλματα θα παραμείνουν επιλεγμένα. Επιλέγεται OK και στη συνέχεια με το εργαλείο επιλογής, επιλέγεται ένα από τα χωρικά στοιχεία με προβλήματα. Με Editor>Validate Features, στο παράθυρο μηνύματος που εμφανίζεται, σημειώνεται ποιο είναι το πρόβλημα για το συγκεκριμένο χωρικό στοιχείο. Επιλέγεται OK και στη συνέχεια το πλήκτρο Attributes button [image: ] για να εμφανιστεί η εγγραφή η οποία αντιστοιχεί στο επιλεγμένο χωρικό στοιχείο και να γίνουν οι αναγκαίες διορθώσεις. Τα παραπάνω στάδια επαναλαμβάνονται μέχρι να διορθωθούν όλα τα σφάλματα και το σύστημα να ενημερώσει τον χρήστη ότι δεν υπάρχουν άλλα προβλήματα.
 
 
3.7.7. Δημιουργία πολυγωνικών χωρικών οντοτήτων από γραμμικές
 
Λόγω της ιδιαιτερότητας της εφαρμογής των μεθόδων διανυσματοποίησης μόνο σε γραμμικές χωρικές οντότητες, η παραγωγή πολυγωνικών χωρικών στοιχείων μπορεί να γίνει με έμμεσο τρόπο. Αφού διανυσματοποιηθούν ως γραμμικά, μετατρέπονται σε πολυγωνικά. Για τον σκοπό αυτό, ενεργοποιούνται τα εργαλεία της ομάδας ArcToolbox η οποία βρίσκεται στη Standard toolbar είτε σε περιβάλλον ArcCatalog είτε σε περιβάλλον ArcMap (Εικόνα 3.32) ή ενεργοποιείται από το μενού Geoprocessing>Arctoolbox. Για τη μετατροπή γραμμικών οντοτήτων σε πολυγωνικές, επιλέγεται το εργαλείο ArcToolbox>Data Management Tools>Features>Feature To Polygon.
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Εικόνα 3.32 Επιλογή των εργαλείων ArcToolbox στο ArcMap.
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Κριτήρια αξιολόγησης 
Κριτήριο αξιολόγησης 1
Αναφερθείτε στις περιπτώσεις για τις οποίες η αυτόματη ψηφιοποίηση είναι η πλέον ενδεδειγμένη μέθοδος ψηφιακής καταγραφής.
 
Κριτήριο αξιολόγησης 2
Για ποιο λόγο είναι προτιμητέα η παράλληλη εισαγωγή γεωμετρίας και περιγραφικών χαρακτηριστικών;
Κεφάλαιο 4 
Αναζήτηση και χρήση χωρικών δεδομένων από άλλες πηγές
Σύνοψη 
Στο κεφάλαιο αυτό, γίνεται αναφορά στα χωρικά δεδομένα που δεν συλλέγονται από τον ίδιο τον χρήστη κατά τη δημιουργία της βάσης χαρτογραφικών δεδομένων, αλλά ενδέχεται να ληφθούν και από άλλες πηγές συμπεριλαμβανομένης και αυτής του διαδικτύου. Συχνά, τα γεωχωρικά δεδομένα από άλλες πηγές διατίθενται σε κάποιο ουδέτερο μορφότυπο π.χ. αρχεία shapefile ή ως υπηρεσίες από διαδικτυακούς εξυπηρετητές γεωχωρικών δεδομένων π.χ. ορθοφωτοχάρτες από την «Εθνικό Κτηματολόγιο και Χαρτογράφηση Α.Ε.» (ΕΚΧΑ Α.Ε.). Στη συνέχεια, αναλύεται η μεθοδολογία με την οποία τα δεδομένα αυτά μπορούν να αξιοποιηθούν ή να ενσωματωθούν στη βάση χαρτογραφικών δεδομένων. Ιδιαίτερη αναφορά γίνεται στον εντοπισμό και στην αντιμετώπιση τυχόν προβλημάτων π.χ. καταλληλότητα, ποιότητα, ασυμφωνία συστήματος αναφοράς συντεταγμένων, χωρικές ασυμβατότητες κ.ά. Το κεφάλαιο  περιλαμβάνει επίσης λεπτομερή περιγραφή για την υλοποίηση όσων αναφέρθηκαν στο Σύστημα Γεωγραφικών Πληροφοριών QGIS και στο Σύστημα Γεωγραφικών Πληροφοριών ArcGIS.
Προαπαιτούμενη γνώση
Γενική γνώση για τα γεωχωρικά δεδομένα και το διαδίκτυο.
4. Γεωχωρικά δεδομένα από άλλες πηγές
 
Κατά τη συλλογή δεδομένων για τη δημιουργία βάσης χαρτογραφικών δεδομένων εκτός από την ψηφιακή καταγραφή (βλ. Κεφάλαιο 3), συχνά αναζητούνται δεδομένα από άλλες πηγές π.χ. τοπικές υπηρεσίες, πολεοδομικά γραφεία, τεχνικές υπηρεσίες κ.ά. Το διαδίκτυο, μέσω του οποίου διατίθενται ευρύτατα πληροφορίες και δεδομένα, αποτελεί επίσης πιθανή πηγή γεωχωρικών δεδομένων. Τα γεωχωρικά δεδομένα τα οποία διατίθενται από άλλες πηγές ενδέχεται να:
 
	Διατίθενται σε διαφορετικές δομές (διανυσματικά ή κανονικοποιημένα δεδομένα).
	Διατίθενται ως αρχεία σε κάποιο ευρέως διαχειρίσιμο μορφότυπο π.χ. shapefile ή ως υπηρεσίες από διαδικτυακούς εξυπηρετητές διάχυσης χωρικών δεδομένων.
	Χαρακτηρίζονται ως ανοικτά δεδομένα ή να διατίθενται με περιορισμούς ως προς τη χρήση.
	Είναι αποτέλεσμα εθελοντικής προσφοράς (VGI – Volunteered Geographic Information) ή να διατίθεται από φορείς του ιδιωτικού ή/και του δημόσιου τομέα. 

 
Ένα ζήτημα που εγείρεται όταν τα δεδομένα διατίθενται από άλλες πηγές είναι αυτό  των δικαιωμάτων χρήσης (copyright). Τα δεδομένα προσφέρονται με άδεια χρήσης, η οποία καθορίζεται από τους αντίστοιχους παρόχους. Για παράδειγμα:
 
	Για τα ψηφιακά υπόβαθρα του Google Maps, η άδεια χρήσης είναι: http://www.google.com/intl/en_ALL/help/terms_maps.html.
	Για τα ψηφιακά δεδομένα του OSM (Open Street Map), η άδεια χρήσης είναι: Creative Commons Attribution-Share Alike 2.0 Generic License.
	Για τα ψηφιακά υπόβαθρα της εταιρίας Εθνικό Κτηματολόγιο και Χαρτογράφηση Α.Ε. (ΕΚΧΑ Α.Ε.) η άδεια χρήσης είναι: http://gis.ktimanet.gr/wms/ktbasemap/default.aspx.
	Τα ψηφιακά δεδομένα της ιστοσελίδας Δημόσια Δεδομένα, Ανοικτά Δεδομένα (www.geodata.gov.gr), προσφέρονται με τους ειδικότερους όρους της Ελληνικής άδειας Creative Commons Αναφορά Προέλευσης (CC BY v.3.0).

 
Ως «ανοικτά» δεδομένα χαρακτηρίζονται τα δεδομένα για τα οποία παρέχεται στον χρήστη το δικαίωμα να τα χρησιμοποιήσει χωρίς κόστος και να διανείμει το έργο που βασίζεται σε αυτά χωρίς κόστος ή περιοριστικούς όρους ιδιοκτησίας. Ο δημόσιος τομέας παράγει δεδομένα καθημερινά, σε κάθε είδους δραστηριότητα και σε όλα τα επίπεδα λειτουργίας του. Η ελεύθερη διάθεση αυτής της πληροφορίας είναι αναγκαία προϋπόθεση για τη διαφάνεια της λειτουργίας της δημόσιας διοίκησης. Τα ανοικτά δεδομένα αποτελούν επίσης ένα πανίσχυρο εργαλείο ανάπτυξης. Η Ευρωπαϊκή Ένωση (ΕΕ) εκτιμά πως αν ανοίξουν τα δεδομένα του δημόσιου τομέα, το όφελος για την ΕΕ θα είναι περίπου 200 δις ευρώ το χρόνο. Σε χώρες με σύντομη ιστορία στην ελεύθερη διάθεση δημόσιας πληροφορίας, όπως η Ελλάδα, τα οφέλη θα είναι ακόμη μεγαλύτερα. Τα οφέλη για τον δημόσιο τομέα προκύπτουν από την εξοικονόμηση πόρων και την αποδοτικότερη λειτουργία και για τον ιδιωτικό τομέα από την ανάπτυξη νέων υπηρεσιών και προϊόντων προστιθέμενης αξίας, τη βελτίωση των υφιστάμενων και τη μείωση του κόστους.
Ο πληθοπορισμός (crowdsourcing) είναι η πράξη της ανάθεσης καθηκόντων, τα οποία παραδοσιακά εκτελούνταν από υπάλληλο ή εργολάβο, σε μεγάλη ομάδα εθελοντών ή κοινότητα, μέσω ανοικτής πρόσκλησης (Βικιπαίδεια, 2015). Στα πλαίσια αυτής  της ιδέας, αναπτύχθηκε η συλλογή γεωγραφικής πληροφορίας από εθελοντές (Volunteered Geographic Information - VGI) (Goodchild, 2007). Πρόκειται για μια πρωτοβουλία δημιουργίας και ελεύθερης διάθεσης γεωχωρικών δεδομένων. Αφορμή αποτέλεσε το υπερβολικό κόστος απόκτησης των γεωχωρικών δεδομένων από επίσημους οργανισμούς και το γεγονός ότι ακόμα και τα διαθέσιμα γεωχωρικά δεδομένα διέπονται από νομικές ή τεχνικές δεσμεύσεις οι οποίες εμποδίζουν πολλές φορές την αξιοποίησή τους. Χαρακτηριστική περίπτωση αποτελεί το OSM (Οpen Street Map - http://www.openstreetmap.org/), που είχε αφορμή τη συλλογή δεδομένων για το οδικό δίκτυο, αλλά σήμερα καλύπτει και άλλα θεματικά επίπεδα. Φυσικά, η κάλυψη και η ποιότητα δεν είναι ούτε ενιαίες, ούτε εγγυημένες για τα δεδομένα αυτής της κατηγορίας. 
Μια επιπλέον δυνατότητα που εισήγαγε η διάδοση των διαδικτυακών χαρτογραφικών υπηρεσιών, είναι η ύπαρξη χαρτών σε κανονικοποιημένη δομή που μπορούν να χρησιμοποιηθούν αυτόνομα ή ως υπόβαθρο κατά τη χαρτοσύνθεση. Οι υπηρεσίες αυτές προσφέρουν ένα υπόβαθρο, στο οποίο απεικονίζονται ορισμένα βασικά θεματικά επίπεδα. Για παράδειγμα, μπορούν να προσφέρουν το υπόβαθρο κατά τη δημιουργία ενός θεματικού ή τουριστικού χάρτη για το διαδίκτυο, το οποίο συνδυάζεται με άλλα διανυσματικά δεδομένα που διαθέτει ο πάροχος αυτής της χαρτογραφικής υπηρεσίας. Οι διαδικτυακές χαρτογραφικές υπηρεσίες εντάσσονται στη χαρτοσύνθεση χωρίς να ενσωματώνονται στη βάση δεδομένων. Ακόμα, οι υπηρεσίες αυτές π.χ. χάρτες Google, χάρτες OSM, ορθοφωτογραφίες της ΕΚΧΑ Α.Ε. κ.ά. μπορούν να χρησιμοποιηθούν ως πηγή για την ψηφιακή καταγραφή διανυσματικών δεδομένων (βλ. Κεφάλαιο 3) προκειμένου να δημιουργηθούν νέα θεματικά επίπεδα ή να ενημερωθούν τα υπάρχοντα στη βάση χαρτογραφικών δεδομένων.
4.1 Έλεγχοι των δεδομένων και ενσωμάτωση στη βάση δεδομένων
 
Τα γεωχωρικά δεδομένα που λαμβάνονται από άλλες πηγές θα πρέπει να ελεγχθούν ως προς την καταλληλότητά τους, πριν ενσωματωθούν στη χαρτογραφική βάση δεδομένων ή χρησιμοποιηθούν με οποιοδήποτε τρόπο. Επομένως, το πρώτο στάδιο αφορά την αναζήτηση του αρχείου μεταδεδομένων ή του ιστορικού το οποίο θα πρέπει να συνοδεύει τα δεδομένα. Σε περίπτωση που δεν υπάρχουν οργανωμένα μεταδεδομένα, αναζητείται κάποια αναφορά για την ποιότητα των δεδομένων η οποία θα περιλαμβάνει πληροφορίες όπως: η περιγραφή του περιεχομένου, ο τρόπος και οι πηγές δημιουργίας των δεδομένων, οι έλεγχοι ποιότητας οι οποίοι έχουν εφαρμοστεί στα δεδομένα κ.ά. Πολλές φορές η τεκμηρίωση των γεωχωρικών δεδομένων, ειδικά εάν προέρχονται από κάποιο επίσημο οργανισμό, είναι εκτενής και αποτελεί ένα ξεχωριστό αρχείο που περιέχει όλες τις απαιτούμενες πληροφορίες ακολουθώντας κάποιο πρότυπο μεταδεδομένων όπως το ISO 19115. Στην περίπτωση κατά την οποία δεν υπάρχει οργανωμένη τεκμηρίωση ή άλλης μορφής μεταδεδομένα, θα πρέπει να πραγματοποιηθούν έλεγχοι που θα οδηγήσουν στην εκτίμηση της ποιότητας. Για να ληφθεί μια απόφαση για την καταλληλότητα χρήσης των δεδομένων θα πρέπει να απαντηθούν ερωτήματα όπως:
 
	Για ποιο σκοπό δημιουργήθηκαν;
	Πότε δημιουργήθηκαν τα δεδομένα και πότε ενημερώθηκαν τελευταία φορά;
	Από ποιους δημιουργήθηκαν;
	Σε τι μέσο (έντυπο / ηλεκτρονικό / διαδίκτυο) δημιουργήθηκαν αρχικά;
	Ποια γεωγραφική περιοχή καλύπτουν;
	Ποια είναι η κλίμακα του χάρτη από τον οποίο ψηφιοποιήθηκαν;
	Ποιο είναι το σύστημα συντεταγμένων του χάρτη;
	Ποια είναι η ακρίβεια θέσης και ιδιοτήτων με βάση τις προδιαγραφές;
	Τα δεδομένα φαίνονται λογικά και συμβατά μεταξύ τους;
	Σε τι μορφότυπο αποθηκεύονται;
	Πώς ελέγχθηκαν;
	Σε ποια επεξεργασία υπεβλήθηκαν πριν αποδοθούν;
	Ποια είναι η αξιοπιστία του παρόχου;

 
Οι χρήστες θα πρέπει να γνωρίζουν ότι το κόστος ενσωμάτωσης σε μια υπάρχουσα βάση χαρτογραφικών δεδομένων (π.χ. μετατροπή, επεξεργασία, διόρθωση κ.ά.) συχνά ξεπερνάει την αξία των γεωγραφικών δεδομένων, τα οποία διατίθενται δωρεάν ή σε εμπορικό πλαίσιο, εφόσον αυτά δεν έχουν τα εγγενή χαρακτηριστικά των στοιχείων της βάσης. Ακόμα και σήμερα, η πιθανότητα συλλογής των δεδομένων από έντυπους χάρτες δεν θα πρέπει να αποκλειστεί. Σε αντίθεση με τη μεγάλη προσφορά και την ευκολία λήψης των διαθέσιμων δεδομένων, δεν υπάρχει οποιαδήποτε εξασφάλιση ότι τα δεδομένα θα περιέχουν την κατάλληλη πληροφορία. Ενδέχεται η πληροφορία που αναζητά ο χρήστης να είναι κατανεμημένη σε αρχεία που παρέχονται από διαφορετικούς δημόσιους και ιδιωτικούς φορείς, σε διαφορετική δομή, σε διαφορετικό μορφότυπο κ.ά. Στην περίπτωση αυτή, η επεξεργασία και η ομογενοποίηση των δεδομένων αυτών είναι πιο δαπανηρή από τη συλλογή  της αντίστοιχης πληροφορίας από έντυπους χάρτες. Η ευρεία διάθεση γεωχωρικών δεδομένων σε ψηφιακή μορφή δεν συνεπάγεται και την καταλληλότητά τους για χρήση σε κάθε χαρτογραφική εφαρμογή. Για τους λόγους αυτούς, προτείνεται ο δειγματοληπτικός έλεγχος της ποιότητας των διαθέσιμων δεδομένων σε σχέση με τις απαιτήσεις της κάθε εφαρμογής ως προς την καταλληλότητα χρήσης, αλλά και ως προς το κόστος και την αποτελεσματικότητα της διαδικασίας ενσωμάτωσης με τα άλλα δεδομένα.
4.1.1 Συνήθεις διαδικασίες επεξεργασίας για την ενσωμάτωση στη βάση χαρτογραφικών δεδομένων
 
Τα δεδομένα που λαμβάνονται από άλλες πηγές, πριν την ενσωμάτωσή τους στη βάση χαρτογραφικών δεδομένων, υπόκεινται συνήθως μια σειρά από επεξεργασίες όπως:
 
	Αλλαγή μορφότυπου των δεδομένων: Τα δεδομένα που λαμβάνονται από άλλες πηγές διατίθενται συνήθως σε κάποιο μορφότυπο, ο οποίος εξασφαλίζει την ευρεία δυνατότητα χρήσης τους. Οι πιο διαδεδομένοι μορφότυποι καταγραφής διανυσματικών δεδομένων είναι: shapefile, dxf, KML κ.ά. Τα αρχεία αυτού του μορφότυπου αν και εξασφαλίζουν συμβατότητα με πολλά ΣΓΠ π.χ. ArcGIS και συστήματα διαχείρισης βάσεων χωρικών δεδομένων π.χ. PostgreSQL/PostGIS, δεν αντιστοιχούν στην αρχική δομή καταγραφής τους. Επομένως, θα πρέπει να μετατρέπονται στη δομή αποθήκευσης δεδομένων για κάθε περιβάλλον επεξεργασίας π.χ. γεωβάση για το ArcGIS, χωρικός πίνακας για το PostgreSQL/PostGIS κ.ά., ώστε να γίνει δυνατή η πλήρης αξιοποίηση των δυνατοτήτων του λογισμικού.
	Αλλαγή Συστήματος Αναφοράς των Συντεταγμένων (ΣΑΣ): Τις περισσότερες φορές, τα δεδομένα που λαμβάνονται από άλλες πηγές δεν χρησιμοποιούν το σύστημα αναφοράς των συντεταγμένων, το οποίο έχει επιλεγεί για τη βάση των χαρτογραφικών δεδομένων. Για παράδειγμα, ενώ για τις περισσότερες εφαρμογές στον ελλαδικό χώρο χρησιμοποιείται το ΕΓΣΑ ’87, η πλειοψηφία των VGI δεδομένων που διατίθενται στο διαδίκτυο και έχουν συλλεγεί με GNSS (Global Navigation Satellite System) χρησιμοποιούν συντεταγμένες στο WGS ‘84. Οι μετασχηματισμοί του ΣΑΣ, που προκύπτουν σε αυτές τις περιπτώσεις, καλύπτονται από τα βασικά εργαλεία ενός ΣΓΠ και αναλύονται στο σχετικό κεφάλαιο (βλ. Κεφάλαιο 6).
	Αντιστοίχηση με τις οντότητες και τις περιγραφικές ιδιότητες της βάσης χαρτογραφικών δεδομένων: Συχνά, τα θεματικά επίπεδα που λαμβάνονται από άλλες πηγές περιέχουν διαφορετικές γεωγραφικές οντότητες από αυτές που έχουν προβλεφθεί από τον σχεδιασμό της βάσης δεδομένων. Για παράδειγμα, οι λίμνες και τα ποτάμια καταγράφονται μαζί, ενώ στη βάση χαρτογραφικών δεδομένων καταγράφονται σε διαφορετικούς χωρικούς πίνακες. Στην περίπτωση αυτή, αλλά και σε άλλες πιο πολύπλοκες, όπου υπάρχει διαφοροποίηση σε επίπεδο λεξικού δεδομένων (data dictionary), τα αρχικά δεδομένα θα πρέπει να επεξεργαστούν έτσι ώστε οι οντότητές τους να αντιστοιχηθούν με αυτές της υπάρχουσας βάσης δεδομένων. Διαφορές ενδέχεται να υφίστανται και σε επίπεδο κωδικοποίησης των περιγραφικών χαρακτηριστικών (ιδιοτήτων). Για παράδειγμα, το οδικό δίκτυο της υπάρχουσας βάσης δεδομένων χρησιμοποιεί την ταξινόμηση «εθνικό δίκτυο», «επαρχιακό δίκτυο» και «κοινοτικό δίκτυο», ενώ τα νέα δεδομένα χρησιμοποιούν την ταξινόμηση «δρόμος ταχείας κυκλοφορίας», «τοπικό δίκτυο» και «αγροτικό δίκτυο». Η αντιστοίχηση και η ομογενοποίηση των δεδομένων είναι μια επίπονη διαδικασία, η οποία λόγω απουσίας λεπτομερέστερων οδηγιών, αντιμετωπίζεται για κάθε περίπτωση ξεχωριστά.
	Γενίκευση: Τα δεδομένα τα οποία λαμβάνονται από άλλες πηγές, θα πρέπει να έχουν ως κλίμακα αναφοράς ή συλλογής μια κλίμακα συμβατή με αυτήν της βάσης χαρτογραφικών δεδομένων. Σε περίπτωση κατα την οποία η κλίμακα είναι μικρότερη της κλίμακας αναφοράς της βάσης χαρτογραφικών δεδομένων, τα δεδομένα θα πρέπει να απορρίπτονται. Αν τα δεδομένα έχουν κλίμακα αναφοράς μεγαλύτερη, θα πρέπει να εφαρμόζεται η διαδικασία της γενίκευσης μοντέλου και της χαρτογραφικής γενίκευσης (βλ. Κεφάλαιο 9).
	Έλεγχοι εντοπισμού τοπολογικών προβλημάτων και θέματα ασυμβατότητας: Τα δεδομένα που λαμβάνονται από άλλες πηγές ενδέχεται να παρουσιάζουν εσωτερικά προβλήματα τοπολογίας και ασυμβατότητας σε σχέση με τα άλλα θεματικά επίπεδα που προϋπάρχουν στη βάση δεδομένων. Τα προβλήματα αυτά θα πρέπει να εντοπιστούν με προσεκτική επισκόπηση και εφαρμογή των τοπολογικών ελέγχων που έχουν ήδη περιγραφεί (βλ. Κεφάλαιο 3). Τα σφάλματα αυτά διορθώνονται με επεξεργασία της γεωμετρίας λαμβάνοντας υπόψη τη σχετική ακρίβεια των θεματικών επιπέδων.

 
Γεωχωρικά δεδομένα μπορούν να εντοπιστούν με τις μηχανές αναζήτησης για το διαδίκτυο. Χαρακτηριστικοί ιστότοποι γεωχωρικών δεδομένων παγκόσμιας κάλυψης είναι οι ακόλουθοι: 
 
	Ακτογραμμή - Global Self-consistent Hierarchical High-Resolution Shoreline (GSHHS): http://www.ngdc.noaa.gov/mgg/shorelines/gshhs.html.
	Natural Earth (http://www.naturalearthdata.com/): Δημόσια (public domain) χαρτογραφικά δεδομένα που διατίθενται σε τρεις κλίμακες 1:10.000.000, 1:50.000 000 και 1:110.000.000.
	Stanford Geospatial Center (https://lib.stanford.edu/GIS/data): Παρουσίαση καταλόγου ιστοσελίδων που παρέχουν γεωχωρικά δεδομένα προς διάθεση.
	European Environment Agency (http://www.eea.europa.eu/): Αναζήτηση και λήψη δεδομένων για την Ευρώπη που σχετίζονται με το περιβάλλον. 
	Advanced Spaceborne Thermal Emission and Reflection Radiometer (ASTER) (http://asterweb.jpl.nasa.gov/gdem.asp): Ψηφιακό μοντέλο εδάφους με ανάλυση 30m.
	Geotopo30 (https://lta.cr.usgs.gov/GTOPO30): Ψηφιακό μοντέλο εδάφους με ανάλυση 30’’ (περίπου 1 km). 

 
4.2 Γεωχωρικά δεδομένα που διατίθενται από το διαδίκτυο
 
Από το διαδίκτυο διατίθενται ποικίλα γεωχωρικά δεδομένα. Πρόκειται για έναν κατάλογο δεδομένων που συνεχώς εμπλουτίζεται και διευρύνεται ως προς το περιεχόμενο και την κάλυψη. Στον Πίνακα 4.1 παρουσιάζονται ενδεικτικά γεωχωρικά δεδομένα που καλύπτουν τον ελλαδικό χώρο. 
4.3 Διαδικασία αναζήτησης και λήψης δεδομένων
 
Στις παραγράφους που ακολουθούν παρουσιάζονται ορισμένες χαρακτηριστικές διαδικασίες αναζήτησης και λήψης γεωχωρικών δεδομένων από το διαδίκτυο.
4.3.1 Λήψη δεδομένων από τον ιστότοπο «Δημόσια, Ανοικτά Δεδομένα» 
 
Με τη βοήθεια ενός φυλλομετρητή, ανακτάται η ιστοσελίδα Δημόσια, Ανοικτά Δεδομένα (http://geodata.gov.gr/geodata/) (Εικόνα 4.1). Τα δεδομένα μπορούν να αναζητηθούν από την επιλογή Μενού>Δεδομένα μέσω της παρουσίασής τους ανά φορέα, ανά θεματική κατηγορία, αλφαβητικά, κατά ημερομηνία ενημέρωσης και κατά ημερομηνία διάθεσης. Επιπλέον, μπορούν να αναζητηθούν μέσω του γραφικού περιβάλλοντος παρουσίασής τους σε χάρτη (Εικόνα 4.2) από την επιλογή Μενού>Χάρτες (http://geodata.gov.gr/maps/). Για τη λήψη ενός θεματικού επιπέδου π.χ. οι οικισμοί σε μορφότυπο shapefile, επιλέγεται Δεδομένα>Οργανισμός Κτηματολογίου και Χαρτογραφήσεων Ελλάδας>Οικισμοί. Στη συνέχεια, επιλέγεται Πρόσβαση>SHP>Αποθήκευση όπως π.χ. oikismoi.zip. Tο αρχείο oikismoi.zip αποθηκεύεται τοπικά και πρέπει να αποσυμπιεστεί ώστε να δημιουργηθεί ένας κατάλογος, π.χ. oikismoi, με αρχεία μορφότυπου shapefile.
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Εικόνα 4.1 Ιστοσελίδα Δημόσια Δεδομένα, Ανοικτά Δεδομένα.
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Πίνακας 4.1 Πηγές δεδομένων για τον ελλαδικό χώρο από το διαδίκτυο.
4.3.2 Εντοπισμός μιας διαδικτυακής χαρτογραφικής υπηρεσίας WMS (Web Map Service)
 
Από τον ιστότοπο Δημόσια, Ανοικτά Δεδομένα (http://geodata.gov.gr/geodata/), επιλέγεται Δεδομένα>Κτηματολόγιο Α.Ε>Ορθοφωτογραφίες για το σύνολο της Ελλάδας. Καταγράφεται το πρότυπο της διαδικτυακής υπηρεσίας που χρησιμοποιείται WMS (Web Map Service) και η διεύθυνση του εξυπηρετητή: http://gis.ktimanet.gr/wms/wmsopen/wmsserver.aspx.
4.3.3 Λήψη διανυσματικών δεδομένων Open Street Map (OSM) 
 
Από τον ιστότοπο http://extract.bbbike.org/ (Εικόνα 4.3) μπορούν να ληφθούν δεδομένα Open Street Map (OSM) για μια περιοχή τα όρια της οποίας θα ορίσει ο χρήστης με τη βοήθεια ενός παραλληλογράμμου (resize or drag polygon) ή ενός κλειστού πολυγώνου (add points to polygon) που θα σχεδιάσει στο χάρτη της οθόνης. Επί πλέον, ο χρήστης παρέχει τις ακόλουθες πληροφορίες: format>shapefile (ESRI), τη διεύθυνση ηλεκτρονικού ταχυδρομείου του χρήστη (Your email address), ένα όνομα για την περιοχή των δεδομένων που θα εξαχθεί (Name of area to extract). H διαδικασία ολοκληρώνεται με το πλήκτρο Extract. Στη συνέχεια, ο χρήστης λαμβάνει ένα ηλεκτρονικό μήνυμα με τη σύνδεση από την οποία θα λάβει ένα αρχείο τύπου zip που περιέχει ένα σύνολο αρχείων μορφότυπου shapefile με τα δεδομένα που ζητήθηκαν. 
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Εικόνα 4.2 Αναζήτηση γεωχωρικών δεδομένων μέσω γραφικού περιβάλλοντος παρουσίασης σε χάρτη.
 
 
 
 
4.3.4 Λήψη δεδομένων SRTM (Shuttle Radar Topography Mission)
 
Για τη λήψη δεδομένων SRTM (Shuttle Radar Topography Mission), από τον ιστότοπο http://srtm.csi.cgiar.org/SELECTION/inputCoord.asp (Εικόνα 4.4), επιλέγεται η περιοχή ενδιαφέροντος και ο μορφότυπος των δεδομένων (GeoTiff ή ArcInfo ASCII). H διαδικασία ολοκληρώνεται με το πλήκτρο Click here to Begin Search. Στη συνέχεια, ο χρήστης επιλέγει έναν από τους διαθέσιμους εξυπηρετητές (Data download (HTTP) (Εικόνα 4.5) και λαμβάνει ένα αρχείο τύπου zip που περιέχει τα αρχεία με τα δεδομένα που ζητήθηκαν.
 
 
[image: ]
Εικόνα 4.3 Λήψη δεδομένων OSM για μια περιοχή ενδιαφέροντος. 
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Εικόνα 4.4 Λήψη δεδομένων SRTM: ορισμός περιοχής και επιλογή μορφότυπου.
 
 
[image: ]
Εικόνα 4.5 Λήψη δεδομένων SRTM: επιλογή εξυπηρετητή.
4.4 Εισαγωγή δεδομένων στο ΣΓΠ QGIS
 
Στη συνέχεια, παρουσιάζονται ορισμένες βασικές περιπτώσεις εισαγωγής και χρήσης δεδομένων στο περιβάλλον του ΣΓΠ QGIS (“QGIS Training Manual”, χ.η.;“QGIS User Guide”, χ.η.).
4.4.1Εισαγωγή αρχείου μορφότυπου shapefile στη βάση γεωχωρικών δεδομένων PostgreSQL/PostGIS
 
Για την εισαγωγή ενός αρχείου μορφότυπου shapefile στη βάση γεωχωρικών δεδομένων PostgreSQL/PostGIS από το περιβάλλον του ΣΓΠ QGIS, χρησιμοποιείται το εργαλείο SPIT (Import shapefiles to PostgreSQL/PostGIS). Το εργαλείο αυτό επιτρέπει την ταυτόχρονη εισαγωγή πολλών αρχείων μορφότυπου shapefile. Από το μενού επιλέγεται Βάση Δεδομένων>SPIT. Στο νέο παράθυρο SPIT - Shapefile to PostGIS Import Tool (Εικόνα 4.6) επιλέγεται η σύνδεση με μια βάση δεδομένων PostgreSQL στην οποία θα γίνει η εισαγωγή π.χ. dm_geodatabase και πραγματοποιείται η σύνδεση με το πλήκτρο Σύνδεση. Απενεργοποιούνται οι επιλογές Use default geometry column name και Use default SRID. Επιπλέον, ορίζονται τα ακόλουθα: το όνομα του πεδίου στο οποίο καταγράφεται η γεωμετρία Geometry column name π.χ. geom, το σύστημα αναφοράς των συντεταγμένων Kωδικός Συστήματος Συν/νων βάσει του κωδικού ESPG (βλ. Κεφάλαιο 6) π.χ. 2100 για το ΕΓΣΑ ’87, το όνομα του πεδίου που λειτουργεί ως πρωτεύον κλειδί Primary key column name π.χ. id, το Global schema της βάσης στο οποίο θα γίνει η εισαγωγή π.χ. data. Τέλος, προστίθενται ένα ή περισσότερα αρχεία μορφότυπου shapefile τα οποία θα εισαχθούν με το πλήκτρο Προσθήκη. Ο χρήστης ακόμα μπορεί να αλλάξει το όνομα του πίνακα DB Relation Name ο οποίος θα δημιουργηθεί στη βάση. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
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Εικόνα 4.6 Εισαγωγή αρχείου μορφότυπου shapefile στη βάση γεωχωρικών δεδομένων PostgreSQL/PostGIS.
4.4.2 Προσθήκη αρχείου μορφότυπου shapefile
 
Για την προσθήκη ενός αρχείου μορφότυπου shapefile, από την εργαλειοθήκη επιλέγεται Προσθήκη διανυσματικού επιπέδου από το εικονίδιο [image: ]. Στο νέο παράθυρο Add vector layer (Εικόνα 4.7), ορίζεται το είδος του αρχείου Source Type>Αρχείο και από το πλήκτρο Αναζήτηση, το αρχείο που θα χρησιμοποιηθεί. Επίσης από την επιλογή Κωδικοποίηση ορίζεται το σχήμα κωδικοποίησης χαρακτήρων που χρησιμοποιούν τα δεδομένα π.χ. UTF - 8. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
 
 
 
4.4.2.1 Εξαγωγή διανυσματικών δεδομένων για την περιοχή μελέτης
 
Για την εξαγωγή διανυσματικών δεδομένων μόνο για την περιοχή μελέτης, από το μενού επιλέγεται Διανύσματα>Geoprocessing Εργαλεία>Clip. Στο νέο παράθυρο Κοπή (clip) (Εικόνα 4.8), ορίζεται το αρχείο το οποίο θα αποκοπεί ως Input layer vector, το αρχείο το οποίο ορίζει την περιοχή ενδιαφέροντος ως Κοπή επιπέδου (clip) και το νέο αρχείο που θα δημιουργηθεί ως Output Shapefile. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Για την ορθή εφαρμογή της διαδικασίας, τα δεδομένα πρέπει να χρησιμοποιούν το ίδιο σύστημα συντεταγμένων.
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Εικόνα 4.7 Εισαγωγή αρχείου shapefile.
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Εικόνα 4.8 Αποκοπή του διανυσματικού θεματικού επιπέδου στα όρια της περιοχής.
4.4.3 Σύνδεση με εξυπηρετητή WMS (Web Map Service) γεωχωρικών δεδομένων
 
Για την υλοποίηση μιας σύνδεσης με έναν εξυπηρετητή γεωχωρικών δεδομένων τύπου WMS (Web Map Service), από την εργαλειοθήκη επιλέγεται Προσθήκη επιπέδου WMS/WMTS από το εικονίδιο [image: ]. Στο νέο παράθυρο Add Layer(s) from a WM(T)S Server (Εικόνα 4.9) επιλέγεται το πλήκτρο Σύνδεση. Στο νέο παράθυρο (Εικόνα 4.10) Create a new WMS connection, ορίζεται το όνομα της σύνδεσης Όνομα π.χ. Kτηματολόγιο, OSM και η διεύθυνση URL π.χ. http://gis.ktimanet.gr/wms/wmsopen/wmsserver.aspx?, http://ows.terrestris.de/osm/service. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 4.9 Σύνδεση με έναν εξυπηρετητή WMS (Web Map Service) χωρικών δεδομένων.
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Εικόνα 4.10 Ορισμός παραμέτρων σύνδεσης WMS.
4.4.4 Εισαγωγή δεδομένων ASCII και αποθήκευση σε αρχείο μορφότυπου shapefile
 
Για την εισαγωγή δεδομένων ASCII, από την εργαλειοθήκη επιλέγεται Αdd Delimited Text Layer από το εικονίδιο [image: ]. Στο νέο παράθυρο Create a Layer from a Delimited Text File (Εικόνα 4.11) ορίζονται: το αρχείο με τα δεδομένα από το πλήκτρο Περιήγηση.., το όνομα του νέου αρχείου ως Όνομα επιπέδου, η δομή του αρχείου ως προς τον χαρακτήρα που χρησιμοποιείται για τη διάκριση των στηλών των δεδομένων (π.χ. όταν χρησιμοποιείται το κόμμα (,) επιλέγεται CSV (Comma Separated Values), το είδος της γεωμετρίας π.χ. Point coordinates και οι στήλες που περιέχουν τις συντεταγμένες. Η ορθή ανάγνωση του αρχείου επιβεβαιώνεται από την παρουσίασή του σε στήλες. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Η αποθήκευση των δεδομένων σε αρχείο μορφότυπου shapefile περιγράφεται στο Παράρτημα Α (βλ. Α.5.2).
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Εικόνα 4.11 Εισαγωγή ASCII δεδομένων. 
4.4.5 Εισαγωγή κανονικοποιημένων δεδομένων 
 
Για την εισαγωγή κανονικοποιημένων δεδομένων π.χ. NASA SRTM στο περιβάλλον του QGIS, από την εργαλειοθήκη επιλέγεται Προσθήκη επιπέδου Raster από το εικονίδιο [image: ]. Στη συνέχεια επιλέγεται το αρχείο που θα εισαχθεί. 
4.4.6 Εισαγωγή δεδομένων OSM
 
Από το μενού επιλέγεται Διανύσματα>Open Street Map> Download Data. Στο νέο παράθυρο Download OpenStreetMap data (Εικόνα 4.12), ορίζονται τα όρια της περιοχής για την οποία θα ληφθούν δεδομένα είτε από τα όρια της περιοχής που απεικονίζεται στην οθόνη (Από τον καμβά του χάρτη), είτε από ένα από τα θεματικά επίπεδα που είναι φορτωμένα (From layer) είτε ορίζοντας τις συντεταγμένες των ορίων (Χειροκίνητα). Επιπλέον, ορίζεται το όνομα του αρχείου Αρχείο προορισμού, όπου θα αποθηκευτούν τα δεδομένα με το πλήκτρο «...». Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
Το αρχείο που λήφθηκε είναι ένα αρχείο με την επέκταση osm και δομή OSM XML (http://wiki.openstreetmap.org/wiki/OSM_XML). Τα δεδομένα αυτά θα πρέπει να μετατραπούν σε έναν άλλο μορφότυπο, ο οποίος είναι πιο κατάλληλος για επεξεργασία στο QGIS π.χ. SpatiaLite. Από το μενού επιλέγεται Διανύσματα>OpenStreetMap>Import topology from XML. Στο νέο παράθυρο Open Street Map Import ορίζονται: το αρχείο με τα δεδομένα OSM π.χ. ikaria.osm ως Input XML file, το νέο αρχείο που θα δημιουργηθεί π.χ. ikaria.osm.db ως Output SpatiaLite DB file και ενεργοποιείται η επιλογή Create connection (SpatiaLite) after import. Στη συνέχεια, θα πρέπει να δημιουργηθούν SpatialLite θεματικά επίπεδα, τα οποία μπορούν να αποδοθούν και να επεξεργαστούν στο περιβάλλον του QGIS. Τα δεδομένα OSM περιλαμβάνουν όλα τα είδη γεωμετρίας (σημεία, γραμμές και πολύγωνα) σε αντίθεση με την πάγια χαρτογραφική τακτική ορισμού των θεματικών επιπέδων. Επομένως, για τη δημιουργία ενός θεματικού επιπέδου, θα πρέπει να επιλεγούν δεδομένα που ανταποκρίνονται στον ορισμό του. Από το μενού επιλέγεται Διανύσματα>OpenStreetMap>Export topology to SpatialLite. Στο νέο παράθυρο Export OSM Topology to Spatial Lite ορίζονται: το αρχείο που δημιουργήθηκε στο προηγούμενο στάδιο, ένα είδος γεωμετρίας π.χ. Point (nodes) ως Export type και το όνομα του θεματικού επιπέδου που θα δημιουργηθεί. Από την επιλογή Load from DB εμφανίζονται στην περιοχή Exported tags όλα τα διατιθέμενα πεδία (http://wiki.openstreetmap.org/wiki/Tags) και στη συνέχεια επιλέγονται αυτά που χρειάζονται. Η επιλογή Load into canvas when finished θα φορτώσει τα δεδομένα ως νέο θεματικό επίπεδο στο περιβάλλον εργασίας. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
Για την επιλογή ενός υποσυνόλου των δεδομένων με βάση τις τιμές των ιδιοτήτων τους, με δεξί κλικ πάνω στο επίπεδο επιλέγεται Open Attribute Table. Στο νέο παράθυρο Attribute Table, επιλέγεται το πλήκτρο [image: ] Select features using an expression (Εικόνα 4.13). Στο νέο παράθυρο Select by expression συντάσσεται η λογική πρόταση επιλογής. Με δεξί κλικ πάνω στο επίπεδο π.χ. ikaria_osm_points και στη συνέχεια επιλογή Save Selection As...., τα επιλεγμένα δεδομένα αποθηκεύονται σε ένα νέο θεματικό επίπεδο. Στο παράθυρο διαλόγου Save vector layer as..., εισάγεται το όνομα του αρχείου που θα αποθηκευτεί π.χ. ikaria_osm_.shp και η επιλογή Add saved file to map, ώστε να προστεθούν τα δεδομένα στον κατάλογο των θεματικών επιπέδων. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
4.4.7 Χρήση εξυπηρετητή WMS για δημιουργία ή/και ενημέρωση διανυσματικών δεδομένων στο περιβάλλον QGIS
 
Από την εργαλειοθήκη επιλέγεται Προσθήκη επιπέδου WMS/WMTS από το εικονίδιο [image: ]. Στο νέο παράθυρο Add Layer(s) from a WM(T)S Server (Εικόνα 4.9) επιλέγεται μια από τις συνδέσεις που έχει δημιουργηθεί π.χ. Κτηματολόγιο και στη συνέχεια το πλήκτρο Προσθήκη. Τα δεδομένα αυτής της υπηρεσίας χρησιμοποιούν ως σύστημα αναφοράς των συντεταγμένων γεωγραφικές συντεταγμένες στο WGS84. Στη συνέχεια, από την εργαλειοθήκη επιλέγεται Προσθήκη διανυσματικού επιπέδου από το εικονίδιο [image: ]. Στο νέο παράθυρο Add vector layer (Εικόνα 4.6), ορίζεται το είδος του αρχείου Source Type>Αρχείο και από το πλήκτρο Αναζήτηση το αρχείο shapefile το οποίο θα χρησιμοποιηθεί για την ψηφιακή καταγραφή. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Σε ορισμένες περιπτώσεις, το σύστημα αναφοράς των συντεταγμένων (ΣΑΣ) για τα στοιχεία που θα καταγραφούν π.χ. ΕΓΣΑ ’87 είναι βάσει των προδιαγραφών διαφορετικό από αυτό της υπηρεσίας WMS π.χ. WGS84. Στην περίπτωση αυτή, πρέπει να μετασχηματιστούν ως προς το ΣΑΣ τα δεδομένα της υπηρεσίας WMS κατά την απόδοσή τους εντός του QGIS. Tο νέο ΣΑΣ ορίζεται από την επιλογή Έργο>Ιδιότητες Έργου. Στο νέο παράθυρο Project Properties|CRS (Εικόνα 4.14), ενεργοποιείται η επιλογή Enable ‘on the fly’ CRS transformation και επιλέγεται το σύστημα αναφοράς των συντεταγμένων βάσει των προδιαγραφών π.χ. GGRS87/Greek Grid. Στη συνέχεια πραγματοποιείται η ψηφιακή καταγραφή, όπως περιγράφηκε στο Κεφάλαιο 3.
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Εικόνα 4.12 Λήψη και εισαγωγή δεδομένων OSM.
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Εικόνα 4.13 Επιλογή με βάση τις τιμές των ιδιοτήτων.
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Εικόνα 4.14 Ορισμός του συστήματος συντεταγμένων στο QGIS.
4.5 Εισαγωγή και χρήση δεδομένων στο ΣΓΠ ArcGIS
 
Στη συνέχεια, παρουσιάζονται ορισμένες βασικές περιπτώσεις εισαγωγής και χρήσης δεδομένων στο περιβάλλον του ΣΓΠ ArcGIS (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β).
4.5.1 Εισαγωγή διανυσματικού αρχείου μορφότυπου shapefile στη γεωβάση
 
Για την εισαγωγή ενός διανυσματικού αρχείου μορφότυπου shapefile στη γεωβάση, από το περιβάλλον του ArcCatalog επιλέγεται το αρχείο shapefile π.χ. oikismoi.shp και με δεξί κλικ  Export>To Geodatabase (single). Στο νέο παράθυρο Feature Class to Feature Class (Εικόνα 4.15) ορίζονται τα ακόλουθα: το αρχείο shapefile που θα εισαχθεί στη βάση δεδομένων Input features, η βάση δεδομένων ή το feature dataset στο οποίο θα γίνει η εισαγωγή Output Location και το όνομα του feature class που θα δημιουργηθεί Output Feature Class. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK. Επιπλέον, υπάρχει η δυνατότητα αφαίρεσης ορισμένων από τα πεδία ιδιοτήτων του αρχείου μορφότυπου shapefile, εάν δεν είναι επιθυμητή η μεταφορά τους στη βάση δεδομένων.
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Εικόνα 4.15 Εισαγωγή αρχείου μορφότυπου shapefile στη γεωβάση.
4.5.1.1 Εξαγωγή δεδομένων για την περιοχή μελέτης
 
Για την εξαγωγή δεδομένων μόνο για την περιοχή μελέτης, ενεργοποιείται το ArcToolbox από το εικονίδιο [image: ]. Από το ArcToolbox, επιλέγεται Analysis Tools>Extract>Clip. Στο νέο παράθυρο Clip (Εικόνα 4.16), ορίζονται τα ακόλουθα: το feature class που θα χρησιμοποιηθεί ως δεδομένα εισόδου Input features, το πολυγωνικό feature class που θα χρησιμοποιηθεί ως όριο Clip Features π.χ. πολύγωνο ακτογραμμής και το όνομα του feature class που θα δημιουργηθεί Output Feature Class. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.
4.5.2 Εισαγωγή σημειακών δεδομένων από αρχείο ASCII
 
Για την εισαγωγή σημειακών δεδομένων από ένα αρχείο ASCII (American Standard Code for Information Interchange) που καταγράφει γεωγραφικές ή καρτεσιανές συντεταγμένες, σε περιβάλλον ArcCatalog επιλέγεται το αρχείο ASCII και με δεξί κλικ Create feature class>From XY table. Στο νέο παράθυρο Create feature class from XY table (Εικόνα 4.17), ορίζονται τα ακόλουθα: το πεδίο με την τετμημένη X Field π.χ. LONG, το πεδίο με την τεταγμένη Y Field π.χ. LAT, το πεδίο με το υψόμετρο Z field π.χ. z, το σύστημα αναφοράς των συντεταγμένων από το πλήκτρο Coordinate System Of Input Coordinates π.χ. Geographic Coordinate Systems>World>WGS84, το νέο αρχείο ή ο νέος χωρικός πίνακας που θα δημιουργηθεί εντός της γεωβάσης Specify output shapefile or feature class π.χ. zpoints_wgs84. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK. 
 
 
[image: ]
Εικόνα 4.16 Εξαγωγή δεδομένων μόνο για την περιοχή μελέτης.
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Εικόνα 4.17 Εισαγωγή σημειακών δεδομένων από αρχείο ASCII.
Τα δεδομένα που δημιουργούνται έχουν τρεις διαστάσεις και γι’ αυτό θα πρέπει να εφαρμοστεί ο μετασχηματισμός τους σε σημειακά δεδομένα (point) δύο διαστάσεων. Από το ArcToolbox, επιλέγεται Data Management Tools>Features>Feature to point. Στο νέο παράθυρο, ορίζονται τα ακόλουθα: ο χωρικός πίνακας προηγούμενου σταδίου Input features π.χ. zpoints_wgs84 και ο νέος χωρικός πίνακας εντός της γεωβάσης Output feature class π.χ. zpoints_wgs84_new. Ακόμη, από την επιλογή Environments ορίζεται Z values>Output has Z values> Disabled. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.
4.5.3 Εισαγωγή κανονικοποιημένων δεδομένων στη βάση δεδομένων
 
Για την εισαγωγή ενός αρχείου κανονικοποιημένων δεδομένων π.χ. ΨΜΕ τύπου SRTM στη βάση δεδομένων, από το περιβάλλον του ArcCatalog επιλέγεται το αρχείο προς μετατροπή και στη συνέχεια με δεξί κλικ η επιλογή Export>Data to Different Format. Στο νέο παράθυρο Copy Raster (Εικόνα 4.18) ορίζονται το αρχικό αρχείο Input Raster και το νέο αρχείο Output Raster Dataset. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.
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Εικόνα 4.18 Εισαγωγή αρχείου κανονικοποιημένων δεδομένων στη βάση δεδομένων
4.5.3.1 Εξαγωγή υπο-περιοχής  από κανονικοποιημένα δεδομένα
 
Για την εξαγωγή ενός τμήματος από τα κανονικοποιημένα δεδομένα, από το ArcToolbox επιλέγεται Data Management Tools>Raster>Raster Processing>Clip. Στο νέο παράθυρο Clip (Εικόνα 4.19) ορίζονται τα αρχικό αρχείο Input Raster, τα δεδομένα που προσδιορίζουν το όριο Output Extent (optional) και το νέο αρχείο που θα δημιουργηθεί Output Raster Dataset. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK.
4.5.4 Ενημέρωση υφιστάμενου χωρικού πίνακα με δεδομένα
 
Για την ενημέρωση υφιστάμενου χωρικού πίνακα με δεδομένα, σε περιβάλλον ArcCatalog επιλέγεται ένας χωρικός πίνακας π.χ. zpoints και με δεξί κλικ Load>Load Data>Next. Στην επόμενη καρτέλα Simple Data Loader, ορίζονται τα δεδομένα που θα εισαχθούν Input Data π.χ. zpoints_ggrs87, με το πλήκτρο Add διαβάζονται και με το πλήκτρο Next γίνεται η μετάβαση στην επόμενη καρτέλα. Εκεί επιβεβαιώνεται η χρήση του χωρικού πίνακα και με το πλήκτρο Next γίνεται η μετάβαση στην επόμενη καρτέλα. Στην καρτέλα αυτή (Εικόνα 4.20), γίνεται η αντιστοίχηση των πεδίων (Target Field> Matching Source Field) του χωρικού πίνακα και των νέων δεδομένων. H διαδικασία ολοκληρώνεται με το πλήκτρο Finish.
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Εικόνα 4.19 Εξαγωγή τμήματος από κανονικοποιημένα δεδομένα.
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Εικόνα 4.20 Ενημέρωση υπάρχοντος χωρικού πίνακα με δεδομένα.
 
4.5.5 Σύνδεση με εξυπηρετητή WMS γεωχωρικών δεδομένων
 
Για τη σύνδεση με έναν εξυπηρετητή WMS γεωχωρικών δεδομένων, σε περιβάλλον ArcCatalog επιλέγεται GIS servers>Add WMS server (Εικόνα 4.21). Στο νέο παράθυρο Add WMS Server (Εικόνα 4.21), συμπληρώνεται η διεύθυνση του εξυπηρετητή ως URL π.χ. για τον ορθοφωτοχάρτη του Κτηματολογίου . http://gis.ktimanet.gr/wms/wmsopen/wmsserver.aspx. Η διαδικασία ολοκληρώνεται με το πλήκτρο OK. Στο παράθυρο Preview, πραγματοποιείται η προεπισκόπηση των δεδομένων του WMS (Εικόνα 4.22).
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Εικόνα 4.21 Σύνδεση με έναν εξυπηρετητή WMS (Web Map Service) χωρικών δεδομένων.
4.5.6 Χρήση εξυπηρετητή WMS για δημιουργία ή/και ενημέρωση διανυσματικών δεδομένων 
 
Με βάση την υπόθεση ότι ως σύστημα αναφοράς των συντεταγμένων έχει επιλεγεί το ΕΓΣΑ ’87, αυτό θα πρέπει να οριστεί στο περιβάλλον ArcMap. Από το περιβάλλον ArcMap, επιλέγεται Layers και με δεξί κλικ Properties>Coordinate System>> New>Projected Coordinate System. Στη συνέχεια ορίζεται το σύστημα αναφοράς των συντεταγμένων με τα χαρακτηριστικά του ΕΓΣΑ’87: Name π.χ. “myEGSA87”, Projection - Transverse_Mercator, False_Easting - 500000.0, False_Northing - 0.0, Central_Meridian - 24.0, Scale_Factor - 0.9996, Geographic Coordinate System> Change: “Europe>GGRS 1987”. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Επιπλέον, επιλέγεται το μέτρο ως μονάδα συντεταγμένων. Από το περιβάλλον ArcMap, επιλέγεται Layers και με δεξί κλικ Properties>General>Units>Display>Meters. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
 
 
[image: ]
Εικόνα 4.22 Αποτέλεσμα σύνδεσης με εξυπηρετητή χωρικών δεδομένων WMS.
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Εικόνα 4.23 Σύνδεση με εξυπηρετητή χωρικών δεδομένων WMS.
Στη συνέχεια, υλοποιείται η σύνδεση με τον εξυπηρετητή WMS του Κτηματολογίου. Από την εργαλειοθήκη Standard Toolbar επιλέγεται το πλήκτρο Add Data [image: ] και στη συνέχεια μια σύνδεση που έχει ήδη υλοποιηθεί π.χ. GIS Servers>KTHMATOLOGIO_BASEMAP on gis.ktimanet.gr>KTHMATOLOGIO_BASEMAP>KTHMATOLOGIO. Η διαδικασία ολοκληρώνεται με το πλήκτρο Add (Εικόνα 4.23).
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Εικόνα 4.24 Κατά τη σύνδεση με τον εξυπηρετητή WMS, εμφανίζεται μήνυμα του συστήματος για ασυμφωνία των συστημάτων αναφοράς των συντεταγμένων.
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Εικόνα 4.25 Στο νέο παράθυρο Geographic Coordinate System Transformations γίνονται οι ανάλογες επιλογές.
Κατά τη σύνδεση με τον εξυπηρετητή WMS, εμφανίζεται ένα μήνυμα του συστήματος (Εικόνα 4.24) για ασυμφωνία των συστημάτων αναφοράς των συντεταγμένων. Αυτό οφείλεται στο ότι η υπηρεσία WMS χρησιμοποιεί γεωγραφικές συντεταγμένες στο WGS’84, ενώ το περιβάλλον του ArcMap έχει οριστεί να χρησιμοποιεί το ΕΓΣΑ ’87. Επομένως, επιλέγεται η εφαρμογή μετασχηματισμού με το πλήκτρο Transformations. Στο νέο παράθυρο Geographic Coordinate System Transformations (Εικόνα 4.25), γίνονται οι κατάλληλες επιλογές και η διαδικασία ολοκληρώνεται με τα πλήκτρα ΟΚ και Close. Με τη διαδικασία αυτή, ο ορθοφωτοχάρτης που λαμβάνεται από τον εξυπηρετητή WMS τoυ Κτηματολογίου μετασχηματίζεται στο σύστημα αναφοράς ΕΓΣΑ ’87 και μπορεί να αξιοποιηθεί για την ψηφιοποίηση των νέων θεματικών επιπέδων στη βάση δεδομένων ή την ενημέρωση των υπαρχόντων σε αυτό. Η διαδικασία ψηφιακής καταγραφής συνεχίζεται όπως περιγράφεται στο Κεφάλαιο 3.
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Κριτήρια αξιολόγησης 
Στη συνέχεια ακολουθούν μια σειρά από κριτήρια αξιολόγησης με τη μορφή ερωτήσεων των οποίων οι απαντήσεις βρίσκονται εντός του κειμένου του κεφαλαίου. 
Κριτήριο αξιολόγησης 1 
Που μπορεί να αναζητηθούν γεωχωρικά δεδομένα;
Κριτήριο αξιολόγησης 2 
Τι γνωρίζετε για το θέμα των δικαιωμάτων χρήσης σε σχέση με τα γεωχωρικά δεδομένα;
Κριτήριο αξιολόγησης 3
Ποιες ερωτήσεις πρέπει να απαντηθούν ώστε να ληφθεί απόφαση για την καταλληλότητα χρήσης των γεωχωρικών δεδομένων;
Κριτήριο αξιολόγησης 4
Ποιες είναι οι συνήθεις διαδικασίες επεξεργασίας πριν την ενσωμάτωση των δεδομένων από άλλες πηγές στη βάση χαρτογραφικών δεδομένων;
Κριτήριο αξιολόγησης 5
Τι κινδύνους κρύβει η χρήση  γεωχωρικών δεδομένων της κατηγορίας VGI;
 
Κεφάλαιο 5 
Έλεγχος ποιότητας χωρικών δεδομένων
Σύνοψη 
Στο κεφάλαιο αυτό περιγράφεται η διαδικασία ελέγχου της ποιότητας των χωρικών δεδομένων που συλλέχθηκαν κατά την ψηφιακή καταγραφή, μέσω της ανασύστασης των τοπολογικών σχέσεων που ενυπάρχουν στο χάρτη και αναγνωρίζονται κατά την ανάγνωσή του. Η αδυναμία ικανοποίησης των σχέσεων αυτών οδηγεί στον εντοπισμό των σφαλμάτων γεωμετρίας. Ο έλεγχος των τοπολογικών σχέσεων υλοποιείται με κανόνες που περιγράφουν τη συμπεριφορά των χωρικών στοιχείων προς άλληλα κι επιτρέπουν την καταγραφή των γεωχωρικών σχέσεων. Περιγράφεται η διαδικασία επιλογής των τοπολογικών κανόνων που θα εφαρμοστούν ανάλογα με τη φύση των θεματικών επιπέδων και τον σκοπό της βάσης χαρτογραφικών δεδομένων. Ακολουθεί λεπτομερής περιγραφή για την υλοποίηση των παραπάνω στο ΣΓΠ QGIS και στο ΣΓΠ ArcGIS μέσω των τοπολογικών κανόνων που διατίθενται.
Προαπαιτούμενη γνώση
Γενική γνώση για την έννοια και τη σημασία των τοπολογικών σχέσεων, τις δομές ψηφιακής καταγραφής των χωρικών οντοτήτων και τα πιθανά σφάλματα που μπορεί να εμφανίζονται στα δεδομένα ως αποτέλεσμα διαδικασιών όπως η συλλογή κ.ά. 
5. Ψηφιακή καταγραφή χωρικών οντοτήτων και τοπολογία
 
Η τοπολογία περιγράφει τις χωρικές σχέσεις ανάμεσα στις χωρικές οντότητες (σημεία, γραμμές, πολύγωνα) μιας περιοχής. Πρόκειται για μια μαθηματική έννοια που περιγράφει τις σχέσεις μεταξύ των χωρικών οντοτήτων που δεν αλλάζουν από τους χαρτογραφικούς μετασχηματισμούς π.χ. αλλαγή απεικόνισης, γενίκευση, γεωγραφική προσαρμογή κ.ά. Για παράδειγμα (Εικόνα 5.1), η επαρχιακή οδός συνδέεται με την αγροτική οδό, ο οικισμός βρίσκεται εντός του νησιού, η στεριά γειτνιάζει με τη θάλασσα κ.ά. Οι τοπολογικές σχέσεις των χαρτογραφικών δεδομένων που ενυπάρχουν στο χάρτη και μπορούν να αναγνωριστούν κατά την ανάγνωσή του, καταγράφονται (έμμεσα) και αυτές κατά την ψηφιακή καταγραφή της γεωμετρίας των χαρτογραφικών δεδομένων. Επομένως, μπορούν, στη συνέχεια, να αναπλαστούν στο επίπεδο της βάσης χαρτογραφικών δεδομένων. 
5.1 Ποιότητα και τοπολογικές σχέσεις
 
Τα σφάλματα της ψηφιακής καταγραφής εμποδίζουν την ορθή καταγραφή της γεωμετρίας και κατά συνέπεια την ανασύσταση των τοπολογικών σχέσεων. Για παράδειγμα, όταν τα τμήματα ενός δικτύου δεν συνδέονται καταγράφεται παράβαση της συνδεσιμότητας, όταν οι παραλιακοί δρόμοι τέμνονται με την ακτογραμμή καταγράφεται παράβαση της σχέσης εντός, όταν τα όρια των οικοπέδων και των οικοδομικών τετραγώνων τέμνονται καταγράφεται παράβαση της σχέσης εντός, όταν υπάρχουν κενά ανάμεσα στα πολύγωνα των χρήσεων γης καταγράφεται παράβαση της γειτνίασης κ.ά. Τα συνηθέστερα σφάλματα στη γεωμετρία, τα οποία οφείλονται στην ψηφιακή καταγραφή, εμποδίζουν τη δημιουργία των σύμφωνων με την πηγή τοπολογικών σχέσεων και αφορούν π.χ. την τομή μιας γραμμής με τον εαυτό της, τα κενά ανάμεσα σε γειτονικά πολύγωνα, τις γραμμές που υπολείπονται ή ξεπερνούν τη γραμμή με την οποία θα έπρεπε να ενώνονται, τις γραμμές που δεν κλείνουν για να σχηματίσουν κλειστά πολύγωνα κ.ά. Η αδυναμία αναδημιουργίας των τοπολογικών σχέσεων στη βάση χαρτογραφικών δεδομένων, υποβαθμίζει την ποιότητα των γεωχωρικών δεδομένων με αποτέλεσμα την αμφισβήτηση της αξιοπιστίας της βάσης δεδομένων.
Συνήθως, οι τοπολογικές σχέσεις ελέγχονται με μια σειρά από κανόνες που περιγράφουν τη συμπεριφορά των χωρικών δεδομένων (π.χ. οι ισοϋψείς δεν πρέπει να τέμνονται ούτε να επικαλύπτονται), επιτρέπουν την καταγραφή των χωρικών σχέσεων (π.χ. οι πρωτεύουσες πρέπει να βρίσκονται εντός των πολυγώνων των κρατών), ελέγχουν την αξιοπιστία της βάσης χαρτογραφικών δεδομένων (π.χ. δεν πρέπει να υπάρχουν κενά ανάμεσα σε όμορα πολύγωνα). Οι κανόνες επιλέγονται από ένα προκαθορισμένο κατάλογο κανόνων που αφορούν σε σημεία, γραμμές και πολύγωνα. Ένας κανόνας μπορεί να αφορά στις σχέσεις: ενός χωρικού στοιχείου συγκεκριμένου θεματικού επιπέδου με τον εαυτό του, μεταξύ του συνόλου των χωρικών στοιχείων ενός θεματικού επιπέδου και τέλος των χωρικών στοιχείων ενός θεματικού επιπέδου ως προς τα χωρικά στοιχεία ενός άλλου θεματικού επιπέδου. Η επιλογή των κανόνων εξαρτάται από τα ιδιαίτερα χαρακτηριστικά κάθε θεματικού επίπεδου, π.χ. οι γραμμές που καταγράφουν το οδικό δίκτυο επιτρέπεται να τέμνονται ενώ οι γραμμές που καταγράφουν τις ισοϋψείς καμπύλες δεν επιτρέπεται να τέμνονται, οι αιωρούμενοι κόμβοι δεν είναι επιθυμητοί σε ένα γραμμικό θεματικό επίπεδο αλλά σε ένα υδρολογικό δίκτυο αντιπροσωπεύουν τις απολήξεις των τμημάτων του. Επιπλέον, η επιλογή επηρεάζεται από τον σκοπό αξιοποίησης των δεδομένων π.χ. η επαλήθευση των κατάλληλων τοπολογικών σχέσεων είναι επιτακτική σε ένα θεματικό επίπεδο οδικού δικτύου το οποίο θα χρησιμοποιηθεί για τη δημιουργία μιας δομής δικτύου. Οι κανόνες βασίζονται στις βασικές τοπολογικές σχέσεις: εφάπτεται, περιέχεται, περιέχει, τέμνεται, καλύπτεται κ.ά. 
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Εικόνα 5.1 Στον χάρτη αναγνωρίζονται οι τοπολογικές σχέσεις. 
Στα σύγχρονα ΣΓΠ, σε αντίθεση με την τακτική του παρελθόντος, η τοπολογία δεν αποθηκεύεται στη βάση δεδομένων μαζί με τη γεωμετρία με βάση το τοπολογικό μοντέλο (Τσούλος, 2008). Δομείται με εντολή του χειριστή/χρήστη του συστήματος βάσει του ελέγχου ικανοποίησης μιας σειράς κανόνων (Hoel, Menon & Morehouse, 2003) ανάλογα με τις δυνατότητες του συστήματος ΣΓΠ και των ιδιαιτεροτήτων των δεδομένων. Ο χρήστης πληροφορείται για τις περιπτώσεις στις οποίες οι κανόνες παραβιάζονται και θα πρέπει να τις θεραπεύσει διορθώνοντας τη γεωμετρία. Οι παραβιάσεις των κανόνων κατονομάζονται ως σφάλματα και καταγράφονται σε σχετική αναφορά ενώ παράλληλα απεικονίζονται και στο γραφικό περιβάλλον του ΣΓΠ. Αρχικά, από τον κατάλογο των προσφερόμενων τοπολογικών κανόνων (Εικόνα 5.2),   επιλέγεται ένα υποσύνολο το οποίο ταιριάζει με τα θεματικά επίπεδα της βάσης χαρτογραφικών δεδομένων. Το ΣΓΠ χρησιμοποιώντας τη γεωμετρία των θεματικών επιπέδων εφαρμόζει τους τοπολογικούς κανόνες. Ως αποτέλεσμα της αξιολόγησης προκύπτει ένας κατάλογος σφαλμάτων που υποδηλούν παραβίαση των κανόνων. Ο χρήστης είτε αποδέχεται την ύπαρξη του σφάλματος ως εξαίρεση του κανόνα ή όταν οφείλεται σε σφάλμα στη γεωμετρία, επιχειρεί τη διόρθωσή του. Όταν ολοκληρωθούν οι διορθώσεις στη γεωμετρία, η αξιολόγηση βάσει των τοπολογικών κανόνων επαναλαμβάνεται. Η διαδικασία ολοκληρώνεται όταν ο χρήστης θεωρήσει ότι όλα τα σφάλματα έχουν διορθωθεί και οι τυχόν εναπομείνασες παραβάσεις των κανόνων είναι αποδεκτές.
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Εικόνα 5.2 Διαδικασία τοπολογικών ελέγχων.
 
 
 	Κανόνας
	Έλεγχος

	Must be covered by
	Τα σημεία θα πρέπει να καλύπτονται από ένα άλλο θεματικό επίπεδο. 

	Must be covered by endpoints of
	Τα σημεία θα πρέπει να καλύπτονται από τους κόμβους ενός γραμμικού θεματικού επίπεδου.

	Must be inside
	Τα σημεία θα πρέπει να βρίσκονται εντός των πολυγώνων ενός άλλου θεματικού επίπεδου.

	Must not have duplicates
	Δεν θα πρέπει να υπάρχουν σημεία με την ίδια γεωμετρική θέση.

	Must not have invalid geometries
	Η γεωμετρία θα πρέπει να είναι έγκυρη

	Must not have multi-part-geometries
	Δεν επιτρέπεται η ύπαρξη γεωμετριών πολλαπλών οντοτήτων.


Πίνακας 5.1 Κανόνες τοπολογίας για σημειακές οντότητες (ΣΓΠ QGIS).
5.2 Τοπολογικοί έλεγχοι και ΣΓΠ QGIS
 
Το ΣΓΠ QGIS (“QGIS Training Manual”, χ.η.;“QGIS User Guide”, χ.η.) διαθέτει εργαλεία ψηφιακής καταγραφής που ελαχιστοποιούν τα τοπολογικά σφάλματα π.χ. εργαλείο σύμπτωσης θέσεων (βλ. Κεφάλαιο 3). Παράλληλα, διατίθεται το εργαλείο Τοπολογικών Ελέγχων (Topology Checker) που είναι χρήσιμο για τη διόρθωση των σφαλμάτων. Το εργαλείο αυτό προσφέρει μια σειρά από τοπολογικούς κανόνες που αφορούν σημεία (Πίνακας 5.1), γραμμές (Πίνακας 5.2) και πολύγωνα (Πίνακας 5.3). 
 
 
 	Κανόνας
	Έλεγχος

	End points must be covered by
	Οι κόμβοι ενός γραμμικού θεματικού επίπεδου θα πρέπει να καλύπτονται από σημεία.

	Must not have dangles
	Δεν πρέπει να υπάρχουν αιωρούμενοι κόμβοι. Ως κόμβοι θεωρούνται οι κορυφές όπου συναντιούνται τρεις τουλάχιστον γραμμές.

	Must not have duplicates
	Δεν θα πρέπει να υπάρχουν γραμμές με την ίδια ακριβώς γεωμετρία.

	Must not have invalid geometries
	Η γεωμετρία θα πρέπει να είναι έγκυρη.

	Must not have multi-part geometries
	Δεν επιτρέπεται η ύπαρξη γεωμετριών πολλαπλών οντοτήτων.

	Must not have pseudos
	Δεν θα πρέπει να υπάρχουν ψευδο-κόμβοι. Κάθε κόμβος κάθε γραμμής πρέπει να ενώνεται με δύο κόμβους άλλων δύο γραμμών. Εάν ο κόμβος ενώνεται μόνο με έναν κόμβο άλλης γραμμής χαρακτηρίζεται ως ψευδο-κόμβος. 


Πίνακας 5.2 Κανόνες για γραμμικές οντότητες (ΣΓΠ QGIS).
 
 
 	Κανόνας
	Έλεγχος

	Must contain
	Ένα πολυγωνικό θεματικό επίπεδο πρέπει να περιέχει δεδομένα από ένα άλλο θεματικό επίπεδο. 

	Must not have duplicates
	Δεν θα πρέπει να υπάρχουν πολύγωνα με την ίδια γεωμετρία.

	Must not have gaps
	Δεν θα πρέπει να υπάρχουν κενά ανάμεσα στα γειτονικά πολύγωνα που συνορεύουν. 

	Must not have invalid geometries
	Η γεωμετρία θα πρέπει να είναι έγκυρη. 

	Must not have multi-part geometries
	Δεν επιτρέπεται η ύπαρξη γεωμετριών πολλαπλών οντοτήτων.

	Must not overlap
	Τα πολύγωνα ενός θεματικού επιπέδου δεν πρέπει να επικαλύπτονται μεταξύ τους.

	Must not overlap with
	Τα πολύγωνα ενός θεματικού επιπέδου δεν πρέπει να επικαλύπτονται με τα πολύγωνα ενός άλλου θεματικού επιπέδου.


Πίνακας 5.3 Κανόνες για πολυγωνικές οντότητες (ΣΓΠ QGIS).
 
 
 	Θεματικά επίπεδα
	Τοπολογικός κανόνας QGIS

	Οδικό Δίκτυο
Υδρολογικό Δίκτυο
Ισοϋψείς καμπύλες 
	Must not have dangles
Must not have duplicates
Must not have multi-part geometries
Must not have pseudos

	Υδρολογικό Δίκτυο & Οδικό δίκτυο
Ισοϋψείς καμπύλες & Οδικό δίκτυο
Υδρολογικό Δίκτυο & Ισοϋψείς καμπύλες
	Μust not overlap

	Οικισμοί & Πολύγωνο Ακτογραμμής
Υψομετρικά Σημεία & Πολύγωνο Ακτογραμμής
	Μust be inside


Πίνακας 5.4 Προτεινόμενοι τοπολογικοί κανόνες και θεματικά επίπεδα (ΣΓΠ QGIS).
Όταν η συνθήκη ενός κανόνα δεν ικανοποιείται από τα δεδομένα, τότε δημιουργείται ένα σφάλμα που καταγράφεται στον πίνακα σφαλμάτων. Από τους διατιθέμενους κανόνες προτείνεται η χρήση του κανόνα Must not have invalid geometries για κάθε θεματικό επίπεδο και των υπολοίπων κατά περίπτωση (Πίνακας 5.4).
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Εικόνα 5.3 Στο παράθυρο Topology Rule Settings ορίζονται οι κανόνες που θα ελεγχθούν και στο παράθυρο Έλεγχος Τοπολογίας παρουσιάζονται σε μορφή πίνακα τα σφάλματα που εντοπίστηκαν.
5.2.1 Οδηγίες εφαρμογής τοπολογικών κανόνων στο ΣΓΠ QGIS
 
Στο ΣΓΠ QGIS ο ορισμός και η εφαρμογή των τοπολογικών κανόνων υλοποιείται σε δύο στάδια.
Στο πρώτο στάδιο, το εργαλείο τοπολογικών ελέγχων καλείται από το μενού Διανύσματα>Έλεγχος τοπολογίας>Έλεγχος τοπολογίας και εμφανίζεται το νέο παράθυρο Έλεγχος Τοπολογίας. Από το κουμπί Ρυθμίσεις ξεκινάει ο διάλογος προσθήκης των τοπολογικών κανόνων στο παράθυρο Topology Rule Settings. Στο νέο αυτό παράθυρο, επιλέγεται ένα θεματικό επίπεδο και ένας κανόνας από τους διαθέσιμους στη λίστα. Η προσθήκη του κανόνα στη λίστα προς έλεγχο γίνεται από το πλήκτρο Προσθήκη κανόνα. Όταν ολοκληρωθεί η προσθήκη όλων των κανόνων, το παράθυρο κλείνει από το πλήκτρο ΟΚ (Εικόνα 5.3). 
Στο δεύτερο στάδιο, η εφαρμογή των κανόνων ξεκινάει από το πλήκτρο Επικύρωση όλων ή Επικύρωση έκτασης, ανάλογα με το αν πρέπει να ελεγχθεί το σύνολο της περιοχής ή μόνο η περιοχή που φαίνεται στην οθόνη. Τα σφάλματα που εντοπίστηκαν, θα εμφανιστούν στον πίνακα με βάση τον κανόνα που παραβιάζεται (στήλη Σφάλμα) και το θεματικό επίπεδο που αφορά (στήλη Επίπεδο). Με διπλό κλικ σε μια καταχώριση του πίνακα, ο χάρτης μεγεθύνεται και μετακινείται στην περιοχή του σφάλματος. Η διόρθωση των σφαλμάτων υλοποιείται με την επέμβαση του χρήστη στη γεωμετρία με τα διαθέσιμα εργαλεία επεξεργασίας. Στη συνέχεια γίνεται επανέλεγχος των κανόνων για να επιβεβαιωθεί η ορθότητα των διορθώσεων.
5.3 Τοπολογικοί έλεγχοι και ΣΓΠ ArcGIS
 
Ο έλεγχος των τοπολογικών σχέσεων στο ΣΓΠ ArcGIS (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β), βασίζεται στην επεξεργασία των θέσεων των κορυφών των γεωχωρικών στοιχείων ενός θεματικού επιπέδου αλλά και ανάμεσα σε διαφορετικά θεματικά επίπεδα που συνδέονται. Όλες οι κορυφές που απέχουν απόσταση μικρότερη από αυτήν που θα οριστεί με την τιμή της παραμέτρου Cluster Tolerance, θεωρείται ότι καταλαμβάνουν την ίδια θέση και το σύστημα τους εκχωρεί το ίδιο ζεύγος συντεταγμένων κατά τη διαδικασία αξιολόγησης. Ο έλεγχος ενός κανόνα και ο προσδιορισμός των σφαλμάτων από τη μη επαλήθευσή του γίνεται κατά τη διαδικασία αξιολόγησης (validate). Τα χωρικά στοιχεία που ταυτίζονται χωρικά και μοιράζονται τις ίδιες θέσεις, εντοπίζονται μέσω δύο διαδικασιών. Αρχικά, η πύκνωση (cracking) προσθέτει κορυφές στις γραμμικές οντότητες στο σημείο που απέχει απόσταση μικρότερη από το Cluster Tolerance από την κορυφή μιας άλλης γραμμικής οντότητας. Στη συνέχεια, η ταύτιση (clustering) μετακινεί τις κορυφές και τους κόμβους των γραμμών, οι οποίοι απέχουν απόσταση μικρότερη από το Cluster Tolerance ώστε να ταυτιστούν.
 
 	Κανόνας
	Έλεγχος

	Must Be Properly Inside Polygons
	Τα σημεία ενός χωρικού πίνακα πρέπει να βρίσκονται εντός των πολυγώνων ενός άλλου χωρικού πίνακα. Σημειακά σφάλματα προκύπτουν όταν τα σημεία βρίσκονται εκτός ή επάνω στο όριο των πολυγώνων π.χ. οι πρωτεύουσες των νομών (σημεία) πρέπει να βρίσκονται εντός των πολυγώνων των νομών.

	Must Be Disjoint
	Tα σημεία ενός χωρικού πίνακα δεν πρέπει να επικαλύπτονται από σημεία του ίδιου χωρικού πίνακα. Σημειακά σφάλματα δημιουργούνται όταν τα σημεία επικαλύπτονται π.χ. οι θέσεις των σημείων γνωστού υψομέτρου πρέπει να είναι μοναδικές.


Πίνακας 5.5 Κανόνες για σημειακές οντότητες (ΣΓΠ ArcGIS).
Ο βαθμός ιεράρχησης (rank) καθορίζει την προτεραιότητα μετακίνησης των κορυφών των δεδομένων ενός χωρικού πίνακα κατά τον έλεγχο των τοπολογικών κανόνων ως προς τα δεδομένα των άλλων χωρικών πινάκων. Τα χωρικά στοιχεία με υψηλή τιμή βαθμού ιεράρχησης (λιγότερο αξιόπιστα) μετακινούνται προς αυτά με χαμηλή τιμή του βαθμού ιεράρχησης (περισσότερο αξιόπιστα). Σε κάθε θεματικό επίπεδο αντιστοιχείται ένας βαθμός ιεράρχησης ανάλογα με τη χωρική ακρίβεια των δεδομένων π.χ. Πολύ ακριβής (1), Ακριβής (2), Μικρότερης ακρίβειας (3), Αμφίβολης ακρίβειας (4). Η αξιολόγηση των κανόνων δημιουργεί μια αναφορά (report) με το πλήθος των σφαλμάτων που εντοπίστηκαν από την εφαρμογή κάθε κανόνα. Τα σφάλματα, ανάλογα με τη γεωμετρία τους, αποθηκεύονται στη δομή της τοπολογίας ως σημειακά, γραμμικά και επιφανειακά. Ο χρήστης έχει τη δυνατότητα να τα αγνοήσει, να τα διορθώσει ή να τα επισημάνει ως εξαιρέσεις. Το ΣΓΠ ArcGIS προσφέρει πολλούς τοπολογικούς κανόνες οι οποίοι αφορούν σε σημεία, γραμμές και πολύγωνα. Στους  πίνακες που ακολουθούν (Πίνακας 5.5, Πίνακας 5.6, Πίνακας 5.7) παρατίθενται κάποιοι από αυτούς, ενώ πλήρης αναφορά και επεξηγηματικά σχήματα βρίσκονται στην ιστοσελίδα (ArcGIS Topology Rules Poster). Από όλους αυτούς τους τοπολογικούς κανόνες προτείνεται η χρήση για κάθε θεματικό επίπεδο, αυτών που παρατίθενται στον παρακάτω πίνακα (Πίνακας 5.8).
 
 
 	Κανόνας
	Έλεγχος

	Must Not Have Dangles
	Οι κόμβοι μιας γραμμής πρέπει να ενώνονται με τους κόμβους μιας άλλης γραμμής ή τμήμα γραμμής. Σημειακά σφάλματα προκύπτουν όταν οι κόμβοι μιας γραμμής δεν ενώνονται με κάποια άλλη γραμμή. 

	Must Not Self-Overlap
	Μια γραμμή δεν πρέπει να επικαλύπτεται από τον εαυτό της. Οι γραμμές μπορούν να εφάπτονται σε μια κορυφή ή να τέμνονται. Γραμμικά σφάλματα δημιουργούνται όταν οι γραμμές επικαλύπτουν τον εαυτό τους. 

	Must Not Self-Intersect
	Μια γραμμή δεν πρέπει να επικαλύπτεται ή να τέμνεται από κάποιο τμήμα του εαυτού της, ενώ οι κόμβοι της γραμμής μπορούν να εφάπτονται με τη γραμμή. Γραμμικά σφάλματα δημιουργούνται όταν οι γραμμές επικαλύπτονται και σημειακά σφάλματα όταν οι γραμμές τέμνονται.

	Must Not Overlap
	Μια γραμμή δεν πρέπει να επικαλύπτεται από κάποιο τμήμα μιας άλλης γραμμής. Οι γραμμές μπορούν να εφάπτονται σε επίπεδο κόμβου, να τέμνονται ή να επικαλύπτονται από τον εαυτό τους. Γραμμικά σφάλματα προκύπτουν όταν οι γραμμές επικαλύπτονται. 

	Must Not Overlap With
	Μια γραμμή ενός χωρικού πίνακα δεν πρέπει να επικαλύπτεται από τη γραμμή ενός άλλου χωρικού πίνακα, ενώ γραμμικά σφάλματα δημιουργούνται όταν οι γραμμές δύο διαφορετικών θεματικών επιπέδων επικαλύπτονται. Ο κανόνας χρησιμοποιείται όταν οι γραμμές ενός θεματικού επιπέδου δεν πρέπει να καταλαμβάνουν τον ίδιο χώρο με τις γραμμές ενός άλλου θεματικού επιπέδου. 

	Must Not Intersect Or Touch Interior
	Μια γραμμή δεν πρέπει να επικαλύπτεται ή να τέμνεται από κάποιο άλλο τμήμα μιας άλλης γραμμής. Επιπλέον, δεν επιτρέπεται ο κόμβος μιας γραμμής να βρίσκεται επάνω σε μια άλλη γραμμή, δηλαδή οι γραμμές δεν πρέπει να τέμνονται ή να επικαλύπτονται παρά μόνο να συναντιούνται σε επίπεδο κόμβων. Γραμμικά σφάλματα προκύπτουν όταν οι γραμμές επικαλύπτονται, ενώ σημειακά σφάλματα όταν οι γραμμές τέμνονται. 

	Must Be Single Part
	Μια γραμμή που ανήκει σε ένα θεματικό επίπεδο πρέπει να είναι συνεχής και να μην αποτελείται από πολλαπλά τμήματα. 

	Must Be Inside
	Οι γραμμές ενός χωρικού πίνακα πρέπει να βρίσκονται εντός των ορίων των πολυγώνων ενός άλλου χωρικού πίνακα. Γραμμικά σφάλματα εντοπίζονται εκεί όπου οι γραμμές δεν βρίσκονται εντός των πολυγώνων. 


Πίνακας 5.6 Κανόνες για γραμμικές οντότητες (ΣΓΠ ArcGIS).
 
 
 	Κανόνας
	Έλεγχος

	Must Not Overlap
	Τα πολύγωνα ενός χωρικού πίνακα δεν πρέπει να επικαλύπτονται. Μπορούν ωστόσο να είναι ασύνδετα, να έχουν ένα κοινό σημείο ή κοινό τμήμα ορίου. Πολυγωνικά σφάλματα προκύπτουν όταν τα πολύγωνα επικαλύπτονται. 

	Must Not Overlap With
	Τα πολύγωνα ενός χωρικού πίνακα δεν πρέπει να επικαλύπτονται από τις πολυγωνικές οντότητες ενός άλλου χωρικού πίνακα, ενώ πολυγωνικά σφάλματα δημιουργούνται όταν τα πολύγωνα δύο διαφορετικών θεματικών επιπέδων επικαλύπτονται. Ο κανόνας χρησιμοποιείται όταν οι πολυγωνικές οντότητες ενός θεματικού επιπέδου δεν πρέπει να καταλαμβάνουν τον ίδιο χώρο με αυτές ενός άλλου θεματικού επιπέδου. 


Πίνακας 5.7 Κανόνες για πολυγωνικές οντότητες (ΣΓΠ ArcGIS).
5.3.1 Οδηγίες εφαρμογής των τοπολογικών κανόνων στο ΣΓΠ ArcGIS
 
Αρχικά, ενεργοποιείται το λογισμικό ArcCatalog από την επιλογή Programs>ArcGIS>ArcCatalog. 
Στη συνέχεια, δημιουργείται ένα αντίγραφο του συνόλου των χωρικών οντοτήτων (Feature Dataset) που περιέχει τα δεδομένα που δημιουργήθηκαν κατά τη συλλογή. Λόγω των αλλαγών που θα γίνουν στη γεωμετρία κατά τον έλεγχο των τοπολογικών κανόνων, συστήνεται η διατήρηση ενός αντιγράφου των αρχικών δεδομένων. Σε επίπεδο Feature Dataset με δεξί κλικ επιλέγεται Copy και στο επίπεδο της γεωβάσης με δεξί κλικ επιλέγεται Paste και στη συνέχεια ΟΚ.
 
 
 	Θεματικά επίπεδα
	Τοπολογικός κανόνας ArcGIS

	Οδικό Δίκτυο
Υδρολογικό Δίκτυο 
	must be larger that cluster tolerance 
must not have dangles
must not self-intersect
must not self-overlap
must not overlap

	Ισοϋψείς καμπύλες 
	must be larger that cluster tolerance 
must not have dangles
must not self-intersect
must not self-overlap
must not intersect or touch interior 

	Οδικό δίκτυο & Πολύγωνο Ακτογραμμής
Υδρολογικό δίκτυο & Πολύγωνο Ακτογραμμής
Ισοϋψείς καμπύλες & Πολύγωνο Ακτογραμμής
	must be inside
 

	Υδρολογικό Δίκτυο & Οδικό δίκτυο
Ισοϋψείς καμπύλες & Οδικό δίκτυο
Υδρολογικό Δίκτυο & Ισοϋψείς καμπύλες
	must not overlap 
 

	Οικισμοί & Πολύγωνο Ακτογραμμής
Υψομετρικά Σημεία & Πολύγωνο Ακτογραμμής
	must be properly inside polygon 
 


Πίνακας 5.8 Προτεινόμενοι τοπολογικοί κανόνες και θεματικά επίπεδα (ΑrcGIS).
Ακολουθεί η δημιουργία της δομής της τοπολογίας και η επιλογή των τοπολογικών κανόνων. Σε επίπεδο Feature Dataset με δεξί κλικ επιλέγεται Νew>Topology. Στο παράθυρο New Topology που εμφανίζεται, επιλέγεται Next και στην επόμενη καρτέλα δίνεται το όνομα της δομής των τοπολογικών κανόνων στην ένδειξη Enter a name for your Topology. Επί πλέον ορίζεται η ελάχιστη απόσταση για την οποία δύο σημεία ή δύο γραμμές θεωρούνται διακριτά χωρικά στοιχεία στην ένδειξη Enter a Cluster Tolerance. Με το πλήκτρο Next εμφανίζεται η επόμενη καρτέλα, όπου γίνεται η επιλογή των κλάσεων των χωρικών στοιχείων (Feature Classes) που θα συμμετέχουν στους τοπολογικούς κανόνες. Με το πλήκτρο Next εμφανίζεται η επόμενη καρτέλα, όπου γίνεται ο ορισμός του πλήθους των βαθμών ιεράρχησης οι οποίοι θα εφαρμοστούν στις κλάσεις χωρικών στοιχείων στην ένδειξη Enter the number of ranks και η ανάθεση ενός βαθμού ιεράρχησης (rank) σε κάθε κλάση χωρικών στοιχείων. Με το πλήκτρο Next εμφανίζεται η επόμενη καρτέλα, όπου γίνεται η προσθήκη των τοπολογικών κανόνων με το πλήκτρο Add Rule. Επαναληπτικά ορίζονται όλοι οι τοπολογικοί κανόνες (Εικόνα 5.4). Το πλήκτρο Save Rules επιτρέπει την αποθήκευση των κανόνων τοπολογίας που ορίστηκαν σε αρχείο από το οποίο μπορεί να ανακτηθούν από το Load Rules. Η διαδικασία ολοκληρώνεται με το πλήκτρο Finish. 
Αφού οριστούν οι τοπολογικοί κανόνες αξιολογούνται. Σε επίπεδο Topology με δεξί κλικ του ποντικιού επιλέγεται Validate. Η αξιολόγηση έχει ως αποτέλεσμα τη δημιουργία μιας αναφοράς με τα σφάλματα από την αξιολόγηση των τοπολογικών κανόνων. Σε επίπεδο Topology με δεξί κλικ του ποντικιού επιλέγεται Properties. Στο νέο παράθυρο Topology properties επιλέγεται η καρτέλα Errors. Εκεί επιλέγεται το πλήκτρο Generate Summary και δημιουργείται η αναφορά. Στη συνέχεια, από το πλήκτρο Export to file είναι δυνατή η αποθήκευση των σφαλμάτων σε αρχείο κειμένου τύπου ASCII.
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Εικόνα 5.4 Προσθήκη κανόνα τοπολογίας.
Αν ο χρήστης επιθυμεί την τροποποίηση των τοπολογικών κανόνων, σε επίπεδο Τopology με δεξί κλικ επιλέγεται Properties. Στο νέο παράθυρο Topology properties, επιλέγεται η καρτέλα General όπου μπορεί να μεταβληθεί το όνομα της ομάδας των τοπολογικών κανόνων στην ένδειξη Name και η ελάχιστη απόσταση για την οποία δύο σημεία ή δύο γραμμές θεωρούνται διακριτά χωρικά στοιχεία στην ένδειξη Cluster Tolerance. Από την καρτέλα Feature Classes είναι δυνατή η προσθήκη μιας νέας κλάσης χωρικών στοιχείων (Add Class), η απαλοιφή μιας κλάσης χωρικών στοιχείων (Remove), η απαλοιφή όλων (Remove all). Ακόμα μπορεί να αλλάξει το πλήθος των βαθμών ιεράρχησης (Number of Ranks) που θα εφαρμοστούν στις κλάσεις χωρικών στοιχείων και ο βαθμός ιεράρχησης (Rank). Από την καρτέλα Rules υλοποιούνται μια σειρά από ενέργειες όπως: η προσθήκη ενός τοπολογικού κανόνα Add Rule, η διαγραφή ένας τοπολογικού κανόνα Remove, η λήψη μιας σύντομης περιγραφής ενός κανόνα Description, η ανάκτηση τοπολογικών κανόνων από αρχείο Load Rules και η αποθήκευση τοπολογικών κανόνων σε αρχείο Save Rules.
5.3.2 Επεξεργασία και διόρθωση σφαλμάτων που εντοπίζονται από την εφαρμογή των τοπολογικών κανόνων 
 
Στο περιβάλλον του ΑrcMap καθορίζονται οι εργαλειοθήκες που θα χρησιμοποιηθούν. Από το menu View>Toolbars ενεργοποιούνται διαδοχικά οι εργαλειοθήκες Layout, Tools, Draw, Editing, Topology και ελέγχεται αν είναι ενεργοποιημένες οι εργαλειοθήκες Main Menu και Standard. Επιλέγεται ως περιβάλλον εργασίας αυτό της ψηφιακής καταγραφής και των διορθώσεων (Data view). Στη συνέχεια, εισάγεται η δομή των τοπολογικών κανόνων που έχει δημιουργηθεί. Από την εργαλειοθήκη Standard, επιλέγεται το πλήκτρο Add Data και στη συνέχεια η δομή των τοπολογικών κανόνων. Κατά την εισαγωγή της είναι δυνατή και η παράλληλη εισαγωγή των κλάσεων των χωρικών στοιχείων που συμμετέχουν σε αυτήν. Η έναρξη της διόρθωσης γίνεται με την επιλογή Start Editing από το πλήκτρο Editor της εργαλειοθήκης Editor. Αυτόματα ενεργοποιείται η εργαλειοθήκη Topology (Εικόνα 5.5) και ο χρήστης επιλέγει τη δομή των τοπολογικών κανόνων που θα χρησιμοποιηθεί προκειμένου να γίνουν οι διορθώσεις στη γεωμετρία. 
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Εικόνα 5.5 Η εργαλειοθήκη για την τοπολογία.
Για τη διαμόρφωση του συμβολισμού των σφαλμάτων, από το παράθυρο Table of Contents επιλέγεται το επίπεδο της τοπολογίας, με δεξί κλικ Properties και τελικά η καρτέλα Symbology. Στην καρτέλα αυτή ορίζεται για τις τρεις κατηγορίες σφαλμάτων Line errors, Point errors και Area errors, η επιλογή Symbolize by error type που επιτρέπει τον οπτικό διαχωρισμό των σφαλμάτων κάθε κατηγορίας (Εικόνα 5.6). Ενδέχεται να τροποποιηθεί το σύμβολο για κάθε είδος τοπολογικού σφάλματος ανάλογα με τις προτιμήσεις του χρήστη, κάνοντας διπλό κλικ πάνω σε αυτό. 
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Εικόνα 5.6 Η επιλογή Symbolize by error type  επιτρέπει τον οπτικό διαχωρισμό των σφαλμάτων κάθε κατηγορίας.
Από το εργαλείο [image: ] Error Inspector, που βρίσκεται στην εργαλειοθήκη Topology, καλείται ο αντίστοιχος πίνακας αναφοράς των σφαλμάτων Error Inspector (Εικόνα 5.7), ο οποίος λειτουργεί διαδραστικά με την απόδοσή τους στο χάρτη. Η επιλογή Errors εμφανίζει τα σφάλματα. Η επιλογή Exceptions εμφανίζει τα σφάλματα που έχουν επισημανθεί ως εξαιρέσεις. Η επιλογή Visible Extent only εμφανίζει τα σφάλματα που βρίσκονται εντός της τρέχουσας περιοχής σχεδίασης. Από το Show με την επιλογή Errors from all rules δίνεται η δυνατότητα να εμφανίζονται τα σφάλματα από όλους τους κανόνες ή με την επιλογή ενός συγκεκριμένου κανόνα, μόνο αυτά που εκείνος εντοπίζει. Η επιλογή του χρήστη επαληθεύεται από το πλήκτρο Search Now. Όταν επιλεγεί ένα σφάλμα (μια γραμμή) από τον πίνακα αναφοράς των σφαλμάτων Error Inspector, στη συνέχεια με δεξί κλικ είναι δυνατή: 
 
	Η σήμανσή του ως εξαίρεση (Mark as exception) από την εφαρμογή του κανόνα.
	Η επιλογή μιας από τις διαδικασίες διόρθωσης που προτείνεται από το περιβάλλον π.χ. Snap../Extend../Trim. Στην περίπτωση αυτή, ο χρήστης καλείται να ορίσει μια μέγιστη απόσταση που χρησιμοποιείται για την εφαρμογή των προηγούμενων διαδικασιών. Εναλλακτικά, μπορεί να ακολουθηθεί μια ανεξάρτητη διαδικασία διόρθωσης που προσφέρεται από τα εργαλεία Editing με τη βοήθεια του εργαλείου σύμπτωσης θέσεων (snapping).
	Η αυτόματη μεγέθυνση της γραφικής απόδοσης των δεδομένων ώστε να είναι ορατό το συγκεκριμένο σφάλμα (Zoom to).
	Η αυτόματη μετάβαση στη περιοχή του συγκεκριμένου σφάλματος ώστε να είναι ορατό (Pan to).
	Η παρουσίαση της περιγραφής του κανόνα που παραβιάζεται (Show Rule Description).
	Στην περίπτωση που στον πίνακα εμφανίζονται και τα σφάλματα που επισημάνθηκαν ως εξαιρέσεις (Exceptions), είναι δυνατή η επαναφορά μιας εξαίρεσης ως σφάλμα (Mark as Error).
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Εικόνα 5.7 Στον πίνακα Error Inspector παρατίθενται τα σφάλματα που εντόπισαν οι τοπολογικοί κανόνες. 
 	Κανόνας
	Προτεινόμενες διαδικασίες διόρθωσης

	Must Be Larger Than Cluster Tolerance
	Delete: Διαγράφει τα γραμμικά στοιχεία που θα χάνονταν κατά τη διαδικασία αξιολόγησης λόγω της τιμής της ελάχιστης απόστασης.

	Must Not Self Overlap
	Simplify: Διαγράφει τα τμήματα που επικαλύπτονται με τον εαυτό τους.

	Must Not Self Intersect
	Simplify (δες καταχώρηση προηγούμενης γραμμής)

	Must Not Intersect or Touch Interior
	Subtract: Διαγράφει τα τμήματα που επικαλύπτονται. Ο χρήστης πρέπει να υποδείξει την οντότητα από την οποία θα διαγραφεί το σφάλμα.
Split: Κατατμεί τις γραμμές που τέμνονται δημιουργώντας ένα κόμβο στο σημείο τομής. 

	Must Not Have Dangles
	Extend: Προεκτείνει την αιωρούμενη άκρη/κόμβο μίας γραμμής μέχρι να ενωθεί με άλλη γραμμή μέσα στην απόσταση που ορίστηκε. Εάν δεν βρεθεί άλλη γραμμή, η επέκταση δεν θα γίνει. Εάν η απόσταση οριστεί ίση με το 0, οι γραμμές θα επεκταθούν μέχρι να βρουν μια γραμμή για να ενωθούν. 
Trim: Αποκόπτει το αιωρούμενο τμήμα μιας γραμμής εάν βρει ένα σημείο τομής μέσα στην απόσταση που ορίστηκε. Εάν δεν βρεθεί σημείο τομής εντός της απόστασης, το τμήμα δεν θα αποκοπεί. Εάν η απόσταση είναι μεγαλύτερη από το μήκος της υπό εξέταση γραμμής, δεν θα γίνει καμία διόρθωση. Εάν η απόσταση οριστεί ίση με το 0, η αναζήτηση τομής θα γίνει για κάθε μήκος. Εάν δεν βρεθεί τομή, δεν θα γίνει καμία διόρθωση. 
Snap: Ενώνει την αιωρούμενη άκρη μίας γραμμής με την πλησιέστερη γραμμή μέσα στην απόσταση που ορίστηκε. Εάν δεν βρεθεί γραμμή , δεν θα γίνει καμία διόρθωση. Η αναζήτηση περιλαμβάνει αρχικά κόμβους μετά κορυφές και τελικά ακμές γραμμών. 

	ust Not Overlap
	Subtract: αφαιρεί το επικαλυπτόμενο τμήμα.

	Must Not Overlap with
	Subtract (βλέπε καταχώρηση προηγούμενης γραμμής).

	Must be inside
	Delete: Διαγράφει τα τμήματα που βρίσκονται εκτός των πολυγώνων.


Πίνακας 5.9 Προτεινόμενες λύσεις για τα σφάλματα που εντοπίζουν οι τοπολογικοί κανόνες που αφορούν γραμμές (ΑrcGIS).
Ο έλεγχος για την επιτυχή διόρθωση των σφαλμάτων γίνεται με την επαναξιολόγηση των κανόνων τοπολογίας από την εργαλειοθήκη Topology με τα ακόλουθα πλήκτρα: 
 
	[image: ] Validate entire topology: αξιολογεί του τοπολογικούς κανόνες σε όλες τις περιοχές που έγινε επεξεργασία της γεωμετρίας.
	[image: ] Validate topology in specified area: αξιολογεί του τοπολογικούς κανόνες στην περιοχή που θα υποδείξει ο χρήστης με το ποντίκι.
	[image: ] Validate topology in current extend: αξιολογεί του τοπολογικούς κανόνες στην περιοχή που εμφανίζεται στην οθόνη εκείνη τη στιγμή. 

 
Για τα σφάλματα που εντοπίζονται από την αξιολόγηση κάθε κανόνα, υπάρχει μια σειρά από συγκεκριμένες διαδικασίες διόρθωσης που προτείνονται από το σύστημα (Πίνακας 5.9 και Πίνακας 5.10). Σημειώνεται ότι η λύση που προτείνεται δεν είναι πάντα η ενδεδειγμένη, οπότε ο χρήστης πρέπει να αποφασίσει εάν θα την εφαρμόσει ή θα ακολουθήσει μια διαφορετική διαδικασία διόρθωσης με τα κλασσικά εργαλεία. Η αποθήκευση των διορθώσεων γίνεται με την επιλογή Save Edits από το πλήκτρο Editor της εργαλειοθήκης Editor. Η ολοκλήρωση των διορθώσεων γίνεται με την επιλογή Stop Editing από το πλήκτρο Editor της εργαλειοθήκης Editor.
 
 
 	Κανόνας
	Προτεινόμενες διαδικασίες διόρθωσης

	Must Be Larger Than Cluster Tolerance
	Delete: Διαγράφει τα πολύγωνα που θα εξαφανίζονταν κατά την αξιολόγηση με τη συγκεκριμένη ελάχιστη απόσταση. 

	Must Not Overlap
	Subtract: Αφαιρεί το κοινό τμήμα από τα επικαλυπτόμενα και αφήνει ένα κενό. 
Merge: Αφαιρεί το επικαλυπτόμενο τμήμα από το ένα πολύγωνο και το προσθέτει στο άλλο βάσει των υποδείξεων του χρήστη. 
Create Feature: Αφαιρεί το κοινό τμήμα από τα επικαλυπτόμενα και δημιουργεί ένα νέο πολύγωνο.

	Must Not Have Gaps
	Create Feature: Δημιουργεί ένα νέο πολύγωνο από τις γραμμές που δημιουργούν το κενό. 

	Must Be Covered By
	Create Feature: Δημιουργεί ένα νέο πολύγωνο από το επικαλυπτόμενο τμήμα ώστε το όριο και των δύο οντοτήτων να είναι το ίδιο.


Πίνακας 5.10 Προτεινόμενες λύσεις για τα σφάλματα που εντοπίζουν οι τοπολογικοί κανόνες που αφορούν πολύγωνα (ΑrcGIS).
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Κριτήρια αξιολόγησης 
Στη συνέχεια ακολουθούν μια σειρά από κριτήρια αξιολόγησης με τη μορφή ερωτήσεων των οποίων οι απαντήσεις βρίσκονται εντός του κειμένου του κεφαλαίου. 
 
Κριτήριο αξιολόγησης 1 
Γιατί είναι χρήσιμη η δόμηση της τοπολογίας;
Κριτήριο αξιολόγησης 2 
Σε τι οφείλεται η αδυναμία ανασύστασης των τοπολογικών σχέσεων;
Κριτήριο αξιολόγησης 3
Αναφέρετε βασικούς τοπολογικούς κανόνες για χαρακτηριστικά θεματικά επίπεδα ενός χάρτη.
Κριτήριο αξιολόγησης 4
Ποια εργαλεία του ΣΔΒΔ μπορούν να αξιοποιηθούν για την εξασφάλιση της ποιότητας μιας βάσης χωρικών δεδομένων;
Κριτήριο αξιολόγησης 5
Υπάρχουν αρνητικές συνέπειες από τους τοπολογικούς ελέγχους;
Κεφάλαιο 6 
Αλλαγή συστήματος αναφοράς των συντεταγμένων
Σύνοψη 
Στο κεφάλαιο αυτό περιγράφεται η διαδικασία αλλαγής του συστήματος αναφοράς των συντεταγμένων των γεωχωρικών δεδομένων. Ο μετασχηματισμός αυτός μπορεί να χρησιμοποιηθεί:
•	Για τον συνδυασμό των θεματικών δεδομένων που υπάρχουν καταχωρισμένα στη βάση χαρτογραφικών δεδομένων και χρησιμοποιούν ένα συγκεκριμένο σύστημα αναφοράς π.χ. το ΕΓΣΑ’87 με γεωχωρικά δεδομένα από άλλες πηγές, όπως δεδομένα GPS, δεδομένα από ναυτικούς χάρτες κ.ά. τα οποία χρησιμοποιούν διαφορετική χαρτογραφική προβολή ή/και σύστημα αναφοράς.
•	Για τη χαρτογραφική απόδοση στη βέλτιστη χαρτογραφική προβολή που αρμόζει με το σκοπό, τη μορφή της χαρτογραφούμενης περιοχής και την κλίμακα του χάρτη.
Ακολουθεί λεπτομερής περιγραφή της υλοποίησης των συγκεκριμένων μετασχηματισμών στο ΣΓΠ QGIS και στο ΣΓΠ ArcGIS.
Προαπαιτούμενη γνώση
Γενική γνώση για τις χαρτογραφικές προβολές και τα προβολικά συστήματα.
6. Χαρτογραφικά δεδομένα και συστήματα αναφοράς των συντεταγμένων 
 
Ένα από τα πλεονεκτήματα των χαρτογραφικών δεδομένων σε ψηφιακή μορφή και των ΣΓΠ ως περιβάλλοντος επεξεργασίας, είναι η ευκολία υλοποίησης μετασχηματισμών (Τσούλος, 2008). Οι μετασχηματισμοί μπορεί να αφορούν τη δομή των δεδομένων π.χ. μετασχηματισμός δεδομένων από κανονικοποιημένη δομή σε διανυσματική (βλ. Κεφάλαιο 3), στο μορφότυπο καταγραφής των ψηφιακών δεδομένων π.χ. μετατροπή ενός αρχείου ASCII με συντεταγμένες σημειακών δεδομένων σε χωρικό πίνακα της γεωβάσης (βλ. Κεφάλαιο 4), στη γεωμετρία π.χ. επεξεργασία, γενίκευση (βλ. Κεφάλαιο 9) και στο Σύστημα Αναφοράς των Συντεταγμένων (ΣΑΣ). Οι μετασχηματισμοί των συντεταγμένων ενδέχεται να βασίζονται σε γεωμετρικούς μετασχηματισμούς (Νάκος, 2014α) π.χ. η χρήση του ομοπαράλληλου μετασχηματισμού για τη γεωαναφορά των σαρωμένων αναλογικών χαρτών πριν την ψηφιακή καταγραφή (βλ. Κεφάλαιο 2). Σε άλλες περιπτώσεις όπου η διαφορά αφορά τη χαρτογραφική απεικόνιση / προβολή, χρησιμοποιούνται οι αναλυτικές σχέσεις των χαρτογραφικών προβολών που μετατρέπουν τις γεωγραφικές συντεταγμένες σε καρτεσιανές και αντίστροφα. Οι απεικονίσεις στη χαρτογραφία αναφέρονται στην προβολή/απεικόνιση της επιφάνειας αναφοράς δηλαδή, του ελλειψοειδούς εκ περιστροφής (ή της σφαίρας) στο επίπεδο του χάρτη. Επιπλέον ενδέχεται να υπάρχει διαφορά στο χαρτογραφικό σύστημα. Με τον όρο χαρτογραφικό σύστημα ορίζεται μια απεικόνιση εφαρμοσμένη σε ένα συγκεκριμένο ελλειψοειδές στο οποίο εκφράζονται οι συντεταγμένες των σημείων του γεωγραφικού χώρου (Νάκος, 2014α). Τότε απαιτείται και η χρήση κατάλληλων μετασχηματισμών για την αλλαγή γεωδαιτικού συστήματος αναφοράς (γεωδαιτικό Datum) στο πλαίσιο της αλλαγής χαρτογραφικού συστήματος. Πρέπει πάντα να λαμβάνεται υπ’ όψιν και το γεωδαιτικό σύστημα αναφοράς με το οποίο σχετίζονται και εφαρμόζονται στη πράξη οι προβολές, επειδή η χρήση των εξισώσεων απεικόνισης καθώς και οι σχέσεις που εκφράζουν τις αναγωγές μεγεθών, απαιτούν τη γνώση του ελλειψοειδούς αναφοράς, στοιχείο βασικό της έννοιας του γεωδαιτικού datum (Λιβιεράτος και Φωτίου, 1993). 
Το παρόν κεφάλαιο αναφέρεται στον μετασχηματισμό της χαρτογραφικής προβολής και του χαρτογραφικού συστήματος. Με τη χρήση αυτών των μετασχηματισμών, δεδομένα από ποικίλες πηγές μπορούν να εισαχθούν στη βάση χαρτογραφικών δεδομένων, η οποία δημιουργήθηκε με σκοπό τη σύνθεση ενός χάρτη, αφού προηγουμένως μετασχηματιστούν ώστε να αναφέρονται στο ίδιο σύστημα  με τα υπάρχοντα δεδομένα. Συχνά, η αλλαγή της χαρτογραφικής προβολής είναι απαιτητή, ώστε η απόδοση των δεδομένων να γίνεται κάθε φορά στην απεικόνιση που αρμόζει. Η επιλογή αυτή βασίζεται στη μορφή της χαρτογραφούμενης περιοχής, στο σκοπό του χάρτη π.χ. χάρτης πλοήγησης, τοπογραφικός, θεματικός χάρτης και στην κλίμακα του χάρτη π.χ. μικρή, μεσαία ή μεγάλη κλίμακα (Maling, 1993). Η ευκολία των μετασχηματισμών στο περιβάλλον των ΣΓΠ επιτρέπει την αλλαγή προβολής ακόμα και για την εξυπηρέτηση χαρτομετρικών εργασιών, όπως είναι η μέτρηση αποστάσεων, εμβαδών και όγκων, ώστε να επιλέγεται η προβολή με τις μικρότερες παραμορφώσεις.
Οι χαρτογραφικές προβολές εκφράζονται με αναλυτικές σχέσεις που συνδέουν τις γεωγραφικές συντεταγμένες με τις καρτεσιανές και αντίστροφα και έχουν τη γενική μορφή: X= f(φ,λ) και Y= g(φ,λ). Η χρήση των σχέσεων αυτών είναι επαρκής για τον μετασχηματισμό ο οποίος αφορά μόνο την αλλαγή χαρτογραφικής προβολής. Για παράδειγμα: για τη μετατροπή των καρτεσιανών συντεταγμένων ΕΓΣΑ ’87 σε γεωγραφικές συντεταγμένες στο ίδιο ελλειψοειδές χρησιμοποιούνται οι σχέσεις που συνδέουν τις γεωγραφικές συντεταγμένες με τις καρτεσιανές, για τη μετατροπή των καρτεσιανών συντεταγμένων ΕΓΣΑ ’87 σε καρτεσιανές συντεταγμένες στη Μερκατορική προβολή στο ίδιο ελλειψοειδές, οι καρτεσιανές συντεταγμένες μετατρέπονται με τις σχέσεις της Εγκάρσιας Μερκατορικής σε γεωγραφικές και στη συνέχεια οι γεωγραφικές συντεταγμένες σε καρτεσιανές με βάση τις αναλυτικές σχέσεις της Μερκατορικής προβολής. 
Εάν είναι επιθυμητή η μετάβαση σε ένα νέο χαρτογραφικό σύστημα που περιλαμβάνει αλλαγή προβολής και ελλειψοειδούς, αρχικά οι καρτεσιανές συντεταγμένες μετασχηματίζονται σε γεωγραφικές, οι γεωγραφικές συντεταγμένες μετασχηματίζονται στο νέο ελλειψοειδές και στη συνέχεια εφαρμόζονται οι αναλυτικές σχέσεις της νέας προβολής. Για παράδειγμα, η ακτογραμμή που λαμβάνεται από ένα ναυτικό χάρτη που χρησιμοποιεί ως σύστημα αναφοράς τη Μερκατορική προβολή και το ελλειψοειδές ED50, θα πρέπει να ακολουθήσει τα παραπάνω στάδια μετασχηματισμού των συντεταγμένων για να μετατραπεί στο ΕΓΣΑ ’87 δηλαδή, πρώτα αλλαγή ελλειψοειδούς και μετά εφαρμογή της νέας προβολής. Αναλυτική περιγραφή των παραμέτρων και των χαρακτηριστικών των χαρτογραφικών συστημάτων, καθώς και των μεθόδων με τη βοήθεια των οποίων μπορεί να γίνει η μετατροπή χωρικών δεδομένων τα οποία αναφέρονται σε διαφορετικά χαρτογραφικά συστήματα μπορεί να αναζητηθεί στη βιβλιογραφία (Λιβιεράτος και Φωτίου, 1993; Νάκος, 2014α).
Στο περιβάλλον των ΣΓΠ, ο χρήστης απλά ορίζει το αρχικό και το τελικό σύστημα αναφοράς των συντεταγμένων και οι μετασχηματισμοί εφαρμόζονται από το λογισμικό, χωρίς ο χρήστης να ενημερώνεται για τα ενδιάμεσα στάδια. Συνιστάται τα αποτελέσματα των μετασχηματισμών να επαληθεύονται με σημεία ελέγχου ή άλλα δεδομένα που αναφέρονται στο νέο σύστημα. 
6.1 Συστήματα αναφοράς των συντεταγμένων που χρησιμοποιούνται στον ελλαδικό χώρο
 
Στον ελλαδικό χώρο έχουν υιοθετηθεί και χρησιμοποιούνται τέσσερα χαρτογραφικά συστήματα: το σύστημα Hatt, η Παγκόσμια Εγκάρσια Μερκατορική Προβολή των 6° (UTM), η Εγκάρσια Μερκατορική Προβολή των 3° και η Εγκάρσια Μερκατορική προβολή του Ελληνικού Γεωδαιτικού Συστήματος Αναφοράς του 1987 (ΕΓΣΑ ’87). Οι ναυτικοί χάρτες που εκδίδει η Υδρογραφική Υπηρεσία του Πολεμικού Ναυτικού (ΥΥΠΝ) χρησιμοποιούν το χαρτογραφικό σύστημα που ορίζεται από τη Μερκατορική προβολή και το διεθνές ελλειψοειδές (International Ellipsoid 1924) με ευρωπαϊκή αφετηρία (ED 50). Το πλάτος υπολογισμού της Μερκατορικής προβολής μεταβάλλεται ανάλογα με την περιοχή που καλύπτει ο χάρτης και αναγράφεται στο φύλλο χάρτου (Φ.Χ.) δίπλα από την κλίμακα. Οι χάρτες γενικής χρήσης κλίμακας 1:50.000, που εκδίδει η Γεωγραφική Υπηρεσία Στρατού (ΓΥΣ) χρησιμοποιούν τη Εγκάρσια Μερκατορική Προβολή (Universal Transverse Mercator – UTM) και το datum ED 50 (Λιβιεράτος και Φωτίου, 1993). Παράλληλα, απεικονίζουν τον κάναβο τετραγωνισμού του συστήματος Hatt (μπλε χρώμα) και τον κάναβο τετραγωνισμού του συστήματος ΕΓΣΑ ’87 (πορτοκαλί), ενώ στα όρια της χαρτογραφούμενης περιοχής αναγράφονται οι συντεταγμένες και στα δύο συστήματα με αντίστοιχα χρώματα (Νάκος, 2014β). Επιπλέον, η ευρεία χρήση των GNSS για τη συλλογή δεδομένων έχει σαν αποτέλεσμα πολλά χαρτογραφικά δεδομένα να αναφέρονται στο γεωδαιτικό σύστημα WGS84. Το ίδιο σύστημα χρησιμοποιούν και τα εθελοντικά δεδομένα που λαμβάνονται από το OSM (βλ. Κεφάλαιο 4). 
Συχνά, για την αναφορά στα χαρτογραφικά και γεωδαιτικά συστήματα, χρησιμοποιείται η κωδικοποίηση που έχει οριστεί από το European Petroleum Search Group (EPSG) (http://spatialreference.org/ref/epsg/) και το Institut Geographique National de France (IGNF). Για παράδειγμα το γεωδαιτικό σύστημα WGS84 έχει τον κωδικό EPSF:4326 και το ΕΓΣΑ ’87 τον EPSG:2100. Τα χαρτογραφικά δεδομένα θα πρέπει να περιέχουν την πληροφορία για το σύστημα αναφοράς των συντεταγμένων στη δομή αποθήκευσής τους. Σε αντίθετη περίπτωση αυτό θα πρέπει να ορίζεται εντός του περιβάλλοντος επεξεργασίας.
Θα πρέπει ακόμα να γίνει μια αναφορά στο χαρτογραφικό σύστημα που χρησιμοποιούν οι διαδικτυακές υπηρεσίες χαρτών π.χ. Google maps, OpenStreetMap, Map Quest, Open Cycle, Geofabrik Topo, Bing κ.ά. (Στάμου και Σκοπελίτη, 2014), οι οποίες αποτελούν τη δημοφιλέστερη πηγή χαρτογραφικής πληροφορίας για τον μέσο χρήστη ή χρησιμοποιούνται ως υπόβαθρο σε διαδικτυακούς χάρτες. Η προβολή που χρησιμοποιούν είναι μια εκδοχή της Μερκατορικής προβολής που καλείται «Ψευδο – Μερκατορική» ή «Μερκατορική του διαδικτύου» (κωδικός EPSG:3857). Η Μερκατορική προβολή είναι μια κυλινδρική σύμμορφη προβολή, η οποία προκαλεί σημαντικές παραμορφώσεις στο εμβαδόν και στις αποστάσεις στις περιοχές μακριά από τον βασικό παράλληλο εφαρμογής, στην προκειμένη περίπτωση τον Ισημερινό. Καθώς η Μερκατορική προβολή δεν μπορεί να απεικονίσει τους πόλους, η απεικόνιση της γης καλύπτεται μέχρι το πλάτος 85° βόρεια. Σε ότι αφορά τις γεωγραφικές συντεταγμένες των δεδομένων, αυτές αναφέρονται στο WGS84. Όμως, κατά την εφαρμογή της Μερκατορικής προβολής στις παραπάνω χαρτογραφικές υπηρεσίες, χρησιμοποιούνται οι σχέσεις εφαρμογής της προβολής στη σφαίρα. Ως ακτίνα της σφαίρας χρησιμοποιείται ο μεγάλος ημιάξονας του WGS 84. Το σφάλμα από τη χρήση αυτής της αυθαίρετης σφαίρας αντί για το ελλειψοειδές και των σχέσεων της προβολής για τη σφαίρα, ενώ οι συντεταγμένες αναφέρονται στο ελλειψοειδές, αναιρούν την ιδιότητα της συμμορφίας της προβολής. Η διαφορά δεν είναι αντιληπτή στις μικρές κλίμακες, αλλά έχει ως αποτέλεσμα χάρτες μεγαλύτερης κλίμακας που αφορούν μικρότερες περιοχές να διαφέρουν από έναν χάρτη που εφαρμόζει τη Μερκατορική προβολή στο ελλειψοειδές WGS 84 με τις ορθές σχέσεις. Η διαφορά αυτή γίνεται πιο έντονη όσο αυξάνει η απόσταση από τον Ισημερινό και μπορεί να φτάσει και τα 40 km κατά τις τεταγμένες, ενώ οι τετμημένες δεν επηρεάζονται από αυτή τη λανθασμένη πρακτική. Για το λόγο αυτό, το υπουργείο Εθνικής Άμυνας των ΗΠΑ έχει χαρακτηρίσει τη συγκεκριμένη προβολή μη αποδεκτή για οποιαδήποτε επίσημη χρήση (National Geospatial Intelligence Agency, 2014).
Ενδέχεται να υπάρχουν μετασχηματισμοί που δεν μπορούν να διαχειριστούν τα ΣΓΠ, κυρίως όταν η μετάβαση ανάμεσα σε datum δεν είναι διαχειρίσιμη από το λογισμικό τους. Στην περίπτωση αυτή, θα πρέπει να αναζητηθεί εναλλακτική λύση, όπως στον μετασχηματισμό δεδομένων από το προβολικό σύστημα Hatt στο ΕΓΣΑ ’87 όπου μπορούν να χρησιμοποιηθούν οι πολυωνυμικές σχέσεις που έχουν οριστεί από τη ΓΥΣ (Νάκος, 2014α).
 
 
6.2 Οδηγίες διαχείρισης του ΣΑΣ στο ΣΓΠ QGIS
 
Το QGIS υποστηρίζει περίπου 2.700 Συστήματα Αναφοράς των Συντεταγμένων (ΣΑΣ). Ο ορισμός κάθε ενός από αυτά αποθηκεύεται στη βάση δεδομένων SQLite που συνοδεύει το QGIS. Τα ΣΑΣ που ορίζει ο χρήστης αποθηκεύονται σε διαφορετικό πίνακα. Για τους χωρικούς πίνακες PostGIS, η πληροφορία για το ΣΑΣ είναι αποθηκευμένη εντός των πινάκων. Για τα αρχεία μορφότυπου shapefile η πληροφορία για το ΣΑΣ, εφόσον υπάρχει, αντλείται από το αρχείο με κατάληξη .prj, όπου καταγράφεται με το πρότυπο Well-Known Text (WKT). Στις παραγράφους που ακολουθούν παρουσιάζονται βασικές εργασίες που σχετίζονται με τη διαχείριση του ΣΑΣ στο QGIS (“QGIS Training Manual”, χ.η.;“QGIS User Guide”, χ.η.).
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Εικόνα 6.1 Παράθυρο Επιλογές - Σύστημα Αναφοράς Συντεταγμένων.
6.2.1 Διαχείριση του ΣΑΣ 
 
Για τη διαχείριση του ΣΑΣ ως παραμέτρου του περιβάλλοντος QGIS, από το μενού επιλέγεται Ρυθμίσεις>Επιλογές>Σύστημα Αναφοράς Συντεταγμένων. Στο νέο παράθυρο Επιλογές|Σύστημα Αναφοράς Συντεταγμένων, ορίζονται τα ακόλουθα και η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ (Εικόνα 6.1): 
 
	Η δυνατότητα δυναμικής αλλαγής προβολής. Η επιλογή Automatically enable “on the fly” reprojection if layers have different CRS ή η επιλογή Enable “on the fly” reprojection by default, επιτρέπει τη δυναμική αλλαγή προβολής, ενώ η επιλογή Don’t enable “on the fly” repojection δεν την επιτρέπει.
	Το ΣΑΣ για ένα νέο έργο από την επιλογή Always start new project with this CRS π.χ. EPSG:2100 – GGRS87 / Greek Grid για το ΕΓΣΑ ’87. 
	Το ΣΑΣ για τα θεματικά επίπεδα που εισάγονται για επεξεργασία ή δημιουργούνται π.χ. η επιλογή Use project CRS ταυτίζει το ΣΑΣ με αυτό του έργου, η επιλογή Prompt for CRS ρωτά τον χρήστη για το ΣΑΣ, η επιλογή Use default CRS displayed below αντιστοιχεί το προκαθορισμένο ΣΑΣ.
	Η διαχείριση της αλλαγής datum π.χ. η ενεργοποίηση της επιλογής Ask for datum transformation when no default is defined. 
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Εικόνα 6.2 Επιλογή ΣΑΣ σε επίπεδο έργου.
6.2.2 Διαχείριση του ΣΑΣ σε επίπεδο έργου του QGIS
 
Για τη διαχείριση του ΣΑΣ σε επίπεδο έργου (project) του QGIS, από το μενού επιλέγεται Έργο>Ιδιότητες Έργου. Στο νέο παράθυρο Project Properties|CRS (Εικόνα 6.2) ορίζεται το ΣΑΣ. Όταν η επιλογή Enable ‘on the fly’ CRS transformation ενεργοποιείται, κάθε θεματικό επίπεδο δυναμικά προσαρμόζεται στο ΣΑΣ του έργου. Στην αντίθετη περίπτωση κάθε θεματικό επίπεδο σχεδιάζεται χρησιμοποιώντας το δικό του ΣΑΣ. Το Φίλτρο χρησιμοποιείται για την αναζήτηση ενός ΣΑΣ βάσει του κώδικα EPSG, του ονόματός του κ.ά. Στον κατάλογο Recently used coordinate reference systems εμφανίζονται τα ΣΑΣ που έχουν χρησιμοποιηθεί πρόσφατα. Από αυτά μπορεί να επιλεγεί το ΣΑΣ βάσει των προδιαγραφών π.χ. GGRS87/Greek Grid. Στην επόμενη καταχώριση Coordinate reference systems of the world τα ΣΑΣ του QGIS παρουσιάζονται ομαδοποιημένα σε τρεις κατηγορίες: Geographic Coordinate Systems η οποία  αφορά σε γεωδαιτικά συστήματα αναφοράς, Projected Coordinate Systems η οποία αφορά σε χαρτογραφικά συστήματα και User Defined Coordinate Systems η οποία αφορά σε συστήματα αναφοράς που ορίζονται από τον χρήστη. Εντός της κατηγορίας Projected Coordinate Systems, υπάρχει ομαδοποίηση ανά χαρτογραφική προβολή. Από αυτά μπορεί να επιλεγεί το ΣΑΣ βάσει των προδιαγραφών του έργου. Η κωδικοποίηση του επιλεγμένου ΣΑΣ βάσει του προτύπου που ορίζει η βιβλιοθήκη PROJ.4, εμφανίζεται για λόγους πληροφόρησης. Η βιβλιοθήκη PROJ.4 (https://github.com/OSGeo/proj.4/wiki) αναλαμβάνει τους μετασχηματισμούς των χαρτογραφικών προβολών και των χαρτογραφικών συστημάτων. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
 
6.2.3 Ορισμός νέου ΣΑΣ από τον χρήστη 
 
Για τον ορισμό ενός νέου ΣΑΣ από τον χρήστη, από το μενού επιλέγεται Ρυθμίσεις>Ιδιοποιημένο ΣΑΣ… και εμφανίζεται το παράθυρο Ορισμός ειδικού Γεωγραφικού Συστήματος Αναφοράς (Εικόνα 6.3). Από την επιλογή Add new CRS ξεκινάει η διαδικασία προσθήκης. Η διαδικασία απαιτεί ένα όνομα και την περιγραφή του νέου χαρτογραφικού συστήματος με τη μορφή που ορίζει η PROJ.4. Η ορθή περιγραφή και διαχείριση του νέου ΣΑΣ μπορεί να ελεγχθεί με τη χρήση σημείων ελέγχου για τα οποία είναι γνωστές οι συντεταγμένες και στα δύο συστήματα. Εάν δοθούν οι συντεταγμένες των σημείων ελέγχου στο αρχικό ΣΑΣ, με το πλήκτρο Calculate, υπολογίζονται οι συντεταγμένες στο νέο ΣΑΣ, οι οποίες μπορούν να ελεγχθούν. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 6.3 Δημιουργία ΣΑΣ από το χρήστη.
6.2.4 Ορισμός του ΣΑΣ για ένα θεματικό επίπεδο
 
Για τον ορισμό του ΣΑΣ για ένα θεματικό επίπεδο, αρχικά προστίθεται στο περιβάλλον του QGIS ένα αρχείο χαρτογραφικών δεδομένων π.χ. coastline.shp. Από τον κατάλογο Επίπεδα των θεματικών επιπέδων επιλέγεται αυτό και από τις επιλογές που εμφανίζονται με δεξί κλικ επιλέγεται η Set layer CRS. Στο νέο παράθυρο Επιλογέας Συστήματος Αναφοράς Συντεταγμένων (Εικόνα 6.4) ορίζεται το όνομα του ΣΑΣ που χρησιμοποιούν τα δεδομένα π.χ. GGRS87 – Greek Grid.
 
6.2.5 Μετασχηματισμός του ΣΑΣ 
 
Συχνά, απαιτείται ο μετασχηματισμός του ΣΑΣ των διανυσματικών ή των κανονικοποιημένων δεδομένων. 
Όσον αφορά τα διανυσματικά δεδομένα, αρχικά, προστίθεται στο περιβάλλον του QGIS το αρχείο των διανυσματικών δεδομένων π.χ. coastline.shp, στο οποίο θα εφαρμοστεί ο μετασχηματισμός του ΣΑΣ σε ένα νέο. Το αποτέλεσμα θα αποθηκευτεί σε ένα νέο αρχείο ίδιου μορφότυπου. Από τον κατάλογο Επίπεδα των θεματικών επιπέδων, επιλέγεται αυτό που θα μετασχηματιστεί και από τις επιλογές που εμφανίζονται με δεξί κλικ επιλέγεται η Αποθήκευση ως. Στο νέο παράθυρο Save vector layer as (Εικόνα 6.5) ορίζεται το όνομα του νέου αρχείου Αποθήκευση ως και από το πλήκτρο Αλλαγή εμφανίζεται το παράθυρο Επιλογέας Συστήματος Αναφοράς Συντεταγμένων. Από το νέο αυτό παράθυρο (Εικόνα 6.4) επιλέγεται το επιθυμητό νέο ΣΑΣ π.χ. WGS84 και η επιλογή ολοκληρώνεται με το πλήκτρο OK. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Η επιτυχία του μετασχηματισμού ελέγχεται με τις συντεταγμένες του κέρσορα που εμφανίζονται στη Γραμμή Κατάστασης στο κάτω μέρος της γραφικής απόδοσης (Εικόνα 6.6).
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Εικόνα 6.4 Επιλογή ΣΑΣ.
Για τον μετασχηματισμό του ΣΑΣ  κανονικοποιημένων δεδομένων, αρχικά, προστίθεται στο περιβάλλον του QGIS ένα αρχείο κανονικοποιημένων δεδομένων π.χ. landuse.tif, στο οποίο θα εφαρμοστεί μετασχηματισμός σε ένα νέο ΣΑΣ. Το αποτέλεσμα θα αποθηκευτεί σε ένα νέο αρχείο ίδιας δομής. Από τον κατάλογο Επίπεδα των θεματικών επιπέδων, επιλέγεται αυτό που θα μετασχηματισθεί και από τις επιλογές που εμφανίζονται με δεξί κλικ επιλέγεται η Αποθήκευση ως. Στο νέο παράθυρο Save raster layer as (Εικόνα 6.7), ορίζεται το όνομα του νέου αρχείου ως Αποθήκευση ως και από το πλήκτρο Αλλαγή εμφανίζεται το παράθυρο Επιλογέας Συστήματος Αναφοράς Συντεταγμένων (Εικόνα 6.4). Σε αυτό το νέο παράθυρο επιλέγεται το επιθυμητό νέο ΣΑΣ π.χ. WGS84 και η επιλογή ολοκληρώνεται με το πλήκτρο OK. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Η επιτυχία του μετασχηματισμού ελέγχεται με τις συντεταγμένες του κέρσορα που εμφανίζονται στη Γραμμή Κατάστασης στο κάτω μέρος της γραφικής απόδοσης (Εικόνα 6.6).
Στην περίπτωση κατα την οποία τα δεδομένα ενός χωρικού πίνακα PostgreSQL/PostGIS πρέπει να αλλάξουν ΣΑΣ, αυτός προστίθεται στο περιβάλλον του QGIS και ακολουθείται η διαδικασία που περιγράφεται στα προηγούμενα για τα διανυσματικά δεδομένα. Τα δεδομένα στο νέο ΣΑΣ αποθηκεύονται σε ένα αρχείο μορφότυπου shapefile. Στη συνέχεια, το αρχείο μορφότυπου shapefile, το οποίο περιέχει τα δεδομένα στο νέο ΣΑΣ εισάγεται εκ νέου στη βάση δεδομένων ως χωρικός πίνακας (βλ. Κεφάλαιο 4).
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Εικόνα 6.5 Μετασχηματισμός ΣΑΣ διανυσματικού αρχείου.
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Εικόνα 6.6 Συντεταγμένες κέρσορα. 
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Εικόνα 6.7 Μετασχηματισμός ΣΑΣ κανονικοποιημένου αρχείου.
6.3 Οδηγίες διαχείρισης του ΣΑΣ στο ΣΓΠ ArcGIS
 
Το ΣΓΠ ArcGIS υποστηρίζει ένα πλήθος ΣΑΣ και χαρτογραφικών προβολών. Τα ΣΑΣ στο ArcGIS εμφανίζονται ομαδοποιημένα σε δύο κατηγορίες: Projected Coordinate System, που αφορά χαρτογραφικά συστήματα, και Geographic Coordinate System, που αφορά γεωδαιτικά συστήματα αναφοράς. Το σύστημα ΕΓΣΑ ’87, το οποίο χρησιμοποιείται ευρέως για τις εφαρμογές του ελλαδικού χώρου στο ΣΓΠ ArcGIS καλείται Greek Grid και εντοπίζεται στον κατάλογο των ΣΑΣ ως Projected Coordinate System>National Grids>Europe>Greek Grid. Στις επόμενες παραγράφους παρουσιάζονται βασικές εργασίες που σχετίζονται με τη διαχείριση του ΣΑΣ (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β). 
 
 
6.3.1 Ενημέρωση του χρήστη για το ΣΑΣ των χαρτογραφικών δεδομένων
 
Για την ενημέρωση του χρήστη σχετικά με το ΣΑΣ των χαρτογραφικών δεδομένων, από το περιβάλλον του ArcCatalog εντοπίζονται τα δεδομένα. Επιλέγονται τα δεδομένα π.χ. αρχείο shapefile, geodatabase κ.ά. και με δεξί κλικ επιλέγεται Properties. Στο νέο παράθυρο Properties και από την καρτέλα ΧΥ Coordinate ο χρήστης ενημερώνεται για το ΣΑΣ το οποίο χρησιμοποιούν τα δεδομένα. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
6.3.1.1 Προσδιορισμός των συντεταγμένων των ορίων ενός θεματικού επιπέδου
 
Για τον προσδιορισμό των συντεταγμένων των ορίων (bounding coordinates) ενός θεματικού επιπέδου, από το κυρίως μενού του ArcCatalog επιλέγεται Customize>ArcCatalog Options. Στην καρτέλα Metadata επιλέγεται Metadata Style: ISO 19139 Metadata Implementation Specification (Εικόνα 6.8). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Στη συνέχεια, επιλέγεται ο πίνακας των χωρικών δεδομένων (feature class) και η καρτέλα Description, απ’ όπου γίνεται και ανάγνωση των συντεταγμένων των ορίων (Extends: Extent in the item's coordinate system) του θεματικού επιπέδου (Εικόνα 6.9).
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Εικόνα 6.8 Επιλογή προτύπου μεταδεδομένων.
6.3.2 Ορισμός του ΣΑΣ των χαρτογραφικών δεδομένων
 
Στην περίπτωση που δεν υφίσταται η πληροφορία του ΣΑΣ για τα δεδομένα, θα πρέπει να γίνει η σχετική ενημέρωση. Στο περιβάλλον του ArcCatalog, εντοπίζονται τα δεδομένα. Στη συνέχεια, επιλέγονται τα δεδομένα π.χ. αρχείο shapefile, geodatabase κ.ά. και με δεξί κλικ επιλέγεται Properties. Στο νέο παράθυρο Properties και στην καρτέλα ΧΥ Coordinate (Εικόνα 6.10), επιλέγεται το κατάλληλο ΣΑΣ, που βρίσκεται είτε στην κατηγορία Projected Coordinate System είτε στην κατηγορία Geographic Coordinate System. Στην περίπτωση που υπάρχουν άλλα δεδομένα που χρησιμοποιούν το ίδιο ΣΑΣ, το ΣΑΣ μπορεί να ενημερωθεί από αυτά. Επιλέγεται Add coordinate system [image: ]> Import και υποδεικνύονται τα κατάλληλα δεδομένα με το κοινό ΣΑΣ. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 6.9 Προσδιορισμός των συντεταγμένων των ορίων ενός θεματικού επιπέδου. 
 
 
[image: ]
Εικόνα 6.10 Ορισμός του ΣΑΣ των χαρτογραφικών δεδομένων.
6.3.3 Μετασχηματισμός του ΣΑΣ 
 
Για τον μετασχηματισμό του ΣΑΣ μιας κλάσης οντοτήτων (Feature Class) ή ενός συνόλου γεωχωρικών δεδομένων (Feature Dataset), από την εργαλειοθήκη ArcToolbox [image: ]επιλέγεται Data Management Tools>Projections and Transformations>Feature>Project. Στο νέο παράθυρο Project ορίζονται: τα δεδομένα ως Input Dataset π.χ. zpoints_wgs84, τα δεδομένα τα οποία θα δημιουργηθούν μετά την αλλαγή του ΣΑΣ ως Output Dataset π.χ. zpoints_ggrs87 και το νέο ΣΑΣ ως Output Coordinate System π.χ. Greek Grid. Σε περίπτωση κατα την οποία τα επιλεγμένα συστήματα χρησιμοποιούν διαφορετικό datum, τότε ενεργοποιείται αυτόματα και η επιλογή Geographic Transformation (optional). Τότε από το ΣΓΠ προτείνεται ένας κατάλληλος μετασχηματισμός, εάν αυτός είναι εφικτός με βάση τα ενσωματωμένα εργαλεία. Εάν η μετάβαση από το ένα datum στο άλλο δεν καλύπτεται από τους μετασχηματισμούς που διαθέτει το ΣΓΠ, ο μετασχηματισμός αυτός δεν μπορεί να εφαρμοστεί. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
Για τον μετασχηματισμό του ΣΑΣ ενός κανονικοποιημένου αρχείου, από την εργαλειοθήκη ArcToolbox επιλέγεται Data Management Tools>Projections and Transformations>Raster>Project Raster. Στο νέο παράθυρο Project Raster (Εικόνα 6.11) ορίζονται: το όνομα του αρχείου (Input Raster) π.χ. symi_contours_all_bw_geo.tif, το όνομα του νέου αρχείου (Output Raster Dataset) που θα δημιουργηθεί μετά την αλλαγή του ΣΑΣ π.χ. symi_contours_all_bw_geo_Pro.tif και το νέο ΣΑΣ ως Output Coordinate System π.χ. Greek Grid. Το ΣΑΣ των αρχικών δεδομένων διαβάζεται από τα δεδομένα και συμπληρώνεται αυτόματα στη φόρμα π.χ. GCS_WGS_1984 ως Input Coordinate System (optional). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 6.11 Μετασχηματισμός ΣΑΣ κανονικοποιημένων δεδομένων.
Στον ακόλουθο πίνακα (Πίνακας 6.1) αναφέρονται τα συνήθη ΣΑΣ για γεωχωρικά δεδομένα που καλύπτουν τον ελλαδικό χώρο και οι σχετικοί μετασχηματισμοί.
 
 
 
 
 
 	Αρχικό σύστημα αναφοράς
	Αρχικό σύστημα αναφοράς (ArcGIS)
	Νέο σύστημα αναφοράς
	Νέο σύστημα αναφοράς (ArcGIS)
	Αλλαγή datum

	γεωγραφικές συντεταγμένες (φ,λ) WGS84
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	Projected Coordinate System >UTM>WGS84>North Hemisphere>WGS 84 UTM Zone 35N ή WGS 84 UTM Zone 34N
	-

	Μερκατορική προβολή (πλάτος υπολογισμού φο) και ED50
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Πίνακας 6.1 Συνήθη ΣΑΣ και μετασχηματισμοί για τον ελλαδικό χώρο.
6.3.4 Ορισμός νέου ΣΑΣ από τον χρήστη 
 
Εάν το ΣΑΣ δεν βρίσκεται στον κατάλογο του ΣΓΠ ορίζεται από τον χρήστη από τη επιλογή Output Coordinate System [image: ]. Στο νέο παράθυρο επιλέγεται [image: ]Add coordinate system [image: ]>New>Projected Coordinate System ή Geographic Coordinate System. Στη συνέχεια, στο νέο παράθυρο New Projected Coordinate System ορίζονται τα ακόλουθα: το όνομα του νέου ΣΑΣ το οποίο ορίζει ο χρήστης Name, μια από τις προβολές που υποστηρίζει το σύστημα Projection π.χ: Albers (Ισοδύναμη κωνική), Cylindrical_Equal_Area (Κυλινδρική Ισοδύναμη), Equidistant_Conic (Κωνική Ισαπέχουσα), Lambert_Conformal_Conic (Κωνική Σύμμορφη), Mercator (Μερκατορική)) και οι παράμετροι εφαρμογής της, όπως το πλάτος υπολογισμού, ο κεντρικός μεσημβρινός, η κλίμακα κ.ά. Ακολούθως ορίζεται το datum αναφοράς Geographic Coordinate System >Select π.χ. Europe >GGRS_1987.prj (το σύστημα αναφοράς των γεωγραφικών συντεταγμένων βάσει του ΕΓΣΑ’87). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 6.12 Ορισμός νέου ΣΑΣ από τον χρήστη.
6.3.5 Ορισμός του ΣΑΣ που χρησιμοποιεί μια χαρτογραφική σύνθεση εντός του ArcMap
 
Σε περιβάλλον ArcMap, επιλέγεται η ομάδα δεδομένων Layers και με δεξί κλικ Properties. Στο νέο παράθυρο επιλέγεται η καρτέλα Coordinate System. Εκεί εμφανίζεται το ΣΑΣ των δεδομένων εάν έχουν προστεθεί και ενδέχεται να επιλεγεί ένα διαφορετικό ΣΑΣ. Επίσης επιλέγονται οι μονάδες των συντεταγμένων από την καρτέλα General>Units>Display π.χ. meters. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
 
 
 
6.3.5.1 Εισαγωγή δεδομένων και δυναμική αλλαγή του ΣΑΣ εντός του ArcMap
 
Αν στο περιβάλλον του ArcMap υπάρχει ήδη ένα θεματικό επίπεδο το οποίο χρησιμοποιεί το ΣΑΣ 1 και στη συνέχεια εισαχθεί ένα άλλο αρχείο το οποίο χρησιμοποιεί το ΣΑΣ 2, τότε το σύστημα ενδέχεται να χρειάζεται πληροφορίες για την εφαρμογή του κατάλληλου μετασχηματισμού (βλ. Κεφάλαιο 4 Εικόνα 4.24) του datum. Στο νέο παράθυρο Geographic Coordinate Systems Warning από το πλήκτρο Transformations, ενεργοποιείται το παράθυρο Geographic Coordinate Systems Transformations όπου επιλέγεται το αρχικό ΣΑΣ π.χ. GCS_WGS_1984 ως Convert from, το νέο ΣΑΣ π.χ. GCS_GGRS_1987 ως Into και ο μετασχηματισμός μετατροπής π.χ. GGRS_1987_Το_WGS_1984 ως Using (choices are sorted by suitability for the layer’s extent) (βλ. Κεφάλαιο 4 Εικόνα 4.25). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Κριτήρια αξιολόγησης 
Στη συνέχεια ακολουθούν μια σειρά από κριτήρια αξιολόγησης με τη μορφή ερωτήσεων των οποίων οι απαντήσεις βρίσκονται εντός του κειμένου του κεφαλαίου. 
 
Κριτήριο αξιολόγησης 1 
Πότε εφαρμόζεται ο μετασχηματισμός του ΣΑΣ;
 
Κριτήριο αξιολόγησης 2 
Πώς μπορεί να ελεγχθεί το αποτέλεσμα του μετασχηματισμού του ΣΑΣ;
 
Κριτήριο αξιολόγησης 3
Αναφέρετε τα συστήματα αναφοράς των συντεταγμένων που χρησιμοποιούνται στον ελλαδικό χώρο.
Κεφάλαιο 7 
Ψηφιακό Μοντέλο Εδάφους
Σύνοψη 
Στο κεφάλαιο αυτό αναλύεται η δημιουργία του Ψηφιακού Μοντέλου Εδάφους (ΨΜΕ) με την αξιοποίηση των θεματικών επιπέδων πληροφορίας που συνδέονται με αυτό, όπως ισοϋψείς καμπύλες, σημεία γνωστού υψομέτρου, υδρολογικό δίκτυο, ακτογραμμή κ.ά. Περιγράφεται η δημιουργία του ΨΜΕ τόσο με τη μέθοδο του δικτύου ακανόνιστων τριγώνων όσο και με αλγορίθμους που βασίζονται στη δομή κανάβου. Επισημαίνεται ότι η διαδικασία που εκτίθεται στο παρόν κεφάλαιο έχει εφαρμογή στο σύνολο των φαινομένων που παρουσιάζουν συνεχή κατανομή. Επιλέχθηκε να δοθεί έμφαση στη δημιουργία του Ψηφιακού Μοντέλου του Εδάφους λόγω του μεγάλου αριθμού εφαρμογών που σχετίζονται τόσο με το μοντέλο αυτό καθαυτό όσο και με τα παράγωγα από αυτό μεγέθη. Αναλύονται θέματα όπως: η αξιοποίηση του κάθε θεματικού επίπεδου κατά τη δημιουργία του ΨΜΕ, ο έλεγχος της αξιοπιστίας του ΨΜΕ μέσω συγκεκριμένων τεχνικών π.χ. εντοπισμός επιπέδων τριγώνων, σύγκριση μεταξύ αρχικών και παράγωγων ισοϋψών, προσδιορισμός χονδροειδών σφαλμάτων στα αρχικά δεδομένα, προσδιορισμός μέσου τετραγωνικού σφάλματος, εύρος τιμών υψομέτρων κ.ά., η σύγκριση των δύο δομών καταγραφής του ΨΜΕ, η οπτικοποίηση του ΨΜΕ μέσω σκίασης, ισοϋψών καμπυλών, υψομετρικών ζωνών κ.ά. Στη συνέχεια, ακολουθεί λεπτομερής περιγραφή για την υλοποίηση των ανωτέρω στο περιβάλλον του ΣΓΠ QGIS και του ΣΓΠ ArcGIS.
Προαπαιτούμενη γνώση
Γενική γνώση για τα Ψηφιακά Μοντέλα Εδάφους.
7. Ψηφιακό Μοντέλο Εδάφους 
 
Το ανάγλυφο της φυσικής γήινης επιφάνειας είναι ένα τρισδιάστατο συνεχές χωρικό φαινόμενο. Στους τοπογραφικούς χάρτες αναπαριστάται συνήθως με τη μορφή ισοϋψών καμπυλών, σκίασης, γραμμοσκιάς κ.ά. Ανάλογα με τον τρόπο αναπαράστασης, υφίσταται ή όχι η δυνατότητα εξαγωγής ποσοτικών αποτελεσμάτων για την τιμή του υψομέτρου. Η διαχείριση του αναγλύφου σε ψηφιακό περιβάλλον, γίνεται μέσω των Ψηφιακών Μοντέλων Εδάφους (ΨΜΕ) που εξασφαλίζουν την αναπαράσταση της φυσικής γήινης επιφάνειας με διαφορετικές δομές και αλγορίθμους παρεμβολής. 
Το ΨΜΕ μπορεί να δημιουργηθεί με τη μέθοδο του δικτύου ακανόνιστων τριγώνων (Triangulated Irregular Network - TIN) όσο και με διάφορες μεθόδους παρεμβολής των οποίων το αποτέλεσμα καταγράφεται σε έναν πίνακα / κάναβο. Μια ακόμη μέθοδος είναι αυτή της παρεμβολής πολυωνυμικών συναρτήσεων, η οποία τείνει να εγκαταλειφθεί λόγω του ότι δεν μπορεί να δημιουργήσει μοντέλα επιφανειών που χαρακτηρίζονται από πολυπλοκότητα.
7.1 Θεματικά επίπεδα για τη δημιουργία του ΨΜΕ
 
Στη δημιουργία ενός ΨΜΕ συνιστάται να συμμετέχουν όλα τα θεματικά επίπεδα της βάσης χωρικών δεδομένων, τα οποία συνδέονται με τη διαμόρφωση της μορφής του φυσικού γήινου αναγλύφου. Για τον λόγο αυτό, προτείνεται η χρήση των θεματικών επιπέδων που ακολουθούν, εφόσον αυτά εμφανίζονται στην περιοχή μελέτης και υπάρχουν αξιόπιστα στοιχεία στη βάση των χωρικών δεδομένων:
 
	Ακτογραμμή 
	Ισοϋψείς
	Υψομετρικά και τριγωνομετρικά σημεία
	Υδρολογικό δίκτυο (συνιστάται η φορά καταγραφής να ταυτίζεται με τη φορά απορροής των υδάτων)
	Λίμνες
	Σημεία γνωστού βάθους
	Ισοβαθείς καμπύλες 
	Όριο περιοχής μελέτης

 
Για τη ορθή συμβολή των παραπάνω θεματικών επιπέδων στη διαμόρφωση του μοντέλου του φυσικού γήινου αναγλύφου, θα πρέπει αυτά να είναι απαλλαγμένα από χονδροειδή σφάλματα π.χ. σφάλματα στην καταχώριση του υψομέτρου των ισοϋψών καμπυλών, σφάλματα στην καταχώριση του υψομέτρου των σημείων γνωστού υψομέτρου, σφάλματα στην καταγραφή της γεωμετρίας των ισοϋψών καμπυλών π.χ. τομές κ.ά. Για την αποφυγή των προβλημάτων αυτών είναι καλό να εφαρμοστούν οι τακτικές που αναφέρονται στο Κεφάλαιο 5. 
7.1.1 Ισοϋψείς καμπύλες και ΨΜΕ
 
Οι ισοϋψείς αποτελούν ιστορικά την πλέον διαδεδομένη μέθοδο για την αποθήκευση και την απόδοση των χαρακτηριστικών του αναγλύφου. Όμως, ενώ αποτελούν τον κύριο όγκο των δεδομένων εισόδου για την παραγωγή ενός ΨΜΕ και λόγω της διαθεσιμότητάς τους χρησιμοποιούνται ευρέως, παρουσιάζουν ορισμένα προβλήματα καθώς έχουν κατασκευαστεί για την γραφική απόδοση του αναγλύφου και όχι για την ψηφιακή καταγραφή του. Κατά τη χρήση τους ως πηγής για τη δημιουργία ενός ΨΜΕ παρατηρείται το φαινόμενο η δειγματοληψία των σημείων γνωστού υψομέτρου να συγκεντρώνεται κατά μήκος των ισοϋψών ενώ δεν υπάρχει πληροφορία με την ίδια πυκνότητα ενδιάμεσα στις ισοϋψείς. Τα σφάλματα που δημιουργούνται κατά την απόδοσή τους λόγω των διαδικασιών της σχεδίασης, της γενίκευσης, της εξομάλυνσης κ.ά. κληροδοτούνται και στο ΨΜΕ, ενώ συχνά ένα μεγάλο μέρος της αρχικής πληροφορίας έχει χαθεί κατά τη χαρτοσύνθεση με αποτέλεσμα να μην εμφανίζεται στο τελικό προϊόν (Weibel and Heller, 1991).
Προκειμένου ο δημιουργός του ΨΜΕ να μπορεί να ελέγξει αν το αποτέλεσμα καταγράφει την πραγματική μορφή του αναγλύφου, θα πρέπει να είναι εξοικειωμένος με την ερμηνεία της μορφής του αναγλύφου μέσω των ισοϋψών κατά την ανάγνωση του χάρτη, ώστε να μπορεί να αναγνωρίσει τις μορφολογικές δομές που σχηματίζουν. Στη συνέχεια, ακολουθεί μια σύντομη περιγραφή των βασικότερων μορφολογικών δομών (Εικόνα 7.1):
 
	Το Ύψωμα είναι μια εδαφική έξαρση. Από την κορυφή του υψώματος, το έδαφος έχει κλίση προς τα χαμηλότερα υψόμετρα σε κάθε κατεύθυνση. 
	Η Πλαγιά (ή κλιτύς) είναι το κεκλιμένο τμήμα μιας εδαφικής έξαρσης. Ανάλογα με τη μορφή των ισοϋψών καταγράφεται η διαφορετική κλίση που μπορεί να εμφανίζουν οι πλαγιές γύρω από το ύψωμα.
	Η Κορυφή είναι το ψηλότερο σημείο μιας εδαφικής έξαρσης.
	Η Κορυφογραμμή είναι η γραμμή συνάντησης δύο πλαγιών κατά τα υψηλότερα σημεία τους. Εδώ οι ισοϋψείς καμπύλες στρέφουν τα κυρτά προς τα χαμηλότερα σημεία του εδάφους.
	Μισγάγγεια (ή ρέμα) είναι η γραμμή συνάντησης δύο πλαγιών κατά τα χαμηλότερα σημεία τους. Εδώ οι ισοϋψείς καμπύλες στρέφουν τα κυρτά προς τα ψηλότερα σημεία του εδάφους. Οι μισγάγγειες συγκεντρώνουν τα νερά της βροχής και γι’ αυτό λέγονται και γραμμές ρύσης των υδάτων. Δηλαδή στη μισγάγγεια τα υψόμετρα βαίνουν προς τα ανάντη ενώ στην κορυφογραμμή βαίνουν προς τα κατάντη. Και στις δύο περιπτώσεις (μισγάγγειες & κορυφογραμμές) αποτελούν το γεωμετρικό τόπο των σημείων αλλαγής κλίσης των εκατέρωθεν πλαγιών.
	Αυχένας είναι το χαμηλότερο σημείο μεταξύ δύο εξάρσεων μιας κορυφογραμμής.
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Εικόνα 7.1 Βασικές μορφολογικές δομές.
7.2 Ψηφιακό Μοντέλο Εδάφους σε δομή ΤΙΝ
 
Το Ψηφιακό Μοντέλο Εδάφους με βάση τη δομή του δικτύου ακανόνιστων τριγώνων (Triangulated Irregular Network - ΤΙΝ), αναπαριστά το ανάγλυφο με ένα σύνολο τριγωνικών επιφανειών των οποίων οι κορυφές ταυτίζονται με τις θέσεις των σημείων των δεδομένων εισόδου (Τσούλος, 2008). Για κάθε κορυφή του τριγώνου αποθηκεύεται το υψόμετρο. Οι αρχικές οντότητες που χρησιμοποιούνται για τη δημιουργία ενός ΤΙΝ παραμένουν στην ίδια θέση ως κόμβοι ή ακμές. Με τον τρόπο αυτό, το ΤΙΝ διατηρεί την ακρίβεια των δεδομένων εισόδου. Δεδομένου ότι η κατανομή των κόμβων του ΤΙΝ στο χώρο δεν είναι κανονική, το ΤΙΝ ενδέχεται να έχει υψηλότερη πυκνότητα σε ορισμένες περιοχές (Εικόνα 7.2) όπου το ανάγλυφο μεταβάλλεται έντονα και όπου τα δεδομένα εισόδου είναι πιο λεπτομερή (π.χ. περιοχή που καλύπτεται από ισοϋψείς) και χαμηλότερη πυκνότητα σε περιοχές που τα αρχικά δεδομένα είναι αραιά (π.χ. περιοχή που καλύπτεται από βαθυμετρικά στοιχεία). Η προσεκτική επιλογή των στοιχείων εισόδου, τα οποία θα αξιοποιηθούν για τη δημιουργία του μοντέλου του αναγλύφου μέσω ενός ΤΙΝ, είναι καθοριστική για την ακρίβεια και την αναπαράστασή του. Πρέπει να επιλέγονται με τρόπο ώστε να καταγράφουν τις περιοχές όπου υπάρχουν σημαντικές αλλαγές στη μορφή του αναγλύφου, δηλαδή στα τοπικά ακρότατα, στην κορυφογραμμή, στις μισγάγγειες κ.ά.
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Εικόνα 7.2 Η πυκνότητα των δεδομένων επηρεάζει το μέγεθος των μέγεθος τριγώνων του ΤΙΝ.
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Εικόνα 7.3 Επίπεδα τρίγωνα (κόκκινη απόχρωση) μπορούν να δημιουργηθούν 1. Στις κορυφογραμμές λόγω έλλειψης γραμμών αλλαγής κλίσης, 2. Στην κορυφή ενός υψώματος λόγω έλλειψης υψομετρικού σημείου, 3. Στις μισγάγγειες λόγω έλλειψης γραμμών αλλαγής κλίσης.
7.2.1 Επίπεδα Τρίγωνα 
 
Ως επίπεδα χαρακτηρίζονται τα τρίγωνα του ΤΙΝ τα οποία έχουν την ίδια τιμή υψομέτρου και στις τρεις κορυφές που τα ορίζουν, με αποτέλεσμα να έχουν μηδενική κλίση. Εκτός μεμονωμένων περιπτώσεων, η ύπαρξη αυτών των επιπέδων τριγώνων παρουσιάζει την αδυναμία του μοντέλου ΤΙΝ να περιγράψει την αληθινή μορφή του φυσικού γήινου αναγλύφου και θα πρέπει να διορθώνονται. Η ύπαρξη των επιπέδων τριγώνων μπορεί να αποφευχθεί με διαφορετικούς τρόπους ανάλογα με τη θέση εμφάνισής τους (Εικόνα 7.3): 
 
	Η εμφάνιση επιπέδων τριγώνων κατά μήκος των ισοϋψών καμπυλών, προκύπτει όταν και οι τρεις κορυφές του τριγώνου ανήκουν στην ίδια ισοϋψή λόγω μεγάλης πυκνότητας των κορυφών της ισοϋψούς καμπύλης. Αντιμετωπίζεται με την απαλοιφή ορισμένων κορυφών με την εφαρμογή ενός αλγόριθμου απλοποίησης των γραμμών π.χ. Douglas Peucker (βλ. Κεφάλαιο 9). Η ύπαρξη των επιπέδων τριγώνων επηρεάζει τον σχεδιασμό των υψομετρικών ζωνών και τον υπολογισμό των κλίσεων.
	Η εμφάνιση επιπέδων τριγώνων στην περιοχή των τοπικών ακρότατων του ΨΜΕ π.χ. κορυφή ενός υψώματος, μπορεί να αποφευχθεί με την προσθήκη μεμονωμένων υψομετρικών σημείων.
	Η εμφάνιση επιπέδων τριγώνων σε περιοχές ειδικών σχηματισμών του αναγλύφου π. χ. αυχένας, μισγάγγεια, μπορεί να αποφευχθεί με την προσθήκη γραμμών αλλαγής κλίσης (breaklines).
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Εικόνα 7.4 Η δημιουργία επιπέδων τριγώνων κατά μήκος των ισοϋψών λόγω της μεγάλης πυκνότητας των κορυφών επηρεάζει τη μορφή των υψομετρικών ζωνών και τον υπολογισμό των κλίσεων. Οι μηδενικές κλίσεις αποδίδονται με κόκκινη απόχρωση.
Σε ένα ΤΙΝ, ο εντοπισμός των επιπέδων τριγώνων μπορεί να βασιστεί στον προσδιορισμό των κλίσεων των τριγώνων (Εικόνα 7.4) και στην επιλογή των τριγώνων εκείνων όπου η κλίση είναι μηδενική. Με τον τρόπο αυτό επιτυγχάνεται η οπτικοποίηση των επιπέδων τριγώνων και ο εντοπισμός των περιοχών όπου απαιτείται η επέμβαση του χρήστη με τη μεθοδολογία που αναφέρθηκε πριν π.χ. προσθήκη γραμμών κλίσης.
7.3 Ψηφιακό Μοντέλο Εδάφους σε δομή κανάβου
 
Οι τεχνικές παρεμβολής χρησιμοποιούνται στα ΨΜΕ για τον προσδιορισμό του υψομέτρου σε περιοχές που δεν υπάρχουν δεδομένα. Η περιοχή μελέτης θεωρείται ότι μπορεί να καλυφθεί από έναν πίνακα/κάναβο, το οποίο ορίζει ένα πλέγμα γραμμών και στηλών με φατνία συγκεκριμένου μεγέθους, για τα οποία το υψόμετρο υπολογίζεται με την εκάστοτε μέθοδο παρεμβολής που έχει επιλεγεί (Εικόνα 7.5). Σε ό,τι αφορά την ανάλυση του κανάβου (μέγεθος φατνίου) θα πρέπει να επιλεγεί έτσι ώστε να εξασφαλίζει την αξιόπιστη αναπαράσταση του αναγλύφου σε σχέση με την κλίμακα και την πυκνότητα των δεδομένων. Κατά τη δημιουργία του ΨΜΕ υπάρχει η δυνατότητα επιλογής της μεθόδου παρεμβολής από διάφορους αλγορίθμους που έχει προτείνει η επιστημονική έρευνα (Τσούλος, 2008).
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Εικόνα 7.5 ΨΜΕ σε δομή κανάβου.
7.4 Κριτική αξιολόγηση ΨΜΕ
 
Πέρα από τη δημιουργία του ΨΜΕ είναι σημαντική η κριτική αξιολόγηση της ποιότητάς του.
7.4.1 Εκτίμηση της ποιότητας ενός ΨΜΕ
 
Η ποιότητα ενός ΨΜΕ εξαρτάται από την ποιότητα, την πυκνότητα και την κατανομή των αρχικών δεδομένων, τη χωρική διακύμανση των δεδομένων, το μοντέλο παρεμβολής και τον αλγόριθμο που χρησιμοποιείται και την ανάλυση (μέγεθος φατνίου) για τα ΨΜΕ δομής κανάβου. Για την εκτίμηση της ποιότητας ενός ΨΜΕ προτείνονται οι παρακάτω έλεγχοι:
 
	Προσδιορισμός με βάση το ΨΜΕ, των υψομέτρων ενός συνόλου σημείων γνωστού υψομέτρου (ονομαστικού) της περιοχής μελέτης, τα οποία δεν χρησιμοποιήθηκαν στη δημιουργία του μοντέλου. Από τη σύγκριση του ονομαστικού υψομέτρου με την τιμή που δίνει το μοντέλο είναι δυνατός ο υπολογισμός του σφάλματος και η έκφρασή του με κάποιο στατιστικό μέγεθος π.χ. Μέσο Τετραγωνικό Σφάλμα (Root Mean Square Εrror - RMSE).
	Ο εντοπισμός χονδροειδών σφαλμάτων, όπως εσφαλμένα υψόμετρα στα αρχικά δεδομένα π.χ. ισοϋψείς, σημεία γνωστού υψομέτρου, λανθασμένη φορά καταγραφής ρεμάτων (αντίθετη από τη φορά απορροής των υδάτων), υλοποιείται με τη χρήση διαφορετικών μεθόδων απεικόνισης του ΨΜΕ όπως βάσει του μοντέλου σκίασης του ΨΜΕ (Εικόνα 7.6) ή η απόδοση των τιμών του υψομέτρου με μια συνεχή παλέτα διαφορετικών τόνων μιας απόχρωσης (Εικόνα 7.7).
	Δημιουργία νέων ισοϋψών από το ΨΜΕ με ισοδιάσταση ίση ή μισή σε σχέση με αυτήν των δεδομένων εισόδου και οπτική σύγκριση των αρχικών ισοϋψών με τις παράγωγες ισοϋψείς, μέσω της απόδοσής τους σε ένα χάρτη. 
	Προσδιορισμός του υδρολογικού μοντέλου από το ΨΜΕ (βλ. Κεφάλαιο 8) και οπτική σύγκριση με το αρχικό μέσω της απόδοσής τους σε ένα χάρτη.
	Έλεγχος και διόρθωση βυθισμάτων: Ως βύθισμα χαρακτηρίζεται ένα ή περισσότερα φατνία όταν όλα τα γειτονικά φατνία έχουν μεγαλύτερο υψόμετρο, με αποτέλεσμα η διεύθυνση ροής μιας σταγόνας νερού που θα πέσει στο φατνίο αυτό να είναι απροσδιόριστη. Κατά τη δημιουργία του ΨΜΕ ενδέχεται να προκύψουν ψευδή βυθίσματα στο ανάγλυφο λόγω αδυναμιών των αρχικών δεδομένων. Τα βυθίσματα αυτά πρέπει να διορθωθούν ώστε να μην απομονώνουν τμήματα της λεκάνης απορροής. Ο αριθμός των βυθισμάτων συνήθως αυξάνεται για ένα ΨΜΕ χαμηλότερης ανάλυσης. Μια άλλη αιτία για τη δημιουργία τους είναι η καταγραφή του υψομέτρου με ακέραιους αριθμούς.
	Η σύγκριση των στατιστικών μεγεθών π.χ. εύρος, μέσος όρος, τυπική απόκλιση των τιμών του υψομέτρου του μοντέλου με αυτά των αρχικών δεδομένων, σε συνδυασμό με τα ιδιαίτερα χαρακτηριστικά του κάθε μοντέλου. Για παράδειγμα είναι γνωστό ότι το μοντέλο ΤΙΝ κρατάει τα αρχικά δεδομένα ενώ στις δομές του κανάβου η τιμή του υψομέτρου κάθε φατνίου προκύπτει από την εκάστοτε μέθοδο παρεμβολής.
	Προσδιορισμός επιπέδων τριγώνων.
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Εικόνα 7.6 Προσδιορισμός χονδροειδών σφαλμάτων με τη βοήθεια του σκιασμένου αναγλύφου.
 
 
 
7.4.2 Σύγκριση διαφορετικών ΨΜΕ μιας περιοχής
 
Πολλές από τις παραπάνω μεθόδους μπορούν να χρησιμοποιηθούν και για τη σύγκριση ΨΜΕ που αφορούν την ίδια περιοχή μελέτης, είτε χρησιμοποιούν διαφορετική δομή π.χ. ΤΙΝ έναντι κανάβου, είτε προέκυψαν από άλλο αλγόριθμο παρεμβολής των υψομέτρων π.χ. Κriging έναντι Topo to Raster κ.ά. Για παράδειγμα, τα στατιστικά μεγέθη των υψομέτρων, η οπτική αντιπαράθεση διαφόρων μεθόδων απόδοσης π.χ. ισοϋψείς καμπύλες, σκίαση, κλίσεις, προσανατολισμός, σύγκριση παράγωγων δεδομένων π.χ. υδρολογικό δίκτυο κ.ά. Στην περίπτωση σύγκρισης ΨΜΕ δομής κανάβου αποτελεί προϋπόθεση η ενιαία τιμή ανάλυσης του κανάβου, η οποία πρέπει να ταυτίζεται με την πλέον αδρή εκ των δύο.
 
 
[image: ]
Εικόνα 7.7 Προσδιορισμός χονδροειδών σφαλμάτων με τη βοήθεια της απόδοσης του αναγλύφου με μια συνεχή παλέτα διαφορετικών τόνων μιας απόχρωσης.
7.4.3 Παράγωγα προϊόντα από το ΨΜΕ και διαφορετικές μέθοδοι απόδοσης
 
Από τα ΨΜΕ συχνά εξάγονται παράγωγα δεδομένα όπως η κλίση, ο προσανατολισμός, οι ισοϋψείς με ισοδιάσταση που επιλέγει ο χρήστης, οι υψομετρικές ζώνες, η σκίαση κ.ά. Αυτά τα δεδομένα αποκαλύπτουν διαφορετικές πτυχές του αναγλύφου και χρησιμοποιούνται για την απόδοσή του ανάλογα με το σκοπό του χάρτη. 
7.5 Δημιουργία ΨΜΕ και επεξεργασία στο περιβάλλον του ΣΓΠ QGIS
 
Στο περιβάλλον του ΣΓΠ QGIS υπάρχουν εργαλεία για τη δημιουργία ΨΜΕ σε δομή ΤΙΝ και κανάβου (“QGIS Training Manual”, χ.η.;“QGIS User Guide”, χ.η.). Επισημαίνεται ότι δεν υπάρχει δομή που να αποθηκεύει το ΤΙΝ ως πλέγμα τριγώνων αλλά αυτό αποθηκεύεται σε δομή κανάβου (κανονικοποιημένο αρχείο) με κάποια διαδικασία μετατροπής, η οποία όμως αποσιωπάται. 
Αρχικά, στο περιβάλλον του QGIS θα πρέπει να δημιουργηθεί ένα καινούργιο έργο (project) και να προστεθούν όλα τα θεματικά επίπεδα τα οποία θα χρησιμοποιηθούν για τη δημιουργία και την επεξεργασία του ΨΜΕ.
7.5.1 Προετοιμασία των δεδομένων
 
Για να καταστεί δυνατή η αξιοποίηση των γραμμικών δεδομένων π.χ. ακτογραμμή, ισοϋψείς κ.ά. και να χρησιμοποιηθούν ως δεδομένα εισόδου για τη δημιουργία ενός ΨΜΕ, θα πρέπει να μετατραπούν σε σημειακά. Από το μενού επιλέγεται Διανύσματα>Εργαλεία γεωμετρίας>Extract Node. Στο νέο παράθυρο Εξαγωγή συγκεκριμένων κόμβων (Εικόνα 7.8), δηλώνεται το διανυσματικό αρχείο από το οποίο θα εξαχθούν οι κορυφές ως Εισαγωγή διανυσματικού επιπέδου τύπου γραμμής ή πολυγώνου και το νέο διανυσματικό αρχείο όπου θα αποθηκευτούν οι κορυφές ως Εξαγωγή Shapefile σημείου. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 7.8 Μετατροπή γραμμών σε σημεία.
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Εικόνα 7.9 Δημιουργία ψηφιακού μοντέλου δομής ΤΙΝ.
7.5.2 Δημιουργία ΨΜΕ δομής ΤΙΝ
 
Από το μενού επιλέγεται Raster>Interpolation>Interpolation. Στο νέο παράθυρο Plugin Παρεμβολής (Εικόνα 7.9), από την επιλογή Vector layers δηλώνεται το διανυσματικό αρχείο το οποίο θα χρησιμοποιεί και από την επιλογή Interpolation attribute, το πεδίο στο οποίο έχει καταγραφεί το υψόμετρο. Το συγκεκριμένο θεματικό επίπεδο θα προστεθεί στον κατάλογο των δεδομένων για τη δημιουργία του ΨΜΕ με το πλήκτρο Προσθήκη. Η διαδικασία επαναλαμβάνεται μέχρι να ολοκληρωθεί η προσθήκη όλων των θεματικών επιπέδων. Στην επιλογή Interpolation method ορίζεται Triangular Interpolation (TIN). Ακόμα ορίζεται το μέγεθος του φατνίου κατά Χ και κατά Υ. Από το πλήκτρο Set to current extent ορίζονται τα όρια της περιοχής που θα καλύπτει το ΤΙΝ να ταυτίζονται με αυτά της περιοχής που απεικονίζεται στην οθόνη. Στην επιλογή Output file ορίζεται το όνομα του ΤΙΝ και η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 7.10 Αποκοπή του ΨΜΕ στα όρια της περιοχής.
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Εικόνα 7.11 Δημιουργία ΨΜΕ δομής κανάβου.
7.5.2.1 Αποκοπή του ΨΜΕ στα όρια της περιοχής μελέτης
 
Από το μενού επιλέγεται Ψηφιδωτό>Εξαγωγή>Clipper. Στο νέο παράθυρο Συνδετήρας (Εικόνα 7.10), ορίζεται το αρχείο που θα χρησιμοποιηθεί ως Αρχείο εισόδου και το νέο αρχείο που θα δημιουργηθεί ως Αρχείο προορισμού. Από την επιλογή Xωρίς τιμή δεδομένου, ορίζεται η τιμή που θα λαμβάνουν τα φατνία χωρίς τιμή π.χ. ως -1. Από την επιλογή Mask layer ορίζεται το διανυσματικό επίπεδο που θα χρησιμοποιηθεί ως όριο για την αποκοπή. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 7.12 Δημιουργία συμβολισμού για το ΨΜΕ.
7.5.3 Δημιουργία ΨΜΕ δομής κανάβου
 
Από το μενού επιλέγεται Raster>Interpolation>Interpolation. Στο νέο παράθυρο Plugin Παρεμβολής (Εικόνα 7.11), από την επιλογή Vector layers δηλώνεται το διανυσματικό αρχείο που θα χρησιμοποιηθεί και από την επιλογή Interpolation attribute το πεδίο στο οποίο καταγράφεται το υψόμετρο. Το συγκεκριμένο θεματικό επίπεδο προστίθεται στον κατάλογο των δεδομένων για τη δημιουργία του ΨΜΕ με το πλήκτρο Προσθήκη. Η διαδικασία επαναλαμβάνεται μέχρι να ολοκληρωθεί η προσθήκη όλων των θεματικών επιπέδων. Στην επιλογή Interpolation method ορίζεται Inverse Distance Weighting (IDW) και ακόμα ορίζεται το μέγεθος του φατνίου κατά Χ και κατά Υ. Από το πλήκτρο Set to current extent, ορίζονται τα όρια της περιοχής που θα καλύπτει το ΤΙΝ να ταυτίζονται με αυτά της περιοχής που απεικονίζεται στην οθόνη. Στην επιλογή Output file ορίζεται το όνομα του νέου ΨΜΕ και η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
7.5.4 Απόδοση ΨΜΕ
 
Επιλέγεται ένα ΨΜΕ και από το μενού που εμφανίζεται με δεξί κλικ επιλέγεται Ιδιότητες. Στο νέο παράθυρο Γενικά επιλέγεται η καρτέλα Στυλ. Στην καρτέλα Στύλ (Εικόνα 7.12), επιλέγεται Single pseudocolor ως Render type. Στη συνέχεια, μπορεί να επιλεγεί μια από τις υπάρχουσες παλέτες ή να δημιουργηθεί μια νέα από την επιλογή New color ramp. Στο νέο παράθυρο Gradient color ramp, ορίζονται η πρώτη και η τελευταία απόχρωση της παλέτας, ενώ ενδιάμεσες αποχρώσεις προστίθενται από το πλήκτρο Add stop. Δίνεται η δυνατότητα προσθήκης απόχρωσης αλλά και καθορισμού της θέσης της στην παλέτα ως ποσοστό. Αφού οριστεί η παλέτα, από το κουμπί Ταξινόμηση της καρτέλας Στυλ, δημιουργείται το σχήμα μετάβασης και μεταφέρεται αριστερά. Επιπλέον επιλογές για τη διαμόρφωση του σχήματος μετάβασης αποτελεί η επιλογή Mode από όπου ορίζεται ως συνεχής (continuous) ή με σταθερό βήμα (equal interval), σε συνδυασμό με το πλήθος των κατηγοριών που ορίζεται από την επιλογή Κλάσεις. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
7.5.5 Υπολογισμός των κλίσεων από το ΨΜΕ και απόδοση των κλίσεων
 
Από το μενού επιλέγεται Ψηφιδωτό>Ανάλυση>DEM. Στο νέο παράθυρο DEM (Μοντέλα Εδάφους) (Εικόνα 7.13) ορίζεται το ΨΜΕ για το οποίο θα υπολογιστούν οι κλίσεις ως Αρχείο εισόδου (DEM raster), ως Αρχείο προορισμού ορίζεται το νέο κανονικοποιημένο αρχείο που θα δημιουργηθεί και θα καταγράφει τις κλίσεις και επιλέγεται ως Λειτουργία (Mode) Slope. Εάν οι κλίσεις θα εκφράζονται ως ποσοστά και όχι σε μοίρες, επιλέγεται Κλίση εκφρασμένη ως ποσοστού (αντί για μοίρες). Με το πλήκτρο ΟΚ ξεκινάει η διαδικασία υπολογισμού.
Η απόδοση των κλίσεων γίνεται με τη διαμόρφωση του κατάλληλου χρωματικού σχήματος όπως αναλύθηκε προηγουμένως για τα υψόμετρα. Για τον εντοπισμό των μηδενικών κλίσεων, οι οποίες στην περίπτωση του ΨΜΕ δομής ΤΙΝ αντιστοιχούν στα επίπεδα τρίγωνα, δημιουργείται μια κατηγορία κλίσεων με μηδενικές τιμές (Εικόνα 7.14).
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Εικόνα 7.13 Υπολογισμός κλίσης.
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Εικόνα 7.14 Δημιουργία παλέτας για την απόδοση της κλίσης και εντοπισμό των μηδενικών κλίσεων.
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Εικόνα 7.15 Εξαγωγή ισοϋψών από το ΨΜΕ.
7.5.6 Εξαγωγή ισοϋψών καμπυλών από το ΨΜΕ
 
Από το μενού επιλέγεται Ψηφιδωτό>Εξαγωγή>Contour. Στο νέο παράθυρο Περίγραμμα (Εικόνα 7.15), ορίζεται το ΨΜΕ ως Αρχείο Εισόδου (raster), το νέο διανυσματικό αρχείο με τις ισοϋψείς ως Output file for contour lines (vector), η ισοδιάσταση ως Μεσοδιάστημα για γραμμές περιγράμματος (Interval) και το όνομα του πεδίου όπου θα καταγράφεται η τιμή του υψομέτρου ως Όνομα Ιδιότητας. Με το πλήκτρο ΟΚ ξεκινάει η διαδικασία υπολογισμού. Σημειώνεται ότι οι ισοϋψείς οι οποίες παράγονται από τον ΨΜΕ ΤΙΝ, παρουσιάζουν προβλήματα στις περιοχές όπου υπάρχουν επίπεδα τρίγωνα. Εάν εξαχθούν ισοϋψείς με ισοδιάσταση ίση με αυτήν των αρχικών ισοϋψών και συγκριθούν με τις αρχικές, διαπιστώνεται ότι στις περιοχές με τα επίπεδα τρίγωνα παρουσιάζονται οι μέγιστες αποκλίσεις. 
7.5.7 Δημιουργία σκίασης από το ΨΜΕ και απόδοση
 
Από το μενού επιλέγεται Ψηφιδωτό>Ανάλυση>DEM. Στο νέο παράθυρο DEM (Μοντέλα Εδάφους) (Εικόνα 7.16), ορίζεται το ΨΜΕ για το οποίο θα υπολογιστούν η σκίαση ως Αρχείο εισόδου (DEM raster), ως Αρχείο προορισμού ορίζεται το νέο κανονικοποιημένο αρχείο που θα δημιουργηθεί και θα καταγράφει τη σκίαση και επιλέγεται ως Λειτουργία (Mode) Λοφοσκιά. Επιπλέον ορίζονται οι παράμετροι της φωτεινής πηγής, δηλαδή το αζιμούθιο ως Αζιμούθιο φωτοσταθερού και το υψόμετρο ως Υψόμετρο φωτοσταθερού. Με το πλήκτρο ΟΚ ξεκινάει η διαδικασία υπολογισμού. 
Η σκίαση αποθηκεύεται σε κανονικοποιημένη δομή και συνηθίζεται να αποδίδεται με μια παλέτα τόνων του γκρι. Παράλληλα, η σκίαση χρησιμοποιείται στην απόδοση σε συνδυασμό με τις υψομετρικές ζώνες για τη δημιουργία της εντύπωσης της τρισδιάστατης απόδοσης. Η σκίαση τοποθετείται στη σειρά σχεδίασης κάτω από αυτήν των υψομετρικών ζωνών και σε συνδυασμό με την προσθήκη διαφάνειας στο επίπεδο (Εικόνα 7.17) των υψομετρικών ζωνών, ώστε να φαίνεται η σκίαση, δημιουργείται  το επιθυμητό αποτέλεσμα.
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Εικόνα 7.16 Υπολογισμός σκίασης από το ΨΜΕ.
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Εικόνα 7.17 Προσθήκη διαφάνειας στην απόδοση ενός θεματικού επιπέδου. 
7.6 Δημιουργία ΨΜΕ και επεξεργασία στο περιβάλλον του ΣΓΠ ΑrcGIS
 
Στο περιβάλλον του ΣΓΠ ΑrcGIS (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β), υπάρχουν εργαλεία για τη δημιουργία ΨΜΕ σε δομή ΤΙΝ και κανάβου. Το ΨΜΕ σε δομή ΤΙΝ αποθηκεύεται ως πλέγμα τριγώνων με ειδική δομή που βασίζεται στους κόμβους, τις ακμές και τις επιφάνειες. Η δημιουργία και η επεξεργασία του ΨΜΕ μπορεί να γίνει με τα εργαλεία του ArcToolbox. Προτείνεται η επεξεργασία να υλοποιείται στο περιβάλλον του ArcMap, ώστε τα αποτελέσματα να απεικονίζονται γραφικά και να αξιολογούνται από τον χρήστη. 
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Εικόνα 7.18 Παράθυρο δημιουργίας ΤΙΝ – ορισμός θεματικών επιπέδων και της μεθόδου αξιοποίησής τους.
Στο περιβάλλον  ArcMap, θα πρέπει να να προστεθούν όλα τα θεματικά επίπεδα (στοιχεία εισόδου) τα οποία θα χρησιμοποιηθούν για τη δημιουργία και την επεξεργασία του ΨΜΕ. Επειδή κάποιοι από τους αλγόριθμους δημιουργίας ΨΜΕ απαιτούν η φορά του υδρολογικού δικτύου να ταυτίζεται με αυτήν της απορροής των υδάτων, θα πρέπει να γίνουν διορθώσεις όπου αυτό δε συμβαίνει. Αρχικά, θα πρέπει να γίνει μια επισκόπηση των δεδομένων για να εντοπιστούν πιθανά σφάλματα. Για τον λόγο αυτό, οι γραμμές του υδρολογικού δικτύου αποδίδονται με το σύμβολο Arrow at end με το οποίο επισημαίνεται ο κόμβος τέλους με ένα βέλος (για τον ορισμό του συμβολισμού βλ. Κεφάλαιο 10). Η έναρξη της διόρθωσης των γραμμών με λανθασμένη φορά γίνεται με την επιλογή Start Editing από το πλήκτρο Editor του Editor toolbar. Επιλέγεται το υδρολογικό δίκτυο από το παράθυρο Create Features. Η επιλογή οντότητας προς διόρθωση γίνεται με την ενεργοποίηση του εργαλείου Edit Tool από το Editor toolbar και στη συνέχεια με την υπόδειξη της οντότητας με το ποντίκι. Αφού επιλεγεί η οντότητα με διπλό κλικ, στη συνέχεια, με δεξί κλικ εμφανίζεται η επιλογή Flip η οποία και επιλέγεται. Η επεξεργασία που ενεργοποιεί η επιλογή Flip αντιστρέφει τη φορά καταγραφής της γραμμής. Η αποθήκευση των δεδομένων που διορθώθηκαν γίνεται με την επιλογή Save Edits από το πλήκτρο Editing του Editor toolbar.
7.6.1 ΨΜΕ δομής ΤΙΝ
7.6.1.1 Δημιουργία ΤΙΝ
 
Για τη δημιουργία ενός ΤΙΝ, από την εργαλειοθήκη ArcToolbox επιλέγεται 3D Analyst Tools>Data Management>TIN>Create TIN. Στο νέο παράθυρο Create Tin (Εικόνα 7.18) γίνεται η επιλογή των θεματικών επιπέδων τα οποία θα χρησιμοποιηθούν για τη δημιουργία του ΤΙΝ, ο ορισμός του πεδίου με την τιμή του υψομέτρου και η επιλογή της κατάλληλης περιγραφής του είδους κάθε θεματικού επιπέδου. Η εντολή δημιουργίας του ΤΙΝ γίνεται με το πλήκτρο ΟΚ. Αφού δημιουργηθεί, το ΤΙΝ προστίθεται αυτόματα στον κατάλογο των θεματικών επιπέδων του ArcMap και αποδίδεται με υψομετρικές ζώνες και σκίαση. 
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Εικόνα 7.19 Επιλογή μεθόδου απόδοσης ΤΙΝ.
Τα θεματικά επίπεδα ανάλογα με τη φύση τους μπορούν να χρησιμοποιηθούν ως εξής:
 
	Mass points: πρόκειται για σημειακές οντότητες που καταγράφουν το υψόμετρο (ή το βάθος) και αποτελούν κόμβους του ΤΙN. Καταγράφουν τη συνολική μορφή της επιφάνειας.
	Hard breaklines: αναπαριστούν γραμμές ασυνέχειας της κλίσης της επιφάνειας όπως είναι τα ρέματα. Καταγράφουν τις απότομες αλλαγές της κλίσης της επιφάνειας και βελτιώνουν την παρουσίαση και την ανάλυση του TIN.
	Soft breaklines: χρησιμοποιούνται για την προσθήκη ακμών σε ένα ΤΙΝ για την καταγραφή γραμμικών δεδομένων που δεν αλλάζουν την τοπική κλίση της επιφάνειας π.χ. όρια περιοχών μελέτης. 
	Clip polygons: ορίζουν το όριο της περιοχής για την παρεμβολή. Όλα τα δεδομένα εισόδου που βρίσκονται εντός αυτής της περιοχής χρησιμοποιούνται για την παρεμβολή και τις διαδικασίες ανάλυσης π.χ. εξαγωγή ισοϋψών καμπυλών και υπολογισμοί όγκου. 
	Erase polygons: Όλα τα δεδομένα εισόδου που βρίσκονται εντός αυτής της περιοχής δεν χρησιμοποιούνται για τη δημιουργία του ΤΙΝ και τις διαδικασίες ανάλυσης π.χ. εξαγωγή ισοϋψών καμπυλών και υπολογισμοί όγκου. 
	Replace polygons: όλα τα σημεία που βρίσκονται εντός του ορίου του πολυγώνου λαμβάνουν μια ενιαία τιμή υψομέτρου. Χρησιμοποιείται για την καταγραφή μιας λίμνης ή για την καταγραφή μιας περιοχής που λόγω εκσκαφής έχει ένα σταθερό υψόμετρο. 
	Fill polygons: όλα τα τρίγωνα που βρίσκονται εντός του ορίου του πολυγώνου λαμβάνουν μια ενιαία ακέραια τιμή σε μια ιδιότητα. Τα υψόμετρα της επιφάνειας δεν επηρεάζονται.

7.6.1.2 Μέθοδοι απόδοσης ΤΙΝ 
 
Η μέθοδος απόδοσης του ΤΙΝ μπορεί να ποικίλει. Επιλέγεται το ΤΙΝ και από το μενού που εμφανίζεται με δεξί κλικ επιλέγεται Properties>Symbology (Εικόνα 7.19). Από το παράθυρο Layer Properties και το πλήκτρο Add πραγματοποιείται η προσθήκη μιας διαφορετικής μορφής απόδοσης. Η απόδοση βασίζεται στα δομικά στοιχεία του ΤΙΝ, δηλαδή, στην ακμή (Edge), στην επίπεδη επιφάνεια (Face) και στον κόμβο (Node). Προσφέρονται οι ακόλουθες επιλογές (Εικόνα 7.19):
 
	Edge type grouped with unique symbol: απόδοση του διαφορετικού τύπου ακμών π.χ. ακμή αλλαγής κλίσης, απλή ακμή κ.ά.
	Face Slope with graduated color ramp: απόδοση των κλίσεων με παλέτα αποχρώσεων. Οι τιμές των κλίσεων ταξινομούνται σε δύο κατηγορίες ώστε αυτή η διαδικασία απόδοσης του ΤΙΝ να χρησιμοποιηθεί για τον εντοπισμό των επιπέδων τριγώνων που έχουν μηδενική κλίση. Επιλέγεται το ΤΙΝ και από το μενού που εμφανίζεται με δεξί κλικ επιλέγεται Properties>Symbology. Από το πλήκτρο Classify ενεργοποιείται το παράθυρο Classification (Εικόνα 7.20), όπου επιλέγεται Method: Equal Interval και Classes: 2. Στη συνέχεια, ενημερώνονται οι τιμές των ορίων 0,001 και 90. Η διαδικασία ολοκληρώνεται με το πλήκτρο OΚ. Στην καρτέλα Symbology διαμορφώνονται τα σύμβολα για κάθε κατηγορία κλίσεων. Η διαδικασία ολοκληρώνεται με το πλήκτρο OΚ.
	Face aspect with graduated color ramp: Απεικόνιση του προσανατολισμού με παλέτα αποχρώσεων.
	Face Elevation with graduated color ramp: Απεικόνιση των υψομετρικών ζωνών με παλέτα αποχρώσεων. 

7.6.1.3 Εξαγωγή ισοϋψών καμπυλών
 
Για την εξαγωγή ισοϋψών καμπυλών από το ΤΙΝ, από την εργαλειοθήκη ArcToolbox επιλέγεται 3D Analyst Tools>Triangulated Surface>Surface Contour. Στο νέο παράθυρο Surface Contour (Εικόνα 7.21), ορίζεται το όνομα του ΤΙΝ ως Input Surface, το διανυσματικό αρχείο στο οποίο θα αποθηκευτούν οι ισοϋψείς καμπύλες ως Output feature class, η ισοδιάσταση ως Contour Interval και η αφετηρία εφαρμογής της ισοδιάστασης ως Base contour. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 7.20 Απόδοση των κλίσεων με ομαδοποίηση σε δύο κατηγορίες με σκοπό τον εντοπισμό των επιπέδων τριγώνων.
 
 
[image: ]
Εικόνα 7.21 Εξαγωγή ισοϋψών καμπυλών από ΤΙΝ.
 
7.6.1.4 Υπολογισμός των στατιστικών στοιχείων  υψομέτρων του ΨΜΕ δομής TIN
 
Για τον υπολογισμό των στατιστικών στοιχείων για τα υψόμετρα του ΨΜΕ δομής TIN, από το περιβάλλον του ArcCatalog επιλέγεται το ΨΜΕ TIN. Στην καρτέλα Description εντοπίζεται η καταχώρηση Extent και Vertical extent.
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Εικόνα 7.22 Εργαλείο Topo to Raster.
7.6.2 ΨΜΕ δομής κανάβου
 
Το ΣΓΠ ArcGIS διαθέτει πολλούς αλγορίθμους για τη δημιουργία ΨΜΕ δομής κανάβου (π.χ. Natural Neighbors, IDW, Spline, Kriging κ.ά.). Στη συνέχεια, αναλύεται η μέθοδος Topo to Raster καθώς χρησιμοποιεί τις ισοϋψείς, το υδρολογικό δίκτυο και τα μεμονωμένα υψομετρικά σημεία αξιοποιώντας τη φύση τους. 
Το εργαλείο Topo Το Raster υλοποιεί τη μέθοδο παρεμβολής ANUDEM (Hutchinson, Xu, & Stein, 2011), η οποία βασίζεται σε μια μορφολογική προσέγγιση και δημιουργεί ένα υδρολογικά ορθό ΨΜΕ σε δομή κανάβου. Στη μέθοδο αυτή ενσωματώνονται ένας αλγόριθμος µε τον οποίο εντοπίζονται αυτόματα οι γραμμές ασυνέχειας της επιφάνειας του αναγλύφου π.χ. κορυφογραμμές και μισγάγγειες και ένας αλγόριθμος ενίσχυσης των στοιχείων του υδρολογικού δικτύου, µε τον οποίο αυτόματα απαλείφονται βυθίσματα ή τρύπες στο προσαρμοζόμενο πλέγμα. Η διαδικασία παρεμβολής είναι μια επαναλαμβανόμενη διαδικασία. Αρχικά, δημιουργείται ένας κάναβος χονδροειδούς ανάλυσης και σε κάθε επανάληψη βελτιώνεται η ανάλυση μέχρι να επιτευχθεί το μέγεθος φατνίου που ορίστηκε από το χρήστη. 
Ο υπολογισμός του υψομέτρου είναι συνδυασμός του μέσου όρου (1η προσέγγιση) και της τεχνικής spline. Έχει βελτιστοποιηθεί ώστε να έχει την υπολογιστική αποδοτικότητα των τοπικών μεθόδων παρεμβολής, όπως η παρεμβολή με βάρη του αντιστρόφου της απόστασης, (IDW), χωρίς να χάνεται η συνέχεια των επιφανειών που εξασφαλίζουν οι συνολικές μέθοδοι παρεμβολής, όπως Kriging και splines. Πρόκειται ουσιαστικά για μια τεχνική discretised thin plate spline (Wahba, 1990), όπου o περιορισμός της ομαλότητας έχει τροποποιηθεί για να επιτρέψει στο προσαρμοζόμενο ΨΜΕ να ακολουθήσει απότομες αλλαγές στο έδαφος, όπως ρέματα και κορυφογραμμές. Η Thin Plate Spline είναι μία μέθοδος παρεμβολής που βρίσκει μια ελάχιστα καμπυλωμένη ομαλή επιφάνεια που περνάει από όλα τα γνωστά σημεία. Ο όρος "Thin Plate" προέρχεται από το γεγονός ότι μιμείται τον τρόπο που ένα λεπτό μεταλλικό φύλλο συμπεριφέρεται εάν κληθεί να περάσει από μία σειρά συγκεκριμένων σημείων. Η επιλογή της κατάλληλης συνάρτησης για τον περιορισμό της ομαλότητας μπορεί να επιτρέψει στο ΨΜΕ να ακολουθήσει την τάση του αναγλύφου πέρα από τα σημεία γνωστού υψομέτρου (παρεμβολή ελάχιστης καμπυλότητας), αλλά και τις απότομες αλλαγές στην κλίση κατά μήκος των κορυφογραμμών και των μισγαγγειών καθώς και να αναγνωρίζει σημεία επί των ρεμάτων ως βυθίσματα.
Το νερό είναι η πρωταρχική διαβρωτική δύναμη η οποία καθορίζει τους γενικούς σχηματισμούς του αναγλύφου. Για τον λόγο αυτό, οι πιο πολλές περιοχές έχουν πολλές κορυφές (τοπικά μέγιστα) και λίγα βυθίσματα (τοπικά ελάχιστα), τα οποία δημιουργούν ένα συνεχές δίκτυο απορροής. Η μέθοδος χρησιμοποιεί αυτή τη γνώση της δομής των επιφανειών και επιβάλλει περιορισμούς στη διαδικασία παρεμβολής που οδηγούν σε ένα συνεχές δίκτυο απορροής και στη σωστή καταγραφή των κορυφογραμμών και των ρεμάτων. Αυτή η επιβαλλόμενη διαδικασία ελέγχου της απορροής, παράγει ΨΜΕ υψηλότερης ακρίβειας με λιγότερα δεδομένα εισόδου. Ο αλγόριθμος λειτουργεί συντηρητικά κατά την αφαίρεση βυθισμάτων και δεν επιβάλλει συνθήκες απορροής οι οποίες θα έρχονταν σε αντίθεση με τα υψομετρικά δεδομένα εισόδου πέρα από ένα όριο που εισάγει ο χρήστης. Η ύπαρξη βυθισμάτων ενδέχεται να οφείλεται σε σφάλματα στα αρχικά δεδομένα.
Κατά την έναρξη της διαδικασίας παρεμβολής η παρούσα μέθοδος χρησιμοποιεί τις πληροφορίες που ενυπάρχουν στις ισοϋψείς για την κατασκευή ενός γενικευμένου μοντέλου απορροής. Με τον προσδιορισμό των περιοχών της μέγιστης τοπικής καμπυλότητας σε κάθε ισοϋψή, οι περιοχές με την πιο απότομη κλίση εντοπίζονται και δημιουργείται ένα δίκτυο ρεμάτων και κορυφογραμμών (Hutchinson, 1988). Οι πληροφορίες αυτές χρησιμοποιούνται για να διασφαλιστούν οι ορθές υδρογεωμορφολογικές ιδιοτήτες του ΨΜΕ και μπορούν επίσης να χρησιμοποιηθούν για να ελεγχθεί η ακρίβειά του. Όταν  καθοριστεί η γενική μορφολογία του ΨΜΕ, οι ισοϋψείς χρησιμοποιούνται και για την παρεμβολή των υψομέτρων.
7.6.2.1 Το εργαλείο Topo to Raster
 
Από την εργαλειοθήκη ArcToolbox επιλέγεται 3D Analyst Tools>Raster Interpolation>Topo to Raster. Στο νέο παράθυρο Topo to Raster (Εικόνα 7.22) ορίζονται τα θεματικά επίπεδα, το πεδίο αποθήκευσης του υψομέτρου και το είδος των δεδομένων. Για παράδειγμα, τα μεμονωμένα σημεία γνωστού υψομέτρου ορίζονται ως PointElevation, οι ισοϋψείς ορίζονται ως Contour, το υδρολογικό δίκτυο ορίζεται ως Stream, το όριο της περιοχής κάλυψης ορίζεται ως Boundary, τα βύθισματα ορίζονται ως Sink, η λίμνη ορίζεται ως Lake κ.ά. Επιπλέον ορίζονται το όνομα του ΨΜΕ που θα δημιουργηθεί ως Output surface raster, το μέγεθος του φατνίου ως Output cell size, ενεργοποιείται η επιλογή Drainage enforcement - Enforce, το είδος της πλειοψηφίας των δεδομένων Primary type of data ως ισουψείς (contour) ή μεμονωμένα υψομετρικά σημεία (spot), ο μέγιστος αριθμός επαναλήψεων ως Maximum number of iterations, η παράμετρος Tolerance 1 (καταγράφει το σφάλμα και την πυκνότητα των δεδομένων σε σχέση με το υδρολογικό δίκτυο) τίθεται για τις ισοϋψείς καμπύλες ίση με το μισό της ισοδιάστασης. Επιπλέον, η διαδικασία δημιουργεί παράγωγα προϊόντα τα οποία επιτρέπουν την κριτική αξιολόγηση του ΨΜΕ όπως το υδρολογικό δίκτυο (Output stream polyline feature) και τα βυθίσματα (Output remaining sink point features). Ακόμα, δημιουργείται ένα αρχείο το οποίο καταγράφει τα δεδομένα που χρησιμοποιήθηκαν και τις παραμέτρους του αλγορίθμου και μπορεί να χρησιμοποιηθεί σε μία νέα εκτέλεση του προγράμματος (Output parameter file). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
7.6.2.2 Διόρθωση των βυθισμάτων ενός ΨΜΕ δομής κανάβου
 
Για τη διόρθωση των βυθισμάτων, από το Arc Τοolbox επιλέγεται Spatial Analyst Tools>>Hydrology>Fill. Στο νέο παράθυρο Fill (Εικόνα 7.23) ορίζεται το αρχικό ΨΜΕ ως Input surface raster και το νέο ΨΜΕ ως Output surface raster. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 7.23 Εργαλείο Fill.
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Εικόνα 7.24 Εργαλείο Hillshade.
7.6.2.3 Δημιουργία κανάβου σκίασης από το ΨΜΕ δομής κανάβου
 
Για τη δημιουργία του κανάβου σκίασης του ΨΜΕ, από την εργαλειοθήκη επιλέγεται ArcToolbox>3D Analyst Tools>Raster Surface>Hillshade. Στο νέο παράθυρο Hillshade (Εικόνα 7.24), ορίζονται το ΨΜΕ ως Input Surface, το όνομα του κανάβου όπου θα αποθηκευτεί το αποτέλεσμα της σκίασης ως Output Raster. Οι επιλογές Azimuth και Altitude λαμβάνουν τις προκαθορισμένες τιμές. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
 
 
 
7.6.2.4 Εξαγωγή ισοϋψών καμπυλών από το ΨΜΕ δομής κανάβου 
 
Από την εργαλειοθήκη ArcToolbox επιλέγεται 3D Analyst Tools>Raster Surface>Contour. Στο νέο παράθυρο Contour (Εικόνα 7.25), ορίζεται το όνομα του ΨΜΕ ως Input raster, το διανυσματικό αρχείο όπου θα αποθηκευτούν οι ισοϋψείς καμπύλες ως Output polyline features, η ισοδιάσταση ως Contour Interval και η αφετηρία εφαρμογής της ισοδιάστασης ως Base contour. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 7.25 Εργαλείο Contour.
7.6.2.5 Απόδοση του κανάβου σκίασης αναγλύφου
 
Επιλέγεται ο κάναβος σκίασης του ΨΜΕ και με δεξί κλικ Properties>Symbology. Στην καρτέλα Symbology επιλέγεται Stretched και μια παλέτα με τόνους του γκρι.
7.6.2.6 Απόδοση του ΨΜΕ δομής κανάβου με υψομετρικές ζώνες
 
Επιλέγεται το ΨΜΕ και με δεξί κλικ του ποντικιού Properties>Symbology. Στην καρτέλα Symbology επιλέγεται Stretched ή Classified και μια παλέτα κατάλληλη για τη απόδοση των υψομέτρων. Επιπλέον είναι δυνατή η μεταβολή του χρωματικού σχήματος της παλέτας ή η δημιουργία νέας παλέτας (βλ. Κεφάλαιο 11).
7.6.2.7 Στατιστικά στοιχεία υψομέτρου για ένα ΨΜΕ δομής κανάβου
 
Από το περιβάλλον του ArcCatalog επιλέγεται το ΨΜΕ δομής κανάβου και με δεξί κλικ Properties>Statistics. Στη νέα καρτέλα Raster Data Properties εντοπίζεται η ένδειξη Statistics και οι στατιστικές τιμές για το υψόμετρο π.χ. min, max, mean κ.ά.
7.6.2.8 Προσδιορισμός υψομέτρου διανυσματικών δεδομένων με βάση το ΨΜΕ δομής κανάβου
 
Από την εργαλειοθήκη ArcToolbox επιλέγεται 3D Analyst Tools>Functional Surface>Interpolate Shape. Στο νέο παράθυρο Interpolate Shape (Εικόνα 7.26), ορίζεται το όνομα του ΨΜΕ ως Input Surface, το διανυσματικό αρχείο για το οποίο θα προσδιοριστούν τα υψόμετρα Input Feature Class και το νέο διανυσματικό αρχείο ως Οuput Feature Class. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 7.26 Εργαλείο Interpolate Shape.
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Κριτήρια αξιολόγησης
Στη συνέχεια ακολουθούν μια σειρά από κριτήρια αξιολόγησης με τη μορφή ερωτήσεων των οποίων οι απαντήσεις βρίσκονται εντός του κειμένου του κεφαλαίου. 
Κριτήριο αξιολόγησης 1 
Αναφέρετε τα θεματικά επίπεδα που χρησιμοποιούνται για τη δημιουργία ενός ΨΜΕ.
 
Κριτήριο αξιολόγησης 2 
Τι προβλήματα εισάγουν οι ισοϋψείς καμπύλες στα ΨΜΕ;
 
Κριτήριο αξιολόγησης 3
Ποιες βασικές γεωμορφολογικές δομές μπορεί να αναγνωρίσει ο αναγνώστης του χάρτη και ποια η αντίστοιχη μορφή των ισοϋψών καμπυλών;
Κριτήριο αξιολόγησης 4
Τι είναι τα επίπεδα τρίγωνα σε ένα ΤΙΝ, πώς εντοπίζονται και πώς μπορούν να διορθωθούν;
 
Κριτήριο αξιολόγησης 5
Ποια τα πλεονεκτήματα της μεθόδου “Topo to Raster”;
 
Κριτήριο αξιολόγησης 6
Αναφέρετε μεθόδους αξιολόγησης ενός ΨΜΕ.
Κριτήριο αξιολόγησης 7
Πώς μπορούν να συγκριθούν δύο ΨΜΕ της ίδιας περιοχής;
 
Κριτήριο αξιολόγησης 8
Με ποια κριτήρια επιλέγεται η ανάλυση ενός ΨΜΕ δομής κανάβου;
 
Κεφάλαιο 8
Υδρολογική ανάλυση με βάση το ΨΜΕ
Σύνοψη 
Στο κεφάλαιο αυτό, παρουσιάζεται ένα τυπικό παράδειγμα αξιοποίησης του Ψηφιακού Μοντέλου Εδάφους  (ΨΜΕ), στο γνωστικό αντικείμενο των Υδατικών Πόρων με τη βοήθεια της τεχνολογίας των Συστημάτων Γεωγραφικών Πληροφοριών (ΓΣΠ). Αναλύονται τα θέματα που αφορούν τον προσδιορισμό των κανάβων διεύθυνσης απορροής και συγκεντρωτικής ροής, καθώς και τον προσδιορισμό των ορίων της λεκάνης απορροής και του υδρογραφικού δικτύου. Γίνεται αναφορά στις μεθόδους ιεράρχησης των κλάδων του υδρογραφικού δικτύου και στον υπολογισμό παράγωγων μετρητικών στοιχείων των υδρογραφικών σχηματισμών οι οποίοι προέκυψαν από το ΨΜΕ όπως: εμβαδόν, μέσο υψόμετρο και κλίσεις της λεκάνης απορροής και μήκος, μήκος ανά τάξη, μέση κλίση κυρίου κλάδου, μηκοτομή κυρίου κλάδου, διατομές σε χαρακτηριστικά σημεία για το υδρογραφικό δίκτυο. Ακολουθεί λεπτομερής περιγραφή για την υλοποίηση των παραπάνω σε περιβάλλον Συστήματος Γεωγραφικών Πληροφοριών.
Προαπαιτούμενη γνώση 
Δημιουργία Ψηφιακού Μοντέλου Εδάφους (βλ. Κεφάλαιο 7). Βασικές αρχές Υδρολογικής Ανάλυσης.
8. Υδρολογική ανάλυση 
 
Μία από τις εφαρμογές των Ψηφιακών Μοντέλων Εδάφους, είναι η αξιοποίησή τους στη μελέτη των υδρογραφικών χαρακτηριστικών μιας περιοχής. Πιο συγκεκριμένα, χρησιμοποιείται για τον προσδιορισμό των ορίων των λεκανών απορροής, του υδρογραφικού δικτύου και τον υπολογισμό διαφόρων στατιστικών μεγεθών, τα οποία αποτελούν αντικείμενο της υδρολογικής ανάλυσης. Το ΨΜΕ χρησιμοποιείται για τη μελέτη του αναγλύφου ως προς τα μορφολογικά (ή φυσιογραφικά) του χαρακτηριστικά. Αυτά αποτελούν ορισμένους από τους παράγοντες οι οποίοι επηρεάζουν την απορροή των επιφανειακών υδάτων που προκύπτουν από τα ατμοσφαιρικά κατακρημνίσματα κι επομένως, επιδρούν στη διαμόρφωση των λεκανών απορροής και του υδρογραφικού δικτύου. Η επιφανειακή απορροή αποτελεί μέρος του υδρολογικού κύκλου και δημιουργείται από το νερό των ατμοσφαιρικών κατακρημνίσεων που δεν απορροφάται από το έδαφος, εφόσον υπάρχει κατάλληλη κλίση και βάθος ροής (Μιμίκου, 2006). 
Η λεκάνη απορροής (ή υδρολογική λεκάνη) είναι η περιοχή του εδάφους που συγκεντρώνει τα όμβρια ύδατα και τα διοχετεύει σε ένα υδρολογικό σύστημα (υδατόρευμα, ποτάμι, λίμνη, θάλασσα). Η επιφανειακή απορροή η οποία προκύπτει από τα ατμοσφαιρικά κατακρημνίσματα είναι από τις σπουδαιότερες διεργασίες που παρατηρούνται σε μια υδρολογική λεκάνη, και περιλαμβάνει επίγειες και υπεδάφιες ροές (Κουτσογιάννης & Ξανθόπουλος, 1999). Επειδή επηρεάζεται από τα γεωμορφολογικά χαρακτηριστικά της λεκάνης, είναι αναγκαία η αριθμητική έκφραση των χαρακτηριστικών αυτών (Τσακίρης, 1995). Τα μορφομετρικά χαρακτηριστικά της λεκάνης απορροής τα οποία επηρεάζουν τη μελέτη των υδρολογικών χαρακτηριστικών μιας περιοχής (Τσακίρης, 1995) είναι:
 
	το μέγεθος,
	το σχήμα,
	το υψόμετρο,
	το ανάγλυφο,
	οι κλίσεις.

 
Το υδρογραφικό δίκτυο είναι ένα οργανωμένο δίκτυο συγκέντρωσης (αποχέτευσης) των επιφανειακών υδάτων που απορρέουν και αποτελείται από κλάδους διαφόρων μεγεθών. Οι αρχικοί κλάδοι είναι συνήθως μικρά, εφήμερα ρεύματα, τα οποία βρίσκονται στα τμήματα του εδάφους με μεγαλύτερο υψόμετρο και οδηγούν το νερό σε μεγαλύτερα κανάλια και ποτάμια κι από εκεί καταλήγει στη θάλασσα. Οι κλάδοι συνδέονται μεταξύ τους και εκείνοι που βρίσκονται σε χαμηλότερα υψόμετρα (κατάντη) δέχονται τα ύδατα από εκείνους που βρίσκονται σε ψηλότερα (ανάντη). Οι κλάδοι του υδρογραφικού δικτύου διακρίνονται ιεραρχικά σε τάξεις, σύμφωνα με διάφορες μεθόδους ταξινόμησης (π.χ. Horton, Strahler, Shreve, Scheidegger) (Τσακίρης, 1995). Ανεξάρτητα από τη μέθοδο ταξινόμησης, οι κλάδοι της μικρότερης τάξης είναι εκείνοι στους οποίους δεν συμβάλλουν άλλοι κλάδοι, δηλαδή είναι οι κλάδοι χωρίς ανάντη συμβολές. Στη μελέτη του υδρογραφικού δικτύου, περιλαμβάνονται ο προσδιορισμός του μήκους, της πυκνότητας (μήκος ανά μονάδα επιφανείας της λεκάνης απορροής) και τα χαρακτηριστικά του κυρίου ρεύματος, όπως το συνολικό μήκος, η κλίση –είτε αριθμητικά είτε ως γράφημα (μηκοτομή)– και το σχήμα της διατομής (Τσακίρης, 1995). 
Οι μορφολογικές δομές (Κεφάλαιο 7, §7.1.1) οι οποίες επηρεάζουν την υδρολογική κατάσταση μιας περιοχής, επιγραμματικά, είναι:
 
	οι κορυφογραμμές (υδροκρίτης),
	οι κλιτύες (πλαγιές), 
	οι μισγάγγειες (υδατορεύματα).
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Εικόνα 8.1 Μοντέλο Απορροής Διευθύνσεων D8.
Η διαδρομή που ακολουθούν τα ατμοσφαιρικά κατακρημνίσματα στην επιφάνεια του εδάφους –είτε αυτά προέρχονται από άμεση κατακρήμνιση, είτε οφείλονται στον κορεσμό του εδάφους– εξαρτάται άμεσα από τις υψομετρικές διαφορές, την κλίση του εδάφους και τον προσανατολισμό της επιφάνειας όπου κινούνται. Για τον λόγο αυτό, έχουν αναπτυχθεί διάφορα μοντέλα προσδιορισμού της διεύθυνσης απορροής με βάση ένα ΨΜΕ, εκ των οποίων το Μοντέλο Απορροής 8 Διευθύνσεων (Jensen & Domingue, 1988) είναι εκείνο με την ευρύτερη χρήση (Εικόνα 8.1). Με βάση το μοντέλο αυτό:
 
	Κάθε φατνίο του ΨΜΕ εξετάζεται σε σχέση με τα γειτονικά φατνία. 
	Υπολογίζονται οι κλίσεις με βάση τις υψομετρικές διαφορές.
	Προσδιορίζεται η διεύθυνση της μέγιστης κλίσης.

 
 Η διεύθυνση της μέγιστης κλίσης είναι η διεύθυνση απορροής του νερού στην επιφάνεια του εδάφους, οπότε το φατνίο κωδικοποιείται αναλόγως (Εικόνα 8.2) λαμβάνοντας μία από τις τιμές 1, 2, 4, 8, 16, 32, 64, 128. Τα δεδομένα αποθηκεύονται σε κανονικοποιημένη δομή (raster), ως κάναβος διεύθυνσης απορροής. 
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Εικόνα 8.2 Κωδικοποίηση των διευθύνσεων στο μοντέλο D8.
Όπως παρουσιάζεται και στο διάγραμμα ροής των εργασιών (Εικόνα 8.3), από τον κάναβο διευθύνσεων απορροής, παράγεται άμεσα το κανονικοποιημένο αρχείο (raster) της λεκάνης απορροής, το οποίο εν συνεχεία μπορεί να μετατραπεί σε διανυσματική δομή (vector) από όπου μπορούν να υπολογιστούν διάφορα γεωμετρικά στοιχεία (π.χ. εμβαδόν). Από το κανονικοποιημένο αρχείο προκύπτουν στοιχεία τα οποία είναι χρήσιμα στην υδρολογική μελέτη, όπως το μέγιστο, το ελάχιστο και το μέσο υψόμετρο. Για τον προσδιορισμό του υδρογραφικού δικτύου, χρειάζεται να προσδιοριστούν οι περιοχές εκείνες του εδάφους, όπου συγκεντρώνονται τα επιφανειακά ύδατα. Αυτό επιτυγχάνεται με τη δημιουργία του κανάβου συγκεντρωτικής ροής που προκύπτει από τον κάναβο διευθύνσεων απορροής. Σε κάθε φατνίο του κανάβου συγκεντρωτικής ροής αποθηκεύεται το πλήθος των φατνίων τα οποία απορρέουν σ’ αυτό (Εικόνα 8.4). Το υδρογραφικό δίκτυο προκύπτει σε κανονικοποιημένη (raster) δομή, με την εφαρμογή ενός ορίου το οποίο καθορίζει το ελάχιστο πλήθος γειτονικών φατνίων που πρέπει να απορρέουν σε κάθε φατνίο, ώστε αυτό να ανήκει στο υδρογραφικό δίκτυο (Εικόνα 8.5). Το όριο αυτό προσδιορίζεται εμπειρικά, με διαδοχικές προσεγγίσεις. Στη συνέχεια, γίνεται η ιεράρχηση των κλάδων του υδρογραφικού δικτύου σε τάξεις, σύμφωνα με κάποια μέθοδο ταξινόμησης και ανάλογα με τις απαιτήσεις του χρήστη και τις δυνατότητες του λογισμικού. Για περαιτέρω αξιοποίηση μετατρέπεται σε διανυσματική δομή, προκειμένου να εξαχθούν γεωμετρικά στοιχεία (μήκος, μήκος ανά τάξη κλπ.)τα οποία χρησιμοποιούνται στην υδρολογική ανάλυση και –αν υποστηρίζεται από το λογισμικό– μετατρέπεται σε τρισδιάστατη δομή (3D) για τη δημιουργία μηκοτομών και διατομών. 
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Εικόνα 8.3 Η ροή εργασιών για την υδρολογική ανάλυση σε ψηφιακό περιβάλλον.
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Εικόνα 8.4 Κάναβος συγκεντρωτικής ροής.
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Εικόνα 8.5 Ο προσδιορισμός του υδρογραφικού δικτύου σε κανονικοποιημένη δομή.
 
 
 
 
8.1. Η υδρολογική ανάλυση στο QGIS
 
Τα εργαλεία για την υδρολογική ανάλυση εντάσσονται στην ομάδα εργαλείων Processing>Toolbox τα οποία βρίσκονται στο βασικό μενού του QGIS (Παράρτημα Α) (“QGIS Training Manual”, χ.η.; “QGIS User Guide”, χ.η.). Για τη λειτουργία τους απαιτείται η ενεργοποίηση των εξωτερικών εφαρμογών GRASS, SAGA και TAU από την καρτέλα ρυθμίσεων Processing>Options>Πάροχοι.
8.1.1 Δημιουργία Υδρογραφικού Δικτύου και Λεκανών Απορροής
 
Το εργαλείο Processing>Toolbox>Geoalgorithms>Domain specific>Hydrology>Channel network and drainage basins δημιουργεί τα κύρια προϊόντα της υδρολογικής ανάλυσης. Στο παράθυρο του εργαλείου αυτού και στην καρτέλα Parameters, το πεδίο Elevation συμπληρώνεται με το κανονικοποιημένο αρχείο (geotif) του ΨΜΕ. Το πεδίο Elevation είναι το μόνο υποχρεωτικό πεδίο αυτού του εργαλείου. Στα υπόλοιπα πεδία (η συμπλήρωση των οποίων είναι προαιρετική) δημιουργούνται αυτόματα τα αντίστοιχα προϊόντα της υδρολογικής ανάλυσης (Εικόνα 8.6). Αποθηκεύονται σε προσωρινά αρχεία (κανονικοποιημένα ή διανυσματικά) και εμφανίζονται στο τρέχον έργο του QGIS. Εάν είναι επιθυμητό, αποθηκεύονται σε μόνιμα αρχεία, αλλάζοντας την επιλογή αποθήκευσης από το αντίστοιχο πλήκτρο (Εικόνα 8.6). Το εργαλείο εκτελείται με το πλήκτρο Run. Μεταξύ των αποτελεσμάτων του εργαλείου αυτού είναι η δημιουργία:
 
	Του κανάβου διεύθυνσης απορροής (Flow Direction).
	Του κανάβου συνεκτικότητας απορροής (Flow Connectivity). 
	Των λεκανών απορροής (Drainage basins) σε κανονικοποιημένη δομή.
	Του υδρογραφικού δικτύου σε κανονικοποιημένη (Strahler Order) και σε διανυσματική (Channels) δομή, ιεραρχημένου σύμφωνα με τη μέθοδο Strahler .
	Των σημείων ενδιαφέροντος (Junctions) των κλάδων του υδρογραφικού δικτύου των κλάδων του υδρογραφικού δικτύου (π.χ. πηγές, διασταυρώσεις, απολήξεις).

 
8.1.2 Υπολογισμός του μήκους του Υδρογραφικού Δικτύου
 
Ο υπολογισμός του συνολικού μήκους του υδρογραφικού δικτύου γίνεται από το βασικό μενού του QGIS (Παράρτημα Α), με το εργαλείο Διανύσματα>Εργαλεία ανάλυσης>Basic statistics. Στο εργαλείο αυτό, συμπληρώνονται:
 
	Το πεδίο Input layer vector: το διανυσματικό θεματικό επίπεδο του υδρογραφικού δικτύου για το οποίο θα γίνει υπολογισμός.
	Το πεδίο Πεδίο προορισμού: επιλέγεται το πεδίο LENGTH.
	Προαιρετικά, ενεργοποιείται (checkbox) το πεδίο Χρησιμοποιείτε μόνο επιλεγμένα χαρακτηριστικά εάν είναι επιθυμητό οι υπολογισμοί να γίνουν μόνο για τα (τυχόν) επιλεγμένα στοιχεία (π.χ. για τον υπολογισμό του μήκους ανά τάξη – βλ. §8).

 
Η εκτέλεση των υπολογισμών γίνεται με το πλήκτρο OK και τα αποτελέσματα εμφανίζονται στο χώρο Statistics output. Στα στατιστικά αποτελέσματα εμφανίζεται και το Άθροισμα που δίνει το ζητούμενο συνολικό μήκος. 
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Εικόνα 8.6 Το εργαλείο δημιουργίας προϊόντων υδρολογικής ανάλυσης στο QGIS.
8.1.3 Μετατροπή των λεκανών απορροής από κανονικοποιημένη σε διανυσματική δομή
 
Η μετατροπή του αρχείου το οποίο περιέχει τις λεκάνες απορροής, από κανονικοποιημένη σε διανυσματική δομή, γίνεται με το εργαλείο Processing>Toolbox>Geoalgorithms>Domainspecific>Raster-Vector>Raster→Vector>Vectorize Raster layer. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input layer: το κανονικοποιημένο αρχείο όπου αποθηκεύτηκαν οι λεκάνες απορροής (§8.1.1).
	Στο πεδίο Output layer: το θεματικό επίπεδο όπου θα αποθηκευτούν οι λεκάνες απορροής σε διανυσματική δομή.

 
Ο πίνακας περιγραφικών χαρακτηριστικών (attributes table) περιλαμβάνει μόνο ένα πεδίο (DN), οπότε απαιτείται να συμπληρωθεί με τα πεδία των γεωμετρικών χαρακτηριστικών, καθώς κι ενός μοναδικού αριθμού εντοπισμού (ID) για περαιτέρω αξιοποίηση. Με δεξί κλικ στο όνομα του θεματικού επιπέδου και την επιλογή Open Attributes Table, ανοίγει το παράθυρο επεξεργασίας του πίνακα. Η δημιουργία νέου πεδίου ιδιοτήτων και η ενημέρωση των τιμών του περιγράφονται στο Κεφάλαιο 9 §9.3.4.
8.1.4 Προσδιορισμός του εμβαδού της κύριας λεκάνης απορροής και δημιουργία νέου θεματικού επιπέδου που περιέχει μόνο το πολύγωνο της κύριας λεκάνης απορροής
 
Στο QGIS, η κύρια λεκάνη απορροής μπορεί να αναγνωριστεί οπτικά στο περιβάλλον του έργου (project). Στην περίπτωση αυτή, με το εργαλείο προσδιορισμού χαρακτηριστικών από το βασικό μενού (Παράρτημα Α), εντοπίζεται το πολύγωνό της και τα περιγραφικά του χαρακτηριστικά. Εάν ο οπτικός εντοπισμός δεν αρκεί, ο προσδιορισμός της κύριας λεκάνης απορροής γίνεται με την εύρεση του πολυγώνου με το μεγαλύτερο εμβαδόν. Στο παράθυρο επεξεργασίας του πίνακα περιγραφικών χαρακτηριστικών (§8.1.3) και με κλικ στο όνομα του πεδίου του εμβαδού (AREA), γίνεται ταξινόμηση των εγγραφών του πεδίου κατά αύξουσα σειρά. Με νέο κλικ, η σειρά ταξινόμησης γίνεται φθίνουσα, οπότε εμφανίζεται ως πρώτη εγγραφή το πολύγωνο με το μεγαλύτερο εμβαδόν. Αφού επιλεγεί το συγκεκριμένο πολύγωνο, με δεξί κλικ στο όνομα του θεματικού επιπέδου και την επιλογή Αποθήκευση ως... δίνεται το όνομα και ο τύπος του νέου θεματικού επιπέδου, που θα περιέχει μόνο το πολύγωνο της κύριας λεκάνης απορροής.
Το εμβαδόν της λεκάνης απορροής χρησιμεύει στον υπολογισμό της πυκνότητας του υδρογραφικού δικτύου (§8.1.2), η οποία προκύπτει ως το πηλίκο του μήκους του υδρογραφικού δικτύου προς το εμβαδόν της υδρολογικής λεκάνης, εκφράζεται δηλαδή ως μήκος ανά μονάδα επιφανείας (Τσακίρης, 1995).
8.1.5. Δημιουργία ενός νέου ΨΜΕ που περιέχει μόνο την κύρια λεκάνη απορροής και εξαγωγή στατιστικών στοιχείων του υψομέτρου 
 
Η δημιουργία ενός νέου ΨΜΕ που περιέχει μόνο την κύρια λεκάνη απορροής, γίνεται από το βασικό μενού, με το εργαλείο Processing>Toolbox>Geoalgorithms>Raster>Raster-Vector>Raster-Vectoroperations>Clip grid with polygon που περιγράφεται στο Κεφάλαιο 7, §7.5.2.
8.1.6 Δημιουργία κανονικοποιημένου αρχείου κλίσεων από το ΨΜΕ της κύριας λεκάνης απορροής
 
Η διαδικασία δημιουργίας κανονικοποιημένου αρχείου κλίσεων περιγράφεται στο Κεφάλαιο 7, §7.5.5.
8.1.7 Επιλογή υδρογραφικού δικτύου το οποίο βρίσκεται εντός της κύριας λεκάνης απορροής
 
Η επιλογή του υδρογραφικού δικτύου το οποίο βρίσκεται εντός της κύριας λεκάνης απορροής, γίνεται με το εργαλείο Διανύσματα>Geoprocessing Εργαλεία>Clip όπως περιγράφεται στο Κεφάλαιο 4 §4.4. Ο υπολογισμός του μήκους, περιγράφεται στην §8.1.2.
8.2. Η υδρολογική ανάλυση στο ArcGIS
 
Τα εργαλεία για την υδρολογική ανάλυση στο ArcGIS βρίσκονται στο ArcToolbox (βλ. Παράρτημα Β), το οποίο είναι διαθέσιμο τόσο σε περιβάλλον ArcCatalog, όσο και σε περιβάλλον ArcMap (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β; Τσούλος, Σκοπελίτη & Στάμου, 2015γ). Ως βασική πηγή δεδομένων, απαιτείται ένα υδρολογικά ορθό ΨΜΕ (Κεφάλαιο 7).
8.2.1 Δημιουργία κανάβου διεύθυνσης απορροής
 
Μετά τη δημιουργία του υδρολογικά ορθού ΨΜΕ, δημιουργείται το αρχείο του κανάβου διεύθυνσης απορροής (Εικόνα 8.7), με το εργαλείο Arc Τοolbox>Spatial Analyst Tools >Hydrology>Flow Direction. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input surface raster: το κανονικοποιημένο αρχείο του ΨΜΕ.
	Στο πεδίο Output flow direction raster: το κανονικοποιημένο αρχείο όπου θα αποθηκευτεί ο κάναβος της διεύθυνσης απορροής.
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Εικόνα 8.7 Δημιουργία του κανάβου διεύθυνσης απορροής από το ΨΜΕ.
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Εικόνα 8.8 Δημιουργία του κανάβου συγκεντρωτικής ροής από τον κάναβο διεύθυνσης απορροής.
8.2.2 Δημιουργία κανάβου συγκεντρωτικής ροής
 
Η δημιουργία αρχείου του κανάβου συγκεντρωτικής ροής από τον κάναβο διεύθυνσης απορροής (Εικόνα 8.8), γίνεται με το εργαλείο Arc Τοolbox>Spatial Analyst Tools>Hydrology>Flow Accumulation. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input flow direction raster: το κανονικοποιημένο αρχείο όπου αποθηκεύτηκε ο κάναβος της διεύθυνσης απορροής (§8.2.1).
	Στο πεδίο Output accumulation raster: το κανονικοποιημένο αρχείο όπου θα αποθηκευτεί ο κάναβος της συγκεντρωτικής ροής.

 
8.2.3 Εξαγωγή Υδρογραφικού Δικτύου
 
Το υδρογραφικό δίκτυο σε κανονικοποιημένη δομή δημιουργείται από τον κάναβο συγκεντρωτικής ροής (Εικόνα 8.9) με το εργαλείο Arc Τοolbox>Spatial Analyst>Reclass>Reclassify. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input Raster: το κανονικοποιημένο αρχείο όπου αποθηκεύτηκε ο κάναβος της συγκεντρωτικής ροής (§8.2.2).
	Στο πεδίο Reclass field: Value.
	Από το πλήκτρο Classify ορίζονται Classification Method: Natural Breaks (Jenks), Classification Classes: 2, Break Values: αλλαγή της μικρότερης τιμής με το όριο επιλογής φατνίων υδρολογικού δικτύου π.χ. 5000. Επιστροφή στο μενού του εργαλείου Reclassify με το πλήκτρο ΟΚ.
	Στον πίνακα Reclassification, επιλέγεται και διαγράφεται με το πλήκτρο Delete entries, η ομάδα με τιμές φατνίων μικρότερες από το όριο.
	Στο πεδίο Output data: το κανονικοποιημένο αρχείο όπου θα αποθηκευτούν τα φατνία του υδρολογικού δικτύου.
	Ενεργοποιείται η επιλογή Change missing values to No Data.
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Εικόνα 8.9 Δημιουργία του υδρογραφικού δικτύου σε κανονικοποιημένη δομή, από τον κάναβο συγκεντρωτικής ροής.
Διευκρινίζεται ότι ο προσδιορισμός του ορίου επιλογής φατνίων του υδρολογικού δικτύου γίνεται με διαδοχικές προσεγγίσεις. Η μεθοδολογία αυτή είναι πιο αποτελεσματική αν γίνει αρχικά σε περιβάλλον ArcMap με τη διαδικασία που περιγράφεται στο Κεφάλαιο 10, §10.8.13.1. Ως μέθοδος συμβολισμού του κανάβου συγκεντρωτικής ροής επιλέγεται η μέθοδος Symbology>Classified. Η κατηγοριοποίηση των δεδομένων γίνεται με το πλήκτρο Classify, το οποίο αναδύει το σχετικό μενού, μέσω του οποίου ορίζονται ως μέθοδος ταξινόμησης η μέθοδος Νatural breaks και το πλήθος των κλάσεων ίσο με 2. Οι δοκιμές γίνονται αλλάζοντας την μικρότερη τιμή, δηλαδή το άνω όριο της πρώτης κλάσης. Αν, για παράδειγμα, το όριο είναι 5000, αυτό σημαίνει ότι τα φατνία του κανάβου με τιμές 0 – 5000 θα είναι εκτός υδρογραφικού δικτύου, ενώ τα φατνία με τιμές μεγαλύτερες του 5000 θα συγκροτούν το υδρογραφικό δίκτυο.
 
 
8.2.4 Ιεράρχηση Υδρογραφικού Δικτύου
 
Η ιεράρχηση του υδρογραφικού δικτύου γίνεται (Εικόνα 8.10) με το εργαλείο Arc Τοolbox>Spatial Analyst Tools>Hydrology >Stream Order. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input Stream raster: το κανονικοποιημένο αρχείο του υδρογραφικού δικτύου (§8.2.3).
	Στο πεδίο Input flow direction raster: ο κάναβος της διεύθυνσης απορροής (§8.2.1).
	Στο πεδίο Output raster: το κανονικοποιημένο αρχείο όπου θα αποθηκευτεί το υδρογραφικό δίκτυο με τους κωδικούς ιεράρχησης.
	Στο πεδίο Method of stream ordering (optional): STRAHLER ή SHREVE. Η προεπιλεγμένη (default) μέθοδος είναι STRAHLER.
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Εικόνα 8.10 Δημιουργία ιεραρχημένου υδρογραφικού δικτύου σε κανονικοποιημένη δομή, από το κανονικοποιημένο αρχείο υδρογραφικού δικτύου.
8.2.5 Εξαγωγή Υδρογραφικού Δικτύου σε διανυσματική δομή
 
Η εξαγωγή (μετατροπή) του υδρογραφικού δικτύου σε διανυσματική δομή γίνεται με το εργαλείο Arc Τοolbox>Spatial Analyst Tools>Hydrology>Stream to Feature. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input stream raster: το κανονικοποιημένο αρχείο όπου αποθηκεύτηκε το υδρολογικό δίκτυο με τους κωδικούς ιεράρχησης (§8.2.4).
	Στο πεδίο Input flow direction raster: το κανονικοποιημένο αρχείο όπου αποθηκεύτηκε ο κάναβος της διεύθυνσης απορροής (§8.2.1).
	Στο πεδίο Output polyline features: το νέο θεματικό επίπεδο όπου θα αποθηκευτεί το υδρολογικό δίκτυο σε διανυσματική δομή.

8.2.6 Υπολογισμός μήκους Υδρογραφικού Δικτύου 
 
Ο υπολογισμός του συνολικού μήκους γίνεται είτε στο περιβάλλον χαρτοσύνθεσης ArcMap είτε στο περιβάλλον ArcCatalog. Με αριστερό κλικ στο όνομα του θεματικού επιπέδου των υδατορευμάτων και στη συνέχεια με δεξί κλικ, επιλέγεται Open Attribute Table. Ακολούθως, επιλέγεται (με αριστερό κλικ) το πεδίο Shape_Length και με δεξί κλικ Statistics, οπότε παράγεται ένα γράφημα στατιστικών στο οποίο αναγράφονται τα στατιστικά στοιχεία για το επιλεγμένο πεδίο (Shape_Length), μεταξύ των οποίων είναι και το συνολικό μήκος, ως το άθροισμα (Sum) του μήκους του συνόλου των οντοτήτων που περιέχει το θεματικό επίπεδο.
Ο υπολογισμός μήκους ανά κατηγορία ιεράρχησης (τάξης) του υδρογραφικού δικτύου γίνεται σε περιβάλλον χαρτοσύνθεσης (ArcMap). Με αριστερό κλικ στο όνομά του επιλέγεται το θεματικό επίπεδο των υδατορευμάτων και στη συνέχεια με δεξί κλικ, επιλέγεται Open Attribute Table. Ακολούθως, με αριστερό κλικ επιλέγεται το πεδίο Grid_code και με δεξί κλικ Summarize. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Select a field to summarize: ορίζεται το πεδίο Grid_code.
	Στο πεδίο Choose one or more summary statistics to be included in the output table επιλέγεται Shape_Length (Sum). 
	Στο πεδίο Specify output table: το όνομα του πίνακα όπου θα αποθηκευτούν τα στατιστικά στοιχεία.

8.2.7 Λεκάνες Απορροής
 
Οι λεκάνες απορροής δημιουργούνται από τον κάναβο διεύθυνσης απορροής (Εικόνα 8.11) με το εργαλείο Arc Τοolbox>Spatial Analyst Tools>Hydrology>Basin. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input flow direction raster: το κανονικοποιημένο αρχείο όπου αποθηκεύτηκε ο κάναβος της διεύθυνσης απορροής (§8.2.1).
	Στο πεδίο Output raster: το κανονικοποιημένο αρχείο όπου θα αποθηκευτούν οι λεκάνες απορροής της περιοχής.
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Εικόνα 8.11 Δημιουργία του κανονικοποιημένου αρχείου των λεκανών απορροής, από τον κάναβο διεύθυνσης απορροής.
8.2.8 Μετατροπή της λεκάνης απορροής από κανονικοποιημένη σε διανυσματική δομή
 
Η μετατροπή του αρχείου που περιέχει τις λεκάνες απορροής από κανονικοποιημένη σε διανυσματική δομή, γίνεται με το εργαλείο Arc Toolbox>Conversion tools>From Raster>Raster to Polygon. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input Raster: το κανονικοποιημένο αρχείο όπου αποθηκεύτηκαν οι λεκάνες απορροής (§8.2.7).
	Στο πεδίο Output polygon features: το θεματικό επίπεδο όπου θα αποθηκευτούν οι λεκάνες απορροής σε διανυσματική δομή.

8.2.9 Προσδιορισμός του εμβαδού της κύριας λεκάνης απορροής και δημιουργία νέου θεματικού επιπέδου που περιέχει μόνο το πολύγωνο της κύριας λεκάνης απορροής
 
Ο προσδιορισμός της κύριας λεκάνης απορροής γίνεται με την εύρεση του πολυγώνου με το μεγαλύτερο εμβαδόν. Σε περιβάλλον ArcMap, επιλέγεται (με αριστερό κλικ) το θεματικό επίπεδο των υδρολογικών λεκανών και ακολούθως με δεξί κλικ γίνεται η επιλογή Open Attribute Table. Στον πίνακα ιδιοτήτων, επιλέγεται (με αριστερό κλικ) το πεδίο Shape_Area και ταξινομείται κατά φθίνουσα σειρά, λειτουργία που εκτελείται με δεξί κλικ και Sort Descending. Ο αριθμός OBJECTID του πολυγώνου με το μέγιστο εμβαδό (π.χ. OBJECTID = 5) είναι το στοιχείο το οποίο θα χρησιμοποιηθεί για τη δημιουργία του νέου αρχείου που θα περιλαμβάνει την κύρια λεκάνη απορροής. Στο εργαλείο Arc Toolbox>Analysis Tools>Extract>Select, δίνονται:
 
	Στο πεδίο Input Features: το όνομα του διανυσματικού αρχείου όπου έχουν αποθηκευτεί οι λεκάνες απορροής (§8.2.8).
	Στο πεδίο Output Feature Class: το όνομα του νέου διανυσματικού αρχείου. 
	Στο πεδίο Expression: συντάσσεται μια λογική έκφραση SQL για την επιλογή του συγκεκριμένου πολυγώνου (π.χ. OBJECTID = 5).

 
Το εμβαδόν της λεκάνης απορροής χρησιμεύει στον υπολογισμό της πυκνότητας του υδρογραφικού δικτύου (§8.2.6), η οποία προκύπτει ως το πηλίκο του μήκους του υδρογραφικού δικτύου ανά μονάδα επιφανείας της υδρολογικής λεκάνης (Τσακίρης, 1995).
8.2.10. Δημιουργία ενός νέου ΨΜΕ το οποίο περιέχει μόνο την κύρια λεκάνη απορροής και εξαγωγή στατιστικών στοιχείων του υψομέτρου
 
Για να εξαχθούν στατιστικά στοιχεία σχετικά με το υψόμετρο της κύριας λεκάνης απορροής, χρειάζεται να δημιουργηθεί ένα ΨΜΕ το οποίο περιέχει μόνο αυτήν. Η δημιουργία αυτού του αρχείου, γίνεται με το εργαλείο Arc Toolbox >Spatial Analyst Tools>Extraction>Extract by Mask. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input raster: το κανονικοποιημένο αρχείο όπου αποθηκεύτηκαν οι λεκάνες απορροής (§8.2.7)
	Στο πεδίο Input raster or feature mask data: το διανυσματικό αρχείο το οποίο περιέχει μόνο την κύρια λεκάνη απορροής (§8.2.9).
	Στο πεδίο Output raster: το κανονικοποιημένο αρχείο ΨΜΕ το οποίο περιορίζεται στα όρια της κύριας λεκάνης απορροής.

 
Με δεξί κλικ επάνω στο νέο ΨΜΕ και με την επιλογή Properties>Source>Property, στην ομάδα Statistics καταγράφονται το ελάχιστο, το μέγιστο και το μέσο υψόμετρο (Min, Max, Mean) που αποτελούν μέρος της υδρολογικής ανάλυσης (Τσακίρης, 1995).
8.2.11 Δημιουργία κανονικοποιημένου αρχείου κλίσεων από το ΨΜΕ της κύριας λεκάνης απορροής
 
Το κανονικοποιημένο αρχείο των κλίσεων της κύριας λεκάνης απορροής, δημιουργείται με το εργαλείο Arc Toolbox>3D Analyst>Surface analysis >Slope. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input surface: το αρχείο ΨΜΕ της κύριας λεκάνης απορροής.
	Στο πεδίο Output measurement: Degree / Percent - Επιλέγεται η έκφραση της κλίσης σε μοίρες ή ποσοστό %. 
	Στο πεδίο Output raster: το νέο κανονικοποιημένο αρχείο όπου θα αποθηκευτούν οι κλίσεις.

 
8.2.12 Επιλογή υδρογραφικού δικτύου το οποίο βρίσκεται εντός της κύριας λεκάνης απορροής
 
Η επιλογή του υδρογραφικού δικτύου το οποίο βρίσκεται εντός της κύριας λεκάνης απορροής, γίνεται με το εργαλείο ArcToolbox>Analysis Tools>Extract>Clip. Στο παράθυρο του εργαλείου αυτού, συμπληρώνονται:
 
	Στο πεδίο Input Features: το διανυσματικό αρχείο του υδρογραφικού δικτύου (§8.2.5).
	Στο πεδίο Clip Features: το διανυσματικό αρχείο με το πολύγωνο κύριας λεκάνης απορροής (§8.2.9).
	Στο πεδίο Output Feature Class: το όνομα ενός νέου διανυσματικού αρχείου όπου θα αποθηκευτεί το τμήμα του υδρολογικού δικτύου το οποίο βρίσκεται εντός της κύριας λεκάνης απορροής.

8.2.13 Επιλογή και ενοποίηση τμημάτων του υδρογραφικού δικτύου ίδιας τάξης
 
Για την καλύτερη διαχείριση του υδρογραφικού δικτύου, χρειάζεται να συνενωθούν (merge) οι διαδοχικοί κλάδοι ίδιας τάξης. Αυτό γίνεται σε περιβάλλον ArcMap>Editor, όπως περιγράφεται στο Κεφάλαιο 3, §3.6.
8.2.14 Μετατροπή του υδρογραφικού δικτύου σε τρισδιάστατη οντότητα
 
Η μετατροπή του υδρογραφικού δικτύου σε τρισδιάστατη οντότητα απαιτείται για την κατασκευή μηκοτομών και διατομών. Η μετατροπή αυτή γίνεται με το εργαλείο 3D Analyst>Functional Surface>Interpolate Shape. Στο παράθυρο του συγκεκριμένου εργαλείου, συμπληρώνονται:
 
	Στο πεδίο Input Surface: το όνομα του ΨΜΕ.
	Στο πεδίο Input feature Class: το διανυσματικό αρχείο με το τμήμα του υδρολογικού δικτύου εντός της κύριας λεκάνης απορροής (με τους ενοποιημένους κλάδους - §8.2.13).
	Στο πεδίο Output feature Class: ένα νέο διανυσματικό αρχείο τρισδιάστατων δεδομένων (3D).

8.2.15 Δημιουργία μηκoτομής κατά μήκος τμήματος του υδρογραφικού δικτύου
 
Η μηκοτομή δημιουργείται σε περιβάλλον χαρτοσύνθεσης (ArcMap), με συνδυασμό των θεματικών επιπέδων του ΨΜΕ και του 3D υδρολογικού δικτύου. Με το εργαλείο επιλογής (Παράρτημα Β, §Β.5.8, Εικόνα Β.16) επιλέγεται η οντότητα από το θεματικό επίπεδο των τρισδιάστατων δεδομένων, για την οποία θα δημιουργηθεί η μηκοτομή. Προστίθεται η γραμμή εργαλείων 3D Analyst και με το εργαλείο Create Profile, η μηκοτομή εμφανίζεται ως γράφημα σε ένα νέο παράθυρο (Εικόνα 8.12 και Εικόνα 8.13). Από την υψομετρική διαφορά και το μήκος της μηκοτομής μπορεί να υπολογιστεί η κλίση του συγκεκριμένου τμήματος του υδρογραφικού δικτύου. Με δεξί κλικ στο γράφημα και την επιλογή Properties γίνεται η διαχείριση της εμφάνισης (π.χ. τίτλος, υπότιτλος κλπ) ενώ με την επιλογή Export γίνεται εξαγωγή και αποθήκευση σε αρχείο γραφικών. Μεταξύ των επιλογών είναι και η προσθήκη της μηκοτομής στη χαρτοσύνθεση ως γραφιστικό στοιχείο (graphics element).
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Εικόνα 8.12 Γράφημα μηκοτομής στο ArcGIS.
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Εικόνα 8.13 Γράφημα διατομής στο ArcGIS.
8.2.16 Δημιουργία διατομής
 
Η διατομή δημιουργείται σε περιβάλλον χαρτοσύνθεσης ArcMap, με συνδυασμό των θεματικών επιπέδων του ΨΜΕ και του 3D υδρολογικού δικτύου. Προστίθεται η γραμμή εργαλείων 3D Analyst και με το εργαλείο Interpolate line σχεδιάζεται μια γραμμή στη θέση όπου είναι επιθυμητό να κατασκευαστεί διατομή. Μετά τη σχεδίαση της γραμμής, με το εργαλείο 3D Analyst>Create Profile, η διατομή εμφανίζεται ως γράφημα σε ένα νέο παράθυρο. Με δεξί κλικ στο γράφημα και την επιλογή Properties γίνεται η διαχείριση της εμφάνισης (π.χ. τίτλος, υπότιτλος κλπ) ενώ με την επιλογή Export γίνεται εξαγωγή και αποθήκευση σε αρχείο γραφικών. Μεταξύ των επιλογών είναι και η προσθήκη της διατομής στη χαρτοσύνθεση ως γραφιστικό στοιχείο (graphics element). 
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Εικόνα 8.14 Χαρτογραφική σύνθεση ΨΜΕ, υδρολογικής λεκάνης και υδρογραφικού δικτύου
8.2.17 Χαρτοσύνθεση
 
Μια τυπική χαρτοσύνθεση η οποία συνδυάζει παράγωγα μεγέθη του ΨΜΕ σχετικά με την υδρολογική ανάλυση, παρουσιάζεται στην Εικόνα 8.14. Η διαδικασία σύνθεσης χάρτη παρουσιάζεται αναλυτικά στο Κεφάλαιο 10.
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Κριτήρια αξιολόγησης
Κριτήριο αξιολόγησης 1
Ποια προϊόντα που χρησιμοποιούνται στην υδρολογική ανάλυση μπορούν να παραχθούν από ένα ΨΜΕ;
 
Κριτήριο αξιολόγησης 2 
Με ποια διαδικασία προσδιορίζεται σε περιβάλλον QGIS το υδρογραφικό δίκτυο μιας περιοχής για την οποία διατίθεται το ΨΜΕ;
 
Κριτήριο αξιολόγησης 3
Με ποια διαδικασία προσδιορίζεται σε περιβάλλον ArcGIS, το υδρογραφικό δίκτυο μιας περιοχής για την οποία διατίθεται το ΨΜΕ;
Κριτήριο αξιολόγησης 4
Με ποια διαδικασία προσδιορίζονται σε περιβάλλον ArcGIS, οι λεκάνες απορροής μιας περιοχής για την οποία διατίθεται το ΨΜΕ;
 
Κριτήριο αξιολόγησης 5
Με ποια διαδικασία προσδιορίζεται το μέσο υψόμετρο μιας λεκάνης απορροής;
 
Κριτήριο αξιολόγησης 6
Με ποια διαδικασία προσδιορίζεται το μήκος και η μέση κλίση του κυρίου κλάδου του υδρογραφικού δικτύου;
 
Κεφάλαιο 9
Χαρτογραφική Γενίκευση
Σύνοψη 
Το κεφάλαιο αυτό αναφέρεται στη χαρτογραφική γενίκευση. Η διαδικασία της γενίκευσης προηγείται της απόδοσης των χαρτογραφικών δεδομένων σε κλίμακα χάρτη μικρότερη από την κλίμακα της βάσης δεδομένων. Περιγράφεται η γενίκευση των θεματικών επίπεδων με προτάσεις για την εφαρμογή συγκεκριμένων τελεστών γενίκευσης, η γενίκευση των γραμμικών δεδομένων, η εφαρμογή της «Αρχής της επιλογής» και τέλος οι μέθοδοι αναλυτικής εκτίμησης των αποτελεσμάτων της γενίκευσης γραμμικών δεδομένων. Στη συνέχεια, παρατίθεται λεπτομερής παρουσίαση της υλοποίησης των παραπάνω στο ΣΓΠ QGIS και στο ΣΓΠ ArcGIS. 
Προαπαιτούμενη γνώση
Γενική γνώση για τον μετασχηματισμό της χαρτογραφικής γενίκευσης.
9. Χαρτογραφική Γενίκευση
 
Η χαρτογραφική γενίκευση ορίζεται ως η επιλογή και η απλοποιημένη απόδοση των λεπτομερειών εκείνων που θεωρούνται κατάλληλες για την κλίμακα και τον σκοπό του χάρτη (ICA, 1973). Η χαρτογραφική γενίκευση κρίνεται αναγκαία, καθώς ο χώρος που διατίθεται στον χάρτη είναι συνάρτηση της κλίμακας και ανάλογος με το τετράγωνο της σμίκρυνσης της γραμμικής κλίμακας. Η μετάβαση σε μια μικρότερη κλίμακα έχει ως συνέπεια τη μείωση του χώρου, την ελάττωση της απόστασης ανάμεσα στις οντότητες που αποδίδονται, τη μείωση της ενάργειας και –πολλές φορές- την αδυναμία  της ορθής ανάγνωσης. Καθώς τα σύμβολα καταλαμβάνουν συγκεκριμένο χώρο, όσο μικρότερη είναι η κλίμακα τόσο λιγότερες πληροφορίες μπορούν να απεικονιστούν. Παραδοσιακά, η γενίκευση βασιζόταν σε μεγάλο βαθμό στην εμπειρία και στο ένστικτο του χαρτογράφου. 
Πλέον, εφαρμόζεται η ψηφιακή γενίκευση καθώς τα χαρτογραφικά δεδομένα διατίθενται σε  ψηφιακή μορφή και η επεξεργασία τους πραγματοποιείται σε περιβάλλον ΣΓΠ. Η ψηφιακή γενίκευση ορίζεται ως η διαδικασία ανάκτησης ενός συνόλου ψηφιακών δεδομένων από μια πηγή, με την εφαρμογή μετασχηματισμών που επιδρούν στη γεωμετρία και στις ιδιότητες (McMaster & Shea, 1992). Η υλοποίηση της χαρτογραφικής διαδικασίας στον ψηφιακό κόσμο απαιτεί τη θέσπιση ενός μοντέλου γενίκευσης (Brassel & Weibel, 1988; McMaster & Shea, 1989; McMaster & Shea, 1992), το οποίο αναγνωρίζει τα στάδια, τις διεργασίες και τους παράγοντες της χαρτογραφικής γενίκευσης και την αναλύει σε μια σειρά από επιμέρους χωρικούς μετασχηματισμούς και μετασχηματισμούς ιδιοτήτων. Σε δεύτερο στάδιο, είναι δυνατό να αναπτυχθούν αλγόριθμοι που υλοποιούν κάθε επιμέρους μετασχηματισμό. 
Πρώτο στάδιο της χαρτογραφικής γενίκευσης αποτελεί η σημασιολογική γενίκευση η οποία αναφέρεται στην επιλογή των θεματικών επιπέδων ή των οντοτήτων που αποδίδονται στον χάρτη. Στη συνέχεια, γενικεύονται τα περιγραφικά χαρακτηριστικά/ιδιότητες των οντοτήτων μέσα από τις διαδικασίες αλλαγής της ταξινόμησης και ομαδοποίησης. Η διαχείριση της γεωμετρίας, στα πλαίσια της χαρτογραφικής γενίκευσης, πραγματοποιείται με μια σειρά από γεωμετρικούς τελεστές που διαφοροποιούνται για τα σημειακά, τα γραμμικά και τα επιφανειακά δεδομένα (McMaster & Shea, 1992; Νάκος, 2011; Τσούλος, 2008). Για παράδειγμα, για τα σημειακά δεδομένα εφαρμόζεται η αφαίρεση, η ενοποίηση, η μετάθεση κ.ά. Για τα γραμμικά δεδομένα εφαρμόζεται η απλοποίηση, η εξομάλυνση, η μετάθεση, η συνένωση, η ενίσχυση της γεωμετρίας κ.ά. και τέλος για τα επιφανειακά εφαρμόζεται η απλοποίηση, η εξομάλυνση, η μετάθεση, η συνένωση, η ενίσχυση της γεωμετρίας, η κατάτμηση, η μετάπτωση διαστάσεων κ.ά. 
Η χαρτογραφική γενίκευση είναι μια σύνθετη και πολυπαραμετρική διαδικασία η οποία επηρεάζεται από πολλούς παράγοντες (Weibel & Dutton, 1999; Robinson et al., 2012). Για παράδειγμα:
 
	Η κλίμακα του χάρτη συνδέεται άμεσα με το βαθμό γενίκευσης.
	Ο σκοπός του χάρτη π.χ. τοπογραφικός χάρτης, τουριστικός χάρτης, καθορίζει τι είναι σημαντικό για το κοινό του χάρτη, το περιεχόμενο, την ιεράρχηση των χαρτογραφικών οντοτήτων, τον συμβολισμό κ.ά.
	Οι προδιαγραφές του συμβολισμού και ο συμβολισμός που επιλέγεται καθορίζουν τον χώρο που καταλαμβάνουν τα χαρτογραφικά δεδομένα στο μέσο απόδοσης και ενδέχεται να προκαλέσουν προβλήματα όπως π.χ. επικάλυψη γειτονικών χαρτογραφικών οντοτήτων 
	Το μέσο απόδοσης, δηλαδή αν ο χάρτης είναι έντυπος, αν αποδίδεται στην οθόνη ή αν προορίζεται για το διαδίκτυο, επηρεάζει το τελικό αποτέλεσμα διαμορφώνοντας παραμέτρους όπως η απόσταση θέασης, τα διαθέσιμα χρώματα, η αναγκαία ταχύτητα σχεδίασης κ.ά. 
	Τα γραφικά όρια, όπως οι ελάχιστες διαστάσεις των σημειακών συμβόλων, το ελάχιστο πάχος γραμμής, το ελάχιστο εμβαδόν επιφανειακής οντότητας, η ελάχιστη απόσταση για τη διάκριση σημειακών και γραμμικών συμβόλων κ.ά.
	Η ποιότητα των αρχικών δεδομένων.
	Η διατήρηση των τοπολογικών σχέσεων.

 
Καθοριστική είναι και η σειρά με την οποία εφαρμόζεται η γενίκευση, καθώς η γενίκευση ενός θεματικού επιπέδου επηρεάζει και τα υπόλοιπα. Καθώς η θέση των τεχνητών οντοτήτων εξαρτάται από τις φυσικές οντότητες, η πληροφορία του αναγλύφου π.χ. ισοϋψείς, υδρολογικό δίκτυο, ακτογραμμή διαχειρίζεται πρώτη. Η διαδοχή δεν είναι απόλυτη αλλά εξαρτάται από τον σκοπό του χάρτη και την κλίμακα. Η συνήθης σειρά γενίκευσης για ένα τοπογραφικό χάρτη μπορεί να είναι η ακόλουθη:
 
	Ακτογραμμή.
	Ισοϋψείς καμπύλες.
	Υδρολογικό δίκτυο.
	Υψομετρικά και τριγωνομετρικά σημεία.
	Τεχνητές οντότητες π.χ. οικισμοί, δρόμοι, κοινωφελή δίκτυα κ.ά. 
	Χρήσεις γης και βλάστηση γενικεύονται τελευταία, καθώς τα περιγράμματά τους εξαρτώνται από τη θέση των φυσικών και τεχνητών οντοτήτων.

 
Μια βασική διαδικασία της γενίκευσης είναι η επιλογή ορισμένου αριθμού από τις οντότητες που συγκροτούν ένα θεματικό επίπεδο και η απόδοσή τους στη νέα κλίμακα. Ένα χρήσιμο εργαλείο για την εφαρμογή της διαδικασίας της επιλογής αποτελεί ο εμπειρικός νόμος των Toepfer & Pillewizer ή «Αρχή της επιλογής». Ο νόμος των Toepfer & Pillewizer (9.1) (Robinson et al., 2012) συνδέει τον αριθμό των χαρτογραφικών οντοτήτων προς απόδοση n στον παράγωγο χάρτη με κλίμακα S, με τον αριθμό των οντοτήτων της ίδιας κατηγορίας nο στον αρχικό χάρτη με κλίμακα Sο. Η αρχή της επιλογής προσδιορίζει την τάξη μεγέθους του αριθμού των οντοτήτων που αποδίδονται στον υπό σύνθεση χάρτη, αλλά δεν υποδεικνύει ποια είναι αυτά. Η επιλογή των οντοτήτων που αποδίδονται στη νέα κλίμακα, πραγματοποιείται από τον χαρτογράφο βάσει πληροφοριών όπως η σχετική σπουδαιότητα του χωρικού στοιχείου στην οπτική ιεραρχία, η σχέση της συγκεκριμένης κατηγορίας χωρικών στοιχείων με το σκοπό του χάρτη, οι γραφικές συνέπειες της διατήρησης του χωρικού στοιχείου, η πυκνότητα, οι τοπολογικές σχέσεις, η χωρική κατανομή κ.ά. Ορισμένα στοιχεία ενδέχεται να μη συμμετέχουν στη διαδικασία της επιλογής ως εξαιρούμενα, συνήθως λόγω της μοναδικότητάς τους π.χ. το αεροδρόμιο.
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(9.1)
9.1 Παραδείγματα χαρτογραφικής γενίκευσης θεματικών επιπέδων
 
Στον Πίνακα 9.1 παρουσιάζεται μια πρόταση για τους τελεστές γενίκευσης που ενδέχεται να χρησιμοποιηθούν για τη χαρτογραφική γενίκευση ορισμένων θεματικών επιπέδων. Τα θεματικά επίπεδα εμφανίζονται ομαδοποιημένα ανάλογα με το γεωμετρικό αρχέτυπο στο οποίο εντάσσονται (σημείο, γραμμή, πολύγωνο). Εκτός  από τη γεωμετρία, η σημασία κάθε θεματικού επιπέδου επιβάλει διαφορετική διαχείριση. Παράλληλα η επίδραση των παραγόντων της γενίκευσης (που αναφέρθηκαν πρωτύτερα) επηρεάζουν τη διαχείριση και το τελικό αποτέλεσμα. 
 
 
 	Γεωμετρία 
	Θεματικά επίπεδα
	Τελεστές γενίκευσης

	Γραμμές
	Ακτογραμμή
	Αναγνώριση τεχνητών και φυσικών οντοτήτων, απλοποίηση, εξομάλυνση, ενίσχυση π.χ. χαρακτηριστικών λεπτομερειών όπως κόλποι (Εικόνα 9.2).

		Οδικό δίκτυο
	Προσδιορισμός νέου πλήθους κατηγοριών, δημιουργία νέας ταξινόμησης, απαλοιφή κλάδων, απλοποίηση, εξομάλυνση, ενίσχυση,  μετάθεση (Εικόνα 9.3).

		Υδρολογικό δίκτυο
	Απαλοιφή κλάδων, απλοποίηση, εξομάλυνση, μετάθεση.

		Ισοϋψείς
	Προσδιορισμός νέας ισοδιάστασης, απλοποίηση, εξομάλυνση.

	Σημεία
	Εκκλησίες
	Απαλοιφή, μετάθεση.

		Υψομετρικά σημεία
	Απαλοιφή.
 

		Ανεμογεννήτριες
	Απαλοιφή, αλλαγή συμβόλου, συνένωση σημείων σε επιφάνεια (Εικόνα 9.1).

	Επιφάνειες
	Οικισμοί
	Μετάπτωση σε σημεία εκτός από τον ιεραρχικά ανώτερο π.χ πρωτεύουσα που παραμένει ως επιφάνεια αν το επιτρέπει η κλίμακα, αφαίρεση.

		Αεροδρόμιο
	Μετάπτωση σε σημειακό.

		Χρήσεις Γης 
	Αλλαγή ταξινόμησης, συνένωση πολυγώνων με κοινή κατηγοριοποίηση, απλοποίηση ορίων, εξομάλυνση, απαλοιφή πολύ μικρών σε εμβαδόν πολυγώνων.


Πίνακας 9.1 Παραδείγματα διαχείρισης της γενίκευσης για διαφορετικά θεματικά επίπεδα.
Επιπλέον παραδείγματα και ανάλυση των ορθών πρακτικών της χαρτογραφικής γενίκευσης μπορούν να αναζητηθούν στη βιβλιογραφία (Swiss Society of Cartography, 1987; Spiess, Baumgartner, Arn & Vez, 2002). 
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Εικόνα 9.1 Παράδειγμα γενίκευσης για ένα σημειακό θεματικό επίπεδο: Ανεμογεννήτριες.
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Εικόνα 9.2 Παράδειγμα γενίκευσης για ένα γραμμικό θεματικό επίπεδο: Ακτογραμμή (φυσική και τεχνητή). 
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Εικόνα 9.3 Παράδειγμα γενίκευσης για ένα γραμμικό θεματικό επίπεδο: Οδικό δίκτυο.
9.2 Γενίκευση γραμμικών χαρτογραφικών οντοτήτων
 
Με δεδομένο ότι οι γραμμικές οντότητες αποτελούν την πλειονότητα των χαρτογραφικών δεδομένων, η διαχείρισή τους κατά τη χαρτογραφική γενίκευση απασχολεί ιδιαίτερα τους χαρτογράφους. Σκοπός της χαρτογραφικής γενίκευσης γραμμικών οντοτήτων είναι η κατά το δυνατό διατήρηση της θέσης και της μορφής των γραμμών, ώστε να μη χάνεται η οριζοντιογραφική ακρίβεια στη νέα κλίμακα και να αναγνωρίζεται η φύση των γραμμών. 
Βασικό τελεστή για τη γενίκευση των γραμμικών δεδομένων αποτελεί η απλοποίηση. Οι αλγόριθμοι απλοποίησης επιλέγουν τις χαρακτηριστικές κορυφές βάσει ενός γεωμετρικού κριτηρίου π.χ. απόσταση, γωνία, εμβαδόν κ.ά. και απορρίπτουν εκείνες που θεωρούνται άχρηστες για την καταγραφή της μορφής της γραμμής. Οδηγούν σε ένα υποσύνολο των αρχικών κορυφών οι οποίες διατηρούν τις οριζοντιογραφικές τους θέσεις. Ένας δεύτερος τελεστής για τις γραμμικές οντότητες είναι η εξομάλυνση. Η εξομάλυνση υλοποιείται στην τελική φάση της γενίκευσης και έχει σκοπό την απόδοση των χαρτογραφικών στοιχείων με τρόπο ώστε να φαίνονται "φυσικά" (Τσούλος, 2008). Οι αλγόριθμοι εξομάλυνσης επενεργούν σε γραμμές μετατοπίζοντας τις θέσεις των κορυφών που τις συνθέτουν. Ουσιαστικά οι αλγόριθμοι της κατηγορίας αυτής δημιουργούν ένα παράγωγο αρχείο κορυφών, το οποίο μεταφέρει το κοσμητικό στοιχείο. 
Σήμερα, τα ΣΓΠ διαθέτουν διάφορους αλγορίθμους απλοποίησης των γραμμών όπως ο αλγόριθμος των Douglas & Peucker, Lang, Reumann-Witkam, Ευκλείδειας απόστασης μεταξύ διαδοχικών κορυφών, Visvalingam & Whyatt κ.ά. (Νάκος, 2011; Τσούλος, 2008). Παράλληλα διατίθενται αλγόριθμοι εξομάλυνσης όπως Boyle (Clayton, 1986), Mέσος όρος κατά McMaster (McMaster & Shea, 1992), Μέσος όρος με βάρη κατά McMaster (McMaster & Shea, 1992), Chaiken (Joy, 1999; Chaikin, 1974), Hermite (Szeliski & Ito, 1986), Snakes (Burghardt, 2005; Steiniger & Meier, 2004), πολυωνυμική προσέγγιση π.χ. PAEK (Polynomial Approximation with Exponential Kernel), καμπύλες Bezier κ.ά. Στη βιβλιογραφία αναφέρονται και άλλοι  αλγόριθμοι (AGENT, 1999). 
Στο ΣΓΠ ArcGIS διατίθεται ο αλγόριθμος απλοποίησης και εξομάλυνσης BendSimplify που βασίζεται σε έρευνα των Wang & Muller (1998). Ο αλγόριθμος BendSimplify αποτελεί έναν νέας γενιάς αλγόριθμο ο οποίος εφαρμόζει τεχνικές για την αναγνώριση του σχήματος. Βασίζεται στην υπόθεση ότι μια γραμμική χαρτογραφική οντότητα, όπως η ακτογραμμή, συντίθεται από στροφές/καμπές (bends) (Εικόνα 9.4). Ως στροφή θεωρείται το τμήμα εκείνο της γραμμής που ορίζεται από έναν αριθμό συνεχών κορυφών με γωνίες καμπής οι οποίες διατηρούν το ίδιο πρόσημο (είναι όλες θετικές ή αρνητικές). Αντίθετα οι κορυφές αρχής και τέλους έχουν γωνίες καμπής με το αντίθετο πρόσημο. Η γωνία καμπής μιας κορυφής μπορεί να προσδιοριστεί από τη διαφορά της γωνίας διεύθυνσης του επόμενου και του προηγούμενου ευθύγραμμου τμήματος τα οποία συναντώνται σε μια κορυφή. Μια σειρά από γεωμετρικές ιδιότητες υπολογίζονται για κάθε καμπή και συγκρίνονται με ένα ημικύκλιο το οποίο χρησιμοποιείται ως αναφορά. Το ημικύκλιο αυτό έχει διάμετρο ίση με την τιμή της παραμέτρου ανοχής. Από τη σύγκριση των τιμών των μέτρων καθορίζεται εάν μια καμπή/στροφή διατηρείται ή απαλείφεται οπότε και αντικαθίσταται από τη γραμμή βάσης (δηλαδή την γραμμή που ενώνει το αρχικό και το τελικό σημείο). Ο αλγόριθμος δρα επαναληπτικά, οπότε αρχικά απαλείφονται οι μικρότερες καμπές και στη συνέχεια οι μεγαλύτερες. Το αποτέλεσμα διατηρεί ως ένα βαθμό την αρχική μορφή της γραμμής.
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Εικόνα 9.4 Η αρχή του αλγόριθμου Bendsimplify.
Οι επιλογές του χαρτογράφου κατά τη γενίκευση, δηλαδή η επιλογή τελεστή, αλγορίθμου και τιμής της παραμέτρου ανοχής συνδέονται σε μεγάλο βαθμό με τη μορφή των γραμμικών χαρτογραφικών οντοτήτων (Σκοπελίτη, 2001). Η μορφή καθορίζεται από το είδος τους π.χ. τεχνητές οντότητες – δρόμος, φυσικές οντότητες – ακτογραμμή αλλά και από τα ιδιαίτερα χαρακτηριστικά τους π.χ. ομαλή ακτογραμμή – δαντελωτή ακτογραμμή. Ένα κρίσιμο ερώτημα, εκτός από την επιλογή του αλγόριθμου, αποτελεί η επιλογή της τιμής της παραμέτρου ανοχής. Η τιμή της παραμέτρου ανοχής καθορίζει τον βαθμό απλοποίησης. Χρειάζονται πολλές «δοκιμές» για τον προσδιορισμό της βέλτιστης τιμής. Ο όρος «δοκιμή» περιλαμβάνει την εφαρμογή των αλγορίθμων οι οποίοι διατίθενται με διαφορετικές τιμές της παραμέτρου ανοχής, τη χρήση του συμβόλου απόδοσης, την εκτύπωση στη νέα κλίμακα απόδοσης και τη σύγκριση ανάμεσα σε διαφορετικά αποτελέσματα. Στο περιβάλλον των ΣΓΠ, η υλοποίηση της γενίκευσης μέσω των εργαλείων που διατίθενται, αφορά έναν αλγόριθμο και μια τιμή της παραμέτρου ανοχής για όλες τις οντότητες ενός θεματικού επιπέδου. Μόνο εάν ο χρήστης φροντίσει να δημιουργήσει υποσύνολα των δεδομένων που επιλέγονται με βάση κριτήρια όπως η μορφή κ.ά. μπορεί να υλοποιηθεί η εφαρμογή διαφορετικών αλγορίθμων και τιμών της παραμέτρου ανοχής σε ορισμένες οντότητες.
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Εικόνα 9.5 Υπολογισμός μέσου βήματος και μέσης απόκλισης αρχικής και γενικευμένης γραμμής.
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(9.4)
 
Συχνά, απαιτείται η σύγκριση μεταξύ των αρχικών και των γενικευμένων οντοτήτων για την αξιολόγηση του αποτελέσματος της γενίκευσης. Για τα γραμμικά δεδομένα μπορούν να χρησιμοποιηθούν μεγέθη όπως το πλήθος των κορυφών, η μέση ανάλυση ή το βήμα καταγραφής των γραμμικών οντοτήτων, η μεταβολή του μήκους, η επιφανειακή μετάθεση, τα διανύσματα μετάθεσης της οριζοντιογραφικής θέσης κ.ά. (McMaster, 1987; Jenks, 1989). Για τον υπολογισμό του μέσου βήματος (Εικόνα 9.5) προτείνεται ο υπολογισμός του πηλίκου του μήκους της γραμμής δια του πλήθους των κορυφών, χρησιμοποιώντας τα δύο προαναφερθέντα μεγέθη τα οποία υπολογίζονται με ευκολία από ένα ΣΓΠ (Σχέση 9.2, Σχέση 9.3). 
Η μεταβολή της οριζοντιογραφικής θέσης προσεγγίζεται από τη σύγκριση της αρχικής γραμμής με τη γενικευμένη γραμμή. Για κάθε κορυφή της αρχικής γραμμής Α, είναι δυνατό να υπολογιστεί η απόσταση (δi) προς τη γενικευμένη γραμμή Α΄, με την ορθή προβολή των κορυφών της αρχικής γραμμής στη γενικευμένη γραμμή (Εικόνα 9.5, Σχέση 9.4). Από το σύνολο των αποστάσεων των κορυφών της γραμμής Α ως προς τη Α΄ είναι δυνατό να ληφθούν μέτρα απόκλισης ανάμεσα στις δύο γραμμικές οντότητες Α και Α΄, όπως η μέση τιμή και η τυπική απόκλιση των αποστάσεων. Στο περιβάλλον του ΣΓΠ, η αρχική γραμμή μετατρέπεται σε ένα σύνολο σημείων τα οποία αντιστοιχούν στις κορυφές και στους κόμβους που την ορίζουν. Από τα σημεία αυτά υπολογίζονται οι αποστάσεις ως προς τη γενικευμένη γραμμή. Ο μέσος όρος αυτών των αποστάσεων αποτελεί μέτρο της μεταβολής της οριζοντιογραφικής θέσης της γραμμής. Επίσης, μπορεί να χρησιμοποιηθεί η επιφανειακή μετάθεση, η οποία αναφέρεται στο εμβαδόν των πολύγωνων που σχηματίζονται από την επίθεση της αρχικής και της γενικευμένης γραμμής. Συνήθως, η επιφανειακή μετάθεση χρησιμοποιείται μετά από διαίρεση με το μήκος της αρχικής γραμμής, δίνοντας με τον τρόπο αυτό ένα μέτρο που προσεγγίζει τη μέση απόσταση. Στις επόμενες παραγράφους περιγράφεται η υλοποίηση των παραπάνω στο περιβάλλον των ΣΓΠ QGIS και ArcGIS. 
Ιδιαίτερη προσοχή πρέπει να δοθεί ώστε οι αλγόριθμοι απλοποίησης και εξομάλυνσης να εφαρμόζονται σε χαρτογραφικά δεδομένα στα οποία έχει εφαρμοστεί μια χαρτογραφική προβολή, δηλαδή χρησιμοποιούν καρτεσιανές συντεταγμένες. Λόγω της γεωμετρίας της σφαίρας και του ελλειψοειδούς, ένα γωνιακό μέγεθος δεν αντιστοιχεί στην ίδια απόσταση επάνω στη σφαίρα ή στο ελλειψοειδές σε οποιοδήποτε σημείο της επιφάνειας αναφοράς. Επομένως, μια παράμετρος ανοχής ορισμένη ως γωνιακό μέγεθος δεν μπορεί να εφαρμοστεί στα δεδομένα αφού αυτό το γωνιακό μέγεθος αντιπροσωπεύει διαφορετικό μήκος καθώς αλλάζει η θέση και ο προσανατολισμός επάνω στην επιφάνεια αναφοράς. Οι αλγόριθμοι απλοποίησης και εξομάλυνσης αφορούν τον ευκλείδειο χώρο. Η παρατήρηση αυτή για τη διαχείριση της γεωμετρίας σε συνδυασμό με τις γεωγραφικές συντεταγμένες, αποτελεί σημείο των καιρών της ψηφιακής εποχής όπου χαρτογραφικά δεδομένα ενδέχεται να διατίθενται με τις γεωγραφικές τους συντεταγμένες π.χ. δεδομένα που συλλέχθηκαν με GNSS, δεδομένα του OSM κ.ά. Στην παραδοσιακή χαρτογραφία και στην πρώιμη περίοδο της ψηφιακής χαρτογραφίας, όπου τα δεδομένα καταγράφονταν ψηφιακά κυρίως από τον χάρτη, δεν εμφανίζονταν το παραπάνω πρόβλημα. 
9.3 Οδηγίες εφαρμογής της γενίκευσης στο ΣΓΠ QGIS
 
Στη συνέχεια, παρουσιάζονται τα εργαλεία που μπορεί να αξιοποιηθούν για την υλοποίηση της γενίκευσης στο περιβάλλον του ΣΓΠ QGIS (“QGIS Training Manual”, χ.η.; “QGIS User Guide”, χ.η.).
9.3.1 Απλοποίηση γραμμικών ή επιφανειακών χαρτογραφικών δεδομένων με το εργαλείο Simplify Geometries
 
Το εργαλείο αυτό εφαρμόζει τον αλγόριθμο απλοποίησης Douglas - Peucker. Από το μενού επιλέγεται Διανύσματα>Εργαλεία Γεωμετρίας>Simplify Geometries. Στο νέο παράθυρο Απλοποίηση γεωμετριών (Εικόνα 9.6), ορίζεται το αρχείο των δεδομένων προς απλοποίηση Εισαγωγή επιπέδου γραμμής ή πολυγώνου π.χ. coastline, το μέγεθος της παραμέτρου ανοχής Απλοποίηση απόστασης ανοχής π.χ. 10, ενεργοποιείται η επιλογή Αποθήκευση σε νέο αρχείο και συμπληρώνεται το όνομα του νέου αρχείου που δημιουργείται καθώς και η επιλογή Προσθήκη αποτελέσματος στον καμβά. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Το σύστημα ενημερώνει τον χρήστη για τον αριθμό κορυφών πριν και μετά την απλοποίηση. 
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Εικόνα 9.6 Εργαλείο Simplify Geometries.
9.3.2 Απλοποίηση ή εξομάλυνση γραμμικών ή επιφανειακών χαρτογραφικών δεδομένων με το εργαλείο v.generalize του GRASS
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Εικόνα 9.7 Ενεργοποίηση εργαλείου v.generalize – Simplify vector.
Στη συνέχεια, ακολουθούν οι οδηγίες χρήσης του εργαλείου v.generalize το οποίο ανήκει στο ΣΓΠ GRASS. Το εργαλείο v.generalize περιλαμβάνει αλγορίθμους οι οποίοι υλοποιούν την απλοποίηση και την εξομάλυνση των γραμμών. Συγκεκριμένα, ο χρήστης μπορεί να διαλέξει από τους ακόλουθους αλγορίθμους απλοποίησης: Douglas-Peucker, Lang, Vertex Reduction και Reumann-Witkam. Ο αλγόριθμος Vertex Reduction αναφέρεται στον αλγόριθμο της Ευκλείδειας απόστασης μεταξύ διαδοχικών κορυφών. Οι αλγόριθμοι παίρνουν ως παράμετρο την παράμετρο ανοχής (threshold), ενώ ο αλγόριθμος του Lang παίρνει επιπλέον παράμετρο τον αριθμό των κορυφών (look_ahead) τις οποίες εξετάζει. Οι τιμές της παραμέτρου ανοχής αναφέρονται στις μονάδες των δεδομένων. Ακόμα παρέχεται η επιλογή Douglas-Peucker Reduction Algorithm, όπου ο Douglas-Peucker δεν λειτουργεί με την παράμετρο ανοχής αλλά με το ποσοστό των κορυφών της αρχικής γραμμής που διατηρούνται (παράμετρος reduction). Επίσης διατίθενται οι ακόλουθοι αλγόριθμοι εξομάλυνσης: Boyle's Forward-Looking Algorithm, McMaster's Sliding Averaging Algorithm, McMaster's Distance Weighting Algorithm, Chaiken's Algorithm, Hermite Interpolation και Snakes. 
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Εικόνα 9.8 Εργαλείο v.generalize – Simplify vector.
Αρχικά, δημιουργείται ένα νέο mapset ή καλείται ένα υπάρχον (βλ. Παράρτημα Α.6.1.1). Σε αυτό εισάγεται προς επεξεργασία το αρχείο με μορφότυπο shapefile (βλ. Παράρτημα Α.6.1.2) και τέλος ορίζεται το προς επεξεργασία διανυσματικό αρχείο του Grass (βλ. Παράρτημα Α.6.1.3). Για την επιλογή του εργαλείου γενίκευσης, από το μενού επιλέγεται Πρόσθετα>Grass>Open GRASS tools. Στο νέο παράθυρο GRASS tools (Εικόνα 9.7), από την καρτέλα Module Tree επιλέγεται GRASS MODULES>Vector>Generalization>v.generalize – Simplify vector. Στη νέα καρτέλα (Εικόνα 9.8), ορίζονται το θεματικό επίπεδο προς επεξεργασία π.χ. coast (Name of input vector map), η επιλογή του γεωμετρικού αρχετύπου των δεδομένων π.χ. line (line ή boundary ή area), ο αλγόριθμος απλοποίησης ή εξομάλυνσης π.χ. Douglas-Peucker Algorithm (Generalization algorithm), η τιμή της παραμέτρου ανοχής π.χ. 50 (Maximal tolerance value (higher value = more simplification) και το όνομα του νέου αρχείου (Name for output vector map). Η εφαρμογή ξεκινάει με το πλήκτρο Εκτέλεση ενώ στη συνέχεια το πλήκτρο Εμφάνιση αποτελέσματος προσθέτει τα νέα δεδομένα στη γραφική απόδοση. Η διαδικασία ολοκληρώνεται με το πλήκτρο Close. Τέλος, το αποτέλεσμα της επεξεργασίας του GRASS μπορεί να αποθηκευτεί ως αρχείο μορφότυπου shapefile (βλ. Παράρτημα Α.6.1.4).
9.3.3 Απλοποίηση γραμμικών ή επιφανειακών χαρτογραφικών δεδομένων με το εργαλείο SimpliPy
 
Το εργαλείο αυτό εφαρμόζει τους αλγορίθμους απλοποίησης Douglas - Peucker και Visvalingam & Whyatt. Από το μενού επιλέγεται Πρόσθετα>Διαχείριση και εγκατάσταση προσθέτων και εγκαθίσταται το εργαλείο SimpliPy (Εικόνα 9.9). Στη συνέχεια, από το μενού επιλέγεται Πρόσθετα>SimpliPy>Advanced geometry simplification. Στο νέο παράθυρο SimpliPy (Εικόνα 9.10) ορίζονται το αρχείο που απλοποιείται Layer, αν θα προστεθεί το αποτέλεσμα στο γραφικό παράθυρο (Add result to canvas (visible layer) ή Add result to canvas (hidden layer)), ο αλγόριθμος Douglas Peucker ή Visvalingam & Whyatt, η τιμή της ανοχής (Tolerance), η μέθοδος διάσπασης των κλειστών γραμμών (First and last, First and furthest, Diameter points) και η διαχείριση των περιορισμών. Η διαχείριση των περιορισμών περιλαμβάνει τη διόρθωση των τομών (Repair intersections), την αποφυγή αφαίρεσης πολύ μικρών πολυγώνων (Prevent shape removal – min points(polygons)), τη διατήρηση των τοπολογικών σχέσεων (Use topology). Η διαδικασία ξεκινάει με το Start. 
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Εικόνα 9.9 Προσθήκη εργαλείου SimpliPy.
9.3.4 Διαγραφή χαρτογραφικών δεδομένων
 
Αρχικά, επιλέγεται το θεματικό επίπεδο. Η επεξεργασία της γεωμετρίας ενεργοποιείται με το εργαλείο [image: ] Εναλλαγή επεξεργασίας. Στη συνέχεια, με το εργαλείο [image: ] Επιλογή αντικειμένων σε περιοχή ή με απλό κλικ, επιλέγονται το ή τα αντικείμενα που θα διαγραφούν. Η διαγραφή ολοκληρώνεται με το εργαλείο [image: ] Διαγραφή επιλεγμένων. Η διαδικασία ολοκληρώνεται με την αποθήκευση των αλλαγών με το εργαλείο [image: ] Αποθήκευση αλλαγών επιπέδου.
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Εικόνα 9.10 Το εργαλείο SimpliPy.
9.3.5 Μετάπτωση επιφανειακών δεδομένων σε σημειακά
 
Από το μενού επιλέγεται Διανύσματα>Εργαλεία γεωμετρίας>Polygon Centroid. Στο νέο παράθυρο Κεντροειδή πολυγώνων (Εικόνα 9.11), ορίζονται το θεματικό επίπεδο με τα πολύγωνα π.χ. settlements (Διανυσματικό επίπεδο πολυγώνων προέλευσης) και το θεματικό επίπεδο που δημιουργείται με τα σημεία π.χ. settlements_point (Shapefile σημείων προορισμού). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
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Εικόνα 9.11 Εργαλείο Polygon Centroid.
 
9.3.6 Δημιουργία νέου θεματικού επιπέδου με την επιλογή υποσυνόλου δεδομένων με βάση τις τιμές των ιδιοτήτων τους
 
Επιλέγεται ένα θεματικό επίπεδο και με δεξί κλικ Open Attribute Table. Από το νέο παράθυρο Attribute Table, με το εργαλείο [image: ] Select features using an expression συντάσσεται η λογική πρόταση επιλογής. Στο νέο παράθυρο Select by expression ορίζονται τα πεδία, οι λογικοί τελεστές και οι αντίστοιχες τιμές. Βοηθητικά, ενδέχεται να χρησιμοποιηθεί ο κατάλογος των Fields and Values για την επιλογή του πεδίου και το Load Values που εμφανίζει τις τιμές των πεδίων (Εικόνα 9.12). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Τέλος, τα επιλεγμένα δεδομένα μπορούν να αποθηκευτούν ως ξεχωριστή δομή διανυσματικών δεδομένων (βλ. Παράρτημα Α.5.2).
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Εικόνα 9.12 Εργαλείο Select features using an expression.
9.3.7 Υπολογισμός μέσου βήματος γραμμής
 
Ο υπολογισμός του μέσου βήματος γραμμής βασίζεται στο μήκος και στον αριθμό των κορυφών κάθε γραμμής. Προϋποθέτει την ύπαρξη ενός πεδίου με το μήκος της γραμμής. Στην περίπτωση που δεν υπάρχει η πληροφορία αυτή αποθκευμένη σε πεδίο, ακολουθείται η παρακάτω διαδικασία. Επιλέγεται το θεματικό επίπεδο και με δεξί κλικ Open Attribute Table. Από το νέο παράθυρο Attribute Table, υλοποιείται η διαδικασία προσθήκης ενός νέου πεδίου με το όνομα Length. Από το εικονίδιο Νέα Στήλη [image: ] (Εικόνα 9.13), ενεργοποιείται το παράθυρο Προσθήκη Στήλης όπου συμπληρώνονται το Όνομα π.χ. Length, ένα Σχόλιο π.χ. μήκος, ο Τύπος π.χ. Decimal number (real), το Πλάτος π.χ. 6 και η Ακρίβεια (δηλαδή ο αριθμός δεκαδικών ψηφίων) π.χ. 2. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Στη συνέχεια, καλείται το περιβάλλον υπολογισμού των τιμών του πεδίου από το πλήκτρο Open field calculator [image: ]. Στο νέο παράθυρο Επεξεργασία πεδίων (Εικόνα 9.14), υπολογίζονται οι τιμές του μήκους με τη συνάρτηση $length και αποθηκεύονται στο νέο πεδίο Length. 
 
 
[image: ]
Εικόνα 9.13 Προσθήκη νέου πεδίου.
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Εικόνα 9.14 Υπολογισμός τιμής πεδίου.
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Εικόνα 9.15 Προσθήκη εργαλείου Vertices Counter.
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Εικόνα 9.16 Το εργαλείο Vertices Counter.
Για τον υπολογισμό του αριθμού των κορυφών, χρησιμοποιείται το εργαλείο Vertices Counter. Από το μενού επιλέγεται Πρόσθετα>Διαχείριση και Εγκατάσταση Προσθέτων. Στο νέο παράθυρο Πρόσθετα όλα επιλέγεται το Vertices Counter με τη βοήθεια του Αναζήτηση (Εικόνα 9.15). Με το πλήκτρο Εγκατάσταση προσθέτου γίνεται η εγκατάσταση και η διαδικασία ολοκληρώνεται με το πλήκτρο Close. Επιλέγεται το θεματικό επίπεδο προς επεξεργασία από τον κατάλογο δεδομένων Επίπεδα και στη συνέχεια Διανύσματα>Vertices Counter>Vertices Counter. Στο νέο παράθυρο Vertices Counter (Εικόνα 9.16), επιλέγεται το θεματικό επίπεδο προς επεξεργασία ως Active Layer και η δημιουργία μιας καινούργιας στήλης για την αποθήκευση του αριθμού των κορυφών Create new column π.χ. Vertices. Η διαδικασία ολοκληρώνεται με το πλήκτρο Count Vertices. Τα αποτελέσματα εμφανίζονται στη περιοχή Results του παραθύρου και παράλληλα ενημερώνεται η στήλη Vertices που δημιουργήθηκε. 
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Εικόνα 9.17 Υπολογισμός τιμής πεδίου.
Στη συνέχεια, πρέπει να υπολογιστεί το πηλίκο του μήκους προς τον αριθμό των κορυφών. Αρχικά, γίνεται η προσθήκη ενός νέου πεδίου για την αποθήκευση των νέων αυτών τιμών. Επιλέγεται το θεματικό επίπεδο και με δεξί κλικ Open Attribute Table. Από το νέο παράθυρο Attribute Table, υλοποιείται η διαδικασία προσθήκης ενός νέου πεδίου DS όπου καταγράφεται η μέση απόσταση. Από το εικονίδιο Νέα Στήλη [image: ] (Εικόνα 9.13), ενεργοποιείται το παράθυρο Προσθήκη Στήλης, όπου συμπληρώνονται το Όνομα π.χ. DS, ένα Σχόλιο π.χ. μέσος όρος απόστασης, ο Τύπος π.χ. Decimal number (real), το Πλάτος π.χ.4 και η Ακρίβεια (δηλαδή ο αριθμός δεκαδικών ψηφίων) π.χ. 2. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Στη συνέχεια, καλείται το περιβάλλον υπολογισμού των τιμών του πεδίου από το πλήκτρο Open field calculator [image: ]. Στο νέο παράθυρο Επεξεργασία πεδίων (Εικόνα 9.17), υπολογίζονται οι τιμές του μήκους του μέσου βήματος με τη συνάρτηση “Length”/ ”Vertices” και αποθηκεύονται στο νέο πεδίο Ds. 
Για τον υπολογισμό στατιστικών μεγεθών για τις τιμές του πεδίου Ds, επιλέγεται από το μενού Διανύσματα>Εργαλεία Ανάλυσης>Βasic Statistics. Στο νέο παράθυρο Βασικές στατιστικές (Εικόνα 9.18), επιλέγονται το θεματικό επίπεδο π.χ. coast (Input layer vector) και το πεδίο π.χ. DS (Πεδίο προορισμού) και στο τμήμα Statistics output εμφανίζονται τα αποτελέσματα. Στην περίπτωση που είναι επιθυμητή η αξιοποίηση μόνο των επιλεγμένων στοιχείων, ενεργοποιείται η επιλογή Χρησιμοποιείτε μόνο επιλεγμένα χαρακτηριστικά. O υπολογισμός ολοκληρώνεται με το πλήκτρο ΟΚ. Τα αποτελέσματα των στατιστικών μεγεθών αντιγράφονται με το συνδυασμό των πλήκτρων Ctrl+C. Η διαδικασία ολοκληρώνεται με το πλήκτρο Close.
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Εικόνα 9.18 Υπολογισμός στατιστικών μεγεθών.
9.3.8 Υπολογισμός μεταβολής της οριζοντιογραφικής θέσης
 
Τα αρχικά γραμμικά δεδομένα μετατρέπονται σε σημειακά, δηλαδή όλες οι κορυφές που αποτελούν τις γραμμές μετασχηματίζονται σε σημειακές οντότητες. Από το μενού επιλέγεται Διανύσματα>Εργαλεία γεωμετρίας>Extract Nodes. Στο νέο παράθυρο Εξαγωγή συγκεκριμένων κόμβων (Εικόνα 9.19), ορίζονται το αρχικό γραμμικό αρχείο π.χ. coast (Εισαγωγή διανυσματικού επιπέδου τύπου γραμμής ή πολυγώνου (vector layer)) και το σημειακό αρχείο που δημιουργείται π.χ. coast_point (Εξαγωγή Shapefile σημείου). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
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Εικόνα 9.19 Μετατροπή γραμμικών δεδομένων σε σημειακά.
Στη συνέχεια, το σημειακό αρχείο εισάγεται στο GRASS (βλ. Παράρτημα Α Α.6.1.1, Α.6.1.2, Α.6.1.3), ώστε να μπορεί να εφαρμοστεί σε αυτό η συνάρτηση του GRASS v.distance. Για την εφαρμογή της από το μενού επιλέγεται Πρόσθετα>Grass>Open GRASS tools. Στο νέο παράθυρο GRASS tools, από την καρτέλα Module Tree επιλέγεται GRASS MODULES>Vector>Spatial Analysis>Vector geometry analysis>v.distance (Εικόνα 9.20). Στο νέα καρτέλα (Εικόνα 9.21), ορίζονται το αρχείο με τα σημεία (Name of existing vector map (from)), το αρχείο με τις γραμμές ως προς τις οποίες υπολογίζονται οι αποστάσεις (Name of existing vector map (to)) και η επιλογή Minimum distance to nearest feature. Η διαδικασία ολοκληρώνεται με το πλήκτρο Εκτέλεση. Στη συνέχεια με το πλήκτρο Εμφάνιση αποτελέσματος προστίθενται τα δεδομένα στη γραφική απόδοση. Το παράθυρο κλείνει με το πλήκτρο Close. Για τον υπολογισμό στατιστικών μεγεθών για τις τιμές της απόστασης που υπολογίστηκαν, επιλέγεται από το μενού Διανύσματα>Βασική Ανάλυση>Βasic Statistics όπως περιγράφηκε προηγουμένως (βλ. Παράρτημα Α 9.3.4). 
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Εικόνα 9.20 Προσθήκη εργαλείου v.distance.
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Εικόνα 9.21 Εφαρμογή εργαλείου v.distance.
9.4 Οδηγίες εφαρμογής της γενίκευσης στο ΣΓΠ ArcGIS
 
Στη συνέχεια, παρουσιάζονται τα εργαλεία τα οποία μπορούν να αξιοποιηθούν για την υλοποίηση της γενίκευσης στο περιβάλλον του ΣΓΠ ArcGIS (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β). 
9.4.1 Απλοποίηση γραμμικών χαρτογραφικών δεδομένων
 
Από την εργαλειοθήκη ArcToolbox, επιλέγεται Cartography Tools>Generalization>Simplify Line. Στο καινούριο παράθυρο Simplify Line (Εικόνα 9.22), ορίζονται τα ακόλουθα: το όνομα του αρχείου το οποίο αποτελεί αντικείμενο γενίκευσης (Input Features), το όνομα του αρχείου με τα γενικευμένα δεδομένα (Output Feature Class), ο αλγόριθμος απλοποίησης (Simplification Algorithm), δηλαδή Point_Remove ή Bend_Simplify, η ανοχή (Maximum Allowable Offset) και οι μονάδες της ανοχής π.χ. meters. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. O χρήστης μπορεί να επιλέξει είτε τον αλγόριθμο Douglas-Peucker με την επιλογή Point_Remove, είτε τον αλγόριθμο Wang & Muller με την επιλογή Bend_Simplify. 
Επιπλέον, υπάρχουν οι ακόλουθες επιλογές για τη διαχείριση των τοπολογικών σφαλμάτων όπως η τομή των γραμμών (line-crossing), η επικάλυψη των γραμμών (coincident lines), η μετάπτωση των γραμμών σε σημεία από υπερβολική απαλοιφή κορυφών κ.ά.. Η επιλογή Check for topological errors ελέγχει την ύπαρξη ή μη τοπολογικών σφαλμάτων. Η ενεργοποίηση των επιλογών Check for topological errors και Resolve topological errors εντοπίζει τα τοπολογικά σφάλματα. Αυτά καταγράφονται στο πεδίο InLine_FID που καταγράφει τον κωδικό ID των οντοτήτων και στο πεδίο SimLnFlag το οποίο παίρνει την τιμή 0 αν δεν υπάρχουν σφάλματα και 1 αν υπάρχουν. Η ενεργοποίηση των επιλογών Check for topological errors και Resolve topological errors, εντοπίζει και διορθώνει τα τοπολογικά σφάλματα μειώνοντας σε κάθε επανάληψη την τιμή της παραμέτρου ανοχής στο μισό για τις οντότητες για τις οποίες παρουσιάστηκε πρόβλημα. Η διαδικασία επαναλαμβάνεται μέχρι να μην εντοπίζονται πλέον τοπολογικά σφάλματα. Η τιμή της παραμέτρου ανοχής, που χρησιμοποιείται τελικά για κάθε γραμμή, καταγράφεται στον πίνακα ιδιοτήτων (Attribute table) στα πεδία MaxSimpTol και MinSimpTol. Όσον αφορά τη διαχείριση των κλειστών γραμμών μηδενικού μήκους που προκύπτουν λόγω απλοποίησης, η ενεργοποίηση της επιλογής Keep collapsed points δημιουργεί σημειακές οντότητες που ταυτίζονται με την κορυφή αρχής/τέλους για αυτές τις γραμμές. Οι σημειακές αυτές οντότητες αποθηκεύονται σε ένα σημειακό θεματικό επίπεδο το οποίο έχει το ίδιο όνομα με το γραμμικό και  κατάληξη _Pnt.
 
 
[image: ] 
Εικόνα 9.22 Το εργαλείο Simplify Line.
Προκειμένου να επιλεγεί ο βέλτιστος συνδυασμός αλγορίθμου και τιμής της παραμέτρου ανοχής, υπάρχει η ανάγκη υλοποίησης πολλαπλών δοκιμών. Από την εργαλειοθήκη ArcToolbox, επιλέγεται Cartography Tools>Generalization>Simplify Line με δεξί κλικ επιλέγεται Batch. Από το νέο παράθυρο (Εικόνα 9.23) πραγματοποιείται η εφαρμογή της απλοποίησης με διαφορετικές παραμέτρους η οποία οδηγεί σε πολλαπλά αποτελέσματα προς σύγκριση. Σε κάθε γραμμή ορίζονται τα δεδομένα εισόδου (Input Features), τα νέα δεδομένα εξόδου (Output Feature Class), ο αλγόριθμος (Simplification Algorithm: Point_Remove / Bend_Simplify), η τιμή της παραμέτρου ανοχής (Simplification Tolerance), η επιλογή Resolve topological errors (resolve_errors, flag_errors), η επιλογή Keep collapsed points (Keep_collapsed_points, No_keep) και τέλος η επιλογή Check for topological Errors (Check, No_check). Η προσθήκη μιας επιπλέον εφαρμογής της απλοποίησης γίνεται με το «+» που προσθέτει μια επιπλέον γραμμή στον πίνακα η οποία συμπληρώνεται ανάλογα. Η διαδικασία ενεργοποιείται με το ΟΚ.
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Εικόνα 9.23 Χρήση του Simplify Line σε batch mode.
9.4.2 Απλοποίηση επιφανειακών χαρτογραφικών δεδομένων
 
Από την εργαλειοθήκη ArcToolbox, επιλέγεται Cartography Tools>Generalization>Simplify Polygon. Στο καινούριο παράθυρο Simplify Polygon (Εικόνα 9.24) ορίζονται το όνομα του αρχείου προς γενίκευση (Input Features), το όνομα του αρχείου με τα γενικευμένα δεδομένα (Output Feature Class), ο αλγόριθμος απλοποίησης (Simplification Algorithm) δηλαδή Point_Remove ή Bend_Simplify, η τιμή της παραμέτρου ανοχής (Maximum Allowable Offset) και οι μονάδες της ανοχής π.χ. meters, το ελάχιστο εμβαδόν (Minimum Area (optional) και οι μονάδες του π.χ square meters. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. O χρήστης μπορεί να επιλέξει είτε τον αλγόριθμο Douglas-Peucker με την επιλογή Point_Remove είτε τον αλγόριθμο Wang & Muller με την επιλογή Bend_Simplify. Για τις πρόσθετες επιλογές ισχύουν όσα αναφέρθηκαν στην προηγούμενη παράγραφο για την απλοποίηση των γραμμών. Προκειμένου να επιλεγεί ο βέλτιστος συνδυασμός αλγορίθμου και τιμής της παραμέτρου ανοχής, υπάρχει η ανάγκη υλοποίησης πολλαπλών δοκιμών με την επιλογή Batch όπως περιγράφηκε στην παραπάνω παράγραφο.
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Εικόνα 9.24 Εργαλείο Simplify Polygon.
9.4.3 Εξομάλυνση γραμμικών χαρτογραφικών δεδομένων
 
Από την εργαλειοθήκη ArcToolbox , επιλέγεται Cartography Tools>Generalization>Smooth Line. Στο νέο παράθυρο Smooth Line (Εικόνα 9.25) ορίζονται το όνομα του αρχείου το οποίο αποτελεί αντικείμενο γενίκευσης (Input Features), το όνομα του αρχείου με τα γενικευμένα δεδομένα (Output Feature Class), ο αλγόριθμος εξομάλυνσης (Smoothing Algorithm) και η τιμή της παραμέτρου ανοχής (Smoothing Tolerance) για τον αλγόριθμο PAEK. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. O χρήστης μπορεί να επιλέξει είτε τον αλγόριθμο PAEK είτε τον αλγόριθμο Bezier. Επιπλέον, υπάρχουν οι ακόλουθες επιλογές για τη διαχείριση των τοπολογικών σφαλμάτων. Η επιλογή Preserve endpoint for closed lines, διατηρεί τη θέση της πρώτης κορυφής για τις κλειστές γραμμές. Η επιλογή NO_CHECK δεν ελέγχει την ύπαρξη τοπολογικών σφαλμάτων και η επιλογή FLAG_ERRORS επισημαίνει την ύπαρξη τοπολογικών σφαλμάτων εάν αυτά δημιουργηθούν. Προκειμένου να επιλεγεί ο βέλτιστος συνδυασμός αλγορίθμου και τιμής της παραμέτρου ανοχής, υπάρχει η ανάγκη υλοποίησης πολλαπλών δοκιμών με επιλογή Batch όπως περιγράφηκε σε προηγούμενη παράγραφο.
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Εικόνα 9.25 Το εργαλείο Smooth Line.
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Εικόνα 9.26 Το εργαλείο Smooth Polygon.
 
9.4.4 Εξομάλυνση επιφανειακών χαρτογραφικών δεδομένων
 
Από την εργαλειοθήκη ArcToolbox , επιλέγεται Cartography Tools>Generalization>Smooth Polygon. Στο νέο παράθυρο Smooth Polygon (Εικόνα 9.26) ορίζονται το όνομα του αρχείου  το οποίο αποτελεί αντικείμενο γενίκευσης (Input Features), το όνομα του αρχείου με τα γενικευμένα δεδομένα (Output Feature Class), ο αλγόριθμος εξομάλυνσης (Smoothing Algorithm) και η τιμή της παραμέτρου ανοχής (Smoothing Tolerance). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. O χρήστης μπορεί να επιλέξει είτε τον αλγόριθμο PAEK είτε τον αλγόριθμο Bezier. Παράλληλα, για τις πρόσθετες επιλογές ισχύουν όσα αναλύθηκαν στην προηγούμενη παράγραφο για την εξομάλυνση των γραμμών. Προκειμένου να επιλεγεί ο βέλτιστος συνδυασμός αλγορίθμου και τιμής της παραμέτρου ανοχής, υπάρχει η ανάγκη υλοποίησης πολλαπλών δοκιμών με την επιλογή Batch, όπως περιγράφηκε σε προηγούμενη παράγραφο.
9.4.5 Διαγραφή χαρτογραφικών δεδομένων
 
Η διαγραφή πραγματοποιείται στο περιβάλλον γραφικής επεξεργασίας ArcMap. Η έναρξη της διόρθωσης γίνεται με την επιλογή Start Editing από το πλήκτρο Editing του Editor toolbar. Η Επιλογή οντότητας προς διόρθωση γίνεται με την ενεργοποίηση του εργαλείου [image: ] (Edit Tool) από το Editor toolbar και στη συνέχεια με την υπόδειξη της οντότητας με το ποντίκι. Όταν επιλεγεί μια οντότητα, η διαγραφή της γίνεται με την επιλογή Delete η οποία εμφανίζεται με δεξί κλικ του ποντικιού ή με το πλήκτρο Delete από το πληκτρολόγιο. Η αποθήκευση των δεδομένων στη νέα τους κατάσταση γίνεται με την επιλογή Save Edits από το πλήκτρο Editing του Editor toolbar. Η ολοκλήρωση της διόρθωσης γίνεται με την επιλογή Stop Editing από το πλήκτρο Editing του Editor toolbar. 
9.4.6 Μετάπτωση επιφανειακών χαρτογραφικών δεδομένων σε σημειακά
 
Το εργαλείο Feature To Point δημιουργεί σημειακές οντότητες οι οποίες αντιπροσωπεύουν πολύγωνα. Χρησιμοποιεί το κέντρο βάρους για ένα πολύγωνο ή μια ομάδα πολυγώνων. Από την εργαλειοθήκη ArcToolbox, επιλέγεται Data Management>Features>Feature To Point. Στο νέο παράθυρο Feature to point ορίζονται τα αρχικά δεδομένα (πολύγωνα) (Input features) και τα νέα δεδομένα (σημεία) που δημιουργούνται (Output feature class). Η ενεργοποίηση της επιλογής Inside (optional) δημιουργεί σημεία εντός των πολυγώνων ανεξάρτητα από τη θέση του κέντρου βάρους. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.
 
 
[image: ]
Εικόνα 9.27 Εργαλείο Feature To Point.
 
9.4.7 Δημιουργία νέου θεματικού επιπέδου με την επιλογή υποσυνόλου δεδομένων με βάση τις τιμές των ιδιοτήτων τους
 
Από την εργαλειοθήκη ArcToolbox, επιλέγεται Analysis Tools>Εxtract>Select. Στο νέο παράθυρο Select, ορίζονται το όνομα του θεματικού επιπέδου από το οποίο εξάγονται τα στοιχεία (Input Features), το όνομα του νέου θεματικού επιπέδου το οποίο δημιουργείται (Output Feature Class) και η λογική πρόταση Expression με την οποία γίνεται η επιλογή. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Η σύνταξη της λογικής πρότασης ξεκινάει με το πλήκτρο SQL [image: ] και ολοκληρώνεται στο νέο παράθυρο Query Builder (Εικόνα 9.28), με τη βοήθεια των λογικών τελεστών, των πεδίων και των τιμών που αυτά λαμβάνουν. Για να εμφανιστούν οι τιμές που λαμβάνουν τα πεδία χρησιμοποιείται το πλήκτρο Get Unique Values. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
 
 
[image: ]
Εικόνα 9.28 Το εργαλείο Select.
 
 
9.4.8 Υπολογισμός του μέσου βήματος καταγραφής των γραμμικών / επιφανειακών δεδομένων
 
Αρχικά στον πίνακα ιδιοτήτων (attribute table) των γεωχωρικών δεδομένων, προστίθενται ένα πεδίο για την αποθήκευση του αριθμού των κορυφών (NumPoints) και ένα για το μέσο βήμα (DS). Στο περιβάλλον του ArcMap προστίθεται το θεματικό επίπεδο. Επιλέγεται το θεματικό επίπεδο και με δεξί κλικ του ποντικιού Open Attribute Table>Table Options [image: ]>Add Field. Στο νέο παράθυρο Add Field, συμπληρώνονται το όνομα του πεδίου Name και το είδος Type π.χ. Short Integer, Long Integer, Double, Text κ.ά. Προστίθενται τα πεδία NumPoints τύπου Long Integer και DS τύπου Double. 
Για τους υπολογισμούς, επιλέγεται το θεματικό επίπεδο και με δεξί κλικ Open Attribute Table. Στο νέο παράθυρο επιλέγεται ένα πεδίο του πίνακα και με δεξί κλικ η επιλογή Field Calculator. Για παράδειγμα, για να υπολογιστεί ο αριθμός κορυφών κάθε γραμμικής οντότητας επιλέγεται το πεδίο NumPoints, με δεξί κλικ Field Calculator και στο νέο παράθυρο επιλέγεται Python και πληκτρολογείται !shape!.pointcount (Εικόνα 9.29). Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Για τον υπολογισμό του Μέσου βήματος, επιλέγεται το πεδίο DS και χρησιμοποιείται η συνάρτηση !Shape_Length!/!NumPoints! (Εικόνα 9.30). Για να προσδιοριστεί η μέση τιμή του πεδίου DS, επιλέγεται το θεματικό επίπεδο και με δεξί κλικ Open Attribute Table. Στη συνέχεια επιλέγεται το πεδίο του πίνακα και με δεξί κλικ η επιλογή Statistics (Εικόνα 9.31). 
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Εικόνα 9.29 Υπολογισμός αριθμού κορυφών.
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Εικόνα 9.30 Υπολογισμός μέσου βήματος.
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Εικόνα 9.31 Υπολογισμός στατιστικών τιμών.
 
 
 
9.4.9 Υπολογισμός μεταβολής της οριζοντιογραφικής θέσης
 
Αρχικά, δημιουργείται ένα σημειακό θεματικό επίπεδο από το γραμμικό θεματικό επίπεδο με βάση τις κορυφές που ορίζουν τις γραμμές. Από την εργαλειοθήκη ArcToolbox, επιλέγεται Data Management>Features>Feature Vertices to Points. Στο νέο παράθυρο Feature Vertices to Points (Εικόνα 9.33) ορίζονται τα γραμμικά δεδομένα Input features, τα νέα σημειακά δεδομένα Output feature class και με την επιλογή Point Type ποιες κορυφές χρησιμοποιούνται π.χ. με την επιλογή Point Type: All όλες οι κορυφές των γραμμικών οντοτήτων μετατρέπονται σε σημειακές. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. 
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Εικόνα 9.32 Το εργαλείο Feature Vertices to Points.
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Εικόνα 9.33 Το εργαλείο Generate Near Table.
Στη συνέχεια, υπολογίζονται οι αποστάσεις από τα σημεία (πρώην κορυφές) προς τη γενικευμένη γραμμή και εξάγεται ο μέσος όρος. Από την εργαλειοθήκη ArcToolbox, επιλέγεται Analysis Tools>Proximity>Generate Near Table. Στο νέο παράθυρο Generate Near Table (Εικόνα 9.33), ορίζονται τα σημεία που προέκυψαν από τις κορυφές των αρχικών δεδομένων ως Input features, τα γραμμικά δεδομένα μετά την απλοποίηση Near Features και ο νέος πίνακας με τις αποστάσεις Output table. Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Για τον υπολογισμό των στατιστικών τιμών του νέου πίνακα ακολουθείται η διαδικασία που περιγράφηκε σε προηγούμενη παράγραφο. 
9.4.10 Εργαλεία γενίκευσης επιφανειακών χαρτογραφικών δεδομένων 
 
Στη συνέχεια, παρουσιάζονται συνοπτικά τα εργαλεία τα οποία βρίσκονται στο μενού ArcToolbox>Data Management>Generalisation και μπορούν να χρησιμοποιηθούν για τη γενίκευση πολυγώνων. To εργαλείο Dissolve συνενώνει πολύγωνα τα οποία έχουν ένα κοινό όριο ή γραμμές που έχουν ένα κοινό κόμβο και επιπλέον έχουν την ίδια τιμή σε κάποια ιδιότητα. Το εργαλείο χρησιμοποιείται όταν λόγω της αλλαγής της ταξινόμησης των ιδιοτήτων πρέπει να αλλάξει η γεωμετρία. Δηλαδή όταν δύο γειτονικά πολύγωνα με την αρχική ταξινόμηση θεωρούνταν διαφορετικά και με τη νέα ταξινόμηση ανήκουν στην ίδια κατηγορία, πρέπει να καταργηθούν τα ενδιάμεσα όρια και να συνενωθούν σε ένα ενιαίο πολύγωνο. Ανάλογη διαχείριση απαιτείται σε ένα οδικό δίκτυο που αλλάζει ταξινόμηση. Για να εφαρμοστεί η διαδικασία  Dissolve προηγείται η διαχείριση των τιμών των πεδίων των ιδιοτήτων ώστε να αποκτήσουν νέες τιμές. To εργαλείο Delineate Built-Up Areas δημιουργεί πολύγωνα που αντιπροσωπεύουν οικιστικές περιοχές αναγνωρίζοντας περιοχές με μεγάλη πυκνότητα σπιτιών σε χάρτες μικρής κλίμακας. To εργαλείο Simplify Building απλοποιεί το όριο των κτηρίων διατηρώντας το σχήμα και το μέγεθος. To εργαλείο Aggregate Polygons συνενώνει πολύγωνα που απέχουν απόσταση μικρότερη από ένα όριο και σχηματίζει νέα πολύγωνα. 
9.4.11 Εργαλεία γενίκευσης σημειακών χαρτογραφικών δεδομένων
 
To εργαλείο ArcToolbox>Data Management>Generalization>Aggregate Points δημιουργεί πολύγωνα γύρω από ομάδες σημείων (για να δημιουργηθεί μια ομάδα χρειάζονται τουλάχιστον 3 σημεία) τα οποία απέχουν απόσταση μικρότερη από ένα όριο.
9.4.12 Εργαλεία  γενίκευσης γραμμικών χαρτογραφικών δεδομένων
 
Τα εργαλεία που ακολουθούν, βρίσκονται στο μενού ArcToolbox>Data Management>Generalization και μπορούν να χρησιμοποιηθούν για τη γενίκευση γραμμών. To εργαλείο Collapse Road Detail απαλείφει μικρά τμήματα των δρόμων που διαταράσσουν τη συνολική μορφή του οδικού δικτύου όπως κυκλικά τμήματα γύρω από πλατείες και τα αντικαθιστά με μια απλοποιημένη μορφή. To εργαλείο Collapse Dual Lines To Centerline εξάγει τον άξονα συμμετρίας από διπλές γραμμές δρόμων χρησιμοποιώντας την παράμετρο του πλάτους. To εργαλείο Thin Road Network δημιουργεί ένα απλοποιημένο οδικό δίκτυο για μια μικρότερη κλίμακα διατηρώντας τη συνδεσιμότητα και το γενικό χαρακτήρα. 
9.4.13 Εργαλεία διαχείρισης των προβλημάτων του συμβολισμού
 
Τα εργαλεία που ακολουθούν, βρίσκονται στο μενού ArcToolbox>Cartography Tools>Generalisation και χρησιμοποιούνται για την επίλυση γραφικών προβλημάτων τα οποία προκύπτουν από την εφαρμογή του συμβολισμού. To εργαλείο Create Cartographic Partitions δημιουργεί ένα πλέγμα από πολύγωνα για ένα θεματικό επίπεδο όπου κάθε πολύγωνο περιλαμβάνει ένα συγκεκριμένο αριθμό δεδομένων, ο οποίος εξαρτάται από την πυκνότητα και την κατανομή των δεδομένων. To εργαλείο Detect Graphic Conflict δημιουργεί πολύγωνα εκεί όπου επικαλύπτονται δύο ή περισσότερες γεωγραφικές οντότητες μετά την εφαρμογή του συμβολισμού. To εργαλείο Resolve Building Conflicts επιλύει προβλήματα επικάλυψης των συμβόλων των κτηρίων με μετάθεση ή αφαίρεση εξετάζοντας τις σχετικές τους θέσεις. To εργαλείο Resolve Road Conflicts επιλύει προβλήματα επικάλυψης των συμβόλων του οδικού δικτύου προσαρμόζοντας τμήματα των γραμμικών τμημάτων. To εργαλείο Propagate Displacement διαχειρίζεται τη μετάθεση που έχει προκύψει από τη διαχείριση των προβλημάτων επικάλυψης του οδικού δικτύου με την εφαρμογή των εντολών Resolve Road Conflicts και Merge Divided Roads. Η μετάθεση μεταδίδεται στις γειτονικές οντότητες ώστε να αποκατασταθούν οι χωρικές σχέσεις.
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Κριτήρια αξιολόγησης 
Στη συνέχεια ακολουθούν μια σειρά από κριτήρια αξιολόγησης με τη μορφή ερωτήσεων των οποίων οι απαντήσεις βρίσκονται εντός του κειμένου του κεφαλαίου. 
 
Κριτήριο αξιολόγησης 1 
Γιατί εφαρμόζεται η χαρτογραφική γενίκευση;
Κριτήριο αξιολόγησης 2
Ποιοι παράγοντες επηρεάζουν τη διαδικασία της χαρτογραφικής γενίκευσης;
Κριτήριο αξιολόγησης 3
Περιγράψτε τη διαδικασία γενίκευσης τριών θεματικών επιπέδων (ένα σημειακό, ένα γραμμικό και ένα επιφανειακό).
 
Κριτήριο αξιολόγησης 4
Ποιοι τελεστές εφαρμόζονται για τη γενίκευση των γραμμικών χαρτογραφικών δεδομένων; Αναφέρατε ορισμένους αλγορίθμους για την υλοποίηση κάθε τελεστή.
Κριτήριο αξιολόγησης 5
Υπάρχουν εργαλεία αξιολόγησης των αποτελεσμάτων της χαρτογραφικής γενίκευσης για τα γραμμικά χαρτογραφικά δεδομένα;
Κριτήριο αξιολόγησης 6 
Ποια εργαλεία μπορούν να χρησιμοποιηθούν για τη χαρτογραφική γενίκευση των γραμμικών χαρτογραφικών δεδομένων σε ένα ΣΓΠ;
 
Κριτήριο αξιολόγησης 7
Ποια εργαλεία μπορούν να χρησιμοποιηθούν για τη χαρτογραφική γενίκευση των σημειακών χαρτογραφικών δεδομένων σε ένα ΣΓΠ;
 
Κριτήριο αξιολόγησης 8
Ποια εργαλεία μπορούν να χρησιμοποιηθούν για τη χαρτογραφική γενίκευση των επιφανειακών χαρτογραφικών δεδομένων σε ένα ΣΓΠ;
 
 
Κεφάλαιο 10 
Σύνθεση χάρτη σε ψηφιακό περιβάλλον
Σύνοψη
Στο κεφάλαιο αυτό, παρουσιάζονται οι διαδικασίες που ακολουθούνται για τη σύνθεση χάρτη σε ψηφιακό περιβάλλον. Πιο συγκεκριμένα, παρατίθενται τα στοιχεία της χαρτοσύνθεσης, οι αρχές της χαρτογραφικής σχεδίασης, τα στοιχεία του χαρτογραφικού σχεδίου, τα στοιχεία του χαρτογραφικού συμβολισμού και ο τρόπος με τον οποίο αυτά υλοποιούνται σε περιβάλλον QGIS και ArcGIS, ανάλογα με τα κατά περίπτωση διαθέσιμα εργαλεία. 
Προαπαιτούμενη γνώση 
Χαρτογραφικές απεικονίσεις, μέθοδοι ταξινόμησης δεδομένων, μέθοδοι χαρτογραφικού συμβολισμού, σύνταξη λογικών εκφράσεων (SQL).
10. Χαρτογραφική σύνθεση και απόδοση
 
Κατά τη χαρτογραφική σύνθεση ενοποιείται και αποδίδεται, σύμφωνα με τους κανόνες της χαρτογραφικού συμβολισμού και της χαρτογραφικής σχεδίασης, το σύνολο των θεματικών επιπέδων των χαρτογραφικών δεδομένων που συλλέχθηκαν και αποτέλεσαν αντικείμενο επεξεργασίας στο πλαίσιο των προηγούμενων φάσεων της χαρτογραφικής διαδικασίας. Επιπλέον και για την ολοκλήρωση της  σύνθεσης/απόδοσης του χάρτη, πρέπει να προστεθούν όλα τα απαραίτητα για τον χάρτη στοιχεία όπως: ονοματολογία, κάναβος, πλαίσιο, γραφική κλίμακα, υπόμνημα συμβόλων, τίτλος κλπ. 
Η χαρτογραφική σύνθεση είναι μια δημιουργική κι όχι τυποποιημένη διαδικασία, κατά την οποία ο χαρτοσυνθέτης καλείται να οργανώσει το υλικό που διαθέτει σε ένα κατανοητό σύνολο, ώστε να επιτευχθεί νοητική και οπτική διάρθρωση του χάρτη (Dent, 1999) και να διευκολυνθεί η επικοινωνία (μετάδοση) της χαρτογραφικής πληροφορίας στον χρήστη του χάρτη. Η χαρτογραφική σχεδίαση έχει ως κύριο στόχο να τονίσει τον σκοπό του χάρτη και να ενεργοποιήσει και να κατευθύνει την προσοχή του χρήστη του χάρτη. Με άλλα λόγια, σκοπός της χαρτογραφικής σχεδίασης είναι η αποτελεσματική μετάδοση της χαρτογραφικής πληροφορίας. Για τον λόγο αυτό, εναρμονίζει το υπόβαθρο με τα θεματικά στοιχεία του χάρτη και διατηρεί τις χαρτογραφικές συμβάσεις σε συνέπεια με καλό οπτικό αποτέλεσμα. Η υλοποίησή της στηρίζεται στην επιλογή των κατάλληλων γραφικών στοιχείων, στον συσχετισμό τους με τα χαρτογραφικά δεδομένα και στην οργάνωσή τους σε λειτουργική διάταξη και ολοκληρωμένη σύνθεση. Ως δημιουργική διαδικασία αποτελεί πρόκληση για τον χαρτοσυνθέτη, καθώς καλείται συχνά να βρει δημιουργικές γραφιστικές λύσεις τόσο για τη συνολική διάρθρωση του χάρτη, όσο και για επιμέρους ζητήματα τα οποία προκύπτουν σε σχέση με τον συμβολισμό των στοιχείων των θεματικών επιπέδων. Ολοκληρώνεται όταν ολοκληρωθεί ο τελικός χάρτης.
Ο χάρτης, ως γραφιστικό μέσο αναπαράστασης του γεωγραφικού χώρου, έχει συγκεκριμένα χαρακτηριστικά τα οποία τον διαφοροποιούν από άλλα (αντίστοιχα) μέσα όπως οι αεροφωτογραφίες, οι ορθοφωτογραφίες κλπ. Αυτά είναι τα εξής:
 
 
	Το προβολικό σύστημα.
	Η επιλογή και γενίκευση των χωρικών στοιχείων που απεικονίζονται.
	Η επιλογή και εφαρμογή του συμβολισμού.
	Το υπόμνημα συμβόλων.
	Οι πληροφορίες περιθωρίου.

 
10.1 Αρχές και στόχοι της χαρτογραφικής σχεδίασης 
 
Οι αρχές της χαρτογραφικής σχεδίασης, αναφέρονται στα χαρακτηριστικά τα οποία πρέπει να έχει ένας χάρτης ως προϊόν γραφισμού (Robinson, Morrison, Muehrcke, Kimerling & Guptill, 1995), αν και σε άλλες βιβλιογραφικές πηγές αυτά αναφέρονται ως στοιχεία της χαρτογραφικής σχεδίασης (Dent, 1999; Slocum , McMaster, Kessler & Howard, 2005). Τα χαρακτηριστικά αυτά είναι:
 
	Η αναγνωσιμότητα ή ευκρίνεια (legibility) των συμβόλων.
	Η οπτική αντίθεση.
	Η οργάνωση εικόνας-υποβάθρου.
	Η ιεραρχική οργάνωση. 

 
Τα σύμβολα τα οποία χρησιμοποιούνται πρέπει να είναι ευανάγνωστα και να γίνονται εύκολα αντιληπτά. Για το μέγεθός τους, μεταξύ άλλων, πρέπει να ληφθούν υπόψη τα ελάχιστα μεγέθη για την ευκρίνειά τους σε σχέση με την απόσταση θέασης του χάρτη και τα όρια που προκύπτουν από τη φυσιολογία του ανθρώπινου οπτικού συστήματος. Εκτός από το μέγεθός τους, ο τύπος του συμβόλου αλλά και η εξοικείωση του χρήστη με τον χάρτη έχουν σημαντική επίδραση στην αναγνώριση της ταυτότητάς του (Robinson et al., 1995). 
Η οπτική αντίθεση είναι ίσως ο σημαντικότερος γραφικός παράγοντας, για την αναγνώριση (αντίληψη) ενός συμβόλου, τόσο σε σχέση με το φόντο του όσο και σε σχέση με παρακείμενα σύμβολα. Εάν ένα σύμβολο είναι αρκετά μεγάλο ώστε να είναι ευκρινές, ο τρόπος που αυτό δημιουργεί αντίθεση με το φόντο του και τα γειτονικά του στοιχεία,  καθορίζει το πώς γίνεται αντιληπτό. Το πόσο καθαρός και έντονος φαίνεται ένας χάρτης  εξαρτάται σε μεγάλο βαθμό από το σύνολο των αντιθέσεων που περιλαμβάνει.
Η ιεραρχική οργάνωση αφορά τον διαχωρισμό των ουσιωδών χαρακτηριστικών σε έναν χάρτη και επιτυγχάνεται με την εφαρμογή μιας εσωτερικής δομής των γραφικών στοιχείων του. Με τη χρήση των μέσων τα οποία παρέχει αυτή η οπτική διαστρωμάτωση, στόχος είναι να απεικονιστούν και, κυρίως, να αναδειχθούν οι ομοιότητες, οι διαφορές και οι συσχετισμοί των χωρικών στοιχείων, δηλαδή οι χωρικές σχέσεις. 
Η οργάνωση εικόνας-υποβάθρου, ως στοιχείο της οπτικής αντίληψης, συνίσταται στο διαχωρισμό μιας οπτικής ακολουθίας σε δύο επίπεδα: το σχετικά άμορφο υπόβαθρο που λειτουργεί ως φόντο, ως παρασκήνιο (background), επάνω στο οποίο διαμορφώνεται και ξεπροβάλλει η εικόνα ως προσκήνιο (foreground) που έχει πιο σαφή και συνεκτική παρουσία. Το μάτι έχει την τάση να σταματάει στην εικόνα η οποία περιέχεται στο μάλλον άμορφο υπόβαθρο κάνοντας αυτόματο διαχωρισμό, ο οποίος ενισχύεται με τη χρήση οπτικών διαφοροποιήσεων όπως εντάσεων, χρωμάτων, μοτίβων, περιγραμμάτων. Πρέπει να σημειωθεί πάντως, ότι η εξοικείωση επηρεάζει σημαντικά την κατανόηση της εικόνας, δηλαδή γίνεται πιο εύκολα αντιληπτό ένα σχήμα που είναι γνωστό. Ομοίως αποτελεσματική είναι και η χρήση λεπτομερειών στη διαμόρφωση της εικόνας. Τα σύμβολα, τα ονόματα αλλά και το πλήθος των χωρικών στοιχείων τα οποία απεικονίζονται, λειτουργούν σαν οπτικά ερεθίσματα ώστε να συγκροτείται η εικόνα στην περιοχή του μεγάλου πλήθους πληροφοριών και να υποχωρεί οπτικά το υπόβαθρο. Εξίσου σημαντικό στοιχείο διαχωρισμού εικόνας και υποβάθρου, είναι το μέγεθος της επιφάνειας, διότι οι μικρότερες επιφάνειες τείνουν να προβάλλουν ως εικόνα και οι μεγαλύτερες ως υπόβαθρο (Robinson et al., 1995).
Ο κύριος επικοινωνιακός στόχος της χαρτογραφικής σχεδίασης, είναι η αναπαράσταση γεωχωρικών δεδομένων, εννοιών και σχέσεων σε έναν χάρτη. Υλοποιείται πρωτίστως με την εκχώρηση σημασίας στα σύμβολα και στη διάταξη των συμβόλων σε μια  συνολική σύνθεση. Οι σχεδιαστικοί στόχοι και οι χειρισμοί των γραφικών, διαφέρουν ανάλογα με το είδος του χάρτη. Στους χάρτες γενικής αναφοράς, οι οποίοι χαρακτηρίζονται από την απόδοση ποικιλίας γεωγραφικών πληροφοριών, ιδανικά κανένα σύμβολο δεν πρέπει να εμφανίζεται περισσότερο σημαντικό από κάποιο άλλο και καμία κατηγορία να μην κυριαρχεί, εκτός από κάποια ειδική περίπτωση όπου πρέπει να δοθεί έμφαση. Αυτός ο σχεδιαστικός και εννοιολογικός στόχος επιτυγχάνεται μέσω της ευκρίνειας και της γραφικής αντίθεσης μεταξύ των συμβόλων. Στους θεματικούς χάρτες, κυρίαρχο στοιχείο είναι η απεικόνιση μιας δεδομένης γεωγραφικής κατανομής, η οποία αναδεικνύεται όχι μόνο με την κατάλληλη μέθοδο συμβολισμού, αλλά και με την υποβάθμιση ή/και εξάλειψη άλλων χωρικών στοιχείων τα οποία δεν σχετίζονται με τη συγκεκριμένη γεωγραφική κατανομή.   
Οι περισσότερες σχεδιαστικές επιλογές είναι συμβάσεις, οι οποίες έχουν εδραιωθεί στη χαρτογραφική παράδοση και τεκμηριώνονται επιστημονικά, κυρίως με βάση την αντίληψη του ανθρώπινου οπτικού συστήματος και την ψυχολογία. Παρά τη διαθεσιμότητα απεριόριστων πρακτικά επιλογών, τελικά αυτές ενέχουν ένα συνδυασμό διαίσθησης και λογικής με σκοπό την αρτιότητα της επικοινωνίας. Η χαρτογραφική σχεδίαση είναι αποτελεσματική, όταν:
 
	Μεταδίδει τη χωρική πληροφορία με τον βέλτιστο τρόπο.
	Περιορίζεται στο ουσιαστικό περιεχόμενο της διαθέσιμης πληροφορίας.
	Αφαιρεί από τον χάρτη οποιαδήποτε περιττά ή ασήμαντα στοιχεία.
	Εγγυάται την επιθυμητή ακρίβεια θέσης.
	Εφαρμόζει συμβολισμό που εξασφαλίζει άμεσο και επιτυχή συνειρμό για τα δεδομένα.
	Υποδηλώνει με σαφήνεια το περιεχόμενο του χάρτη.
	Υπακούει στις χαρτογραφικές αρχές.
	Έχει αποτέλεσμα ευανάγνωστο και αισθητικά ικανοποιητικό χάρτη.
	Είναι εφικτή η κατασκευή του, δηλαδή, η παραγωγή και η αναπαραγωγή του.

 
10.2 Στοιχεία χαρτογραφικού σχεδίου
 
Παρά τη μεγάλη ποικιλία που παρουσιάζουν οι χάρτες ως προς τη μορφή τους, οι περισσότεροι συγκροτούνται από συγκεκριμένα στοιχεία, τα οποία μάλιστα αποτελούν τα δομικά στοιχεία της χαρτογραφικής επικοινωνίας, δηλαδή μεταδίδουν τη γεωγραφική πληροφορίας (Slocum et al., 2005). Τα πιο συνηθισμένα στοιχεία  του χαρτογραφικού σχεδίου (συστατικά στοιχεία της σύνθεσης), κοινά στους περισσότερους χάρτες, είναι:
 
	Η χαρτογραφούμενη περιοχή.
	Το περίγραμμα της χαρτογραφούμενης περιοχής και το περίγραμμα του χάρτη.
	Ο τίτλος και ο υπότιτλος.
	Τα ένθετα (χάρτες, γραφήματα, εικόνες κλπ.).
	Το υπόμνημα συμβόλων.
	Η κλίμακα.
	Οι πηγές δεδομένων.
	Ο προσανατολισμός.

 
Η χαρτογραφική σχεδίαση αφορά την επιλογή των χαρτογραφικών στοιχείων τα οποία θα συμπεριληφθούν στον χάρτη αλλά και στον τρόπο με τον οποίο θα ενσωματωθούν σε αυτόν. Η υλοποίησή τους σχετίζεται με την επιλογή του περιεχομένου, του μεγέθους, της θέσης και του στυλ κάθε στοιχείου.
 
 
10.3 Η σύνθεση του χάρτη
 
Για δεδομένη απεικόνιση (προβολή), η οποία επιλέγεται με βάση το είδος και τον σκοπό του χάρτη, η σύνθεση του χάρτη αρχίζει με τον προσδιορισμό των εξής παραγόντων, οι οποίοι, μάλιστα αλληλοεπηρεάζονται:
 
	Καθορισμός των ορίων της χαρτογραφούμενης περιοχής.
	Υπολογισμός των διαστάσεων της χαρτογραφούμενης περιοχής.
	Καθορισμός της κλίμακας.
	Επιλογή του μεγέθους του μέσου απόδοσης.

 
Μέχρι εδώ, το πρόβλημα είναι απλά γεωμετρικό, πώς δηλαδή θα συνδυαστούν τα στοιχεία αυτά για να μορφοποιηθεί ο χάρτης ως προς το σχήμα και το μέγεθός του και να συγκροτηθεί το αρχιτεκτονικό του (layout). Η διαμόρφωση του αρχιτεκτονικού και η επιλογή και εφαρμογή του κατάλληλου συμβολισμού, ολοκληρώνουν τη σύνθεση του χάρτη. Η σύνταξη του αρχιτεκτονικού, αφορά την ενσωμάτωση της χαρτογραφούμενης περιοχής και των συστατικών στοιχείων της σύνθεσης, δηλαδή τον τίτλο του χάρτη, το υπόμνημα των συμβόλων, τυχόν ένθετα και δείκτες διεύθυνσης. Στους χάρτες μεγάλης κλίμακας τα συστατικά στοιχεία της σύνθεσης τοποθετούνται ως πληροφορίες περιθωρίου, δηλαδή εκτός χαρτογραφούμενης περιοχής. Αντίθετα, στους χάρτες μικρής κλίμακας, τα συστατικά στοιχεία της σύνθεσης τοποθετούνται συνήθως μέσα στο πλαίσιο του χάρτη. Βέβαια, στην περίπτωση αυτή, συνιστάται η γραφιστική διαφοροποίηση των στοιχείων αυτών σε σχέση με τα χωρικά στοιχεία. Σε κάθε περίπτωση, η τοποθέτηση των συστατικών στοιχείων της σύνθεσης γίνεται με τέτοιο τρόπο, ώστε η συνολική εικόνα να είναι ισορροπημένη. Η εξισορρόπηση των στοιχείων του χάρτη υλοποιείται γύρω από το οπτικό κέντρο του, το οποίο βρίσκεται λίγο ψηλότερα από το γεωμετρικό κέντρο του χάρτη (5% του ύψους). Για έναν έντυπο χάρτη, η ιδανική σχέση διαστάσεων είναι 3:5. Στη χαρτογραφική σύνθεση (Εικόνα 10.1) περιλαμβάνονται:
 
	Η απόδοση της χαρτογραφούμενης περιοχής σύμφωνα με τους κανόνες του χαρτογραφικού συμβολισμού.
	Το πλαίσιο, γεωγραφικό πλέγμα ή/και κάναβος τετραγωνισμού, ενδείξεις γεωγραφικών ή/και καρτεσιανών συντεταγμένων, στοιχεία τα οποία, εκτός από τη θέση των χαρτογραφικών στοιχείων, καθορίζουν και την έκταση του χάρτη και οργανώνουν το περιεχόμενό του.
	Οι πληροφορίες θέσης.
	Τα ένθετα  (εάν υπάρχουν).
	Ο τίτλος και ο υπότιτλος.
	Το υπόμνημα συμβόλων.
	Η κλίμακα (ονομαστική και γραφική).
	Τα στοιχεία της χαρτογραφικής απεικόνισης (cartographic projection) και του συστήματος αναφοράς.
	Οι δείκτες προσανατολισμού (εάν απαιτούνται).
	Ο χάρτης θέσης ή κατανομής φύλλων εάν πρόκειται για σειρά χαρτών.
	Οι πηγές δεδομένων & τα στοιχεία της έκδοσης (φορέας, χρονολογία κλπ.).

 
Ειδικά για τους δείκτες προσανατολισμού, πρέπει να διευκρινιστεί ότι δεν χρειάζεται να συμπεριληφθούν στη χαρτοσύνθεση όταν περιλαμβάνεται το γεωγραφικό πλέγμα, καθώς  σε κάθε σημείο του χάρτη η διεύθυνση του μεσημβρινού δηλώνει τη διεύθυνση του Βορρά στη συγκεκριμένη θέση. Εάν παρόλα αυτά ο χαρτοσυνθέτης αποφασίσει να συμπεριλάβει και δείκτη του αληθούς Βορρά, θα πρέπει να τοποθετηθεί με την κατάλληλη γωνία σχεδίασης, σύμφωνα με τη γωνία διεύθυνσης του μεσημβρινού στη συγκεκριμένη θέση, αφού σε πολλές χαρτογραφικές απεικονίσεις, οι μεσημβρινοί όχι μόνο δεν είναι παράλληλοι μεταξύ τους, αλλά μπορεί να είναι και καμπύλες γραμμές. Οι δείκτες προσανατολισμού είναι απαραίτητοι όταν ο χάρτης είναι σχεδιασμένος υπό στροφή και όχι σύμφωνα με τον προσανατολισμό του γεωγραφικού πλέγματος, αλλά και όταν χάρτης χρησιμοποιείται για πλοήγηση (Slocum et al., 2005).
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Εικόνα 10.1 Παράδειγμα σύνθεσης χάρτη.
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Εικόνα 10.2 Κατακόρυφη στοίχιση των χαρτογραφικών στοιχείων.
Για ό,τι αφορά στη διάταξη του χάρτη στο μέσο απόδοσης, βασικά κριτήρια αποτελούν η αναλογία των διαστάσεων της χαρτογραφούμενης περιοχής κατά τις διευθύνσεις Βορρά-Νότου και Ανατολής-Δύσης, καθώς και οι διαστάσεις του μέσου απόδοσης (π.χ.  ύψος/πλάτος του χαρτιού εκτύπωσης). Η οριζόντια διάταξη (landscape) είναι προτιμότερη στις περιπτώσεις που η χαρτογραφούμενη περιοχή έχει μεγαλύτερο μήκος κατά τη διεύθυνση Ανατολής-Δύσης, ενώ η κατακόρυφη διάταξη (portrait) προτιμάται στις περιπτώσεις που η διάσταση κατά τη διεύθυνση Βορρά-Νότου είναι μεγαλύτερη. Κατά τη σύνταξη του αρχιτεκτονικού, ειδική μέριμνα απαιτείται για την οριζόντια και κατακόρυφη στοίχιση των επιμέρους στοιχείων (Εικόνα 10.2).
Το υπόμνημα των συμβόλων, τα οποία χρησιμοποιούνται στον χάρτη, είναι ένα από τα στοιχεία περιθωρίου και το πλέον κρίσιμο για την επίτευξη της επικοινωνίας της χαρτογραφικής πληροφορίας. Παρά το γεγονός ότι ανάλογα με το είδος του χάρτη και τον χαρτογραφικό φορέα, υιοθετούνται διάφορες μορφές, το υπόμνημα έχει ορισμένα χαρακτηριστικά τα οποία πρέπει να τηρούνται σε κάθε περίπτωση. Κατ’ αρχάς πρέπει να είναι ξεκάθαρο και να διαφοροποιείται γραφιστικά από τα στοιχεία της χαρτογραφούμενης περιοχής, στην περίπτωση κατα την οποία λόγω κλίμακας και μορφής του αρχιτεκτονικού, ενσωματώνεται σ’ αυτήν.Το υπόμνημα περιλαμβάνει τα πρότυπα των συμβόλων και τις αντίστοιχες επεξηγήσεις, ενώ τα αυτονόητα σύμβολα, συνήθως, παραλείπονται (Slocum et al., 2005). Για παράδειγμα, δεν θα παρατεθούν τα σύμβολα που αντιστοιχούν στο φόντο της ξηράς και της θάλασσας. Θα πρέπει να σημειωθεί ότι ειδικές κατηγορίες χαρτών, όπως είναι οι ναυτικοί χάρτες, δεν περιλαμβάνουν υπόμνημα, καθώς τα χρησιμοποιούμενα σύμβολα αποτελούν ειδική έκδοση (INT1, ΧΕΕ64). Τα σύμβολα στο υπόμνημα και στον χάρτη πρέπει να είναι απολύτως ίδια ως προς όλα τα γραφιστικά τους χαρακτηριστικά. Αν και το υπόμνημα οφείλει να είναι τόσο καλά σχεδιασμένο ώστε να είναι αυτο-επεξηγηματικό, συχνά συνοδεύεται από τον τίτλο ‘ΥΠΟΜΝΗΜΑ’. Η πιο συνηθισμένη διάταξη ακολουθεί τη φορά ανάγνωσης κειμένων (στο  δυτικό κόσμο) από αριστερά προς τα δεξιά και από πάνω προς τα κάτω, δηλαδή τα σύμβολα τοποθετούνται στα αριστερά και οι επεξηγήσεις τους στα δεξιά επιτρέποντας στον χρήστη να διαβάσει πρώτα το σύμβολο και στη συνέχεια την ερμηνεία του. Τα στοιχεία του υπομνήματος πρέπει να έχουν ομοιόμορφη κατακόρυφη κατανομή, δηλαδή σταθερές καθ’ ύψος αποστάσεις, τα σύμβολα να ακολουθούν κεντρική (οριζόντια) στοίχιση, να γίνεται κεντρική κατακόρυφη στοίχιση συμβόλου-επεξήγησης και αριστερή στοίχιση των επεξηγήσεων (Εικόνα 10.3). Ειδικότερα για τις επεξηγήσεις, αυτές θα πρέπει να γράφονται στον ενικό αριθμό εάν ένα σύμβολο αντιπροσωπεύει ένα χωρικό στοιχείο (π.χ. πετρελαιοπηγή) και στον πληθυντικό εάν ένα σύμβολο αντιπροσωπεύει πολλά χωρικά στοιχεία (π.χ. πετρελαιοπηγές).
Ένα άλλο ζήτημα που προκύπτει, είναι η σειρά παράθεσης των συμβόλων. Η παράθεση μπορεί να γίνει είτε με βάση την αλφαβητική σειρά των επεξηγήσεών τους, είτε ανάλογα με την ταξινόμηση των χωρικών στοιχείων (βλ. κατωτέρω §10.4). Τα στοιχεία που έχουν ταξινομηθεί κατά τα ποιοτικά τους χαρακτηριστικά στην ονομαστική κλίμακα, παρατίθενται σύμφωνα με την αλφαβητική σειρά των επεξηγήσεών τους, ενώ όσα έχουν ταξινομηθεί με βάση τα ποσοτικά τους χαρακτηριστικά στην κλίμακα τάξης ή την κλίμακα διαστήματος παρατίθενται σύμφωνα με την ιεράρχηση που έχει προκύψει από την ταξινόμηση. Εάν τα στοιχεία έχουν ενταχθεί σε ομάδες, η σειρά παράθεσης των ομάδων μπορεί να γίνει αλφαβητικά.
Θα πρέπει εδώ να γίνει ειδική μνεία για την παράθεση των επιφανειακών συμβόλων. Το είδος των δεδομένων που αντιπροσωπεύουν επηρεάζει τον τρόπο παράθεσής τους:
 
	Τα σύμβολα των ποιοτικών δεδομένων παρατίθενται, συνήθως, με κενό μεταξύ τους καθ’ ύψος, όπως γίνεται με τις λοιπές κατηγορίες συμβόλων (Εικόνα 10.4α).
	Τα σύμβολα τα οποία αντιστοιχούν σε ένα εύρος αριθμητικών δεδομένων, παρατίθενται χωρίς κενό μεταξύ τους, για να δοθεί έμφαση στη διαβάθμιση των τιμών (Εικόνα 10.4β). Η διάταξη αυτή συνιστάται ιδίως για χάρτες που περιλαμβάνουν σκιασμένες ισαριθμικές (ή/και ισοπληθείς) ζώνες, οπότε τα επιφανειακά σύμβολα εμφανίζονται στον χάρτη με την ίδια διαδοχική σειρά που έχουν και στο υπόμνημα.
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Εικόνα 10.3 Υπόμνημα: αριστερή στοίχιση και αλφαβητική ταξινόμηση επεξηγήσεων, κεντρική στοίχιση συμβόλων.
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Εικόνα 10.4 Υπόμνημα επιφανειακών συμβόλων - οι εναλλακτικές επιλογές διάταξης των συμβόλων.
Για την καλύτερη οπτική οργάνωση και ισορροπία των στοιχείων του υπομνήματος, συνιστάται να λαμβάνεται υπόψη η κατηγορία στην οποία ανήκουν και να παρατίθενται πρώτα τα σημειακά, ακολούθως τα γραμμικά και τέλος τα επιφανειακά.
10.4 Ο χαρτογραφικός συμβολισμός
 
Ένα από τα εγγενή χαρακτηριστικά του χάρτη, είναι η απεικόνιση των χωρικών στοιχείων με τη χρήση συμβόλων. Ο χάρτης συνιστά γραφική αναπαράσταση της γεωγραφικής πραγματικότητας, η οποία υλοποιείται μέσω του χαρτογραφικού συμβολισμού. Σε αντίθεση με την εικόνα που χαρακτηρίζεται από την ιδιότητα της ομοιότητας, ο χάρτης προκύπτει ως αποτέλεσμα μιας αφαιρετικής διαδικασίας, καθώς γίνεται επιλογή των οντοτήτων που θα απεικονιστούν και χρησιμοποιεί σύμβολα τα οποία έχουν συμβατική σχέση με το σημαινόμενο.
Η ερμηνεία του χάρτη εξαρτάται από την κατανόηση των συμβόλων, της σύνδεσής τους με τα φαινόμενα που αναπαριστούν και της γραφικής δομής με την οποία εμφανίζονται (Keats, 1996). Ο χαρτογραφικός συμβολισμός, μέσω των γραφικών στοιχείων τα οποία συγκροτούν τα σύμβολα, χρησιμοποιείται για να αναπαραστήσει γραφικά, τα κάτωθι στοιχεία των γεωγραφικών φαινομένων που χαρτογραφούνται:
 
	Τη θέση.
	Το σχήμα και το μέγεθος.
	Τις ιδιότητες (δηλαδή τα περιγραφικά χαρακτηριστικά).

 
Τα σύμβολα, δηλαδή, δεν υποδηλώνουν μόνο τη φυσική (ή νοητή) παρουσία ενός χαρτογραφικού στοιχείου (θέση) αλλά και τις ιδιότητές του. Για τον λόγο αυτό, η χαρτογραφική παράδοση επιβάλλει κανόνες οι οποίοι έχουν χαρακτήρα συμβάσεων που αφορούν τη μορφή και το χρώμα των συμβόλων, σε σχέση με την πραγματική εμφάνιση των χαρτογραφικών στοιχείων. Είτε πρόκειται για χάρτες γενικής αναφοράς (όπως είναι οι τοπογραφικοί, όπου όλες οι οντότητες έχουν την ίδια σημασία και δεν δίνεται έμφαση σε κάποια από αυτές), είτε για χάρτες θεματικών απεικονίσεων (όπου δίνεται έμφαση στην κατανομή ενός γεωγραφικού φαινομένου), οι συμβάσεις αυτές παίζουν καθοριστικό ρόλο στη διαμόρφωση και επιλογή των συμβόλων. Η σχέση ανάμεσα στο σύμβολο και στην πραγματικότητα ποικίλλει: άλλοτε υπάρχει ισχυρή ομοιότητα και άλλοτε είναι συμβατική (conventional). Τα χαρτογραφικά σύμβολα, λοιπόν, μπορεί να είναι:
 
	Αυθαίρετα ή συμβατικά.
	Γεωμετρικά ή εικονογραφικά. 
	Μιμητικά ή αφαιρετικά (μη μιμητικά). 

 
Ειδική κατηγορία συμβόλων αποτελούν τα γεωγραφικά ονόματα, καθώς υποδηλώνουν τόσο τη θέση όσο και τις ιδιότητες (είδος) του φαινομένου που συμβολίζουν. Λειτουργούν δηλαδή ως κυριολεκτικό σύμβολο, καθώς τα γράμματα κωδικοποιούν ήχους (όνομα), ως σύμβολο θέσης αλλά και ως σύμβολο ιεράρχησης. Εκτός από την επιλογή των συμβόλων, η εμφάνιση των χαρτών επηρεάζεται και από τεχνικούς περιορισμούς οι οποίοι σχετίζονται τόσο με τα διαθέσιμα μέσα και υλικά, όσο και με τις δεξιότητες του χαρτογράφου σε σχέση με αυτά καθώς και με τον διαθέσιμο χρόνο και τον προϋπολογισμό. 
Ο χαρτογραφικός συμβολισμός, μέσω των γραφιστικών στοιχείων που συγκροτούν τα σύμβολα, αναφέρεται στην απόδοση (δηλαδή τη γραφική αναπαράσταση) της θέσης και επομένως στην ταυτόχρονη απόδοση του σχήματος και του μεγέθους, καθώς και στην απόδοση των ιδιοτήτων, δηλαδή των περιγραφικών χαρακτηριστικών των χωρικών στοιχείων που χαρτογραφούνται. Στο πλαίσιο της χαρτογραφικής απόδοσης, χρησιμοποιούνται διάφορα μέσα και μέθοδοι συμβολισμού για τη σχεδίαση (σύνθεση) των συμβόλων που θα επιλεγούν για να περιγράψουν τους τύπους και τις τιμές των δεδομένων. Η υλοποίηση του χαρτογραφικού συμβολισμού ακολουθεί τρία διακριτά στάδια:
 
	Ανάλυση και ταξινόμηση των χαρτογραφικών δεδομένων, σύμφωνα με τη φύση, τις ιδιότητες και τις τιμές τους. 
	Επιλογή των κατάλληλων οπτικών μεταβλητών, ανάλογα με την ταξινόμηση των δεδομένων.
	Σχεδίαση και κατασκευή συμβόλων.

 
10.4.1 Ανάλυση και ταξινόμηση
 
Η ανάλυση αναφέρεται στη κατάταξη των γεωγραφικών φαινομένων τα οποία χαρτογραφούνται, καθώς και στα ποιοτικά και ποσοτικά τους χαρακτηριστικά. Με βάση τα γεωμετρικά χαρακτηριστικά των γεωχωρικών οντοτήτων, η κατάταξη γίνεται σύμφωνα με το γεωμετρικό τους αρχέτυπο στην κλίμακα απόδοσης, (Εικόνα 10.5), στις ακόλουθες κατηγορίες:
 
	Σημειακά, όταν αρκεί ένα ζευγάρι συντεταγμένων π.χ. (Χ,Υ), (λ,φ), (R, θ) για να καταγράψει τη θέση της οντότητας η οποία χαρτογραφείται. Θεωρείται ότι έχουν μηδενικές διαστάσεις στο επίπεδο.
	Γραμμικά, όταν απαιτείται μια ακολουθία συντεταγμένων για την καταγραφή της οντότητας. Θεωρείται ότι έχουν μία διάσταση στο επίπεδο.
	Επιφανειακά, όταν για την καταγραφή της οντότητας απαιτείται μια ακολουθία συντεταγμένων με κοινή αρχή και τέλος. Θεωρείται ότι έχουν δύο διαστάσεις στο επίπεδο.
	Ογκομετρικά/Τρισδιάστατα, όταν εκτός από την οριζοντιογραφική θέση (Χ,Υ), καταγράφεται και η τρίτη διάσταση είτε ως πραγματικό υψόμετρο (Ζ), είτε ως τιμή ενός άλλου φαινομένου στη θέση αυτή. 
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Εικόνα 10.5 Σημειακά, Γραμμικά και Επιφανειακά γεωγραφικά φαινόμενα.
Η κατάταξη σύμφωνα με τα ποιοτικά και ποσοτικά χαρακτηριστικά, γίνεται με βάση τις κλίμακες μέτρησης (ιεράρχησης), οι οποίες εξαρτώνται από τις «τιμές» των δεδομένων. Κατά ονομαστική κλίμακα ταξινομούνται τα δεδομένα για τα οποία η διάκριση γίνεται με βάση τα ποιοτικά τους χαρακτηριστικά, διαφέρουν δηλαδή κατά είδος και η διαφοροποίηση γίνεται λεκτικά (φάρος, τριγωνομετρικό σημείο, ανεμόμυλος, ..., δρόμος, ποταμός, σύνορο, ..., ασβεστολιθικά πετρώματα, σχιστόλιθοι, ..., αστική γη, δάσος, ...). Κατά κλίμακα τάξης ταξινομούνται τα δεδομένα για τα οποία η διάκριση γίνεται με βάση τα ποσοτικά τους χαρακτηριστικά και η διαφοροποίηση είναι λεκτική ποσοτική (κύριο – δευτερεύον, μικρό – μεγάλο, ...). Κατά κλίμακα διαστήματος ταξινομούνται τα δεδομένα για τα οποία η διάκριση γίνεται με βάση τα ποσοτικά τους χαρακτηριστικά, αλλά η μεταξύ τους διαφοροποίηση είναι αριθμητική (100, 200, 455...0-25,25-50, 50-100, ...). 
10.4.2 Οπτικές μεταβλητές και ταξινόμηση δεδομένων
 
Ο όρος «οπτική μεταβλητή» έχει εισαχθεί από τον Jacque Bertin στο έργο του «Semiologie Graphique» το 1967 και αναφέρεται στα διακριτά γραφικά χαρακτηριστικά των συμβόλων. Οι κύριες οπτικές μεταβλητές (Robinson et al., 1995) είναι:
 
	Το σχήμα, δηλαδή η μορφή ενός γραφικού συμβόλου.
	Το μέγεθος, δηλαδή η φαινομενική διαφοροποίηση των διαστάσεων.
	Ο προσανατολισμός, δηλαδή η διεύθυνση του άξονα συμμετρίας ενός συμβόλου.
	Η απόχρωση (χρώματος), δηλαδή η αντιληπτική διαφοροποίηση του χαρακτηριστικού το οποίο στην καθομιλουμένη ονομάζεται «χρώμα». Η απόχρωση, πρακτικά, αναφέρεται στο όνομα του χρώματος και αντιστοιχεί στο διαφορετικό μήκος κύματος του φωτός στο οποίο οφείλεται η ιδιότητα των αντικειμένων να γίνονται αντιληπτά ως έγχρωμα.
	Η ένταση (ή τόνος ή αξία χρώματος), δηλαδή το αντιληπτικό χαρακτηριστικό που περιγράφει πόσο φωτεινό ή σκούρο είναι ένα χρώμα.
	Η πληρότητα ή κορεσμός (χρώματος), που περιγράφει πόσο ζωηρό ή μουντό είναι ένα χρώμα. Τα ζωηρά χρώματα είναι υψηλού κορεσμού, ενώ τα μουντά χαμηλού.

 
Δευτερεύουσες οπτικές μεταβλητές θεωρούνται η διάταξη, η υφή και ο προσανατολισμός μοτίβου. 
Η ταξινόμηση των δεδομένων σύμφωνα με τις κλίμακες μέτρησης (ιεράρχησης) συνδέεται με την επιλογή της κατάλληλης οπτικής μεταβλητής για τη σύνθεση των συμβόλων. Σύμφωνα με τον Βertin, μία οπτική μεταβλητή χρησιμοποιείται για να αποδόσει χαρτογραφικά (να αναπαραστήσει) μία ιδιότητα και η χαρτογραφική αναπαράσταση ενός φαινομένου είναι πιο επιτυχής και αποδοτική (Dent, 1999) όταν:
 
	Η ονομαστική κλίμακα εκφράζεται με τη χρήση του σχήματος ή του προσανατολισμού ή της απόχρωσης
	Οι κλίμακες τάξης και διαστήματος αποδίδονται με τη χρήση του μεγέθους, της έντασης ή του κορεσμού.

 
Περαιτέρω διαφοροποιήσεις γίνονται σύμφωνα με τα γεωμετρικά χαρακτηριστικά των γεωχωρικών δεδομένων, καθώς για την απόδοση ποσοτικών διαφοροποιήσεων με μικρά σημειακά ή λεπτά γραμμικά σύμβολα είναι προτιμότερη η χρήση του μεγέθους κι όχι της έντασης ή του κορεσμού. Η ένταση και ο κορεσμός χρησιμοποιούνται επιτυχώς σε επιφανειακά σύμβολα, για την απόδοση ποσοτικών διαφοροποιήσεων σε επιφανειακά χωρικά στοιχεία.
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Εικόνα 10.6 Κατηγορίες συμβόλων και οπτικές μεταβλητές.
10.4.3 Σχεδίαση και κατασκευή χαρτογραφικών συμβόλων
 
Οι οπτικές μεταβλητές χρησιμοποιούνται στη χαρτογραφία για τη συγκρότηση συμβόλων, σε συνάρτηση με την ταξινόμηση των δεδομένων. Στη δισδιάσταση αναπαράσταση του χώρου τα θεμελιώδη γραφικά στοιχεία  -σημειακά, γραμμικά και επιφανειακά- αποτελούν τη βάση για τη δημιουργία των χαρτογραφικών συμβόλων. Η σχεδίαση και κατασκευή των συμβόλων είναι σύνθετη διαδικασία και σχετίζεται τόσο με τη θεωρία και εφαρμογή του συμβολισμού, όσο και με τη σχεδίαση του χάρτη (map design), αποτελεί δε μέρος της χαρτογραφικής απόδοσης (map representation) στο πλαίσιο της οποίας υλοποιείται η μετάδοση της χαρτογραφικής πληροφορίας. Τα χαρτογραφικά σύμβολα χωρίζονται σε τρεις κατηγορίες (Dent, 1999): σημειακά, γραμμικά και  επιφανειακά. Κοινό χαρακτηριστικό τους είναι ότι σε κάθε περίπτωση αποτελούν τον φορέα της θέσης του γεωγραφικού φαινομένου που αναπαριστούν.
Τα σημειακά σύμβολα, χρησιμοποιούνται για να αποδώσουν τα χαρακτηριστικά μιας θέσης η οποία εκφράζεται χαρτογραφικά ως σημείο, έχει δηλαδή μηδενικές διαστάσεις. Ως γραφικά στοιχεία, τα σημειακά σύμβολα έχουν δύο διαστάσεις (πλάτος και ύψος).
Τα γραμμικά σύμβολα, χρησιμοποιούνται για να αποδώσουν τα χαρακτηριστικά γεωγραφικών φαινομένων τα οποία εκφράζονται χαρτογραφικά ως γραμμές, είναι δηλαδή μονοδιάστατα. Ως γραφικά στοιχεία, έχουν δύο διαστάσεις (μήκος και πλάτος) αλλά το μήκος είναι πολύ μεγαλύτερο από το πλάτος τους. Απεικονίζουν τη θέση του άξονα συμμετρίας ενός χωρικού στοιχείου.
Τα επιφανειακά σύμβολα, αποδίδουν τα χαρακτηριστικά γεωγραφικών φαινομένων τα οποία εκφράζονται χαρτογραφικά ως επιφάνειες, έχουν δηλαδή δύο διαστάσεις (μήκος και πλάτος) και ακολουθούν το «πραγματικό» σχήμα της οντότητας που απεικονίζουν.
Τα ογκομετρικά γεωγραφικά φαινόμενα, μπορούν να αποδοθούν χαρτογραφικά είτε με σημειακά, είτε με γραμμικά είτε με επιφανειακά σύμβολα.
Στις τρεις αυτές κατηγορίες συμβόλων, πρέπει να προστεθούν και τα σύμβολα που έχουν τη μορφή κειμένου (text) και είτε αναπαριστούν γεωγραφικά ονόματα, είτε αποδίδουν αλφαριθμητικές πληροφορίες που σχετίζονται με τη φύση και τα χαρακτηριστικά των γεωγραφικών φαινομένων (π.χ. υψόμετρο σημείου ή ισοϋψούς καμπύλης).
Η χρήση των οπτικών μεταβλητών στις τρεις κατηγορίες συμβόλων, σχετίζεται με την παραμετροποίηση των γραφικών τους ιδιοτήτων και με την αναπαράσταση των οπτικών τους διαστάσεων (Εικόνα 10.6). 
10.4.4 Μέθοδοι συμβολισμού
 
Οι μέθοδοι συμβολισμού προσδιορίζονται τόσο από την ταξινόμηση των χαρτογραφικών δεδομένων η οποία καθορίζει σε μεγάλο βαθμό τις οπτικές μεταβλητές, όσο και από τα μοντέλα των γεωγραφικών φαινομένων. Οι χωρικές διαστάσεις των χωρικών στοιχείων, δηλαδή τα γεωμετρικά τους χαρακτηριστικά, είναι ένας τρόπος προσέγγισης της διάταξης των δεδομένων στον χώρο. Ένας άλλος τρόπος είναι η διερεύνηση της κατανομής τους, δηλαδή εάν είναι διακριτά ή συνεχή, αλλά και εάν τα δεδομένα είναι πρωτογενή ή παράγωγα. Διακριτά θεωρούνται τα γεωγραφικά φαινόμενα τα οποία υφίστανται σε ξεχωριστές θέσεις, δηλαδή έχουν κενό χώρο ανάμεσά τους. Συνεχή θεωρούνται εκείνα τα οποία απαντώνται σε όλες τις θέσεις του χώρου, δηλαδή το φαινόμενο έχει τιμή σε κάθε σημείο του χώρου (π.χ. υψόμετρο, θερμοκρασία κλπ.). Τόσο τα διακριτά, όσο και τα συνεχή φαινόμενα μπορούν να περιγραφούν ως ομαλά ή ακανόνιστα. Τα ακανόνιστα αλλάζουν απότομα τιμή ως μη εξαρτώμενη από τη γεωγραφική θέση, ενώ τα ομαλά βαθμιαία. Για ό,τι αφορά τις ποσοτικές κλίμακες μέτρησης, καθοριστικό στοιχείο για την επιλογή της μεθόδου συμβολισμού είναι επίσης εάν τα δεδομένα είναι πρωτογενή ή παράγωγα.
Η χαρτογραφική απόδοση δεδομένων τα οποία χαρακτηρίζονται από ονομαστική διαφοροποίηση (ποιοτικά δεδομένα) γίνεται με  χρήση του σχήματος, της απόχρωσης και του προσανατολισμού (Εικόνα 10.7). Η χρήση κάθε μιας από αυτές τις οπτικές μεταβλητές δίνει την εντύπωση ότι τα φαινόμενα που αναπαριστώνται διαφέρουν κατά είδος χωρίς να υποδηλώνονται διαφορές κατά μέγεθος. Η εφαρμογή τους γίνεται σε όλες τις κατηγορίες συμβόλων: σημειακά, γραμμικά και επιφανειακά.
Εκτός από την προφανή σχέση του γεωμετρικού αρχετύπου του χωρικού στοιχείου με την κατηγορία του χαρτογραφικού συμβόλου το οποίο θα χρησιμοποιηθεί (π.χ. σημειακά χωρικά στοιχεία αποδίδονται χαρτογραφικά με σημειακά σύμβολα κ.ο.κ.), υπάρχουν και περιπτώσεις οι οποίες σχετίζονται κυρίως με θεματικές απεικονίσεις ποσοτικών δεδομένων όπου η μέθοδος συμβολισμού καθορίζει τον γεωμετρικό χαρακτήρα των συμβόλων. Τα ογκομετρικά ή τρισδιάστατα χωρικά στοιχεία αντιμετωπίζονται ως στατιστική επιφάνεια. Η στατιστική επιφάνεια υφίσταται για κάθε κατανομή που είναι μαθηματικά συνεχής και μετράται σε κλίμακα τάξης ή διαστήματος. Οι τιμές του φαινομένου θεωρείται ότι σχηματίζουν ένα γεωγραφικό όγκο και η χαρτογραφική απόδοσή του αφορά στην αναπαράσταση του κελύφους της επιφάνειάς του. Ο συμβολισμός μπορεί να μορφοποιηθεί είτε με σημειακά σύμβολα, είτε με γραμμικά σύμβολα (χάρτες ισαριθμικών ή ισοπληθών καμπυλών), είτε με επιφανειακά σύμβολα (χωροπληθής απεικόνιση, σκιαγραφημένες ζώνες - Εικόνα 10.8).
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Εικόνα 10.7 Παραδείγματα συμβόλων για δεδομένα που διαφοροποιούνται ποιοτικά.
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Εικόνα 10.8 Απόδοση ποσοτικών επιφανειακών δεδομένων με σκιαγραφημένες ζώνες.
10.5 Η χρήση του χρώματος
 
Ειδικότερα για τη χρήση του χρώματος, αποχρώσεις παρεμφερούς χρωματικής δύναμης (αξίας) πρέπει να χρησιμοποιούνται για τον συμβολισμό στοιχείων παρόμοιας σπουδαιότητας. Παρόμοιες ονομαστικές κλάσεις πρέπει να συμβολίζονται με γειτονικές αποχρώσεις, ενώ μεγάλες αντιθέσεις με αντίθετες. Οι πιο συνηθισμένες χρωματικές συμβάσεις για την χαρτογράφηση ποιοτικών χαρακτηριστικών σχετίζονται με την επιλογή της απόχρωσης:
 
	Μπλε για υδάτινα στοιχεία και χαρακτηριστικά.
	Κόκκινο για θερμές, μπλε για ψυχρές θερμοκρασίες.
	Πράσινο για βλάστηση.
	Κίτρινο και γήινα χρώματα για φτωχή βλάστηση ή ξηρές περιοχές.
	Καφέ για το ανάγλυφο και τις ισοϋψείς καμπύλες.

 
Οι ποσοτικές χρωματικές συμβάσεις αναφέρονται στη χρήση των διαστάσεων του χρώματος (απόχρωση, ένταση, κορεσμός) για να συμβολίσουν τη μεταβολή ποσοτικών δεδομένων.
 
	Η αλλαγή της έντασης μιας απόχρωσης αποδίδει βαθμωτές σειρές δεδομένων.
	Το πλήθος των εντάσεων που είναι δυνατόν να χρησιμοποιηθούν από τον ανθρώπινο εγκέφαλο για επιτυχείς συγκρίσεις, είναι έως 6 ή 7, εξαρτάται όμως και από την απόχρωση. Οι αποχρώσεις που βρίσκονται στο μέσο του φάσματος παράγουν λιγότερο διακριτές χρωματικές διαβαθμίσεις.
	Η μεγαλύτερη ένταση συνδέεται με τη μεγαλύτερη τιμή δεδομένων. 
	Μεσαίες αποχρώσεις πρέπει να αποφεύγονται για το συμβολισμό αντίθετων ακραίων τιμών.
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Εικόνα 10.9 Χρωματικά σχήματα – παραδείγματα.
Για την εφαρμογή τους χρησιμοποιούνται διάφορα χρωματικά σχήματα (Εικόνα 10.9 Χρωματικά σχήματαΕικόνα 10.9):
	Μιας απόχρωσης: Χρησιμοποιείται μία απόχρωση με μεταβολή έντασης για το συμβολισμό διαβαθμισμένων δεδομένων.
	Τμήμα του φάσματος: Παρακείμενες αποχρώσεις, σε αντιστοιχία με τη φασματική τους διάταξη, χρησιμοποιούνται για να συμβολίσουν τη μεταβολή μιας ποσότητας.
	Πλήρες φάσμα: Κάθε απόχρωση χρησιμοποιείται για να συμβολίσει διαφορετική τιμή δεδομένων. Η διάταξή τους είναι αντίστοιχη της φασματικής. Χρησιμοποιείται κυρίως για τον συμβολισμό θερμοκρασίας.
	Διπολικό ή αποκλίνον: Χρησιμοποιούνται δύο αντίθετες αποχρώσεις με συμμετρικές διαβαθμίσεις της έντασης, για τον συμβολισμό δεδομένων τα οποία αποκλίνουν από μια μεσαία τιμή.
	Σχήμα μετάβασης: Πρόκειται για μια σειρά χρωμάτων τα οποία εκτείνονται από μια ανοικτή ένταση μιας απόχρωσης μέχρι τη σκούρα ένταση μιας άλλης απόχρωσης. Οι αποχρώσεις είναι φασματικά παρακείμενες.

 
10.6. Απόδοση γεωγραφικών ονομάτων (Ονοματολογία)
 
Τα γεωγραφικά ονόματα ή τοπωνύμια, αποτελούν ένα σημαντικό συστατικό της οπτικής παρουσίασης του χάρτη και η σχεδίαση και τοποθέτησή τους επηρεάζει καθοριστικά τη γραφική ποιότητά του. Αυτό οφείλεται στο ότι τα τοπωνύμια αλληλεπιδρούν με άλλα σύμβολα και αποσπούν την προσοχή του χρήστη. Η ποιότητα και πληρότητα ενός χάρτη εξαρτάται σε μεγάλο βαθμό από την απόδοση της ονοματολογίας, η οποία συνιστά μια από τις πλέον πολύπλοκες και χρονοβόρες διαδικασίες. Η ονοματολογία αναφέρεται τόσο σε σημειακά, όσο σε γραμμικά και σε επιφανειακά δεδομένα, η δε τοποθέτησή της έπεται του συμβολισμού. Η απόδοση των γεωγραφικών ονομάτων γίνεται με χρήση τυπογραφικών στοιχείων, τα χαρακτηριστικά των οποίων παρατίθενται στην Εικόνα 10.10.
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Εικόνα 10.10 Τα χαρακτηριστικά των τυπογραφικών στοιχείων (Robinson et al., 1995).
Ανάλογα με την κατηγορία του χάρτη και τον φορέα παραγωγής του, υπάρχουν γενικές οδηγίες (προδιαγραφές) απόδοσης των τοπωνυμίων για το σύνολο των χαρτογραφικών οντοτήτων, αλλά και ειδικές οδηγίες για σημειακές, γραμμικές και επιφανειακές χαρτογραφικές οντότητες. Βασική αρχή, είναι η τοποθέτηση ενός τοπωνυμίου εξ ολοκλήρου είτε στην ξηρά είτε στη θάλασσα, δεν πρέπει δηλαδή να διασταυρώνεται με την ακτογραμμή για να μην γίνεται δυσανάγνωστο. Στην περίπτωση διασταύρωσης με άλλα γραμμικά χωρικά στοιχεία του χάρτη, διακόπτεται τοπικά το γραμμικό σύμβολο ώστε να διευκολυνθεί η ανάγνωση του τοπωνυμίου. Το γεωμετρικό αρχέτυπο των χαρτογραφικών οντοτήτων και η μορφή του γεωγραφικού πλέγματος καθορίζουν τη μορφή και τη θέση του οδηγού αναγραφής των τοπωνυμίων. Για τα σημειακά χωρικά στοιχεία, και για χάρτες μικρής κλίμακας, η ονοματολογία ακολουθεί τη μορφή των παραλλήλων του γεωγραφικού πλέγματος, ενώ καταβάλλεται προσπάθεια η τοποθέτησή τους να ξεκινά από το κέντρο του χάρτη και να κινείται ακτινωτά προς τα άκρα. Για τα γραμμικά, ακολουθεί τη μορφή του γραμμικού στοιχείου, ενώ για τα επιφανειακά ακολουθεί μια ομαλή καμπύλη στο εσωτερικό του επιφανειακού στοιχείου. Τα τοπωνύμια διοικητικών διαιρέσεων αναγράφονται οριζόντια (ή σύμφωνα με τη μορφή των παραλλήλων του γεωγραφικού πλέγματος). 
Η μορφή των τυπογραφικών στοιχείων είναι συνδεδεμένη με συμβάσεις χρήσης. Η χρήση κεφαλαίων και πεζών συνδέεται με την απόδοση της σπουδαιότητας των στοιχείων στα οποία αναφέρονται τα τοπωνύμια, ενώ συνηθίζεται με όρθια τυπογραφικά στοιχεία να αναγράφονται τοπωνύμια τα οποία αντιστοιχούν σε γεωχωρικά στοιχεία που δημιούργησε ο άνθρωπος, ενώ με πλάγια γραφή αναγράφονται όσα αναφέρονται στο υγρό στοιχείο (Εικόνα 10.11). 
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Εικόνα 10.11 Παράδειγμα αναγραφής τοπωνυμίων.
Το μέγεθος των τυπογραφικών στοιχείων σχετίζεται με την αναγνωσιμότητα. Θεωρείται ότι διαφορές μεγέθους μικρότερες του 15% είναι μη αναγνώσιμες, ενώ μεγαλύτερες του 25% είναι επιθυμητές. Το μέγεθος αναφέρεται στο ύψος των τυπογραφικών στοιχείων και εκφράζεται σε στιγμές (pts), συνδέεται, δε, με το μέγεθος ή τη σπουδαιότητα του προς απόδοση αντικειμένου. 
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Εικόνα 10.12 Παραδείγματα χρωματικής αντίθεσης τυπογραφικών στοιχείων και φόντου.
Το χρώμα των τυπογραφικών στοιχείων παίζει καθοριστικό ρόλο, επειδή η αναγνωσιμότητα εξαρτάται από τον βαθμό της οπτικής αντίθεσης μεταξύ των τυπογραφικών στοιχείων και του φόντου του υποβάθρου. Όσο η τονική ένταση του τοπωνυμίου πλησιάζει αυτήν του φόντου του υποβάθρου, η αναγνωσιμότητα ελαττώνεται (Εικόνα 10.12).
Η διαφοροποίηση των διαφόρων κατηγοριών τοπωνυμίων μπορεί να ενισχυθεί και με την επιλογή διαφορετικών χρωμάτων, στο πλαίσιο της χρήσης των οπτικών μεταβλητών στον συμβολισμό. Σημαντική στη χαρτογραφική παράδοση είναι η αναγραφή των τοπωνυμίων των υδάτινων στοιχείων με μπλε χρώμα. Συνοψίζοντας:
 
	Η γραμματοσειρά, ο σχεδιαστικός χαρακτήρας και το χρώμα χρησιμοποιούνται για τη διαφοροποίηση κατά το είδος (π.χ. χερσαία-θαλάσσια, νησιά-ακρωτήρια-οικισμοί-όρη κ.ά.).
	Η μορφή (κεφαλαία-πεζά) και το μέγεθος χρησιμοποιούνται για την ανάδειξη ποσοτικών διαφοροποιήσεων (π.χ. πρωτεύουσα, μικρή-μεγάλη πόλη κ.ά.).

 
10.7 Η διαδικασία της σύνθεσης χάρτη στο QGIS
 
Στο QGIS, η σύνθεση του χάρτη γίνεται σε περιβάλλον QGIS Desktop (“QGIS User Guide”, χ.η.; “QGIS Training Manual”, χ.η.). Η ενεργοποίησή του καθώς και η διαμόρφωση του περιβάλλοντος εργασίας, παρατίθενται στο Παράρτημα Α. H χαρτοσύνθεση υλοποιείται στο πλαίσιο δημιουργίας ενός έργου (project). Αρχικά καθορίζεται η μέθοδος συμβολισμού και διαμορφώνονται τα σύμβολα για κάθε θεματικό επίπεδο (layer) και στη συνέχεια, μορφοποιείται το αρχιτεκτονικό του χάρτη στο πλαίσιο δημιουργίας ενός χάρτη για εκτύπωση. Στις διαδικασίες που περιγράφονται στη συνέχεια, έχει χρησιμοποιηθεί η έκδοση QGIS 2.6.1-Brighton.
10.7.1 Συμβολισμός των χωρικών στοιχείων
 
Για κάθε θεματικό επίπεδο (layer) το οποίο εντάσσεται στο έργο (project) (βλ. Παράρτημα Α §Α.2 και Κεφάλαιο 2 §2.1.2), εμφανίζονται όλες οι οντότητες που περιέχονται σ’ αυτό και αναπαριστώνται χαρτογραφικά με ένα ενιαίο σύμβολο το οποίο εκχωρείται αυτόματα. Η επιλογή του συμβόλου είναι τυχαία, αλλά ανήκει στην ίδια κατηγορία με το γεωμετρικό αρχέτυπο των δεδομένων και δίνεται η δυνατότητα αλλαγής, ανάλογα με τις απαιτήσεις του χαρτογραφικού συμβολισμού. Η διαδικασία προσδιορισμού ή/και αλλαγής των χαρακτηριστικών των συμβόλων που περιγράφεται στη συνέχεια, ισχύει για όλες τις κατηγορίες συμβόλων (σημειακά, γραμμικά, επιφανειακά). Με δεξί κλικ επάνω στο όνομα του shapefile (στο παράθυρο των Layers – βλ. Κεφάλαιο 2, §2.1.2, Εικόνα 2.7) ενεργοποιείται το μενού επιλογών για το συγκεκριμένο θεματικό επίπεδο. Από την επιλογή Properties>Layer Properties η οποία περιλαμβάνει μια σειρά από επιμέρους επιλογές, μεταξύ των οποίων και τις επιλογές Style και Labels. Ανάλογα με τη γεωμετρία των οντοτήτων του shapefile (σημείο, γραμμή ή πολύγωνο) η επιλογή Style εμφανίζει διαφορετικό μενού στο δεξί τμήμα της οθόνης προκειμένου να δώσει τις κατάλληλες επιλογές στον χρήστη για την τροποποίηση του συμβολισμού της κάθε γεωμετρίας. 
Οι διαθέσιμες μέθοδοι συμβολισμού (Εικόνα 10.13), οι οποίες επιλέγονται από το μενού διαμόρφωσης του συμβολισμού για όλες τις κατηγορίες συμβόλων, είναι οι εξής:
  
•	Συμβολισμός με ένα μοναδικό (ενιαίο) σύμβολο (Single Symbol).
•	Συμβολισμός με βάση τις τιμές των ιδιοτήτων στοιχείων (Categorized). 
•	Συμβολισμός με βάση βαθμίδες τιμών των ιδιοτήτων (Graduated).
•	Συμβολισμός με βάση κανόνες οι οποίοι θα καθοριστούν επί των ιδιοτήτων των οντοτήτων (Rule-based). 
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Εικόνα 10.13 Οι διαθέσιμες μέθοδοι συμβολισμού στο QGIS.
Ειδικά για τα σημειακά θεματικά επίπεδα, δίνεται η επιλογή του καθορισμού και του τρόπου τοποθέτησης των σημειακών συμβόλων (Μετατόπιση σημείου – Point displacement). Για όλες τις κατηγορίες, είναι διαθέσιμα προκατασκευασμένα σύμβολα τα οποία εκχωρούνται άμεσα στο σύνολο των οντοτήτων του shapefile ή αποτελούν μια βάση προκειμένου να τροποποιηθούν. Η τροποποίηση του styling είναι δυνατόν να γίνει με χρήση του υπο-μενού Symbol Layers και διπλό κλικ στο πρότυπο του συμβόλου. Σε αυτό το μενού δίνεται η δυνατότητα στον χρήστη να προσθέσει ή να αφαιρέσει επίπεδα συμβολισμού για την τελική σύνθεση ενός συμβόλου. Επίσης, υπάρχει η δυνατότητα τροποποίησης της σειράς (ιεράρχησης) προβολής των διαφόρων επιπέδων ενός συμβόλου προκειμένου να κατασκευαστεί το τελικό σύμβολο. Τέλος, για κάθε ένα από τα επίπεδα του συμβόλου, δίνεται η δυνατότητα τροποποίησης των ιδιοτήτων τους (π.χ. χρώμα, fill pattern, προσανατολισμός pattern κλπ.). Οι διαθέσιμες μέθοδοι συμβολισμού παρουσιάζονται στην Εικόνα 10.13.
 
 
10.7.2 Συμβολισμός χωρικών στοιχείων με ενιαίο σύμβολο
 
Ο συμβολισμός με ενιαίο σύμβολο ορίζεται από την επιλογή Single symbol. Οι βασικές επιλογές για κάθε κατηγορία συμβόλων παρουσιάζονται στις εικόνες Εικόνα 10.14, Εικόνα 10.15 και Εικόνα 10.16 που ακολουθούν.
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Εικόνα 10.14 Οι επιλογές διαμόρφωσης σημειακών συμβόλων στο QGIS.
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Εικόνα 10.15 Οι επιλογές διαμόρφωσης γραμμικών συμβόλων στο QGIS.
 
 
[image: ]
Εικόνα 10.16 Οι επιλογές διαμόρφωσης επιφανειακών συμβόλων στο QGIS.
 
10.7.3 Συμβολισμός δεδομένων με κατηγοριοποίηση
 
Ο συμβολισμός των δεδομένων με κατηγοριοποίηση στηρίζεται στην απόδοση ανάλογα με τις τιμές μιας στήλης (ενός πεδίου) του πίνακα ιδιοτήτων. Μετά την επιλογή της μεθόδου συμβολισμού (Εικόνα 10.13), επιλέγεται η στήλη του πίνακα ιδιοτήτων και ακολούθως, με το πλήκτρο Ταξινόμηση, προστίθενται όλες οι διαθέσιμες διακριτές τιμές (Εικόνα 10.17). Η διαγραφή μιας τιμής γίνεται με την επιλογή της με αριστερό κλικ και το πλήκτρο Διαγραφή, ενώ με το πλήκτρο Διαγραφή όλων, διαγράφονται όλες οι κατηγορίες που έχουν προστεθεί.  Η εφαρμογή των ρυθμίσεων γίνεται με το πλήκτρο ΟΚ ή Apply.
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Εικόνα 10.17 Ρυθμίσεις για το συμβολισμό δεδομένων με κατηγοριοποίηση στο QGIS.
10.7.4 Συμβολισμός δεδομένων στηριζόμενος σε κανόνες
 
Με τη μέθοδο συμβολισμού Στηριζόμενο σε κανόνες, δίνεται η δυνατότητα συμβολισμού με βάση κανόνες τυος οποίους ορίζει ο χρήστης, αξιοποιώντας τις τιμές των περιγραφικών στοιχείων (attributes) των χωρικών οντοτήτων. Η προσθήκη του κανόνα (Εικόνα 10.18) γίνεται με το πλήκτρο + και τη φόρμα διαχείρισής του που ενεργοποιείται με αυτό (Εικόνα 10.19). Στη φόρμα διαχείρισης (Rule Properties) ορίζονται τα στοιχεία του κανόνα που θα εφαρμοστεί στις ιδιότητες των οντοτήτων, προκειμένου να συμβολιστούν ανάλογα οι χωρικές οντότητες του shapefile. Η σύνταξη του κανόνα (της λογικής έκφρασης) γίνεται από το μενού Expression string builder. Όσα χωρικά στοιχεία δεν υπακούουν στον συγκεκριμένο κανόνα δεν θα σχεδιαστούν. Για τη δημιουργία του ορίσματος του λογικού κανόνα, ο χρήστης έχει στη διάθεσή του την επιλογή όλων των διαθέσιμων τελεστών οι οποίοι περιλαμβάνονται στο QGIS. Έτσι, για παράδειγμα, ο χρήστης μπορεί να επιλέξει ένα από τα πεδία περιγραφικής πληροφορίας του shapefile, να δώσει ένα όρισμα και να συμβολίσει με συγκεκριμένο τρόπο όσα χωρικά στοιχεία υπακούουν στο συγκεκριμένο κανόνα (Εικόνα 10.20). Εάν είναι επιθυμητό, με αντίστοιχο τρόπο, μπορεί να δημιουργηθεί ένας νέος κανόνας για τις υπόλοιπες χωρικές οντότητες του shapefile, αν και η σωστή προσέγγιση αυτής της περίπτωσης είναι να ακολουθηθεί η μέθοδος συμβολισμού με κατηγοριοποίηση. Έτσι, για το παράδειγμα της Εικόνας 10.20 μπορούν να επιλεγούν οι υπόλοιπες οντότητες με τη σύνταξη της λογικής έκφρασης "Layer" != 'asfaltostrwmenes_' και να ονομαστούν και να συμβολιστούν με  διαφορετικό τρόπο.
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Εικόνα 10.18 Συμβολισμός στηριζόμενος σε κανόνες στο QGIS.
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Εικόνα 10.19 Το περιβάλλον σύνταξης του κανόνα συμβολισμού στο QGIS.
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Εικόνα 10.20 Παράδειγμα σύνταξης λογικής έκφρασης με βάση πεδία ιδιοτήτων στο QGIS.
10.7.5 Απόδοση τιμών ιδιοτήτων με μορφή κειμένου
 
Η απόδοση τιμών ιδιοτήτων με μορφή κειμένου, βασίζεται στο περιεχόμενο ενός ή περισσοτέρων πεδίων του πίνακα περιγραφικών χαρακτηριστικών (ιδιοτήτων) ενός θεματικού επιπέδου (layer). Για την ενεργοποίηση της διαδικασίας αυτής από τον κατάλογο περιεχομένων της χαρτοσύνθεσης, γίνεται δεξί κλικ στο θεματικό επίπεδο για το οποίο είναι επιθυμητή αυτή η ενέργεια. Με την επιλογή Ιδιότητες αναδύεται το παράθυρο Layer Properties, όπου η επιλογή Ετικέτες είναι αυτή που αφορά τη διαμόρφωση του κειμένου με το οποίο θα αποδοθεί το περιεχόμενο μιας από τις ιδιότητες του θεματικού επιπέδου. Στην Εικόνα 10.21 παρουσιάζεται το μενού ρυθμίσεων των ετικετών για το επιλεγμένο θεματικό επίπεδο, καθώς και η μορφοποίηση των χαρακτηριστικών του κειμένου (συμβολισμός) για την περίπτωση απόδοσης αυτούσιου του περιεχομένου του πεδίου από τον πίνακα περιγραφικών χαρακτηριστικών του θεματικού επιπέδου.
Η μορφοποίηση των ετικετών έχει τις εξής επιλογές (βλ. Εικόνα 10.21):
 
•	Κείμενο – αφορά τη μορφοποίηση της γραμματοσειράς (γραμματοσειρά, στυλ, μέγεθος, χρώμα, διαφάνεια κλπ.).
•	Formatting – αφορά τη μορφοποίηση του συνόλου του κειμένου (wrapping, ύψος γραμμής, στοίχιση, μορφοποίηση αριθμών κλπ.).
•	Buffer – δημιουργία περιγράμματος κάτω από το κείμενο της ετικέτας.
•	Background – εισαγωγή και μορφοποίηση φόντου πίσω από την ετικέτα.
•	Shadow – δημιουργία φαινομένου σκίασης πίσω από το κείμενο της ετικέτας.
•	Placement – παραμετροποίηση του σημείου τοποθέτησης του κειμένου.
•	Rendering – παραμετροποίηση του τρόπου εμφάνισης (ανάλογα με την κλίμακα του χάρτη και ανάλογα με την τοποθέτηση των άλλων ετικετών).
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Εικόνα 10.21 Το μενού ρυθμίσεων των ετικετών στο QGIS.
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Εικόνα 10.22 Το περιβάλλον σύνταξης σύνθετης ετικέτας στο QGIS.
Δίνεται επίσης η δυνατότητα να γίνει η απόδοση με βάση μια σύνθετη έκφραση η οποία μπορεί να οριστεί επί του περιεχομένου του πεδίου ή και του συνδυασμού περισσοτέρων πεδίων, τόσο περιγραφικών όσο και γεωμετρικών. Η διαδικασία περιγράφεται στην Εικόνα 10.22 και υλοποιείται στο πλαίσιο του παραθύρου Expression dialog το οποίο αναδύεται όταν γίνει η συγκεκριμένη επιλογή. Στη βάση του παραθύρου αυτού, εμφανίζεται η προεπισκόπηση (Output preview) του αποτελέσματος της έκφρασης που συντάχθηκε ή μήνυμα λάθους στη σύνταξη.
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Εικόνα 10.23 Απόδοση δεδομένων ΨΜΕ με σκιαγραφημένες ζώνες στο QGIS.
10.7.6 Απόδοση δεδομένων Ψηφιακού Μοντέλου Εδάφους (ΨΜΕ)
 
Η απόδοση των δεδομένων ενός Ψηφιακού Μοντέλου Εδάφους ΨΜΕ (Digital Terrain Model – DTM) αφορά την απόδοση φαινομένων τα οποία χαρακτηρίζονται από συνέχεια. Για τον συμβολισμό τους χρησιμοποιείται η μέθοδος των σκιαγραφημένων ζωνών (βλ. §10.4.4) και συχνά συνδυάζεται με φωτοσκίαση (βλ. Κεφάλαιο 7). Για την απόδοση των δεδομένων του αναγλύφου, επιλέγεται από τον κατάλογο των θεματικών επιπέδων το αντίστοιχο κανονικοποιημένο αρχείο και με δεξί κλικ ενεργοποείται η επιλογή Ιδιότητες. Ακολουθώντας την ίδια διαδικασία που τηρείται για όλα τα θεματικά επίπεδα, στην καρτέλα Στυλ (Εικόνα 10.23) και στο πεδίο Render type, επιλέγεται Single pseudocolor. Στη συνέχεια, από το πεδίο Generate new color ramp μπορεί να επιλεγεί μια από τις υπάρχουσες χρωματικές ακολουθίες ή να δημιουργηθεί μια νέα με την επιλογή New color ramp…. Στην περίπτωση δημιουργίας νέας χρωματικής ακολουθίας στο αναδυόμενο παράθυρο Gradient color ramp ορίζονται η πρώτη και η τελευταία απόχρωση της παλέτας, ενώ ενδιάμεσες αποχρώσεις προστίθενται από το πλήκτρο Add stop. Δίνεται η δυνατότητα προσθήκης απόχρωσης αλλά και θέσης στην ακολουθία ως ποσοστού. Αφού οριστεί η χρωματική ακολουθία, από το πεδίο Ταξινόμηση δημιουργούνται οι κλάσεις των δεδομένων (εν προκείμένω οι υψομετρικές ζώνες). Επιπλέον επιλογές για τη διαμόρφωση του τρόπου (μεθόδου) απόδοσης, αποτελεί η επιλογή Λειτουργία, από όπου ορίζεται ως συνεχής - continuous ή με σταθερό βήμα - equal interval, σε συνδυασμό με το πλήθος των κατηγοριών το οποίο ορίζεται από την επιλογή Κλάσεις. Πρέπει να σημειωθεί ότι η μέθοδος continuous δημιουργεί πέντε (5) κλάσεις δεδομένων. Στο πεδίο Ετικέτα μπορούν να διορθωθούν οι τιμές για την εμφάνισή τους στο υπόμνημα. Η διαδικασία ολοκληρώνεται με το πλήκτρο Apply και ΟΚ.
 
Στην περίπτωση που η απόδοση του αναγλύφου συνδυάζεται με κανονικοποιημένο αρχείο φωτοσκιασμένου αναγλύφου (hillshade), χρειάζεται να γίνουν δύο ρυθμίσεις:
 
	Στη σειρά σχεδίασης το αρχείο DTM να βρίσκεται ψηλότερα από το αρχείο hillshade.

	Το αρχείο DTM θα πρέπει να αποδοθεί με διαφάνεια, ώστε να δημιουργείται η οπτική εντύπωση του τρισδιάστατου (Εικόνα 10.24). Η διαφάνεια ορίζεται από το μενού Ιδιότητες>Διαφάνεια.
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Εικόνα 10.24 Απόδοση ΨΜΕ με συνδυασμό υψομετρικών ζωνών και φωτοσκίασης.
10.7.7 Μορφοποίηση του αρχιτεκτονικού
 
Στο QGIS, η μορφοποίηση του αρχιτεκτονικού γίνεται από το βασικό μενού με την επιλογή Project>New Print Composer, μετά την ολοκλήρωση του συμβολισμού για όλα τα θεματικά επίπεδα της χαρτοσύνθεσης. Η ενεργοποίηση του Print Composer ανοίγει ένα νέο παράθυρο εργασιών από το βασικό μενού, από όπου επιλέγεται Layout>Add Map (Εικόνα 10.25). Με τον cursor κατασκευάζεται το ορθογώνιο παραλληλόγραμμο μέσα στο οποίο εντάσσεται αυτόματα ο χάρτης ο οποίος έχει δημιουργηθεί στο περιβάλλον Desktop. Οι αλλαγές που τυχόν γίνουν στη χαρτοσύνθεση εφαρμόζονται με το πλήκτρο ανανέωσης (Εικόνα 10.25). Η θέση της χαρτογραφούμενης περιοχής μετακινείται με την επιλογή Layout>Move Content.
Στην καρτέλα Σύνθεση, ορίζονται οι διαστάσεις και ο προσανατολισμός της σελίδας σχεδίασης. Στην καρτέλα Ιδιότητες, μεταξύ άλλων, ορίζονται:
 
	Η κλίμακα του χάρτη.
	Η γωνία σχεδίασης της χαρτογραφούμενης περιοχής.
	Η έκταση (τα όρια) της χαρτογραφούμενης περιοχής.
	Οι κάναβοι.
	Η θέση και το μέγεθος στη σελίδα σχεδίασης.
	Το εσωτερικό πλαίσιο του χάρτη.
	Το χρώμα του φόντου, με το οποίο γεμίζει το εσωτερικό πλαίσιο και μπορεί να λειτουργήσει ως φόντο ξηράς ή θάλασσας.
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Εικόνα 10.25 Το περιβάλλον μορφοποίησης του αρχιτεκτονικού στο QGIS.
10.7.8 Προσθήκη κανάβου τετραγωνισμού
 
Στην καρτέλα Ιδιότητες και στο πεδίο Grids ορίζονται τα χαρακτηριστικά του κανάβου τετραγωνισμού, δηλαδή του κανάβου στις μονάδες του συστήματος αναφοράς των συντεταγμένων (ΣΑΣ). Για το ΕΓΣΑ 1987 από το πλήκτρο ΣΑΣ>Αλλαγή ορίζεται GGRS87/Greek Grid EPSG:2100. Ορίζονται οι μονάδες και οι διαστάσεις των φατνίων καθώς και ο τρόπος απεικόνισής τους. Επιλέγεται επίσης το είδος του πλαισίου (Frame Style) και τα χαρακτηριστικά αναγραφής των συντεταγμένων.
10.7.9 Προσθήκη γεωγραφικού κανάβου
 
Στην καρτέλα Ιδιότητες και στο πεδίο Grid, προστίθεται με το πλήκτρο + νέος κάναβος (Εικόνα 10.26) και από το πεδίο ΣΑΣ>Αλλαγή επιλέγεται Geographic Coordinate Systems και από τη λίστα επιλέγεται το κατάλληλο σύστημα (για το ΕΓΣΑ 1987, επιλέγεται Greek EPSG: 4120). Στη συνέχεια, διαμορφώνονται τα χαρακτηριστικά του γεωγραφικού πλέγματος με τρόπο ανάλογο εκείνου που περιγράφεται στην §10.7.8. Σημειώνεται ότι το μέγεθος των φατνίων δίνεται σε δεκαδικές μοίρες.
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Εικόνα 10.26 Προσθήκη κανάβου στο QGIS.
10.7.10 Προσθήκη τίτλου
 
Η προσθήκη τίτλου γίνεται από το βασικό μενού του Print Composer, με την επιλογή Layout>Add Label (Εικόνα 10.25) και διαμορφώνεται από την καρτέλα Ιδιότητες αντικειμένου.
10.7.11 Προσθήκη γραφικής κλίμακας
 
Η προσθήκη της γραφικής κλίμακας γίνεται από το βασικό μενού του Print Composer, με την επιλογή Layout>Add Scalebar (Εικόνα 10.25) και διαμορφώνεται με τα εργαλεία της καρτέλας Ιδιότητες αντικειμένου.
10.7.12 Προσθήκη και διαχείριση υπομνήματος
 
Η προσθήκη του υπομνήματος γίνεται από το βασικό μενού του Print Composer με την επιλογή Layout>Add Legend (Εικόνα 10.25). Η διαχείρισή του γίνεται με τα εργαλεία της καρτέλας Ιδιότητες αντικειμένου, όπου ορίζονται τα χαρακτηριστικά των γραμματοσειρών οι οποίες θα χρησιμοποιηθούν για τα επιμέρους στοιχεία του υπομνήματος, τα διάκενα ανάμεσα σ’ αυτά, ο αριθμός των στηλών κλπ. Πρέπει να σημειωθεί ότι οι επεξηγήσεις των συμβόλων, αντλούνται είτε από το Όνομα του επιπέδου (καρτέλα Ιδιότητες>Γενικά του θεματικού επιπέδου της χαρτοσύνθεσης) για την περίπτωση συμβολισμού με ενιαίο σύμβολο (§10.7.2), είτε από την καρτέλα Ιδιότητες>Στυλ και το πεδίο Υπόμνημα όπου έχουν συμπληρωθεί για κάθε κατηγορία δεδομένων για την περίπτωση συμβολισμού με κατηγοριοποίηση (§10.7.3 και Εικόνα 10.17) ή συμβολισμού βασιζόμενου σε κανόνες (§10.7.4). Η αφαίρεση ενός στοιχείου από το υπόμνημα γίνεται από την καρτέλα Ιδιότητες αντικειμένου, στο πεδίο Στοιχεία Υπομνήματος με την απενεργοποίηση της επιλογής Auto update, οπότε ενεργοποιούνται τα εργαλεία προσθήκης, αφαίρεσης και μετακίνησης των θεματικών επιπέδων που εμφανίζονται στο υπόμνημα.
10.7.13 Προσθήκη δείκτη προσανατολισμού
 
Η προσθήκη του δείκτη προσανατολισμού γίνεται από το βασικό μενού του Print Composer, με την επιλογή Layout>Add Arrow (Εικόνα 10.25), οπότε προστίθεται ένα βέλος, που διαμορφώνεται από την καρτέλα Ιδιότητες αντικειμένου. Εναλλακτικά, μπορεί να γίνει με προσθήκη εικόνας με την επιλογή Layout>Add Image (Εικόνα 10.25), οπότε και αναζητείται η σχετική εικόνα SVG από το πεδίο Ιδιότητες αντικειμένου>Αναζήτηση σε καταλόγους. Η διαμόρφωσή του γίνεται με τα εργαλεία της καρτέλας Ιδιότητες αντικειμένου. Και στις δύο περιπτώσεις απαιτείται προσοχή, ώστε να δοθεί η κατάλληλη περιστροφή στο αντικείμενο, για να προσαρμοστεί στη γωνία διεύθυνσης του μεσημβρινού στην περιοχή του χάρτη όπου θα τοποθετηθεί ο δείκτης προσανατολισμού.
10.7.14 Προσθήκη κειμένου και γεωμετρικών σχημάτων
 
Η προσθήκη ελεύθερου κειμένου και γεωμετρικών σχημάτων γίνεται με τα αντίστοιχα εργαλεία του Print Composer (Εικόνα 10.25).
10.7.15 Αποθήκευση της χαρτοσύνθεσης
 
Η αποθήκευση του έργου γίνεται από το βασικό μενού του Print Composer, με την επιλογή Composer>Αποθήκευση έργου.
10.7.16 Εκτύπωση της χαρτοσύνθεσης
 
Η εκτύπωση του έργου γίνεται από το βασικό μενού του Print Composer, με την επιλογή Composer>Print Composers.
10.7.17 Εξαγωγή σε format εικόνας
 
Η εξαγωγή του έργου σε format εικόνας γίνεται από το βασικό μενού του Print Composer, με τις επιλογές Composer>Export as Image, Composer>Export as PDF, Composer>Export as SVG.
10.8 Η διαδικασία της σύνθεσης χάρτη στο ArcGIS
 
Στο ArcGIS, η σύνθεση του χάρτη γίνεται σε περιβάλλον ArcMap (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β). Η ενεργοποίησή του καθώς και η διαμόρφωση του περιβάλλοντος εργασίας, παρατίθενται στο Παράρτημα Β, §Β.5.1- §Β5.3. Ο προσδιορισμός του συστήματος αναφοράς των δεδομένων, των μονάδων, η προσθήκη των θεματικών επιπέδων περιγράφονται στις παραγράφους §Β.5.4 και §Β.5.5 του Παραρτήματος Β. Ενδεικτικά αναφέρεται ότι το layer μπορεί να είναι ArcINFO Coverage, Shapefile, Feature Class, AUTOCAD Drawing, DXF, DGN file, TIFF, JPEG κλπ. Στις διαδικασίες που περιγράφονται ακολούθως, έχουν χρησιμοποιηθεί οι εκδόσεις ArcGIS 10.1 και ArcGIS 10.2.
10.8.1 Μορφοποίηση του αρχιτεκτονικού
 
Η μορφοποίηση του αρχιτεκτονικού του χάρτη γίνεται στην κατάσταση λειτουργίας Layout View (Παράρτημα Β, §Β.5.4) και αφορά τον καθορισμό της κλίμακας, της θέσης και του μεγέθους της χαρτογραφούμενης περιοχής (dataframe). Τα στοιχεία αυτά ορίζονται με την επιλογή Layers>Properties>Dataframe και Layers>Properties>Size and Position αντίστοιχα. Ο καθορισμός της κλίμακας γίνεται από την καρτέλα Dataframe>Extent>Fixed scale (Εικόνα 10.27). Το όνομα του dataframe (Layers) αλλάζει με δεξί κλικ Properties>General>Name. Η δημιουργία ενός ή περισσοτέρων ενθέτων, γίνεται με την εισαγωγή ενός ή περισσοτέρων dataframes αντίστοιχα, με την επιλογή Insert>Dataframe από το βασικό μενού.
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Εικόνα 10.27  Διαχείριση των στοιχείων μορφοποίησης του dataframe στο ArcMap.
Ο καθορισμός των επιλογών μορφοποίησης σελίδας γίνεται από το μενού File>Page Setup. Εδώ ορίζεται το περιβάλλον εκτύπωσης, το μέγεθος της σελίδας και ο προσανατολισμός της (οριζόντιος – landscape / κατακόρυφος – portrait). Στο πλαίσιο αυτής της διαδικασίας καθορίζεται η θέση του πλαισίου της χαρτογραφούμενης περιοχής στη σελίδα σχεδίασης (απόδοσης), καθώς και οι θέσεις και οι διαστάσεις των λοιπών στοιχείων περιθωρίου (βλ. §10.8.15). 
Η περιήγηση στη σελίδα σχεδίασης (απόδοσης) γίνεται με τα εργαλεία της γραμμής εργαλείων Layout για μεγέθυνση, σμίκρυνση, μετακίνηση, κλίμακα 1:1, μεγέθυνση και σμίκρυνση σε προκαθορισμένο ποσοστό, επιστροφή στην προηγούμενη επισκόπηση, μετάβαση στην επόμενη κλπ. (Εικόνα 10.28).
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Εικόνα 10.28 Η γραμμή εργαλείων Layout του ArcMap.
10.8.2 Συμβολισμός των χωρικών στοιχείων
 
Για κάθε θεματικό επίπεδο (layer) το οποίο εντάσσεται στη χαρτοσύνθεση, εμφανίζονται όλες οι οντότητες που περιέχονται σ’ αυτό και αναπαριστώνται χαρτογραφικά με ένα ενιαίο σύμβολο που εκχωρείται αυτόματα. Η επιλογή του συμβόλου είναι τυχαία, αλλά ανήκει στην ίδια κατηγορία με το γεωμετρικό αρχέτυπο των δεδομένων, δίνεται δε η δυνατότητα αλλαγής του, ανάλογα με τις απαιτήσεις του χαρτογραφικού συμβολισμού. Εκτός από την προσαρμογή της μεθόδου συμβολισμού και των συμβόλων, είναι εφικτή και η απόδοση ενός υποσυνόλου οντοτήτων ενός layer. Δηλαδή, είναι εφικτή η απόδοση οντοτήτων ενός layer οι οποίες πληρούν ορισμένες συνθήκες και έχουν συγκεκριμένες ιδιότητες. Αυτό υλοποιείται με τη σύνταξη μιας λογικής συνθήκης (logical condition) σε μορφή SQL Query αξιοποιώντας τα πεδία και τις τιμές του πίνακα περιγραφικών χαρακτηριστικών (attribute table). Το ερώτημα υποβάλλεται προς τη Βάση Δεδομένων και επιλέγονται εκείνες οι οντότητες οι οποίες ικανοποιούν τη συγκεκριμένη συνθήκη και είναι διαθέσιμες για απόδοση (συμβολισμό). Η σύνταξη της συνθήκης για το συγκεκριμένο θεματικό επίπεδο, γίνεται με την επιλογή Properties>Definition Query και μπορεί να υποβοηθηθεί με το εργαλείο Query builder (Εικόνα 10.29). Η επαναφορά όλων των οντοτήτων, γίνεται με τη διαγραφή του ερωτήματος. 
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Εικόνα 10.29 Το περιβάλλον σύνταξης λογικής συνθήκης στο ArcMap.
Για κάθε θεματικό επίπεδο της χαρτοσύνθεσης, ανάλογα με τη φύση και τις ιδιότητες των χαρτογραφικών δεδομένων, καθορίζεται η μέθοδος του συμβολισμού και τα χαρακτηριστικά των συμβόλων. Με δεξί κλικ στο layer από τον πίνακα περιεχομένων (TOC, §B.5.2) εμφανίζεται το μενού με όλες τις δυνατές λειτουργίες για τα θεματικά επιθέματα. Η επιλογή Properties ενεργοποιεί μια ομάδα από επάλληλες καρτέλες λειτουργιών από τις οποίες επιλέγεται η καρτέλα Symbology μέσω της οποίας καθορίζονται το είδος (μέθοδος) του συμβολισμού και τα χαρακτηριστικά του συμβόλου (ή των συμβόλων). Οι διαθέσιμες μέθοδοι συμβολισμού είναι οι εξής:
 
	Features (Single symbol) – συμβολισμός με ενιαίο σύμβολο.
	Categories – συμβολισμός ανάλογα με τις τιμές ενός πεδίου του πίνακα ιδιοτήτων. 
	Quantities.
	Charts.
	Multiple attributes.
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Εικόνα 10.30 Διαχείριση των χαρακτηριστικών για ένα επιφανειακό σύμβολο στο ArcMap.
10.8.2.1 Συμβολισμός χωρικών στοιχείων με ενιαίο σύμβολο
 
Για τον συμβολισμό του συνόλου των χαρτογραφικών οντοτήτων ενός θεματικού επιπέδου (layer) της χαρτοσύνθεσης με το ίδιο σύμβολο, διατηρείται η προκαθορισμένη επιλογή του συστήματος Features/Single symbol (Εικόνα 10.30). Η διαδικασία προσδιορισμού ή/και αλλαγής των χαρακτηριστικών των συμβόλων που ακολουθεί, ισχύει για όλες τις κατηγορίες συμβόλων (σημειακά, γραμμικά, επιφανειακά). Πρέπει να σημειωθεί ότι, κάθε σύμβολο μπορεί να αποτελείται από περισσότερα του ενός επίπεδα. Για τον καθορισμό των χαρακτηριστικών του συμβόλου, γίνεται διπλό κλικ στο πρότυπο του συμβόλου που εμφανίζεται στην καρτέλα Symbology και μέσω του μενού Symbol Selector που ενεργοποιείται και το πλήκτρο Edit symbol, μπορούν να διαφοροποιηθούν η μορφή, η απόχρωση και το περίγραμμα του συμβόλου, μέσω του Symbol Property Editor. 
Για τα επιφανειακά σύμβολα οι διαθέσιμες μορφές βρίσκονται στην επιλογή Type (Εικόνα 10.31).
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Εικόνα 10.31 Διαχείριση των χαρακτηριστικών για ένα επιφανειακό σύμβολο στο ArcMap.
Οι διαθέσιμοι τύποι επιφανειακών συμβόλων είναι:
 
	Simple συμπαγές χρώμα με προαιρετικό περίγραμμα. 

	3D Texture – υφή 3Δ.
	Gradient – χρώμα με διαβαθμισμένη ένταση.
	Line – διαγράμμιση. 
	Marker – επανάληψη σημειακού συμβόλου.
	Picture – επανάληψη εικονιδίου.

 
H διαχείριση των επιπέδων ενός συμβόλου παρατίθεται στην Εικόνα 10.32.
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Εικόνα 10.32 Διαχείριση των επιπέδων ενός συμβόλου στο ArcMap.
Αντίστοιχα, για τα σημειακά σύμβολα, μέσω του Symbol Selector επιλέγεται η μορφή, η απόχρωση, το μέγεθος και η γωνία του συμβόλου, ενώ από τον Symbol Property Editor γίνεται προσθήκη νέων layers στο σύμβολο, αλλαγή τύπου (μορφής), προσθήκη μάσκας και περιγράμματος. Οι διαθέσιμοι τύποι σημειακών συμβόλων βρίσκονται στο μενού Type. Ομοίως, για τα γραμμικά σύμβολα, μέσω του Symbol Selector επιλέγεται η μορφή, η απόχρωση, και το πάχος (μέγεθος) της γραμμής, ενώ από τον Symbol Property Editor γίνεται προσθήκη νέων layers στο σύμβολο και σύνθετες αλλαγές του τύπου (μορφής) της γραμμής. Οι διαθέσιμοι τύποι γραμμής βρίσκονται στο μενού Type.
10.8.2.2 Συμβολισμός χωρικών στοιχείων με κατηγοριοποίηση 
 
Για τον συμβολισμό των χαρτογραφικών οντοτήτων ενός layer ανάλογα με τις ιδιότητές τους, επιλέγεται από την καρτέλα Symbology η μέθοδος συμβολισμού Categories. Aπό την καρτέλα Properties>Symbology >Categories>Unique values και τον κατάλογο Value field, επιλέγεται το πεδίο με βάση το οποίο θα γίνει ο συμβολισμός. Mε τα πλήκτρα Add All Values, Add values, Remove και Remove All, γίνεται η διαχείριση των τιμών του επιλεγμένου πεδίου. Οι τιμές μπορούν επίσης να ομαδοποιηθούν ως εξής: με αριστερό κλικ επιλέγεται η πρώτη τιμή και πατώντας το πλήκτρο <Shift> επιλέγεται η τελευταία αν πρόκειται για τιμές οι οποίες είναι διαδοχικές στη λίστα, ενώ για την επιλογή μεμονωμένων τιμών χρησιμοποιείται το πλήκτρο <Ctrl> σε συνδυασμό με αριστερό κλικ. Στη συνέχεια με δεξί κλικ, από το μενού που εμφανίζεται, επιλέγεται η λειτουργία Group Values. Για κάθε τιμή (ή ομάδα τιμών) ο χρήστης μπορεί να ενημερώσει το πεδίο Label με την περιγραφή των δεδομένων, η οποία μπορεί να χρησιμοποιηθεί στο υπόμνημα ως επεξήγηση του αντίστοιχου συμβόλου. Εναλλακτικά, μπορεί να προστεθεί σε κάθε Label με δεξί κλικ και τη λειτουργία Edit Description for legend, η επεξήγηση του συμβόλου.
 
 
[image: ]
Εικόνα 10.33 Το περιβάλλον διαμόρφωσης μιας χρωματικής ακολουθίας στο ArcMap.
Ο συμβολισμός με χρωματικές ακολουθίες (color ramps) χρησιμοποιείται στο ArcMap για την απόδοση ομάδων δεδομένων με ομάδες χρωμάτων. Οι χρωματικές ακολουθίες είναι διαθέσιμες όταν η μέθοδος συμβολισμού είναι Categories ή Quantities. Τυπικό παράδειγμα η εφαρμογή τους στους χάρτες διαβαθμισμένου χρώματος (Graduated colors maps). Στο ArcMap υπάρχουν ήδη αρκετές (Εικόνα 10.34), αλλά μπορούν να κατασκευαστούν και άλλες είτε από το βασικό μενού μέσω του Customize>Style Manager είτε με την τροποποίηση των ήδη υπαρχουσών. Η τροποποίηση μιας υπάρχουσας ακολουθίας (Εικόνα 10.33) γίνεται με δεξί κλικ και την επιλογή Properties και η αποθήκευσή της με την επιλογή Save to Style (Εικόνα 10.35). Υποστηρίζονται τέσσερα είδη color ramps:
 
	Αλγοριθμικές (Algorithmic) – φασματική μετάβαση μεταξύ δύο χρωμάτων. 
	Προκαθορισμένες (Preset) – ορίζονται με τη διαδοχή 13 συγκεκριμένων χρωμάτων. 
	Τυχαίων χρωμάτων (Random) – διακριτά φασματικά χρώματα. 
	Πολλαπλές (Multipart) – συγκροτούνται με την αλληλουχία οποιουδήποτε από τους τρεις προηγούμενους τύπους, σε οποιοδήποτε συνδυασμό.
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Εικόνα 10.34 Επιλογή μιας χρωματικής ακολουθίας από τις υπάρχουσες στο ArcMap.
10.8.2.3 Εκχώρηση διαφάνειας στα σύμβολα
 
Η διαφάνεια στην απόδοση ενός layer ορίζεται στον συμβολισμό του μέσω της καρτέλας Properties>Display>Transparency (%). Η προσομοίωση της διαφάνειας στο υπόμνημα συμβόλων είναι εφικτή, εφόσον αυτό οριστεί στην καρτέλα Properties>General του dataframe, όπου ενεργοποιείται το checkbox Simulate layer transparency in legends και ισχύει για τα σύμβολα όλων των θεματικών επιπέδων τα οποία αποδίδονται με διαφάνεια.
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Εικόνα 10.35 Αποθήκευση μιας χρωματικής ακολουθίας στο ArcMap.
10.8.2.4 Απόδοση τιμών ιδιοτήτων με μορφή κειμένου (labels)
 
Η απόδοση τιμών ιδιοτήτων με μορφή κειμένου, γίνεται με δύο μεθόδους: είτε με ενιαίο τρόπο για όλες τις οντότητες, είτε ανάλογα με τις κατηγορίες (classes) δεδομένων. Στον κατάλογο του dataframe επιλέγεται με αριστερό κλικ το θεματικό επίπεδο (layer) και από το μενού λειτουργιών που εμφανίζεται, ενεργοποιείται η λειτουργία Label features και στη συνέχεια με Properties επιλέγεται η καρτέλα Labels (Εικόνα 10.36). Στην καρτέλα αυτή ορίζεται το πεδίο (Label field) από το περιεχόμενο του οποίου θα αντληθούν οι labels. Η λειτουργία Label features μπορεί να ενεργοποιηθεί και μέσω της καρτέλας αυτής. Πρέπει να σημειωθεί ότι οι labels διατηρούν σταθερό μέγεθος καθώς γίνεται μεγέθυνση ή σμίκρυνση του χάρτη. Από το μενού Properties>General>Reference Scale του dataframe ορίζοντας την κλίμακα αναφοράς «παγώνει» το μέγεθος του κειμένου (και των συμβόλων). Έτσι ακόμη και στην κατάσταση data view τα σύμβολα και τα κείμενα φαίνονται όπως θα φαίνονται στην εκτύπωση.
Με την επιλογή Placement Properties καθορίζεται η σχετική θέση κειμένου–χαρτογραφικού στοιχείου. Οι δυνατότητες διαφέρουν ανάλογα με τη γεωμετρία του χαρτογραφικού στοιχείου με το οποίο σχετίζονται οι labels. Για γραμμικά χαρτογραφικά στοιχεία καθορίζονται o προσανατολισμός και η θέση. Οι επιλογές για την προσανατολισμό σε σχέση με τα γραμμικά στοιχεία είναι:
 
	Οριζόντια.
	Παράλληλα με τη γραμμή.
	Σε καμπύλη ακολουθώντας τη μορφή της γραμμής.
	Κάθετα στη γραμμή.
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Εικόνα 10.36 Το περιβάλλον διαμόρφωσης των labels στο ArcMap.
Οι επιλογές για τη σχετική θέση κειμένου-γραμμικού χαρτογραφικού στοιχείου είναι:
 
	Επάνω από τη γραμμή.
	Κατά μήκος της γραμμής.
	Κάτω από τη γραμμή.

 
Αυτή η μέθοδος συμβολισμού βρίσκει ευρεία εφαρμογή στον συμβολισμό των ισαριθμικών (ή ισοπληθών) καμπυλών, με χαρακτηριστικό παράδειγμα τις ισοϋψείς καμπύλες ενός τοπογραφικού χάρτη.
Για την τοποθέτηση του κειμένου σε σχέση με τα σημειακά σύμβολα με τα οποία συνδέονται, στο μενού Placement Properties>Change location παρατίθενται οπτικοποιημένες και με ιεράρχηση προτεραιότητας, οι πιθανές σχετικές θέσεις κειμένου–συμβόλου. Στην καρτέλα Conflict Detection ορίζονται εξειδικευμένες παράμετροι του συμβολισμού, σε σχέση με την προτεραιότητα και το βάρος της απόδοσης του κειμένου.
Τα χαρακτηριστικά συμβόλου για το κείμενο (γραμματοσειρά, μέγεθος, απόχρωση κλπ.) καθορίζονται από το πεδίο Symbol από όπoυ ενεργοποιείται ο αντίστοιχος Editor. Στην καρτέλα Mask του Editor ορίζονται τα χαρακτηριστικά ενός επιφανειακού συμβόλου, το οποίο θα περιβάλλει το κείμενο και θα λειτουργεί ως υπόβαθρο (φόντο) ώστε να είναι πιο ευανάγνωστο σε σχέση με τα γραμμικά χαρτογραφικά στοιχεία τα οποία τέμνονται από το κείμενο. Η απόχρωση αυτού του επιφανειακού συμβόλου συνήθως είναι ίδια με την απόχρωση του φόντου επάνω στο οποίο «πατάει» το κείμενο.
10.8.2.5 Απόδοση Labels σε κατηγορίες (classes)
 
Στον κατάλογο του dataframe, επιλέγεται με αριστερό κλικ το layer και από το μενού λειτουργιών που εμφανίζεται με δεξί κλικ, ενεργοποιείται η λειτουργία Label features και στη συνέχεια με Properties επιλέγεται η καρτέλα Labels. Εκεί ενεργοποιείται η επιλογή Method: Define classes of features and label each class differently (Εικόνα 10.37). Με τις επιλογές Class: Add, Rename, Delete γίνεται η διαχείριση των κλάσεων, ενώ με την SQL query γίνεται η επιλογή των χαρτογραφικών δεδομένων για τα οποία θα εφαρμοστεί η απόδοση των τιμών, με βάση τις ιδιότητές τους. Η επιλογή Get Symbol Classes δημιουργεί κατηγορίες ανάλογα με την κατηγοροποίηση των δεδομένων. Επίσης, με την επιλογή Expression δίνεται η δυνατότητα καθορισμού μιας λογικής έκφρασης για την τιμή της ιδιότητας που θα αποδοθεί. Π.χ. για τις ισοβαθείς: [Elevation] * (-1) ώστε να εμφανίζεται η τιμή ως θετική τιμή βάθους και όχι ως αρνητική τιμή υψομέτρου όπως ίσως είναι αποθηκευμένη στον πίνακα ιδιοτήτων του θεματικού επιπέδου.
 
 
[image: ]
Εικόνα 10.37 Απόδοση labels σε κατηγορίες στο ArcMap.
10.8.2.6 Σύνθετη απόδοση Labels
 
Στο περιβάλλον διαμόρφωσης των Labels όπως έχει περιγραφεί στις §10.8.2.4 και §10.8.2.5, από το πεδίο Expression δίνεται η δυνατότητα να χρησιμοποιηθούν συναρτήσεις (functions) της Visual Basic για τη διαμόρφωση του περιεχομένου ή/και της εμφάνισης του κειμένου που θα αποδοθεί ως label. Παραδείγματα:
 
	Προσθήκη ενός σταθερού κειμένου πριν από το περιεχόμενο του πεδίου Field1: "κείμενο1: " & [field1].
	Αναγραφή δύο ιδιοτήτων (έστω Field1 και Field2) σε δύο διαφορετικές γραμμές: [Field1] & vbCrLf & [Field2] ή [Field1] & vbNewLine & [Field2]

 
Ή με τη χρήση VBScript με την ενεργοποίηση του πεδίου Advanced: 
 
Function FindLabel ( [FIELD1],  [FIELD2]  )
FindLabel = [FIELD1] & vbCrLf & [FIELD2] 
End Function
 
Άλλα παραδείγματα χρήσης συναρτήσεων παρουσιάζονται στην Εικόνα 10.38, ενώ η ενίσχυση του κειμένου με χρήση εντολών διαμόρφωσης (formatting tags), παρουσιάζεται στην Εικόνα 10.39.
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Εικόνα 10.38 Παραδείγματα συναρτήσεων διαμόρφωσης labels στο ArcMap.
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Εικόνα 10.39 Εντολές διαμόρφωσης κειμένου (formatting tags) στο ArcMap.
10.8.2.7 Αποθήκευση συμβολισμού σε layer
 
Με δεξί κλικ στο όνομα του layer στον πίνακα περιεχομένων και την επιλογή Save As Layer File, αποθηκεύεται το layer με τον συμβολισμό όπως αυτός έχει καθοριστεί στην τρέχουσα σύνθεση και μπορεί να χρησιμοποιηθεί είτε από άλλα layers, είτε από το ίδιο σε μία άλλη χαρτοσύνθεση. Η ανάκλησή του γίνεται από την επιλογή Properties>Symbology>Import
10.8.2.8 Εισαγωγή συμβολισμού από layer
 
Με δεξί κλικ σε ένα layer και Properties>Symbology>Import αναζητείται το layer file που περιέχει τον συμβολισμό ο οποίος θα χρησιμοποιηθεί. 
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Εικόνα 10.40 Το περιβάλλον δημιουργίας Annotation feature class στο ArcCatalog.
10.8.3. Ονοματολογία
 
Η annotation είναι ένας τρόπος αποθήκευσης τοπωνυμίων ή κειμένου (text) που πρόκειται να αποδοθούν σε χάρτη, σύμφωνα με τον οποίο για κάθε στοιχείο του τοπωνυμίου αποθηκεύεται η θέση, το κείμενο και οι παράμετροι απόδοσης (εμφάνισης). Επιλέγεται όταν είναι σημαντική η ακριβής θέση του τοπωνυμίου/κειμένου. Σε αντίθεση με την απόδοση ονομασιών ως text, η χρήση της annotation επιτρέπει την απόδοση σε περισσότερους από έναν χάρτες και δεν επηρεάζεται από τη θέση του dataframe στο μέσο απόδοσης. Οι χωρικές οντότητες οι οποίες είναι αποθηκευμένες ως annotation έχουν σταθερή θέση και μέγεθος σε μονάδες του προβολικού συστήματος, οπότε και υπακούουν στους κανόνες μεγέθυνσης και σμίκρυνσης με τις αλλαγές της κλίμακας του χάρτη. Υποστηρίζονται δύο τύποι annotation: geodatabase annotation και map document annotation. Η annotation στη γεωβάση αποθηκεύεται σε feature classes. Όπως σε όλες τις feature classes, οι χωρικές οντότητες σε μια annotation feature class έχουν γεωγραφική θέση και ιδιότητες και μπορεί να βρίσκονται είτε μέσα σε feature dataset, είτε να είναι ελεύθερες (ανεξάρτητες) μέσα στη γεωβάση. Για κάθε annotation feature καταγράφονται τα στοιχεία του συμβολισμού όπως η γραμματοσειρά (font), το μέγεθος (size), το χρώμα (color), και άλλα στοιχεία τα οποία αποτελούν παραμέτρους του σχεδιαστικού χαρακτήρα του συμβόλου του κειμένου. Η annotation τυπικά είναι text, αλλά μπορεί να περιλαμβάνει και γραφικά.
Σε περιβάλλον ArcCatalog επιλέγεται η γεωβάση ή το feature dataset και με δεξί κλικ New>Feature class ενεργοποιείται μια ακολουθία από διαδοχικά μενού δημιουργίας νέας feature class. Ορίζεται το όνομα (Name) και ο τύπος Type>Annotation Features, η κλίμακα αναφοράς (Reference Scale) καθώς και οι κατηγορίες της ονοματολογίας (annotation classes) με τα στοιχεία συμβολισμού τους (Εικόνα 10.40).
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Εικόνα 10.41 Διαχείριση των annotation classes στο ArcCatalog.
Οι κατηγορίες της ονοματολογίας δημιουργούνται με βάση το είδος των ονομασιών που θα περιλαμβάνουν και ακολουθούν τον τύπο και τα χαρακτηριστικά συμβολισμού των γεωγραφικών ονομασιών. Οι οντότητες οι οποίες εντάσσονται σε μια annotation feature class μπορεί να είναι δύο ειδών: 
 
	Ονομασίες οι οποίες αναφέρονται σε γεωγραφικά στοιχεία ή γεωγραφικούς σχηματισμούς που δεν σχετίζονται με οντότητες της γεωβάσης, όπως για παράδειγμα ονομασίες ορέων, θαλασσών, ακρωτηρίων κλπ.
	Ονομασίες οι οποίες συνδέονται με συγκεκριμένες οντότητες που βρίσκονται σε μιά άλλη feature class της γεωβάσης. Το ‘όνομα/κείμενο’ αντιστοιχεί στο περιεχόμενο ενός ή περισσοτέρων πεδίων της οντότητας με την οποία σχετίζονται, για παράδειγμα, ονομασίες οικισμών ή ποταμών. Η ονοματολογία η οποία συνδέεται με συγκεκριμένη feature class, ενημερώνεται αυτόματα για τις αλλαγές που γίνονται σ’ αυτήν, τόσο στα χωρικά όσο και στα περιγραφικά της στοιχεία (θέση – ιδιότητες).

 
Η ονοματολογία ως χωρική οντότητα (annotation feature class), περιλαμβάνει μία ή περισσότερες κατηγορίες (annotation classes). Κάθε κατηγορία περιλαμβάνει τα χαρακτηριστικά τα οποία καθορίζουν τον τρόπο εμφάνισης  συγκεκριμένου υποσυνόλου ονομασιών. Τα χαρακτηριστικά αυτά είναι:
 
	Τα χαρακτηριστικά του συμβόλου τα οποία θα χρησιμοποιούνται κατά τη δημιουργία νέων οντοτήτων (‘ονομασιών’). Τα σύμβολα που χρησιμοποιούνται έχουν τη μορφή και τα χαρακτηριστικά κειμένου (text).
	Το εύρος των κλιμάκων στο οποίο θα είναι ορατή η ονοματολογία.

 
Οι annotation classes αντικαθιστούν τη δημιουργία και διαχείριση πολλών annotation feature classes. Αν υπάρχουν περισσότερες της μιας annotation classes, αυτές υλοποιούνται ως subtypes στην annotation feature class. Η διαχείρισή τους γίνεται από την καρτέλα Properties>Annotation Classes της feature class (Εικόνα 10.41).
Η εισαγωγή και επεξεργασία των οντοτήτων γίνεται σε περιβάλλον ArcMap. Προστίθεται στον πίνακα περιεχομένων το θεματικό επίπεδο της annotation (annotation feature class) και γίνεται η έναρξη της ψηφιακής καταγραφής (ή της διόρθωσης) με την επιλογή Editor>Start Editing από το πλήκτρο της Editor toolbar. Για την εισαγωγή επιλέγεται στο παράθυρο Create Features η annotation class και στο μενού Construction Tools ορίζεται η μορφή του οδηγού αναγραφής της annotation που θα προστεθεί.
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Εικόνα 10.42 Οι οδηγοί αναγραφής της ονοματολογίας στο ArcMap.
Οι οδηγοί αναγραφής που υποστηρίζονται είναι:
 
	Οριζόντιος (Horizontal).
	Κεκλιμένος ευθύγραμμος (Straight).
	Καμπυλωτός (Curved).
	Ανάλογος με τη μορφή γραμμικού/πολυγωνικού στοιχείου (Follow-feature).
	Κατασκευή annotation features με γραμμή σύνδεσης με συγκεκριμένη θέση (Leader).

 
Στο πεδίο του παραθύρου Annotation construction>Text καταγράφεται το περιεχόμενο (όνομα/κείμενο). Αν είναι επιθυμητή η αναγραφή κειμένου σε περισσότερες από μία γραμμές, η αλλαγή γραμμής επισημαίνεται με <Ctrl><Enter>. Αν είναι επιθυμητή η αναγραφή κειμένου από ένα πεδίο ιδιοτήτων μιας οντότητας, γίνεται κλικ στο Find Text και στη συνέχεια κλικ στην οντότητα.
Η επιλογή, η μετακίνηση ή η διαγραφή μιας ή περισσοτέρων οντοτήτων annotation υλοποποιείται με τον ίδιο τρόπο που ισχύει για όλα τα άλλα είδη οντοτήτων κατά τη διαδικασία διόρθωσης (editing). Η αποθήκευση των δεδομένων τα οποία καταγράφηκαν γίνεται με την επιλογή Editor>Save Edits και η ολοκλήρωση της ψηφιακής καταγραφής με την επιλογή Editor>Stop Editing. Κατά την ψηφιακή καταγραφή χρησιμοποιούνται τα χαρακτηριστικά του συμβόλου της annotation class τα οποία έχουν οριστεί κατά τη δημιουργία της. Είναι όμως εφικτή, η αλλαγή αυτών καθώς και άλλων χαρακτηριστικών για επιλεγμένες οντότητες. Η επιλογή γίνεται με το εργαλείο επιλογής [image: ] που βρίσκεται στην Editor toolbar και οι αλλαγές με δεξί κλικ, οπότε και ενεργοποιείται το μενού με τις διαθέσιμες ενέργειες (context μενού).
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Εικόνα 10.43 Το περιβάλλον ρύθμισης της προσθήκης ονοματολογίας στο ArcMap.
10.8.3.1 Αλλαγή του συμβόλου
 
Για την επιλεγμένη οντότητα annotation, με δεξί κλικ και την επιλογή Attributes ενεργοποιείται το μενού ιδιοτήτων της. Οι αλλαγές γίνονται μέσω της καρτέλας Annotation με τα εργαλεία διαμόρφωσης του συμβόλου.
10.8.3.2 Αλλαγή του κειμένου
 
Για την επιλεγμένη οντότητα annotation, με δεξί κλικ και την επιλογή Attributes ενεργοποιείται το μενού ιδιοτήτων της. Η αλλαγή γίνεται μέσω της καρτέλας Annotation στο πεδίο όπου αναγράφεται το κείμενο.
10.8.3.3 Αλλαγή της μορφής του οδηγού αναγραφής
 
Για την επιλεγμένη οντότητα annotation, με δεξί κλικ και την επιλογή Curvature καθορίζεται η νέα μορφή του οδηγού αναγραφής.
10.8.3.4 Αλλαγή του σχήματος του οδηγού αναγραφής
 
Με το εργαλείο [image: ] επιλέγεται η οντότητα με καμπυλωτό οδηγό αναγραφής, το σχήμα του οποίου χρειάζεται να αλλάξει. Με δεξί κλικ και Edit Baseline Sketch εμφανίζονται οι κορυφές μορφοποίησης του οδηγού. Για τη μετακίνηση μιας κορυφής, τίθεται ο δείκτης επάνω της κι όταν το σχήμα του γίνει ρομβοειδές, σύρεται στην νέα θέση όπου και αφήνεται. Για την προσθήκη νέων κορυφών με δεξί κλικ και Insert vertex προστίθεται νέα κορυφή στη θέση που βρίσκεται ο δείκτης. Η ολοκλήρωση των διορθώσεων ολοκληρώνεται με δεξί κλικ και Finish Baseline Sketch.
 
 
10.8.3.5 Αναστροφή annotation
 
Για την επιλεγμένη οντότητα με δεξί κλικ και Flip Annotation γίνεται αναστροφή της ως προς τον οδηγό αναγραφής. Εφαρμόζεται σε οντότητες με ευθύγραμμο ή οριζόντιο οδηγό αναγραφής.
10.8.3.6 Περιστροφή annotation
 
Για την επιλεγμένη οντότητα με δεξί κλικ και Rotate Mode γίνεται περιστροφή του οδηγού αναγραφής, το τέλος της οποίας σηματοδοτείται με δεξί κλικ και Finish Rotate Mode.
10.8.3.7 Κατασκευή & διαχείριση annotation σε follow-feature mode
 
Στο πεδίο του παραθύρου Annotation construction> Text γράφεται το κείμενο ή ανακαλείται από ένα πεδίο ιδιοτήτων (Find Text). Ακολούθως, γίνεται κλικ στην οντότητα τη μορφή της οποίας θα ακολουθεί ο οδηγός αναγραφής της annotation και στη συνέχεια πάλι κλικ σε σημείο κατά μήκος της επιλεγμένης οντότητας όπου θα τοποθετηθεί το annotation. Οι ρυθμίσεις για την τοποθέτηση γίνονται μέσω Follow Features Options (Εικόνα 10.44).
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Εικόνα 10.44 Οι ρυθμίσεις τοποθέτησης ονοματολογίας σύμφωνα με τη μορφή ενός γραμμικού στοιχείου στο ArcMap. 
Περαιτέρω διαχείριση γίνεται με την επιλογή Follow του context μενού. Εναλλακτικά, μπορεί να χρησιμοποιηθεί η επιλογή Follow this Feature η οποία ενεργοποιείται με δεξί κλικ από το context μενού του επιλεγμένου annotation. Ο δείκτης τοποθετείται στη γραμμική οντότητα η οποία θα χρησιμοποιηθεί ως οδηγός αναγραφής και επανασχεδιάζεται το επιλεγμένο annotation.
10.8.3.8 Κατασκευή annotation από labels
 
Έχοντας αποδώσει μια ιδιότητα με τη μορφή κειμένου (labels) με την επιλογή Convert Labels to Annotation είτε για ένα μεμονωμένο layer είτε για το dataframe, μετατρέπονται οι labels σε annotation. Με τον τρόπο αυτό, μετατρέπεται σε ‘ονοματολογία’ το περιεχόμενο μιας ιδιότητας όπως έχει αποθηκευτεί σε μια feature class και δημιουργείται μια νέα annotation feature class. Η αποθήκευση μπορεί να γίνει είτε στο ίδιο dataset που βρίσκεται και η feature class – πηγή, οπότε και πρόκειται για annotation η οποία είναι συνδεδεμένη με τις οντότητες μιάς άλλης feature class (feature linked annotation), είτε σε κάποια άλλη θέση της γεωβάσης. Στο μενού επιλογών το οποίο ενεργοποιείται κατά τη μετατροπή, ορίζονται:
 
	Πού θα αποθηκευτεί η annotation (geodatabase/map document).
	Για ποιές οντότητες θα δημιουργηθεί (All features/Features in current extent).
	Αν θα συνδέεται με τις οντότητες της πηγής (Feature linked).

 
Θα δημιουργηθούν οντότητες και για labels που δεν έχουν αποδοθεί λόγω έλλειψης χώρου στο χάρτη (Convert unplaced labels to unplaced annotation). Η annotation η οποία έχει δημιουργηθεί με τη μέθοδο αυτή , εμφανίζεται στον χάρτη μόνο εφόσον εμφανίζεται και το θεματικό επίπεδο από το οποίο έχει αντληθεί. Ο συμβολισμός ακολουθεί τη μορφοποίηση που έχει οριστεί κατά την απόδοση των labels. Για αλλαγές χρησιμοποιούνται τα εργαλεία που έχουν περιγραφεί ανωτέρω στις παραγράφους §10.8.3.1 έως §10.8.3.7. Κατά τη μετατροπή, κάθε label class μετατρέπεται σε annotation class.
10.8.3.9 Τοποθέτηση unplaced annotation
 
Σε λειτουργία διόρθωσης (Editor>Start Editing) ενεργοποιείται το παράθυρο της μη τοποθετημένης (unplaced) annotation Editor>Editing Windows>Unplaced Annotation. Όλες οι οντότητες (features), οι οποίες δεν έχουν εμφανιστεί στον χάρτη επειδή δεν υπήρχε αρκετός χώρος σύμφωνα με τις ρυθμίσεις απόδοσης των labels, εμφανίζονται ως ένας κατάλογος, ο οποίος μπορεί να ταξινομηθεί είτε αλφαβητικά (κατά τη στήλη Text) είτε κατά την κατηγορία (κατά τη στήλη Class). Η καταγραφή τους στον κατάλογο γίνεται με την επιλογή Search Now και η σχεδίασή τους με την επιλογή Draw. Με δεξί κλικ σε μια εγγραφή αυτού του καταλόγου, ενεργοποιείται το context μενού των διαθέσιμων ενεργειών (Place/Pan to/Zoom to Annotation, Pan/Zoom to Feature, Delete). Αφού τοποθετηθεί το annotation, μπορούν να χρησιμοποιηθούν για τη διαχείρισή της τα εργαλεία που έχουν περιγραφεί στις παραγράφους §10.8.3.1 έως §10.8.3.7.
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Εικόνα 10.45 Το περιβάλλον ρύθμισης των χαρακτηριστικών του γεωγραφικού κανάβου στο ArcMap.
10.8.4 Προσθήκη γεωγραφικού κανάβου
 
Από το μενού Properties του dataframe (που ενεργοποιείται με δεξί κλικ στο όνομα του Dataframe) επιλέγεται η καρτέλα Grids και το πλήκτρο New Grid με το οποίο ενεργοποιείται η διαδικασία προσθήκης κανάβων μέσω μιας αλληλουχίας από διαδοχικά μενού (Grids and Graticules Wizard). Η επιλογή Graticule: divides map by meridians and parallels αντιστοιχεί στην κατασκευή γεωγραφικού κανάβου. O oρισμός του μεγέθους των φατνίων του κανάβου, γίνεται σε μοίρες, πρώτα και δεύτερα λεπτά της μοίρας. Μετά την ολοκλήρωση της διαδικασίας κατασκευής του γεωγραφικού κανάβου, με την επιλογή Properties, γίνεται περαιτέρω επεξεργασία της μορφής των μεσημβρινών & των παραλλήλων καθώς και των ενδείξεων των συντεταγμένων τους.
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Εικόνα 10.46 Τα διαδοχικά μενού ρύθμισης των χαρακτηριστικών του κανάβου τετραγωνισμού στο ArcMap.
10.8.5 Προσθήκη κανάβου τετραγωνισμού
 
Η διαδικασία είναι ανάλογη εκείνης για την προσθήκη του γεωγραφικού κανάβου (§10.8.4). Από το μενού Properties του Dataframe (που ενεργοποιείται με δεξί κλικ στο όνομα του Dataframe) επιλέγεται η καρτέλα Grids: Properties>Grids>New Grid>Measured Grid: divides map into a grid of map units. Καθορίζονται το μέγεθος των φατνίων στις μονάδες του συστήματος αναφοράς, η μορφή του κανάβου καθώς και το αντίστοιχο σύμβολο. Ακολούθως γίνεται ο καθορισμός της μορφής και των συμβόλων των υποδιαιρέσεων και των αριθμητικών ενδείξεων των καρτεσιανών συντεταγμένων. Μετά την ολοκλήρωση της διαδικασίας εισαγωγής του κανάβου, με την επιλογή Properties, γίνεται περαιτέρω επεξεργασία της μορφής του κανάβου καθώς και των αριθμητικών ενδείξεων. Στο μενού Additional Properties>Number format βρίσκονται τα εργαλεία διαμόρφωσης των αριθμητικών ενδείξεων των καρτεσιανών συντεταγμένων. Είναι κρίσιμο να οριστεί εδώ το πλήθος των δεκαδικών ψηφίων, επειδή στο ArcMap είναι προκαθορισμένο να ισούται με 6 δεκαδικά ψηφία.
10.8.6 Προσθήκη εξωτερικού πλαισίου και φόντου
 
Με την καρτέλα Properties>Frame του dataframe, ορίζεται ένα εξωτερικό πλαίσιο της χαρτογραφούμενης περιοχής σε απόσταση Gap: X & Y γύρω από αυτήν, καθώς και το χρώμα του υποβάθρου (Background). Το γέμισμα του Frame με χρώμα χρησιμοποιείται ως το φόντο της θάλασσας ή της ξηράς (ανάλογα με τον χάρτη), στην περίπτωση που δεν υπάρχει η αντίστοιχη κλάση οντοτήτων (feature class) στη γεωβάση.
10.8.7 Προσθήκη τίτλου
 
Η εισαγωγή του τίτλου γίνεται από το βασικό μενού Insert>Title. Η μετακίνηση στην επιθυμητή θέση γίνεται με το εργαλείο χειροκίνητης επιλογής της εργαλειοθήκης Draw, ενώ η διαχείρισή του γίνεται με δεξί κλικ και την επιλογή Properties. Εναλλακτικά, μπορεί να προστεθεί με το εργαλείο προσθήκης κειμένου της εργαλειοθήκης Draw (βλ. και κατωτέρω §10.8.11).
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Εικόνα 10.47 Διαχείριση της γραφικής κλίμακας στο ArcMap.
10.8.8 Προσθήκη γραφικής κλίμακας
 
Η εισαγωγή της γραφικής κλίμακας γίνεται από το βασικό μενού Insert>Scale Bar. Επιλέγεται η μορφή της από ένα σύνολο προκαθορισμένων προτύπων και ακολούθως καθορίζονται οι υποδιαιρέσεις και οι αριθμητικές ενδείξεις (Εικόνα 10.47). Η μετακίνηση στην επιθυμητή θέση γίνεται με το εργαλείο χειροκίνητης επιλογής της εργαλειοθήκης Draw. Είναι εφικτή η αλλαγή των χαρακτηριστικών της σε δεύτερο χρόνο, με δεξί κλικ και Properties.
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Εικόνα 10.48 Διαχείριση του περιεχομένου του υπομνήματος στο ArcMap.
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Εικόνα 10.49 Εισαγωγή της επεξήγησης του συμβόλου για τη μέθοδο συμβολισμού με ενιαίο σύμβολο στο ArcMap.
10.8.9 Προσθήκη και διαχείριση υπομνήματος συμβόλων
 
Η εισαγωγή του υπομνήματος συμβόλων γίνεται από το βασικό μενού Insert>Legend. Η διαδικασία υλοποιείται με μια αλληλουχία από διαδοχικά μενού όπου καθορίζονται το περιεχόμενο και η μορφή των στοιχείων του υπομνήματος. Αρχικά γίνεται η επιλογή των θεματικών επιπέδων τα οποία θα εμφανιστούν στο υπόμνημα. Η προκαθορισμένη επιλογή περιλαμβάνει όλα τα ενεργά επίπεδα της σύνθεσης, αλλά είναι εφικτή η αφαίρεση ή η εκ των υστέρων προσθήκη, καθώς και η αλλαγή της σειράς τοποθέτησής τους στο υπόμνημα (Εικόνα 10.48). 
Στη συνέχεια καθορίζονται:
 
	Ο τίτλος του υπομνήματος και χαρακτηριστικά του αντίστοιχου συμβόλου (text).
	Οι αποστάσεις μεταξύ των διαφόρων στοιχείων του υπομνήματος (σύμβολα/περιγραφή).
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Εικόνα 10.50 Δημιουργία νέας στήλης στο υπόμνημα συμβόλων στο ArcMap.
Η ολοκλήρωση της διαδικασίας γίνεται με Finish και ο χρήστης τοποθετεί το υπόμνημα στην επιθυμητή θέση. Η μετακίνηση γίνεται με το εργαλείο χειροκίνητης επιλογής της εργαλειοθήκης Draw. Εφόσον η μορφή του υπομνήματος το απαιτεί, ακολουθούν ενέργειες για τον καθορισμό της εμφάνισης συμβόλου-επεξήγησης για κάθε layer. Το  υπόμνημα, ως γραφικό στοιχείο της σύνθεσης, επιλέγεται με το εργαλείο επιλογής και με δεξί κλικ εμφανίζεται το μενού λειτουργιών του. Επιλέγοντας Legend Properties>Items για κάθε στοιχείο (Legend item) καθορίζεται ο τρόπος εμφάνισής του (Style). Το περιεχόμενο της επεξήγησης κάθε συμβόλου, καθορίζεται από την καρτέλα Legend Items>Style>Properties>General και εξαρτάται από το είδος του συμβολισμού όπως έχει οριστεί σε κάθε layer (Properties>Symbology). Πιο συγκεκριμένα, εάν η μέθοδος συμβολισμού είναι Symbology: Features>Single symbol, ενεργοποιείται η επιλογή Show Descriptions και καθορίζονται τα χαρακτηριστικά της γραμματοσειράς στο πεδίο Description Symbol. Το περιεχόμενο της επεξήγησης προέρχεται από την καρτέλα Properties>Symbology>Description του layer, όπου και πρέπει να συμπληρωθεί (Εικόνα 10.49). Εάν η μέθοδος συμβολισμού είναι Symbology: Categories>Unique values, ενεργοποιείται η επιλογή Show Labels και καθορίζονται τα χαρακτηριστικά της γραμματοσειράς στο πεδίο Label Symbol. Το περιεχόμενο της περιγραφής προέρχεται από την καρτέλα Properties>Symbology και το πεδίο Labels όπου έχουν συμπληρωθεί είτε από τον χρήστη είτε από το λογισμικό (βλ.§ 10.8.2.2). Στην περίπτωση κατά την οποία έχει συμπληρωθεί το πεδίο Properties>Symbology>Label>Edit Description>Description for Legend του layer, τότε ενεργοποιείται και εδώ η επιλογή Show Descriptions, όπως περιγράφεται ανωτέρω.
Εάν, είτε ο διαθέσιμος χώρος, είτε το στυλ του χάρτη το απαιτεί, το υπόμνημα μπορεί να συγκροτείται από περισσότερες από μία στήλες. Η δημιουργία νέας στήλης συμβόλων υλοποιείται με την επιλογή του θεματικού επιπέδου του υπομνήματος από το οποίο θα ξεκινήσει η νέα στήλη και σημειώνεται η λειτουργία Place in new column (Εικόνα 10.50).
10.8.10 Προσθήκη γεωμετρικών σχημάτων
 
Η προσθήκη γεωμετρικών σχημάτων, όπως πλαίσια, περιγράμματα, σημεία κ.ά. γίνεται με το εργαλείο σχεδίασης από την εργαλειοθήκη Draw το οποίο διαθέτει διάφορες μορφές (Εικόνα 10.51).
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Εικόνα 10.51 Προσθήκη γεωμετρικών σχημάτων στο ArcMap.
10.8.11 Προσθήκη κειμένου 
 
Η προσθήκη κειμένου γίνεται με το εργαλείο κειμένου από την εργαλειοθήκη Draw (Εικόνα 10.52), για κείμενο σε διάφορες μορφές και διάφορους οδηγούς αναγραφής ή από το μενού Insert>Text (μόνο για κείμενο με οριζόντιο οδηγό αναγραφής).
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Εικόνα 10.52 Προσθήκη κειμένου στο ArcMap.
10.8.12 Προσθήκη δείκτη προσανατολισμού 
 
Η εισαγωγή του δείκτη προσανατολισμού γίνεται από το βασικό μενού Insert>North Arrow. Επιλέγεται από τα διαθέσιμα σύμβολα δεικτών του Βορρά, καθορίζεται η απόχρωση και το μέγεθός του και τοποθετείται (ή μετακινείται) στην επιθυμητή θέση με τον δείκτη του ποντικιού.
 
 
 
 
10.8.13 Απόδοση δεδομένων Ψηφιακού Μοντέλου Εδάφους (ΨΜΕ)
 
Τα δεδομένα του κανονικοποιημένου αρχείου αποδίδονται ως συνεχή, με τη χρήση μιας διαβαθμισμένης χρωματικής κλίμακας (graduated color ramp). Η μέθοδος αυτή ορίζεται από την καρτέλα Symbology του raster αρχείου: Properties>Symbology>Stretched (Εικόνα 10.53).
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Εικόνα 10.53 Απόδοση δεδομένων DTM με τη μέθοδο Stretched στο ArcMap.
Η επιλογή της χρωματικής παλέτας γίνεται από τη λίστα Color Ramp. H αλλαγή κάποιας από τις υφιστάμενες ή προσθήκη νέας, γίνεται δεξί κλικ & Properties επάνω στη συγκεκριμένη color ramp (βλ. και §10.8.2.2). 
10.8.13.1 Απόδοση υψομετρικών ζωνών
 
Τα δεδομένα του raster αρχείου αποδίδονται χωρισμένα σε κλάσεις είτε με τη χρήση διαβαθμισμένης χρωματικής κλίμακας (graduated color ramp) είτε με μεμονωμένα χρώματα. Η μέθοδος αυτή ορίζεται από την καρτέλα Symbology του raster αρχείου Properties>Symbology>Classified (Εικόνα 10.54). Η κατηγοριοποίηση των δεδομένων γίνεται με το πλήκτρο Classify, το οποίο αναδύει το σχετικό μενού μέσω του οποίου ορίζονται η μέθοδος και το πλήθος ή το εύρος των κλάσεων. Η επιλογή της χρωματικής παλέτας γίνεται από τη λίστα Color Ramp. H αλλαγή κάποιας από τις υφιστάμενες ή προσθήκη νέας, γίνεται με δεξί κλικ & Properties επάνω στη συγκεκριμένη color ramp. Η αποθήκευση μιας νέας ή μιας διορθωμένης χρωματικής παλέτας γίνεται με δεξί κλικ & Save (βλ. §10.8.2.2).
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Εικόνα 10.54 Απόδοση δεδομένων DTM με υψομετρικές ζώνες στο ArcMap.
Πολύ συχνά, η απόδοση των δεδομένων του DTM, συνδυάζεται με την απόδοση φωτοσκιασμένου αναγλύφου οπότε:
 
	Oρίζεται διαφάνεια στον συμβολισμό του DTM μέσω της καρτέλας Properties>Display>Transparency.
	Oρίζεται, στη σειρά σχεδίασης στον Πίνακα Περιεχομένων του dataframe, να βρίσκεται ψηλότερα από το layer του φωτοσκιασμένου αναγλύφου.

10.8.13.2 Απόδοση φωτοσκιασμένου αναγλύφου
 
Η απόδοση του φωτοσκιασμένου αναγλύφου (hillshade) γίνεται με τη μέθοδο Stretched. 
Properties>Symbology>Stretched (βλ. §10.8.13.1).
10.8.14 Αποθήκευση της χαρτοσύνθεσης
 
Η αποθήκευση της χαρτοσύνθεσης γίνεται από το βασικό μενού File>Save (βλ. και Παράρτημα Β §Β5.13. Για την αποδέσμευση από την ονομασία των drives του τρέχοντος pathname, ορίζεται από το μενού File>Map Document Properties>Pathnames>Stοre relative pathnames to data sources (Εικόνα 10.55).
10.8.15 Εκτύπωση χαρτοσύνθεσης
 
Η εκτύπωση της χαρτοσύνθεσης γίνεται από το βασικό μενού File>Print. Αν δεν έχουν οριστεί σε προηγούμενα στάδια της εργασίας, από το μενού File>Page Setup, ορίζεται ο εκτυπωτής, το μέγεθος της σελίδας και ο προσανατολισμός της σελίδας (κατακόρυφος – portrait / οριζόντιος – landscape) (βλ. Παράρτημα Β§Β.5.14). Για τη δημιουργία αρχείου PDF, ως εκτυπωτής ορίζεται Adobe PDF ή ακολουθείται η διαδικασία που περιγράφεται στην §10.8.16, επιλέγοντας ως τύπο αρχείου PDF.
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Εικόνα 10.55 Ρυθμίσεις για την αποθήκευση της χαρτοσύνθεσης στο ArcMap.
10.8.16 Εξαγωγή χαρτοσύνθεσης σε format εικόνας
 
Η εξαγωγή της χαρτοσύνθεσης σε format εικόνας γίνεται από το βασικό μενού File>Export Map. Επιλέγεται ο μορφότυπος του αρχείου, καθώς και τα χαρακτηριστικά του, τα οποία εξαρτώνται από το είδος του.
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Κριτήρια αξιολόγησης
Κριτήριο αξιολόγησης 1 
Ποιοι είναι οι παράγοντες που καθιστούν αποτελεσματική τη χαρτογραφική σύνθεση;
Κριτήριο αξιολόγησης 2 
Ποια χαρακτηριστικά θεωρούνται στοιχεία της χαρτογραφικής σχεδίασης;
 
Κριτήριο αξιολόγησης 3 
Ποια χαρτογραφικά στοιχεία είναι κοινά στους περισσότερους χάρτες;
Κριτήριο αξιολόγησης 4
Ποια είναι τα στάδια που ακολουθούνται για την υλοποίηση του χαρτογραφικού συμβολισμού;
Κριτήριο αξιολόγησης 5 
Σε τι συνίστανται η ανάλυση και η ταξινόμηση των γεωγραφικών φαινομένων που χαρτογραφούνται;
 
Κριτήριο αξιολόγησης 6 
Ποιες είναι οι κύριες οπτικές μεταβλητές και πώς αξιοποιούνται στον χαρτογραφικό συμβολισμό;
 
Κριτήριο αξιολόγησης 7 
Ποια χρωματικά σχήματα γνωρίζετε και ποια η χρήση τους στον συμβολισμό των χωρικών δεδομένων; 
Κριτήριο αξιολόγησης 8 
Ποιος είναι ο ρόλος της ονοματολογίας στους χάρτες;
Κεφάλαιο 11 
Δημιουργία υλικού αναπαραγωγής σε ψηφιακό περιβάλλον
 
Σύνοψη 
Στο κεφάλαιο αυτό, περιγράφεται  η διαδικασία δημιουργίας του υλικού αναπαραγωγής  χάρτη ο οποίος έχει συντεθεί με ψηφιακές μεθόδους και πρόκειται να αναπαραχθεί σε πολλά αντίτυπα με τη διαδικασία offset. Καθώς πρόκειται για το ενδιάμεσο στάδιο μεταξύ της παραγωγής (σύνθεσης) και αναπαραγωγής του χάρτη, παρουσιάζεται το αντικείμενο της διαχείρισης του χρώματος για τα ψηφιακά προϊόντα, τα οποία πρόκειται να διατεθούν είτε σε ψηφιακή είτε σε αναλογική (έντυπη) μορφή. Τέλος, παρουσιάζονται τα χαρακτηριστικά και η διαδικασία δημιουργίας των αρχείων της τετραχρωμίας (CMYK) που απαιτείται για την κατασκευή των πλακών εκτύπωσης σε offset.
 
Προαπαιτούμενη γνώση 
Θεωρία του χρώματος, χρωματικά μοντέλα (συστήματα), χρωματικοί χώροι.
 
11. Η αναπαραγωγή του χάρτη
 
Η ολοκλήρωση της ψηφιακής σύνθεσης του χάρτη, έχει αποτέλεσμα τη δημιουργία του ψηφιακού πρωτοτύπου του χάρτη. Αυτό αποτελεί το προτελευταίο στάδιο της χαρτογραφικής διαδικασίας, πριν την αναπαραγωγή για τη διάθεσή του. Με τα σύγχρονα ψηφιακά μέσα σύνθεσης του χάρτη, είναι εφικτή –τόσο τεχνικά όσο και οικονομικά– η παραγωγή μικρού αριθμού  αντιτύπων, ακόμη και ενός μοναδικού, το οποίο μάλιστα μπορεί να έχει είτε αναλογική (έντυπη) είτε ψηφιακή μορφή (αρχείο εικόνας). Σε κάθε περίπτωση, αυτό που απαιτείται είναι η πιστότητα των αντιτύπων σε σχέση με το πρωτότυπο, τόσο για ό,τι αφορά τη γεωμετρική ακρίβεια, όσο και για ό,τι αφορά την ευκρίνεια των συμβόλων και κυρίως την πιστότητα των χρωμάτων. Είναι καθοριστικό να  είναι εκ των προτέρων γνωστός ο τρόπος διάδοσης του χάρτη έτσι ώστε, κατά τη σύνθεσή του, να ληφθούν υπόψη τα τεχνικά και οικονομικά χαρακτηριστικά της μεθόδου αναπαραγωγής (Εικόνα 11.1). Τα τεχνικά χαρακτηριστικά της μεθόδου αναπαραγωγής είναι τέτοια που μπορεί να επηρεάσουν –αν όχι να καθορίσουν– τις διαδικασίες και πρακτικές σύνθεσης του χάρτη, αλλά και την παραγωγή του πρωτοτύπου. Για τον λόγο αυτό, η εξέλιξη της Χαρτογραφίας συνδέθηκε ιστορικά με την εξέλιξη των μεθόδων αναπαραγωγής των χαρτών και, κυρίως, με την τυπογραφία. Η μέθοδος αναπαραγωγής και η προσδοκώμενη ποιότητα του τελικού προϊόντος προσδιορίζει –εμμέσως πλην σαφώς– και τη διαδικασία προετοιμασίας του υλικού για την παραγωγή του χάρτη. Η διαδικασία συνίσταται στον μετασχηματισμό της εικόνας από μια μορφή υλικού σε άλλη. Εφόσον απαιτείται η δημιουργία μεγάλου αριθμού εκτυπωμένων αντιτύπων, πρέπει να επιλεγεί μια μέθοδος αναπαραγωγής με κριτήρια που σχετίζονται όχι μόνο με την ακρίβεια και πιστότητα σε σχέση με το πρωτότυπο, αλλά και με οικονομικούς παράγοντες που καθιστούν συμφέρουσα τη διάδοση του χάρτη (Robinson, Morrison, Muehrcke, Kimerling & Guptill, 1995). 
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Εικόνα 11.1 Η μετάβαση από την σύνταξη στην αναπαραγωγή του χάρτη.
Με βάση το κόστος ανά μονάδα ανάλογα με τον αριθμό των αντιτύπων, οι μέθοδοι αναπαραγωγής του έντυπου χάρτη διακρίνονται σε μεθόδους για λίγα αντίτυπα και σε μεθόδους για πολλά αντίτυπα. Το γεγονός ότι η ψηφιακή προσέγγιση της χαρτογραφίας έχει επικρατήσει σχεδόν καθολικά, επηρεάζει δραστικά τη σύνθεση, την παραγωγή και την αναπαραγωγή του χάρτη. Εκτός από το ψηφιακό πρωτότυπο του χάρτη, ένα σύνολο συσκευών εξόδου γραφικών παράγει υλικά αντίτυπα χαρτών σε εκτυπωτές ή σχεδιαστές, ενώ άλλες συσκευές (π.χ. οθόνες) παράγουν εφήμερα αντίγραφα προσδιορίζοντας παράλληλα και μια διαφορετική προσέγγιση χαρτοσύνθεσης που αφορά στη σύνθεση και σύνταξη του χάρτη. Θα πρέπει να σημειωθεί, ότι στα συστήματα εκτύπωσης έχουν επικρατήσει τα συστήματα τεχνολογίας raster τα οποία εκτυπώνουν την εικόνα ως σειρές από μικρές κουκίδες- εικονοστοιχεία (dots), ανεξάρτητα από το αν το περιεχόμενό της αφορά σε διανυσματικά ή κανονικοποιημένα δεδομένα.
Υπάρχουν δύο ομάδες συσκευών οι οποίες διαφέρουν ως προς την παραγωγή του χρώματος, ως εξής:
  
	Οι συσκευές οι οποίες χρησιμοποιούν χρωστικές (μελάνια, toners) κι επομένως υλοποιούν το χρώμα σύμφωνα με το σύστημα CMYK. 
	Οι συσκευές οι οποίες χρησιμοποιούν την ηλεκτρομαγνητική ακτινοβολία, δηλαδή το φως, οπότε υλοποιούν το χρώμα σύμφωνα με το σύστημα RGB.

 
Το σύνολο των χρωμάτων τα οποία μπορούν να παραχθούν στο πλαίσιο κάθε χρωματικού μοντέλου (συστήματος) είναι συγκεκριμένο και καλύπτει ένα υποσύνολο των χρωμάτων που αντιλαμβάνεται ο άνθρωπος, τα οποία περιγράφονται με το σύστημα CIE. Τα υποσύνολα αυτά διαφέρουν μεταξύ τους, όχι μόνο από χρωματικό μοντέλο σε χρωματικό μοντέλο, δηλαδή από το RGB (οθόνη, σαρωτής κλπ.) στο CMYK (εκτυπωτής κλπ.) αλλά και από συσκευή σε συσκευή της ίδιας κατηγορίας (π.χ. οθόνη – σαρωτής ή από τη μία οθόνη στην άλλη). Αυτό οφείλεται, τόσο στα ιδιαίτερα φυσικά χαρακτηριστικά των χρωστικών και του φωτός, όσο και στα τεχνικά χαρακτηριστικά των συσκευών αυτών καθαυτών, ζητήματα τα οποία δεν αποτελούν αντικείμενο του παρόντος κεφαλαίου. Από τις διαφοροποιήσεις αυτές, προκύπτει η ανάγκη να γνωρίζει ο χαρτοσυνθέτης πώς θα φαίνονται τα χρώματα στο τελικό μέσο απόδοσης του χάρτη κι επομένως, πώς θα ορίσει τα χρώματα των συμβόλων του χάρτη στο ψηφιακό πρωτότυπο. Για τον λόγο αυτό, τόσο η διαχείριση του χρώματος, όσο και ο χρωματικός διαχωρισμός διαδραματίζουν σημαντικό ρόλο και περιγράφονται στις ακόλουθες ενότητες (Τσούλος, Αντωνίου, Σκοπελίτη & Στάμου, 2015).
11.1 Η διαχείριση του χρώματος
 
Η διαχείριση του χρώματος αφορά στον προσδιορισμό των σχέσεων των χρωμάτων σε διάφορες ψηφιακές συσκευές όπως οθόνες Η/Υ, ψηφιακές φωτογραφικές μηχανές, σαρωτές, προβολείς, εκτυπωτές, αυτόματοι σχεδιαστές κλπ. Η ακριβής επισκόπηση του χρώματος είναι καθοριστική για τη λήψη αποφάσεων, κατά τη ροή εργασιών από την ψηφιακή συλλογή δεδομένων μέχρι την τελική απόδοση του χάρτη. Επιτρέπει μάλιστα, την παραγωγή προϊόντων σύμφωνα με συγκεκριμένα πρότυπα (ISO, SWOP, Japan Color Print κλπ.) κυρίως για την περίπτωση της ανταλλαγής ψηφιακών εικόνων (Color Management, χ.η). 
Η χρωματική δυνατότητα (γκάμα χρωμάτων - color gamut) κάθε συσκευής εισόδου ή εξόδου, διαφέρει τόσο μεταξύ των συσκευών όσο και σε σχέση με το εύρος των χρωμάτων τα οποία γίνονται αντιληπτά από τον άνθρωπο. Σε συνδυασμό με τους διαφορετικούς χρωματικούς χώρους που χρησιμοποιούνται, τα χρώματα τα οποία αποδίδονται είτε κατά την ανταλλαγή αρχείων είτε κατά τη ροή εργασιών, παρουσιάζουν διαφορές στην εμφάνιση, δηλαδή στον τρόπο που γίνονται αντιληπτά. Η διαχείριση χρώματος γίνεται στο πλαίσιο εφαρμογών λογισμικού επεξεργασίας εικόνας και εν μέρει περιλαμβάνεται στο λειτουργικό σύστημα, με κάποια προεγκατεστημένα αρχεία γενικής χρήσης. Κατά τη διαχείριση του χρώματος και προκειμένου να επιτευχθεί η (κατά το δυνατόν)  πιστή απόδοση του χρώματος μεταξύ των συσκευών:
  
	Συγκρίνεται ο χρωματικός χώρος στον οποίο δημιουργήθηκε μια έγχρωμη εικόνα με το χώρο στον οποίο αποδίδεται.
	Επιφέρονται οι απαραίτητες ρυθμίσεις (μετατροπές).

 
Η μετατροπή του χρώματος γίνεται μέσω των χρωματικών προφίλ (color profiles) και της μεθόδου απεικόνισης/συμπίεσης (rendering intent). Τα χρωματικά προφίλ, συνιστούν τη μαθηματική περιγραφή του χρώματος (με τη μορφή συντεταγμένων, π.χ. Adobe: ICC profiles) σε μια συσκευή εισόδου ή εξόδου. Κατά τη διαχείριση του χρώματος, ο χρωματικός χώρος της συσκευής εισόδου μετατρέπεται σε έναν ενδιάμεσο χρωματικό χώρο CIELAB (L*a*b*) ο οποίος λειτουργεί ως γενικός (καθολικός) μεταφραστής του χρώματος (universal color translator) και από εκεί μεταπίπτει στον χρωματικό χώρο της συσκευής (Εικόνα 11.2).
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Εικόνα 11.2 Η μετάβαση του χρώματος από τις συσκευές εισόδου στις συσκευές εξόδου.
Η μέθοδος απεικόνισης αφορά στη διαχείριση των διαφορών που προκύπτουν κατά τη μετάπτωση από έναν μεγαλύτερο σε έναν μικρότερο χρωματικό χώρο ή γενικότερα από έναν χρωματικό χώρο σε κάποιον άλλο. Οι μέθοδοι απεικόνισης είναι τέσσερις (“Color Management”, χ.η.):
 
	Αντιληπτική (perceptual), η οποία διατηρεί τις σχέσεις και τις διαφορές μεταξύ των χρωμάτων.
	Σχετική χρωματομετρική (relative colorimetric), η οποία διατηρεί σταθερά όσα χρώματα βρίσκονται μέσα στο χρωματικό εύρος της συσκευής εξόδου και εκείνα που βρίσκονται εκτός, τα τοποθετεί στο όριο του χρωματικού εύρους της τελικής συσκευής. Στο πλαίσιο της μεθόδου πραγματοποιείται και μετακίνηση του λευκού και του μαύρου σημείου.
	Απόλυτη χρωματομετρική (absolute colorimetric), η οποία διατηρεί σταθερά όσα χρώματα βρίσκονται μέσα στο χρωματικό εύρος της συσκευής εξόδου και εκείνα που βρίσκονται εκτός, τα τοποθετεί στο όριο του χρωματικού εύρους της τελικής συσκευής. Εδώ διατηρείται σταθερό το λευκό σημείο.
	Μέθοδος κορεσμού (saturation) - διατηρεί τη ζωηρότητα των χρωμάτων υψηλού κορεσμού, σε βάρος της ακρίβειας της απόχρωσης και της φωτεινότητας.

 
Η διαχείριση του χρώματος γίνεται για όλες τις συσκευές  εισόδου – εξόδου, οι οποίες συμμετέχουν στη χαρτογραφική διαδικασία και για το σκοπό αυτό απαιτείται η δημιουργία ή η εγκατάσταση των αντίστοιχων χρωματικών προφίλ:
 
	Προφίλ για οθόνες Η/Υ.
	Προφίλ για συσκευές εισόδου .
	Προφίλ για συσκευές εξόδου/εκτύπωσης.
	Προφίλ για αρχεία (εικόνες).

11.1.1 Η διαχείριση του χρώματος στις οθόνες Η/Υ
 
Τα προφίλ των οθονών πρέπει να ελέγχονται σε τακτά χρονικά διαστήματα και να δημιουργούνται διαφορετικά αρχεία για διαφορετικές συνθήκες εργασίας (π.χ. περιβάλλοντος φωτισμού). Είναι τα πρώτα που δημιουργούνται μετά τη ρύθμιση (calibration) των οθονών για:
 
	Τη φωτεινότητα και αντίθεση. 
	Τη διόρθωση γ (γ correction - η τιμή της καμπύλης λευκού-μαύρου στο μεσαίο σημείο της). 
	Το λευκό σημείο.
	Το είδος των σωματιδίων του φωσφόρου. 

 
Η εγκατάσταση του χρωματικού προφίλ μπορεί να γίνει με:
 
	Επιλογή από τον κατασκευαστή.
	Δημιουργία νέου χρωματικού προφίλ, με ειδικό εξοπλισμό.
	Εγκατάσταση ή αντιγραφή στο σύστημα (π.χ. Windows). 

11.1.2 Η διαχείριση του χρώματος στους εκτυπωτές
 
Η δημιουργία χρωματικού προφίλ για τους εκτυπωτές, απαιτεί ειδικό εξοπλισμό (φασματοφωτόμετρο) και λογισμικό (profile maker). Επειδή η απόδοση του χρώματος επηρεάζεται τόσο από το μελάνι, όσο και από την επίστρωση, το χρώμα και το βάρος του χαρτιού, για κάθε εκτυπωτή πρέπει να δημιουργείται διαφορετικό χρωματικό προφίλ για κάθε συνδυασμό μελανιού-χαρτιού. Οι περισσότεροι εκτυπωτές συνοδεύονται από ενσωματωμένα χρωματικά προφίλ αλλά, εφόσον υπάρχει ο σχετικός ειδικός εξοπλισμός, καλό είναι να δημιουργούνται τα αντίστοιχα εξειδικευμένα. Αρχικά, η διαδικασία περιλαμβάνει την εκτύπωση του σχετικού χρωματικού πίνακα δοκιμής (test color chart) (Εικόνα 11.3) με τις επιλογές που δίνει ένα λογισμικό διαχείρισης εικόνων (π.χ. Adobe Photoshop):
 
	Κατά το άνοιγμα του αρχείου ορίζεται “Leave as Is (Don’t Color Manage)”.
	Κατά την εκτύπωση ορίζεται η μη διαχείριση του χρώματος (No Color Management).
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Εικόνα 11.3 Xρωματικός πίνακας δοκιμής (test color chart).
Αυτός ο εκτυπωμένος χρωματικός πίνακας δοκιμής, θεωρείται ως «η σελίδα αναφοράς». Στη συνέχεια, γίνεται η «μέτρηση» της σελίδας αναφοράς με το φασματοφωτόμετρο και η αποθήκευση της μέτρησης σε αρχείο με όνομα που καλό είναι να είναι ενδεικτικό τόσο του εκτυπωτή, όσο και του χαρτιού που χρησιμοποιήθηκε. Για τα CMYK αρχεία, ορίζονται τα χαρακτηριστικά του χρωματικού διαχωρισμού (Separation) (βλ. κατωτέρω §11.2), διατηρώντας τις προκαθορισμένες ρυθμίσεις του Profile Maker. Με τον χρωματικό διαχωρισμό, καθορίζονται η διόρθωση γ  (με την προσαρμογή της καμπύλης) και η σύνθεση του μαύρου σημείου (Neutralize). Ο υπολογισμός του profile έχει ως αποτέλεσμα τη δημιουργία ενός αρχείου .icc, το οποίο θα πρέπει να αποθηκευτεί στις ρυθμίσεις του εκτυπωτή (π.χ. για τα Windows Control Panel>Printers) και, αν είναι επιθυμητό, να οριστεί ως πρoεπιλεγμένο ώστε όλες οι εκτυπώσεις να γίνονται με αυτό. Για τη βελτίωση του αποτελέσματος η διαδικασία θα πρέπει να επαναληφθεί από την αρχή:
  
	Με την εκτύπωση του αρχείου (δηλαδή της σελίδας αναφοράς) με την επιλογή αφενός μεν το λογισμικό να διαχειριστεί το χρώμα (π.χ. Photoshop Manages Color), αφετέρου δε να οριστεί η μέθοδος συμπίεσης χρώματος.
	Με τη «μέτρηση» της νέας σελίδας αναφοράς. 
	Με άλλο εργαλείο του λογισμικού (π.χ. X-Rite>Measure Tool>Comparing) γίνεται η σύγκριση (πρότυπο Delta E 2000) με το αρχικό αρχείο, προσδιορίζονται οι αποκλίσεις τόσο οπτικά (κίτρινα φατνία) όσο και αριθμητικά, ανάλογα με τις προδιαγραφές (Εικόνα 11.4).
	Επανάληψη της διαδικασίας  για τη βελτίωση του χρωματικού προφίλ.
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Εικόνα 11.4 Φατνία χρωματικής απόκλισης.
11.1.3 Η διαχείριση του χρώματος σε αρχεία εικόνων
 
Για κάθε αρχείο εικόνας, ο προσδιορισμός του χρωματικού προφίλ καθορίζει το πώς θα εμφανίζεται το χρώμα σε αυτό. Οι αριθμητικές χρωματικές συντεταγμένες δεν έχουν νόημα χωρίς τη συσχέτισή τους με έναν χρωματικό χώρο, καθώς –χωρίς αυτόν– εμφανίζονται διαφορετικά σε κάθε συσκευή. Όταν όμως αυτές προσδιορίζονται σε έναν συγκεκριμένο χρωματικό χώρο προσδιορίζουν ένα συγκεκριμένο χρώμα. Δηλαδή, οι τιμές των χρωματικών συντεταγμένων αναφέρονται σε ένα χρωματικό μοντέλο, ενώ το χρώμα καθαυτό αναφέρεται σε έναν χρωματικό χώρο. Σε ένα τυπικό περιβάλλον λογισμικού επεξεργασίας εικόνας (π.χ. Adobe Photoshop) και εφόσον έχει ενεργοποιηθεί η διαχείριση χρώματος, η εφαρμογή θα προσδίδει σε κάθε νέο αρχείο που δημιουργείται το χρωματικό προφίλ του ενεργού χρωματικού χώρου. Οι χρωματικοί χώροι που διατίθενται για τα αρχεία εικόνων είναι:
 
	Ο χώρος sRGB περιλαμβάνει τα χρώματα τα οποία μπορούν να τυπωθούν και δίνει τη δυνατότητα στον χρήστη να βλέπει ό,τι μπορεί να τυπωθεί. Είναι προϊόν της εταιρίας Hewlett Packard (HP) και είναι ενσωματωμένος στους οδηγούς PCL drivers των εκτυπωτών τύπου laser, στους εκτυπωτές ψεκασμού μελάνης (inkjet) καθώς και σε εφαρμογές της εταιρίας Microsoft και στο Διαδίκτυο (Internet).
	Ο χώρος CMYK αφορά εκτυπωτές με RIP (Raster Image Processor), εκτυπωτές με οδηγούς PS drivers, καθώς και εκτυπωτικές μηχανές τύπου offset (§11.2).
	Ο χώρος Grey που περιγράφει το χρώμα ως κουκίδες (dot grain), ο οποίος για τους εκτυπωτές τεχνολογίας inkjet ορίζει ποσοστό πυκνότητας των κουκίδων ίσο με 20%, ενώ για τους εκτυπωτές τύπου laser είναι 7-8%.
	Ο χώρος Spot αφορά σε ατόφια μελάνια που χρησιμοποιούνται στην εκτύπωση με πλακάτα χρώματα (§11.2).

 
Οι επιλογές της  πολιτικής διαχείρισης του χρώματος για κάποιο αρχείο είναι οι ακόλουθες:
  
	Εκχώρηση χρωματικού προφίλ (Assign profile), κατά την οποία οι τιμές των RGB συντεταγμένων διατηρούνται σταθερές, ενώ οι τιμές των συντεταγμένων Lab αλλάζουν.
	Διατήρηση χρώματος κατά τη μεταφορά: κατάσταση (mode) Lab color.
	Μετατροπή χρωματικού προφίλ (Convert to profile) στον χρωματικό χώρο της συσκευής προορισμού, οπότε ενώ αλλάζουν οι τιμές των συντεταγμένων RGB, δεν αλλάζει η οπτική εντύπωση και οι συντεταγμένες Lab.
	Αφαίρεση χρωματικού προφίλ.
	Ενσωμάτωση χρωματικού προφίλ, που γίνεται κατά την αποθήκευση του αρχείου ή κατά την εξαγωγή του (export) σε format που υποστηρίζει ICC profiles.

 
Κατά το άνοιγμα του αρχείου, η προκαθορισμένη επιλογή είναι η αυτόματη απόδοση σε αυτό του χρωματικού προφίλ που έχει οριστεί στις Ρυθμίσεις Χρώματος (Color Settings) και αφορούν τόσο στον χρωματικό χώρο εργασίας (Working Spaces) όσο και στην πολιτική διαχείρισης χρώματος (Color Management Policies).
 
	Κατά την εισαγωγή αρχείου χωρίς χρωματικό προφίλ, το χρώμα ρυθμίζεται από το ίδιο το αρχείο.
	Κατά την εισαγωγή αρχείου με ενσωματωμένο χρωματικό προφίλ, χρησιμοποιούνται οι τρέχουσες ρυθμίσεις (Color settings).

 
 
Η ενσωμάτωση χρωματικού προφίλ απαιτείται όταν το αρχείο προετοιμάζεται για μια διαφορετική συσκευή εξόδου ή όταν απαιτείται η βελτίωση της προεπιλεγμένης πολιτικής. Η αλλαγή χρωματικού προφίλ αφορά είτε την εφαρμογή νέου, είτε την αφαίρεση του ενσωματωμένου, είτε τη μετατροπή του.
11.1.4 Διαχείριση χρώματος κατά την εκτύπωση
11.1.4.1 Εκτύπωση με διαχείριση χρώματος
 
Όταν επιλεγεί να γίνει εκτύπωση με διαχείριση χρώματος, υπάρχουν δύο δυνατότητες. Στην πρώτη, ο εκτυπωτής καθορίζει το χρώμα. Τότε γίνεται η ελάχιστη μετατροπή χρώματος για τη μετάβαση στον χρωματικό χώρο του εκτυπωτή. Π.χ. για εκτύπωση CMYK αρχείου σε εκτυπωτή τεχνολογίας inkjet, η εφαρμογή το μετατρέπει σε RGB ή Lab, ανάλογα με τον εκτυπωτή. Χρησιμοποιείται κυρίως για εκτύπωση σε ειδικά χαρτιά, οπότε και χρησιμοποιούνται εξειδικευμένα χρωματικά προφίλ. Η ενεργοποίηση της διαχείρισης χρώματος γίνεται στον οδηγό (driver) του εκτυπωτή. Η δεύτερη δυνατότητα είναι η εφαρμογή (π.χ. Photoshop) να καθορίσει το χρώμα. Το λογισμικό επιφέρει όλες τις μετατροπές για τη δημιουργία του χρώματος για τη συγκεκριμένη συσκευή εξόδου, δηλαδή γίνεται προσαρμογή στη χρωματική γκάμα της συσκευής. Συνιστάται όταν διατίθενται ICC profiles για κάθε συνδυασμό  εκτυπωτή–μελανιού–χαρτιού.
11.1.4.2 Εκτύπωση χωρίς διαχείριση χρώματος
 
Η εκτύπωση χωρίς διαχείριση χρώματος γίνεται είτε για τη δημιουργία χρωματικού προφίλ είτε για εκτύπωση των δοκιμαστικών (test targets). Στην περίπτωση αυτή γίνεται απενεργοποίηση της επιλογής στον οδηγό (driver) του εκτυπωτή.
11.2 Ο χρωματικός διαχωρισμός
 
Από το σύνολο των μεθόδων αναπαραγωγής πολλών αντιγράφων, εκείνη που επικράτησε είναι η μέθοδος της φωτο-λιθογραφίας (offset) που αποτελεί την εξέλιξη της επιπεδογραφικής εκτύπωσης (λιθογραφίας) που εφευρέθηκε το 1798 (Robinson et al., 1995). Η επικράτησή της οφείλεται στα υψηλής ποιότητας –και παράλληλα– οικονομικά προϊόντα που παράγονται, ενδείκνυται, δε, τόσο για μονόχρωμες, όσο και για έγχρωμες εκτυπώσεις. Και στις δύο περιπτώσεις ακολουθείται η ίδια διαδικασία, αλλά για τις εκτυπώσεις πολλαπλών χρωμάτων είναι επαναλαμβανόμενη για κάθε χρώμα μελανιού. Έτσι, αρχικά γίνεται επεξεργασία του πρωτοτύπου ώστε να αποκτήσει μορφή μετάδοσης (film). Στη συνέχεια, η σχεδιαστική εργασία μεταφέρεται, μέσω ενός φωτογραφικού πλαισίου (βολταϊκό τόξο ή laser) στην εκτυπωτική πλάκα η οποία είναι ένα φύλλο αλουμινίου (που ονομάζεται «τσίγκος»). Στη μία του πλευρά, ο τσίγκος έχει επίστρωση από φωτοευαίσθητο –στο ορατό εύρος του φάσματος–  ειδικό υλικό ανοικτού γκρίζου χρώματος και επιτρέπει την εκτύπωση με ανάλυση 250 lpi (lines per inch). Στο στάδιο αυτό, όπου υπάρχει σχεδιαστική εργασία φωτίζεται, ενώ οι κενές περιοχές όχι. Ακολούθως, γίνεται η εμφάνιση του τσίγκου με εμβάπτιση σε διάλυμα υγρού εμφάνισης και νερού (1:4) το οποίο επικάθεται σε ό,τι έχει φωτιστεί και αποκτά χρώμα μπλε, ενώ οι κενές περιοχές παραμένουν γκρι. Μετά από κάποιες απαραίτητες ενδιάμεσες εργασίες (retouche, πλύσιμο και καθαρισμός), γίνεται η τοποθέτηση των πλακών στο πιεστήριο. Η αρχή υλοποίησης της εκτυπωτικής διαδικασίας, στηρίζεται στην αμοιβαία άπωση των λιπαρών ουσιών και του νερού.
Για τη σύνταξη του χάρτη, το κρίσιμο στοιχείο είναι η διαδικασία που ακολουθείται κατά τη λιθογραφική εκτύπωση για ό,τι αφορά την παραγωγή του χρώματος. Υπάρχουν δύο εναλλακτικές διαδικασίες και η επιλογή της κατάλληλης εξαρτάται από το πλήθος των χρωμάτων που περιέχει η εικόνα (ο χάρτης):
 
	Η εκτύπωση πλακάτων χρωμάτων, η οποία περιλαμβάνει τη δημιουργία μιας εκτυπωτικής πλάκας για κάθε χρώμα που περιέχεται στην εικόνα.
	Η εκτύπωση χρωμάτων διαχωρισμού, η οποία περιλαμβάνει τέσσερις εκτυπωτικές πλάκες, μία για κάθε ένα από τα αφαιρετικά κύρια χρώματα.

 
Η εκτύπωση χρωμάτων διαχωρισμού, γνωστή και ως εκτύπωση τετραχρωμίας, στηρίζεται στο γεγονός ότι όλοι σχεδόν οι χρωματικοί συνδυασμοί προκύπτουν από διάφορες μίξεις των αφαιρετικών κυρίων χρωμάτων: κυανό, ματζέντα, κίτρινο. Για την εκτύπωση τετραχρωμίας, στα κύρια αφαιρετικά χρώματα έχει προστεθεί και το μαύρο, τόσο για την απόδοση του μαύρου χρώματος με πιο οικονομικό τρόπο –για να εξοικονομούνται τα υπόλοιπα τρία χρώματα– όσο και για την πρόσδοση χρωματικής δύναμης στο σύνολο της εικόνας. Έτσι, έχει προκύψει το χρωματικό σύστημα CMYK (Cyan, Magenta, Yellow, blacK), το οποίο με βάση τις ιδιότητες των χρωστικών ουσιών, δηλαδή των μελανιών,  περιγράφει την παραγωγή των χρωμάτων από το κυανό (Cyan), το ματζέντα (Μagenta) και το κίτρινο (Yellow). H ανάμιξη των μελανιών δεν μπορεί να παράξει το λευκό χρώμα, που υλοποιείται από το χαρτί. Στο σύστημα αυτό, το χρώμα περιγράφεται με τέσσερις διαστάσεις (συνιστώσες): C-M-Y-K (Cyan-Magenta-YellowBlack) οι οποίες παίρνουν τιμές από 0 μέχρι 100. Χαρακτηριστικά παραδείγματα είναι τα ακόλουθα:
 
	Μαύρο: 0-0-0-100
	Λευκό: 0-0-0-0 δεν παράγεται
	Μεσαίο γκρι: 50-50-50-0
	Κίτρινο: 0-0-100-0
	Κυανό: 100-0-0-0
	Magenta: 0-100-0-0
	Κόκκινο: 0-100-100-0
	Πράσινο: 100-0-100-0
	Μπλε: 100-100-0-0

 
Η παραγωγή του χρώματος γίνεται με διαφάνειες τονικής διαβάθμισης (κουκίδες), οι οποίες πρέπει να τοποθετούνται υπό γωνία  30 μοιρών μεταξύ τους για να αποφεύγεται το φαινόμενο των «κροσσών moiré» (Εικόνα 11.5). Οι γωνίες τοποθέτησης για κάθε χρώμα είναι:
 
	Μαύρο 45 μοίρες,
	Ματζέντα 75 μοίρες,
	Κίτρινο 90 μοίρες,
	Κυανό 105 μοίρες.
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Εικόνα 11.5 Δημιουργία χρωμάτων με τετραχρωμία (πηγή εικόνας: ESRI )
Η παραγωγή του χρώματος στις οθόνες, βασίζεται στις ιδιότητες του φωτός και περιγράφεται από το χρωματικό σύστημα RGB (Red, Green, Blue). Είναι το σύστημα το οποίο στηρίζεται στην τριχρωματική θεωρία της έγχρωμης όρασης και βρίσκει εφαρμογή στην έγχρωμη τηλεόραση και στην έγχρωμη οθόνη, χρησιμοποιώντας τόσο την τεχνολογία της καθοδικής λυχνίας (CRT) όσο και την τεχνολογία «πλάσμα» ή υγρών κρυστάλλων. Στο σύστημα αυτό, το χρώμα περιγράφεται με τρεις διαστάσεις (συνιστώσες): R-G-B (Red–Green-Blue) οι οποίες παίρνουν τιμές από 0 μέχρι 255. Χαρακτηριστικά παραδείγματα είναι τα ακόλουθα:
 
	Μαύρο: 0-0-0
	Λευκό: 255-255-255
	Μεσαίο γκρι: 128-128-128
	Κόκκινο: 255-0-0
	Πράσινο: 0-255-0
	Μπλε: 0-0-255
	Κίτρινο: 255-255-0
	Κυανό:0-255-255
	Magenta: 255-255-0

 
Ο διαχωρισμός των χρωμάτων επιτυγχάνεται είτε μέσω φωτογράφισης του πρωτοτύπου με φίλτρα ή μέσω ηλεκτρονικής σάρωσης. Τα αρνητικά διαχωρισμού τα οποία προκύπτουν, καταγράφουν τα τρία προσθετικά χρώματα (RGB) του πρωτοτύπου ως ασπρόμαυρες πυκνότητες.
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Εικόνα 11.6 Χρωματικός διαχωρισμός χάρτη.
11.2.1 Ο χρωματικός διαχωρισμός με λογισμικό γραφιστικής επεξεργασίας
 
Στις σύγχρονες μονάδες χαρτογραφικής παραγωγής, ο χρωματικός διαχωρισμός γίνεται σε εξειδικευμένo περιβάλλον λογισμικού γραφιστικής επεξεργασίας. Για παράδειγμα, στο Adobe Photoshop ακολουθείται η εξής διαδικασία:
 
	Ορίζεται ως κατάσταση λειτουργίας Image>Mode>CMYK Color.
	Εκτελείται ο χρωματικός διαχωρισμός από την καρτέλα Channels>Split Channels.
	Δημιουργούνται 4 διαφορετικά αρχεία, τα οποία αποθηκεύονται σε μορφή tiff.

 
Στην Εικόνα 11.6 παρουσιάζονται τα αρχεία που προκύπτουν από τον χρωματικό διαχωρισμό ενός έγχρωμου χάρτη, διαδικασία που υλοποιήθηκε με το λογισμικό Adobe Photoshop CS5.
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Εικόνα 11.7 Οι ρυθμίσεις του χρωματικού διαχωρισμού στο ArcMap.
11.2.2 Ο χρωματικός διαχωρισμός στο ArcMap
 
Για έναν χάρτη ο οποίος έχει δημιουργηθεί σε περιβάλλον ArcMap, ο χρωματικός διαχωρισμός μπορεί να γίνει με δύο τρόπους. Ο πρώτος χρησιμοποιεί ένα ανεξάρτητο λογισμικό επεξεργασίας εικόνας όπως περιγράφεται ανωτέρω (§11.2.1), αφού προηγουμένως ο χάρτης έχει εξαχθεί σε format εικόνας (§10.8.16). Ο δεύτερος υλοποιείται στο ίδιο το ArcMap, στο πλαίσιο της λειτουργίας η οποία επιτρέπει την εξαγωγή της χαρτοσύνθεσης σε κάποιο άλλο format. Για την υλοποίησή του, απαιτείται η εγκατάσταση της επέκτασης Esri Production Mapping, όπου περιλαμβάνεται το λογισμικό Production PDF (“ArcGIS Help 10.2”, χ.η). Η δημιουργία των αρχείων του χρωματικού διαχωρισμού για μια χαρτοσύνθεση γίνεται στο ArcMap με το εργαλείο File>Export Map (§10.8.16) και μπορούν να επιλεγούν είτε η εξαγωγή σε μορφή Separated Tiff, είτε η εξαγωγή σε Production PDF, διαδικασία  η οποία παρουσιάζεται συνοπτικά στη συνέχεια. Στο παράθυρο του εργαλείου αυτού, καθώς και στην αλληλουχία των διαδοχικών εργαλείων που ενεργοποιούνται, συμπληρώνονται:
 
	Στο πεδίο Save as type: επιλέγεται Production PDF.
	Στην καρτέλα Production: επιλέγεται Map Colors που ενεργοποιεί το παράθυρο διαλόγου Color Mapping Rules.
	Στο παράθυρο Color Mapping Rules: επιλέγεται Color Separation Settings.
	Στο παράθυρο Separation Settings: με την επιλογή (check) Enable Separation ενεργοποιείται η διαδικασία του χρωματικού διαχωρισμού.

 
Οι ρυθμίσεις (Εικόνα 11.7Error! Reference source not found.) αφορούν το σχήμα των κουκίδων (Dot Shape), τον προσανατολισμό κάθε χρώματος (Angle) και την ανάλυση (Frequency) που δίνεται σε γραμμές ανά ίντσα (lpi – lines per inch). Στο συγκεκριμένο λογισμικό, η ανάλυση μπορεί να πάρει τρεις τιμές: 100, 175 ή 200. 
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Κριτήρια αξιολόγησης
 
Κριτήριο αξιολόγησης 1
Για ποιους λόγους  η εμφάνιση των χρωμάτων διαφέρει ανάμεσα σε διάφορες συσκευές εισόδου/εξόδου;
Κριτήριο αξιολόγησης 2
Τι είναι η διαχείριση του χρώματος και πού εφαρμόζεται;
 
Κριτήριο αξιολόγησης 3
Τι είναι οι μέθοδοι απεικόνισης του χρώματος μεταξύ χρωματικών χώρων;
 
Κριτήριο αξιολόγησης 4
Ποιες είναι οι διαθέσιμες μέθοδοι απεικόνισης κατά τη διαχείριση του χρώματος;
Κριτήριο αξιολόγησης 5
Ποιες είναι οι διαφορές ανάμεσα στα χρωματικά μοντέλα CMYK και RGB;
Κριτήριο αξιολόγησης 6
Πού βρίσκουν εφαρμογή τα χρωματικά μοντέλα CMYK και RGB;
Κεφάλαιο 12 
Δημοσιοποίηση χαρτών και χαρτογραφικών δεδομένων στο διαδίκτυο
Σύνοψη 
Στο κεφάλαιο αυτό παρουσιάζονται τα πρότυπα του Open Geospatial Consortium (OGC) για τη δημοσιοποίηση χαρτογραφικών δεδομένων και χαρτών στο διαδίκτυο, όπως το Web Map Service (WMS) και το Web Feature Service (WFS). Περιγράφεται η διαδικασία συγκρότησης ενός εξυπηρετητή δημοσιοποίησης χαρτογραφικών δεδομένων και χαρτών που ακολουθεί τα παραπάνω πρότυπα. Ακολουθεί η ανάλυση θεμάτων όπως η επιλογή του κατάλληλου προτύπου, η δημοσιοποίηση ενός χάρτη, η δημοσιοποίηση χαρτογραφικών δεδομένων, ο ορισμός των δυνατοτήτων παρέμβασης του χρήστη, η σύνδεση του εξυπηρετητή με τα θεματικά επίπεδα κ.ά. Τέλος, περιγράφεται η υλοποίηση των παραπάνω στο περιβάλλον ανοικτού λογισμικού Geoserver και στο ΣΓΠ ArcGIS.
 
Προαπαιτούμενη γνώση
Γενική γνώση για το διαδίκτυο και τα πρότυπα δημοσιοποίησης δεδομένων.
12. Χαρτογραφία και διαδίκτυο
 
Το διαδίκτυο ως το νέο μέσο για τη δημοσιοποίηση χαρτών, προκάλεσε στη χαρτογραφική επιστήμη παρόμοια επανάσταση με τη έλευση της τυπογραφίας (Black and Cartwright, 2005). Η εξέλιξη των διαδικτυακών χαρτών είναι στενά συνδεδεμένη με την τεχνολογική πρόοδο της ψηφιακής χαρτογραφίας και του διαδικτύου. Ο στατικός χάρτης σύντομα αντικαταστάθηκε από τον διαδραστικό χάρτη που διαθέτει μεγαλύτερη πολυπλοκότητα, προσφέρει συμμετοχή του χρήστη, περισσότερα εργαλεία π.χ. πλοήγηση, αλλαγή κλίμακας, επιλογή θεματικών επιπέδων κ.ά. (Köbben, 2001). Σήμερα στο διαδίκτυο λειτουργούν πολλές υπηρεσίες θέασης και επεξεργασίας γεωγραφικών δεδομένων και χαρτών. Μια τέτοια υπηρεσία μπορεί να λειτουργεί υπό την αιγίδα ενός εθνικού χαρτογραφικού οργανισμού (π.χ. Institut Géographique National (IGN) στη Γαλλία: www.ign.fr), μιας εταιρείας (π.χ. Google: www.googlemaps.com), ενός ιδιώτη που δημοσιοποιεί δεδομένα προσωπικού ενδιαφέροντος με τη βοήθεια χαρτών (π.χ. https://storymaps.arcgis.com/en/gallery/#s=0&md=storymaps-author:community-story-maps) ή μιας κοινότητας πληθοπορισμού (crowdsourcing) (π.χ. OSM www.osm.org). Οι υπηρεσίες αυτές βασίζονται στο πρότυπο πελάτη – εξυπηρετητή      (client - server) της διαδικτυακής επικοινωνίας, αλλά χρησιμοποιούν εξειδικευμένο λογισμικό και πρότυπα ικανά να διαχειριστούν τα χαρτογραφικά δεδομένα και τους χάρτες. 
Η τεχνολογία για τη δημιουργία και τη διάχυση χαρτών και γεωχωρικών δεδομένων στο διαδίκτυο βασίζεται σε πρωτόκολλα και γλώσσες που εξασφαλίζουν τη διαλειτουργικότητα. Η διαλειτουργικότητα (interoperability) αναφέρεται στη δυνατότητα δύο ή περισσοτέρων συστημάτων να ανταλλάσσουν και να χρησιμοποιούν την πληροφορία που αντάλλαξαν (Geraci, 1991), με αποτέλεσμα να επιτυγχάνεται η επικοινωνία ανάμεσα σε ετερογενή περιβάλλοντα. Η διαλειτουργικότητα στο διαδίκτυο εξασφαλίζεται με την εφαρμογή προτύπων. Η Κοινοπραξία του Παγκόσμιου Ιστού (World Wide Web Consortium - W3C - http://www.w3.org) αναπτύσσει την τεχνολογία, η οποία δημιουργεί μια ανοικτή πλατφόρμα με πρότυπα και γλώσσες για τη λειτουργία διαδικτυακών εφαρμογών όπως HTTP (HyperText Transfer Protocol), HTML (HyperText Markup Language), XML(eXtensible Mark-up Language), SVG (Scalable Vector Graphics), OWL (Web ontology language), RDF (Resource Description Framework), WSDL (Web Service Definition Language) κ.ά. Παράλληλα, άλλοι οργανισμοί δημοσιεύουν πρότυπα για τη γεωχωρική πληροφορία και προωθούν τη διαλειτουργικότητα στο διαδίκτυο. Μέσα από τις προσπάθειές τους η διαλειτουργικότητα της γεωχωρικής πληροφορίας εξελίχθηκε σημαντικά τα τελευταία είκοσι χρόνια π.χ. η ISO/TC 211 (International Organization for Standardization / Technical Committee 211 - www.iso.org) δημιουργεί διεθνή πρότυπα για την ποιότητα, η CEN/TC 287 (European Committee for Standardization - www.cen.eu) καλύπτει ευρωπαϊκά θέματα, η OGC (Open Geospatial Consortium - http://www.opengeospatial.org) αναπτύσσει πρότυπα διαλειτουργικότητας στο διαδίκτυο κ.ά. Παρόλα αυτά υπάρχουν κενά που καλούνται να καλύψουν άλλες ευρωπαϊκές πρωτοβουλίες όπως η INSPIRE (Infrastructure for Spatial Information in the European Community - http://inspire.ec.europa.eu). 
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Εικόνα 12.1 Σχηματική παρουσίαση ενός συστήματος πελάτη - εξυπηρετητή το οποίο υποστηρίζει τη διαδικτυακή μεταφορά χαρτών και χαρτογραφικών δεδομένων.
Το OGC ιδρύθηκε το 1994 με στόχο να καταστήσει τη γεωχωρική πληροφορία βασικό στοιχείο της παγκόσμιας υποδομής πληροφοριών. Τα μέλη του OGC είναι πάροχοι και χρήστες. Μέσα από συνεργασία αναπτύσσουν ανοιχτά πρότυπα διεπαφής και κωδικοποίησης, καθώς επίσης και βέλτιστες τεχνικές, οι οποίες επιτρέπουν στους προγραμματιστές να δημιουργούν πληροφοριακά συστήματα τα οποία ανταλλάσουν χωρική πληροφορία και αλληλεπιδρούν με άλλα πληροφοριακά συστήματα. Τα πρότυπα του OGC (http://www.opengeospatial.org/standards/is) καλύπτουν θέματα όπως: η δημοσιοποίηση χαρτών (Web Map Service – WMS), διανυσματικών χαρτογραφικών δεδομένων (Web Feature Service - WFS) και κανονικοποιημένων χαρτογραφικών δεδομένων (Web Coverage Service - WCS) στο διαδίκτυο, η κωδικοποίηση των χαρτογραφικών δεδομένων (Geography Markup Language - GML), η επεξεργασία των δεδομένων (Web Processing Service - WPS), η κωδικοποίηση του συμβολισμού (Style Layer Descriptor - SLD) κ.ά. Βασική αρχή του OGC είναι τα πρότυπα να είναι «ανοικτά», δηλαδή ελεύθερα και προσβάσιμα σε όλους, χωρίς κόστος άδειας χρήσης, ανεξάρτητα από τον πάροχο και τα δεδομένα και τέλος να θεσπίζονται με μια δημοκρατική διαδικασία. Οι διαδικτυακές υπηρεσίες του OGC επιτυγχάνουν τη διαλειτουργικότητα χρησιμοποιώντας ανοικτά πρότυπα που βασίζονται σε άλλα -επίσης ανοικτά- πρότυπα του διαδικτύου όπως HTML, ΧΜL κ.ά.
12.1 Πρότυπα δημοσιοποίησης χαρτών και χαρτογραφικών δεδομένων 
 
Οι διαδικτυακές χαρτογραφικές υπηρεσίες που διαχειρίζονται τη δημοσιοποίηση χαρτών και χαρτογραφικών δεδομένων αξιοποιούν τα πρότυπα WFS και WMS της OGC (Neumann, 2012). Στην Εικόνα 12.1 παρουσιάζεται σχηματικά ένα σύστημα πελάτη - εξυπηρετητή που ικανοποιεί την παραπάνω απαίτηση με διεργασίες που εκτελούνται στην πλευρά του εξυπηρετητή. Το αίτημα (request) π.χ. για ένα χάρτη ή χαρτογραφικά δεδομένα διατυπώνεται από τον πελάτη με βάση τις τυπικές μεθόδους HTML σε ένα URL (Uniform Resource Locator), το οποίο περιλαμβάνει τη διεύθυνση του εξυπηρετητή, το είδος της υπηρεσίας π.χ. WMS, WFS και τις λέξεις κλειδιά που περιγράφουν τη λειτουργία και διαχωρίζονται με τους χαρακτήρες (?) και (&). Το αίτημα μπορεί να διαβιβαστεί και μέσω ενός πελάτη που προσφέρει στον χρήστη διαδραστικά εργαλεία π.χ. ένα περιβάλλον ΣΓΠ όπως QGIS, ArcGIS κ.ά. Ο εξυπηρετητής επεξεργάζεται το αίτημα και δημιουργεί μια απάντηση (response) η οποία περιλαμβάνει ένα χάρτη ή χαρτογραφικά δεδομένα.
Το WMS παρέχει μια απλή διεπαφή πρωτοκόλλου HTTP για την αίτηση και λήψη χαρτών με χαρτογραφικά δεδομένα από μια ή περισσότερες κατανεμημένες βάσεις χωρικών δεδομένων. Η απάντηση του εξυπηρετητή στο αίτημα WMS είναι μια ή περισσότερες εικόνες με γεωγραφική αναφορά (σε μορφότυπο JPEG, PNG κ.ά.) οι οποίες μπορούν να απεικονιστούν εύκολα σε κάποιο φυλλομετρητή αλλά και σε τοπικές εφαρμογές π.χ. ΣΓΠ. Αυτό το πρότυπο του OGC επιτρέπει στα δεδομένα (διανυσματικά και κανονικοποιημένα) να είναι ανοικτά για θέαση σε όλους. To WFS ορίζει ένα πρωτόκολλο για ανάκτηση και επεξεργασία διανυσματικών γεωχωρικών δεδομένων με χρήση του προτύπου GML. Οι χρήστες αλληλεπιδρούν με τις υπηρεσίες WFS μέσω ενός φυλλομετρητή ή μέσω ενός λογισμικού ΣΓΠ και αποκτούν πρόσβαση μέσω διαδικτύου σε θεματικά επίπεδα δεδομένων από εξωτερικές πηγές. Ανάλογα με τις λειτουργίες τις οποίες πρέπει να υλοποιεί η χαρτογραφική διαδικτυακή εφαρμογή, τα πρότυπα WMS και WFS μπορεί να χρησιμοποιηθούν μεμονωμένα ή και σε συνδυασμό (Εικόνα 12.2).
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Εικόνα 12.2 Συνδυασμένη χρήση των προτύπων WMS και WFS.
Κάθε υπηρεσία WMS και WFS υλοποιεί μια σειρά από λειτουργίες (Εικόνα 12.3). Όλες οι υπηρεσίες διαθέτουν τη λειτουργία GetCapabilities. Ο πελάτης ζητά από τον εξυπηρετητή να τον ενημερώσει για τα διαθέσιμα δεδομένα. Ο εξυπηρετητής απαντά με ένα τυποποιημένο κείμενο XML το οποίο περιγράφει τα διαθέσιμα θεματικά επίπεδα και τα αντίστοιχα μεταδεδομένα π.χ. το σύστημα αναφοράς των συντεταγμένων, τις ιδιότητές τους κ.α. Η λειτουργία GetCapabilities χρησιμοποιεί τις παράμετρους SERVICE με τιμές WMS ή WFS (είδος υπηρεσίας) και REQUEST με τιμή GetCapabilities (είδος λειτουργίας) (Εικόνα 12.4).
Για τη δημιουργία υπηρεσιών εξυπηρετητή με βάση τα πρότυπα δημοσιοποίησης χαρτών και χαρτογραφικών δεδομένων της OGC, μπορούν να χρησιμοποιηθούν ΕΛ/ΛΑΚ όπως GeoServer, degree, MapServer, QGIS Server, GeoWebCache κ.ά. ή εμπορικά περιβάλλοντα λογισμικού όπως ESRI ArcGIS Server, GeoMedia WebMap, Autodesk Infrastructure Studio κ.ά. 
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Εικόνα 12.3 Κάθε υπηρεσία WMS και WFS υλοποιεί μια σειρά από λειτουργίες.
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Εικόνα 12.4 Παράδειγμα αιτήματος GetCapabilities και τμήμα του αποτελέσματος.
 
12.1.1 Οι λειτουργίες του προτύπου WMS
 
Το πρότυπο WMS (http://www.opengeospatial.org/standards/wms) (Εικόνα 12.5) περιλαμβάνει μια σειρά από υπηρεσίες όπως: η λήψη χαρτών σε μορφή εικόνας (GetMap), η λήψη πληροφοριών για τον εξυπηρετητή π.χ. μορφότυπος εικόνας χάρτη, θεματικά επίπεδα, Συστήματα Αναφοράς Συντεταγμένων κ.ά. (GetCapabilities), η ανάκτηση πληροφοριών για ένα θεματικό επίπεδο με βάση τη θέση του ποντικιού στην εικόνα του χάρτη (GetFeatureInfo) κ.ά.
Με το αίτημα GetMap (Εικόνα 12.5), ο πελάτης ζητάει από τον εξυπηρετητή έναν χάρτη τα χαρακτηριστικά του οποίου περιγράφονται με παραμέτρους. Το αίτημα (Εικόνα 12.6) συντάσσεται με βάση τις ακόλουθες παραμέτρους: VERSION=version (έκδοση υπηρεσίας) π.χ. 1.0.0, 1.1.0, 1.1.1, 1.3, REQUEST=GetMap (όνομα λειτουργίας), LAYERS=layer_list (ονόματα θεματικών επιπέδων χωρισμένα με «,»), STYLES=style_list (ονόματα συμβολισμού χωρισμένα με «,»), CRS (ή SRS v.1.3)=namespace:identifier (σύστημα αναφοράς συντεταγμένων), BBOX=minx,miny,maxx,maxy (όριο συντεταγμένων περιοχής σε μονάδες του παραπάνω ΣΑΣ), WIDTH=output_width (πλάτος χάρτη σε εικονοστοιχεία οθόνης), HEIGHT=output_height (ύψος χάρτη σε εικονοστοιχεία οθόνης) και FORMAT=output_format (μορφότυπος εικόνας χάρτη). Εάν ο λόγος των διαστάσεων της εικόνας είναι διαφορετικός από τον λόγο των διαστάσεων που ορίζονται από τα όρια της περιοχής, τότε ο χάρτης παραμορφώνεται. Ο εξυπηρετητής (Εικόνα 12.5) WMS ανακτά και επιλέγει τα χαρτογραφικά δεδομένα τα οποία ζητήθηκαν από τη βάση δεδομένων, εφαρμόζει τον συμβολισμό που περιγράφεται με βάση το πρότυπο SLD (βλ. Κεφάλαιο 13), συνθέτει τον χάρτη και απαντά στο αίτημα του χρήστη με τον χάρτη ως αρχείο εικόνας με γεωαναφορά π.χ. GIF, PNG κ.ά.
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Εικόνα 12.5 Το πρότυπο WMS.
Με το αίτημα GetLegendGraphic, ο πελάτης ζητάει από τον εξυπηρετητή πληροφορίες που αφορούν τον συμβολισμό και λαμβάνει το υπόμνημα σε μορφή εικόνας (Εικόνα 12.7). Με το αίτημα GetFeatureInfo (Εικόνα 12.8), ο πελάτης ζητάει από τον εξυπηρετητή πληροφορίες οι οποίες αφορούν σε μια συγκεκριμένη οντότητα που απεικονίζεται στον χάρτη. Ο εξυπηρετητής ανταποκρίνεται με ένα αρχείο XML. Το αίτημα αυτό μπορεί να εφαρμοστεί μόνο στα θεματικά επίπεδα τα οποία έχουν την ιδιότητα queryable="1" (true), όπως φαίνεται από την απάντηση στο αίτημα GetCapabilities. H τυπική χρήση αυτής της λειτουργίας αφορά την περίπτωση όπου ο χρήστης αφού δει τον χάρτη διαλέγει ένα σημείο επί του χάρτη για το οποίο ζητά επιπλέον πληροφορίες. Η λειτουργία αυτή δίνει τη δυνατότητα στον πελάτη να ορίσει ένα εικονοστοιχείο με βάση τη θέση του στην οθόνη (Χ = θέση Χ & Υ = θέση Υ), ένα θεματικό επίπεδο (layer = όνομα θεματικού επιπέδου) και τον μορφότυπο στον οποίο θα ληφθεί η απάντηση (info_format = μορφότυπος).
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Εικόνα 12.6 Παράδειγμα αιτήματος WMS GetMap και του αποτελέσματος.
 
 
[image: ]
Εικόνα 12.7 Παράδειγμα αιτήματος WMS GetLegendGraphic και του αποτελέσματος.
 
 
[image: ]
Εικόνα 12.8 Παράδειγμα αιτήματος WMS GetFeatureInfo και του αποτελέσματος.
12.1.2.1 Δημοσιοποίηση χάρτη στο διαδίκτυο με χρήση πινακίδων
 
Η τεχνολογία AJAX (Asynchronous JavaScript and XML) περιλαμβάνει μια σειρά από τεχνικές που χρησιμοποιούνται από τον πελάτη για τη δημιουργία ασύγχρονων διαδικτυακών εφαρμογών. Επιτρέπει σε μια ιστοσελίδα να ανανεώνεται ασύγχρονα, δηλαδή να ανταλλάσσονται μικρού όγκου δεδομένα με τον εξυπηρετητή στο παρασκήνιο και να ανανεώνονται τμήματα της ιστοσελίδας και όχι το σύνολό της. Οι τεχνικές AJAX βελτίωσαν το χρόνο επικοινωνίας εξυπηρετητή - πελάτη και επέτρεψαν τη διάχυση χαρτών σε διαφορετικές κλίμακες με ταχύτητα. Εφαρμογή της τεχνολογίας αυτής αποτελεί η διάχυση των χαρτών στο διαδίκτυο σε πινακίδες (Peterson, 2012).
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Εικόνα 12.9 Ο χάρτης για το διαδίκτυο σχεδιάζεται σε μια προοδευτική σειρά από κλίμακες χρησιμοποιώντας πινακίδες που συγκροτούν τη δομή μιας πυραμίδας.
Οι διαδικτυακοί χάρτες δεν διαχέονται πλέον ως μια σειρά από θεματικά επίπεδα με τη μορφή διανυσματικών δεδομένων, αλλά ως εικόνες. Η τεχνική αυτή αρχικά εφαρμόστηκε από τις εταιρίες Google Maps και Bing Maps, αλλά πλέον εφαρμόζεται ευρύτατα αφού συνδυάζει υψηλή χαρτογραφική ποιότητα με ταχύτητα μετάδοσης. Οι χαρτογραφικές πινακίδες (Map tiles) (Εικόνα 12.9) αποτελούν μια ιεραρχική δομή που συνδέει τον βαθμό μεγέθυνσης του χάρτη με το πλήθος των πινακίδων οι οποίες χρησιμοποιούνται για την απόδοση μιας περιοχής π.χ. βαθμός μεγέθυνσης 0 αντιστοιχεί σε 1, βαθμός μεγέθυνσης 1 αντιστοιχεί σε 2 x 2, βαθμός μεγέθυνσης 2 αντιστοιχεί σε 4 x 4, …, βαθμός μεγέθυνσης 12 αντιστοιχεί σε 4096 x 4096, …, βαθμός μεγέθυνσης n αντιστοιχεί σε 2n x 2n. Κάθε πινακίδα αποθηκεύεται ως εικόνα με 256 x 256 εικονοστοιχεία. Η ταχύτητα απόκρισης βελτιώνεται όταν οι χάρτες σε διαφορετικές κλίμακες αποθηκεύονται σε μορφή πυραμίδας εικόνων στον εξυπηρετητή. Η τεχνική χρησιμοποιείται από τα περισσότερα περιβάλλοντα λογισμικού δημοσιοποίησης χαρτών. Πρότυπο για την τεχνική αυτή αποτελεί το Web Map Tile Service (WMTS) της OGC (http://www.opengeospatial.org/standards/wmts). 
Μειονέκτημα της τεχνικής αυτής αποτελεί η στατικότητα του χάρτη από τη στιγμή που αποθηκεύεται σε πινακίδες στον εξυπηρετητή. Στην περίπτωση που ο χάρτης περιλαμβάνει ένα θεματικό επίπεδο που ενημερώνεται συχνά, τότε προτείνεται ο χάρτης να διαχωρίζεται στο υπόβαθρο και στο θεματικό επίπεδο. Το υπόβαθρο υλοποιείται ως μια υπηρεσία χάρτη σε πινακίδες (WMTS) και ενδέχεται να χρησιμοποιείται για διαφορετικούς χάρτες, ενώ το θεματικό επίπεδο ως μια υπηρεσία δεδομένων (WFS). Αν αλλάξουν τα δεδομένα που εμφανίζονται στο χάρτη υποβάθρου, τότε θα πρέπει να δημιουργηθούν εκ νέου οι πινακίδες. Με δεδομένο ότι το πλήθος των πινακίδων αυξάνεται όσο μεγαλώνει η κλίμακα, απαιτείται σημαντικός αποθηκευτικός χώρος. Για τον λόγο αυτό, συχνά δημιουργούνται μόνο αυτές που καλύπτουν τις πιο δημοφιλείς περιοχές και οι υπόλοιπες δημιουργούνται όταν ζητηθούν για πρώτη φορά από τον χρήστη. 
Αν και η ταχύτητα σχεδίασης του χάρτη βελτιώνεται με την τεχνική αυτή, συχνά παρατηρούνται προβλήματα στην αναγραφή της ονοματολογίας. Στα όρια των πινακίδων τα ονόματα αναγράφονται και στις δύο γειτονικές πινακίδες, καθώς δεν υπάρχει τρόπος η μια πινακίδα να γνωρίζει ότι το όνομα έχει αναγραφεί στην άλλη. Για τη αντιμετώπιση αυτού του προβλήματος το λογισμικό κατά τη δημιουργία των πινακίδων σχεδιάζει μια περιοχή μεγαλύτερη από τα όρια της πινακίδας και στη συνέχεια την κόβει σε μικρότερες πινακίδες. 
12.1.2 Οι λειτουργίες του προτύπου WFS
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Εικόνα 12.10 To πρότυπο WFS.
Το πρότυπο WFS (http://www.opengeospatial.org/standards/wfs) (Εικόνα 12.10) περιλαμβάνει μια σειρά από λειτουργίες όπως: η λήψη πληροφοριών για τα δεδομένα και η επεξεργασία των δεδομένων (π.χ. ενημέρωση, προσθήκη, διαγραφή κ.ά.). Με το αίτημα DescribeFeatureType, ο πελάτης ζητάει από τον εξυπηρετητή να περιγράψει τα χαρακτηριστικά κάθε γεωχωρικής οντότητας που είναι διαθέσιμη. Με το αίτημα GetFeature (Εικόνα 12.10), ο πελάτης ζητάει από τον εξυπηρετητή να ανακτήσει το σύνολο των χαρτογραφικών δεδομένων από ένα θεματικό επίπεδο ή ένα υποσύνολό τους όπως ορίζεται μέσω ενός λογικού ερωτήματος το οποίο αφορά τις ιδιότητες. Ο εξυπηρετητής ανακτά τα χαρτογραφικά δεδομένα από τη βάση δεδομένων, τα κωδικοποιεί βάσει ενός μορφότυπου π.χ. GML και τα επιστρέφει στον χρήστη. Βάσει του πρότυπου WFS-T (Web Feature Service Τransactional) με το αίτημα Transaction, ο πελάτης ζητά από τον εξυπηρετητή να επέμβει στα δεδομένα με τις διαδικασίες της προσθήκης (Ιnsert), της διόρθωσης (Update) και της διαγραφής (Delete).
12.2 Δημοσιοποίηση χαρτών και χαρτογραφικών δεδομένων με τον Geoserver
 
Ο GeoServer είναι ένας ισχυρός εξυπηρετητής που έχει τη δυνατότητα δημοσιοποίησης χαρτών και χαρτογραφικών δεδομένων από διαφορετικές πηγές αξιοποιώντας ανοικτά πρότυπα. Οι υπηρεσίες του αξιοποιηούνται σε χαρτογραφικές εφαρμογές ή σε εφαρμογές παρουσίασης και επεξεργασίας χαρτογραφικών δεδομένων για το διαδίκτυο και τα ΣΓΠ. Υλοποιεί τα πρότυπα WMS και WFS του OGC. Πρόκειται για ένα Ελεύθερο Λογισμικό/Λογισμικό Ανοικτού Κώδικα (ΕΛ/ΛΑΚ) που αναπτύχθηκε με την ανοικτή βιβλιοθήκη Geotools και ενσωματώνει τη βιβλιοθήκη OpenLayers (Geoserver, 2015).
Στη συνέχεια, παρουσιάζονται ορισμένα βασικά εργαλεία που μπορούν να αξιοποιηθούν για τη δημοσιοποίηση χαρτών και χαρτογραφικών δεδομένων με τον Geoserver (Geoserver, 2015; Τσούλος, Αντωνίου, Σκοπελίτη & Στάμου, 2015). 
12.2.1 Λήψη και εγκατάσταση Geoserver
 
Το λογισμικό του Geoserver λαμβάνεται από την ιστοσελίδα του (http://geoserver.org/), επιλέγοντας την καταλληλότερη έκδοση για το περιβάλλον εργασίας. Ο χρήστης θα πρέπει γνωρίζει ότι κατά την εγκατάσταση θεωρείται ως προεπιλεγμένη τιμή η θύρα 8080. Αν η θύρα αυτή χρησιμοποιείται ήδη στο συγκεκριμένο περιβάλλον εργασίας μπορεί να οριστεί μια άλλη π.χ. 8081.
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Εικόνα 12.11 Το περιβάλλον του Geoserver.
12.2.2 Εκκίνηση
 
Η διαχείριση του Geoserver γίνεται μέσω ενός φυλλομετρητή. Η διεύθυνση λειτουργίας πληκτρολογείται στον φυλλομετρητή και εμφανίζεται το παράθυρο υποδοχής (Εικόνα 12.11). Κατά την εργασία σε προσωπικό Η/Υ στον οποίο είναι εγκατεστημένος ο Geoserver, η διεύθυνση αυτή είναι συνήθως http://localhost:8080/geoserver/, ενώ σε κάποιον απομακρυσμένο εξυπηρετητή (server) προστίθεται η διεύθυνση ΙP π.χ. http://147.102.110.1:8080/geoserver/web/. Στο περιβάλλον των Windows, η μετάβαση στην ιστοσελίδα διαχείρισης γίνεται με την επιλογή Programs>Geoserver 2.X.X>Geoserver Web Admin Page. Σε περίπτωση κατά την οποία η υπηρεσία του Geoserver δεν είναι ενεργοποιημένη, προηγείται η επιλογή Programs>Geoserver 2.X.X>Start Geoserver.
12.2.3 Διαπίστευση χρήση
 
Κατά την εγκατάσταση του προγράμματος δημιουργείται ο χρήστης (user) admin με κωδικό (password) geoserver. Ο χρήστης μπορεί με αυτόν τον λογαριασμό να διαπιστευτεί ως διαχειριστής.
12.2.4 Βασικές ρυθμίσεις περιβάλλοντος Geoserver
 
Από το μενού About & Status λαμβάνονται πληροφορίες για τις βασικές ρυθμίσεις του περιβάλλοντος του Geoserver (Εικόνα 12.12). Η επιλογή Server Status εμφανίζει μια σύνοψη της κατάστασης (status) και των ρυθμίσεων (configuration). Η επιλογή GeoServer logs εμφανίζει ή αποθηκεύει σε ξεχωριστό αρχείο το ιστορικό των ενεργειών. Η επιλογή Contact Information εμφανίζει τις πληροφορίες επικοινωνίας. Τα συγκεκριμένα στοιχεία περιλαμβάνονται και στην απάντηση του εξυπηρετητή στο αίτημα GetCapabilities. Η επιλογή About GeoServer εμφανίζει γενικές πληροφορίες για τον GeoServer.
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Εικόνα 12.12 Βασικά μενού του Geoserver.
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Εικόνα 12.13 Δημιουργία Workspace.
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Εικόνα 12.14 Διαμόρφωση χαρακτηριστικών του Workspace.
12.2.5 Δημιουργία ενός Workspace
 
To πρώτο βήμα για τη δημοσιοποίηση χαρτογραφικών δεδομένων είναι η δημιουργία ενός Workspace. Πρόκειται για έναν εικονικό χώρο ο οποίος περιέχει και ομαδοποιεί τα δεδομένα. Πολλαπλά θεματικά επίπεδα από διάφορες πηγές μπορούν να περιέχονται σε ένα Workspace, αρκεί το κάθε θεματικό επίπεδο να έχει μοναδικό όνομα. Από το μενού Data επιλέγεται Workspaces>Add new Workspace (Εικόνα 12.13). Ένα Workspace ορίζεται από το όνομά του που ζητείται ως Name (συχνά γνωστό και ως «πρόθεμα χώρου» (namespace prefix)) και μια URI διεύθυνση (Namespace URI) που ζητείται ως URI. Τα δύο αυτά στοιχεία το ορίζουν με μοναδικό τρόπο. Όταν δοθούν όλα τα στοιχεία επιλέγεται Submit. Το όνομα του Workspace μπορεί να περιλαμβάνει το πολύ 10 χαρακτήρες χωρίς κενά. Το URI είναι παρόμοιο με τα συνηθισμένα URL, με τη διαφορά ότι δεν είναι απαραίτητο να δείχνει σε κάποιο συγκεκριμένο σημείο/διεύθυνση στο διαδίκτυο, απλά πρέπει να δίνει μια μοναδική ταυτότητα. Για το URI προτείνεται η χρήση ενός URL που συνδέεται με το έργο που υλοποιείται π.χ. http://www.samos.org/geodata για το workspace “geodata”. 
Αφού δημιουργηθεί ένα Workspace, αυτό επιλέγεται από τον κατάλογο και στη νέα οθόνη (Εικόνα 12.14) πραγματοποιείται η ενεργοποίησή του (Enabled) καθώς και ο ορισμός των υπηρεσιών (services) τις οποίες θα υποστηρίζει π.χ. WMS, WFS κ.ά. Επιπλέον ρυθμίσεις για τις υπηρεσίες WMS και WFS που υποστηρίζει ένα Workspace, υλοποιούνται από το μενού Services>WMS ή Services>WFS. Εκεί για παράδειγμα ορίζεται εάν μια υπηρεσία WFS θα υποστηρίζει τις διαδικασίες επεξεργασίας των δεδομένων με την επιλογή Service Level>Transactional. 
Για τη διαγραφή ενός Workspace από τον κατάλογο των Workspaces που υπαρχουν, επιλέγεται το κουτάκι δίπλα από αυτό και το πλήκτρο Remove selected workspaces(s). Η διαδικασία επιβεβαιώνεται με το πλήκτρο ΟΚ στο παράθυρο που εμφανίζεται. 
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Εικόνα 12.15 Επιλογές για τη δημιουργία ενός Store.
 
 
 
12.2.6 Επιλογή της πηγής των χαρτογραφικών δεδομένων με τον ορισμό ενός Store
 
Η δομή Store του Geoserver συνδέεται με μια πηγή δεδομένων η οποία περιέχει διανυσματικά ή κανονικοποιημένα δεδομένα. Η πηγή δεδομένων μπορεί να είναι ένα μεμονωμένο αρχείο ή ένα σύνολο αρχείων, ένας πίνακας σε μία βάση δεδομένων, ένα κανονικοποιημένο αρχείο ή ένας κατάλογος (directory) με δεδομένα. Η δομή Store δημιουργεί εφάπαξ τη σύνδεση με τα δεδομένα. Για τα κανονικοποιημένα δεδομένα το Store είναι ένα αρχείο. Για τα διανυσματικά δεδομένα το Store μπορεί να είναι ένα αρχείο (file), ένας κατάλογος με δεδομένα (directory), μια βάση δεδομένων (database) ή ένας εξυπηρετητής (server).
Για τον ορισμό ενός Store, από το μενού Data επιλέγεται Stores>Add new Store. Στο νέο παράθυρο (Εικόνα 12.15), ορίζεται το είδος της πηγής των δεδομένων. Για τα διανυσματικά δεδομένα (Vector Data Sources) μπορεί να επιλεγεί ένας κατάλογος που περιέχει πολλαπλά αρχεία μορφότυπου shapefile (Directory of spatial files), ένα μεμονωμένο αρχείο μορφότυπου shapefile (Shapefile), μια διαδικτυακή υπηρεσία γεωγραφικών δεδομένων (Web Feature Service) ή μια βάση δεδομένων (PostGIS). Για τα κανονικοποιημένα δεδομένα (Raster Data Sources) μπορεί να επιλεγεί ένα αρχείο μορφότυπου GeoTIFF, Gtopo30 κ.ά. Ακόμα μπορεί να χρησιμοποιηθεί η επιλογή άλλες πηγές (Other data sources) π.χ. διαδικτυακή υπηρεσία χαρτών (WMS).
12.2.6.1 Δημιουργία Store για αρχείο μορφότυπου shapefile
 
Για τον ορισμό ενός Store για αρχείο μορφότυπου shapefile, από το μενού Data επιλέγεται Stores>Add new Store και στη συνέχεια από την ομάδα Vector Data Sources η επιλογή Shapefile. Στη νέα οθόνη που εμφανίζεται (Εικόνα 12.16), συμπληρώνονται τα ακόλουθα: ως Workspace αυτό στο οποίο τοποθετείται το θεματικό επίπεδο (αρχικά εμφανίζεται αυτό που έχει οριστεί ως προεπιλεγμένο αλλά μπορεί να αλλάξει), ως Data Source Name ορίζεται ένα όνομα που επιλέγει ο χρήστης, η επιλογή Enabled εξασφαλίζει ότι το θεματικό επίπεδο μπορεί να δημοσιοποιηθεί, στο Description δηλώνεται μια σύντομη περιγραφή και τέλος στο Shapefile location με τη βοήθεια του πλήκτρου Browse ορίζεται η θέση του αρχείου shapefile που χρησιμοποιείται. Σημειώνεται ότι ο Geoserver έχει πρόσβαση μέσω αυτής της διαδικασίας στους δίσκους του Η/Υ/εξυπηρετητή στον οποίο είναι εγκατεστημένος και σε κάθε άλλο δίσκο που είναι συνδεδεμένος με αυτόν. Η διαδικασία ολοκληρώνεται με το πλήκτρο Save. Η επιλογή DBF charset (π.χ. ISO-8859-1, UTF-8) διαμορφώνεται έτσι ώστε να εξασφαλίζει την ορθή ανάγνωση των αλφαβητικών τιμών των πεδίων.
 
12.2.6.2 Δημιουργία Store για κατάλογο αρχείων μορφότυπου shapefile
 
Για τον ορισμό ενός Store για κατάλογο αρχείων μορφότυπου shapefile, από το μενού Data επιλέγεται Stores>Add new Store και στη συνέχεια από την ομάδα Vector Data Sources η επιλογή Directory of spatial files (Shapefiles). Στη νέα οθόνη που εμφανίζεται (Εικόνα 12.17), συμπληρώνονται τα ακόλουθα: ως Workspace αυτό στο οποίο τοποθετούνται τα θεματικά επίπεδα (αρχικά εμφανίζεται αυτό που έχει οριστεί ως προεπιλεγμένο αλλά μπορεί να αλλάξει), ως Data Source Name ορίζεται ένα όνομα που επιλέγει ο χρήστης, η επιλογή Enabled εξασφαλίζει ότι τα θεματικά επίπεδα μπορεί να δημοσιοποιηθούν, στο Description δηλώνεται μια σύντομη περιγραφή και τέλος στο Shapefile location, με τη βοήθεια του πλήκτρου Browse, ορίζεται ο κατάλογος ο οποίος περιέχει τα αρχεία shapefile. Σημειώνεται ότι ο Geoserver έχει πρόσβαση μέσω αυτής της διαδικασίας στους δίσκους του Η/Υ/ εξυπηρετητή στον οποίο είναι εγκατεστημένος και σε κάθε άλλο δίσκο ο οποίος είναι συνδεδεμένος με αυτόν. Η διαδικασία ολοκληρώνεται με το πλήκτρο Save. Η επιλογή DBF charset π.χ. ISO-8859-1, UTF-8 διαμορφώνεται έτσι ώστε να εξασφαλίζει την ορθή ανάγνωση των αλφαβητικών τιμών των πεδίων.
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Εικόνα 12.16 Δημιουργία Store για ένα αρχείο μορφότυπου shapefile.
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Εικόνα 12.17 Δημιουργία Store για έναν κατάλογο αρχείων μορφότυπου shapefile.
12.2.6.3 Δημιουργία Store για βάση δεδομένων Postgres
 
Για τον ορισμό ενός Store για βάση δεδομένων Postgres, από το μενού Data επιλέγεται Stores>Add new Store και στη συνέχεια από την ομάδα Vector Data Sources η επιλογή PostGIS-PostGIS Database. Στη νέα οθόνη που εμφανίζεται (Εικόνα 12.18), συμπληρώνονται τα ακόλουθα: ως Workspace αυτό στο οποίο τοποθετούνται τα θεματικά επίπεδα (αρχικά εμφανίζεται αυτό που έχει οριστεί ως προεπιλεγμένο αλλά μπορεί να αλλάξει), ως Data Source Name ορίζεται ένα όνομα που επιλέγει ο χρήστης, η επιλογή του Enabled εξασφαλίζει ότι τα θεματικά επίπεδα μπορεί να δημοσιοποιηθούν και τέλος στο Description δηλώνεται μια σύντομη περιγραφή. Στη συνέχεια, συμπληρώνονται οι παράμετροι σύνδεσης με τη βάση δεδομένων: το host αναφέρεται στη διεύθυνση του εξυπηρετητή στον οποίο είναι εγκατεστημένη η Postgres (εάν η εγκατάσταση είναι στον τοπικό υπολογιστή, τότε το όνομα του host είναι localhost, σε διαφορετική περίπτωση θα πρέπει να δοθεί η πλήρης διεύθυνση), το port αναφέρεται σε αυτήν που αναμένει τις κλήσεις ο εξυπηρετητής που διαχειρίζεται την Postgres π.χ. 5432, το database αναφέρεται στο όνομα της βάσης με την οποία θα γίνει η σύνδεση, το schema αναφέρεται στο σχήμα της βάσης δεδομένων στο οποίο βρίσκονται οι πίνακες δεδομένων που θα χρησιμοποιηθούν, το user αναφέρεται στο όνομα χρήστη (username) και το passwd στον κωδικό (password) για τη σύνδεση με τη βάση. Οι λοιπές επιλογές μπορούν να πάρουν τις προκαθορισμένες (default) τιμές. Η διαδικασία ολοκληρώνεται με το πλήκτρο Save.
 
12.2.6.4 Δημιουργία Store για κανονικοποιημένο αρχείο
 
Για τον ορισμό ενός Store για ένα κανονικοποιημένο αρχείο π.χ. μορφότυπου GeoTIFF, από το μενού Data επιλέγεται Stores>Add new Store και στη συνέχεια από την ομάδα Raster Data Sources η επιλογή GeoTIFF - Tagged Image File Format with Geographic information. Στη νέα οθόνη η οποία θα εμφανιστεί (Εικόνα 12.19), συμπληρώνονται τα ακόλουθα: ως Workspace αυτό στο οποίο θα τοποθετηθεί το θεματικό επίπεδο (αρχικά εμφανίζεται αυτό που έχει οριστεί ως προεπιλεγμένο αλλά μπορεί να αλλάξει), ως Data Source Name ορίζεται ένα όνομα το οποίο επιλέγει ο χρήστης, στο Description δηλώνεται μια σύντομη περιγραφή και τέλος στο Connection Parameters, με τη βοήθεια του πλήκτρου Browse, ορίζεται η θέση του αρχείου που θα χρησιμοποιηθεί. Σημειώνεται ότι, ο Geoserver έχει πρόσβαση μέσω αυτής της διαδικασίας στους δίσκους του Η/Υ/εξυπηρετητή στον οποίο είναι εγκατεστημένος και σε κάθε άλλο δίσκο ο οποίος είναι συνδεδεμένος με αυτόν. Η διαδικασία ολοκληρώνεται με το πλήκτρο Save. 
12.2.6.5 Διαγραφή ενός Store 
 
Για την διαγραφή ενός Store, από τον κατάλογο των υπαρχόντων Stores επιλέγεται το κουτάκι δίπλα από αυτό και το πλήκτρο Remove selected store(s). Η διαδικασία επιβεβαιώνεται με το πλήκτρο ΟΚ στο παράθυρο που εμφανίζεται.
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Εικόνα 12.18 Δημιουργία Store για μια βάση δεδομένων Postgres.
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Εικόνα 12.19 Δημιουργία Store για ένα κανονικοποιημένο αρχείο.
12.2.7 Δημοσιοποίηση ενός θεματικού επιπέδου
 
Στο περιβάλλον του Geoserver, η δομή layer αναφέρεται σε κάθε θεματικό επίπεδο που δημοσιοποιείται και χρησιμοποιεί διανυσματικά ή κανονικοποιημένα δεδομένα. Κάθε layer συνδέεται με μια πηγή δεδομένων η οποία έχει υλοποιηθεί με ένα Store και ανήκει σε ένα Workspace. Ένα σύνολο από θεματικά επίπεδα (layers) δημιουργούν έναν χάρτη βάσει της δομής layer group του Geoserver (βλ. Κεφάλαιο 13). 
Για τη δημιουργία ενός layer επιλέγεται Data>Layers>Add a new resource. Στο επόμενο παράθυρο ορίζεται o συνδυασμός Workspace και Store που θα χρησιμοποιηθεί π.χ. geodata:i8aki. Από τη λίστα των layers τα οποία εμφανίζονται (Εικόνα 12.20), επιλέγεται το επιθυμητό με το πλήκτρο Publish (ή Publish Again σε περίπτωση που δημοσιοποιείται με νέες παραμέτρους ένα ήδη δημοσιοποιημένο θεματικό επιπέδο). Στο νέο παράθυρο Edit Layer καρτέλα Data (Εικόνα 12.21), ορίζεται το όνομα Name, μια σύντομη περιγραφή Title, μια εκτενέστερη περιγραφή Abstract, υλοποιείται η προσθήκη (Add) και η αφαίρεση (Remove selected) λέξεων κλειδιών (Keywords) και τέλος προστίθεται ένας εξωτερικός σύνδεσμος μεταδεδομένων (Metadata links) σύμφωνα με τα πρότυπα TC211 και FGDC. Η επιλογή Enabled καθορίζει ότι το θεματικό επίπεδο είναι διαθέσιμο σε κάθε αίτημα και η επιλογή Advertised καθορίζει ότι το θεματικό επίπεδο θα εμφανίζεται στο αίτημα GetCapabilities. Η επιλογή Coordinate Reference System>Native SRS αναφέρεται στο Σύστημα Αναφοράς Συντεταγμένων - ΣΑΣ του θεματικού επιπέδου, το οποίο ανακτάται από τα δεδομένα εάν είναι καταγεγραμμένο. Η επιλογή Coordinate Reference System>Declared SRS αναφέρεται στο ΣΑΣ το οποίο χρησιμοποιεί ο GeoServer για τη δημοσιοποίηση των δεδομένων. Τα ΣΑΣ (SRS ή CRS) στον Geoserver ορίζονται βάσει του προτύπου EPSG (βλ. Κεφάλαιο 6) π.χ EPSG:2100 για το ΕΓΣΑ 87, EPSG:4326 για το WGS84 κ.ά. Η επιλογή Coordinate Reference System>SRS Handling καθορίζει τον τρόπο με τον οποίο διαχειρίζεται ο Geoserver το ΣΑΣ όταν τα δύο παραπάνω ΣΑΣ διαφέρουν. Η επιλογή Forced declared θεωρεί ως ΣΑΣ των δεδομένων αυτό που δηλώθηκε στο Declared SRS. Η επιλογή Keep native διατηρεί το ΣΑΣ το οποίο δηλώθηκε ως Native SRS. Η επιλογή Reproject native to declared, μετασχηματίζει τα δεδομένα από το ΣΑΣ που δηλώθηκε ως Native SRS στο ΣΑΣ που δηλώθηκε ως Declared SRS. Η επιλογή Bounding Boxes καθορίζει το εύρος των συντεταγμένων του layer. Το Native Bounding Box αναφέρεται στο εύρος των συντεταγμένων στο ΣΑΣ του Native SRS. Οι συντεταγμένες αυτές προσδιορίζονται από το Compute from data. Το Lat/Long Bounding Box εμφανίζει το εύρος των γεωγραφικών συντεταγμένων. Υπολογίζεται από το Compute from native bounds. Από το παράθυρο Edit Layer και την καρτέλα Publishing, με την επιλογή WMS Settings>Queryable, καθορίζεται εάν το αίτημα GetFeatureInfo μπορεί να χρησιμοποιηθεί στο θεματικό επίπεδο. Τέλος, στην καρτέλα Publishing διαμορφώνεται ο συμβολισμός όπως παρουσιάζεται στο Κεφάλαιο 13.
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Εικόνα 12.20 Δημιουργία νέου layer.
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Εικόνα 12.21 Δημοσιοποίηση ενός θεματικού επιπέδου.
12.2.8 Προεπισκόπηση  δημοσιοποιημένου θεματικού επιπέδου
 
Για την προεπισκόπηση ενός θεματικού επιπέδου όπως θα φαίνεται στο διαδίκτυο, επιλέγεται Data>Layer Preview. Η διαδικασία προεπισκόπησης υποστηρίζει μια ποικιλία μορφoτύπων (Εικόνα 12.22). Το αποτέλεσμα κάθε επιλογής μπορεί να είναι εικόνα (image) π.χ. PNG, κείμενο (text) π.χ. CSV ή δεδομένα (data) π.χ. GML. Οι επιλογές καλύπτουν τις δημοφιλείς μορφές Common Formats όπως OpenLayers, KML και GML. Επιπλέον, υπάρχουν οι επιλογές All Formats>WMS όπως AtomPub, GIF, GeoRss, JPEG, KML (compressed), PDF, PNG, SVG, TIFF κ.ά. Ειδικά για τα διανυσματικά δεδομένα υπάρχουν ακόμα οι επιλογές All Formats>WFS όπως GML, CSV, GML3, GeoJSON, Shapefile κ.ά. Το αποτέλεσμα της κάθε επιλογής εμφανίζεται σε ένα παράθυρο του φυλλομετρητή ή αποθηκεύεται τοπικά μετά από ερώτηση του χρήστη.
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Εικόνα 12.22 Προεπισκόπηση θεματικού επιπέδου.
12.2.9 Δημιουργία πινακίδων για ένα θεματικό επίπεδο
 
Για τη δημιουργία των πινακίδων σχεδίασης για ένα θεματικό επίπεδο, χρησιμοποιείται το GeoWebCache το οποίο είναι ενσωματωμένο στον GeoServer. Επιλέγεται το μενού Tile Caching>Tile Layers και εμφανίζεται ο κατάλογος των δημοσιοποιημένων θεματικών επιπέδων. Αν επιλεγεί ένα από τα επίπεδα, στο νέο παράθυρο Edit Layer>Tile Caching εμφανίζονται οι παράμετροι δημιουργίας των πινακίδων που δημιουργούνται όταν ο χάρτης ζητηθεί από τον χρήστη (on demand). Για τη δημιουργία των πινακίδων και την αποθήκευσή τους στον εξυπηρετητή, από την οθόνη Tile Layers επιλέγεται ένα θεματικό επίπεδο και η επιλογή Seed/Truncate. Στο νέο παράθυρο Create a new task (Εικόνα 12.23), συμπληρώνονται τα ακόλουθα: το είδος της εργασίας Type of operation π.χ. Seed (δημιουργεί πινακίδες χωρίς να σβήνει τις υπάρχουσες), Reseed (δημιουργεί πινακίδες και σβήνει τις υπάρχουσες), Truncate (σβήνει τις υπάρχουσες πινακίδες), το ΣΑΣ Grid Set π.χ. EPSG:4326, EPSG:900913, ο μορφότυπος των εικόνων των πινακίδων Format π.χ. image/gif (GIF), image/jpeg (JPEG), image/png (24 bit PNG), image/png8 (8 bit PNG) κ.ά., το μικρότερο Zoom start και το μεγαλύτερο Zoom stop επίπεδο μεγέθυνσης και τέλος το εύρος της περιοχής Bounding box για το οποίο θα δημιουργηθούν πινακίδες. Το εύρος της περιοχής μπορεί να είναι μικρότερο της περιοχής την οποία καλύπτουν τα δεδομένα. Η διαδικασία ολοκληρώνεται με το πλήκτρο Submit. Η διαδικασία δημιουργίας των πινακίδων ξεκινάει και ολοκληρώνεται μετά από λίγο ανάλογα με την υπολογιστική ισχύ του συστήματος Η/Υ. Σε τακτά χρονικά διαστήματα διαπιστώνεται η πρόοδος της διαδικασίας από το Refresh List (Εικόνα 12.24).
Για την προεπισκόπηση της σχεδίασης του χάρτη με χρήση των πινακίδων, επιλέγεται το μενού Tile Caching>Tile Layers. Στη νέα οθόνη με τον κατάλογο των θεματικών επιπέδων επιλέγεται ένα από αυτά. Δίπλα από το θεματικό επίπεδο επιλέγεται Preview και ο συνδυασμός του ΣΑΣ και του μορφότυπου της εικόνας π.χ. EPSG:900913 / png. Η σχεδίαση του χάρτη είναι ταχύτερη και η ονοματολογία δεν αλλάζει θέση, όπως συμβαίνει όταν ο χάρτης σχεδιάζεται από το Layer Preview όπου κάθε πινακίδα σχεδιάζεται κατόπιν απαίτησης του χρήστη.
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Εικόνα 12.23 Δημιουργία πινακίδων προς αποθήκευση στον εξυπηρετητή.
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Εικόνα 12.24 Παρακολούθηση διαδικασίας δημιουργίας πινακίδων.
12.2.10 Εξοικείωση με αιτήματα βάσει των προτύπων του OGC
 
Από το περιβάλλον του Geoserver, ο χρήστης μπορεί να εξοικειωθεί με αιτήματα βάσει των προτύπων του OGC. Από το μενού επιλέγεται Demos>Demos requests. Στο νέο παράθυρο (Εικόνα 12.25), ο χρήστης μπορεί να επιλέξει ένα από τη λίστα των αιτημάτων και να δει το αποτέλεσμα, να το τροποποιήσει ή να συντάξει νέο.
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Εικόνα 12.25 Παραδείγματα αιτημάτων των προτύπων της OGC.
12.3 Δημοσιοποίηση χαρτών και χαρτογραφικών δεδομένων με το ΑrcGIS
 
Το ΣΓΠ ArcGIS προσφέρει τη δυνατότητα δημοσιοποίησης ενός χάρτη ή γεωχωρικών δεδομένων μέσω του εξυπηρετητή ArcGIS Online ή ενός εξυπηρετητή ArcGIS Server βάσει των προτύπων WMS και WFS. Η χρήση των υπηρεσιών τις οποίες προσφέρει ο εξυπηρετητής ArcGIS Online, πλεονεκτεί στο ότι δεν απαιτεί την εγκατάσταση λογισμικού εξυπηρετητή και την οργάνωση των υπηρεσιών, αλλά υστερεί σε δυνατότητες. Οι υπηρεσίες του λειτουργούν σε ένα περιβάλλον υπολογιστικού νέφους (cloud) το οποίο ελέγχεται από την ESRI. Η πρόσβαση στις υπηρεσίες του ArcGIS Online παρέχεται μέσω συνδρομών. Σε υψηλών απαιτήσεων εφαρμογές θα πρέπει να χρησιμοποιείται ο εξυπηρετητής ArcGIS Server που εγκαθίσταται σε έναν Η/Υ εξυπηρετητή. Στη συνέχεια, παρουσιάζονται ορισμένα βασικά εργαλεία που μπορούν να αξιοποιηθούν για τη δημοσιοποίηση χαρτών και χαρτογραφικών δεδομένων με το ArcGIS (“ArcGIS Help 10.2”, χ.η.; Τσούλος, Σκοπελίτη & Στάμου, 2015α; Τσούλος, Σκοπελίτη & Στάμου, 2015β). 
12.3.1 Δημοσιοποίηση χάρτη σε πινακίδες
 
Μια χαρτοσύνθεση για το διαδίκτυο, η οποία έχει σχεδιαστεί στο περιβάλλον του ArcMap, μπορεί να δημοσιοποιηθεί με βάση την τεχνική διάχυσης χαρτών με πινακίδες. Προαπαιτούμενα είναι η σύνδεση στο διαδίκτυο και η πρόσβαση σε έναν εξυπηρετητή ο οποίος συνεργάζεται με το ArcGIS όπως ο ArcGIS Server ή το ArcGIS Online. 
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Εικόνα 12.26 Δημοσιοποίηση χάρτη σε πινακίδες από το περιβάλλον του ArcMap.
Από το περιβάλλον του ArcMap, ενεργοποιείται η προς δημοσιοποίηση χαρτοσύνθεση από το μενού File>Open και επιλέγεται το περιβάλλον Data View. Για να υλοποιηθεί η σύνδεση στο ArcGIS Online, από το μενού επιλέγεται File>Sign In και εισάγονται τα στοιχεία διαπίστευσης. Από το μενού επιλέγεται File>Share As και στο νέο παράθυρο Share As Service η επιλογή Publish a service και το πλήκτρο Next (Εικόνα 12.26). Στο νέο παράθυρο, Publish a Service, επιλέγεται Choose a connection>My Hosted Services για να επιτευχθεί η σύνδεση με το ArcGIS Online ή Connect to ArcGIS Server [image: ] για να επιτευχθεί η σύνδεση με κάποιον ArcGIS Server. Επιπλέον, ορίζεται ένα όνομα Service Name για την υπηρεσία που θα δημιουργηθεί π.χ. Ikaria. Με το πλήκτρο Continue γίνεται η μετάβαση στο παράθυρο του Service Editor.Στο παράθυρο του Service Editor ορίζονται οι ιδιότητες της διαδικτυακής υπηρεσίας και διαμορφώνονται οι επιτρεπόμενες ενέργειες των χρηστών. Από το παράθυρο Service Editor και την καρτέλα Capabilities, επιλέγεται Tiled Mapping για την υπηρεσία WMST. Στο παράθυρο Service Editor (Εικόνα 12.27) και την καρτέλα Caching, ενεργοποιείται η επιλογή Tiling scheme>ArcGIS Online, Bing Maps, Google Maps. Βάσει της επιλογής αυτής, οι κλίμακες στις οποίες θα σχεδιάζεται ο χάρτης ακολουθούν το σύνηθες πρότυπο των διαδικτυακών χαρτογραφικών υπηρεσιών. Επιπλέον, μπορεί να επιλεγεί ένα υποσύνολο των κλιμάκων που προτείνονται. Για να δημιουργηθεί ένας διαφορετικός κατάλογος κλιμάκων από τον χρήστη, επιλέγεται Tiling scheme>Suggest και ορίζεται το πλήθος των κλιμάκων. Στη συνέχεια, από την επιλογή Caching>Advanced Settings (Εικόνα 12.27) μπορούν να αφαιρεθούν ή να προστεθούν νέες κλίμακες με τα πλήκτρα Add και Delete. Στο παράθυρο Service Editor και την καρτέλα Item Description, δηλώνεται μια περίληψη Summary, οι λέξεις κλειδιά Tags για την υπηρεσία και μια εκτενέστερη περιγραφή Description (Εικόνα 12.28). Τέλος, στο παράθυρο Service Editor και την καρτέλα Sharing επιλέγεται ποιος θα έχει πρόσβαση σε αυτήν την υπηρεσία π.χ. κάθε χρήστης Everyone (public). 
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Εικόνα 12.27 Ορισμός των κλιμάκων σχεδίασης του χάρτη. 
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Εικόνα 12.28 Ορισμός των μεταδεδομένων του χάρτη και των ομάδων δημοσιοποιήσης.
Για την ολοκλήρωση της δημοσιοποίησης του χάρτη ως υπηρεσίας, από το παράθυρο Service Editor επιλέγεται [image: ]Analyze και ξεκινάει ο έλεγχος. Τα λάθη που εμφανίζονται στο παράθυρο Prepare (Εικόνα 12.29) πρέπει να διορθωθούν για να ολοκληρωθεί η διαδικασία. Από την επιλογή [image: ]Preview γίνεται προεπισκόπηση του χάρτη όπως θα δημοσιοποιηθεί στο διαδίκτυο. Με την επιλογή [image: ]Publish ολοκληρώνεται η διαδικασία. Στο σημείο αυτό τα δεδομένα μεταφέρονται στον εξυπηρετητή. 
Το μέγεθος των δεδομένων και η ταχύτητα της σύνδεσης καθορίζουν τη διάρκεια της διαδικασίας δημοσιοποίησης. Επιπλέον, χρειάζεται χρόνος για τη δόμηση των πινακίδων. Όταν η υπηρεσία δημοσιοποιηθεί, γίνεται ορατή στην καταχώριση My Hosted Services στο παράθυρο Catalog του ArcCatalog. Εκεί η υπηρεσία εμφανίζεται ως δυο ανεξάρτητα αντικείμενα: ως μια υπηρεσία χαρτών (Map Service) και ως ένας ορισμός της υπηρεσίας (Service Definition) που περιέχει ένα συμπιεσμένο αρχείο με τον χάρτη, τα δεδομένα και λεπτομέρειες για τον τρόπο με τον οποίο γίνεται η δημοσιοποίηση του χάρτη.
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Εικόνα 12.29 Τα λάθη που εντοπίζονται κατά την ανάλυση του χάρτη για τη δημοσιοποίηση του εμφανίζονται στο παράθυρο Prepare.
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Εικόνα 12.30 Δημοσιοποίηση χαρτογραφικών δεδομένων από το περιβάλλον του ArcMap με βάση το πρότυπο WFS.
12.3.2 Δημοσιοποίηση ενός θεματικού επιπέδου με βάση το πρότυπο WFS-Τ
 
H δυνατότητα διάδρασης με τα χαρτογραφικά δεδομένα μέσω των διαδικτυακών υπηρεσιών δίνεται με τη δημιουργία μιας υπηρεσίας WFS-Τ. Προαπαιτούμενα είναι η σύνδεση στο διαδίκτυο και η πρόσβαση σε έναν εξυπηρετητή που συνεργάζεται με το ArcGIS, όπως ο ArcGIS server ή το ArcGIS Online. 
Στο περιβάλλον του ArcMap προστίθεται το θεματικό επίπεδο από το μενού File>Add Data>Add Data και επιλέγεται το περιβάλλον Data View. Για να υλοποιηθεί η σύνδεση στο ArcGIS Online, από το μενού επιλέγεται File>Sign In και εισάγονται τα στοιχεία διαπίστευσης. Από το μενού επιλέγεται File>Share As και στο νέο παράθυρο Share As Service η επιλογή Publish a service και το πλήκτρο Next (Εικόνα 12.26). Στο νέο παράθυρο, Publish a Service επιλέγεται Choose a connection>My Hosted Services για να επιτευχθεί η σύνδεση με το ArcGIS Online ή Connect to ArcGIS Server [image: ] για να επιτευχθεί η σύνδεση με κάποιον ArcGIS Server. Επιπλέον, ορίζεται ένα όνομα Service Name για την υπηρεσία που θα δημιουργηθεί π.χ. Ikaria_edit. Με το πλήκτρο Continue γίνεται η μετάβαση στο παράθυρο του Service Editor. 
Στο παράθυρο Service Editor και την καρτέλα Capabilities επιλέγεται Feature Access για την υπηρεσία WFS (Εικόνα 12.30). Από την καρτέλα Feature Access καθορίζονται οι επιτρεπτές ενέργειες στα δεδομένα όπως δημιουργία (Create), διαγραφή (Delete), ερώτηση (Query), συγχρονισμός αλλαγών (Sync) και ενημέρωση ιδιοτήτων (Update). Στο παράθυρο Service Editor και την καρτέλα Item Description δηλώνεται μια περίληψη Summary, οι λέξεις κλειδιά Tags για την υπηρεσία και μια εκτενέστερη περιγραφή Description. Από το παράθυρο Service Editor και την καρτέλα Sharing επιλέγεται ποιος θα έχει πρόσβαση σε αυτήν την υπηρεσία π.χ. με κάθε χρήστη Everyone (public) (Εικόνα 12.28). Τέλος, από το παράθυρο Service Editor, επιλέγεται [image: ]Analyze και ξεκινάει ο έλεγχος για τη δημοσίευση των δεδομένων. Τα λάθη που εμφανίζονται στο παράθυρο Prepare πρέπει να διορθωθούν για να ολοκληρωθεί η διαδικασία. Από την επιλογή [image: ]Preview γίνεται προεπισκόπηση των δεδομένων όπως θα δημοσιοποιηθούν στο διαδίκτυο. Με την επιλογή [image: ]Publish ολοκληρώνεται η διαδικασία.
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Κριτήρια αξιολόγησης 
Στη συνέχεια ακολουθούν μια σειρά από κριτήρια αξιολόγησης με τη μορφή ερωτήσεων των οποίων οι απαντήσεις βρίσκονται εντός του κειμένου του κεφαλαίου. 
 
Κριτήριο αξιολόγησης 1 
Τι επιτυγχάνεται με το πρότυπο WMS;
 
Κριτήριο αξιολόγησης 2 
Τι επιτυγχάνεται με το πρότυπο WFS;
Κριτήριο αξιολόγησης 3
Τι είδους μορφότυπους δεδομένων μπορεί να δημοσιοποιήσει ο Geoserver;
 
Κριτήριο αξιολόγησης 4
Τι επιτυγχάνεται με το αίτημα GetDescription του πρότυπου WFS/WMS;
 
Κριτήριο αξιολόγησης 5
Με ποιο αίτημα του πρότυπου WMS ζητείται ένα δημοσιοποιημένο θεματικό επίπεδο ή χάρτης από τον εξυπηρετητή σε μορφή εικόνας; Ποιες παράμετροι διαμορφώνουν αυτό το αίτημα;
Κριτήριο αξιολόγησης 6
Σε ποιες περιπτώσεις προτείνεται η αξιοποίηση του προτύπου WMS και σε ποιες το πρότυπο WFS; Περιγράψτε μια περίπτωση συνδυασμού.
 
Κριτήριο αξιολόγησης 7
Ποια τεχνολογία αξιοποιεί το πρότυπο WMTS; Ποια η διαφορά από το WMS και ποια τα πλεονεκτήματά του;
Κεφάλαιο 13 
Σύνθεση χάρτη για το διαδίκτυο
Σύνοψη 
Tο κεφάλαιο αυτό ασχολείται με τη μεθοδολογία σύνθεσης χάρτη για το διαδίκτυο. Παρουσιάζονται οι παράγοντες που επηρεάζουν το αποτέλεσμα της σύνθεσης καθώς και μια σειρά καλών πρακτικών για την υλοποίηση της χαρτοσύνθεσης. Στο πλαίσιο αυτό, παρέχεται μια συνοπτική περιγραφή του προτύπου Styled Layer Descriptor (SLD) του OGC που χρησιμοποιείται για την περιγραφή του συμβολισμού. Παρουσιάζεται η διαδικασία δημιουργίας του συμβολισμού για ένα θεματικό επίπεδο με το ΣΓΠ QGIS και η αποθήκευσή του σε αρχεία βάσει του προτύπου SLD της OGC. Επιπλέον, περιγράφεται η ενσωμάτωσή τους στον Geoserver και η δημιουργία Style, η σύνδεση του συμβολισμού με ένα δημοσιοποιημένο θεματικό επίπεδο και η δημιουργία του χάρτη ως σύνολο θεματικών επιπέδων. 
 
Προαπαιτούμενη γνώση
Γενική γνώση για τα πρότυπα δημοσιοποίησης των χαρτών και των χαρτογραφικών δεδομένων στο διαδίκτυο (βλ. Κεφάλαιο 12) και τη χαρτογραφική σύνθεση (βλ. Κεφάλαιο 10).
13. Χάρτης και διαδίκτυο
 
Η εξάπλωση της χρήσης του διαδικτύου στην κοινωνία έδωσε τεράστια ώθηση στη διάδοση των χαρτών. Καθημερινά ο μέσος χρήστης έρχεται σε επαφή με χάρτες και γεωχωρική πληροφορία μέσα από τις ιστοσελίδες που επισκέπτεται. Παράλληλα, η σύνταξη χαρτών για το διαδίκτυο είναι δυνατή από κάθε χρήστη του διαδικτύου. Η χαρτογραφία πέρασε από τα χέρια των πεπειραμένων χαρτογράφων και των γεωεπιστημόνων στον μη εξειδικευμένο συντάκτη (Tsou, 2011). Η κοινωνία των χρηστών και των συντακτών του χάρτη διευρύνθηκε θεαματικά, αλλά οι μη εκπαιδευμένοι συντάκτες  δεν ακολουθούν τις χαρτογραφικές αρχές και ορθές πρακτικές. Η κατάσταση αυτή έχει αποτέλεσμα,  σφάλματα στην επεξεργασία, ανάλυση και απόδοση των χαρτογραφικών δεδομένων. Η ορθή σχεδίαση ενός χάρτη είναι σημαντική καθώς ο χάρτης πρέπει να σχεδιάζεται με βάση τις αρχές της Χαρτογραφίας, να διαβάζεται με μια ματιά και να περιέχει αξιόπιστες πληροφορίες τις οποίες ο χρήστης εμπιστεύεται και ανακαλεί με ευκολία (Jenny, Jenny & Räber, 2008). Οι βασικές αρχές σχεδίασης των παραδοσιακών χαρτών εφαρμόζονται και στη σχεδίαση των χαρτών για το διαδίκτυο. Όμως, η σχεδίαση χαρτών για το διαδίκτυο δεσμεύεται από παράγοντες όπως τα εγγενή χαρακτηριστικά του διαδικτύου ως μέσου, το λογισμικό, την απόδοση στην οθόνη κ.ά. Ακόμα και οι έμπειροι χαρτογράφοι πρέπει να προσαρμοστούν στις συνθήκες που επιβάλλει το διαδίκτυο (Van den Worm, 2001) και να κατανοήσουν τους περιορισμούς αλλά και τις αυξημένες λειτουργίες των διαδικτυακών χαρτών όπως είναι η διαδραστικότητα.
13.1 Παράγοντες που επηρεάζουν τη σχεδίαση χαρτών για το διαδίκτυο
 
Κατά τον σχεδιασμό ενός χάρτη προς δημοσιοποίηση στο διαδίκτυο, εκτός από την εφαρμογή των ορθών χαρτογραφικών πρακτικών (βλ. Κεφάλαιο 10), πρέπει να λαμβάνεται ιδιαίτερη μέριμνα για τους παράγοντες που επηρεάζουν το τελικό αποτέλεσμα, οι οποίοι αναλύονται στη συνέχεια.
13.1.1 Λογισμικό
 
Ο εξυπηρετητής για τη δημοσιοποίηση του χάρτη π.χ. Geoserver, Mapserver, ArcGIS Server (βλ. Κεφάλαιο 12) επιλέγεται ώστε να εξασφαλίζεται η πρόσβαση σε όσο το δυνατό περισσότερους χρήστες, π.χ. συμβατότητα με διαφορετικούς φυλλομετρητές, απουσία αναγκαιότητας για πρόσθετα στοιχεία (plug-ins), προσαρμοστικότητα σε διαφορετικές συσκευές κ.ά. (Jenny et al., 2008). Παράλληλα, για τη σύνταξη της χαρτογραφικής εφαρμογής πρέπει να επιλέγεται λογισμικό (π.χ. Open Layers, Leaflet κ.ά.) που υπηρετεί τις ανάγκες της εφαρμογής και εξασφαλίζει πρόσθετες λειτουργίες, όπως η δυνατότητα διαμόρφωσης φιλικού περιβάλλοντος διεπικοινωνίας, η διαδραστική συμμετοχή του χρήστη και διαδραστικά εργαλεία απόδοσης. Εκτός από την παρουσίαση του χάρτη, τα συνήθη εργαλεία περιλαμβάνουν την πλοήγηση, την αλλαγή της κλίμακας με παράλληλη προσαρμογή του περιεχομένου και του συμβολισμού του χάρτη, την επιλογή θεματικών επιπέδων, την παρουσίαση των περιγραφικών χαρακτηριστικών με διαφορετικό τρόπο (π.χ. γράφημα, κείμενο), την προσαρμογή της απόδοσης στις ανάγκες του χρήστη (π.χ. νέο σύμβολο, όρια ομαδοποίησης σε ένα χωροπληθή χάρτη), λειτουργίες χωρικής ανάλυσης (π.χ. προσδιορισμός ζώνης επιρροής), λειτουργίες χαρτομετρίας (π.χ. μέτρηση αποστάσεων, χάραξη μηκοτομής), λειτουργίες διαχείρισης γεωγραφικής πληροφορίας (π.χ. ενημέρωση γεωμετρίας και ιδιοτήτων, αλλαγή προβολής), τη χρήση πολυμέσων, τη δυναμική απόδοση (π.χ. χρονική αλλαγή), το διαδραστικό υπόμνημα, τον χάρτη ευρετήριο (ώστε ο χρήστης να έχει μια συνοπτική εικόνα της περιοχής που καλύπτει ο χάρτης) κ.ά.
Το περιβάλλον διεπιφάνειας πρέπει να είναι φιλικό και γνώριμο στον χρήστη από άλλες διαδικτυακές εφαρμογές π.χ. υπογραμμισμένοι υπερσύνδεσμοι (hyperlinks), διαδραστικά εργαλεία τα οποία συνδέονται με τη χρήση του ποντικού σε συγκεκριμένες θέσεις (π.χ. mouse over effect, click effect ), κουμπιά, μπάρες. 	Για να συμπεριληφθούν τα στοιχεία που αποδίδονται σε έναν έντυπο χάρτη σε ένα χάρτη οθόνης, θα πρέπει ο χάρτης να διαθέτει διαδραστικά στοιχεία. Τα διαδραστικά στοιχεία εντοπίζονται πιο γρήγορα από τον χρήστη όταν τοποθετούνται εντός του χάρτη, καθώς ο χάρτης είναι ήδη το κέντρο του ενδιαφέροντος. Η επιτυχής λειτουργία κάθε διαδραστικού χάρτη θα πρέπει να ελέγχεται τουλάχιστον από ένα μικρό σύνολο χρηστών, ώστε να επιβεβαιώνεται η λειτουργικότητα της επιλεγμένης σχεδίασης. Όταν ο χρήστης έχει  δυνατότητα συμμετοχής στη διαμόρφωση του χαρτογραφικού αποτελέσματος, πρέπει να κατευθύνεται και να προστατεύεται από επιλογές που ενδέχεται να οδηγήσουν σε απρόβλεπτο αποτέλεσμα. 
13.1.2 Το διαδίκτυο
 
Το διαδίκτυο ως μέσο μετάδοσης της χαρτογραφικής πληροφορίας έχει πολλά ιδιαίτερα χαρακτηριστικά, τα οποία πρέπει να ληφθούν υπόψη κατά τον σχεδιασμό του χάρτη. Καθώς η ταχύτητα μετάδοσης στο διαδίκτυο ποικίλει και ο χρήστης δεν διαθέτει πάντα τον απαιτούμενο χρόνο για την εμφάνιση του χάρτη, ο χαρτογράφος αναγκάζεται να συμβιβαστεί μεταξύ μιας αποδεκτής ποιότητας και της περιορισμένης ταχύτητας μετάδοσης (Jenny et al., 2008). Το μέγεθος του αρχείου των χαρτογραφικών δεδομένων περιορίζει την ολοκλήρωση της μεταφοράς και επομένως καθορίζει το περιεχόμενο του χάρτη. Η συνεχώς αυξανόμενη ταχύτητα των διαδικτυακών υποδομών που προσφέρονται πλέον ευρύτατα και τεχνικές όπως η μετάδοση του χάρτη σε πινακίδες, βελτιώνουν τη σημερινή κατάσταση.
Ο χάρτης σχεδιάζεται με σκοπό να εξασφαλίζει επικοινωνία με κάθε χρήστη. Λόγω του διαδικτύου το κοινό του χάρτη είναι απρόβλεπτο και ποικίλει, καθώς είναι αδύνατο να προβλεφθεί ποιος θα διαβάσει τον χάρτη, για ποιο σκοπό (π.χ. πληροφόρηση, πλοήγηση κ.ά.) και πόσο χρόνο θα διαθέσει. Όλοι οι χρήστες πρέπει να μπορούν να αντιλαμβάνονται, να κατανοούν, να πλοηγούνται και να έχουν αμφίδρομη επικοινωνία με τον χάρτη όπως και με τον υπόλοιπο παγκόσμιο ιστό (Kraak, 2001). Επιπλέον, πέρα από τον παραδοσιακό του ρόλο, ο χάρτης στο διαδίκτυο δρα και ως διεπιφάνεια σύνδεσης ή ευρετήριο με άλλα δεδομένα. Παράλληλα, το περιβάλλον θέασης του χάρτη όπως η συσκευή (π.χ. H/Y, laptop, tablet, smartphone κ.ά.), ο φυλλομετρητής, η οθόνη (μέγεθος, ανάλυση κ.ά.), το φυσικό περιβάλλον (π.χ. φωτισμός) δεν είναι προβλέψιμα χαρακτηριστικά.
13.1.3 Η οθόνη
 
Οι χάρτες που δημοσιοποιούνται μέσω του διαδικτύου χρησιμοποιούν την οθόνη ως μέσο απόδοσης με αποτέλεσμα να υιοθετούν και όλους τους περιορισμούς που αυτή θέτει (Jenny et al., 2008; Stopper, Wiesmann & Schnabel, 2012; Van den Worm, 2001). Η ανάλυση της οθόνης (μετριέται σε dpi – dots per inch) καθορίζει τον βαθμό απόδοσης λεπτομερειών που είναι ορατές στην οθόνη και εξαρτάται από το μέγεθος του εικονοστοιχείου (pixel). Ο βαθμός απόδοσης λεπτομερειών στην οθόνη, είναι διαφορετικός από αυτόν του χαρτιού στο οποίο παραδοσιακά εργάζεται ο χαρτογράφος. Για παράδειγμα, το ελάχιστο μέγεθος γραμμής για έντυπους χάρτες αντιστοιχεί σε 0.1mm (Εικόνα 13.1), ενώ για συνήθη ανάλυση οθόνης το εικονοστοιχείο έχει μέγεθος της τάξης των 0.26 mm. Κατά συνέπεια το εικονοστοιχείο είναι μεγαλύτερο από το μικρότερο μέγεθος (0.17mm) που μπορεί να διακρίνει το ανθρώπινο μάτι στη οθόνη (Εικόνα 13.1).
Εκτός από την ανάλυση, το μέγεθος της οθόνης είναι περιορισμένο και ως εκ τούτου δεσμευτικό. Επιπλέον, η διατιθέμενη επιφάνεια απόδοσης μειώνεται λόγω των περιφερειακών στοιχείων στο παράθυρο του φυλλομετρητή π.χ. γραμμή διεύθυνσης ιστοσελίδας, μενού, γραμμή κατάστασης (status bar) κ.ά. Η μείωση του μεγέθους του χάρτη έχει συνέπειες στη σύνθεση και τη σύνταξη (π.χ. γενίκευση, συμβολισμός κ.ά.). Παράλληλα, λόγω της διαφορετικής ανάλυσης και του μεγέθους κάθε οθόνης δεν είναι δυνατό να προβλεφθεί η κλίμακα στην οποία θα αποδοθεί ο χάρτης, με αποτέλεσμα ο χάρτης να πρέπει να προσαρμόζεται σε διαφορετικές κλίμακες.
Για τη βελτίωση της ευκρίνειας της οθόνης λόγω του μεγέθους του εικονοστοιχείου χρησιμοποιείται η τεχνική της εξομάλυνσης (anti-aliasing). Η τεχνική αυτή επιτρέπει τη σχεδίαση γραμμών με ανάλυση μικρότερη από αυτήν της οθόνης και προσθέτει μεγαλύτερο ρεαλισμό στην ψηφιακή εικόνα διορθώνοντας τις «πριονωτές» γραμμές. Οι αλγόριθμοι αυτής της τεχνικής διαφέρουν σε κάθε πρόγραμμα δημοσιοποίησης του χάρτη και ο χαρτογράφος θα πρέπει να τους αξιολογεί. Η τεχνική χρησιμοποιείται από τον εξυπηρετητή κατά τη μετατροπή του χάρτη με διανυσματικά δεδομένα σε κανονικοποιημένα αρχεία π.χ. JPEG.
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Εικόνα 13.1 Το ανθρώπινο μάτι και τα ελάχιστα μεγέθη για τον έντυπο χάρτη και τον χάρτη οθόνης.
 
 
13.1.3.1 Συμβολισμός
 
Για να είναι ο χάρτης ευκρινής, τα ελάχιστα μεγέθη και οι αποστάσεις ανάμεσα στα σύμβολα πρέπει να προσαρμοστούν στους περιορισμούς που θέτει η ανάλυση της εικόνας και η τεχνική εξομάλυνσης (Jenny et al., 2008; Stopper et al., 2012; Van den Worm, 2001). Τα σύμβολα πρέπει να είναι απλά και να αναγνωρίζονται εύκολα. Προτείνεται η χρήση τυποποιημένων συμβόλων όπου αυτό είναι δυνατό. Τα πάχη των γραμμών, τα ελάχιστα μεγέθη των σημειακών συμβόλων και οι ελάχιστες αποστάσεις ανάμεσα στα γραφικά στοιχεία πρέπει να είναι μεγαλύτερα από αυτά που εφαρμόζονται στους έντυπους χάρτες (περίπου διπλάσια). Τα εικονογραφικά σύμβολα και οι διακεκομμένες γραμμές δεν είναι ιδιαίτερα ευκρινή. 
13.1.3.2 Γενίκευση
 
Ιδιαίτερη προσοχή πρέπει να δοθεί στη γενίκευση των χαρτών για το διαδίκτυο (Jenny et al., 2008; Stopper et al., 2012; Van den Worm, 2001). Η πυκνότητα πληροφορίας πρέπει να μειωθεί σε σχέση με αυτήν του αντίστοιχου έντυπου χάρτη κατά 2 ή 3 φορές δηλαδή η σχεδίαση ενός έντυπου χάρτη στην οθόνη απαιτεί μεγέθυνση κατά 2.5 – 3 φορές (Jenny et al., 2008). Αυτό οφείλεται στην αυξημένη απόσταση ανάγνωσης, στη χαμηλή ανάλυση της οθόνης και στην τεχνική εξομάλυνσης. Η εφαρμογή της εξομάλυνσης απαιτεί την ύπαρξη επιπλέον χώρου κατά μήκος των ακμών των αντικειμένων για τη σχεδίαση της ομαλής μετάβασης ανάμεσα σε δύο χρώματα. Ο έντυπος χάρτης δεν μπορεί να χρησιμοποιηθεί ως έχει για παρουσίαση στην οθόνη, αλλά αποτελεί αφετηρία για τη σχεδίαση ενός νέου χάρτη για το διαδίκτυο. Η πληροφορία που αφαιρείται λόγω της γενίκευσης μπορεί να προστεθεί με άλλο τρόπο παρουσίασης μέσω συνδέσμων και να καλυφθεί με χρήση της διαδραστικότητας. Παράλληλα, καθώς ο χάρτης είναι δυναμικός και η κλίμακά του μεταβάλλεται, πρέπει να προσαρμόζεται στην εκάστοτε κλίμακα με την εφαρμογή της γενίκευσης ή/και την αλλαγή του συμβολισμού. Αν και οι διαδικτυακοί χάρτες δεν έχουν συγκεκριμένη κλίμακα για κάθε χάρτη υπάρχει μια ιδεατή κλίμακα ή ένα εύρος κλιμάκων. Πρόκειται για εκείνη την κλίμακα που έχει επιλέξει ο χαρτογράφος και καθορίζει την ακρίβεια και το περιεχόμενο του χάρτη. Για τη διαχείριση της γενίκευσης προτείνεται η χρήση ορίων κλίμακας και χαρτογραφικών κανόνων (Iosifescu-Enescu, Hugentobler & Hurni, 2009) για την απόδοση των θεματικών επιπέδων, η αλλαγή του συμβολισμού όπου αυτό είναι απαραίτητο και η χρήση γενίκευσης σε πραγματικό χρόνο ή η σύνδεση με βάσεις δεδομένων πολλαπλών κλιμάκων.
 
13.1.3.3 Ονοματολογία
 
Η επιλογή κατάλληλων γραμματοσειρών για την αναγραφή της ονοματολογίας είναι μια σύνθετη διαδικασία που ισορροπεί ανάμεσα σε αντικρουόμενα κριτήρια (Jenny et al., 2008; Stopper et al., 2012; Van den Worm, 2001). Μόνο ένας περιορισμένος αριθμός γραμματοσειρών είναι κατάλληλες αλλά και διαθέσιμες σε όλα τα συστήματα. Η ευκρίνεια επηρεάζεται από τη γραμματοσειρά, από τον αλγόριθμο που κάνει τη μετατροπή από διανύσματα σε εικόνα (π.χ. φυλλομετρητής, λογισμικό δημοσιοποίησης, συσκευή), από την ανάλυση της οθόνης και από τον αλγόριθμο εξομάλυνσης. H χρήση της εξομάλυνσης βελτιώνει την ευκρίνεια χαρακτήρων μεγαλύτερων από 18 στιγμές (points). Για τις συνήθεις γραμματοσειρές προτείνεται ελάχιστο μέγεθος 12 στιγμές. Θα πρέπει να προτιμούνται απλοί χαρακτήρες με μεγάλα ανοίγματα (π.χ. Cisalpin, Frutiger) και μικρές απαιτήσεις σε χώρο ώστε να αποφεύγονται οι επικαλύψεις. Οι γραμματοσειρές Sans Serif είναι πιο ευανάγνωστες ειδικά για μεγέθη από 10 έως 16 στιγμές (Εικόνα 13.2). Κανονικά και έντονα (bold) γράμματα διαβάζονται καλύτερα από λεπτά και με μικρές αποστάσεις μεταξύ τους (condensed). Κατά τη χρήση χαρακτήρων με κλίση (italic), η απόσταση ανάμεσά τους πρέπει να αυξάνεται. Προτείνεται η χρήση συγκεκριμένων γραμματοσειρών όπως Verdana, Lucida, Frutiger, Stone Sans, Cisalpin, Myriad, Arial, Century Gothic, Georgia, Platino Linetype, Trebuschet κ.ά. (Jenny et al., 2008; Buckley, 2012) (Εικόνα 13.2).
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Εικόνα 13.2 Προτεινόμενες γραμματοσειρές και μεγέθη για χρήση στο διαδίκτυο.
13.1.3.4 Διαχείριση χρώματος 
 
Όπως είναι γνωστό, τα χρώματα στην οθόνη διαφέρουν από αυτά του  έντυπου χάρτη λόγω της μεθόδου σχηματισμού τους στην οθόνη. Εκτός από τις χαρτογραφικές πρακτικές για τη διαχείριση του χρώματος (βλ. Κεφάλαιο 11), ο χρήστης πρέπει να γνωρίζει ότι η τελική εικόνα των χρωμάτων ενός χάρτη επηρεάζεται από παράγοντες όπως ο αριθμός των χρωμάτων που μπορεί να αποδίδει μια οθόνη, το είδος της οθόνης, η ηλικία της, οι επιλογές (φωτεινότητα, αντίθεση κ.ά.), οι συνθήκες θέασης, η τιμή της διόρθωσης γ που χρησιμοποιεί το εκάστοτε λογισμικό, ο τρόπος απόδοσης των χρωμάτων από τον φυλλομετρητή, ο μορφότυπος της εικόνας κ.ά. (Jenny et al., 2008; Stopper et al., 2012; Van den Worm, 2001).
13.1.4 Οπτική ιεράρχηση 
 
Η οπτική ιεράρχηση των χαρτών για το διαδίκτυο, απαιτεί μεγαλύτερη προσοχή σε σχέση με τους παραδοσιακούς χάρτες. Ο χάρτης δεν αποτελεί το μοναδικό στοιχείο στο πεδίο θέασης του χρήστη αλλά μοιράζεται το ενδιαφέρον του χρήστη με τα υπόλοιπα στοιχεία της ιστοσελίδας. Επιπλέον, λόγω του δυναμικού χαρακτήρα του χάρτη, ενδέχεται να εναλλάσσονται διαφορετικά θεματικά επίπεδα σε ένα βασικό υπόβαθρο. Στον χάρτη του διαδικτύου διακρίνονται τρία βασικά επίπεδα (Van den Worm, 2001). Το πρώτο επίπεδο αφορά το κύριο θέμα του χάρτη και τα διαδραστικά αντικείμενα που συμπληρώνουν το κύριο θέμα. Το δεύτερο επίπεδο αφορά τις πληροφορίες του υποβάθρου αλλά και τα διαδραστικά αντικείμενα που συμπληρώνουν τις πληροφορίες υποβάθρου. Τέλος, το συμπληρωματικό επίπεδο περιλαμβάνει τις πληροφορίες περιθωρίου και συμπληρωματικά στοιχεία (π.χ. γραφήματα, εικόνες κ.ά.).
13.2 Πρότυπο SLD για τον χαρτογραφικό συμβολισμό
 
Για τη δημοσιοποίηση ενός χάρτη στο διαδίκτυο συνήθως χρησιμοποιείται το πρότυπο WMS. Κάθε εξυπηρετητής WMS μπορεί να αποδίδει χαρτογραφικά δεδομένα χρησιμοποιώντας χαρτογραφικά σύμβολα και στη συνέχεια να δημοσιοποιεί χάρτες (βλ. Κεφάλαιο 12). Τα χαρτογραφικά σύμβολα που χρησιμοποιούνται δεν συνυπάρχουν με τα χαρτογραφικά δεδομένα αλλά περιγράφονται με χρήση ειδικής κωδικοποίησης. Ο χαρτογραφικός συμβολισμός περιγράφεται μέσω του προτύπου του Styled Layer Descriptor (SLD). Πρόκειται για μια γλώσσα επισήμανσης (markup language) που βασίζεται στην XML και αποτελεί πρότυπο του OGC (http://www.opengeospatial.org/standards/sld). Κάθε αρχείο SLD που περιγράφει τον συμβολισμό συσχετίζεται με ένα δημοσιοποιημένο θεματικό επίπεδό π.χ. Layer του Geoserver.
Ένα αρχείο SLD αποτελεί ουσιαστικά ένα αρχείο XML που περιέχει συγκεκριμένα στοιχεία (elements) και τις ιδιότητές τους βάσει του προτύπου. Ορισμένες ετικέτες (tags) στο αρχείο SLD εμφανίζονται με ένα πρόθεμα π.χ. ogc:, το οποίο δείχνει το XML namespace στο οποίο ανήκουν. Το αρχείο SLD ακολουθεί ιεραρχική δομή. Το πρώτο τμήμα (header) περιέχει μεταδεδομένα για τα XML namespaces και είναι συνήθως το ίδιο για διαφορετικά αρχεία SLD. Το πρώτο στοιχείο (root element) ενός αρχείου SLD είναι το StyledLayerDescriptor. Περιέχει τα στοιχεία Layer και Style που περιγράφουν το θεματικό επίπεδο και τον συμβολισμό. Το στοιχείο Style περιέχει τα στοιχεία Rule και Filter που περιγράφουν ποια στοιχεία θα αποδοθούν με τον συγκεκριμένο συμβολισμό και σε ποια κλίμακα. Το στοιχείο Rule περιέχει το στοιχείο Symbolizer που καλύπτει τα διαφορετικά είδη γεωμετρίας και περιγράφει το σύμβολο που θα χρησιμοποιηθεί. Στη συνέχεια, περιγράφονται λεπτομερώς τα στοιχεία Rule, Filter και Symbolizer που διαχειρίζονται τον συμβολισμό.
13.2.1 Διαμόρφωση κανόνων επιλογής και απόδοσης χαρτογραφικών δεδομένων
 
Το στοιχείο Rule (http://docs.geoserver.org/stable/en/user/styling/sld-reference/rules.html) περιγράφει τον συμβολισμό των χαρτογραφικών δεδομένων βάσει κανόνων. Περιέχει το στοιχείο Filter το οποίο επιλέγει ορισμένες οντότητες από το θεματικό επίπεδο και τις συνδέει με ένα ή περισσότερα σύμβολα. Οι οντότητες για τις οποίες το φίλτρο επιλογής είναι αληθές, αποδίδονται χρησιμοποιώντας τα σύμβολα που ορίζει ο κανόνας. Ακόμα ορίζει την επιλογή ενός εύρους κλιμάκων για το οποίο εφαρμόζεται ένας συγκεκριμένος συμβολισμός, με αποτέλεσμα αφενός ο συμβολισμός να μεταβάλλεται ανάλογα με την κλίμακα και αφ’ ετέρου ένα θεματικό επίπεδο ή ορισμένες οντότητες αυτού να μην αποδίδονται καθόλου. Περιέχει το στοιχείο Name το οποίο ορίζει το όνομα, το στοιχείο Title το οποίο ορίζει τον τίτλο που εμφανίζεται στο υπόμνημα για τις οντότητες που επιλέχθηκαν, το στοιχείο Abstract το οποίο περιέχει μια περιληπτική περιγραφή και το στοιχείο Filter που ορίζει για ποιες οντότητες θα εφαρμοστεί ο κανόνας. Τα στοιχεία MinScaleDenominator και MaxScaleDenominator ορίζουν το εύρος των κλιμάκων για τις οποίες θα υλοποιείται η απόδοση. Στη συνέχεια, ανάλογα με τη γεωμετρία των δεδομένων χρησιμοποιείται το PointSymbolizer για την περιγραφή ενός σημειακού σύμβολου, το LineSymbolizer για την περιγραφή ενός γραμμικού σύμβολου, το PolygonSymbolizer για την περιγραφή ενός επιφανειακού σύμβολου, το TextSymbolizer για την περιγραφή της αναγραφής της ονοματολογίας και τέλος το RasterSymbolizer για την απόδοση των κανονικοποιημένων δεδομένων.
13.2.1.1 Τελεστές επιλογής
 
Το στοιχείο Filter (http://docs.geoserver.org/stable/en/user/styling/sld-reference/filters.html) είναι ο μηχανισμός του SLD για τον ορισμό των λογικών προτάσεων επιλογής. Χρησιμοποιείται εντός του στοιχείου Rule για να ορίσει ποια δεδομένα θα αποδοθούν με το σύμβολο που περιγράφεται στη συνέχεια. Η γλώσσα επιλογής που χρησιμοποιεί το SLD ακολουθεί το πρότυπο OGC Filter Encoding (http://www.opengeospatial.org/standards/filter) και βασίζεται σε διάφορους τελεστές επιλογής. Οι τελεστές σύγκρισης (comparison operators) χρησιμοποιούνται για να ορίσουν συνθήκες που αφορούν τις περιγραφικές ιδιότητες των χαρτογραφικών δεδομένων. Διατίθενται οι παρακάτω δυαδικοί τελεστές (binary operators): PropertyIsEqualTo, PropertyIsNotEqualTo, PropertyIsLessThan, PropertyIsLessThanOrEqualTo, PropertyIsGreaterThan, PropertyIsGreaterThanOrEqualTo. Η διατύπωση της πρότασης επιλογής περιέχει το πεδίο στο οποίο καταγράφεται μια περιγραφική ιδιότητα των χαρτογραφικών δεδομένων (PropertyName), έναν από τους παραπάνω τελεστές και μια τιμή αναφοράς (Literal). Οι χωρικοί τελεστές (spatial operators) χρησιμοποιούνται για να ορίσουν συνθήκες οι οποίες αφορούν τη γεωμετρία των χαρτογραφικών δεδομένων. Διατίθενται οι παρακάτω χωρικοί τελεστές που αφορούν την τοπολογία και βασίζονται στο πρότυπο OGC Simple Features: Intersects, Equals, Disjoint, Touches, Within, Overlaps, Crosses, Contains. Η διατύπωση της πρότασης επιλογής περιέχει το πεδίο όπου καταγράφεται η γεωμετρία (PropertyName), έναν από τους παραπάνω χωρικούς τελεστές και ένα άλλο χαρτογραφικό στοιχείο του οποίου η γεωμετρία περιγράφεται με το πρότυπο GML. Ακόμα υπάρχουν χωρικοί τελεστές οι οποίοι αφορούν τις αποστάσεις (distance operators) ανάμεσα στις οντότητες, όπως DWithin και Beyond. Τέλος, οι λογικοί τελεστές (logical operators) χρησιμοποιούνται για το συνδυασμό επιμέρους προτάσεων. Διατίθενται οι λογικοί συντελεστές And, Or και Not. Οι τελεστές And και Or συνδυάζουν δύο προτάσεις επιλογής ενώ ο τελεστής Not αφορά μια πρόταση.
13.2.2 Απόδοση σημειακών δεδομένων
 
Το στοιχείο PointSymbolizer (http://docs.geoserver.org/stable/en/user/styling/sld-reference/pointsymbolizer.html) χρησιμοποιείται για τον συμβολισμό των σημειακών χαρτογραφικών δεδομένων. Περιέχει το στοιχείο Graphic το οποίο ορίζει το σύμβολο με το στοιχείο ExternalGraphic ή το στοιχείο Mark. Η μορφή του συμβόλου διαμορφώνεται από το στοιχείο Opacity που ορίζει το ποσοστό διαφάνειας του συμβόλου λαμβάνοντας τιμές από 0 (πλήρης διαφάνεια) έως 1 (πλήρης αδιαφάνεια - προκαθορισμένη τιμή), το στοιχείο Size που ορίζει το μέγεθος του συμβόλου (αναφέρεται στο ύψος ενώ το πλάτος διαμορφώνεται ανάλογα ώστε να μην αλλοιώνεται η αναλογία των διαστάσεων) και το στοιχείο 	Rotation, που ορίζει την περιστροφή του συμβόλου γύρω από το κέντρο του και εκφράζεται σε μοίρες.
Το στοιχείο ExternalGraphic, χρησιμοποιείται για να εισάγει ένα εξωτερικό αρχείο εικόνας σε μορφότυπο PNG ή SVG με το σύμβολο που θα χρησιμοποιηθεί. Περιέχει το στοιχείο OnlineResource, όπου η ιδιότητα xlink:href ορίζει τη θέση του αρχείου μέσω μιας διεύθυνσης URL ή μιας τοπικής διαδρομής. Το στοιχείο Format ορίζει τον μορφότυπο MIME της εικόνας και υποστηρίζει τους συνηθισμένους μορφότυπους εικόνων για το διαδίκτυο όπως image/png, image/jpeg, image/gif, image/svg+xml.
Το στοιχείο Mark χρησιμοποιείται για τη χρήση ενός προκαθορισμένου διανυσματικού γεωμετρικού σχήματος που περιγράφεται με ένα τυποποιημένο όνομα (well-known name). Περιέχει το στοιχείο WellKnownName το οποίο ορίζει το τυποποιημένο όνομα του σχήματος π.χ. circle, triangle, star, cross ή x. Η μορφή του σχήματος αυτού καθορίζεται από το στοιχείο Fill που ορίζει το επιφανειακό σύμβολο του συμβόλου για τα κλειστά σχήματα και το στοιχείο Stroke που ορίζει πως θα σχεδιαστεί το γραμμικό περίγραμμα.
Παραδείγματα συμβολισμού των σημειακών χαρτογραφικών δεδομένων με τη χρήση του PointSymbolizer μπορούν να αναζητηθούν στο SLD Cookbook (http://docs.geoserver.org/stable/en/user/styling/sld-cookbook/points.html).
13.2.3 Απόδοση γραμμικών δεδομένων
 
Το στοιχείο LineSymbolizer (http://docs.geoserver.org/stable/en/user/styling/sld-reference/linesymbolizer.html) χρησιμοποιείται για τον συμβολισμό γραμμικών χαρτογραφικών δεδομένων. Περιέχει τo στοιχείo Stroke το οποίο περιγράφει το γραμμικό σύμβολο με τη βοήθεια τριών στοιχείων. Το GraphicFill σχεδιάζει κατά μήκος των εικονοστοιχείων της γραμμής ένα επαναλαμβανόμενο μοτίβο, το GraphicStroke σχεδιάζει κατά μήκος της γραμμής ένα επαναλαμβανόμενο γραμμικό μοτίβο και τέλος το στοιχείο CssParameter διαμορφώνει το σύμβολο π.χ. χρώμα, πάχος, ποσοστό διαφάνειας, διαχείριση διασταυρώσεων κ.ά. με βάση τα στοιχεία του προτύπου CSS (Cascading Style Sheets).
Παραδείγματα συμβολισμού γραμμικών χαρτογραφικών δεδομένων με τη χρήση του LineSymbolizer μπορούν να αναζητηθούν στο SLD Cookbook (http://docs.geoserver.org/stable/en/user/styling/sld-cookbook/lines.html).
13.2.4 Απόδοση επιφανειακών δεδομένων
 
Το στοιχείο PolygonSymbolizer (http://docs.geoserver.org/stable/en/user/styling/sld-reference/polygonsymbolizer.html) χρησιμοποιείται για τον συμβολισμό των πολυγωνικών χαρτογραφικών δεδομένων. Περιέχει το στοιχείο Fill το οποίο ορίζει το σύμβολο για το εσωτερικό του πολυγώνου. Το στοιχείο GraphicFill δημιουργεί ένα επαναλαμβανόμενο μοτίβο από μια γραφική εικόνα ή ένα σύμβολο, που ορίζεται με το στοιχείο Graphic. Το στοιχείο CssParameter περιγράφει τις παραμέτρους εφαρμογής ενός συμπαγούς χρώματος. Ακόμα περιέχει το στοιχείο Stroke που ορίζει το σύμβολο για το περίγραμμα των πολυγώνων.
Παραδείγματα συμβολισμού επιφανειακών χαρτογραφικών δεδομένων με τη χρήση του PolygonSymbolizer μπορούν να αναζητηθούν στο SLD Cookbook (http://docs.geoserver.org/stable/en/user/styling/sld-cookbook/polygons.html).
13.2.5 Απόδοση ονοματολογίας
 
Το στοιχείο TextSymbolizer (http://docs.geoserver.org/stable/en/user/styling/sld-reference/textsymbolizer.html) χρησιμοποιείται για τη διαμόρφωση της ονοματολογίας. Περιέχει το στοιχείο Label το οποίο ορίζει το κείμενο. Εάν το προς αναγραφή κείμενο υπάρχει στα δεδομένα, τότε χρησιμοποιείται το όνομα του πεδίου μέσω του PropertyName. Οι τιμές πολλών πεδίων μπορούν να συνδυαστούν και να διαμορφωθούν με την χρήση συναρτήσεων και φίλτρων. Η αναγραφή του κειμένου διαμορφώνεται με το στοιχείο Font που ορίζει τη γραμματοσειρά, ενώ μια σειρά από στοιχεία CssParameter ορίζουν τις λεπτομέρειες διαμόρφωσης των χαρακτήρων. Ακόμα περιέχει το στοιχείο Halo που δημιουργεί μια μάσκα, το στοιχείο Fill που ορίζει το γέμισμα, το στοιχείο Graphic που ορίζει ένα γραφικό σύμβολο το οποίο εμφανίζεται στο υπόβαθρο και τέλος το στοιχείο Priority που ορίζει τον βαθμό προτεραιότητας κατά την αντιμετώπιση προβλημάτων επικαλύψεων. Το στοιχείο LabelPlacement, ορίζει τη θέση του τοπωνυμίου σε σχέση με τη γεωμετρία με βάση δύο στοιχεία. Το στοιχείο PointPlacement αποδίδει το τοπωνύμιο μιας σημειακής οντότητας. Το στοιχείο LinePlacement αποδίδει το τοπωνύμιο κατά μήκος μιας γραμμικής οντότητας. Η θέση του κειμένου σε σχέση με τη θέση της χαρτογραφικής οντότητας ελέγχεται από ένα σύνολο επιπλέον στοιχείων.
Παραδείγματα απόδοσης τοπωνυμίων με τη χρήση του TextSymbolizer μπορούν να αναζητηθούν στο SLD Cookbook (http://docs.geoserver.org/stable/en/user/styling/sld-reference/labeling.html) και ειδικότερα για τις σημειακές χαρτογραφικές οντότητες (http://docs.geoserver.org/stable/en/user/styling/sld-cookbook/points.html), για τις γραμμικές χαρτογραφικές οντότητες (http://docs.geoserver.org/stable/en/user/styling/sld-reference/linesymbolizer.html) και για τις επιφανειακές χαρτογραφικές οντότητες (http://docs.geoserver.org/stable/en/user/styling/sld-reference/polygonsymbolizer.html).
13.2.6 Απόδοση κανονικοποιημένων δεδομένων
 
Το στοιχείο RasterSymbolizer (http://docs.geoserver.org/stable/en/user/styling/sld-reference/rastersymbolizer.html) χρησιμοποιείται για την απόδοση κανονικοποιημένων δεδομένων. Περιέχει τo στοιχείο Opacity που ορίζει τον βαθμό διαφάνειας, το στοιχείο ColorMap που ορίζει την παλέτα χρωμάτων με την οποία θα αποδοθούν τα εικονοστοιχεία π.χ. διαβάθμιση χρωμάτων, συγκεκριμένες αποχρώσεις κ.ά. Η παλέτα ορίζεται με μια σειρά από στοιχεία ColorMapEntry. Κάθε στοιχείο ColorMapEntry ορίζει ένα χρώμα και το αντιστοιχίζει με μια τιμή των εικονοστοιχείων. Το χρώμα περιγράφεται με τη δεκαεξαδική RGB δομή (#RRGGBB). Επίσης καθορίζεται ο βαθμός διαφάνειας με το στοιχείο Opacity και η ένδειξη του υπομνήματος με το στοιχείο label. Μια παλέτα μπορεί να έχει έως και 255 ColorMapEntry στοιχεία. 
Η ιδιότητα ColorMap type ορίζει το είδος του ColorMap ο οποίος θα χρησιμοποιηθεί. Η τιμή type="ramp" είναι η προεπιλεγμένη και ορίζει ότι τα χρώματα θα παρεμβληθούν για τις τιμές που βρίσκονται ανάμεσα σε αυτές που ορίζονται από τα ColorMapEntry. Η τιμή type="values" επιτρέπει την απόδοση μόνο των εικονοστοιχείων που έχουν τις τιμές που αναφέρονται. Η τιμή type="intervals" επιτρέπει την απόδοση ενός εύρους τιμών των εικονοστοιχείων, που ορίζεται με δύο τιμές (ελάχιστη τιμή – μέγιστη τιμή), χρησιμοποιώντας το χρώμα που αντιστοιχεί στην ελάχιστη τιμή χωρίς να πραγματοποιείται παρεμβολή ανάμεσα στα όρια. Η ιδιότητα extended ορίζει εάν η παλέτα των χρωμάτων χρησιμοποιεί χρώματα 256 (8-bit) ή 65536 (16-bit) colors. Η προεπιλεγμένη τιμή false ορίζει την 8-bit παλέτα ενώ η τιμή true τη 16-bit.
Παραδείγματα απόδοσης κανονικοποιημένων χαρτογραφικών δεδομένων με τη χρήση του RasterSymbolizer μπορούν να αναζητηθούν στο SLD Cookbook (http://docs.geoserver.org/stable/en/user/styling/sld-cookbook/rasters.html).
13.3 Καταγραφή του συμβολισμού με το πρότυπο SLD
13.3.1 Δημιουργία αρχείου συμβολισμού SLD με επεξεργαστή κειμένου
 
Η περιγραφή του συμβολισμού με το πρότυπο SLD εμπίπτει στη δημιουργία ενός κειμένου με βάση μια γλώσσα επισήμανσης. Για τον λόγο αυτό, προτείνεται η χρήση ενός εξειδικευμένου προγράμματος επεξεργασίας κειμένων για γλώσσες επισήμανσης π.χ. Notepad++ (https://notepad-plus-plus.org/), Geany (http://www.geany.org/).
13.3.2 Δημιουργία αρχείου συμβολισμού SLD με το QGIS
 
Όταν στο περιβάλλον του ΣΓΠ QGIS (“QGIS Training Manual”, χ.η.;“QGIS User Guide”, χ.η.) διαμορφωθεί ο συμβολισμός ενός θεματικού επιπέδου (βλ. Κεφάλαιο 10), μπορεί να αποθηκευτεί με βάση το πρότυπο SLD και να χρησιμοποιηθεί σε οποιοδήποτε περιβάλλον είναι συμβατό με αυτό. Η αποθήκευση γίνεται από το παράθυρο Layer Properties και την καρτέλα Στυλ με το πλήκτρο Save StyleΑρχείο SLD. Το αρχείο SLD μπορεί να χρησιμοποιηθεί ως έχει ή να επεξεργαστεί από τον χρήστη σε ένα πρόγραμμα επεξεργασίας κειμένου για γλώσσες επισήμανσης για να εξειδικευτεί περισσότερο. Σημειώνεται ότι η περιγραφή της απόδοσης της ονοματολογίας όπως ορίζεται στο QGIS δεν αποθηκεύεται στο αρχείο SLD, οπότε θα πρέπει να προστεθεί από τον χρήστη με επεξεργασία του αρχείου SLD.
13.4 Δημιουργία και δημοσιοποίηση χάρτη με τον Geoserver
 
Στη συνέχεια, παρουσιάζεται η διαδικασία της αποθήκευσης του συμβολισμού που έχει καταγραφεί σε ένα αρχείο SLD ως Style του Geoserver. Ακολουθεί η αντιστοίχιση του συμβολισμού Style με ένα θεματικό επίπεδο, η δημιουργία του χάρτη ως Layer Group και τέλος η σχεδίαση του υπομνήματος (Geoserver, 2015; Τσούλος, Αντωνίου, Σκοπελίτη & Στάμου, 2015). 
13.4.1 Αποθήκευση συμβολισμού ως Style
 
Για την απόδοση του συμβολισμού στα χαρτογραφικά δεδομένα, ο Geoserver χρησιμοποιεί τη προδιαγραφή SLD. Υλοποιεί το πρότυπο SLD 1.0.0 καθώς και ορισμένα τμήματα από τα πρότυπα SE 1.1.0 και WMS-SLD 1.1.0. Ο συμβολισμός εντός του Geoserver καταγράφεται ως ένα Style. Από την επιλογή Style του μενού του Geoserver (Εικόνα 13.3), εμφανίζονται όλα τα υπάρχοντα Styles του GeoServer. Με την επιλογή Add a new style δημιουργείται ένα νέο Style είτε από την αρχή είτε με την εισαγωγή ενός υπάρχοντος αρχείου SLD στον Geoserver. Στη νέα οθόνη, για την εισαγωγή ενός αρχείου SLD επιλέγεται Choose File και στη συνέχεια Upload. Το περιεχόμενο του αρχείου εμφανίζεται στο πλαίσιο του Editor όπου μπορούν να γίνουν ενημερώσεις ή διορθώσεις στο αρχείο SLD. Με την επιλογή Validate, ελέγχεται αν το περιεχόμενο είναι σύμφωνο με την προδιαγραφή SLD. Εάν πρόκειται για ένα ορθά δομημένο αρχείο, τότε στην κορυφή της σελίδας εμφανίζεται το μήνυμα No validation error, το οποίο ενημερώνει ότι δεν υπάρχουν σφάλματα. Στη συνέχεια, συμπληρώνονται το όνομα (Name) του Style και ο χώρος αποθήκευσης (Workspace). Με την επιλογή Submit αποθηκεύεται το συγκεκριμένο Style. Έκτοτε εμφανίζεται στον κατάλογο διαθέσιμων Styles του GeoServer (Εικόνα 13.4) και μπορεί να χρησιμοποιηθεί για την απόδοση ενός θεματικού επιπέδου (layer). 
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Εικόνα 13.3. Κατάλογος διατιθέμενων Styles
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Εικόνα 13.4. Δημιουργία νέου Style.
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Εικόνα 13.5 Στον κατάλογο Available Styles εντοπίζεται το Style και με το βέλος μεταφέρεται στον κατάλογο Selected Styles. Στη συνέχεια μεταφέρεται και στην επιλογή Default Style.
 
13.4.2 Αντιστοίχιση Style με ένα θεματικό επίπεδο
 
Για την αντιστοίχιση ενός Style με ένα θεματικό επίπεδο, από το μενού επιλέγεται Layers και στη συνέχεια από τον κατάλογο των θεματικών επιπέδων το συγκεκριμένο θεματικό επίπεδο. Στο νέο παράθυρο επιβεβαιώνεται ότι το συγκεκριμένο θεματικό επίπεδο είναι ενεργοποιημένο (Enabled) για δημοσίευση και επιλέγεται η καρτέλα Publishing. Στον κατάλογο Available Styles (Εικόνα 13.5) εντοπίζεται το Style και με το βέλος μεταφέρεται στον κατάλογο Selected Styles. Στη συνέχεια, μεταφέρεται και στην επιλογή Default Style. Η διαδικασία ολοκληρώνεται με το πλήκτρο Save.
 
13.4.3 Δημιουργία χάρτη ως Layer Group
 
Η δομή Layer Group επιτρέπει την οργάνωση ενός συνόλου θεματικών επιπέδων (ή άλλων Layer Groups) του GeoServer σε μια δομή που αντιπροσωπεύει έναν χάρτη. Η δομή αυτή χρησιμοποιείται από το αίτημα του WMS, με αποτέλεσμα να απλοποιείται η σύνταξη ενός αιτήματος το οποίο απαιτεί την ανάκτηση πολλών θεματικών επιπέδων (layers). Περιλαμβάνει έναν αριθμό ανεξάρτητων Layers από διάφορα Workspaces και ορίζει την σειρά οπτικοποίησής τους. 
Για τη δημιουργία ενός Layer Group επιλέγεται Data>Layer Groups και στη συνέχεια επιλέγεται Add new layer Group (Εικόνα 13.6). Στη νέα οθόνη (Εικόνα 13.7) ορίζονται οι παράμετροι του Layer Group όπως το όνομα Name, μια σύντομη περιγραφή Title, μια εκτενέστερη περιγραφή Abstract και το Workspace στο οποίο θα αποθηκευτεί. Η παράμετρος mode παίρνει την τιμή Single, ώστε τo Layer Group να ανακτάται συνολικά ως ο χάρτης που αντιπροσωπεύει. Τα όρια Bounds της περιοχής που θα καλύπτει μπορούν είτε να συμπληρωθούν χειροκίνητα είτε να δημιουργηθούν αυτόματα με την επιλογή Generate Bounds μετά την πρσθήκη όλων των θεματικών επιπέδων. Η τελευταία αυτή επιλογή ενημερώνει και το ΣΑΣ το οποίο θα χρησιμοποιείται για το συγκεκριμένο Group. Ωστόσο, αυτό μπορεί να αλλάξει με την επιλογή Find. Ένα Layer Group ενδέχεται να περιλαμβάνει θεματικά επίπεδα με διαφορετικά όρια ή ΣΑΣ. Ο GeoServer αναλαμβάνει να μετασχηματίσει όλα τα θεματικά επιπέδα στο επιλεγμένο ΣΑΣ. Με την επιλογή Add Layer πραγματοποιείται η προσθήκη των θεματικών επίπεδων Layer ή ακόμα και άλλων Layer Group στο Layer Group. Όλα τα θεματικά επίπεδα ή ομάδες θεματικών επιπέδων που προστίθενται, εμφανίζονται σε έναν κατάλογο (Εικόνα 13.7). Η στήλη Drawing order καθορίζει τη σειρά σχεδίασης των επιπέδων και μεταβάλλεται με τη χρήση των βελών. Στο περιβάλλον του GeoServer τα θεματικά επίπεδα σχεδιάζονται ξεκινώντας από αυτό που βρίσκεται πιο ψηλά στον κατάλογο. H στήλη Style δίνει τη δυνατότητα να αντιστοιχιθεί κάποιο από τα αποθηκευμένα Styles συμβολισμού στο συγκεκριμένο Layer ή να χρησιμοποιηθεί το ήδη αντιστοιχισμένο. Η στήλη Remove δίνει τη δυνατότητα να αφαιρεθεί κάποιο από τα θεματικά επίπεδα. Οι επιλογές αποθηκεύονται με την κουμπί Save.
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Εικόνα 13.6 Δημιουργία Layer Group.
13.4.4 Δημιουργία υπομνήματος
 
Για τη λήψη του υπομνήματος σε μορφή εικόνας, χρησιμοποιείται το αίτημα GetLegendGraphic (βλ. Κεφάλαιο 12) του προτύπου WMS. Για παράδειγμα με το παρακάτω αίτημα http://localhost:8090/geoserver/wms?REQUEST=GetLegendGraphic&VERSION=1.0.0&FORMAT=image/png&WIDTH=20&HEIGHT=20&LAYER=mytest:layers_all λαμβάνεται το υπόμνημα (Εικόνα 13.8). Με τον τρόπο αυτό στο υπόμνημα εμφανίζονται όλα τα θεματικά επίπεδα (layers) που συμμετέχουν στη χαρτοσύνθεση (layer group) π.χ. η ξηρά που παραδοσιακά δεν εμφανίζεται στο υπόμνημα. Για τον λόγο αυτό, κατασκευάζεται μια νέα χαρτοσύνθεση (layer group) η οποία περιέχει μόνο εκείνα τα επίπεδα (layers) που ο χρήστης επιθυμεί να εμφανίζονται στο υπόμνημα. Στη συνέχεια, στο αίτημα για τη λήψη του υπομνήματος με GetLegendGraphic, χρησιμοποιείται αυτή η νέα χαρτοσύνθεση (layer group). Για παράδειγμα με το παρακάτω αίτημα λαμβάνεται το υπόμνημα (Εικόνα 13.8) http://localhost:8090/geoserver/wms?REQUEST=GetLegendGraphic&VERSION=1.0.0&FORMAT=image/png&WIDTH=20&HEIGHT=20&LAYER=mytest:layers_legend.
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Εικόνα 13.7 Ορισμός των παραμέτρων του Layer Group.
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Εικόνα 13.8 Δημιουργία υπομνήματος.
Το αίτημα και το αποτέλεσμά του, που είναι το υπόμνημα ως εικόνα, μπορεί να ενσωματωθούν στην ιστοσελίδα της χαρτογραφικής εφαρμογής ως εικόνα 
(<img src="http://localhost:8090/geoserver/wms?REQUEST=GetLegendGraphic&VERSION=1.0.0&FORMAT=image/png&WIDTH=50&HEIGHT=30&LAYER=mytest:layers_legend" style="width:50px;height:142px") ή ως σύνδεσμος (<a href=" 1</a). 
Από τον Geoserver σε επίπεδο Layer ορίζεται η παράμετρος Title π.χ. Σημεία Γνωστού Υψομέτρου (Εικόνα 13.9) που θα εμφανίζεται στο υπόμνημα ως το όνομα του θεματικού επίπεδου (Layer) (Εικόνα 13.8). Στην περίπτωση που τα σύμβολα διαφοροποιούνται εντός ενός θεματικού επιπέδου, τότε οι επιμέρους περιγραφές τους π.χ. Τριγωνομετρικό Σημείο, αντλούνται από το αρχείο SLD που χρησιμοποιείται για τον συμβολισμό. (Εικόνα 13.10). Οι περιγραφές των συμβόλων, εφ’ όσον υπάρχουν, εμφανίζονται και κατά τη διαδικασία δημοσιοποίησης ενός θεματικού επίπεδου και αντιστοίχισης του Style στην καρτέλα Publish (Εικόνα 13.11).
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Εικόνα 13.9 Η παράμετρος Title π.χ. Σημεία Γνωστού Υψομέτρου εμφανίζεται στο υπόμνημα ως το όνομα του θεματικού επίπεδου.
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Εικόνα 13.10 Στοιχεία υπομνήματος.
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Εικόνα 13.11 Οι περιγραφές των συμβόλων, εφ’ όσον υπάρχουν, εμφανίζονται και κατά τη διαδικασία δημοσιοποίησης ενός θεματικού επίπεδου στην καρτέλα Publish.
13.5 Δημιουργία και δημοσιοποίηση χάρτη με το ArcGIS
 
Τα σχετικά θέματα έχουν καλυφθεί στο Κεφάλαιο 12. (βλ. παράγραφο 12.3).
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Κριτήρια αξιολόγησης 
Στη συνέχεια, ακολουθούν μια σειρά από κριτήρια αξιολόγησης με τη μορφή ερωτήσεων των οποίων οι απαντήσεις βρίσκονται εντός του κειμένου του κεφαλαίου. 
 
Κριτήριο αξιολόγησης 1
Ποιοι παράγοντες επηρεάζουν τη σχεδίαση ενός χάρτη για το διαδίκτυο;
 
Κριτήριο αξιολόγησης 2 
Μπορεί ένας χάρτης που σχεδιάστηκε για έντυπη παραγωγή να δημοσιοποιηθεί ως έχει στο διαδίκτυο; Τι πρέπει να αλλάξει;
Κριτήριο αξιολόγησης 3 
Τι είναι το πρότυπο SLD;
 
Κριτήριο αξιολόγησης 4
Με ποια δομή του Geoserver καταγράφεται ο χαρτογραφικός συμβολισμός;
 
Κριτήριο αξιολόγησης 5
Με ποια δομή του Geoserver καταγράφεται μια χαρτοσύνθεση;
Παράρτημα Α – Εισαγωγή στο QGIS
Α.1 Το Σύστημα Γεωγραφικών Πληροφοριών QGIS
 
Το Quantum GIS ή QGIS (http://www.qgis.org) είναι ένα ΕΛ/ΛΑΚ Σύστημα Γεωγραφικών Πληροφοριών. Λειτουργεί σε Linux, Unix, Mac OSX και Windows. Διατίθεται με την άδεια GNU General Public License (GPL).
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Εικόνα Α.1 Το περιβάλλον γραφικής διεπαφής (Graphical User Interface – GUI) του QGIS.
To QGIS διαθέτει φιλικό γραφικό περιβάλλον επικοινωνίας με το χρήστη και ενσωματώνει εργαλεία και λειτουργίες όπως η σχεδίαση και η ταυτόχρονη σχεδίαση διανυσματικών και κανονικοποιημένων γεωχωρικών δεδομένων, η διαχείριση και ο μετασχηματισμός του Συστήματος Αναφοράς Συντεταγμένων (ΣΑΣ), η διερεύνηση των δεδομένων και η χαρτοσύνθεση, η συλλογή, η επεξεργασία, η διαχείριση και η εξαγωγή, η χωρική ανάλυση και η γεωεπεξεργασία των δεδομένων, η δημοσιοποίηση στο διαδίκτυο κ.ά. Υποστηρίζει πολλαπλούς μορφότυπους διανυσματικών και κανονικοποιημένων δεδομένων και επικοινωνεί με χωρικές βάσεις δεδομένων. Προσφέρει ισχυρές αναλυτικές δυνατότητες μέσω της συνεργασίας του με το GRASS και άλλες βιβλιοθήκες εργαλείων.
Στη συνέχεια, ακολουθεί η συνοπτική παρουσίαση ορισμένων βασικών στοιχείων για το QGIS, ενώ περισσότερες πληροφορίες μπορούν να αναζητηθούν στην ιστοσελίδα του προγράμματος (“QGIS Training Manual”, χ.η.;“QGIS User Guide”, χ.η.).
Α.1.1 Εγκατάσταση και εκκίνηση του προγράμματος
 
Η εγκατάσταση του QGIS είναι πολύ απλή και υλοποιείται με το πρόγραμμα εγκατάστασης που διατίθεται για κάθε λειτουργικό σύστημα. Η πιο πρόσφατη έκδοση του προγράμματος μπορεί να ληφθεί από την ιστοσελίδα http://download.qgis.org. Αφού ολοκληρωθεί η εγκατάσταση, η εκκίνηση του προγράμματος QGIS πραγματοποιείται από το εικονίδιο [image: ], οπότε εμφανίζεται το παράθυρο της εφαρμογής (Εικόνα Α.1).
 
Α.2 Το γραφικό περιβάλλον διεπαφής του QGIS
Η αρχική εμφάνιση του γραφικού περιβάλλοντος ενδέχεται να είναι διαφορετική για κάθε χρήστη ανάλογα με τη γλώσσα και τις εργαλειοθήκες που εμφανίζονται. Στο γραφικό περιβάλλον διακρίνοται οι ακόλουθες πέντε περιοχές: Μενού (Menu Bar), Εργαλειοθήκη (Tool Bar), Θεματικά Επίπεδα (Layers), Περιοχή χάρτη (Map Area) και Γραμμή Κατάστασης (Status Bar) (Εικόνα Α.1). 
A.2.1 Μενού (Menu Bar)
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Εικόνα Α.2 Βασικό μενού.
Το μενού (Εικόνα Α.1) δίνει πρόσβαση σε διαφορετικά εργαλεία του QGIS ακολουθώντας μια ιεραρχική δομή. Μια πλήρης αναφορά των επιλογών του μενού βρίσκεται στην ιστοσελίδα του QGIS (http://docs.qgis.org/2.6/en/docs/user_manual/introduction/qgis_gui.html) ενώ μια συνοπτική παρουσίαση ακολουθεί:
 
	Το μενού Έργο (Project) χρησιμοποιείται για το άνοιγμα, την αποθήκευση, τον καθορισμό των ιδιοτήτων και την εκτύπωση ενός έργου. 
	Το μενού Επεξεργασία (Edit) χρησιμοποιείται για την επεξεργασία των δεδομένων ενός θεματικού επιπέδου π.χ. προσθήκη, διόρθωση, διαγραφή κ.ά. 
	Το μενού Εμφάνιση (View) περιέχει εργαλεία για την πλοήγηση εντός του χάρτη, την αλλαγή του βαθμού μεγέθυνση, του ορισμού του εύρους της περιοχής σχεδίασης κ.ά.
	Το μενού Επίπεδο (Layer) χρησιμοποιείται για τη διαχείριση των θεματικών επιπέδων. 
	Το μενού Ρυθμίσεις (Settings) χρησιμοποιείται για τη διαχείριση των ρυθμίσεων του περιβάλλοντος όπως του ΣΑΣ (Ιδιοποιημένο ΣΑΣ), του συμβολισμού (Διαχείριση Στυλ), του μενού (Παραμετροποίηση), των χαρακτηριστικών κάθε έργου (Επιλογές) κ.ά.
	Το μενού Πρόσθετα (Plugins) χρησιμοποιείται για τη διαχείριση των υπαρχόντων πρόσθετων εργαλείων και την προσθήκη νέων.
	Το μενού Διανύσματα (Vector) περιέχει εργαλεία για τη διαχείριση των διανυσματικών δεδομένων. 
	Το μενού Raster και το μενού Ψηφιδωτό περιέχουν εργαλεία για τη διαχείριση των κανονικοποιημένων δεδομένων. 
	Το μενού Βάση δεδομένων (Database) περιέχει εργαλεία για τη διαχείριση των βάσεων δεδομένων. 
	Το μενού Processing περιέχει επιπλέον εργαλεία για τη διαχείριση των διανυσματικών και των κανονικοποιημένων δεδομένων. 
	Το μενού Βοήθεια (Help) οδηγεί σε διάφορους συνδέσμους με βοήθεια για το πρόγραμμα. 

A.2.2 Εργαλειοθήκη 
 
Οι συνηθέστερες λειτουργίες που ενεργοποιούνται από το μενού είναι διαθέσιμες και ως εργαλεία της εργαλειοθήκης (Tool Bar) (Εικόνα Α.3). Οι εργαλειοθήκες του QGIS μπορούν να εμφανίζονται ή να κρύβονται από την επιλογή Εμφάνιση>Toolbars από το κεντρικό μενού (Εικόνα Α.2) του προγράμματος.
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Εικόνα Α.3 Εργαλειοθήκη.
A.2.3 Επίπεδα 
 
Το παράθυρο Επίπεδα (Layers) (Εικόνα Α.1) αποτελεί έναν κατάλογο των θεματικών επιπέδων προς επεξεργασία. Το τετραγωνίδιο ελέγχου (checkbox) δίπλα από κάθε θεματικό επίπεδο χρησιμοποιείται για την εμφάνιση ή την απόκρυψή του. Παράλληλα, η σειρά των θεματικών επιπέδων καθορίζει τη σειρά σχεδίασής τους και μπορεί να μεταβληθεί. Επιπλέον, διατίθενται και άλλα εργαλεία διαχείρισης των θεματικών επιπέδων, όπως η ομαδοποίηση.
A.2.4 Χάρτης
 
Στη περιοχή του χάρτη (Map View) σχεδιάζονται με το συμβολισμό που έχει επιλεγεί τα θεματικά επίπεδα και το γραφικό αποτέλεσμα της επεξεργασίας. Ο χρήστης με τα εργαλεία που προσφέρει η εργαλειοθήκη Πλοήγηση Χάρτη (Εικόνα Α.4) ή το μενού Εμφάνιση έχει τη δυνατότητα να πλοηγηθεί εντός του χάρτη, να αλλάξει το βαθμό μεγέθυνσης, να ορίσει το εύρος της περιοχής σχεδίασης κ.ά. 
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Εικόνα Α.4 Εργαλειοθήκη Πλοήγηση Χάρτη.
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Εικόνα Α.5 Γραμμή Κατάστασης.
A.2.5 Γραμμή Κατάστασης 
 
Η γραμμή κατάστασης (Status Bar) (Εικόνα Α.5) εμφανίζει τις συντεταγμένες π.χ. καρτεσιανές, γεωγραφικές της θέσης του κέρσορα στη οθόνη, καθώς αυτός κινείται στο χάρτη. Αριστερά από αυτή την ένδειξη, υπάρχει ένα κουμπί που αντικαθιστά τις ενδείξεις των συντεταγμένων με το εύρος της περιοχής που απεικονίζεται στην οθόνη. Δεξιά υπάρχει η ένδειξη για την κλίμακα, ένα μικρό τετραγωνίδιο ελέγχου (checkbox) Διαδικασία σχεδίασης χάρτη που ελέγχει την ανανέωση του γραφικού παραθύρου, ο κωδικός EPSG του ΣΑΣ και το εργαλείο [image: ] που επιτρέπει την αλλαγή του ΣΑΣ.
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Εικόνα Α.6 Από το παράθυρο Project Properties ορίζονται τα χαρακτηριστικά του έργου.
Α.3 Η δομή Έργο του QGIS και οι ιδιότητές του 
 
Το ΣΓΠ QGIS αξιοποιεί τη δομή Έργο (Project) για να αποθηκεύσει τις ρυθμίσεις, το συμβολισμό καθώς και τα θεματικά επίπεδα (δεδομένα) που χρησιμοποιούνται σε μια συνεδρία λειτουργίας (session). Πρόκειται για ένα αρχείο με κατάληξη qgs. Η αποθήκευσή του γίνεται από το μενού Έργο>Αποθήκευση ή Έργο>Αποθήκευση ως. Από το μενού Έργο>Ιδιότητες Έργου ή Ρυθμίσεις>Επιλογές ορίζονται τα χαρακτηριστικά του έργου στο παράθυρο Project Properties (Εικόνα Α.6):
 
	Στην καρτέλα Γενικά (General) (Εικόνα Α6), ορίζεται ο τίτλος (Project title), το χρώμα σχεδίασης των επιλεγμένων οντοτήτων (Χρώμα επιλογής), το χρώμα του υποβάθρου του γραφικού παράθυρου (Χρώμα φόντου), ενεργοποιείται η επιλογή αποθήκευσης των σχετικών θέσεων των δεδομένων, οι μονάδες (Canvas units) καθώς και η Ακρίβεια δηλαδή ο αριθμός των δεκαδικών ψηφίων των δεδομένων. Εάν η επιλογή Enable CRS transformation έχει ενεργοποιηθεί στην καρτέλα CRS, τότε ενεργοποιείται το Measure tool για τη μέτρηση αποστάσεων στο ελλειψοειδές. Ακόμα ορίζεται ένας κατάλογος από κλίμακες που περιορίζουν τις γενικά ορισμένες κλίμακες. 
	Η καρτέλα CRS επιτρέπει την επιλογή του ΣΑΣ και τη δυναμική αλλαγή του ΣΑΣ (Enable CRS transformation). 
	Η καρτέλα Identify layers ορίζει τα θεματικά επίπεδα που θα είναι διαθέσιμα στο εργαλείο ταυτοποίησης [image: ]. 
	Η καρτέλα Styles καθορίζει τα προκαθορισμένα σύμβολα που χρησιμοποιούνται για την απόδοση των γεωχωρικών δεδομένων καθώς και το ποσοστό της διαφάνειας. 
	Η καρτέλα OWS Server ορίζει τις ρυθμίσεις του εξυπηρετητή QGIS WMS και WFS. 
	Η καρτέλα Macros χρησιμοποιείται για την επεξεργασία των αυτοματισμών (macros) σε γλώσσα Python. 
	Η καρτέλα Relations χρησιμοποιείται για τον ορισμό συσχετίσεων μεταξύ των δεδομένων.

 
Α.4 Διαμόρφωση παραμέτρων λειτουργίας (settings) του QGIS
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Εικόνα Α.7 Από το παράθυρο Επιλογές ορίζονται τα χαρακτηριστικά κάθε έργου.
Από το μενού Ρυθμίσεις>Επιλογές εμφανίζεται το παράθυρο Επιλογές (Εικόνα Α.7), από όπου καθορίζονται διάφορες παράμετροι του QGIS. Μια πλήρης αναφορά των επιλογών βρίσκεται στην ιστοσελίδα του QGIS (http://docs.qgis.org/2.6/en/docs/user_manual/introduction/qgis_configuration.html).
 
 
Α.5 Διαχείριση δεδομένων 
Α.5.1 Εισαγωγή δεδομένων 
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Εικόνα Α.8 Προσθήκη γεωγραφικών δεδομένων στο QGIS.
Το πρώτο στάδιο εργασίας με το QGIS αφορά την εισαγωγή των γεωχωρικών δεδομένων. Η εισαγωγή γίνεται από το μενού Επίπεδο>Προσθήκη επιπέδου και στη συνέχεια την κατάλληλη επιλογή (Εικόνα Α.8 Προσθήκη γεωγραφικών δεδομένων στο QGIS.Εικόνα Α.8) ή από τα σχετικά κουμπιά της εργαλειοθήκης. Για παράδειγμα: 
 
	[image: ] Προσθήκη διανυσματικών γεωχωρικών δεδομένων (υποστήριξη πολλαπλών μορφότυπων). 
	[image: ] Προσθήκη κανονικοποιημένων γεωχωρικών δεδομένων. 
	[image: ] Προσθήκη από τη βάση δεδομένων PostGIS.
	[image: ] Προσθήκη από τη βάση δεδομένων SpatiaLite.
	[image: ] Προσθήκη από τη βάση δεδομένων MSSQL.
	[image: ] Προσθήκη από τη βάση δεδομένων Oracle Spatial.
	[image: ] Προσθήκη ενός θεματικού επίπεδου WMS.
	[image: ] Προσθήκη ενός θεματικού επίπεδου WCS.
	[image: ] Προσθήκη ενός θεματικού επίπεδου WFS. 

 
Για την αφαίρεση ενός θεματικού επιπέδου, επιλέγεται το θεματικό επίπεδο και με δεξί κλικ Απομάκρυνση. 
Α.5.2 Αποθήκευση διανυσματικών δεδομένων
 
Για την αποθήκευση των διανυσματικών δεδομένων, επιλέγεται το θεματικό επίπεδο από τον κατάλογο των δεδομένων π.χ. coast και με δεξί κλικ Αποθήκευση ως. Στο νέο παράθυρο Save vector layer as… (Εικόνα Α.9), ορίζεται ο μορφότυπος (Μορφή) π.χ. ESRI Shapefile, GeoJSN, ESRI FileGDB κ.ά., το όνομα του νέου αρχείου ως Αποθήκευση ως, το ΣΑΣ και η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ. Σε περίπτωση που είναι επιθυμητή η αποθήκευση μόνο των επιλεγμένων οντοτήτων του θεματικού επιπέδου, ενεργοποιείται η επιλογή Save only selected features. Για την προσθήκη του νέου αρχείου στο περιβάλλον του QGIS ενεργοποιείται η επιλογή Add saved map to map.
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Εικόνα Α.9 Αποθήκευση διανυσματικών δεδομένων.
 
Α.6 Εργαλεία επεξεργασίας 
 
Βασικό πλεονέκτημα του QGIS είναι η ενσωμάτωση εργαλείων επεξεργασίας από διαφορετικές πηγές όπως το ΣΓΠ GRASS, οι βιβλιοθήκες χωρικής ανάλυσης π.χ. SAGA, GDAL/OGR, fTools κ.ά. καθώς και τα πρόσθετα (plugins) που κατασκευάζουν οι χρήστες. 
Α.6.1 Εργαλεία του ΣΓΠ GRASS
 
Το GRASS (Geographic Resources Analysis Support System) είναι ένα ΕΛ/ΛΑΚ ΣΓΠ που διαθέτει πολλά εργαλεία επεξεργασίας των διανυσματικών και των κανονικοποιημένων δεδομένων. Μέσω του ΣΓΠ QGIS, o χρήστης έχει πρόσβαση στα εργαλεία του GRASS με αποτέλεσμα να εμπλουτίζεται η λειτουργικότητά του. Τα δεδομένα του GRASS αποθηκεύονται σε ένα κατάλογο ο οποίος αναφέρεται ως GISDBASE. Στην πραγματικότητα φέρει το όνομα Grassdata και δημιουργείται με την εγκατάσταση του προγράμματος ή μπορεί να επιλεγεί ένας άλλος κατάλογος από τον χρήστη. Στον κατάλογο αυτό, τα δεδομένα του GRASS οργανώνονται σε έργα (projects), τα οποία αποθηκεύονται σε υποκαταλόγους που καλούνται Locations. Κάθε Location ορίζεται από το ΣΑΣ και τα γεωγραφικά του όρια και μπορεί να περιέχει διάφορα Mapsets. Κάθε Mapset αποτελεί έναν κατάλογο που χρησιμοποιείται για να οργανώνονται τα δεδομένα π.χ. διαφορετικές υποενότητες, υποπεριοχές κ.ά. (Neteler & Mitasova, 2008). Η διαχείριση των γεωγραφικών δεδομένων από το GRASS απαιτεί την εισαγωγή τους σε δομές Location και Mapset.
Για τη χρήση ενός εργαλείου πρέπει να έχει ενεργοποιηθεί ένα Mapset (βλ. Α.6.1.1) και στη συνέχεια επιλέγεται από το μενού GRASS>Open GRASS Tools. Από το νέο παράθυρο GRASS Tools (Εικόνα Α.10) και την καρτέλα Modules Tree επιλέγεται το εργαλείο που θα χρησιμοποιηθεί ή μέσω αναζήτησης από την καρτέλα Modules List. 
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Εικόνα Α.10 Επιλογή εργαλείου GRASS.
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Εικόνα Α.11 Δημιουργία νέου Μapset.
Α.6.1.1 Δημιουργία και άνοιγμα Μapset
 
Από το μενού επιλέγεται Πρόσθετα>Grass>Create new GRASS mapset. Στο νέο παράθυρο New Mapset (Εικόνα Α.11), από το πλήκτρο Περιήγηση, δημιουργείται ένας νέος φάκελος π.χ. myproject και επιλέγεται Νext. Στο επόμενο παράθυρο, δημιουργείται μία Location π.χ. Ikaria και επιλέγεται Νext. Στο επόμενο παράθυρο, επιλέγεται το ΣΑΣ π.χ. GGRS87/Greek Grid και επιλέγεται Νext. Στο επόμενο παράθυρο, ορίζονται τα γεωγραφικά όρια της περιοχής με την πληκτρολόγηση των γεωγραφικών ορίων ή την επιλογή μιας χώρας π.χ. Greece και επιλέγεται Νext. Στο επόμενο παράθυρο, ορίζεται το όνομα του mapset π.χ. Ikaria_data και επιλέγεται Νext. Η διαδικασία ολοκληρώνεται με το Finish. 
Στην περίπτωση που υπάρχει ήδη το mapset, από το μενού επιλέγεται Πρόσθετα>Grass>Open mapset. Στο νέο παράθυρο Select GRASS Mapset (Εικόνα Α.12), από το πλήκτρο Περιήγηση ορίζονται τα Gisdbase, Location και Mapset. Η διαδικασία ολοκληρώνεται με το OK. 
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Εικόνα Α.12 Επιλογή Mapset.
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Εικόνα Α.13 Ενεργοποίηση εργαλείου v.in.ogr.qgis Import loaded vector.
Α.6.1.2 Εισαγωγή ενός αρχείου μορφότυπου shapefile για επεξεργασία στο GRASS
 
Για την εισαγωγή των αρχείων μορφότυπου shapefile στο GRASS, από το μενού επιλέγεται Πρόσθετα> GRASS >Open GRASS tools. Στο νέο παράθυρο GRASS tools, από την καρτέλα Module Tree επιλέγεται GRASS MODULES>File management>Import vector into GRASS>v.in.ogr.qgis Import loaded vector (Εικόνα Α.13). Στη νέα καρτέλα (Εικόνα Α.14) ορίζεται το όνομα του αρχείου που χρησιμοποιείται, το οποίο πρέπει ήδη να έχει προστεθεί στο έργο του QGIS ως Loaded layer και το όνομα του διανυσματικού αρχείου GRASS που δημιουργείται π.χ. coast_grass ως Name for output vector map. Η εφαρμογή ξεκινάει με το πλήκτρο Εκτέλεση και στη συνέχεια το πλήκτρο Εμφάνιση αποτελέσματος προσθέτει τα νέα δεδομένα στη γραφική απόδοση. Η διαδικασία ολοκληρώνεται με το πλήκτρο Close. 
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Εικόνα Α.14 Εργαλείο v.in.ogr.qgis Import loaded vector.
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Εικόνα Α.15 Εργαλείο Add GRASS vector layer.
Α.6.1.3 Ορισμός διανυσματικού αρχείου προς επεξεργασία
 
Για τον ορισμό του διανυσματικού αρχείου GRASS προς επεξεργασία, από το μενού επιλέγεται Πρόσθετα> GRASS >Add GRASS vector layer. Στο νέο παράθυρο Select GRASS Vector Layer (Εικόνα Α.15), ορίζονται τα Gisdbase, Location, Mapset και Map Name. Στην επιλογή Επίπεδο επιλέγεται η γεωμετρία των δεδομένων π.χ. 1_line. Η διαδικασία ολοκληρώνεται με το OK.
Α.6.1.4 Αποθήκευση αποτελέσματος επεξεργασίας
 
Προκειμένου να αποθηκευτεί το αποτέλεσμα της επεξεργασίας του GRASS ως αρχείο μορφότυπου shapefile, επιλέγεται το αποτέλεσμα της επεξεργασία από το παράθυρο Επίπεδα π.χ. coast_grass και με δεξί κλικ Save vector layer as (βλ. Α.5.2).
Α.6.2 Εργαλειοθήκη Επεξεργασίας 
 
Από την Εργαλειοθήκη Επεξεργασίας (Toolbox) του QGIS μπορούν να κληθούν όλα τα εγγενή και τα πρόσθετα εργαλεία επεξεργασίας. Η εργαλειοθήκη για την επεξεργασία των γεωχωρικών δεδομένων ενεργοποιείται από το μενού Processing>Toolbox και στη συνέχεια ο χρήστης επιλέγει το εργαλείο που χρειάζεται από το παράθυρο Εργαλειοθήκη Επεξεργασίας (Εικόνα Α.16). Τα εργαλεία εμφανίζονται κάτω από την ένδειξη Geoalgorithms ομαδοποιημένα σε κατηγορίες π.χ. Domain Specific, Images, Raster, Vector, Raster-Vector. Υπάρχουν ακόμα άλλες δύο ενδείξεις Models και Scripts, που περιέχουν αλγορίθμους και ρουτίνες επεξεργασίας που έχει δημιουργήσει ο χρήστης συνδυάζοντας τα διατιθέμενα εργαλεία. Στο επάνω μέρος του παραθύρου υπάρχει η δυνατότητα αναζήτησης ενός εργαλείου πληκτρολογώντας μια λέξη κλειδί. Στο κάτω μέρος του παραθύρου υπάρχει ένα κουμπί που επιτρέπει την εναλλαγή μεταξύ του απλοποιημένου καταλόγου αλγορίθμων (Simplified interface) και το σύνθετο κατάλογο (Advanced interface). Στο σύνθετο κατάλογο οι αλγόριθμοι ομαδοποιούνται κατά τον πάροχό τους π.χ. SAGA, GRASS, GDAL/OGR κ.ά. Όταν ο χρήστης επιλέξει ένα εργαλείο, με δεξί κλικ εμφανίζεται η επιλογή Εκτέλεση διαδικασίας μαζικά που επιτρέπει την εκτέλεση της επεξεργασίας επαναληπτικά (batch mode) στο παράθυρο Batch Processing (Εικόνα Α.17). 
Από το μενού Processing>Graphical modeler εμφανίζεται το παράθυρο Μοντελοποίηση επεξεργασίας, όπου αλγόριθμοι και δεδομένα μπορούν να συνδυαστούν γραφικά δημιουργώντας μια ροή επεξεργασίας των δεδομένων (Εικόνα Α.18).
 
 
[image: ]
Εικόνα Α.16 Εργαλειοθήκη Επεξεργασίας.
Από το μενού Processing>Ηistory εμφανίζεται το παράθυρο Ιστορικό και αρχείο καταγραφής όπου εμφανίζονται το ιστορικό των διαδικασιών επεξεργασίας που έχουν υλοποιηθεί (Εικόνα Α.19).
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Εικόνα Α.17 Batch Processing.
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Εικόνα Α.18 Δημιουργία μοντέλου επεξεργασίας.
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Εικόνα Α.19 Ιστορικό και αρχείο καταγραφής.
 
 
 
Α.6.3 Πρόσθετα (Plugins)
 
Το QGIS έχει σχεδιαστεί με βάση την αρχιτεκτονική των πρόσθετων εργαλείων (plugins), με αποτέλεσμα να προστίθενται με ευκολία νέα χαρακτηριστικά και λειτουργίες. Τα πρόσθετα εργαλεία συντάσσονται από προγραμματιστές του QGIS και άλλους ανεξάρτητους χρήστες που θέλουν να επεκτείνουν την βασική λειτουργικότητα του λογισμικού. Συχνά, χρειάζεται η ενημέρωση του προγράμματος λόγω της ύπαρξης νέων εργαλείων. Τα βασικά πρόσθετων εργαλείων (Core Plugins) είναι μέρος της τυπικής εγκατάστασης του QGIS. Tα εξωτερικά πρόσθετων εργαλείων (External Plugins) είναι διαθέσιμα στο QGIS Plugins Repository και πρέπει να εγκατασταθούν με τη χρήση του εργαλείου Plugin Manager. 
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Εικόνα Α.20 Προσθήκη πρόσθετων εργαλείων. 
Η προσθήκη ενός εργαλείου γίνεται από το μενού Πρόσθετα>Διαχείριση και Εγκατάσταση Προσθέτων. Στο παράθυρο Πρόσθετα (Εικόνα Α.20), στην καρτέλα Όλα εμφανίζονται όλα τα πρόσθετα, στην καρτέλα Installed τα εγκατεστημένα και στην καρτέλα Not Installed αυτά που δεν έχουν εγκατασταθεί αλλά μπορεί να γίνει η εγκατάσταση τους. Από την καρτέλα Ρυθμίσεις (Εικόνα Α.21) ενεργοποιείται η επιλογή Check for updates on startup και καθορίζεται πότε π.χ. every time QGIS starts ώστε να γίνεται η ενημέρωση για τα νέα πρόσθετα εργαλεία. Για την εγκατάσταση ενός εργαλείου από το παράθυρο Πρόσθετα επιλέγεται το εργαλείο προς εγκατάσταση από την καρτέλα Not Installed. 
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Εικόνα Α.21 Ενημέρωση για την ύπαρξη νέων πρόσθετων εργαλείων.
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Παράρτημα Β – Εισαγωγή στο ArcGIS
B.1 Ορισμοί & βασικές έννοιες
 
	Φαινόμενο: Ο,τιδήποτε υποπίπτει στην ανθρώπινη αντίληψη.
	Γεωγραφικό (Γεωχωρικό ή χωρικό) φαινόμενο: Ο,τιδήποτε υποπίπτει στην ανθρώπινη αντίληψη και έχει σχέση με τη Γη (τον πραγματικό κόσμο).
	Γεωγραφικές (Γεωχωρικές ή χωρικές) οντότητες (entities) ή στοιχεία: Αντικείμενα του πραγματικού κόσμου τα οποία δεν υποδιαιρούνται σε επιμέρους οντότητες της ίδιας κατηγορίας.
	Χαρτογραφικές οντότητες ή στοιχεία: Το υποσύνολο των γεωγραφικών (γεωχωρικών – χωρικών) οντοτήτων που πρόκειται να αποδοθούν χαρτογραφικά
	Αντικείμενο (object): Η έκφραση μιας οντότητας σε ψηφιακό περιβάλλον.
	Τα αντικείμενα και οι σχετικές με αυτά ιδιότητες και τιμές αντιπροσωπεύουν τις γεωγραφικές οντότητες.

 
Τα γεωγραφικά φαινόμενα, μπορεί να είναι συγκεκριμένα ή αφηρημένα, μπορούν να αναφέρονται στο δισδιάστατο ή τρισδιάστατο χώρο ή ακόμη και να αποτελούν χρονοσειρές αν πρόκειται για φαινόμενα που μεταβάλλονται δυναμικά στο χρόνο. Ο χάρτης αποτελεί το εργαλείο-κλειδί για τη μελέτη των χωρικών φαινομένων και των μεταξύ τους σχέσεων. Τα Συστήματα Γεωγραφικών Πληροφοριών υλοποιούν μία αλυσίδα από λειτουργίες που επιτρέπουν τη μετάβαση από την παρατήρηση και τη συλλογή χωρικών δεδομένων, στην αποθήκευση, επεξεργασία, ανάλυση και απόδοσή τους και την περαιτέρω αξιοποίησή τους τους για τη λήψη αποφάσεων και εξαγωγή συμπερασμάτων. 
Ο χάρτης είναι ένα σύστημα πληροφοριών: αποτελείται από ένα σύνολο δεδομένων που έχουν αποθηκευτεί και αναλυθεί και οι πληροφορίες που πηγάζουν από αυτό το σύνολο χρησιμοποιούνται για τη λήψη αποφάσεων. Για να είναι χρήσιμος ένας χάρτης πρέπει να μεταφέρει την πληροφορία με σαφή και ευκρινή τρόπο προς τους χρήστες.
Τα Συστήματα Διαχείρισης Βάσεων Δεδομένων (ΣΔΒΔ) – Database Management Systems (DBMS) είναι συστήματα λογισμικού για τη δημιουργία, διαχείριση και αξιοποίηση της Βάσης Δεδομένων από ένα οργανισμό και τους χρήστες της.. 
Ως δεδομένα νοούνται οι πληροφορίες που κρίνεται ότι είναι σημαντικές για τον χρήστη ή τον οργανισμό/φορέα τον οποίο έχει σκοπό να εξυπηρετήσει το σύστημα. 
Ως Βάση Δεδομένων θεωρείται ένα οργανωμένο σύνολο πληροφοριών, το οποίο είναι δομημένο με τρόπο που να επιτρέπει τη διαχείριση των δεδομένων για διάφορες εφαρμογές. 
Τα Συστήματα Διαχείρισης Βάσεων Δεδομένων, παρέχουν στους χρήστες μια σειρά από εργαλεία που εκτελούν λειτουργίες, όπως οι ακόλουθες:
 
	Δημιουργία νέων αρχείων με βάση συγκεκριμένη δομή και μορφότυπο (format).
	Διαγραφή υπαρχόντων αρχείων.
	Προσθήκη εγγραφών σε υπάρχοντα αρχεία.
	Διαγραφή εγγραφών από υπάρχοντα αρχεία.
	Ενημέρωση εγγραφών.
	Επιλογή εγγραφώνς που ικανοποιούν λογικές εκφράσεις.

 
Η συγκρότηση των χωρικών οντοτήτων σε περιβάλλον ΣΓΠ στηρίζεται στην άρρηκτη σύνδεση των γεωμετρικών στοιχείων με τα περιγραφικά χαρακτηριστικά. Τα γεωμετρικά στοιχεία είναι η έκφραση των χωρικών δεδομένων σε μία από τις τρεις βασικές κατηγορίες χωρικών φαινομένων: σημειακά, γραμμικά και επιφανειακά, είναι δε ο γραφικός τρόπος με τον οποίο αυτάαναπαριστώνται.. Η περιγραφή του γεωγραφικού χώρου σε περιβάλλον Η/Υ υλοποιείται:
 
	Με την αποθήκευση των γεωμετρικών στοιχείων (θέση υπό μορφή συντεταγμένων) που καταγράφουν τα γεωγραφικά φαινόμενα.
	Με την αποθήκευση των περιγραφικών χαρακτηριστικών τους (ιδιότητες) που τα προσδιορίζουν πλήρως και καθορίζουν τη μεταξύ τους διαφοροποίηση.
	Με τον προσδιορισμό των τοπολογικών τους σχέσεων.

 
 Για κάθε κατηγορία χωρικών στοιχείων που υπάρχουν στη ΒΔ, δημιουργείται ένα θεματικό επίπεδο (layer).
B.2 Εισαγωγή στο ArcGIS
 
Το ArcGIS Desktop (“ArcGIS Help 10.2”, χ.η.) είναι από τα κύρια πλαίσια λειτουργίας του ArcGIS και αποτελεί ένα ολοκληρωμένο σύνολο εργαλείων που παρέχουν στον χρήστη πρόσβαση σε γεωγραφικές οντότητες και δυνατότητες εκτέλεσης χωρικών διεργασιών. Απαρτίζεται από εξειδικευμένα υποσυστήματα με αντικείμενο την επισκόπηση, επεξεργασία, ανάλυση και απόδοση χωρικών δεδομένων και συμπληρώνεται από εξειδικευμένες επεκτάσεις (extensions). Οι εφαρμογές αυτές είναι:
 
	ArcCatalog.
	ArcToolbox.
	ArcMap.

 
Επιπλέον, διατίθενται και υποσυστήματα που είναι γνωστά ως επεκτάσεις και ενεργοποιούνται από τον χρήστη κατά περίπτωση. Ορισμένες από αυτές είναι:
 
	3D Analyst.
	Data Interoperability.
	Geostatistical Analyst.
	Network Analyst.
	Publisher.
	Schematics.
	Spatial Analyst.
	Statistical Analyst.
	Tracking Analyst.
	Production Manager.

 
Σημειώνεται επίσης ότι το ArcGIS έχει τρία επίπεδα χρήσης:
 
	ArcView.
	ArcEditor.
	ArcInfo.

 
Η πλήρης λειτουργικότητα βρίσκεται στο τρίτο επίπεδο (ArcInfo). Σε όλες τις εφαρμογές του ArcGIS είναι διαθέσιμη η βοήθεια ArcGIS Desktop Help που ενεργοποιείται είτε αυτόνομα από τη λίστα εφαρμογών του ArcGIS Start>All Programs>ArcGIS Desktop Help, είτε από το πλήκτρο Help του βασικού μενού κάθε εφαρμογής.
Β.3 ArcCatalog
 
Το περιβάλλον ArcCatalog παρέχει στον χρήστη μια ολοκληρωμένη άποψη του συνόλου των μορφών δεδομένων που υποστηρίζονται από το ArcGIS: data files, databases καθώς και άλλων αρχείων του ArcGIS. Έχει τη μορφή του Windows explorer, προσαρμοσμένου όμως στην αναγνώριση και αντιστοίχως το «συμβολισμό» με τα κατάλληλα εικονίδια των ειδικών δομών των χωρικών δεδομένων. Τα χωρικά δεδομένα συχνά αποτελούνται από ομάδες αρχείων και ενώ στον Windows explorer εμφανίζονται ως σύνολο φακέλων και αρχείων (folders και files), ο ArcCatalog εμφανίζει και διαχειρίζεται τα χωρικά δεδομένα ως ενιαίες οντότητες. Επίσης, στα περιεχόμενα εμφανίζει μόνο τις δομές που αναγνωρίζει και όχι αρχεία άλλων τύπων που τυχόν υπάρχουν σε ένα φάκελο (folder).
Ο ArcCatalog είναι το υποσύστημα που χρησιμοποιείται για την οργάνωση και διαχείριση των χωρικών δεδομένων και επιτρέπει τη σύνδεση με τους «φυσικούς» χώρους που είναι αποθηκευμένα τα δεδομένα και οι χάρτες, τη διερεύνηση, τη διαχείριση και την αναζήτησή τους. Είναι εφοδιασμένος μεταξύ άλλων με εργαλεία για:
 
	Aναζήτηση χωρικών δεδομένων.
	Eπισκόπηση χωρικών δεδομένων (γεωμετρικών και περιγραφικών).
	Kαταγραφή, επισκόπηση και διαχείριση μεταδεδομένων.
	Eισαγωγή και εξαγωγή δεδομένων σε άλλες γεωγραφικές δομές.
	Δημιουργία και διαχείριση γεωβάσεων.

 
Η οργάνωση των δεδομένων στον ArcCatalog γίνεται σε δύο βασικούς τύπους. Τους χώρους εργασίας (workspaces) και τις γεωβάσεις (geodatabases). Οι τύποι των αρχείων που αναγνωρίζονται από τον ArcCatalog είναι:
 
	Coverages και πίνακες INFO. 
	CAD (AUTOCAD dwg, AUTOCAD dxf, MICROSTATION dgn).
	Geodatabase feature datasets και feature classes.
	Shapefiles.
	ΤΙΝ datasets.
	Terrain datasets.
	Raster data.
	VPF files.
	DBase tables.
	Text files (ASCII).
	Microsoft Access, Excel και άλλοι OLE DB πίνακες.
	ArcMap documents, templates και layers.
	ArcScene documents.

 
Β.3.1 Shapefile vs Feature class
 
To Shapefile, είναι ένα απλό μη τοπολογικό format χωρικών δεδομένων, για την αποθήκευση γεωμετρικής και περιγραφικής πληροφορίας. Οι γεωγραφικές οντότητες σε ένα shapefile αποθηκεύονται ως γραμμές ή σημεία ή πολύγωνα και οι περιγραφικές πληροφορίες μπορούν να είναι αποθηκευμένες σε πίνακες τύπου dbf που να συνδέονται με το shapefile. Μπορούν να βρίσκονται αποθηκευμένα σε έναν απλό φάκελο του συστήματος ή/και σε workspace (Εικόνα Β.2). Τα shapefiles μπορούν να εξαχθούν (export) σε άλλες δομές δεδομένων (CAD, Coverage, Geodatabase) αλλά και να αποτελέσουν πηγή για εισαγωγή δεδομένων (import) σε μια γεωβάση (geodatabase).
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Εικόνα Β.1 Ο κατάλογος δεδομένων του ArcCatalog.
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Εικόνα Β.2 Αποθήκευση shapefiles στον ArcCatalog.
Η feature class αποτελείται από ομοιογενείς γεωγραφικές οντότητες που έχουν κοινές ιδιότητες (attributes). Περιέχεται σε μια γεωβάση ή σε ένα feature dataset μιας γεωβάσης και υποστηρίζει τοπολογικές σχέσεις. Γενικά στηρίζεται σε τρία γεωμετρικά αρχέτυπα (σημείο, γραμμή, πολύγωνο) αλλά υπάρχουν επτά (7) τύποι feature classes:
 
	Σημεία (points).
	Γραμμές (lines).
	Πολύγωνα (polygons).
	Ονοματολογία (annotation).
	Διαστάσεις (dimensions).
	Πολλαπλά σημεία (multipoints).
	Πολλαπλές Επιφάνειες (multipatches).

 
Οι feature classes μπορούν να εξαχθούν σε άλλες δομές δεδομένων (CAD, Coverage, Geodatabase, Shapefile) αλλά και να αποτελέσουν πηγή για εισαγωγή δεδομένων (import) σε μια γεωβάση (geodatabase) ή σε ένα feature dataset.
Β.3.2 Ενεργοποίηση
 
Η ενεργοποίηση γίνεται από την έναρξη προγραμμάτων με την αλληλουχία επιλογών Start>All Programs>ArcGIS>ArcCatalog.
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Εικόνα Β.3 Το παράθυρο λειτουργιών του ArcCatalog.
Β.3.3 Οι γραμμές εργαλείων του ArcCatalog
 
Οι γραμμές εργαλείων (toolbars) ενεργοποιούνται από το κυρίως μενού του ArcCatalog μέσω της επιλογής View>Toolbars. Η γραμμή εργαλείων Main menu (Εικόνα Β.4) ενεργοποιείται αυτόματα.
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Εικόνα Β.4 Η εργαλειοθήκη Main menu του ArcCatalog. 
Απαραίτητες είναι οι εργαλειοθήκες Standard (Εικόνα Β.5) και Geography (Εικόνα Β.6).
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Εικόνα Β.5 Η γραμμή εργαλείων Standard του ArcCatalog.
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Εικόνα Β.6 Η γραμμή εργαλείων Geography του ArcCatalog.
Οι υπόλοιπες γραμμές εργαλείων, ενεργοποιούνται ανάλογα με τις απαιτήσεις του χρήστη.
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Εικόνα Β.7 Σύνδεση με το χώρο αποθήκευσης των δεδομένων.
Β.3.4 Ορισμός σύνδεσης με το χώρο των δεδομένων 
 
Με το πλήκτρο [image: ] Connect to folder γίνεται η σύνδεση με ένα φάκελο εργασίας (folder) στον οποίο βρίσκονται αποθηκευμένα τα δεδομένα (Εικόνα Β.7).
Β.3.5 Επισκόπηση των χωρικών οντοτήτων
 
Επιλογή του dataset με αριστερό κλικ και από τη βάση της καρτέλας Preview, επιλέγεται Preview>Geography (Εικόνα Β.8). Η εργαλειοθήκη Geography (Εικόνα Β.6) ενεργοποιείται όταν επιλεγεί ένα dataset χωρικών δεδομένων και τα πλήκτρα αντιστοιχούν στις λειτουργίες μεγέθυνσης, σμίκρυνσης, μετακίνησης, απεικόνισης του συνόλου της έκτασης της γεωγραφικής περιοχής, αναγνώρισης οντοτήτων και δημιουργίας συντόμευσης (thumbnail) σε δεδομένα (Εικόνα Β.9).
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Εικόνα Β.8 Επισκόπηση δεδομένων σε γεωγραφική μορφή.
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Εικόνα Β.9 Πλήκτρα επισκόπησης δεδομένων σε γεωγραφική μορφή.
Β.3.6 Επισκόπηση των περιγραφικών χαρακτηριστικών
 
Για την επισκόπηση των περιγραφικών χαρακτηριστικών, γίνεται επιλογή του dataset με αριστερό κλικ και από τη βάση της καρτέλας Preview, επιλέγεται Preview>Table.
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Εικόνα Β.10 Επισκόπηση δεδομένων σε μορφή πίνακα.
Β.3.7 Δημιουργία φακέλου εργασίας
 
Η δημιουργία φακέλου εργασίας γίνεται με την επιλογή File>New Folder.
 
Β.3.8 Δημιουργία νέων datasets
 
Η δημιουργία νέων datasets γίνεται με την επιλογή File>New. Υποστηρίζονται οι ακόλουθες περιπτώσεις:
 
	Shapefile.
	Feature class.
	Personal Geodatabase.
	File Geodatabase.

 
Για παράδειγμα File>New>Feature class.
Β.3.8.1. Δημιουργία βάσης γεωχωρικών δεδομένων (Geodatabase)
 
Σε περιβάλλον ArcCatalog και στο χώρο εργασίας που έχει δημιουργηθεί ή επιλεγεί, δίνεται
File >New>File Geodatabase ή Personal Geodatabase.
Β.3.8.2. Δημιουργία συνόλου χωρικών δεδομένων (Feature Dataset)
 
Η δημιουργία ενός Feature Dataset γίνεται με File>New>Feature Dataset. Στην αλληλουχία των διαδοχικών παραθύρων που ενεργοποιούνται, ορίζονται τα ακόλουθα:
 
	Name (Όνομα).
	XY Coordinate System (Ορισμός προβολικού συστήματος).
	Vertical Coordinate System (προεπιλογή: unknown).
	XY Tolerance (μέγιστη απόσταση για την οποία δύο κορυφές ταυτίζονται).
	Ολοκλήρωση της διαδικασίας με το πλήκτρο Finish.

 
Β.3.8.3. Εισαγωγή ενός διανυσματικού αρχείου στη βάση χωρικών δεδομένων ως κλάση αντικειμένων (Feature Class)
 
Σε επίπεδο Geodatabase ή Feature Dataset με δεξί κλικ του ποντικιού ενεργοποιείται το σχετικό εργαλείο και επιλέγεται Import>Feature Class (single). Στο παράθυρο του εργαλείου αυτού συμπληρώνονται:
 
	Στο πεδίο Ιnput features: το όνομα του shapefile ή της feature class ή του coverage που περιέχει τα χωρικά δεδομένα.
	Στο πεδίο Output Feature Class: όνομα του πίνακα χωρικών στοιχείων που θα δημιουργηθεί στη γεωβάση.
	Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.

 
Β.3.8.4. Εισαγωγή πολλαπλών διανυσματικών αρχείων στη βάση χωρικών δεδομένων ως κλάσεις αντικειμένων (Feature Class)
 
Σε επίπεδο Geodatabase ή Feature Dataset με δεξί κλικ του ποντικιού ενεργοποιείται το σχετικό εργαλείο και επιλέγεται Import>Feature Class (multiple). Στο παράθυρο του εργαλείου αυτού συμπληρώνονται:
    
	Στο πεδίο Ιnput features: τα διανυσματικά αρχεία που θα εισαχθούν.
	 Στο πεδίο Output Geodatabase: το όνομα της γεωβάσης στην οποία θα εισαχθούν τα δεδομένα.
	Η διαδικασία ολοκληρώνεται με το πλήκτρο ΟΚ.

 
Β.3.9 Μεταδεδομένα (Metadata)
 
Τα μεταδεδομένα είναι πληροφορίες που περιγράφουν το περιεχόμενο, την ποιότητα, την κατάσταση και άλλα χαρακτηριστικά των δεδομένων. Στον ArcCatalog η οργάνωση των μεταδεδομένων χωρίζεται στις ιδιότητες (properties) και την τεκμηρίωση (documentation). 
Οι ιδιότητες αφορούν στο εύρος της περιοχής που καλύπτουν τα γεωχωρικά δεδομένα, το προβολικό σύστημα, πληροφορίες για τα πινακοποιημένα στοιχεία των περιγραφικών χαρακτηριστικών (attributes) που τα συνοδεύουν και καταγράφονται αυτόματα στον ArcCatalog. Η τεκμηρίωση αφορά σε περιγραφικές πληροφορίες (για παράδειγμα νομικές πληροφορίες για τη χρήση των δεδομένων) που καταγράφονται από τον χρήστη με τη βοήθεια ενός metadata editor. Η αποθήκευση στον ArcCatalog γίνεται σε μορφή XML. Η επισκόπηση των μεταδεδομένων στον ArcCatalog γίνεται από την καρτέλα Metadata.
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Εικόνα Β.11 Επισκόπηση των μεταδεδομένων.
Β.3.10 Αναζήτηση χαρτών και δεδομένων
 
Με το εργαλείο Search γίνεται η αναζήτηση δεδομένων. Το εργαλείο αυτό θα αναζητήσει σε αρχεία, databases και σε GIS servers δεδομένα που πληρούν τα κριτήρια που θα τεθούν. Η αναζήτηση γίνεται για συγκεκριμένα formats δεδομένων και για χάρτες που καλύπτουν μια ορισμένη γεωγραφική περιοχή. Η αναζήτηση αποθηκεύεται στον ArcCatalog και δημιουργούνται συντομεύσεις στα αποτελέσματα της αναζήτησης, ενώ η αναζήτηση μπορεί να επαναληφθεί και με τροποποιημένα κριτήρια και να εκτελεστεί ξανά.
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Εικόνα Β.12 Η διαδικασία αναζήτησης χαρτών και δεδομένων.
Β.4 ArcToolbox
 
Το ArcToolbox είναι μια συλλογή από εργαλεία γεω-επεξεργασίας, στην οποία τα εργαλεία είναι οργανωμένα κατά λειτουργική ενότητα (toolbox). Κάθε ενότητα περιέχει ομάδες (toolsets) κι αυτές με τη σειρά τους περιέχουν εργαλεία (tools). Από το λογισμικό δίνεται η δυνατότητα, ο χρήστης να κατασκευάσει δικά του εργαλεία και να τα αποθηκεύσει.
 
 
[image: ]
Εικόνα Β.13 Συλλογή εργαλείων ArcToolbox.
 
Β.4.1  Ενεργοποίηση
 
Σε όλα τα προγράμματα του ArcGIS, η ενεργοποίηση του ArcToolbox γίνεται από το εικονίδιο [image: ] που βρίσκεται στη γραμμή εργαλείων Standard. Η βασική δομή του παρουσιάζεται στην Εικόνα Β.13.
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Εικόνα Β.14 Η δομή των εργαλείων στο ArcToolbox.
Β.5 ArcMap
 
Το ArcMap είναι το κύριο υποσύστημα του ArcGIS που χρησιμοποιείται για όλες τις χαρτογραφικές διαδικασίες αλλά και τις διαδικασίες διόρθωσης (editing) των δεδομένων. Σε μία χαρτογραφική σύνθεση η γεωχωρική πληροφορία αποδίδεται σαν μια συλλογή θεματικών επιπέδων και συμπληρώνεται από άλλα στοιχεία (γραφήματα, εικόνες, υπόμνημα συμβόλων, γραφική και ονομαστική κλίμακα, κάναβοι, τίτλος και λοιπές πληροφορίες περιθωρίου).
Υπάρχουν δύο καταστάσεις λειτουργίας του ArcMap: η data frame view και η layout view. Data frame είναι η χαρτογραφούμενη περιοχή όπου απεικονίζεται η γεωγραφική πληροφορία σαν σειρά από θεματικά επίπεδα (layers). H layout view είναι η επισκόπηση του αρχιτεκτονικού του χάρτη όπου διατάσσονται τα στοιχεία της χαρτογραφικής σύνθεσης όπως θα παρουσιαστούν στο τελικό μέσο απόδοσης. Τα αρχεία των χαρτογραφικών συνθέσεων έχουν extension .mxd.
Β.5.1 Ενεργοποίηση
 
Η ενεργοποίηση του προγράμματος γίνεται από την έναρξη προγραμμάτων των Windows Programs>ArcGIS>ArcMap>A new empty map για σύνθεση νέου χάρτη ή An existing map για μια ήδη υπάρχουσα χαρτοσύνθεση.
Β.5.2 Δομή της οθόνης του ArcMap
 
Η οθόνη του ArcMap έχει την τυπική δομή του παραθύρου του Windows explorer: στο επάνω μέρος υπάρχει το βασικό μενού με τις κύριες λειτουργίες και ο χώρος τοποθέτησης των εργαλειοθηκών και το υπόλοιπο είναι χωρισμένο σε δύο «παράθυρα». Το αριστερό διατίθεται για τον πίνακα περιεχομένων (TOC – Table of contents) και το δεξί για την εμφάνιση των χωρικών δεδομένων. Ο πίνακας περιεχομένων λειτουργεί ως κατάλογος των data frames (που μπορεί να είναι περισσότερα του ενός) και των θεματικών επιπέδων του χάρτη, εμφανίζει το είδος των στοιχείων που περιέχει το καθένα, το συμβολισμό που χρησιμοποιείται για την απόδοσή του αλλά και τη σειρά σχεδίασής τους στο χάρτη, η οποία μπορεί να αλλάξει σύροντας τα με το ποντίκι στην επιθυμητή θέση. Εκ πρoοιμίου εμφανίζονται πιο ψηλά τα σημειακά θεματικά επίπεδα, ακολουθούν τα γραμμικά και τέλος εμφανίζονται τα πολυγωνικά. Η σειρά σχεδίασης στο χάρτη είναι αντίστροφη, δηλαδή τα πολυγωνικά σχεδιάζονται πρώτα και επιτίθενται διαδοχικά τα γραμμικά και τα σημειακά.
Β.5.3 Γραμμές εργαλείων (toolbars)
 
Από το μενού View>Toolbars ενεργοποιούνται διαδοχικά οι γραμμές εργαλείων Layout, Tools, Draw και ελέγχεται αν είναι ενεργοποιημένες οι γραμμές εργαλείων Main menu και Standard. Κατά την ενεργοποίησή τους (αν δεν τοποθετηθούν αυτόματα στο χώρο που είναι δεσμευμένος για τα εργαλεία) εμφανίζονται ως «αιωρούμενες» και με το αριστερό πλήκτρο του ποντικιού σύρονται και τοποθετούνται στις γκρίζες περιοχές των εργαλείων.
Β.5.4 Data vs Layout view
 
Από τη βάση του παραθύρου απόδοσης των χωρικών δεδομένων επιλέγεται η κατάσταση λειτουργίας: η χαρτογραφούμενη περιοχή (data frame view) ή το αρχιτεκτονικό του χάρτη (layout view).
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Εικόνα Β.15 Επιλογή κατάστασης λειτουργίας Data frame view ή Layout view.
Η data frame view εμφανίζει τα γεωγραφικά δεδομένα που καθορίζονται από το περιεχόμενο των θεματικών επιπέδων που περιλαμβάνει το data frame. H layout view, εκτός από τα χαρτογραφικά δεδομένα, εμφανίζει και τη διάταξή τους στην τελική «σελίδα» σχεδίασης, μαζί με τα υπόλοιπα στοιχεία της χαρτογραφικής σύνθεσης.
Β.5.5 Ορισμός του συστήματος αναφοράς των δεδομένων 
 
Η διαδικασία αυτή γίνεται μόνο μια φορά, στην αρχή της σύνθεσης του χάρτη. Στο χώρο της οθόνης όπου εμφανίζονται τα θεματικά επίπεδα της σύνθεσης, με δεξί κλικ στη λέξη Layers (που είναι το default όνομα του data frame) εμφανίζεται το μενού με όλες τις δυνατές λειτουργίες για τη χαρτογραφούμενη περιοχή (data frame). Η επιλογή Properties ενεργοποιεί μια ομάδα από επάλληλες καρτέλες λειτουργιών, από τις οποίες επιλέγεται η καρτέλα Coordinate System, μέσω της οποίας υλοποιείται η δυνατότητα ορισμού ή επιλογής ενός συστήματος συντεταγμένων ως το σύστημα αναφοράς του χάρτη. Για την περίπτωση του ΕΓΣΑ 87 επιλέγεται Select a coordinate system>Predefined>Projected Coordinates systems>National Grids> Greek_Grid. Σημειώνεται ότι τα χωρικά δεδομένα θα εμφανίζονται στην οθόνη μόνο εφόσον το σύστημα συντεταγμένων τους ή το προβολικό τους σύστημα συμπίπτει με αυτό του συστήματος αναφοράς που ορίστηκε. O ορισμός των μονάδων γίνεται από την καρτέλα Layers>Properties>General.
Β.5.6 Προσθήκη θεματικών επιπέδων
 
Γίνεται με το πλήκτρο [image: ] Add Data από τη γραμμή εργαλείων Standard. Αφού γίνει η πλοήγηση (navigation) στο φάκελο όπου βρίσκονται τα δεδομένα, επιλέγεται με αριστερό κλικ του ποντικιού το θεματικό επίπεδο που θα προστεθεί. Μπορούν να επιλεγούν ταυτόχρονα περισσότερα του ενός θεματικού επιπέδου με τη χρήση του πλήκτρου <Ctrl> ή <Shift>. (ΣΣ: Για να διευκολυνθεί η προσθήκη των θεματικών επιπέδων, είναι καλύτερο να οριστεί μια μόνιμη σύνδεση με το φάκελο (ή τους φακέλους) που βρίσκονται τα δεδομένα.
Β.5.7 Layer properties
 
Για κάθε θεματικό επίπεδο που εισάγεται στη χαρτοσύνθεση, οι διαθέσιμες ενέργειες εμφανίζονται στο μενού που αναδύεται κάνοντας δεξί κλικ ή διπλό αριστερό στο όνομά του. Η επιλογή Properties ενεργοποιεί μια ομάδα από επάλληλες καρτέλες στις οποίες βρίσκονται εργαλεία που καθορίζουν ή δίνουν πληροφορίες για:
 
	το συμβολισμό (symbology),
	την εμφάνιση (display),
	τα πεδία των ιδιοτήτων (fields),
	τα γενικά στοιχεία (general),
	τις συνθήκες επιλογής (selection),
	την πηγή των δεδομένων (source),
	τις συνδέσεις με πίνακες (joins & relates),
	λογικές επιλογές που έχουν γίνει για τα δεδομένα (definition query).

 
Β.5.8 Περιήγηση στα δεδομένα
 
Με τη χρήση των εργαλείων της γραμμής εργαλείων Tools είναι εφικτή η περιήγηση και επισκόπηση των χωρικών δεδομένων (Εικόνα Β.16).
 
 
[image: ]
Εικόνα Β.16 Τα εργαλεία περιήγησης της γραμμής εργαλείων Tools.
B.5.8 Μέθοδοι επιλογής
 
Από το μενού Selections καθορίζονται οι συνθήκες επιλογής των οντοτήτων:
 
	Select by attributes με τη σύνταξη ερωτήματος SQL στα περιγραφικά χαρακτηριστικά.
	Select by location με τη σύνταξη συνθήκης αναφορικά με τις σχετικές χωρικές θέσεις των θεματικών επιπέδων.
	Clear selected features.
	Zoom / Pan selected features.

 
 
 
B.5.9 Περιγραφικά δεδομένα
 
Για κάθε θεματικό επίπεδο του dataframe είναι δυνατή η επισκόπηση και διαχείριση των περιγραφικών του χαρακτηριστικών (attributes). Με δεξί κλικ στο θεματικό επίπεδο, από το μενού που αναδύεται, γίνεται η επιλογή Open Attribute Table. Με το πλήκτρο Options δίνονται διάφορες δυνατότητες, όπως:
 
	Προσθήκη νέου πεδίου (Add field).
	Σύνδεση με πίνακα (Join, Relate).
	Επιλογή εγγραφών με σύνταξη SQL query, απο-επιλογή εγγραφών, εναλλαγή επιλεγμένων – μη επιλεγμένων.
	Εύρεση και αντικατάσταση.
	Έκδοση αναφορών (reports).
	Εξαγωγή (export) σε πίνακα dbf.

 
Επιπλέον, επιλέγοντας ένα πεδίο (στήλη) είναι δυνατή:
 
	Η ταξινόμηση των δεδομένων (sorting).
	Η έκδοση στατιστικών (statistics).
	Η διαγραφή του πεδίου, εφόσον δεν πρόκειται για πεδίο του συστήματος.

Β.5.10 Μετρήσεις
 
Το εργαλείο Measure [image: ] από τη γραμμή εργαλείων Tools ενεργοποιεί την αντίστοιχη γραμμή εργαλείων μέσω της οποίας γίνονται:
 
	Μέτρηση απόστασης.
	Μέτρηση εμβαδού.
	Μέτρηση των γεωμετρικών στοιχείων οντότητας.
	Τήρηση στατιστικών των μετρήσεων.

Β.5.11 Map tips
 
Στην κατάσταση λειτουργίας Data view τα Map tips εμφανίζονται με την τοποθέτηση του δείκτη (pointer) του ποντικιού σε μια οντότητα, οπότε εμφανίζεται το όνομα της οντότητας ή κάποια άλλη πληροφορία χωρίς τη χρήση του εργαλείου Identify. Mε τη βασική προϋπόθεση ότι στο πεδίο αυτό έχει δημιουργηθεί spatial index, τo ArcMap επιτρέπει την επιλογή του πεδίου που θα εμφανίζεται ως Map tip:
 
	Δεξί κλικ στο θεματικό επίπεδο, Properties>Display>Show Map tips.
	Κλικ Fields και επιλογή του επιθυμητού πεδίου.
	Κλικ ΟΚ.

 
Β.5.12 Εξαγωγή δεδομένων (Export)
 
Από το περιβάλλον του ArcMap, είναι δυνατή η εξαγωγή των δεδομένων ενός θεματικού επιπέδου είτε σε μορφή shapefile είτε σε μορφή feature class με δεξί κλικ στο όνομά του και Export data.
 
Β.5.13 Αποθήκευση
 
Η αποθήκευση της χαρτοσύνθεσης γίνεται με την επιλογή File>Save ή Save as. Δίνεται επίσης η δυνατότητα αποθήκευσης της χαρτοσύνθεσης σε δομή (format) προηγούμενων εκδόσεων (versions) του λογισμικού, με την επιλογή File>Save A Copy. Πρέπει να σημειωθεί ότι για την αποδέσμευση από την ονομασία του τρέχοντος pathname ορίζεται από το μενού File>Map Document Properties>Pathnames>Stοre relative pathnames to data sources.
Β.5.14 Εκτύπωση
 
Η εκτύπωση της χαρτοσύνθεσης γίνεται από το μενού File>Print. Οι απαραίτητες ρυθμίσεις που πρέπει να προηγηθούν, είναι οι ακόλουθες:
 
	Η ρύθμιση της σελίδας σχεδίασης με την επιλογή File>Page Setup. Ορίζονται ο εκτυπωτής, το μέγεθος της σελίδας και ο προσανατολισμός της σελίδας (κατακόρυφο – portrait / οριζόντιο – landscape). Επιλέγεται ως κατάσταση λειτουργίας αυτή της απόδοσης (Layout View) (Εικόνα Β.15).
	Ο καθορισμός της κλίμακας, της θέσης και των μονάδων με την επιλογή Layers>Properties>Data Frame>Fixed Scale (πληκτρολογείται η κλίμακα απόδοσης) και την επιλογή Layers>Properties>General>Units Maps: Meters & Units Page: Meters.
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